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કƳʔુટરનાે પ̋રચય 
 

1. ઉɠેશાે (Objectives) 

અા ǐકરણના અતંે તમે:   

 કƳʔુટર શંુ છે તે સમજશા ેઅને કƳʔુટર કેવી રીતે કાયƙ કરે છે તેની મળૂભૂત ̀ણકારી મળેવશાે. 
 કƳʔુટરના ઇ̍તહાસ અને ̍વકાસની પેઢીઅાે ̍વશે મા̋હતી મેળવશાે અને દરેક પેઢીનું ̍વƸલેષણ કરી 

શકશાે. 
 કƳʔુટર ̐સ˶મના મȕુ લƖણાે અન ેઉપયાેગાે અાેળખી શકશા ેજમે કે ઝડપ, ચાેકસાઈ, મ˄ી-ટા̔˱̬ગ 

વગેરે. 
 ̍વ̑ભɿ Ɩેǋાેમાં કƳʔુટરના ઉપયાેગની સમજ મેળવી શકશાે જેમ કે ̏શƖણ, અારાેƝય, મનાેરંજન અન ે

˗વસાય. 
 કƳʔુટર ̐સ˶મના ઘટકાેન ેઅાેળખી શકશાે જમે કે હાડƙવેર, સાʘેવેર, ઇનપટુ અને અાઉટપુટ ઉપકરણાે. 
 હાડƙવેર અને સાેʘવેર વȝેનાે તફાવત સમ͂ શકશા ેઅને દરેકના ǐકારાે તથા ઉદાહરણાે ̀ણી શકશાે. 
 ડેટા અને મા̋હતી વȝેનાે તફાવત સમ̀શ ેઅને ડેટા ǐાસેે̐સ̬ગના તબǲાઅાે સમ̀શે. 
 મા̋હતી અને ડેટાની બાઇનરીમાં રજૂઅાત કેવી રીત ેથાય છે તે સમ̀શ ેઅને ASCII, Unicode જવેા 

કાે̋ડ̬ગ ̐સ˶મ ̍વશે ̀ણશાે. 

2. પ̋રચય  

અાજના ટેકનાેલાે͂  યુગમાં કƳʔુટર અે અેક મહɗપૂણƙ અને અ̏નવાયƙ સાધન બની ગયું છે. કƳʔુટરના 
ઉપયાેગથી ̍વ̍વધ Ɩેǋાેમાં ƿાં̍ ત અાવી છે, અને અાજના સમયમાં તેનાે ઉપયાેગ ̍વƗાન, ̏શƖણ, અારાેƝય, 
˗વસાય, મનાેરંજન, સંચાર, અને સંશાેધન જવેા અનેક Ɩેǋાેમાં થાય છે. કƳʔુટરની મદદથી માટેાભાગની 
જ̋ટલ ǐ̋ƿયાઅાે ઝડપથી અને ચાેકસાઇપવૂƙક શȂ બની છે. 

3. કƳʔુટર શંુ છે? 

કƳʔુટર અેક ઇલેƛǇાે̏ નક ઉપકરણ (Electronic Device) છે, જ ે˗̘Ǹ ɦારા અાપવામાં અાવેલી મા̋હતી 
(Data) ને ̄ીકારી, તેના પર ǐ̋ƿયા (Processing) કરી અને તેન ેઉપયાેગી મા̋હતી (Information) તરીકે 
રજૂ કરે છે. કƳʔુટર ફǸ ગણતરીઅાે કરવા પૂરતું સી̌મત નથી; તે મા̋હતી સǁંહ (Data Storage), ̍ વƸલેષણ 
(Analysis), અને સંચાર (Communication) જેવા ̍વ̍વધ કાયા̳ પણ સરળતાથી કરી શકે છે. 

3.1 કƳʔુટરના ેઇ̍તહાસ 

કƳʔુટરના ̍ વકાસની યાǋા ખૂબ જ રસǐદ અને ƿાં̍ તકારી રહી છે. અાજના અાધુ̏નક કƳʔુટરાે અેકદમ ઝડપી, 
શ̘Ǹશાળી અને બહુમુખી છે, પરંતુ શͅઅાતમાં કƳʔુટરાે ખૂબ માેટા અન ે મયાƙ̋દત Ɩમતા ધરાવતા હતા. 
કƳʔુટરના ઇ̍તહાસને ǐાચીન ગણતરીના સાધનાેથી લઈને અાજના અાધુ̏ નક કƳʔુટરાે સુધી ̍વ̍વધ 
તબǲાઅામેાં વહ̲ચી શકાય. 
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કƳʔુટરના ̍ વકાસ પહેલા, મનુˮ  ગણતરીઅાે કરવા માટે ̍ વ̍વધ સાધનાેનાે ઉપયાેગ કરતા ેહતાે. જૂના સમયમા ં
̍વ̍વધ ગણતરી માટેના ઉપકરણાે ̍વકસાવવામાં અા˗ા, જ ે કƳʔુટરના ̍વકાસ માટે મહɗપૂણƙ પગ̎થયા 
સા̐બત થયા. 

a. અબાકસ (Abacus) અે ̍વ˝નું સાૈથી ǐાચીન ગણતરી સાધન માનવામાં અાવે છે, જ ેઅાશરે 3000 ઈ.સ. 
પૂવ̳ ચીન અન ે મસેાેપાેટે̌મયામાં ̍વક̐સત થયું હતુ.ં અા યાં̍ǋક સાધન લાકડાના Ǒેમમાંથી બનાવવામા ં
અાવતું હતુ,ં જમેાં ̍વ̍વધ થાંભલાઅાે (Rods) પર ગાે̐ ળયાં (Beads) મુકવામાં અાવતા હતા. અા 
ગાે̐ ળયાઅાેને સરકાવીને ̍વ̍વધ ગણતરીઅાે, જમે કે સરવાળા (Addition) અને બાદબાકી 
(Subtraction) કરવામાં અાવતી. તે સમયના વેપારીઅા ે અન ે ગ̒ણતશા˸ીઅાે માટે અɔંત ઉપયાેગી 
સાધન હતું. અબાકસ અાજના સમયમાં પણ કેટલાક દેશાેમાં ǐાથ̌મક ƺતરના ગ̒ણત ̏શƖણ માટે 
ઉપયાેગમા ંલેવાય છે, કારણ કે તે બાળકાેમાં સંȕાઅાે સમજવા અને તીǖ ગણતરી Ɩમતાઅાે ̍વકસાવવા 
માટે મદદͅપ થાય છે. 

 

Image source: https://www.merriam-webster.com/dictionary/abacus  

b. પા˱લાઈન (Pascaline) અે 1642માં ǑેƮચ ગ̒ણતશા˸ી Ʊલેઝ પા˱લ (Blaise Pascal) ɦારા 
̍વકસાવાયેલ અેક યાં̍ ǋક ગણતરી મશીન હતું. તે ̍વશેષͅપે સરવાળા (Addition) અને બાદબાકી 
(Subtraction) જવેી ǐાથ̌મક ગણતરીઅાે કરવાની Ɩમતા ધરાવતું હતું. પા˱લાઈનનું કાયƙ ̎ ગયર ̐ સ˶મ 
(Gear System) પર અાધા̋રત હતુ,ં જ ે મશીનમાં ̍વ̍વધ ચƿાે (Wheels) અને દાંતાવાળાં ̎ગયસƙ 
(Cogwheels) ɦારા સચંા̏લત થતંુ. તે સમયની Ǎ̑ˠઅ,ે અા મશીન અેક મહɗપૂણƙ શાેધ હતી, કારણ કે 
તે હƺત̏લ̑ખત ગણતરીઅાે કરતાં વધુ ઝડપી અને ચાǲેસ પ̋રણામાે અાપતું હતંુ. પા˱લાઈનના ̍ વકાસન ે
અાધુ̏નક કƳʔુટરાે માટેની શͅઅાત તરીકે ̀ેવામાં અાવે છે. 
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Image Source: https://en.wikipedia.org/wiki/Pascaline#/media/File:Pascaline-
CnAM_823-1-IMG_1506-black.jpg  

c. લે̐બ̏નઝ કેˀુલેટર (Leibniz Calculator) અે 1673માં ǐȕાત જમƙન ગ̒ણતશા˸ી ગાેટǑીડ 
લે̐બ̏નઝ (Gottfried Wilhelm Leibniz) ɦારા ̍વકસાવવામાં અા˗ંુ હતું. અા યાં̍ǋક ગણતરી મશીન 
પા˱લાઈન કરતાં વધુ સુધારાયેલ હતું, કારણ કે તે માǋ સરવાળા (Addition) અને બાદબાકી 
(Subtraction) જ નહ̯, પરંતુ ભાગાકાર (Division) અને ગુણાકાર (Multiplication) જવેી વધુ જ̋ટલ 
ગણતરીઅાે પણ કરી શકતું હતંુ. લે̐બ̏નઝે "Stepped Drum" નામની ટેક̏નક ̍વકસાવી, જનેી મદદથી 
અા મશીન સંȕાઅાે પર ઝડપી અને ચાેǲસ ગણતરીઅાે કરી શકતું. લે̐બ̏નઝ કેˀુલેટર ગ̒ણત અને 
કƳʔુ̋ટ̬ગ Ɩેǋે અેક મહɊપણૂƙ શાેધ હતી, જ ેભ̍વˮના અાધુ̏નક ગણતરી મશીનાે માટે પાયાે પુરવામાં 
સહાયક બની. 

 

Image Source: http://www.gwleibniz.com/calculator/calculator_jpg.html 

d. અેના̏લ̋ટકલ અેિƮજન (Analytical Engine) 1837માં ǐȕાત ̐ǒ̋ટશ ગ̒ણતશા˸ી ચા˔ƙ બાબેજ 
(Charles Babbage) ɦારા ̋ડઝાઇન કરવામાં અા˗ું હતું. અા મશીન અાધુ̏નક કƳʔુટરાે માટેનંુ 
અાધારભતૂ માેડલ માનવામાં અાવે છે, કારણ કે તેમાં મેમરી (Memory), લાે͂ કલ યુ̏ નટ (Logical Unit), 
અને ǐાǁેામેબલ ̏નયંǋણ (Programmable Control) જવેી અગɔની સુ̍ વધાઅાે સમાવેશ પામી હતી. 
અેના̏લ̋ટકલ અેિƮજન માǋ અેક ગણતરી મશીન જ નહાતેું, પણ તે ǐાǁેામલેખન માટે સƖમ હતું, જનેા 
કારણે તે અાપાેઅાપ (Automated) ગણતરીઅાે કરી શકતું હતું. અા મશીન માટે અેડા લવલેસ (Ada 
Lovelace) અે ǐથમ કƳʔુટર ǐાેǁામ બના˗ંુ હતું, જનેા કારણે તેને "̍વ˝ની ǐથમ ǐાǁેામર" તરીકે 
અાેળખવામાં અાવે છે. અિેƮજનની અવધારણા અાજના અાધુ̏નક કƳʔુટરાે માટે અેક મજબૂત પાયાે 
પુરવામાં મદદͅપ બની હતી, ̀ેકે તેના સમયગાળામાં ટેક̏નકલ મયાƙદાઅાેને કારણે તનેાે સંપૂણƙ ̍વકાસ 
શȂ થયાે નહાેતા.ે 
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Image Source: https://en.wikipedia.org/wiki/Analytical_engine 

અાધુ̏નક કƳʔુટરાેનાે ̍વકાસ (Generations of Computers) 

કƳʔુટરાેના ̍વકાસને મુȕ પાંચ પેઢીઅાે (Generations) માં વહ̲ચી શકાય છે. 

પેઢી વષƙ ટેકનાેલાે͂ ઉદાહરણ ̍વશેષતા 
ǐથમ પેઢી (First 
Generation)  

1940-1956 વȂુેમ ȵુબ 
(Vacuum Tubes) 
નાે ઉપયાેગ. 

મશીન લ̲Ɲવેજ 
(Machine 
Language) નાે 
ઉપયાેગ. 

 

ENIAC 
(Electronic 
Numerical 
Integrator and 
Computer) – 
1946 
UNIVAC 
(Universal 
Automatic 
Computer) – 
1951 

માેટંુ કદ, વધુ વીજ 
વપરાશ, વધુ 
ગરમી ઉɎɿ 
થતી. 

ઝડપ અાેછી 
અને 
̍વ˝સનીયતા 
અાેછી. 

 

બી͂ પેઢી 
(Second 
Generation) 

1956-1963 Ǉાિɯ˶ર 
(Transistor) નાે 
ઉપયાેગ (વેȂુમ 
ȵુબ કરતા નાના 
અને વધુ કાયƙƖમ). 
અેસેƳƱલી લ̲Ɲવેજ 
(Assembly 
Language) નાે 
ઉપયાેગ શͅ થયાે. 

IBM 1401, IBM 
7094 

 

કદમાં નાનુ,ં વધુ 
ઝડપી, અાેછા ે
વીજ ખચƙ. 
ǐથમ કƳʔુટર 
ǐાેǁા̌મ̬ગ લ̲Ɲવેજ 
(COBOL, 
FORTRAN) 
̍વકસી. 
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ǋી͂ પેઢી (Third 
Generation)  

1964-1971 ઇ̔ɰǁેટેડ સ̋ક̭ટ 
(ICs) નાે ઉપયાેગ, જ ે
Ǉાિɯ˶રની 
જƝયાઅે ઘણા 
ઇલેƛǇાે̏નક ઘટકાે 
અેક સાથે ̀ેડે. 

IBM 360, PDP-8 વધુ કાયƙƖમતા, 
અાેછી ઉ̀ƙ 
જ̋ͅરયાત, અન ે
ખચƙમાં ઘટાડાે. 
મ˄ી-ટા̔˱̬ગ 
અને અાેપરે̋ટ̬ગ 
̐સ˶મનાે 
̍વકાસ. 

ચાેથી પેઢી 
(Fourth 
Generation) 

1971-2000 માઇƿાે̎ચપ 
(Microprocessor) 
નાે ̍વકાસ. 

˗̘Ǹગત કƳʔુટરાે 
(PCs) નાે ઉɣવ. 

 

Intel 4004, IBM 
PC, Apple 
Macintosh 

 

ગ̍તશીલ અન ે
પાેટ̳બલ 
કƳʔુટરા.ે 
ઉȝ-ƺતરના 
ǐાેǁા̌મ̬ગ લ̲Ɲવેજ 
(C, C++, Java) 
નાે ̍વકાસ. 

પાંચમી પેઢી 
(Fifth 
Generation) 

ભ̍વˮના 
કƳʔુટરાે 

કૃ̍ǋમ બુ̏ɡ 
(Artificial 
Intelligence – 
AI), Quantum 
Computing. 
માનવ-કƳʔટુર 
પ̋રભાષા (Natural 
Language 
Processing). 

 ̄યં શીખતા 
અને અાેટાેમેટેડ 
કƳʔુટરા.ે 
અવાજ, ˾શƙ 
અને ̍વƣયુઅલ 
રેકાે̗Șશન. 

 

કƳʔુટરના ઇ̍તહાસમાં સતત સુધારાઅાે અને નવીનતાઅાે ̀ેવા મળી છે. 1940 થી શͅ થયેલી કƳʔુટર ƿાં̍ત 
અાજ ેતે ƺતરે પહા̲ચી છે કે કƳʔુટરાે હવ ેમાનવ બુ̏ɡ (AI), મશીન લ̏ન̮ગ (Machine Learning) અને ȃાઉડ 
કƳʔુ̋ટ̬ગ (Cloud Computing) પર અાધા̋રત છે. 

ભ̍વˮમાં, Quantum Computing અને AI સંશાેધન ɦારા કƳʔુટરાે વધુ શ̘Ǹશાળી બની શકશે. અા 
ƿમશઃ સુધારા હંમેશા ટેકનાેલાે͂ને નવી ઊંચાઈઅાેઅે પહાચ̲ાડશે. 

3.2 કƳʔુટર ̐સ˶મના લƖણા ે

કƳʔુટર અે અાજના યુગનું સાૈથી શ̘Ǹશાળી સાધન છે, જ ે̍ વ̍વધ Ɩેǋાેમાં તેનાે ઉપયાેગ થઈ શકે તેવા ̍ વ̏શˠ 
લƖણાે ધરાવે છે. કƳʔુટર ̐સ˶મ તનેી ઝડપી ગ̍ત, સચાેટતા, અાૅટાેમેશન, મ˄ી-ટા̔˱̬ગ અને ઊંચી ˶ાેરેજ 
Ɩમતા જેવી ̍વશેષતાઅાેને કારણે માનવ ͂વનનાે અેક અ̍વભાȱ ̋હ̅ાે બની ગયું છે. નીચે કƳʔુટર 
̐સ˶મના મુȕ લƖણાેની ચચાƙ કરવામાં અાવી છે. 
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લાƖ̒ણકતા વણƙન 

ઝડપ (Speed) કƳʔુટર અɔંત ઝડપથી ǐાસેે̐ સ̬ગ કરી શકે છે. તે માǋ કેટલીક ̌મ̏લસેકંડ 
અથવા નેનાેસેકંડમાં માેટી સંȕામાં ગણતરીઅાે અને અાકંડાકીય ǐ̋ƿયાઅા ે
પણૂƙ કરી શકે છે. ઉદાહરણ તરીકે, અેક સામાʈ કƳʔુટર સેકંડના ભાગમાં 
લાખાે ગણતરીઅાે કરી શકે છે, જ ેમાનવી માટે અશȂ છે. 

ચાેકસાઈ (Accuracy) કƳʔુટરાે ખૂબ જ ચાેકસાઈ (Accuracy) સાથે કામ કરે છે. તે માǋ માનવી 
ɦારા દાખલ કરેલાં ડેટા અને અાદેશાે (Instructions) પર અાધાર રાખે છે. ̀ે 
દાખલ કરાયેલ મા̋હતી સાચી હાેય, તાે કƳʔુટર Ȃારેય ખાટંુે પ̋રણામ અાપતુ ં
નથી. 

અાૅટાેમેશન 
(Automation) 

અેકવાર કƳʔુટર ǐાǁેામ અથવા સુચનાઅાે અાપવામાં અાવે, પછી તે અટȂા 
વગર (Uninterrupted) કાયƙ કરવા સƖમ હાેય છે. તે અાપલેા અાદેશાે 
અનુસાર ̄ ચા̏લત રીતે કાયƙ કરે છે, અને તેને સતત માનવ હƺતƖેપની જͅર 
નથી. 

મ˄ી-ટા̔˱̬ગ 
(Multitasking) 

અાધુ̏નક કƳʔુટરાે અેક જ સમયે અેક કરતાં વધુ કાયƙ કરી શકે છે. ઉદાહરણ 
તરીકે, કƳʔટુર અેકસાથે ʸુ̏ઝક વગાડી શકે, ઈɰરનેટ ǒાઉ̏ઝ̬ગ કરી શકે, 
ડાેȂુમેɰ અે̋ડ̋ટ̬ગ કરી શકે અને બેકǁાઉɱમાં સાેʘવેર અપડેટ પણ કરી 
શકે છે. 

ઊંચી સંǁહ Ɩમતા (High 
Storage Capacity) 

કƳʔુટરાે ̍વશાળ ડેટાને સંǁહ કરવા સƖમ છે. અાજના કƳʔુટરાે ટેરાબાઈટ 
(TB) કે તેથી વધુ ડેટાને ˶ાેર કરી શકે છે. ̋ડ̏જટલ માɪમ પર મા̋હતી સંǁહ 
કરવાથી કાગળ અને ભાૈ̍તક જƝયા બચી શકે છે. 

સવƙǋ ઉપયાેગ 
(Versatility) 

કƳʔુટરાેનાે ઉપયાેગ ̍વ̍વધ Ɩેǋાેમાં થઈ શકે છે, જમે કે ̏શƖણ, અારાƝેય, 
વƗૈા̏નક સંશાેધન, ˗ાપાર, મનાેરંજન અને સંચાર. તેની સરળતાથી બદલાઈ 
શકતી કામગીરીને લીધે તે દરેક Ɩેǋમાં ઉપયાેગી બની ગયું છે. 

̀ેડાણ Ɩમતા 
(Connectivity) 

કƳʔુટરને ઈɰરનેટ અને અʈ નેટવકƙ  સાથે ̀ેડીને ̍વ˝ભરના લાેકાે સાથ ે
ડેટા અને મા̋હતી વહ̲ચી શકાય છે. ઈɰરનેટની મદદથી, કƳʔુટર અેકમાǋ 
ગણતરી માટેનું સાધન નહ̯, પણ અેક મહɊપણૂƙ સંપકƙ  સાધન પણ બની ગયું 
છે. 

પ̋રǗમ અને ખચƙ ઘટાડતુ ં
(Reduces Effort & 
Cost) 

કƳʔુટરના ઉપયાેગથી માનવીય Ǘમની જ̋ͅરયાત અાેછી થઈ છે. તે ઝડપથી 
અને અાેછી ભૂલ સાથે વધુ કાયƙ કરી શકે છે. ઉદાહરણ તરીકે, અાૅ̋ફસાેમા ં
માણસ ɦારા ̋હસાબ રાખવાને બદલે અેકાઉ̔ɰ̬ગ સાેʘવેરનાે ઉપયાેગ 
થવાથી ખચƙ અને સમય બચી શકે છે. 

બાૈ̐ ɡક Ɩમતા 
(Artificial 
Intelligence) 

અાજના કƳʔુટરાેમાં કૃ̍ǋમ બુ̏ɡ (AI) નાે સમાવેશ થતા ે જઈ ર̈ાે છે. AI 
Ɩમતાવાળા કƳʔુટરાે માનવ મગજની જમે ̍વચાર કરી શકે છે અને 
̄યંસંચા̏લત ̏નણƙય લઈ શકે છે. 
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કƳʔુટર ̐સ˶મની ̍વ̍વધ ̍વશેષતાઅાે તેને અેક શ̘Ǹશાળી, ઝડપી અને સવƙǁાહી સાધન બનાવે છે. 
અાજના ટેકનાેલાે͂-ચા̏લત યુગમા,ં કƳʔુટર ̍વના ͂વન કˍવું મƸુકેલ છે. તેની ઊંચી સચાેટતા, ઝડપ અને 
મ˄ી-ટા̔˱̬ગ Ɩમતા તેને દરેક Ɩેǋ માટે અ̏નવાયƙ બનાવ ેછે. 

3.3 કƳʔુટરના મૂળભૂત ઉપયાેગાે 

કƳʔુટર અાજ ેદરેક Ɩેǋમાં ઉપયાેગી બʈું છે. તેનાે ઉપયાેગ માǋ ગણતરી અને ડેટા સંǁહ માટે જ નહ̯, પણ 
સંચાર, ̏શƖણ, અારાેƝય, મનાેરંજન, ˗વસાય અને વૈƗા̏નક સંશાેધન જવેા અનેક Ɩેǋાેમાં થાય છે. નીચ ે
કƳʔુટરના કેટલાક મુȕ ઉપયાેગાેની ચચાƙ કરવામાં અાવી છે. 

Ɩેǋ ઉપયાેગ 

̏શƖણ અને સંશાેધન 
(Education & 
Research) 

કƳʔુટર ̏શƖણ Ɩેǋમાં ƿાં̍ ત લા˗ું છે. ̍વɥાથ̰અાે અને ̏શƖકાે અાેનલાઈન 
પાȸƿમાે, ઈ-બુȋ, શૈƖ̒ણક ̍વ̋ડઅાેઝ અને સંશાેધન માટે ઉપયાેગી 
વેબસાઇટ્સ ɦારા Ɨાન ǐાʏ કરી શકે છે. અાેનલાઇન ̏શƖણ ʕેટફાેમƙ (જમે કે 
Coursera, Udemy) ̍વɥાથ̰અાે માટે Distance Learning ને સરળ બનાવે 
છે. 

˗વસાય અને અાૅ̋ફસ 
કાયƙ (Business & 
Office Work) 

કƳʔુટરના ઉપયાેગથી ˗વસાય વધુ સુઘડ બʈા છે. અેકાઉ̔ɰ̬ગ સાેʘવેર 
(Tally, QuickBooks) ɦારા ̋હસાબ-̋કતાબ સરળતાથી રાખી શકાય છે. 
Additionally, કƳʔુટરાે ǐાજેǶે મેનેજમેɰ, ઈમેલ સંચાર, ડેટાબઝે મેનેજમેɰ 
અને માક̳̋ટ̬ગ માટે ઉપયાેગ થાય છે. 

અારાƝેય સેવા 
(Healthcare) 

અાધુ̏નક હાૅ̖˾ટલાે અને અારાેƝય કેƮǍાેમાં કƳʔુટર ɦારા દદ̰અાેની મા̋હતી, 
̋રપાેટ્ƙસ, અને દવાઅાેનું સંચાલન થાય છે. અા ઉપરાતં, રાબેાે̋ ટક સજƙરી, 
̋ડ̏જટલ ˱ે̏ન̬ગ (MRI, CT Scan) અને દૂર˺ સારવાર (Telemedicine) માટે 
પણ કƳʔુટર ઉપયાેગી છે. 

મનાેરંજન 
(Entertainment) 

કƳʔુટર મનાેરંજન માટે પણ મહɗપૂણƙ છે. લાેક̌ǐય ʕેટફાેમƙ જમે કે 
YouTube, Netflix, Amazon Prime અને Spotify ɦારા લાેકાે ʸુ̏ઝક, 
મૂવીઝ અને ગેʼનાે અાનંદ લઈ શકે છે. વધુમાં Video editing, graphic 
designing અને અે̏નમેશન માટે પણ કƳʔુટર ઉપયાેગ થાય છે. 

સંચાર 
(Communication) 

કƳʔુટરના ̍વકાસ પછી, ઈ-મેલ, ચે̋ટ̬ગ, વી̋ડયાે કાે̏ લ̬ગ અને સાે̏શયલ મી̋ડયા 
ʕેટફાેમƙ (WhatsApp, Facebook, Instagram) ɦારા સંચાર ઝડપી અને 
સરળ બʈું છે. કƳʔુટર ઈɰરનેટ સાથે ̀ેડાઈને ̍વ˝ભરના લાેકાે સાથે તુરંત 
સંપકƙ  સાધવા સƖમ છે. 

બ̲̋ક̬ગ અને નાણાકીય 
˗વહારાે (Banking & 
Finance) 

કƳʔુટર બ̲̋ક̬ગ Ɩેǋમાં ખાસ મહɗ ધરાવે છે. Online banking, ATM, fund 
transfer, stock market trading અને UPI પેમેɰ જવેી સુ̍વધાઅાે 
કƳʔુટરના કારણે શȂ બની છે. અાજ ેલાેકાે ઘરબેઠા અકે ̚ȃકમાં નાણાકીય 
˗વહારાે કરી શકે છે. 
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Ɩેǋ ઉપયાેગ 

વƗૈા̏નક સંશાેધન અન ે
ǐયાેગા ે (Scientific 
Research & 
Experiments) 

વƗૈા̏નક સંશાેધનમાં કƳʔુટરનાે ઉપયાેગ ̍વશાળ પાયે થાય છે. માેસમના 
અનુમાન (Weather Forecasting), અવકાશ સંશાેધન (Space Research), 
રાસાય̒ણક ǐયાેગાે અને દવાના ̍વકાસ (Drug Discovery) માટે કƳʔુટર 
મહɗપૂણƙ ભૂ̌મકા ભજવે છે. 

ગે̌ મ̬ગ અને વȢુƙઅલ 
̋રયા̏લટી (Gaming & 
Virtual Reality) 

અાજના યુગમાં કƳʔટુર ગે̌મ̬ગ ખૂબ લાેક̌ǐય બʈું છે. હાઇ-અેɱ ǁા̋ફȋ 
અને વȢુƙઅલ ̋રયા̏લટી (VR) ટેǽાેલાે͂ ɦારા ̋રયા̏લ̔˶ક ગે̌મ̬ગ અનુભવ 
મળી શકે છે. 

 

કƳʔુટર અાજના યુગમાં દરેક Ɩેǋ માટે અ̏નવાયƙ બની ગયંુ છે. તે ̏શƖણથી લઈ અારાેƝય, ˗વસાય, 
મનાેરંજન અને સંશાેધન સુધી ˗ાપક રીતે ઉપયાેગ થાય છે. ટેકનાેલાે͂ના ̍વકાસ સાથે, કƳʔુટરના નવા 
નવા ઉપયાેગાે ̍વક̐સત થઈ ર̈ા છે, અને તે માનવ ͂વનને વધુ સરળ અને કાયƙƖમ બનાવી ર̈ંુ છે. 

4. કƳʔુટર ̐સ˶મના ઘટકાે 

અાજના ̋ડ̏જટલ યુગમાં, કƳʔુટર અાપણા ͂વનનાે અેક અ̍ત મહɗપણૂƙ ભાગ બની ગયંુ છે. તે માǋ 
ગા̒ણ̍તક ગણતરીઅાે માટે જ નહ̯, પણ ˗વસાય, ̏શƖણ, અારાેƝય, સંચાર અને મનાેરંજન જવેા અનેક 
Ɩેǋાેમાં તેનાે ˗ાપક ઉપયાગે થાય છે. કƳʔુટર ̐સ˶મ ̍વ̍વધ હાડƙવેર અને સાેʘવેર ઘટકાેના સમૂહથી 
બનેલી હાેય છે, જ ેઅેકબી̀ની સાથે સંક̏લત થઈને ̐સ˶મને કાયƙરત બનાવે છે. 

કƳʔુટરના મȕુ ઘટકાેમાં હાડƙવેર, સાેʘવેર, ઇનપુટ ઉપકરણાે અને અાઉટપટુ ઉપકરણાે શામેલ છે. હાડƙવેર 
કƳʔુટરની ભાૈ̍તક રચના માટે જવાબદાર છે, ȱારે સાેʘવેર કƳʔુટરને સુચનાઅાે અાપવામાં મદદ કરે છે. 
ઇનપુટ ઉપકરણાે ɦારા યુઝસƙ કƳʔુટરને મા̋હતી પૂરી પાડે છે, અને અાઉટપુટ ઉપકરણાે ɦારા ǐાેસેસ થયેલ 
મા̋હતી ǐદ̏શ̭ત થાય છે. 

અા ̍વભાગમાં, અાપણે કƳʔટુર ̐સ˶મના ̍વ̍વધ ઘટકાે અને તેમની કાયƙપɡ̍તની ̍વƺતૃત સમજ મેળવશું, 
જ ેકƳʔુટરના સમǁ કાયƙને વધુ સારી રીતે સમજવામાં મદદ કરશે. 

4.1 સેƮǇલ ǐાેસે̐ સ̬ગ યુ̏ નટ (CPU) 

સƮેǇલ ǐાેસે̐ સ̬ગ યુ̏ નટ (CPU) ને કƳʔુટરના મગજ (Brain) તરીકે અાેળખવામાં અાવે છે. તે તમામ 
ગણતરીઅાે અને લાે̏ જકલ ǐાેસે̐ સ̬ગ માટે જવાબદાર હાેય છે. કƳʔુટરમાં ઇનપુટ ડેટા પર ǐ̋ƿયા કરવાનંુ અને 
તેને અાઉટપટુમાં ͅપાંત̋રત કરવાનું મુȕ કાયƙ CPU ɦારા કરવામાં અાવે છે. 

CPU ના મȕુ ઘટકાે 

CPU મુȕɗે ǋણ મુȕ ઘટકાેમાથંી બનેલાે હાયે છે: 

1. અંકગ̒ણત અને તકƙ  યુ̏નટ (ALU - Arithmetic & Logic Unit) 

 ALU કƳʔુટરના ગણતરી અન ેતકƙ -અાધા̋રત કાયƙ કરવા માટે જવાબદાર છે. 
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 અા યુ̏ નટમાં સરવાળા (Addition), બાદબાકી (Subtraction), ગુણાકાર (Multiplication), અને 
ભાગાકાર (Division) જેવી ગણતરીઅાે કરવામાં અાવે છે. 

 તેમજ, તુલનાɒક કામગીરી (Comparisons) અને તકƙ  (Logical) ǐવૃ̍ ɇઅા ેપણ ALU હેɱલ કરે 
છે. 

2. ̏નયǋંણ યુ̏નટ (Control Unit - CU) 

 CU સમǁ કƳʔુટર ̐સ˶મનુ ંસંચાલન કરે છે. 

 ત ેઇનપુટ ડેટા ǐાʏ કરીને, CPUના અʈ ભાગાે અને મેમરી સાથે ɔાં સુધી ǐ̋ƿયા કરે છે, ȱાં સુધી 
અં̍ તમ અાઉટપટુ ǐાʏ ન થાય. 

 CU ǐાેǁામની સુચનાઅાેને ડીકાેડ (Decode) કરે છે અને CPUના ̍વ̍વધ ભાગાે વȝે તાલમેલ 
˺ા̌પત કરે છે. 

3. ર̏જ˶સƙ (Registers) 

 ર̏જ˶સƙ અે કામચલાઉ મમેરી ˶ાેરેજ છે, જ ેCPUમાં જ અિƺતɗ ધરાવે છે. 

 ત ેઉȝ ગ̍તથી મા̋હતી ˶ાેર (Store) અને પનુઃǐાʏ (Retrieve) કરી શકે છે. 

 ર̏જ˶સƙ ̍વ̍વધ ǐકારના હાેય છે, જેમ કે સંયાેજન ર̏જ˶ર (Accumulator), ǐાેǁામ કાઉɰર 
(Program Counter), ઈƮ˷Ȇન ર̏જ˶ર (Instruction Register) વગેરે. 

CPU ના ǐકારાે 

CPU અલગ-અલગ ǐકારના હાેઈ શકે છે: 

1. ̐સ̬ગલ-કાેર CPU (Single-Core CPU): અેક સમયે અેક જ કાયƙ ǐાેસેસ કરી શકે છે. 

2. મ˄ી-કાેર CPU (Multi-Core CPU): અેક સાથે ઘણા કામ કરવા માટે સƖમ છે (Dual-Core, 
Quad-Core, Octa-Core). 

3. RISC (Reduced Instruction Set Computing): ઝડપી ǐ̋ƿયા માટે સરળ સુચનાઅાે પર કાયƙ 
કરે છે. 

4. CISC (Complex Instruction Set Computing): અેક સાથે ̍વ̍વધ જ̋ટલ સુચનાઅાે ǐાેસેસ કરી 
શકે છે. 

સƮેǇલ ǐાેસે̐સ̬ગ યુ̏નટ (CPU) અે કƳʔુટર ̐સ˶મનુ ં સાૈથી મહɗપૂણƙ ભાગ છે, જ ે કƳʔુટરના તમામ 
સુચનાકીય ǐ̋ƿયાઅાે માટે જવાબદાર છે. ALU, Control Unit અને Registers મળીને CPUનું કાયƙ ચલાવે 
છે. CPUની કામગીરી અને ગ̍ત, કƳʔુટરની કાયƙƖમતાને નǲી કરે છે. અાજના અાધુ̏નક યુગમાં, મ˄ી-કાેર 
ǐાેસેસસƙ અને ઉȝ ગ̍તવાળા CPU કƳʔુ̋ટ̬ગ Ɩમતામાં માેટા ફેરફારાે લાવી ર̈ા છે. 

 

4.2 ઈનપુટ ̋ડવાઈસ (Input Devices) 
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કƳʔૂટરની અદંર દાખલ કરવા માટેના અેકમને ઈનપુટ ̋ડવાઇસ કહે છે. જનેા ɦારા કƳʔટૂરમાં ડેટા કે 
સૂચનાઅાેનાે દાખલ (Input) કરવામાં અાવે છે. ઇનપુટ ઉપકરણાે કƳʔૂટર પર મા̋હતી અન ે̏નયંǋણ સંકેતા ે
અાપવા માટે વપરાય છે. અહ̯ અાપણ ેકƳʔૂટરના કેટલાંક અગɔના ઈનપુટ ̋ડવાઇસ ̍વશે મા̋હતી મેળવીશું.  
 

 કીબાડેƙ: કીબાડેƙ અે સાૈથી સામાʈ ઇનપુટ ઉપકરણ છે, જનેા 
માɪમથી લખાણ (Text), અાંકડા (Numbers), અન ે ̍વ̍વધ 
અાદેશાે કƳʔુટરમાં દાખલ કરી શકાય છે. તનેા માટે  A-Z, 0-9, 
F1 થી F12 ફંȆન કી અને ̍વ̏શˠ કીઅા ે (Ctrl, Alt, Shift, 
Enter) હાેય છે. અાજના સમયનંુ કીબાેડƙ QWERTY ફાેમ̳ટ પર 
અાધા̋રત હાેય છે.  
 

 
કી-બાેડƙ  

માઉસ: માઉસ અેક પાેઈ̔ɰ̬ગ ̋ડવાઈસ છે, જનેા માɪમથી 
˲ીન પર કસƙર ખસેડી શકાય છે. સામાʈ રીત,ે માઉસ પર ડાબા 
અને જમણા બટન નામના બ ેબટન, અને ˲ાલે બાર મɪમા ં
હાેય છે. માઉસ ˲ીન પર કસƙર ̗˺̍ત ̏નયંǋણ કરવા માટે 
વાપરી શકાય છે. તે ̚ȃક, ડબલ ̚ȃક, ǉેગ અને ǉાેપ જવેી 
̋ƿયાઅાે માટે વપરાય છે. કેટલાક માઉસમાં ˲ ાેલ ̊ ીલ પણ હાેય 
છે, જનેા ઉપયાેગથી પેજ ઉપર નીચે કરવાે સરળ બને છે. 

 
માઉસ 

  
̀ેય̔˶ક: ̀ેય̔˶ક માેનીટરની  ˲ીન પર કસƙરનું ˺ાન 
ખસેડવા માટે ઉપયાેગી છે. ̀ેય̔˶ક તમામ ̋દશામાં ખસેડી 
શકાય છે. ̀ેય̔˶કનું કાયƙ માઉસ સમાન છે. તેનાે ઉપયાેગ 
મȕુɗે ગે̌મ̬ગ અને ưલાઇટ ̐સʸુલેટરમાં થાય છે. તમેાં ̋દશા 
̏નયં̍ǋત કરવા માટે હેɱલ હાેય છે અને કેટલીક વખત બટન 
પણ હાેય છે. 

 
̀ેય̔˶ક 

  
લાઇટ પેન:  લાઇટ પેન અ ેપેન જવંુે દેખાતું પાેઈ̔ɰ̬ગ ઉપકરણ 
છે, જ ેમાેનીટર ˲ીન પર મનૂેમાંથી ̍વકˍ પસંદ કરવા અથવા 
̎ચǋાે દાેરવા માટે ઉપયાેગમાં લેવાય છે. તેમાં અેક નાની નળી હાેય 
છે જમેાં અાે̐ ʍકલ ̐સ˶મ સમા̍વˠ હાેય છે. અા ̐સ˶મ ˲ીન 
પર ˾ શƙ કરતી વખતે સ̋ƿય થાય છે અને સીધંુ CPU સુધી સંકેત 
માેકલે છે, જેથી ઉપયાેગકતાƙની ̋ƿયાને કƳʔુટર અાેળખી શકે. 

 
લાઇટ પેન 

  
Ǉેક બાેલ:  Ǉેકબાેલ અે અેક ǐકારનું પાેઈ̔ɰ̬ગ ̋ ડવાઈસ છે, જનેાે 
ઉપયાેગ મુȕɗે ˲ીન પર કસƙરને ખસેડવા માટે થાય છે. તે 
માઉસથી થાેડીક ̑ભɿ રીતે કાયƙ કરે છે. માઉસને ચલાવવા માટે 
સપાટી પર ખસડેવાની જͅર પડે છે પરંતુ Ǉેકબાેલ ̗˺ર રહે છે  

Ǉેક બાૅલ 
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અને તેમાં રહેલી બાેલને અંગૂઠા કે અાંગળીથી ઘુમાવીને કસƙર 
ખસેડવામાં અાવે છે. 
  
˱ૅનર : ˱ેનર અેક ઉપકરણ છે જે ફાેટાે અથવા દƺતાવેજને 
˱ેન કરી ̋ડ̏જટલ ફાેમƙમાં કƳʔુટરમાં દાખલ કરે છે. ǐમાણપǋા,ે 
ફાેટાેǁાʟ અને દƺતાવે̀ેની નકલ બનાવવા માટે તેનાે ઉપયાેગ 
થાય છે. નકલ થઈ ગયેલ મા̋હતીમાં સાેફટવેરની મદદથી ફેરફાર 
કરી શકાય છે.  અાધુ̏ નક ˱ેનર અાેસીઅાર (OCR – Optical 
Character Recognition) ટેǽાેલાે͂  પણ સપાેટƙ કરે છે. 
 

 
˱ેનર 

̋ડ̏જટલાઈઝર: ̋ડ̏જટલાઈઝર ઇનપુટ ̋ડવાઈસ છે, જ ે
અેનાલાેગ મા̋હતી (જમે કે ̎ચǋ કે રેખા̎ચǋાે)ને ̋ડ̏જટલ 
̄ͅપમાં ͅ પાંત̋રત કરે છે. તનેાે ઉપયાેગ કƳʔુટર પર અાકૃ̍તઅા ે
કે ǁા̋ફȋ બનાવવા માટે થાય છે. ̋ ડ̏જટલાઈઝર ǁા̋ફȋ અને 
ǍƸય મા̋હતીને બાઈનરી ફામે̳ટમાં બદલે છે, જથેી કƳʔુટર તેને 
સમ͂ને ǐાેસેસ કરી શકે. અા ઉપકરણન ે̋ડ̏જટલાઈઝર ટેƱલેટ 
અથવા ǁા̋ફȋ ટેƱલેટ તરીકે પણ અાેળખવામાં અાવે છે. 

 
̋ડ̏જટલાઈઝર 

  
ટચ ˲ીન:  ટચ ˲ીન અ ે̋ડવાઈસ પણ છે અને ̋ડƺʕે પણ. 
˾શƙ ɦારા (̋ફ̬ગર કે ˶ાઇલસ પેનથી) યૂઝર ઇનપટુ અાપી શકે 
છે. ́ાટƙફાેન, ટેબલટે અને કેટલીક અɥતન લેપટાેપાેમા ં
ટચ˲ીન સામાʈ રીતે ̀ેવા મળે છે.   

ટચ ˲ીન 
  
માઇƿાેફાેન: માઇƿાેફાેન અવાજને ઇલેƛǇાે̏ નક ̐સȘલમા ં
ͅપાંત̋રત કરે છે. તેની મદદથી અાે̋ ડયા ેરેકાે̋ડ̮ગ, વાેઇસ કમાɱ, 
અાેનલાઇન ̌મ̋ટ̬ગ અન ે મી̋ડયા અે̋ ડ̋ટ̬ગ માટે અવાજ 
કƳʔુટરમાં દાખલ થાય છે. 

 
માઇƿાેફાેન 

  
મȘેે̋ટક ઇɬ કેરેǶર રીડર (MICR) :  MICR અે અવેી 
ટેકનાેલાે͂  છે જ ેબેɬાેમાં માેટી સંȕામાં ચેકની ઝડપથી ǐ̋ƿયા 
કરવા માટે ઉપયાેગી થાય છે. MICR માɪમથી ચેક પર છાપેલા 
બɬે કાેડ અને ચેક નંબર મશીન ɦારા સરળતાથી વાંચી શકાય 
છે. અા ǐ̋ƿયામાં મȘેે̋ટક ઇંકનાે ઉપયાગે થતાે હાેવાથી તેન ે
“મȘેે̋ટક ઇɬ કેરેǶર રેક̗Șશન” કહેવાય છે. MICRનાે મȕુ 
લાભ અે છે કે તે ચાેકસાઈ અને ઝડપથી મા̋હતી વાંચે છે, જ ે
બે̔ ɬ̬ગ ǐ̋ƿયામાં સમય બચાવે છે. 
 

 
MICR 
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અાૅ̑ ʍકલ કેરેǶર રીડર (OCR): OCR ̌ǐɰેડ લખાણ વાંચવા 
માટે ઉપયાેગી છે. OCR અાેʍીકલી અƖર ˱ેન કરે છે અન ે
મેમરી પર લખાણ સǁંહ કરે છે. 

 
OCR  

  
બાર કાડે રીડર : બાર કાેડ રીડર બાર કાેડેડ મા̋હતી (અાછા અન ે
ઘાટા રેખાઅાે ̄ ͅપમાં મા̋હતી) વાંચવા માટે ઉપયાેગી સાધન છે. 
બાર કાેડેડ મા̋હતી સામાʈ રીતે પƺુતકા,ે શાે̌પ̬ગ માેલમાં રાખેલ 
વƺતુમા વપરાય  છે. બાર કાડે રીડર બાર કાેડ ˱ેન કરે છે પછી 
અાˎાʈૂમે̋ રક મૂˑ માં તેને ફેરવે છે.  

બાર કાેડ રીડર 
  
અાે̑ ʍકલ માકƙ  રીડર (OMR): OMR પેન અથવા પે̘ʉલથી 
કરવામાં અાવેલ માકƙના ǐકાર અાેળખવા માટે ઉપયાેગી છે. થાેડા 
̍વકˍામેાંથી પસંદ કરેલ કે ̎ચ̋̆ત થયેલ માકƙને અાેળખવા માટે 
વપરાય છે. બહુ વૈક̕ˍક પરીƖાના (MCQ) જવાબની 
ચકાસણી માટે વ૫રાય છે. 

 
OMR 

  
બાયાેમે̋Ǉક ઉપકરણા:ે અા ઉપકરણાે માનવીના શારી̋રક ̎ચ̆ા ે
જમે કે અાંગળીના ̏નશાન (Fingerprint), અાખંની કીકી 
(Retina), અન ે ચહેરાને અાેળખવા માટે ઉપયાેગ થાય છે. તે 
સુરƖા અન ે અાેળખ માટે ઉપયાેગી છે (જમે કે અાધાર કાડƙ 
વે̋ર̋ફકેશન, ફાેન અનલાૅક વગેરે). 

 
  

વેબકેમ (Webcam): વબેકેમ ͂વંત છબીઅાે અથવા ̍વ̋ડયા ે
કƳʔુટરમાં ઇનપુટ કરવા માટે ઉપયાગેી છે. તે વી̋ડયાે કાે̏ લ̬ગ, 
અાેનલાઇન ȃાસ, લાઇવ ˷ી̌મ̬ગ અને ફેસ રેકાે̗ Șશન માટે 
ઉપયાેગ થાય છે. 
 

 
 

ઇનપુટ ̋ડવાઈ̐સસના ̍વના કƳʔુટર પર કાેઇ પણ કાયƙ શȂ નથી. અા ઉપકરણાે ɦારા અાપણે કƳʔુટરન ે
અાપણે શું ઇȞીય ેછે તે સમ̀વી શકીઅે છીઅ.ે ટેǽાલેાે͂ ના ̍વકાસ સાથે નવા ઇનપુટ ઉપકરણાે પણ 
̍વકાસ પામી ર̈ા છે જ ેઅાપણા કƳʔુ̋ટ̬ગ અનભુવને વધુ સરળ, ઝડપભયા̳ અન ેકુશળ બનાવે છે. 

4.3 અાઉટપુટ ̋ડવાઇસ (Output Devices) 
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કƳʔુટર અે અેક ઇલેƛǇાે̏ નક મશીન છે, જે ડેટા પર ǐ̋ƿયા કરીને ઉપયાેગી મા̋હતી અાપે છે. અા મા̋હતીન ે
દશાƙવવા માટે કƳʔુટરમાંથી બહાર અાવતી મા̋હતી (Output) માટે ખાસ ઉપકરણાેની જͅર પડે છે, જનેે 
અાઉટપુટ ̋ડવાઇસીસ કહેવામાં અાવે છે. અા ઉપકરણાે કƳʔુટરની અંદર ǐાેસેસ થયેલ મા̋હતીનું વાંચી શકાય 
તવેા ͅપમાં ફેરવે છે, જમે કે લખાણ, છબીઅાે, ɫ̏ન, ̍વ̋ડયાે વગેરે. 

માે̏નટર (Monitor) 

માે̏ નટર અે અેક મહɗપણૂƙ અાઉટપુટ ઉપકરણ છે, જ ે સુચના ǐમાણે મા̋હતી ˲ીન પર દશાƙવે છે. તે 
̍વƣયુઅલ અાઉટપુટ ̋ ડવાઇસ તરીકે અાેળખાય છે, અને તેમાં તમે લખાણ (Text), ̎ચǋાે (Images), ̍ વ̋ડયા,ે 
અે̏ નમેશન અને અʈ ǐકારની મા̋હતી ̀ેઈ શકાે છાે. માે̏ નટર યૂઝર અને કƳʔુટર વȝે સંવાદનંુ માɪમ છે. 
ȱારે અાપણે કાેઈ મા̋હતી ઇનપટુ કરીઅે છીઅે (જમે કે કીબાેડƙથી લખાણ), ɔારે તેનું પ̋રણામ માે̏નટર પર 
દેખાય છે. અાપણે કƳʔુટરમાં જ ેકામ કરીઅ ેછીઅે તે બધંુ માે̏નટર પર દેખાતું હાેવાથી, તેને Visual Interface 
પણ કહેવામાં અાવે છે. 

માે̏ નટરના મુȕ ǐકારા ે

1. CRT માે̏ નટર (Cathode Ray Tube Monitor) 

 અા માે̏ નટરાે જૂની પɡ̍ત મજુબના હાેય છે. 

 માેટા, ભારે અને વધુ ̍વજળી વાપરતા હાેય છે. 

 અાજ ેઅાેછા ̀ેવા મળે છે. 
 

2. LCD માે̏ નટર (Liquid Crystal Display) 

 પાતળા અન ેહળવા હાેય છે. 

 વીજળીનાે ઉપયાેગ અાેછાે કરે છે. 

 અાકારમાં સુંદર અને અાંખ માટે અારામદાયક હાેય છે.  

3. LED માે̏નટર (Light Emitting Diode) 

 LCD કરતા વધુ સુધારેલી ટેǽાેલાે͂  ધરાવે છે. 

 તે તેજ̄ી રંગાે અને વધુ ˾ˠતા અાપે છે. 

 વધુ વીજળીનાે બચાવ (અેનજ̰ અે̋ફ̏શઅɰ) કરે છે. 
 

4. OLED માે̏નટર (Organic LED) 

 વધારે ઊ̀ƙ બચાવ કરે છે અને ખૂબ ઊંચી Ȅાે̏ લટી ધરાવે છે. 

 ખૂબ પાતળા હાેય છે અને વૈ̍ વɪપૂણƙ ͆Ƹય ગુણવɇા અાપે છે. 

 હાલના સમયમાં ટાેચની તકનીક ગણાય છે.  

માે̏ નટરની ખા̐સયતા ે
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ગુણવɇા ̍વગત 

રેઝાેˑૂશન ˲ીન પર કેટલાં ̌પȋલ છે તે બતાવે છે – જટેલા વધ,ુ તેટલી ˾ˠતા વધારે 

સાઇઝ ઇંચમાં માપવામાં અાવે છે (જમે કે 15", 17", 21") 

રંગ Ɩમતા કાળા-સફેદથી લઈન ેલાખા ેરંગાે દશાƙવવાની Ɩમતા 

̋રǑેશ રેટ ˲ીન દર સેકંડે કેટલી વખત નવી થાય છે – વધુ હાેવા પર ǍƸયાે સારા દેખાય છે 

ટચ ˲ીન સપાેટƙ કેટલાક માે̏નટરાેમાં ˾શƙ ɦારા ̏નયંǋણ શȂ હાેય છે (Touch Screen Monitors) 

 

માે̏નટર અે કƳʔુટરનાે અɔતં મહɗપૂણƙ ભાગ છે. તે માનવ માટે મા̋હતી ̀ેઈ શકાય તેવી બનાવે છે. અાજ ે
ટેǽાેલાે͂ ના ̍વકાસ સાથ,ે માે̏ નટરાે વધુ પાતળા, ઊ̀ƙ બચાવનાર અને ઉȝ ગુણવɇાવાળા બʈા છે. 
˗ાવસા̍યક થી લઈને સામાʈ ઉપયાેગ સુધી માે̏નટર દરેક જƝયા પર અાવƸયક છે. 

̌ǐɰર (Printer) 

̌ǐɰર અે અેવું અાઉટપુટ ઉપકરણ છે જ ેકƳʔુટરમાં રહેલી મા̋હતીનંુ હાડƙ કાેપી (Hard Copy) ̄ͅપ અાપે 
છે. અેટલે કે, કƳʔટુરમાંના લખાણ, છબી કે ડેટાને કાગળ પર છાપી અાપે છે. તે મા̋હતીનંુ ͆Ƹયમાન અન ે
˺ાયી ̄ͅપ બનાવે છે જનેે સાચવી શકાય છે. 

અાઉટપુટ ઉપકરણાે ̍વના, કƳʔુટર ઉપયાેગકતાƙને તેની ǐાસેેસ કરેલી મા̋હતી બતાવી શકતું નથી. અાજના 
̋ડ͂ટલ યુગમાં માે̏નટર, ̌ǐɰર અન ે˾ીકર જવેા ઉપકરણાે માǋ ફર̏જયાત જ નહ̯, પણ અનુભવને સમૃɡ 
બનાવનાર સાધનાે બની ચȂૂા છે. દરેક ઉપકરણ પાતેાની જƝયા પર ̍વ̏શˠ અન ેઉપયાેગી છે. 

̌ǐɰર અાે̋ફસ, શાળા, કાેલેજ, હાૅ̖˾ટલ, બɬે વગેરેમા ં દƺતાવે̀ે અને ̋રપાેટ્ƙસ ̌ǐɰ કરવા માટે. ̐બલ, 
રસીદ, પરીƖા પેપસƙ, ફાેટા,ે ǁાફ વગેરે છાપવા માટે તેમજ કƳʔુટરમાં રહેલી મા̋હતી છાપવા માટે ખૂબ ઉપયાેગી 
છે. 

̌ǐɰરના મȕુ ǐકારા ે

1. ઇɬજેટ ̌ǐɰર (Inkjet Printer) 

 અા ̌ǐɰર નાના-નાના શાહી̐બ̬દુઅાે (ink droplets) છાંટી 
છાપે છે. 

 રંગીન છાપકામ માટે યાેƝય અને સƺતા હાેય છે. 

 ઘરમાં સામાʈ ઉપયાેગ માટે ખૂબ લાેક̌ǐય છે. 

 ધીમા ગ̍તના હાેય છે અને ઇંક ઝડપી ખૂટી ̀ય છે. 
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2. લેઝર ̌ǐɰર (Laser Printer) 

 લેઝર બીમ વડે ટાેનર પાવડર કાગળ પર છાપે છે. 

 ખૂબ ઝડપથી અને ઊંચી ગુણવɇાવાળું છાપકામ કરે છે. 

 અાે̋ફસ અને ̐બઝનેસ માટે Ǘેˤ ગણાય છે. 

 શ̈́અાતમાં મા̲ઘા હાયે છે, પણ લાંબા ગાળે ખચƙ બચાવે છે.  

3. ડાેટ મેઇ̋Ǉȋ ̌ǐɰર (Dot Matrix Printer) 

 અા મશીન ટકરાવથી છાપે છે, જમેાં સુયાે̏ જત ̌ પન કાગળ પર 
ધકેલાય છે. 

 ધીમું અને અવાજવાળું હાેય છે, પણ સતત ફાેમƙ (carbon 
copy) માટે ઉપયાેગી છે. 

 ખાસ કરીને બɬે કે રસીદના છાપકામ માટે વપરાય છે.  

4. થમƙલ ̌ǐɰર (Thermal Printer) 

 તાપમાનના અાધારે છાપે છે (̐બનશાહી પɡ̍ત). 

 ખાસ કરીને ATM રસીદ, શાે̌પ̬ગ ̐બલ, Ǉા̋ફક ચાલાન વગેરે 
માટે વપરાય છે. 

 તેજ અને શાંત છાપકામ માટે ̀ણીતું છે.  
 

̍વ̍વધ ǐકારના ̌ǐɰરનાે તફાવત  

ǐકાર છાપકામની 
પɡ̍ત 

ગુણવɇા ઝડપ ખચƙ ઉપયાેગ માટે 
યાƝેય 

ઇɬજટે શાહી છાંટીન ે ઊંચી મɪમ અાેછી ̋ક̬મત ઘરેલુ ઉપયાેગ, 
ફાેટા ે

લેઝર ટાેનર પાવડર વડે ખૂબ ઊંચી વધુ મા̲ધુ, પણ લાંબાગાળે 
સƺતુ ં

અાે̋ફસ, 
ડાȂેુમɰે 

ડાેટ 
મે̋ Ǉȋ 

̌પન વડે ટકરાવ નીચી ધીમી અાેછી રસીદ, ̐બ̏લ̬ગ 

થમƙલ ગરમી ɦારા મɪમ વધુ અાેછી રસીદ, ̐બલ 

 

̌ǐɰરની ̍વશેષતાઅા ે

 માેટા ભાગના ̌ǐɰરાે Windows / Mac / Linux અાધા̋રત અાેપરે̋ટ̬ગ ̐સ˶મમાં કાયƙ કરે છે. 
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 રંગીન અને Ʊલેક અેɱ ˚ાઇટ: ઘણાં ̌ǐɰરાે બંને ǐકારનુ ં̌ǐɰ̯ગ સપાેટƙ કરે છે. 

 વાયરલેસ કનેȆન: અાજકાલના ́ાટƙ ̌ǐɰરાે Wi-Fi, Bluetooth વડે પણ કાયƙ કરે છે. 

 મ̔˄ફંȆન ̌ǐɰર: કેટલાક ̌ǐɰરાે ˱ેન, ફેȋ અને કાેપી પણ કરી શકે છે. 

 

̌ǐɰર અે કƳʔુટર ̐સ˶મનું અેક અગɔનું ઉપકરણ છે, જ ે̋ડ̏જટલ મા̋હતીને કાગળ પર છાપી કાયƙƖમ 
અને ઉપયાેગી બનાવે છે. અાપણી દૈ̏નક જ̋ͅરયાતાે માટે ˗̘Ǹગત ઉપયાેગથી માંડીન ેઉɥાેગલƖી જͅરીયાત 
માટે ̍વ̍વધ ǐકારના ̌ǐɰરાે ઉપલʤ છે. . ટેકનાેલાે͂ સાથે ̌ǐɰસƙ વધુ ́ાટƙ, ઝડપી અને ̋કફાયતી બʈા 
છે. 

ʕાેટર (Plotter) 

ʕાેટર અે અેક ̍વ̏શˠ ǐકારનું ̌ǐ̔ɰ̬ગ ઉપકરણ છે, જ ે માેટા કદના ટેક̏નકલ ̎ચǋા,ે ǁાʟ અને 
અƮે͂નીયર̯ગ ǉાેઈંƝસને ચાકેસાઈપૂવƙક છાપવા માટે ઉપયાેગમાં લેવાય છે. સામાʈ ̌ǐɰર કરતાં ʕાટેર વધુ  
̍વગતવાર છાપકામ કરે છે. તે મુȕɗે શાહી કે પેનની મદદથી દƺતાવે̀ે છાપે છે, જથેી રેખાઅાે તથા અાકારા ે
ખૂબ જ ˾ˠ દેખાય છે. ʕાેટરના મુȕ બે ǐકાર છે: ưલટેબેડ ʕાેટર અને ǉમ ʕાટેર. ưલેટબેડ ʕાેટરમાં 
કાગળ ̗˺ર રહે છે અને પેન હલતી હાેય છે, ȱારે ǉમ ʕાટેરમાં કાગળ ǉમ ઉપર લપેટાયેલંુ હાેય છે અને પેન 
તેને અનુસરીને હલતી રહે છે. ʕાેટરનાે ઉપયાેગ ખાસ કરીને અેƮ͂નીયર̯ગ ǉાેઈંƝસ (જવેી કે AutoCAD), 
અા̋ક̭ટેǴરલ ̋ડઝાઇન, નકશા અને Ʊલુ̌ǐɰ્સ છાપવા માટે થાય છે. ઉપરાંત, તેનાે ઉપયાેગ માેટા કદના 
બેનર અને પાે˶સƙ છાપવા માટે પણ ˗ાપકપણે થાય છે. 

˾ીકર (Speaker) 

˾ીકર અે અેક મહɗપણૂƙ અાઉટપુટ ઉપકરણ છે, જ ે
કƳʔુટરના સાઉɱ કાડƙ ɦારા ǐાʏ થતા ̋ડ̏જટલ અાે̋ ડયાેને 
ɫ̏નમાં પ̋રવ̍ત̭ત કરે છે. અા ઉપકરણની મદદથી કƳʔુટરથી 
ઊɎɿ થતી તમામ ǐકારની અાૅ̋ડયાે ̀ણકારી જેમ કે સગંીત, 
વાેઈસ મેસેજ, વી̋ડયાે સાઉɱ, અને ̐સ˶મ અેલટ્ƙસ અાપણે 
˾ˠ રીતે સાંભળી શકીઅે છીઅે. ˾ીકર મ˄ી̌મડીયા માટે 
અɔંત ઉપયાેગી છે અને તેનાે ̍વ̍વધ Ɩેǋાેમાં ̍ વશાળ ǐમાણમા ં
ઉપયાેગ થાય છે. ˾ીકરાે ઘણા ǐકારના હાેય છે જમે કે 2.0 
(બે̏ ઝક ˶ી̋રયાે), 2.1 (બેઝ સાથે), 5.1 અને 7.1 ચેનલ ̐સ˶ʼ 
જ ેɫ̏ન ǐદાન કરે છે. તેનાે ઉપયાેગ અાેનલાઈન ȃાસીસ માટે 
અાે̋ડયાે સમજવા, ̋ફːાે ̀ેવાની મ̀ માણવા, સંગીત 
સાંભળવા તેમજ અેલામƙ કે નાે̋ટ̋ફકેશન અવાજ તરીકે થાય છે. 
˾ીકર ગે̌ મ̬ગ અનુભવને વધુ રાેમાંચક પણ બનાવે છે. 

 

હેડફાેન (Headphone) 
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હેડફાેન અે અેક પસƙનલ અાે̋ડયાે અાઉટપુટ ઉપકરણ છે, જેને 
વપરાશકતાƙ સીધા પાેતાના કાન પર પહેરી શકે છે અને કƳʔુટર, 
માેબાઈલ કે અʈ ઉપકરણમાંથી મળતા ɫ̏નને ˾ˠ અન ે
અવરાેધર̋હત સાંભળી શકે છે. હેડફાેન, ˾ ીકરનાે ̠ ̘Ǹગત ̍ વકˍ 
છે અને તેનાે ઉપયાેગ ખાસ કરીને ɔારે થાય છે ȱારે ˗̘Ǹગત 
અવાજ સાભંળવાે જͅરી હાેય અથવા અાસપાસના લાેકાેને અવાજથી 
̍વƖેપ ન થવાે ̀ેઈઅે. હેડફાેનના ̍વ̍વધ ǐકારામેાં ઇયરફાેન સાૈથી 
નાના કદના હાેય છે અને સીધા કાનની અંદર મૂકી શકાય છે. અાેવર-
ઇયર હેડફાેન માટેા કદના હાયે છે, Ǘેˤ સાઉɱ ગુણવɇા અાપે છે 
અને નાેઈઝ કેʉ̏લ̬ગ જવેી સુ̍ વધાઅાે ધરાવે છે. વાયરલસે હેડફાેન 
Ʊલૂટૂથ ɦારા ઉપકરણ સાથે કનેǶ થાય છે, જ ેવધુ ગ̍તશીલતા અને 
સરળતાથી ઉપયાેગ કરવાની સુ̍વધા અાપે છે. હેડફાેનનાે ઉપયાેગ 
શાં̍તથી સંગીત સાંભળવા, અાેનલાઈન મી̋ટ̬ગ કે કાેલમાં સંભાષણ  
માટે, તમેજ પિƱલક જƝયાઅે ગે̌ મ̬ગ કે વી̋ડયાે ̀ેવા માટે ˗ાપક 
ǐમાણમાં થાય છે. 

 

 

ǐાેજેǶર (Projector) 

ǐાેજǶેર અે અેવું અાઉટપટુ ઉપકરણ છે, જ ેકƳʔુટરમાં રહેલા 
̍વ̋ડઅાે અાઉટપટુને માેટી ˲ીન કે ̋દવાલ પર ǐદ̏શ̭ત કરે છે. 
તેની મદદથી નાના ˲ીનના કɰેɰને ̍વશાળ ǐેƖકાે સુધી 
પહા̲ચાડવાે સરળ બને છે. અા ઉપકરણ ખાસ કરીને ̏શƖણ, 
ǐેઝɰેશન, ̌મ̋ટ̬ગ અને મનારંેજન માટે ઉપયાેગી છે. 

 ǐાેજǶેરના મુȕ ǋણ ǐકારાે છે: DLP (Digital Light 
Processing) ǐાેજǶેર, જ ે તેજ અને ˾ˠ ઇમેજ અાપે છે; 
LCD (Liquid Crystal Display) ǐાેજǶેર, જ ેરંગાેની ઊંચી 
ગુણવɇા માટે ̀ણીતા છે; અને LED ǐાેજǶેર, જ ેઊ̀ƙ બચત અને લાંબી અાયુˮ  ધરાવે છે. ǐાેજǶેરના ે
ઉપયાેગ શાળા, કાેલેજ અને અાે̋ફસમાં શƖૈ̒ણક અને ˗ાવસા̍યક ǐેઝɰેશન માટે થાય છે. ઉપરાંત, ઘરમાં 
હાેમ ̎થયેટર તરીકે ̋ફːાે ̀વેા માટે અને કાૅʃરʉ તેમજ સેમીનારમાં માેટી ˲ીન પર મા̋હતી રજૂ કરવા માટે 
પણ તેનાે ˗ાપક ઉપયાેગ થાય છે. 

4.4 કƳʔુટર મેમરી (Computer Memory) 

કƳʔુટર મેમરી શું છે? 

કƳʔુટર મેમરી અે અેવી જƝયા છે ȱાં કƳʔુટર જͅરી મા̋હતી (Data), સૂચનાઅાે (Instructions) અને 
ǐાેસેસ કરાયેલ પ̋રણામાેને સાચવે છે. કƳʔુટરમાં કાેઈપણ ǐકારનું કાયƙ કરવા માટે મા̋હતીની જͅર હાેય છે  
અને અા મા̋હતી મમેરી ɦારા સીપીયુ (CPU) સુધી પહા̲ચાડવામાં અાવે છે. જેમ અાપણે વƺતુઅાે યાદ રાખવા 
માટે મગજનાે ઉપયાેગ કરીઅે છીઅે, અે જ રીતે કƳʔુટર મા̋હતી “મેમરી”માં સાચવે છે. 
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કƳʔુટર મેમરીના ઘણા મહɗપૂણƙ કાયા̳ હાયે છે, જ ેકƳʔુટર ̐સ˶મના કાયƙ માટે અાધારભૂત છે. ǐથમ, મમેરી 
મા̋હતી (Data) અને સૂચનાઅાે (Instructions)ને ˶ાેર કરે છે, જથેી ȱારે પણ જͅર પડે ɔારે CPU તેને 
મેળવી શકે. અા મા̋હતીમાં વપરાશકતાƙ ɦારા દાખલ કરાયલે ડેટા તેમજ ǐાǁેામ ɦારા અાપેલી સૂચનાઅાે શામેલ 
હાેય છે.  

બીજંુ કાયƙ અે છે કે, મેમરી અા સૂચનાઅાેને કામ દરʸાન યાદ રાખે છે જથેી ǐાેસેસ દર̌મયાન કાેઈ ̍વƖેપ ન 
થાય. ȱારે CPU મા̋હતી પર ǐાેસેસ કરે છે, ɔારે તે પ̋રણામાેને પણ કામચલાઉ રીત ે મેમરીમા ંસાચવે છે. 
છે˒ે, અા ǐાેસેસ કરેલી મા̋હતી અેટલ ેકે પ̋રણામ, યાેƝય રીતે યુઝર સુધી પહા̲ચાડવામાં અાવે છે, જમે કે ˲ ીન 
પર દશાƙવવામાં અાવે છે અથવા કાેઈ અાઉટપુટ ̋ડવાઇસ (Printer, Speaker વગેરે) મારફતે અાપવામાં અાવે 
છે. અા તમામ ǐ̋ƿયાઅાે મેમરીની મદદ વગર શȂ નથી. 

મેમરીના મુȕ બ ેǐકાર 

 
ǐાયમરી મમેરી (Primary Memory) 

અા મેમરી સીધી કƳʔટુરના મȕુ ǐાસેેસર (CPU) સાથ ે ̀ેડાયેલી હાયે છે. અેમા ં ડેટા ટંૂકા સમય માટે જ 
રાખવામાં અાવે છે. તેને "મેઈન મેમરી" પણ કહેવામાં અાવે છે. 

RAM – Random Access Memory 

 લƖણાે: 

o વાેલેટાઇલ મેમરી: કƳʔુટર બંધ કરાતાં મા̋હતી પણ ગુમ થઇ ̀ય છે. 

o મા̋હતી સીધા અૅȋેસ કરી શકાય છે (Randomly). 

o કાયƙ કરતા સમયે ઉપયાેગી. 

o વધુ RAM = વધુ ઝડપ અને અેકસાથે ઘણી અે̖ʕકેશʉ ચલાવવાનું શȂ થાય છે. 

કƳʔુટર મમેરી

ǐાથ̌મક મેમરી

RAM ROM

̋ɦ̍તયક મેમરી

HDD SSD USB CD/DVD
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 ઉદાહરણ: ȱારે તમે Word, Excel અને Chrome અેકસાથે ખાેલાે છાે ɔારે તે બધા ǐાેǁામ RAMમા ં
લાેડ થાય છે. 

ROM – Read Only Memory 

 લƖણાે: 

o નાેન-વાેલેટાઇલ: મેમરી બંધ થયા પછી પણ મા̋હતી સચવાઈ રહે છે. 

o માǋ વાંચી શકાય તેવી મા̋હતી હાેય છે, સામાʈ રીતે બદલાઈ શકતી નથી. 

o કƳʔુટરને ‘on’ કરવાના સમયે BIOS/Startup Program અ̋હ̬થી ચાલે છે. 

 ઉદાહરણ: કƳʔુટર શͅ થતી વખતે ચકાસણી માટે BIOS ǐાેǁામ ROMમાંથી ચાલે છે. 

 

સેકɱરી મેમરી (Secondary Memory) 

સેકɱરી મેમરી (Secondary Memory) અે કƳʔુટર ̐સ˶મની અેવી મેમરી છે જ ેમા̋હતીનું લાંબાગાળા માટે 
સǁંહ કરવાનું ˺ાન પૂͅં પાડે છે. ȱારે ǐાથ̌મક મેમરી (જમે કે RAM) હંગામી મા̋હતી માટે હાેય છે, ɔારે 
સેકɱરી મેમરી કƳʔુટર બંધ થયા પછી પણ મા̋હતી યથાવત રાખે છે. અા મેમરીનાે ઉપયાેગ દƺતાવે̀,ે 
ફાેટાેǁાʟ, વી̋ડયાેઝ, ǐાǁેાʼ અને ̍વ̍વધ ǐકારની ફાઇલાેને હંમેશા માટે સંǁ̋હત કરવા માટે થાય છે. 

સેકɱરી મેમરીના લƖણાે: 

લƖણ વણƙન 

˶ાેરેજ Ɩમતા માેટી માǋામાં મા̋હતી ˶ાેર કરવાની Ɩમતા હાેય છે (GB થી TB સુધી). 

નાેન-વાેલેટાઇલ કƳʔુટર બંધ કયાƙ પછી પણ મા̋હતી યથાવત રહે છે. 

સƺતું ̍વકˍ ǐાથ̌મક મેમરીની તુલનામાં વધુ Ɩમતા અને અાેછા ખચ̳ મળ ેછે. 

ધીમી ગ̍ત RAM કરતાં થાેડી ધીમી ગ̍ત હાેય છે, પરંતુ વધુ ˺ાયી. 

 

Hard Disk Drive (HDD): 

 પરંપરાગત ˶ાેરેજ ઉપકરણ. 

 ઘૂમતા મȘેે̋ટક ʕેટસƙ વડે મા̋હતી સાચવે છે. 

 500GB થી લઈને અનેક TB સુધીની Ɩમતા. 

 ધીમી પણ ̍વ˝સનીય.  
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Solid State Drive (SSD): 

 નવી ટેǽાલેાે͂  અાધા̋રત ˶ાેરેજ. 

 કાેઈ યાં̍ǋક ભાગાે નથી તેથી ઝડપથી મા̋હતી વાંચી અને 
લખી શકે છે. 

 ખૂબ જ ઝડપી બૂ̋ ટ̬ગ અન ેલાે̋ડ̬ગ ˾ીડ. 

 હવે માટેાભાગના લેપટાેપ અને PCમાં SSD નાે ઉપયાગે થાય 
છે.  

Pen Drive (USB Flash Drive): 

 નાના કદનું પાેટ̳બલ ˶ાેરેજ. 

 મા̋હતીને અેક જƝયાઅેથી બી͂ જƝયાઅે લઇ જવા માટે ખબૂ 
જ ઉપયાેગી. 

 4GB થી 1TB સુધી ઉપલʤ. 

 ˱ૂલ, અાે̋ફસ અને પસƙનલ ઉપયાેગ માટે યાેƝય. 

 

Memory Card (SD Card): 

 ́ાટƙફાેન, કેમેરા, ટીવી વગેરેમાં વપરાય છે. 

 ફાેટાે, વી̋ડયાે અને અે̖ʕકેશનના ડેટા માટે ઉપયાેગી. 

 નાના કદમાં માેટી Ɩમતા. 
 

CD/DVD (Optical Disk): 

 Circular disk જમેાં મા̋હતી લેઝર ɦારા લખાય છે અને 
વંચાય છે. 

 CD માં અંદાજે 700 MB અને DVD માં લગભગ 4.7 GB સુધી 
મા̋હતી રાખી શકાય છે. 

 હવે અાેછંુ વપરાય છે, પરંતુ અગાઉ બહુ લાકે̌ǐય હતા. 

 

External Hard Drive: 

 પાેટ̳બલ hard disk જે USB કે Thunderbolt ɦારા ̀ેડાય 
છે. 

 માેટા ǐમાણમાં ડેટાનંુ બેકઅપ રાખવા માટે ઉપયાેગી. 

 મા̋હતી વહન કરવા માટે ખૂબ સારી. 
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સેકɱરી મેમરી અે કƳʔુટરમા ંમા̋હતીના લાંબા ગાળાના સંǁહ માટે અɔંત અાવƸયક છે. તેનું ઉપયાેગ ǐɔƖ 
રીતે અાપણાં રાે̏ જ̬દા ͂વનમાં થાય છે જમેાં તમે ફાટેા સવે કરાે છાે, ગીતાે સાંભળાે છાે, વી̋ડયાે જુઅાે છાે, કે 
તમારા દƺતાવે̀ ે સંǁ̋હત કરાે છાે. જમે જમે ટેકનાેલાે͂ ̍વકસે છે, તેમ તેમ સેકɱરી મેમરીના ઉપકરણાે વધુ 
ઝડપથી, વધુ Ɩમતા સાથે અને વધુ નાનાં કદમાં ઉપલʤ થાય છે. 

5. હાડƙવેર અને સાેʘવેરનાે ȕાલ Concept of Hardware and Software) 

કƳʔુટર ̐સ˶મના બે અાધારભૂત ઘટકાે છે હાડƙવેર (Hardware) અને સાેʘવેર (Software). કƳʔુટર 
યાેƝય રીતે કામ કરી શકે તે માટે અા બંને ભાગાે સાથે મળીને કાયƙ કરે છે. હાડƙવેર ̍વના સાેʘવેર કામ નહ̯ કરે 
અને સાʘેવેર ̍વના હાડƙવેર ̏ન̒˟ય બની ̀ય. ચાલાે, અા બંનેના અથƙ અને ઉપયાેગને ̍વગતે સમ͂અે. 

હાડƙવેર (Hardware) શું છે? 

હાડƙવેર અે કƳʔુટરનાે ̀ેઈ (visible) અને ˾શƙ (touchable) કરી શકાય તેવાે ભાગ છે. કƳʔુટર ̐સ˶મમા ં
જ ેભાૈ̍ તક ઘટકાે હાેય છે જનેાે ઉપયાેગ મા̋હતી મેળવવા, સંભાળવા અને દશાƙવવા માટે થાય છે, તેને હાડƙવેર 
કહેવાય છે. 

ઉદાહરણ તરીકે: 

 ઇનપુટ ̋ડવાઈસ: કીબાેડƙ, માઉસ, ˱ેનર 

 અાઉટપુટ ̋ડવાઈસ: માે̏નટર, ̌ǐɰર, ˾ીકર 

 ǐાેસે̐ સ̬ગ ̋ડવાઈસ: સƮેǇલ ǐાેસે̐સ̬ગ યુ̏ નટ (CPU) 

 ˶ાેરેજ ઉપકરણાે: Hard Disk, SSD, Pen Drive 

હાડƙવેર અે કƳʔુટરનંુ અે “શરીર” છે, જનેા ɦારા તમામ કામગીરી ભાૈ̍તક રીતે શȂ બને છે. 

સાેʘવેર (Software) શું છે? 

સાેʘવેર અે સૂચનાઅાેનાે (instructions) અથવા ǐાેǁાʼનાે સમૂહ છે, જ ેકƳʔુટરને જણાવે છે કે તેને શંુ 
કરવંુ અને કેવી રીતે કરવું. અʈ શʣાેમાં કહીઅે તા,ે સાેʘવેર અે કƳʔુટર માટે "બુ̏ɡ" પૂરી પાડે છે. ત ે
અાંકડાઅાે પર ǐ̋ƿયા કરે છે અને ઇનપુટને અાઉટપટુમાં ફેરવે છે. 

સાેʘવેર મુȕɗે બે ǐકારના હાેય છે: 

1. ̐સ˶મ સાʘેવેર (System Software): 

o અાેપરે̋ટ̬ગ ̐સ˶મ (OS): Windows, Linux, Mac OS 

o કƳʔુટર અને હાડƙવેરને ̏નયં̍ǋત કરે છે. 

o અʈ તમામ સાેʘવેરને કામ કરવા માટે માળખંુ પૂ̈́ં પાડે છે. 

2. અે̖ ʕકેશન સાેʘવેર (Application Software): 

o વપરાશકતાƙઅાેની ̍વ̏શˠ જ̋ͅરયાતાે માટે બનાવવામાં અાવે છે. 

o ઉદાહરણ: MS Word, Excel, Photoshop, Tally, VLC Media Player 

 હાડƙવેર અને સાેʘવેર વȝેનાે તફાવત  
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ƿમ હાડƙવેર (Hardware) સાેʘવેર (Software) 

1 ભાૈ̍તક ઘટકાે છે જનેે ̀ઈે અને ˾શ̰ 
શકાય 

અભાૈ̍ તક ઘટકાે છે જનેે ̀ેઈ અથવા ˾શ̰ શકાય 
નહ̯ 

2 તૂટી શકે છે અથવા નˠ થઈ શકે છે વાયરસ અથવા ભૂલથી બગડી શકે છે 

3 માે̏નટર, માઉસ, કીબાેડƙ, ̌ǐɰર વગેરે Windows, MS Office, Photoshop, Tally વગેરે 

4 અેકવાર ખરીɥા પછી ખાસ બદલાતા નથી વારંવાર અપડેટ અથવા અપǁેડ કરી શકાય છે 

5 તેનું કાયƙ સાેʘવેરના માગƙદશƙન હેઠળ થાય 
છે 

હાડƙવેર ઉપર કાયƙરત રહે છે 

 

હાડƙવેર અને સાેʘવેર કƳʔુટર ̐સ˶મના બે અગɔના પાયા છે. હાડƙવેર ̍વના સાેʘવેર કાયƙ નથી કરી શકતંુ 
અને સાેʘવેર ̍ વના હાડƙવેર ̏ ન̒˟ય છે. બંનેના સહયાેગથી કƳʔુટર અેક કાયƙƖમ સાધન બને છે, જે અાજના 
ડી͂ટલ જગત માટે અ̏નવાયƙ છે. 

 

5.1 હાડƙવેર (Hardware) 

હાડƙવેર અે કƳʔુટર ̐સ˶મનાે ભાૈ̍ તક (Physical) અને ̀ેઈ શકાય તેવાે (Visible) ભાગ છે. કƳʔુટર સાથ ે
સંકળાયેલા બધા સાધનાે કે ઉપકરણાે જનેે ˾શ̰ શકાય છે અને ̀ેઈ શકાય છે તેને હાડƙવેર કહેવામાં અાવે 
છે. હાડƙવેર ̍વના કƳʔુટર કાયƙ કરી શકતું નથી કારણ કે તે સાેʘવેર ɦારા અાપલેી સૂચનાઅાેને અમલ કરે છે. 

હાડƙવેરના મુȕ ઉɠેશાે છે: 

 મા̋હતીનંુ ઇનપુટ (Input) લેવા 

 મા̋હતી પર ǐ̋ƿયા (Processing) કરવી 

 અાઉટપુટ (Output) અાપવું 

 મા̋હતીનાે સંǁહ (Storage) કરવાે 

હાડƙવેરના મુȕ ǐકારાે: 

1. ઇનપુટ ઉપકરણાે (Input Devices): વપરાશકતાƙ કƳʔુટરને જ ેમા̋હતી અાપે છે તે ઉપકરણાે ɦારા 
અાપવામાં અાવે છે. 

ઉદાહરણ: કીબાેડƙ, માઉસ, ˱ેનર, માઇƿાેફાેન 

2. ǐાેસે̐ સ̬ગ ઉપકરણ (Processing Device): અા કƳʔુટરનંુ મગજ કહેવાય છે જ ેઅાપેલી મા̋હતી 
પર કાયƙ કરે છે. 

ઉદાહરણ: સƮેǇલ ǐાેસે̐સ̬ગ યુ̏નટ (CPU) 

3. અાઉટપુટ ઉપકરણાે (Output Devices): મા̋હતીની ǐ̋ƿયા પછી જે પ̋રણામ મળતું હાેય તે 
વપરાશકતાƙને દશાƙવવાનાે ભાગ. 
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ઉદાહરણ: માે̏નટર, ̌ǐɰર, ˾ીકર 

4. ˶ાેરેજ ઉપકરણાે (Storage Devices): મા̋હતી અથવા ડેટાને લાંબા સમય સુધી રાખવા માટે અા 
હાડƙવેરના ેઉપયાેગ થાય છે. 

ઉદાહરણ: Hard Disk, SSD, CD/DVD, Pen Drive 

હાડƙવેરની ̍વશેષતાઅાે: 

 તેને ̀ેઈ શકાય છે અને ˾શ̰ શકાય છે. 

 તે તૂટી શકે છે અથવા ̏ન˫ળ થઇ શકે છે. 

 તે સાેʘવેર ɦારા ̏નયં̍ǋત થાય છે. 

 તેની ચાેકસાઈ અને કાયƙƖમતા સાેʘવેર પર અાધાર રાખે છે. 

હાડƙવેર કƳʔુટરનું મૂળભૂત અને અાવƸયક ઘટક છે. તે બધા ઉપકરણાે કે જનેા ɦારા કƳʔુટર મા̋હતી લે છે, 
તેના પર ǐ̋ƿયા કરે છે અને પ̋રણામ અાપે છે તે બધા હાડƙવેરમાં અાવરી લેવાય છે. હાડƙવેર ̍વના કƳʔુટર માǋ 
અેક ̏ન̒˟ય યંǋ હાેય છે. 

 

5.2 સાʘેવેર (Software) 

સાેʘવેર અે કƳʔુટર ̐સ˶મનાે અભાૈ̍તક (Non-Physical) ઘટક છે, જ ેકƳʔુટરને શંુ કરવું અને કેવી રીતે 
કરવંુ તે જણાવે છે. તે અેક ǐકારના ે ǐાેǁામ છે, જ ે સૂચનાઅાેના ͅપમાં કƳʔુટર સાથે સંચાર કરે છે અને 
હાડƙવેરને ̏નયં̍ǋત કરે છે. હાડƙવેર ̍વના સાેʘવેર કામ કરી શકતું નથી અને સાેʘવેર ̍વના હાડƙવેર ̏ન̒˟ય 
બની ̀ય છે. સાેʘવેર અે કƳʔુટરના મગજનું કાયƙ કરે છે, જ ેવપરાશકતાƙ અને કƳʔુટર હાડƙવેર વȝેનંુ 
માɪમ બને છે. 

સાેʘવેરના મુȕ ǐકારાે: 

1. ̐સ˶મ સાʘેવેર (System Software): અા ǐકારનું સાેʘવેર કƳʔુટર ̐સ˶મના હાડƙવેર અને અʈ 
સાેʘવેર વȝે સંકલન કરે છે. 

ઉદાહરણ: Windows, Linux, macOS, Device Drivers, Utility Software 

2. અે̖ ʕકેશન સાેʘવેર (Application Software): વપરાશકતાƙની ચાેǲસ જ̋ͅરયાતાે માટે ̋ડઝાઇન 
થયેલ સાેʘવેર. 

ઉદાહરણ: MS Word, Excel, Tally, Photoshop, Browsers (Chrome, Firefox) 

3. ǐાǁેા̍મ̬ગ સાેʘવેર (Programming Software): ǐાǁેામ બનાવવા માટે ઉપયાેગમાં લેવાતા સાેʘવેર.  

ઉદાહરણ: C, C++, Java, Python, Compiler, Editor 

સાેʘવેરની ̍વશેષતાઅા:ે 

 ˾શ̰ શકાય ન̋હ (અભાૈ̍તક). 

 વારંવાર અપડેટ અથવા સુધારણા કરી શકાય. 
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 હાડƙવેરના કાયƙ માટે અ̏નવાયƙ છે. 

 યુઝર ઇɰરફેસ ǐદાન કરે છે. 

 બƝસ અને વાયરસથી અસર પામી શકે છે. 

સાેʘવેર અે કƳʔટુરને કાયƙƖમ બનાવતું માɪમ છે. હાડƙવેર તાે માǋ અેક યાં̍ ǋક માળખંુ છે, પરંતુ સાેʘવેર 
અે છે જ ેતેને “બુ̏ɡ” અાપ ેછે. અાજના યુગમાં દરેક ફીˆ જવેા કે ̏શƖણ, ˗વસાય, મનાેરંજન, અારાેƝય 
વગરેેમાં સાેʘવેરનાે ˗ાપક ઉપયાેગ થાય છે. 

5.2.1 અે̖ ʕકેશન સાેʘવેર (Application Software) 

અે̖ ʕકેશન સાʘેવેર અે ખાસ કાયા̳ કરવા માટે બનાવવામાં અાવેલ સાેʘવેર છે જ ે વપરાશકતાƙની 
જ̋ͅરયાતાેને પૂણƙ કરે છે. અા સાેʘવેરનાે ઉપયાેગ અાપણા રાે̏જદ̬ા કાયા̳ માટે થાય છે જમે કે દƺતાવે̀ે 
બનાવવા, ગણતરી કરવા, ʸુ̏ઝક સાંભળવા વગરેે. 

મȕુ ǐકારા:ે 

1. જનરલ પપƙઝ અે̖ ʕકેશન (General Purpose Applications): રાજેબરાેજના કાયા̳ માટે. 
ઉદાહરણ: MS Word, Excel, PowerPoint 

2. ˾ે̐શયલ પપƙઝ અે̖ ʕકેશન (Special Purpose Applications): ચાેǲસ કાયƙ માટે બનાવેલ. 
ઉદાહરણ: Tally (̋હસાબ માટે), Photoshop (̋ડઝાઇન માટે), VLC Media Player 

3. ક˶માઇઝડ અે̖ ʕકેશન (Customized Applications): કાેઈ ખાસ સં˺ા કે ઉɥાેગ માટે ̍વ̏શˠ 
રીતે બનાવેલું સાેʘવેર. 

ઉદાહરણ: ˱ૂલ મેનેજમેɰ ̐સ˶મ, હાે̖ ˾ટલ મેનેજમેɰ સાેʘવેર 

અે̖ ʕકેશન સાેʘવેર અે છે જ ેકƳʔુટરને ઉપયાેગી બનાવે છે. તે અે બધાં કાયા̳માં મદદͅપ થાય છે જે અાપણે 
અાપણા રાે̏જ̬દા ͂વનમાં કƳʔુટરમાં કરતા હાેઈઅે છીઅ.ે 

5.2.2 ̐સ˶મ સાેʘવેર (System Software) 

̐સ˶મ સાેʘવેર અે કƳʔટુરના હાડƙવેર અને યુઝર વȝેનુ ંમાɪમ બને છે. તેનાે મુȕ ઉɠેશ હાડƙવેરના તમામ 
ઘટકાેને કાયƙƖમ બનાવવાનાે હાેય છે. અા ǐકારના સાેʘવેર કƳʔુટરના બધાં ભાગાેન ેસંચા̏લત કરે છે અને 
અʈ સાેʘવેરના ચાલવા માટે જͅરી વાતાવરણ (Environment) પૂ̈́ ં  પાડે છે. 

મȕુ ǐકારા:ે 

1. અાેપરે̋ટ̬ગ ̐સ˶મ (Operating System):જ ેસાʘેવેર કƳʔુટરને શ̈́ કરે છે અને તમામ ǐાǁેાʼ 
અને હાડƙવેરને સંચા̏લત કરે છે. 

ઉદાહરણ: Windows, Linux, macOS 

2. ̋ડવાઈસ ǉાઈવસƙ (Device Drivers): હાડƙવેર ઉપકરણાેને અાેપરે̋ટ̬ગ ̐સ˶મ સાથે ̀ેડવા માટેના 
સાેʘવેર. 
ઉદાહરણ: ̌ǐɰર ǉાઈવર, ǁા̋ફȋ કાડƙ ǉાઈવર 
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3. યૂ̋ટ̏લટી સાેʘવેર (Utility Software): કƳʔુટરની કાયƙƖમતા અને સુરƖા માટે ઉપયાેગી. 
ઉદાહરણ: Antivirus, Disk Cleaner, File Compression Tools 

̐સ˶મ સાેʘવેર ̍વના કƳʔુટરનું અાેપરેશન અશȂ છે. તે અે માળખંુ પૂ̈́ પાડી અાપે છે, જમેાં અʈ 
અે̖ ʕકેશન સાેʘવેર કામ કરી શકે. 

5.3 ǐાેǁા̍મ̬ગ ભાષા (Programming Language) 

કƳʔુટર માનવ ભાષા સમ͂ શકતું નથી. કƳʔુટરને કંઈક કાયƙ કરાવવું હાેય તાે અાપણે તેને ચાેǲસ રીતે 
લખેલી સૂચનાઅાે અાપવી પડે છે. અાવી સૂચનાઅાેને લખવા માટે જ ેભાષાનાે ઉપયાેગ થાય છે, તેન ેǐાǁેા̌મ̬ગ 
ભાષા કહેવામાં અાવે છે. ǐાǁેા̌મ̬ગ ભાષાઅાે અે કƳʔુટરને માગƙદશƙન અાપતી ભાષાઅાે છે, જનેા માɪમથી 
વપરાશકતાƙ કƳʔુટર માટે ǐાǁેામ લખી શકે છે. 

ǐાેǁા̍મ̬ગ ભાષાના ǐકારાે: 

1. મશીન ભાષા (Machine Language): 

o કƳʔુટર સમ͂ શકે અેવી સાૈથી પાયાની ભાષા. 

o માǋ 0 અને 1 (બાઇનરી) માં લખાયેલી હાેય છે. 

o ઉદાહરણ: 10110000 01100001 

2. અેસેr લી ભાષા (Assembly Language): 

o મશીન ભાષા કરતાં સરળ. 

o શાેટƙકાેડ્સ કે નેમાે̏ નȋ (Mnemonic codes) નાે ઉપયાેગ થાય છે. 

o ઉદાહરણ: MOV A, B 

o અા ભાષાને કƳʔુટર સમજ ેતે માટે અેસેʳલર (Assembler) ની જͅર પડે છે. 

3. ઉȝ ƺતરની ભાષા (High-Level Language): 

o માનવી માટે સમજવી સરળ. 

o English જવેી શʣાવલીનાે ઉપયાેગ થાય છે. 

o ઉદાહરણ: C, C++, Java, Python, Visual Basic 

o અાવા ǐાેǁામને કƳʔુટર સમજ ે તે માટે કʱાઇલર (Compiler) અથવા ઇɰરǐીટર 
(Interpreter) જͅરી છે. 

ǐȕાત ǐાેǁા̍મ̬ગ ભાષાઅાે: 

ભાષા ̍વશેષતા ઉપયાેગનંુ Ɩેǋ 

C ̐સ˶મ સાેʘવેર માટે ઉપયાેગી અાેપરે̋ટ̬ગ ̐સ˶મ 

C++ અાેʠǶે અાે̋રઅેɰેડ ગમે ડેવલપમેɰ 
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Java ʕેટફાેમƙ ઈ̒ɱપેɱɰ માેબાઈલ, વેબ અે̖ʕકેશન 

Python સરળ, માેડનƙ ડેટા સાયʉ, AI 

JavaScript વેબ ડેવલપમેɰ ǒાઉઝર અાધા̋રત અƯેસ 

 

ǐાǁેા̌મ̬ગ ભાષાઅાે કƳʔુટરને કાયƙ કરવાની Ɩમતા અાપે છે. અાજના ટેǽાેલાે͂ યુગમાં નવી નવી ભાષાઅા ે
̍વકાસ પામી રહી છે, જનેા ɦારા અાપણે સાʘેવેર, માેબાઇલ અેપ, વેબસાઇટ્સ, રાેબાટ્ેસ, AI ̐સ˶મ વગેરે 
બનાવી શકીઅે છીઅ.ે અેક સારી ǐાǁેા̌મ̬ગ ભાષા ઉપયાગેકતાƙને યાેƝય ̏નયંǋણ, સરળતા અને કાયƙƖમતા 
પૂરી પાડે છે. 

6. મા̋હતી/ડેટાની રજૂઅાત (Representation of Data/Information) 

કƳʔુટર માનવની ભાષા સમ͂ શકતંુ નથી. માનવ ɦારા અાપવામાં અાવતી મા̋હતી અને સૂચનાઅાે કƳʔુટર 
માટે ઉપયાેગી બને તે માટે તેને બાઇનરી ̄ͅપમાં ͅપાંત̋રત કરવી પડે છે. અા ǐ̋ƿયાન ેમા̋હતીની કƳʔુટરમા ં
રજૂઅાત કહેવામાં અાવે છે. કƳʔુટર મા̋હતી કે ડેટાન ે0 અને 1 ની Ǘેણી તરીકે જ અાેળખી શકે છે, જેને 
બાઇનરી ભાષા કહેવાય છે. 

 

કેમ બાઇનરી? 

કƳʔુટરનું ઝડપી અને ચાેકસાઈભયુ̫ કામગીરી કરતંુ માળખંુ માǋ બે ̗˺̍તઅા ેON (1) અને OFF (0) ને 
અાેળખી શકે છે. તેથી, સમǁ મા̋હતી બાઇનરી ̐સ˶મ પર અાધા̋રત છે. દરેક ǐકારની મા̋હતી છે˒ે 
બાઇનરીમાં જ ͅપાંત̋રત થાય છે. 

ડેટાના ̍વ̍વધ ǐકારાે અને તેમનંુ બાઇનરીમાં ͅપાંતરણ: 

અાંકડાઅાે 
(Numbers) 

અાંકડાઅાે સાૈથી સરળ ͅપમાં બાઇનરીમાં ͅપાંત̋રત થાય છે. 
ઉદાહરણ તરીકે: દશાંશ (Decimal) સȕંા 10 = બાઇનરી 1010 

અƖરાે 
(Characters) 

અƖરાેને કƳʔુટર અાેળખવા માટે દરેક અƖરને કાેઇ નǲી થયેલાે નંબર 
અાપવામાં અાવે છે. અા માટે ASCII (American Standard Code for 
Information Interchange) અને Unicode જવેી પɡ̍તઅાે ઉપયાેગ થાય છે. 

 ઉદાહરણ: A = ASCII કાેડ 65 = બાઇનરી 01000001 

 ઉદાહરણ: a = ASCII કાેડ 97 = બાઇનરી 01100001 

̍વ̐શˠ અƖરાે 
(Special 
Characters) 

જમે કે @, #, $, %, વગરેે પણ પાેતાના અનુƿમ કાેડ ધરાવે છે. 

ઉદાહરણ: @ = ASCII કાેડ 64 = બાઇનરી 01000000 
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̎ચǋાે અને ̍વ̋ડઅાે 
(Images and 
Videos) 

̎ચǋાે નાના નાના ̌પȋેલમાં ̍વભા͂ત હાેય છે. દરેક ̌પȋેલનાે રંગ તથા 
તેજ̗̄તા પણ સંȕાɒક ͅપમાં બતાવવામાં અાવે છે, અને તે સંȕાઅાે પણ 
બાઇનરી ̄ͅપમાં જ ˶ાેર થાય છે. ̍વ̋ડઅાે અે ̎ચǋાે અને ɫ̏નનાે સમૂહ હાેય 
છે. દરેક Ǒેમ (̎ચǋ) અને સાઉɱ ̚ȃપ બાઇનરીમાં ͅપાંત̋રત કરીને ˶ાેર થાય 
છે. 

અવાજ (Sound) અવાજને ̋ ડ̏જટલ બનાવવા માટે તેને સેɦ ̏લ̬ગ પɡ̍તથી ͅ પાંત̋રત કરવામાં અાવે 
છે. દરેક સેʱલની ̋ક̬મતને બાઇનરીમાં ˶ારે કરવામાં અાવે છે. 

 

અƖરાેને રજુ કરવાની પɡ̍તઅાે: 

1. ASCII (American Standard Code for Information Interchange): 

 7-̐બટ કાે̋ ડ̬ગ પɡ̍ત. 

 મુȕɗે અંǁે͂ અƖરાે અને સȕંાઅાે માટે ઉપયાેગી. 

 કુલ 128 અƖરાેને કવર કરે છે. 

2. Unicode: 

 વૈ̏ ˝ક ƺતરે ઉપયાેગ થતી પɡ̍ત. 

 અનેક ભાષાઅાે (ગુજરાતી, ̋હɹી, ચાઇનીઝ, વગરેે) ના અƖરાેને સમાવે છે. 

 દરેક અƖરને 16, 32 અથવા વધુ ̐બટ્સ સાથે રજૂ કરે છે. 

ડેટાને કƳʔુટરમાં યાેƝય રીતે રજૂ કરવા અે કƳʔુટરની કાયƙƖમતા માટે ખૂબ જ અાવƸયક છે. બાઇનરી ̐સ˶મ, 
ASCII અને Unicode જવેી પɡ̍તઅાે કƳʔુટરને ̍વ̍વધ ǐકારની મા̋હતી (અƖરાે, અવાજ, ̎ચǋા,ે ̍વડીયાે 
વગરેે) ને સમજવા અને ǐ̋ƿયા કરવા લાયક બનાવે છે. અા કારણે કƳʔુટર બહુમુખી સાધન તરીકે ̍વક̃ું છે. 

7. ડેટા ǐાેસે̐ સ̬ગની સંકˍના (Concept of Data processing) 

અાજના ̋ડ̏જટલ યુગમાં દરેક Ɩેǋમા ંમા̋હતીનું મહɊ ખૂબજ વધી ગયંુ છે. ઉɥાેગ, ̏શƖણ, અારાેƝય, બ̲̋ક̬ગ 
વગરેે Ɩેǋાેમાં ̍વશાળ માǋામાં મા̋હતી અેકǋ થાય છે. અા મા̋હતી ɔારે જ ઉપયાેગી બને છે ȱારે તેને યાેƝય 
રીતે ǐ̋ƿયા કરીને ઉપયાેગી મા̋હતી (Information) માં બદલી શકાય. અા સમǁ ǐ̋ƿયા ને ડેટા ǐાેસે̐સ̬ગ 
(Data Processing) કહેવાય છે. 

ડેટા અેટલે શંુ? 

ડેટા અે કાેઈપણ ǐકારની મા̋હતી હાેય છે, જમે કે સȕંાઅાે, શʣા,ે ̎ચǋાે કે અવાજ. ડેટા જયાં સુધી તેનંુ 
̍વƸલેષણ (Analysis) અને ǐ̋ƿયા (Processing) કરવામાં ન અાવે ɔાં સુધી અગɔના નથી . 

ઉદાહરણ: 
̍વɥાથ̰અાેના રાેલ નંબર અને ગુણનાે અʬાસ કરીઅે તાે માǋ રાેલ નંબર અને ગુણ અે ડેટા છે. ̀ે અાપણે 
તે ગુણને ઉમેરીઅે, સરેરાશ કાઢીઅે, Ǘેણી અાપીઅ ેતાે તે મા̋હતી (Information) બની જશે. 
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ડેટા ǐાેસે̐ સ̬ગ અેટલે શંુ? 

ડેટા ǐાેસે̐ સ̬ગ અે અેવી ǐ̋ƿયા છે જમેાં ડેટાને વૈƗા̏નક, તકƙસંગત અથવા અાંકડાકીય રીતથી સાચવવામાં અાવે 
છે, પ̋રવ̍ત̭ત કરવામાં અાવે છે અને ઉપયાેગી મા̋હ̍તમાં બદલીને ǐƺતુત કરવામાં અાવે છે. અામાં મુȕɗે 
નીચેના તબǲાઅાે હાેય છે: 

ડેટા ǐાેસે̐ સ̬ગના તબǲાઅાે (Steps of Data Processing): 

1. ઇનપુટ (Input): અા તબǲામાં ડેટાને કƳʔુટરમાં દાખલ કરવામાં અાવે છે. ઉદાહરણͅપ ેકીબાેડƙ, માઉસ, 
˱ેનર વગેરે ɦારા ડેટા દાખલ થાય છે. 

2. ǐાેસે̐ સ̬ગ (Processing): અા તબǲામાં કƳʔુટર ̍વ̍વધ કાયƙ કરે છે જમે કે સરવાળાે, બાદબાકી, 
સરેરાશ કાઢવી, વગ̰કરણ કરવું વગેરે. ડેટા પર ગા̒ણ̍તક અને તકƙસંગત ̏નયમાે લાગ ુકરવામાં અાવે છે. 

3. અાઉટપુટ (Output): ǐાેસેસ કયાƙ બાદ મળેલી મા̋હતી (Result) ને ˲ીન પર બતાવવી કે ̌ǐɰ કરીને 
ǐƺતુત કરવી. અા મા̋હતી ઉપયાેગકતાƙને યાેƝય ̏નણƙય લેવા માટે ઉપયાેગી બને છે. 

4. ˶ાેરેજ (Storage): ǐાેસેસ કરેલા ડેટાને ભા̍વ ઉપયાેગ માટે હાડƙ ̋ડ˱, પને ǉાઈવ, ȃાઉડ ˶ાેરેજ 
વગરેેમાં સંǁહ કરવામાં અાવે છે. 

ડેટા ǐાેસે̐ સ̬ગના ǐકારાે: 

1. મʈેુઅલ ડેટા ǐાેસે̐ સ̬ગ: માણસ ɦારા હાથથી મા̋હતી ǐ̋ƿયા કરવી. જમે કે ̋હસાબ લખવાે. 

2. મીકે̏નકલ ડેટા ǐાેસે̐ સ̬ગ: ગણતરી કરવા માટે કેˀુલેટર જવેા સાધનાેનાે ઉપયાેગ. 

3. ઇલેƛǇાે̏ નક ડેટા ǐાેસે̐ સ̬ગ (EDP): કƳʔુટર ɦારા ઝડપી અને સચાેટ મા̋હતી ǐ̋ƿયા. અા સાૈથી વધુ 
ઉપયાેગમાં લેવામાં અાવે છે. 

ડેટા ǐાેસે̐ સ̬ગના લાભાે: 

 ઝડપી કામગીરી: માેટા ǐમાણમાં મા̋હતી અેકસાથે અને ઝડપી રીતે ǐ̋ƿયા કરી શકાય છે. 

 શુɡતા (Accuracy): માનવીય ભૂલની શȂતા ઘટે છે. 

 સǁંહ Ɩમતા: માટેી મા̋હતી ̋ડ̏જટલ રીતે સરળતાથી સંǁહ કરી શકાય છે. 

 ̍વƸલેષણ માટે મદદͅપ: ̍વ̍વધ ǐકારના ̋રપાેટ્ƙસ અને ǁાફ ɦારા મા̋હતીના ઊંડા ̍વƸલેષણમાં મદદ મળે 
છે. 

ડેટા ǐાેસે̐ સ̬ગ અે અાધુ̏નક કƳʔુ̋ટ̬ગ ˗વ˺ાનાે અાધારભૂત ̋હ̅ાે છે. કાેઈ પણ Ɩેǋમાં સફળતા માટે સાચી 
મા̋હતીનંુ સચાેટ અને ઝડપથી મળવું અાવƸયક બને છે. ડેટા ǐાેસે̐ સ̬ગ ɦારા અાપણે અમૂˑ મા̋હતી મેળવી 
શકીઅે છીઅે, જ ે̍વ̍વધ ̏નણƙયાે લેવા માટે અાધારͅપ બને છે. 

8. ̌ǐɰર ઇʊાેલ કરવું (Installing a Printer)  

કƳʔુટરના ઉપયાેગ દર̌મયાન, દƺતાવે̀ ે, ફાેટાેǁાʟ અથવા અʈ મા̋હતીની હાડƙકાેપી બનાવવા માટે ̌ ǐɰર 
મહɗપૂણƙ ઉપકરણ છે. ̌ǐɰર યાેƝય રીતે ઇʊાેલ કરવું જͅરી છે જથેી તે સરળતાથી કƳʔુટર સાથે સંકળાય 
અને યાેƝય રીતે કાયƙ કરે. 
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̌ǐɰર ઇʊાેલેશનમાં બે મȕુ તબǲાઅાે હાેય છે: હાડƙવેર કનેȆન અન ેસાેʘવેર ઇʊાેલેશન. 

૧. હાડƙવેર કનેȆન 

ǐથમ તબǲામા,ં ̌ǐɰરને કƳʔુટર સાથે ̀ેડવું પડે છે: 

વાયડƙ કનȆેન: 

 USB કેબલ ɦારા ̌ǐɰરને કƳʔુટર સાથે ̀ેડાે. 

 કેબલ સારી રીતે લાગેલ છે તેની ખાતરી કરાે. 

વાયરલેસ કનેȆન: 

 વાઇફાઇ અથવા Ʊલૂટૂથ ɦારા ̌ǐɰર ̀ેડાય છે. 

 ̌ǐɰર અને કƳʔુટર બંને અકે જ નેટવકƙ  પર હાેવા ̀ેઈઅ.ે 

 જͅર પડે તાે ̌ǐɰરના નેટવકƙ  સે̋ટ̬Ɲસમાથંી Wi-Fi સેટઅપ કરાે. 

૨. સાેʘવેર ઇʊાેલેશન 

કƳʔુટરને ̌ǐɰર અાેળખાવવા માટે યાેƝય ǉાઇવર ઇʊાલે કરવું જͅરી છે: 

 චඡ અાેટાેમે̋ટક ǉાઇવર ઇʊાેલેશન: 

 Windows 10/11 અથવા MacOS જવેા અાધુ̏નક અાેપરે̋ટ̬ગ ̐સ˶ʼ માટેા ભાગે નવા ̋ડવાઇસને 
અાેળખીને અાપમેળે ǉાઇવર ઇʊાેલ કરે છે. 

 චඡ મʈેુઅલ ǉાઇવર ઇʊાેલેશન: 

 ̀ે અાેટાેમે̋ ટક ઇʊાેલેશન ન થાય, તાે ̌ǐɰર સાથે મળેલી CD થી અથવા ̌ǐɰરની વેબસાઇટ 
પરથી યાેƝય ǉાઇવર ડાઉનલાડે કરાે અને ઇʊાેલ કરાે. 

૩. ̌ǐɰર સેટઅપ પૂણƙ કરવુ ં

ǉાઇવર ઇʊાેલ થયા પછી નીચેના પગલાં લેવા: 

 චඡ ̌ǐɰર નામ તપાસાે: 

 Control Panel → Devices and Printers → ̌ǐɰરનું નામ ̀ેઈને ખાતરી કરાે કે ̌ǐɰર દેખાય 
છે. 

 චඡ ̋ડફાે˄ ̌ǐɰર સેટ કરા:ે 

 ̀ે તમારા કƳʔટુર સાથે અકેથી વધારે ̌ǐɰર ̀ેડાયેલા હાેય તાે યાેƝય ̌ǐɰરને ̋ડફાે˄  તરીકે સેટ 
કરાે. 

 චඡ ટે˶ પેજ ̌ǐɰ કરાે: 

 ̌ǐɰર સારી રીતે કામ કરે છે કે નહ̯ તે માટે ટે˶ પેજ ̌ǐɰ કરીને તપાસાે. 

૪. મહɗની બાબતા ે
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 ̌ǐɰર ǉાઇવર ̏નય̌મત રીતે અપડેટ કરતા રહાે જથેી નવી સુ̍વધાઅાે અન ેસલામતી માટે સપાેટƙ મળ.ે 

 વાયરલેસ ̌ǐɰર માટે નેટવકƙ નંુ સ̋ƿય અને મજબતૂ હાેવું જͅરી છે. 

 કેટલાક નવા માેડલામેાં માેબાઇલ અે̖ʕકેશનથી સીધું ̌ǐ̔ɰ̬ગ પણ શȂ છે. 

̌ǐɰર ઇʊાેલ કરવંુ અે સરળ પરંતુ મહɗપૂણƙ ǐ̋ƿયા છે. યાેƝય રીતે ઇʊાેલ કરેલા ̌ǐɰરથી તમે ઝડપી 
અને ઉȝ ગણુવɇાવાળા ̌ǐɰ મેળવી શકાે છાે. તે ̏શƖણ, અાે̋ ફસ કાયƙ, અને ઘરેલુ ઉપયાેગ માટે અ̏નવાયƙ 
સાધન બની ગયંુ છે. 

9. સારાંશ (Summary) 

અા અેકમમાં કƳʔુટર ̍વશે મૂળભૂત Ɨાન અાપવામાં અા˗ું છે. કƳʔુટરના પ̋રચયથી શͅઅાત કરીન,ે તેનાે 
ઇ̍તહાસ, ̍વકાસની ̍વ̍વધ પેઢીઅાે અને તેના ઉપયાેગના Ɩેǋાેની ̍વગતવાર સમજ અાપવામાં અાવી છે. 

 કƳʔુટર શંુ છે: કƳʔુટર અે અેક ઇલેƛǇાે̏ નક ઉપકરણ છે જે મા̋હતી મેળવવા, ǐાસેેસ કરવા અને ઉપયાેગી 
મા̋હતી તરીકે રજૂ કરવા માટે બનાવવામાં અા˗ું છે. 

 કƳʔુટરના ઇ̍તહાસ અને ̍વકાસ: અબાકસ, પા˱લાઈન, લે̐બ̏નઝ કેˀુલેટર અને અેના̏લ̋ટકલ 
અેિƮજન જવેા સાધનાેના ઉ˒ેખથી લઈને કƳʔુટરના પાંચ પેઢીઅાેના ̍વકાસ સુધીનાે ઇ̍તહાસ 
અાપવામાં અા˗ાે છે. 

 કƳʔુટર ̐સ˶મના લƖણાે: જમે કે ઝડપ, ચાેકસાઈ, અાૅટાેમેશન, મ˄ીટા̔˱̬ગ, ઊચંી ˶ાેરેજ Ɩમતા, 
સવƙǋ ઉપયાેગ અને કૃ̍ǋમ બુ̏ɡ. 

 કƳʔુટરના ઉપયાેગાે: ̏શƖણ, અારાƝેય, ˗વસાય, મનાેરંજન, સંચાર, બ̲̋ક̬ગ અને વૈƗા̏નક સંશાેધન 
જવેા Ɩેǋાેમાં તેની ઉપયાે̎ગતા. 

 કƳʔુટર ̐સ˶મના ઘટકાે: હાડƙવેર, સાેʘવેર, ઇનપુટ અને અાઉટપુટ ઉપકરણાે, અને મેમરીનાે 
˗ાȕા̍યત ઉ˒ેખ. 

 હાડƙવેર અને સાેʘવેરનાે ȕાલ: બંનેના અથƙ, તફાવત અને ǐકારાેની સમજ સાથે તેમની સાથે ̀ેડાયેલી 
ઉપકરણાેની મા̋હતી. 

 ડેટા ǐાેસે̐સ̬ગની સંકˍના: ડેટાને ઉપયાેગી મા̋હતીમાં ͅપાંત̋રત કરવાની ǐ̋ƿયા અને તેના ̍વ̍વધ 
તબǲાઅા.ે 

 મા̋હતી/ડેટાની રજૂઅાત: 
ASCII, Unicode જવેી પɡ̍તઅાે અને બાઇનરી ̐સ˶મના ઉપયાેગથી કƳʔુટરમાં મા̋હતી કેવી રીતે રજૂ 
થાય છે તેની સમજણ. 

10. નમૂનાͅપ ǐ˜ાે અને જવાબાે (Model question and answers) 

1. કƳʔુટરનું મુȕ કાયƙ શંુ છે? 
a) ̍વƗાન બતાવવું 
b) રમત રમવી 
c) ડેટાને ǐાેસેસ કરવાે 
d) ̋ફːાે ચલાવવી 
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2. કƳʔુટરના ̌પતામહ તરીકે કાેને અાેળખવામાં અાવે છે? 
a) ̐બલ ગટ્ેસ 
b) ચા˔ƙ બાબેજ  
c) ˶ીવ ̀ેʪ 
d) ̌પટર નાેટƙન 

3. નીચેમાંથી કયું ઇનપુટ ઉપકરણ છે? 
a) માે̏ નટર 
b) ̌ǐɰર 
c) કીબાેડƙ   
d) ˾ીકર 

4. RAM અે કઈ ǐકારની મેમરી છે? 
a) નાેન-વાેલેટાઈલ 
b) વાેલેટાઈલ 
c) ચુંબકીય 
d) અૅ̐ ʍકલ 

5. નીચેના માંથી કયું અાઉટપુટ ઉપકરણ નથી? 
a) ˱ેનર 
b) ̌ǐɰર 
c) માે̏ નટર 
d) ˾ીકર 

6. ENIAC કઈ પઢેીનાે કƳʔુટર છે? 
a) ǋી͂ 
b) ǐથમ  
c) બી͂ 
d) ચાેથી 

7. CPU ના કેટલા મુȕ ભાગાે હાેય છે? 
a) 1 
b) 2 
c) 3  
d) 4 

8. નીચેમાંથી કયું સાેʘવેર છે? 
a) માઉસ 
b) Windows  
c) માે̏ નટર 
d) કીબાેડƙ 
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9. ASCII કાેડ મȕુɗે શંુ રજૂ કરે છે? 
a) અંક 
b) અƖરાે અને અંક 
c) ફાેટાે 
d) અવાજ 

10. CD/DVD કઈ ǐકારની મેમરી છે? 
a) Primary 
b) Secondary  
c) Temporary 
d) ROM 

11. OCR નાે સંપણૂƙ અથƙ શંુ થાય છે? 
a) Optical Code Reader 
b) Optical Character Recognition 
c) Online Code Recorder 
d) Open Cloud Resource 

12. કયું ˶ાેરેજ ઉપકરણ પાેટ̳બલ છે? 
a) RAM 
b) ROM 
c) Hard Disk 
d) Pen Drive  

13. નીચેમાંથી કયું Programming Language છે? 
a) Photoshop 
b) Tally 
c) Python 
d) Excel 
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અાેપરેટ̯ગ સી˶મનાે પ̋રચય 
(Windows 10) 

 

1. ઉɠેશાે  

 અા ǐકરણના અંતે શીખનાર:   

 અાેપરે̋ટ̬ગ ̐સ˶મ શંુ છે અને તે કેમ અાવƸયક છે તે સમજશે. 
 અાેપરે̋ટ̬ગ ̐સ˶મના મુȕ કાયƙ જમે કે ǐાેસસે મેનેજમɰે, મેમરી મેનેજમેɰ, ફાઈલ ̐સ˶મ મેનેજમેɰ 

અને I/O ઉપકરણ સંચાલન ̍વશે ̍વƺતૃત ̀ણકારી મેળવશે. 
 Windows અાેપરે̋ટ̬ગ ̐સ˶મના મૂળ તɗાે અને તેની ̍વ̏શˠતાઅાે અાેળખી શકશ.ે 
 Windows અાેપરે̋ટ̬ગ ̐ સ˶મના યુઝર ઇɰરફેસના મુȕ ઘટકાે જવેા કે ડે˱ટાેપ, ટા˱બાર, અાઇકાʉે 

અને ˶ાટƙ મેનુને અાેળખી અને ઉપયાેગ કરી શકશે. 
 અે̖ ʕકેશન સાેʘવેર શંુ છે અને Windows પર અે̖ʕકેશʉ કેવી રીતે ચલાવવી તે શીખી શકશે. 
 અાેપરે̋ટ̬ગ ̐સ˶મની મૂળભૂત સે̋ ટ̬Ɲસ જમે કે તારીખ-સમય બદલવા, ̋ડƺʕે ǐાેપટ̰ઝ ગાેઠવવી, ̌ǐɰર 

ઉમેરવું/દૂર કરવું તે શીખશે. 
 ફાઈલ મેનેજમેɰના મૂળ તɗાે જેવા કે ફાઈલાે બનાવવી, સાચવવી, ખસેડવી, નકલ કરવી અને કાઢી 

નાખવી ̍વશે સમજણ ǐાʏ કરશે. 
 ̍વ̍વધ ફાઈલ ǐકારાે અને ફાઈલ અȌ̲ેશન ̍વશે Ɨાન ǐાʏ કરશે. 

 

1.1 પ̋રચય (Introduction) 

અાજના ટેકનાેલાે͂  યુગમાં કƳʔુટર ઉɥાેગ, ̏શƖણ, અારાેƝય, ̍વƗાન, સંચાર, મનાેરંજન વગરેે Ɩેǋમાં 
મહɗપૂણƙ ભૂ̌મકા ભજવી ર̈ા છે.  કƳʔુટર ફǸ હાડƙવેરનાે સમૂહ હાેય છે જે સૂચનાઅાે ̍વના કાેઈ કાયƙ કરી 
શકતું નથી. અા સચૂનાઅાે અને ̏નયંǋણની ǐ̋ƿયા અાેપરે̋ટ̬ગ ̐સ˶મ (Operating System) ɦારા કરવામાં 
અાવે છે. 

અાેપરે̋ટ̬ગ ̐સ˶મ અે કાેy ુ̏નકેશન ̐ǒજ છે જ ે કƳʔુટર હાડƙવેર અને યુઝર (વપરાશકતાƙ) અથવા 
અે̖ ʕકેશન સાૅʘવેર વȝે સંવાદ ˺ા̌પત કરે છે. યઝુર ɦારા અાપલે દરેક કમાંડ અાપેરે̋ટ̬ગ ̐સ˶મ ɦારા 
યીƝય રીતે હાડƙવેર સુધી પહા̲ચાડવામાં અાવે છે અને તેના પ̋રણામાે પાછા યુઝરને મળે છે. 

દરેક અાેપરે̋ટ̬ગ ̐સ˶મ અલગ અલગ ǐકારના ઉપકરણાે માટે અને અલગ ǐકારના યૂઝરાે માટે રચાયેલ હાેય 
છે. 

શા માટે અાેપરે̋ટ̬ગ ̐સ˶મ જͅરી છે? 

અેક કƳʔુટર ̐સ˶મમાં અનેક સાધનાે હાેય છે જમે કે કીબાેડƙ, માઉસ, ̌ǐɰર, RAM, હાડƙ ̋ડ˱ વગેરે. દરેક 
સાધન અલગ રીતે કાયƙ કરે છે અને અે બધા સાથે કામ કરવું કાેઈ ˗̘Ǹ માટે શȂ નથી. અાેપરે̋ટ̬ગ ̐સ˶મ 
અે બધાને સંક̏લત કરીને અેક સુસંગત માળખંુ પૂ̈́ પાડે છે જથેી કƳʔુટર સરળતાથી ચલાવી શકાય. 
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અા રીતે, અાેપરે̋ટ̬ગ ̐સ˶મ અે કƳʔુટર ̐સ˶મનંુ Ǚદય છે. તેના ̍વના કƳʔટુર માǋ અેક ̏ન̒˟ય મશીન 
બની ̀ય છે. અા અેકમમાં અાપણે અાેપરે̋ટ̬ગ ̐સ˶મના અાધારભૂત ȕાલા,ે તેની કામગીરી, અને તેના 
ǐકારાેની ̍વગતવાર સમજણ મેળવીશું. 

1.2 અાેપરે̋ટ̬ગ ̐સ˶મના મૂળ તɗાે (Basics of Operating System) 

કƳʔુટર હાડƙવેર પાેતાના કાયƙમાં ખૂબ શ̘Ǹશાળી હાેય છે, પરંતુ તે પાેતાની રીતે કાેઇ કાયƙ કરી શકતંુ નથી. તેનંુ 
યાેƝય રીતે સંચાલન અને ̏નયંǋણ કરવા માટે અેક મɪ˺ ̐સ˶મની જͅર પડે છે જનેે અાપણે "અાેપરે̋ટ̬ગ 
̐સ˶મ" કહીઅે છીઅે. અાેપરે̋ટ̬ગ ̐સ˶મ અે તમામ ǐકારના કƳʔુટર ̐સ˶મ માટે અાધાર પરુાે પાડે છે. 

1.2.1 અાેપરે̋ટ̬ગ ̐સ˶મ અેટલે શું? 

અાેપરે̋ટ̬ગ ̐સ˶મ અે અેક ̐સ˶મ સાʘૅવેર છે જ ેકƳʔુટર હાડƙવેર અને યુઝર વȝેના ઇɰરફેસ તરીકે કાયƙ 
કરે છે. તે સંǁ̋હત ડેટાને અȋૅેસ કરવા, ǐાǁેામ ચલાવવા, ̍વ̍વધ ઉપકરણાે (devices)નાે ઉપયાેગ કરવાે 
વગરેે કાયા̳ માટે જવાબદાર છે. 

અાેપરે̋ટ̬ગ ̐સ˶મના મુȕ કાયƙ Ɩેǋા ે

ǐાેસેસ મેનેજમેɰ (Process Management) 

કƳʔુટરમાં ȱારે અેકથી વધુ ǐાેǁામ અેકસાથે ચાલે છે ɔારે દરેક ǐાેǁામ/ǐાેસેસને ̏નયં̍ǋત કરવું જͅરી બને 
છે. મેમરીમાં હાલમાં શ̈́ ǐાǁેામને ǐાેસેસ કહે છે.  અાેપરે̋ટ̬ગ ̐ સ˶મ નવી ǐાેસેસ શͅ કરવી, અેને યાેƝય સમય 
અાપવાે, અને જͅરી પȻે તેને રાેકવી અથવા બંધ કરવી જવેી કામગીરી કરે છે. 

મેમરી મેનેજમેɰ (Memory Management) 

કƳʔુટરમાં ઉપલʤ RAM (મેમરી) મયાƙ̋ દત હાેય છે. અાપેરે̋ટ̬ગ ̐સ˶મ નǲી કરે છે કે કઈ અે̖ʕકેશનને 
કેટલી મેમરી ફાળવવી અને Ȃારે મુǸ કરવી. અાથી કƳʔુટર ̐સ˶મ કાયƙƖમ રહે છે. 

ફાઈલ ̐સ˶મ મેનેજમેɰ (File System Management) 

યૂઝર ɦારા બનાવવામાં અાવેલી દરેક ફાઈલ અાેપરે̋ટ̬ગ ̐ સ˶મ ɦારા ̏નયં̍ǋત થાય છે જને કે તેનું નામ, ˺ ાન, 
ǐકાર, અȋેેસ અ̍ધકાર વગેરે અાેપરે̋ટ̬ગ ̐સ˶મ  રાખે છે. તે ફાઈલાેને સુર̐Ɩત રીતે સંǁ̋હત રાખે છે. 

ઇનપુટ અને અાઉટપુટ ઉપકરણાેનું સંચાલન (I/O Device Management) 

અાેપરે̋ટ̬ગ ̐સ˶મ ̍વ̍વધ ઇનપુટ અને અાઉટપુટ ઉપકરણાે જમે કે કીબાેડƙ, માઉસ, ̌ǐɰર, ˱ેનર વગેરેના 
કાયƙને સંચા̏લત કરે છે. દરેક ઉપકરણ માટે ǉાઇવરાે અને ̏નયંǋણ પɡ̍તઅાે હાયે છે, જ ેઅાેપરે̋ટ̬ગ ̐સ˶મ  
સંભાળે છે. 

યૂઝર ઇɰરફેસ પૂરાે પાડવાે (Providing User Interface) 

અાેપરે̋ટ̬ગ ̐સ˶મ GUI (Graphical User Interface) જમે કે Windows Desktop, Icons, Buttons 
અથવા CLI (Command Line Interface) જમે કે DOS Prompt મારફતે યૂઝરને કƳʔુટર સાથે ̋ƿયા કરવા 
દે છે. 



 

  
SARDAR PATEL INSTITUTE OF PUBLIC ADMINISTRATION, AHMEDABAD 35 

 

̍વચાર કરાે કે તમે તમારા માેબાઇલમાં ʸુ̏ઝક વગાડાે છાે, ǒાઉઝર ખાેલાે છાે અને અેક સાથે WhatsApp 
પણ ચલાવાે છાે અા બધું અાેપરે̋ટ̬ગ ̐સ˶મના કાયƙƖમ સંચાલન ̍વના શȂ જ ન હાેત. અેટલાં માટે, 
અાેપરે̋ટ̬ગ ̐સ˶મ અે માǋ કƳʔુટરનાે અાɒા છે. 

1.2.2 ǐ̐સɡ અાેપરે̋ટ̬ગ ̐સ˶મના મૂળ તɗાે (Windows 10) 

Windows અે માઇƿાેસાʘે કંપની ɦારા ̍વકસાવેલ અાેપરે̋ટ̬ગ ̐ સ˶મ છે, અને તે ̍ વ˝માં સાૈથી વધુ ઉપયાેગ 
થતી અાેપરે̋ટ̬ગ ̐સ˶મામેાથંી અેક છે. ǐથમ વખત 1985માં લાƮેચ થયેલંુ Windows અાજ ે પણ ઘણી 
અાવૃ̍ɇઅાે સાથે બ̀રમાં હાજર છે જમે કે Windows 7, Windows 8, Windows 10 અને Windows 11. 
Windows ને ખાસ કરીને તેના ǁા̋ફકલ યુઝર ઇɰરફેસ (GUI), સરળતા અને અે̖ʕકેશન સંǁહ માટે 
અાેળખવામાં અાવે છે. 

Windows અાપેરે̋ટ̬ગ ̐સ˶મની ખા̐સયતાે 

1. Graphical User Interface (GUI): Windows યૂઝરને બટન, અાઈકાેન, ̍વɱાે અને મેનૂના અાધારે 
કƳʔુટરને ચલાવવાની સરળ રીત અાપે છે. કાેઈ પણ ǐાǁેામ ચલાવવાે કે ફાઈલ અૅȋેસ કરવી હાેય, તે માǋ 
માઉસ ̚ȃકથી શȂ બને છે. 

2. Multitasking: Windows અેક સાથે અેકથી વધુ ǐાǁેાʼ ચલાવવાની Ɩમતા ધરાવે છે જમે કે Wordમાં 
લખાણ લખવું, Spotify ચલાવવું અને સાથે ǒાઉઝર પણ ખૂલું રાખવું. 

3. Plug and Play: નવા હાડƙવેર જવેા કે USB, ̌ǐɰર વગેરે ̀ેડતાંજ Windows તેને અાેળખી લે છે અને 
જͅરી ǉાઈવર અાપમેળે ઇʊાેલ કરે છે. 

4. Security Features: Windows ̍વ̍વધ ǐકારની સુરƖા સુ̍વધાઅાે અાપ ેછે જમે કે પાસવડƙ ǐાેટેȆન, 
ફાયરવાેલ, અે̔ ɰવાયરસ સપાેટƙ, Windows Defender વગેરે. 

5. File Management: Windows અેક ˗ાવસા̍યક NTFS ફાઈલ ̐સ˶મ અાપ ે છે જે સઘન ફાઈલ 
સંચાલન, પર̌મશન ̐સ˶મ અને બેકઅપ સપાેટƙ અાપે છે. 

6. Software Compatibility:  Windows માટે હ̀રાે ǐકારના સાૅʘવેર ઉપલʤ છે જમે કે Microsoft 
Office, Adobe Photoshop, AutoCAD વગેરે, જનેાે ˗ાપક ઉપયાેગ થાય છે. 

Windows અાપેરે̋ટ̬ગ ̐સ˶મના લાભાે 

 સરળ અને વાપરવામાં સહેલી 

 વધુ અે̖ʕકેશન સપાેટƙ 

 હાડƙવેર સાથે વધુ અનુકૂળતા 

 ̏નય̌મત અપડેટ્સ અને સપાટેƙ 

Windows ના ઉપયાેગ Ɩǋેા ે

 ઘરેલું ઉપયાેગ: મૂવી ̀ેવા, ǒાઉ̏ઝ̬ગ, રમતાે રમવા 
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 ઉɥાેગ Ɩેǋ: દƺતાવેજ ˗વ˺ા, ડેટા અેના̏લ̐સસ, કાેʸુ̏નકેશન 

 શૈƖ̒ણક Ɩેǋ: ǐાેજǶે તૈયાર કરવા, અાેનલાઇન લ̏ન̮ગ, ǐેઝɰેશન 

 ̐બઝનેસ: અેકાઉ̔ɰ̬ગ, ERP, MIS ̐સ˶મા ે

Windows અાપેરે̋ટ̬ગ ̐સ˶મ અ ેસરળતા, કાયƙƖમતા અને ˗ાપક ઉપયાેગ માટે ̀ણીતી છે. તેની GUI 
અાધા̋રત પɡ̍તને કારણે નવાે યૂઝર પણ સરળતાથી કƳʔુટરન ે ચલાવી શકે છે. અાજ ે Windows અેક 
˗ાપક પાયે અપનાવેલ અાપેરે̋ટ̬ગ ̐સ˶મ બની ગઈ છે, જ ે˗̘Ǹગત ઉપયાેગથી લઈ ઉɥાગેાેના જુદા જુદા 
Ɩેǋાે સુધી બધે ઉપયાેગી છે. 

1.3 ̍વɱાેઝ યુઝર ઇɰરફેસ (Windows User Interface) 

Windows અાેપરે̋ટ̬ગ ̐ સ˶મ અકે Graphical User Interface (GUI) પર અાધા̋રત ̐ સ˶મ છે, જ ેયૂઝરન ે
સરળ અને ͆Ƹય માɪમથી કƳʔુટર સાથે સંવાદ સાધવાની Ɩમતા અાપે છે. અહ̯યા Windows ના મȕુ 
ઇɰરફેસ ઘટકાેને ̍વગતવાર સમ̀˗ા ંછે. 

ડે˱ટાેપ (Desktop) 

ડે˱ટાેપ અે Windows ખુˑા પછી દેખાતી મȕુ ˲ીન છે, જમેા ંઅાઇકાેન, ટા˱બાર અને બેકǁાઉɱ હાેય 
છે. તે નાની નાની ચી̀ેને (જમે કે ફાે̂ ર, ફાઈલ, શાેટƙકટ) સǁં̋હત કરવાના ̍વƺતાર તરીકે કામ કરે છે. નીચ ે
કાેઈ કƳʔુટરની ડે˱ટાેપ દેખાડેલ છે.   

 

1.3.1 ટા˱બાર (Taskbar) 

ટા˱બાર અે Windows અાેપરે̋ટ̬ગ ̐સ˶મના યૂઝર ઇɰરફેસ નાે અગɔનાે ભાગ છે. તે સામાʈ રીત ે
˲ીનની નીચે અાવેલાે હાેય છે અન ેકƳʔુટરમાં ચાલી રહેલા કાયƙƿમાે અને ̍વ̍વધ ટૂ˔ને સંચા̏લત કરવા 
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માટે વપરાય છે. ટા˱બારના માɪમથી યઝૂર સરળતાથી ̍વ̍વધ અે̖ ʕકેશʉ વȝે ફેરફાર કરી શકે છે અને 
જͅરી ફંȆʉ ઝડપથી અૅȋેસ કરી શકે છે. 

ટા˱બારના મુȕ ભાગાે: 

 

1. Start Button (˶ાટƙ બટન): 

 ટા˱બારની સાૈથી ડાબી બાજુઅે હાેય છે.  

 અહ̯થી Start Menu ખૂલે છે, ȱાંથી અે̖ʕકેશન, ફાઈ˔, સે̋ ટ̬Ɲસ વગેરે અૅȋેસ કરી શકાય છે. 

2. Search Bar (સચƙ  બાર):  

 Windows 10 અને પછીની અાવૃ̍ɇઅામેા ંઉપલʤ. 

 ફાઈલ, અે̖ ʕકેશન કે વેબ કɰેɰ તરત શાેધી શકાય છે. 

 કીબાેડƙથી “Windows Key + S” દબાવી પણ ખાેલી શકાય. 

3. Pinned Applications (̌પન કરેલી અે̖ʕકેશʉ)  

 ટા˱બાર પર તમે મનપસંદ અે̖ ʕકેશʉ ̌પન કરી શકાે છાે. 

 જમે કે: Chrome, Word, File Explorer, Notepad વગેરે. 

 અેક ̚ȃકથી અે̖ ʕકેશન શͅ કરી શકાય છે. 

4. Running Applications (ચાલતી અે̖ʕકેશʉ):  

 હાલ ચાલી રહેલી દરેક અે̖ ʕકેશન ટા˱બાર પર અલગ બટન તરીકે દશાƙય છે. 

 બટન પર ̚ȃક કરીન ેતમારી ̍વɱાેઝ વȝે સરળતાથી ફેરફાર કરી શકાય છે. 

5. System Tray (̐સ˶મ Ǉે) / Notification Area:   

 ટા˱બારની જમણી બાજુ હાયે છે. 

 અહ̯ ઘ̋ડયાળ, તારીખ, વાેˑ ુમ કંǇાલે, Wi-Fi ˶ેટસ, બેટરી લેવલ, અન ેઅપડેટ નાે̋ટ̋ફકેશʉ 
̀ેવા મળે છે. 

 ̀ે તમારી ̐સ˶મમાં કાઈે ǐાƱેલેમ હાેય તાે તે અહ̯ દેખાય છે. 

6. Show Desktop Button (ડે˱ટાેપ બતાવવાનાે બટન): 

 ટા˱બારના અેકદમ જમણે છે (System Tray પછી).  
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 તેને ̚ȃક કરતાં તમામ અાેપન ̍વɱાેઝ minimize થઇ ̀ય છે અને ડે˱ટાેપ ખુ˒ાે દેખાય છે. 

 

1.3.2 અાઇકાેʉ (Icons) 

અાઇકાને અેટલ ે˲ીન પર દેખાતું અેક નાનું ǁા̋ફક ̎ચ̆ (Icon), જ ેકાેઈ ખાસ ફાઈલ, ફાેˆર કે અે̖ʕકેશન 
દશાƙવે છે. અાઇકાʉેનાે મȕુ હેતુ અે છે કે યૂઝર તેની ઝડપથી અાેળખ મેળવી શકે અને અેક ̚ȃકથી 
ઉપયાેગમા ંલઈ શકે. 

Windows જવેા GUI અાધા̋રત અાેપરે̋ટ̬ગ ̐સ˶મમા,ં અાઇકાેન વધુ સારાે અને સરળતાથી સમ͂ શકાય ત ે
ǐકારનાે ઇɰરફેસ પૂરા ેપાડે છે. 

અાઇકાʉેના મȕુ ǐકારાે: 

1. System Icons (̐સ˶મ અાઇકાેન): 

 અા ǐકારના અાઇકાેન અાેપરે̋ટ̬ગ ̐સ˶મમાં ̋ડફાે˄ રીતે અાપવામાં અાવતા હાયે છે. 

 ઉદાહરણ: 

o  This PC / My Computer – ફાઈલ ̐સ˶મ અને ǉાઇƷસ ̀ેવા માટે 

o  Recycle Bin – ̋ડલીટ કરેલી ફાઈલાે માટે 

o  Network – નેટવકƙ  મા̋હતી માટે 

o  Control Panel – ̐સ˶મ સે̋ ટ̬Ɲસ માટે 

2. Application Icons (અે̖ʕકેશન અાઇકાેન): 

 દરેક ઇʊાેલ કરેલી અે̖ ʕકેશનન ેપાેતાનું અાઇકાેન હાેય છે. 

 ઉદાહરણ: 

o Chrome –  

o MS Word –  

o Adobe Photoshop –  

3. Shortcut Icons (શાેટƙકટ અાઇકાેન): 

 તમારા મનપસંદ ǐાǁેામ અથવા ફાઈલ અાેપન કરવા માટે ઉપયાેગી (Shortcut). 

 શાેટƙકટ અાઇકાેનમાં સામાʈ રીતે અેક નાનાે તીરાે (Arrow) ̀ેવા મળે છે.  

 તે ફાઈલ કે અે̖ ʕકેશનની ǐ̍તકૃ̍ત નથી પરંતુ તે સુધી પહા̲ચવાનાે રƺતાે છે. 

4. Folder Icons (ફાેˆર અાઇકાને): 
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 ડેટા કે ફાઈલાેને Ǘેણીબɡ અને ગાેઠવેલા ͅપમાં સંǁહ કરવા માટે ફાેˆરાેના અાઇકાેન હાેય છે. 

 તમે નવી ફાેˆરાે બનાવી શકાે છાે અને તેમાં ડેટા મૂકી શકાે છાે. 

અાઇકાેન સાથે કઈ રીતે કામ કરાય? 

̋ƿયા કેવી રીતે કરાય 

Open ડબલ ̚ȃક અથવા Enter કી દબાવી 

Rename અાઇકાેન પર રાઈટ-̚ȃક → Rename 

Delete અાઇકાેન પર રાઈટ-̚ȃક → Delete 

Move / Drag ડે˱ટાેપ પર પસંદગી અને ખ̲ચીને અʈ જƝયાઅે મૂકવુ ં

Create Shortcut ફાઈલ પર રાઈટ-̚ȃક → Create Shortcut 

અાઇકાેનના ફાયદા: 

 સરળ અાેળખ: અાઇકાેન તુરંત અાેળખી શકાય છે. 
 ડબલ ̚ȃક કરીને તરત ઉપયાેગમાં લઇ શકાય છે તથા ઝડપથી અૅȋેસ કરી શકાય છે. 
 ડે˱ટાેપને ˗વ̗˺ત બનાવે છે. 
 શાેટƙકટ બનાવીને રાેજબરાેજની અે̖ʕકેશʉ સરળ રીતે અȋૅેસ થઇ શકે છે. 

અાઇકાેન ક˶માઇઝેશન: 

 તમે અાઇકાેનનું નામ, ˺ાન અને દેખાવ બદલાવી શકાે છાે. 
 Windows Settings → Personalization → Themes → Desktop Icon Settings 

અહ̯થી તમે system icons પસંદ કે અનપસંદ કરી શકાે છાે. 
 તમા̈́ં મનગમતું અાઇકાેન પણ અપલાેડ કરીને ફેરફાર કરી શકાય છે. 

અાઇકાેʉ કƳʔુટરની દુ̏નયામાં અɔંત ઉપયાેગી છે, જ ેયૂઝરને અેકદમ સરળતાથી ̍વ̍વધ સંસાધનાે સુધી 
પહા̲ચવા દે છે. ̍વɱાેઝ જવેી અાેપરે̋ટ̬ગ ̐સ˶ʼ અાઇકાને અાધા̋રત ઇɰરફેસ ɦારા ટેક̏નકલ કાયƙને પણ 
સરળ અને વપરાશકતાƙ-̌મǋતાપૂવƙક બનાવે છે. 

1.3.3 ˶ાટƙ મેનુ (Start Menu) 

˶ાટƙ મેનૂ શું છે? 

˶ાટƙ મેન ૂ અે Windows અાેપરે̋ટ̬ગ ̐સ˶મમાં ǐારં̑ભક ̐બ̬દુ છે, ȱાંથી યૂઝર બધંુ શͅ કરી શકે છે  
જમે કે અે̖ ʕકેશન ખાેલવી, સે̋ ટ̬Ɲસ બદલવા, કƳʔુટર બધં કરવુ ંઅથવા જͅરી ફાઈલાે શાેધવી. ˶ાટƙ મેનૂ  અે 
જƝયા છે ȱાં તમા̈́ં અાખું કƳʔુટર ˗વ̗˺ત રીતે હાજર હાેય છે, જથેી તમે સરળતાથી બધંુ શાેધી શકાે અને 
ચલાવી શકાે. 

˶ાટƙ મેનૂના મુȕ ઘટકાે અને તેમનાે ઉપયાેગ: 
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1. Pinned Apps (̌પન કરેલી અે̖ʕકેશʉ): યઝૂર પાેતાની પસદંગીની અને વારંવાર વપરાતી 
અે̖ ʕકેશʉ અહ̯ ̌પન કરી શકે છે. ઉદાહરણ તરીકે: Chrome, Word, Excel, WhatsApp વગેરે. પીન 
કરવાથી વારંવાર અૅȋેસ થતી અે̖ ʕકેશન ઝડપથી ઉપલʤ થાય છે. 

2. All Apps List (બધી અે̖ʕકેશʉની યાદી): ˶ાટƙ મેનૂની અંદર "All Apps" પર ̚ȃક કરવાથી, 
કƳʔુટરમાં ઇʊાેલ થયલેી તમામ અે̖ʕકેશʉ ̏લ̔˶̬ગ ̀ેવા મળે છે.  અહ̯થી તમે કાઈે પણ અે̖ʕકેશન 
ઝડપથી શાેધી અને ચલાવી શકાે છાે. 

 

3. Search Bar (સચƙ બાર): અહ̯ તમે તમારી ફાઈલ, અે̖ ʕકેશન, સે̋ ટ̬ગ અથવા વેબ સાઇટ શાેધી શકાે છા.ે 
ઉદાહરણ: ̀ે તમારે "Calculator" ખાેલવંુ હાેય, તાે તમે માǋ "Cal" લખશાે અને તરત કેˀુલેટર દેખાશે. 

 

̌પન કરેલી અે̖ʕકેશʉ 

બધી અે̖ ʕકેશʉની યાદી 
̀ેવા માટે  

Search Bar 

યૂઝર અકેાઉɰ 
̍વકˍા ે̀ેવા માટે 
અહી ̚ȃક કરાે પાવર ̍વકˍા ે

સે̋ ટ̬ગ બદલવા અા 
અાઇકન પર  ̚ȃક કરા ે
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4. User Account (યઝૂર અકાઉɰ ̍વકˍાે): 

 તમારા અકાઉɰ સંબં̍ધત ̍વકˍાે જમે કે Lock, Sign Out, Account Settings વગેરે અહ̯થી 
કરી શકાય છે. 

 ઘણા યુઝર માટે ǐાેફેશનલ કે ̠ ̘Ǹગત વપરાશ માટે અેકથી વધારે અકાઉɰ હેɱલ કરવાના ે̍ વકˍ 
પણ અહ̯થી મળે છે. 

5. Power Options (પાવર ̍વકˍાે): 

 અહ̯થી તમે કƳʔુટર Shut Down, Restart, Sleep કે Hibernate કરી શકાે છાે. 

 ȱારે કામ પૂ̈́ ં  થાય ɔારે અહ̯થી જ કƳʔુટરને યાેƝય રીત ેબંધ કરવંુ જͅરી છે. 

6. Settings Shortcut (સે̋ ટ̬Ɲસ શાેટƙકટ): 

 અહ̯થી સીધા Windows Settings ખાેલી શકાય છે. નીચે તમે Settings પર ̚ȃક કરતા અાેપન 
થાય છે તે ̍વɱાે દેખાય છે.  

 ̐સ˶મ અપડેટ કરવી હાેય, નેટવકƙ  બદલવંુ હાેય કે ˲ીન સે̋ ટ̬Ɲસ બદલવા હાેય, તાે અહ̯થી 
સરળતાથી કરી શકાય છે. 

 

˶ાટƙ મેનૂના ̍વ̐શˠ લƖણાે: 

લƖણ વણƙન 

સરળ ને̍વગેશન બધંુ અેક જƝયા પર સǁં̋હત હાેવાથી કામ ઝડપથી કરી શકાય છે. 

સચƙ Ɩમતા કાેઈ પણ ફાઈલ અથવા અે̖ ʕકેશન તરત શાેધી શકાય છે. 
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પસƙનલાઇઝેશન પાેતાની રીતે અે̖ ʕકેશʉ અન ેસે̋ ટ̬Ɲસ ગાેઠવી શકાય છે. 

ǐાેડ̖Ƕ̍વટી વધારવી સમય બચાવે છે અને કામની ઝડપ વધારવી સરળ બને છે. 

 

̍વ̐ભɿ Windows અાવૃ̎ɇઅામેાં Start Menu કેવી રીતે બદલાયું છે: 

Windows અાવૃ̎ ɇ અાઇકાેન Start Menuનું ̄ͅપ અને ફેરફાર 

Windows 95 

 

સાૈǐથમ Start Button રજૂ થયું.  

Windows XP 

 

વધુ સુંદર અને રંગીન ˶ાટƙ મેનૂ. Recent documents 
દશાƙવાયું. 

Windows 7 

 

સરળ શાેધ સુ̍ વધા સાથે વધુ ઝડપી ˶ાટƙ મેનૂ. 

Windows 8 

 

Start Menu દૂર કરી Start Screen લાવવામા ંઅાવી.  

Windows 10 

 

Start Menu પાછંુ લાવવામા ંઅા˗ું, Live Tiles સાથે. 

Windows 11 

 

વધુ ̌મ̏નમલ અને કેિƮǍત (Centre) Start Menu; 
લાઈવ ટાઈ˔ દૂર. 

 

˶ાટƙ મેનૂનાે મહɗ: 

 અાેપરે̋ટ̬ગ ̐સ˶મનાે મȕુ દરવા̀ે છે. 
 કામ શͅ કરવંુ હાેય કે બંધ કરવું હાયે, બધંુ ˶ાટƙ મેનૂમાંથી થતંુ હાેય છે. 
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 દરેક વપરાશકતાƙને તનેા દૈ̏નક કƳʔુટર કામ માટે અાનું મહɗ સમજવંુ જͅરી છે. 

˶ાટƙ મેનૂ અે ̍ વɱાેઝ અાેપરે̋ટ̬ગ ̐ સ˶મનું અɔતં ઉપયાગેી સાધન છે. તનેા માɪમથી તમે તમા̈́ં કામ ઝડપી, 
સરળ અને વધુ અસરકારક બનાવી શકાે છાે. Windows ઉપયાેગ કરનાર દરેક ˗̘Ǹઅે ˶ાટƙ મેનનૂા દરેક 
ભાગ અને તેની Ɩમતાઅાે સાથે પ̋ર̎ચત થવું ̀ેઈઅે. 

1.3.4 અે̖ʕકેશન ચલાવવી (Running an Application) 

અે̖ ʕકેશન શંુ છે? 

અે̖ ʕકેશન સાેʘવેર અે અેવંુ સાેʘવેર છે, જ ેખાસ અેક ̍વ̏શˠ કાયƙ કે કાયƙસમૂહ કરવા માટે બનાવવામા ં
અા˗ું છે. અે̖ ʕકેશન વપરાશકતાƙ અન ેઅાેપરે̋ટ̬ગ ̐સ˶મ વȝે કામની સરળતા લાવે છે. 

અે̖ ʕકેશન સાેʘવેરના ઉદાહરણ: 

 Word Processor → Microsoft Word 
 Web Browser → Google Chrome 
 Media Player → VLC Player 
 Drawing Tool → MS Paint 

અે̖ ʕકેશન કેવી રીતે ચલાવવી? 

અે̖ ʕકેશન ખાેલવા માટે Windows માં નીચેના મȕુ રƺતાઅા ેછે: 

1. ˶ાટƙ મેનૂ મારફતે અે̖ʕકેશન ચલાવવી: 

 ˲ીનના નીચે ડાબા ખૂણ ેStart Button પર ̚ȃક કરાે. 

 Pinned Applications અથવા All Appsમાંથી જͅરી અે̖ ʕકેશન શાેધાે. 
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 અે̖ ʕકેશનના નામ પર ̚ȃક કરાે અને અે શͅ થઈ જશે.  

 ઉદાહરણ: Start → All Apps → Calculator  પર Click કરતા Calculator ખૂલે છે. 

 

 

1. ડે˱ટાેપ શાેટƙકટ ɦારા ચલાવવી:  

 ડે˱ટાેપ પર અાવેલ અે̖ ʕકેશનનું અાઇકાેન શાેધાે. અાઇકાને પર ડબલ ̚ȃક કરતા અે̖ʕકેશન તરત 
શͅ થઈ જશે. 

ઉદાહરણ: Google Chrome ના અાઇકાેન પર ડબલ ̚ȃક કરતા ǒાઉઝર ખૂલે છે. 

3. ફાઈલ અેȋʕાેરર મારફતે ચલાવવી: 

 File Explorer (Windows + E) ખાેલાે. C: Drive → Program Files → અે̖ʕકેશનનાે ફાે̂ ર શાેધાે. 
ɔાંથી મુȕ executable (.exe) ફાઈલ પર ડબલ ̚ȃક કરાે. 

 ઉદાહરણ: C:\Program Files\Microsoft Office\root\Office16\WINWORD.EXE પર ડબલ 
̚ȃક કરતા Word ખૂલે છે. 

4. Run Command ɦારા ચલાવવી: 

 Windows Key + R દબાવા ે→ Run ̍વɱાે ખુલશે. 

 ɔાં અે̖ ʕકેશનનું નામ લખાે અને Enter કરાે. 

 චඡ ઉદાહરણ: 

 Run → લખા ેnotepad → Enter → Notepad ખૂલે છે. 

 

 Run → લખા ેMs paint → Enter → MS Paint ખૂલ ેછે. 

      

ખાસ ના̲ધાે: 

 ઝડપથી અે̖ʕકેશન ખાેલવા માટે Run Command Ǘેˤ છે. 

 વારંવાર વપરાતી અે̖ ʕકેશʉને Taskbar અથવા Start Menu પર ̌પન કરી શકાય છે. 
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 Windows Multitasking ને સપાેટƙ કરે છે અેકસાથે ઘણી અે̖ʕકેશʉ ખાેલી શકાય છે. 

અેકથી વધુ અે̖ʕકેશન ચલાવવી (Multitasking): 

 તમે અેક સમયે Microsoft Word પણ ખાેલી શકાે છાે, સાથે Chrome ǒાઉઝર અન ેVLC Media 
Player પણ ચલાવી શકાે છા.ે 

 Windows દરેક અાેપન અે̖ʕકેશન માટે અલગ ̍વɱાે અાપે છે. 

 Alt + Tab દબાવીને અેક અે̖ ʕકેશનમાંથી બી͂ અે̖ʕકેશન પર તાબડતાેબ ̄ીચ કરી શકાય છે. 

અે̖ ʕકેશન ચલાવતી વખતે સમ̃ાઅાે (Problems) અને ઉકેલાે: 

સમ̃ા ઉકેલ 

અે̖ ʕકેશન અાેપન થતી નથી System Restart કરાે અથવા અે̖ʕકેશન ફરીથી ઇʊાેલ કરાે. 

કƳʔુટર ધીમું ચાલે છે અનાવƸયક અે̖ʕકેશʉ બધં કરાે. 

Error Messages Error ǐમાણે અે̖ʕકેશન અપડેટ કરાે કે ટે̚ǽકલ સહાય લવાે. 

 

અે̖ ʕકેશન બંધ કેવી રીતે કરવી? 

 Alt + F4 → હાલમાં ચાલી રહેલી અે̖ʕકેશન બંધ કરવા માટે. 

 Taskbar પર અે̖ ʕકેશન પર રાઈટ-̚ȃક કરાે → "Close Window" પસંદ કરાે. 

 ̀ે અે̖ʕકેશન હ̲ગ થઈ ગઈ હાેય → Task Manager (Ctrl + Shift + Esc) → અે̖ʕકેશન પસંદ 
કરાે → "End Task" કરાે. 

અે̖ ʕકેશન ચલાવવી અે કƳʔુટરના ઉપયાેગ માટે અગɔની કુશળતા છે. Windows જવેી અાેપરે̋ટ̬ગ 
̐સ˶મ અે̖ ʕકેશʉ ચલાવવાનું બહુ સરળ બનાવી અાપે છે. અે̖ʕકેશન ખાેલવી, તેમાં કામ કરવું અને 
જͅરી હાેય ɔારે અેને યાેƝય રીતે બંધ કરવી વગેરે ǐ̋ƿયાઅાે માટે દરેક વપરાશકતાƙઅે ̏નપણુ થવું ̀ેઈઅે. 

1.4 અાેપરે̋ટ̬ગ ̐સ˶મની ̐સʱલ સે̋ટ̬Ɲસ Operating System simple setting 

કƳʔુટર પર સુઘડ અને સરળ રીતે કામ કરવા માટે અમકુ બે̏ઝક સે̋ટ̬Ɲસ ̀ણવી અને તેમને સમયાંતરે 
અેડજ˶ કરવી જͅરી છે. અા સે̋ટ̬Ɲસ ɦારા તમે તમા̈́ં કƳʔુટર તમારા જͅરીયાત મુજબ ક˶માઇઝ કરી શકાે 
છાે અને Ǘેˤ રીતે ઉપયાેગ કરી શકાે છાે. સે̋ ટ̬Ɲસ ɦારા તમા̈́ં કƳʔુટર તમારી જ̋ͅરયાતાે અને પસંદગીઅાે 
ǐમાણે ગાેઠવી શકાય છે. ̀ે યાેƝય રીતે અને સમયાંતરે સે̋ટ̬Ɲસ કરાે, તાે તમારા કƳʔુટરનંુ પરફાેમƙʉ વધે છે 
અને ઉપયાેગનાે અનુભવ વધુ સારાે બને છે. 

1.4.1 ̐સ˶મ તારીખ અને સમય બદલવા (Changing System Date and Time) 

કƳʔુટરમાં સાચી તારીખ અને સમય મહɗપણૂƙ છે, ખાસ કરીને ફાઈલાેના સમય ˶ેʱ, ઇમેઇ˔ અને 
ઇɰરનેટ સુરƖા માટે. 
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તારીખ અન ેસમય બદલવાની રીત: 

1. સી˶મ Ǉેમાં અાવેલ ઘ̋ડયાળ પર જમણંુ માઉસ બટન ̚ȃક કરાે. 

 

2. "Adjust date and time" પસંદ કરાે.  નીચે મુજબની ̍વɱાે અાેપન થાય છે. 

 

3. "Set time automatically" બંધ કરાે અને પછી "Change" બટન પર ̚ȃક કરા.ે નીચે મુજબના ે
ડાયલાગે બાƖે અાેપન થાય છે.  
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4. નવી તારીખ અને સમય પસંદ કરીને "Change" પર ̚ȃક કરાે. 

1.4.2 ̋ડƺʕે ǐાેપટ̰ઝ બદલી (Changing Display Properties) 

̋ડƺʕે સે̋ટ̬Ɲસથી ˲ીન ̋રઝાેˑુશન, ǒાઈટનેસ, વાેલપપેર અને થીમ બદલી શકાય છે. 

̋ડƺʕે ǐાપેટ̰ઝ બદલવાની રીત: 

1. Desktop પર ખાલી જƝયાઅે Right-Click કરાે અને "Display settings" પસંદ કરાે. 

 

2. ǒાઈટનેસ અને કલર અેડજ˶ કરાે અથવા ˱ે̏લ̬ગ બદલાે. 



 

  
SARDAR PATEL INSTITUTE OF PUBLIC ADMINISTRATION, AHMEDABAD 48 

 

 

3. "Personalization" હેઠળ બેકǁાઉɱ, કલસƙ અન ેથીમ પસંદ કરા.ે 

 

1.4.3 ̍વɱાેઝ કʱાેનɰ્સ ઉમેરવા કે દૂર કરવું (To Add or Remove Windows 
Components) 

̍વɱાેઝના ચાેǲસ ફીચસƙ (જમે કે Internet Explorer, Games, Print Services) ઉમેરવા કે દૂર કરવા માટે: 

 චඡ ̍વɱાેઝ કʱાેનɰ્સ ઉમેરવા/દૂર કરવા માટે: 
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1. ˶ાટƙ મેનુમાં સચƙ બારમાં માંથી નીચે મુજબ સચƙ કરી Control Panel પર ̚ȃક કરી તેને ખાેલાે. 

 

2. "Programs and Features" પસંદ કરાે. 

 

3. ડાબી બાજુઅે અાવેલ  "Turn Windows features on or off" ̍વકˍ પર ̚ȃક કરાે. 
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4. ̍વɱાેઝ કʱાેનɰ્સ ઉમેરવા કે દૂર કરવા જ̋ͅરયાત મુજબ ચેકબાેȋ પસંદ કરાે કે દૂર કરાે અને OK 
પર ̚ȃક કરાે. 

 

1.4.4 ǐાેǁામ ઉમેરવા કે દૂર કરવંુ (To Add or Remove a Program) 

ȱારે કાેઈ નવંુ સાʘેવેર ઇʊાેલ કરવંુ હાેય કે જૂનું દૂર કરવું હાેય ɔારે અા ̍વકˍ ઉપયાેગ થાય છે. 

 චඡ ǐાǁેામ ઉમેરવા/દૂર કરવાની રીત: 

1. ̀ે નવા ǐાǁેામ ઉમરેવાનાે હાયે, તાે ઇʊાેલેશન ફાઈલ પર  ડબલ ̚ȃક કરી શ̈́ કરા.ે 

2. ̀ે નવા ǐાǁેામ દુર કરવા હાેય તાે Control Panel → Programs and Features ખાેલાે. 

 

3. જ ેǐાǁેામ દૂર કરવાે હાેય તે ǐાǁેામને ̏લ˶માંથી પસદં કરાે અન ે"Uninstall" પર ̚ȃક કરાે. 

1.4.5 ̌ǐɰર ઉમેરવંુ કે દૂર કરવું (Adding and Removing Printers) 
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કƳʔુટર સાથે નવંુ ̌ǐɰર ̀ડેવંુ કે જૂનંુ ̌ǐɰર દૂર કરવંુ ખૂબ સરળ છે. 

̌ǐɰર ઉમેરવા/દૂર કરવાની રીત: 

1. Control Panel → Devices and Printers પર ̚ȃક કરાે. 

 

2. Printers & Scanners ̍વકˍ પર ̚ȃક કરા ે

 

3. "Add a Printer" પસંદ કરાે અને ˱ેન કરાવાે, જͅરી ̌ǐɰર પસંદ કરાે અને કનેǶ કરા.ે 
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4. જુનું ̌ǐɰર દૂર કરવા માટે, ̌ǐɰર પર ̚ȃક કરાે અને ɔારબાદ નીચે મુજબની ̍વɱાે અાપેન થાય 
છે તેમાં Remove બટન પર ̚ȃક કરાે. 

 

Simple Settings વપરાશકતાƙને પાેતાની જ̋ͅરયાત મજુબ ̐સ˶મને ગાેઠવવામાં મદદ કરે છે. તારીખ અન ે
સમય થી લઈ ǐાǁેાʼ અને ̌ǐɰસƙ સુધી બધંુ ˗વ̗˺ત કરવંુ બહુ જ જͅરી છે જથેી કƳʔુટર સતત કાયƙƖમ 
અને ˗વ̗˺ત રહે. 

1.5 ફાઈલ મેનજેમɰે (File Management) 
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ફાઈલ મેનેજમેɰનાે અથƙ 

ફાઈલ મેનેજમેɰ અે અાેપરે̋ટ̬ગ ̐સ˶મનું અેક અાવƸયક કાયƙ છે, જમેાં ફાઈલ અને ફાેˆરને ˗વ̗˺ત રીતે 
સંભાળવાની, ગાેઠવવાની અને ˗વ˺ા̌પત કરવાની ǐ̋ƿયા શામેલ છે. કƳʔટુરના ઉપયાેગ દર̌મયાન જ ે
મા̋હતી સંǁ̋હત થાય છે તેને સરળતાથી શાેધી શકાય અને ઉપયાેગ કરી શકાય અે માટે ફાઈલ મેનેજમેɰ 
જͅરી છે. 

ઉદાહરણ તરીકે: 
ȱારે તમે Microsoft Word માં ડાેȂુમɰે બનાવાે છાે અને તેને "My Documents" ફાેˆરમાં સાચવાે 
છાે, ɔારે ફાઈલ મેનેજમેɰ તેની સાચવણી અને ˶ાેરેજનું કાયƙ કરે છે. 

ફાઈલ મેનેજમેɰના મȕુ કાયƙ 

1. ફાઈલ બનાવવી (Create): નવી ફાઈલાે અથવા ડાેȂુમɰ્ેસ બનાવવાનું કાયƙ. 

2. ફાઈલ સાચવવી (Store): ફાઈલાેને હાડƙ ̋ ડ˱, પને ǉાઈવ અથવા ȃાઉડ જવેી મેમરીમાં સાચવવાનંુ 
કાયƙ. 

3. ફાઈલ ખાેલવી (Open): અગાઉ બનાવેલી ફાઈલાે ખાેલીને તેમાં ̀ેવા અથવા ફેરફાર કરવા માટે. 

4. ફાઈલનું નામ બદલવું (Rename): ફાઈલનું નામ બદલીને વધુ ˾ˠ અથવા ઉપયાેગી બનાવવું. 

5. ફાઈલ ખસેડવી (Move): ફાઈલને અેક ફાેˆરથી બી̀ ફાેˆરમાં ખસેડવી. 

6. ફાઈલની નકલ બનાવવી (Copy): ફાઈલની નકલ બનાવવી અને જુદા-જુદા ˺ાન ેસાચવવી. 

7. ફાઈલ કાઢી નાખવી (Delete): ̐બનજͅરી ફાઈલાેને દૂર કરીને જƝયા બચાવવી. 

8. ફાઈલ શાેધવી (Search): ઝડપી શાેધ માટે સાેʘવેર ટૂ˔ અથવા અાેપરે̋ટ̬ગ ̐સ˶મની શાેધ 
સુ̍ વધાનાે ઉપયાેગ. 

9. બેકઅપ અને રીકવરી (Backup & Recovery): ફાઈલ ગમુાવાની ̗˺̍તમા,ં પહેલા લીધેલા 
બેકઅપથી મા̋હતી પુનઃǐાʏ કરવાની ˗વ˺ા. 

ફાઈલ મેનેજમેɰના ઘટકાે 

ઘટક વણƙન 

ફાઈલ ̐સ˶મ ફાઈ˔ અને ફાેˆસƙને સાચવવા માટેની ̐સ˶મ (જમે કે NTFS, FAT32). 

̋ડરેǶરી ˷Ǵર ફાેˆસƙ અને સબ-ફાેˆસƙનું બહુƺતરીય માળખું. 

પાથ (Path) ફાઈલ સુધી પહા̲ચવાનાે માગƙ (જમે કે C:\Users\Documents\Report.docx). 

અેકસેસ કંǇાેલ ફાઈલ પર કાેણ શું કાયƙ કરી શકે છે તે નǲી કરવું (જમે કે Read, Write, Execute 
Permissions). 
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ફાઈલ મેનેજમેɰ ટૂ˔ અને સાેʘવેર 

 Windows File Explorer: ફાઈ˔ અને ફાેˆસƙને દશાƙવતી અને સંચા̏લત કરતી GUI અાધા̋રત 
̍વɱાે. 

 Command Line Interface (CLI): Command Prompt અથવા PowerShell વડે ફાઈલ 
અાેપરેશʉ. 

 ફાઈલ મેનેજમેɰના ફાયદા 

 મા̋હતીની સરળ ગાેઠવણી અને ઝડપી ǐાʏી. 
 ˶ાેરેજના ેયાેƝય ઉપયાેગ અને જƝયા બચાવવી. 
 ǐાેડ̖Ƕ̍વટી અને કાયƙƖમતા વધારવી. 
 મા̋હતી ગુમાવાનું ̀ેખમ ઘટાડવુ.ં 
 સુરƖા અને બેકઅપ ˗વ̗˺ત રીતે ̀ળવવી. 

ફાઈલ મેનેજમેɰ કાેઈ પણ અાેપરે̋ટ̬ગ ̐સ˶મ માટે અ̏નવાયƙ છે. યાેƝય ફાઈલ મેનજેમેɰ ̍વના, મા̋હતી 
ગુમાવાની શȂતા વધી શકે છે અને કƳʔુટરમાં કાયƙ કરવું મƸુકેલ બની શકે છે. ̍વભાગીકૃત રીતે ફાઈલાેને 
સાચવવી અને જͅરીયાત મજુબ ઝડપથી શાેધી કાઢવી અે કાયƙƖમ કƳʔુટર વપરાશનું અેક અગɔનું પગલંુ 
છે. 

1.6 ફાઈલના ǐકારાે (Types of Files) 

ફાઈલ અેટલે શુ?ં 

ફાઈલ અે મા̋હતી સંǁ̋હત કરવાનંુ અેક અેકમ છે, જનેે કƳʔુટર પર સંǁ̋હત કરી શકાય છે અને ȱારે જͅર 
હાેય ɔારે ઉપયાેગ/ǐાʏ કરી શકાય છે. ǐɔેક ફાઈલમાં ̍વ̏શˠ ǐકારના ે ડેટા હાયે છે અને તેના ઉપયાેગ 
ǐમાણે તેનું વગ̰કરણ થાય છે. 

ફાઈલના મુȕ ǐકારા ે

અાેપરે̋ટ̬ગ ̐સ˶મમાં ̍વ̍વધ ǐકારની ફાઈલાે હાેય છે જમેાં મુȕ ǐકાર નીચે મુજબ છે: 

ફાઈલનાે ǐકાર ̍વગત 

ટેȌ ફાઈલ (Text File) જ ે ફાઈલાેમાં મુȕɗે લખાણ (Alphabet, Numbers) હાેય છે. 
ઉદાહરણ: .txt, .docx 

ǐાેǁા̌મ̬ગ ફાઈલ (Program File) જ ેફાઈલાેમાં ǐાǁેા̌મ̬ગ કાેડ અથવા કમાંડ હાેય છે. ઉદાહરણ: .c, .cpp, 
.py, .java 

અેિƛઝȂુટેબલ ફાઈલ 
(Executable File) 

જ ે ફાઈલ સીધી અાેપરે̋ટ̬ગ ̐સ˶મ ɦારા ચલાવવામાં અાવે છે. 
ઉદાહરણ: .exe, .bat 

મા˄ી̌મડીયા ફાઈલ 
(Multimedia File) 

જમેાં અાૅ̋ડયાે, ̍વ̋ડયાે અથવા ̌પǴર જવેી મા̋હતી હાેય છે. 
ઉદાહરણ: .mp3, .mp4, .jpg, .png 
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ડેટાબેસ ફાઈલ (Database File) ડેટાબેઝ સાથે ̀ેડાયેલી ફાઈલ જ ેમા̋હતીના સંǁહ માટે વપરાય છે. 
ઉદાહરણ: .mdb, .db, .sql 

કાેʲેƺડ ફાઈલ (Compressed 
File) 

ફાઈલની સાઈઝ ઘટાડવા માટે કʲેસ કરેલી ફાઈલ. ઉદાહરણ: .zip, 
.rar 

̐સ˶મ ફાઈલ (System File) અાેપરે̋ટ̬ગ ̐સ˶મના કાયƙ માટે જͅરી ફાઈલાે. ઉદાહરણ: .sys, .dll 

દરેક ǐકારની ફાઈલનાે ઉપયાેગ 

ફાઈલ ǐકાર ઉપયાેગ 

Text File નાેટ્સ, ડાેȂુમɰ્ેસ, ̔˲ʍ્સ લખવા માટે. 

Program File સાેʘવેર અને અે̖ʕકેશન તૈયાર કરવા માટે. 

Executable File સાેʘવેર અને અે̖ʕકેશʉ ચલાવવા માટે. 

Multimedia File મનાેરંજન, ǐƺતુ̍ ત અને ̋ડ̏જટલ મી̋ડયા માટે. 

Database File માેટા ǐમાણમાં ડેટાનું સંચાલન અને સંǁહ કરવા માટે. 

Compressed File ˶ાેરેજ બચાવવા અને ફાઈલ Ǉાʉફર કરવા માટે. 

System File અાેપરે̋ટ̬ગ ̐સ˶મને યાેƝય રીતે ચલાવા માટે. 

 

ફાઈલ અેȌ̲શન શું છે? 

ǐɔેક ફાઈલનું અેક ̍વ̏શˠ અȌ̲ેશન હાેય છે જે તેના ǐકારને ̏નધાƙ̋રત કરે છે. 
ફાઈલ અેȌ̲શન ફાઈલના નામ પછી અાવે છે અને ડાેટ (.) થી જુદંુ કરવામાં અાવે છે. 
ઉદાહરણ: report.docx મા ં.docx અે ફાઈલ અેȌ̲શન છે. 

મહɗનુ ં

 દરેક ફાઈલનાે ઉપયાેગ અને તેનું કાયƙ અલગ હાેય છે. 

 અાેપરે̋ટ̬ગ ̐સ˶મ દરેક ફાઈલ ǐકારને અાેળખે છે અને યાેƝય ǐાેǁામથી તેને ખાેલે છે. 

 ફાઈલના ǐકાર અનુસાર તેના ેસǁંહ, સુરƖા અને બેકઅપ મહɗપણૂƙ બને છે. 

ફાઈલના ̍વ̍વધ ǐકારાે કƳʔટુર પર મા̋હતીના ̍ વ̍વધ ̄ ͅપાેને ̠ વ̗˺ત રીતે સંચા̏લત કરવા મદદͅપ થાય 
છે. સાચી રીતે ફાઈલાેનું વગ̰કરણ અને ˗વ˺ાપન કરવાથી કƳʔુટરના ેઉપયાેગ વધુ સરળ અને કાયƙƖમ 
બને છે. 

1.7 અɰેીવાયરસ સાેʘવેર 
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અાજના ̋ડ̏જટલ યુગમાં કƳʔુટર અને ઇલેƛǇાે̏ નક ઉપકરણાે રાે̏ જ̬દા ͂વન અને ˗વસાયમાં મહɗપણૂƙ 
બʈા છે. સાથે સાથ,ે વાયરસ, માલવેર, ˾ ાયવેર, Ǉાેજન જવેા ખતરનાક ǐાેǁાʼ પણ વɪા છે, જે કƳʔુટરના 
ડેટા અને ̐સȂુ̋રટી માટે માેટાે ખતરાે ઊભાે કરે છે. અાવા ખતરાઅાેથી બચવા માટે "અɰેીવાયરસ સાેʘવેર" 
અ̍ત અાવƸયક છે. 

અɰેીવાયરસ સાેʘવેર અે કƳʔુટર ǐાǁેામ છે જ ેવાયરસ અને અʈ નકામા સાેʘવેરને શાેધે છે, દૂર કરે છે 
અને કƳʔુટરને સુર̐Ɩત રાખે છે. તે અાેપરે̋ટ̬ગ ̐ સ˶મના સુરƖા ƺતરને મજબૂત બનાવે છે અને વપરાશકતાƙને 
સુર̐Ɩત કƳʔુ̋ટ̬ગ અનુભવ અાપે છે. 

અɰેીવાયરસ સાેʘવેરના મȕુ કાયƙ 

 Detection (શાેધ): કƳʔુટરમાં રહેલા શંકા˾દ અથવા ખતરનાક સાેʘવેરની અાેળખ કરવી. 

 Prevention (રાેકથામ): વાયરસ કે માલવેર ̐સ˶મમાં ǐવેશે અે પહેલા તેને રાેકવાે. 

 Removal (દૂર કરવું): અાેળખાયેલ ખતરનાક સાેʘવેરને ̐સ˶મમાંથી Ȅાેરɰાઇન કરવાે અથવા 
સંપૂણƙપણે કાઢી નાખવાે. 

 Real-time Protection (̋રયલ ટાઈમ સુરƖા): સતત ˱ે̏ન̬ગ કરીને કાેઈ પણ શકંા˾દ ǐવૃ̍ ɇ 
તરત અટકાવવી. 

 System Recovery (પુનઃ˺ાપન): વાયરસથી થયેલું નુકસાન સુધારવાનાે ǐયાસ કરવાે. 

અɰેીવાયરસ સાેʘવેરના ǐકારા ે

ǐકાર ̍વગત 

Signature-based Antivirus ̀ણીતા વાયરસની સહીન ે(Signature) અાધારે અાેળખ કરે છે. 

Heuristic-based Antivirus નવા ǐકારના વાયરસ શાેધવા માટે ̍વƸલષેણ પɡ̍તઅાે ઉપયાેગ કરે છે. 

Behaviour-based 
Antivirus 

ǐાǁેામના વતƙન અાધારે ખતરાે અાેળખે છે. 

Cloud-based Antivirus મા̋હતી અને ˱ે̏ન̬ગ માટે ȃાઉડ સવƙરનાે ઉપયાેગ કરે છે. 

Hybrid Antivirus ઉપરાેǸ તમામ પɡ̍તઅાેનંુ સંયાેજન ધરાવે છે. 

 

લાેક̌ǐય અેɰીવાયરસ સાેʘવેર ઉદાહરણાે 

 Windows Defender (Windows સાથે અંદર જ અાવે છે) 

 Avast Free Antivirus 

 Norton Antivirus 

 McAfee Antivirus 



 

  
SARDAR PATEL INSTITUTE OF PUBLIC ADMINISTRATION, AHMEDABAD 57 

 

 Quick Heal Total Security 

 Kaspersky Antivirus 

 

અɰેીવાયરસ સાેʘવેરના ફાયદા 

 ડેટા અને ˗̘Ǹગત મા̋હતીનું રƖણ: ગાેપનીય મા̋હતી ચાેરાઈ જતી અટકાવે છે. 

 ̐સ˶મ કામગીરી સુધારવી: વાયરસ દૂર કરીને કƳʔુટર ઝડપી બનાવે છે. 

 ઇમેઇલ અને ǒાઉ̏ઝ̬ગ સુરƖા: ઇમેઇ˔ અને વેબસાઈટ્સમાંથી અાવતાં ખતરાઅાેને અટકાવે છે. 

 અપડેટ્સ ɦારા નવી સુરƖા: સતત અપડેટ થતંુ રહે છે જેથી નવા ખતરાઅાે સામે રƖણ મળ.ે 

 ̋ફ̏શ̬ગ અને ઈɰરનેટ ̏લ̬કથી બચાવ: નકલી વેબસાઈટ્સ અને ̏લ̬ȋથી બચાવે છે. 

મહɗપૂણƙ સૂચનાે 

 અɰેીવાયરસ સાેʘવેર અપડેટ રાખવાે ̀ેઈઅે, કારણ કે નવા ǐકારના વાયરસ સતત ઊભા થાય 
છે. 

 ̐સ˶મનું ̏નય̌મત ˱ે̏ન̬ગ કરવું ̀ેઈઅે જથેી છૂપાયેલા ખતરાઅાે ઝડપાઈ શકે. 

 માǋ અ̍ધકૃત અને ̍વ˝સનીય અેɰીવાયરસ ǐાેǁામનાે ઉપયાેગ કરવાે ̀ેઈઅે. 

અાેપરે̋ટ̬ગ ̐સ˶મનંુ કાયƙƖમ અને સુર̐Ɩત સંચાલન અેɰીવાયરસ સાેʘવેર ̍વના અશȂ છે. 
અɰેીવાયરસ ન હાેવાને કારણે કƳʔુટરમાં ડેટા ચાેરી, ̐સ˶મ ƿેશ અને નાણાકીય નુકસાન જવેી ગંભીર 
પ̋ર̗˺̍તઅાે ઊભી થઈ શકે છે. અેટલે, દરેક યુઝરે પાેતાના અાેપરે̋ટ̬ગ ̐સ˶મ માટે યાેƝય અેɰીવાયરસ 
સાેʘવેર પસંદ કરીને તેને અપડેટ રાખવું અɔંત અાવƸયક છે. 

1.8 Summary  

અા અેકમમાં અાેપરે̋ટ̬ગ ̐સ˶મના મૂળભૂત ȕાલાે અને તેની કામગીરીને ̍વગતે સમ̀વવામાં અા˗ા છે. 
અાેપરે̋ટ̬ગ ̐સ˶મ અે કƳʔુટર હાડƙવેર અને યૂઝર અથવા અે̖ʕકેશન સાૅʘવેર વȝે સંવાદ ˺ા̌પત કરતુ ં
̐સ˶મ સાૅʘવેર છે. કƳʔટુર પર ̍વ̍વધ ઉપકરણાે અને સંસાધનાેનંુ સંકલન અને ̏નયંǋણ અાેપરે̋ટ̬ગ 
̐સ˶મ ɦારા થાય છે. 

અા અેકમમાં Windows અાેપરે̋ટ̬ગ ̐ સ˶મના મૂળ તɗાે, તેની ખા̐સયતાે અને ઉપયાેગ Ɩેǋાેની ચચાƙ કરવામાં 
અાવી છે. Windowsના મુȕ યુઝર ઇɰરફેસ ઘટકાે જેમ કે ડે˱ટાેપ, ટા˱બાર, અાઇકાેʉ અને ˶ાટƙ મેન ુ
̍વશે ̍વƺતૃત મા̋હતી અાપવામાં અાવી છે. 

અે̖ ʕકેશન સાૅʘવેર શંુ છે અને Windows પર અે̖ʕકેશન કેવી રીતે ચલાવવી તે પણ સમ̀વાયું છે. સાથ ે
સાથે અાેપરે̋ટ̬ગ ̐સ˶મની સરળ સે̋ટ̬Ɲસ જમે કે તારીખ અને સમય બદલવાે, ̋ડƺʕે ǐાેપટ̰ઝ ગાેઠવવી, 
̌ǐɰર ઉમેરવુ ંકે દૂર કરવુ ંતેની ̀ણકારી અાપવામાં અાવી છે. 
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અંતે, ફાઈલ મેનેજમેɰના અʬાસ ɦારા ફાઈ˔ અને ફાેˆસƙનું સંચાલન કેવી રીતે કરવું અને ̍ વ̍વધ ǐકારની 
ફાઈલાે ̍વશેની મા̋હતી અાપવામાં અાવેલ છે. ફાઈલના ં ǐકારાે અને ફાઈલ અȌ̲ેશનનું મહɗ પણ 
સમ̀વવામાં અા˗ું છે. અા ઉપરાંત અેɰીવાયરસ સાેʘવેર ̍વષે ̍વƺતૃત મા̋હતી અાપવામાં અાવી છે.  

અા અેકમ ɦારા શીખનાર અાેપરે̋ટ̬ગ ̐સ˶મના મૂળ તɗાે અને તેનંુ મહɗ સમ͂ શકશે અને કƳʔુટર 
ચલાવવાની અને મેનેજ કરવાની મહɗપણૂƙ કુશળતા ̍વકસાવી શકશે. 

2. નમૂનાͅપ ǐ˜ાે અને જવાબાે (Model question and answers) 

Q1. અાેપરે̋ટ̬ગ ̐સ˶મ શું છે? 
 (A) અે̖ʕકેશન સાૅʘવેર 
 (B) હાડƙવેર ઉપકરણ 
 (C) યુઝર ઇɰરફેસ અને હાડƙવેર વȝે ̐ǒજ 
 (D) ફાઈલ મેનેજમેɰ ટૂલ 
Answer: (C) 

Q2. નીચેમાંથી કયંુ અાેપરે̋ટ̬ગ ̐સ˶મનું કાયƙ નથી? 
 (A) મેમરી મેનેજમેɰ 
 (B) ̌ǐ̔ɰ̬ગ ડાȂુેમɰે 
 (C) ǐાેસેસ મેનેજમેɰ 
 (D) ફાઈલ મેનેજમેɰ 
Answer: (B) 

Q3. Windows અાેપરે̋ટ̬ગ ̐સ˶મ માટે નીચેનું કયંુ સાચું છે? 
 (A) માǋ CLI અાધા̋રત છે 
 (B) માǋ હાડƙવેર સંચા̏લત કરે છે 
 (C) GUI અાધા̋રત અાેપરે̋ટ̬ગ ̐સ˶મ છે 
 (D) કાેઈ યુઝર ઇɰરફેસ નથી 
Answer: (C) 

Q4. Windowsમાં કઈ સુ̍વધા સચƙ માટે ઉપયાેગી છે? 
 (A) Start Button 
 (B) Search Bar 
 (C) Taskbar 
 (D) Control Panel 
Answer: (B) 

Q5. નીચેમાંથી કઈ ફાઈલ ટાઇપ ટેȌ ફાઈલ છે? 
 (A) .exe 
 (B) .txt 
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 (C) .jpg 
 (D) .mp4 
Answer: (B) 

Q6. Windows અાેપરે̋ટ̬ગ ̐સ˶મમાં ‘Taskbar’ કયા ભાગમાં હાેય છે? 
 (A) ˲ીનની ઉપર 
 (B) ˲ીનની જમણી બાજુઅ ે
 (C) ˲ીનની નીચ ે
 (D) ˲ીનની મɪમાં 
Answer: (C) 

Q7. Start Menu માંથી તમે શું કરી શકાે છાે? 
 (A) કƳʔુટર બંધ કરી શકાે છાે 
 (B) અે̖ ʕકેશન ખાેલી શકાે છાે 
 (C) સે̋ ટ̬Ɲસ અȋૅેસ કરી શકાે છાે 
 (D) ઉપરાǸે બધા 
Answer: (D) 

Q8. Windowsમાં ‘Recycle Bin’ નાે ઉપયાેગ શું માટે થાય છે? 
 (A) ફાઈલાે ડાઉનલાેડ કરવા માટે 
 (B) ̋ડલીટ કરેલી ફાઈલાે રાખવા માટે 
 (C) નેટવકƙ  સે̋ટ̬Ɲસ માટે 
 (D) કƳʔુટર બંધ કરવા માટે 
Answer: (B) 

Q9. અાેપરે̋ટ̬ગ ̐સ˶મમાં મેમરી મેનેજમેɰનાે હેતુ શંુ છે? 
 (A) ફાઈલ સેવ કરવી 
 (B) RAM નાે યાƝેય ઉપયાેગ કરવાે 
 (C) ˱ે̏ન̬ગ કરવું 
 (D) ̌ǐ̔ɰ̬ગ કરવું 
Answer: (B) 

Q10. નીચેમાંથી કયંુ અાેપરે̋ટ̬ગ ̐સ˶મનું ઉદાહરણ છે? 
 (A) Microsoft Word 
 (B) Adobe Photoshop 
 (C) Windows 10 
 (D) Google Chrome 
Answer: (C) 
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Q11. Windowsમાં શાૅટƙકટ અાઇકાેન કેવી રીતે અાેળખી શકાય? 
 (A) લાલ રંગથી 
 (B) નાના તીરના ̎ચ̆થી 
 (C) માેટા અાકારથી 
 (D) ઊભા બાેȋથી 
Answer: (B) 

Q12. ફાઈલ અેȌ̲શન શું દશાƙવે છે? 
 (A) ફાઈલનું કદ 
 (B) ફાઈલનાે ǐકાર 
 (C) ફાઈલનું ˺ાન 
 (D) ફાઈલનું નામ 
Answer: (B) 

Q13. નીચેમાંથી કયું मʐी̌મડીયા ફાઈલનંુ ઉદાહરણ છે? 
 (A) .docx 
 (B) .exe 
 (C) .mp3 
 (D) .bat 
Answer: (C) 

Q14. Alt + Tab કઈ ̋ƿયા માટે વપરાય છે? 
 (A) કƳʔુટર બંધ કરવા 
 (B) અે̖ ʕકેશʉ વȝે ̄ીચ કરવા 
 (C) નવાે ફાેˆર બનાવવા 
 (D) ˲ીન લાૅક કરવા 
Answer: (B) 

Q15. Control Panel નાે ઉપયાેગ શું માટે થાય છે? 
 (A) ʸુ̏ઝક વગાડવા 
 (B) ̐સ˶મ સે̋ટ̬Ɲસ બદલવા 
 (C) ગેમ રમવા 
 (D) વેબ ǒાઉ̏ઝ̬ગ માટે 
Answer: (B) 
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માઈƿાેસાેʘ વડƙ 2019 
 

1. ઉɠેશાે (Objectives) 

અા ǐકરણના ેઅʬાસ કયાƙ બાદ તમે Microsoft Word 2019નાે સંપૂણƙ અને અસરકારક ઉપયાેગ કરી 
શકશાે. અા ǐકરણના અંતે તમે:   

 Microsoft Word 2019નાે પ̋રચય મેળવી શકશાે તથા વડƙ ǐાસેે̐સ̬ગના ઉપયાેગ અને ઉપયાે̎ગતા 
સમ͂ શકશા.ે 

 Microsoft Word 2019ના ̍વ̍વધ ભાગાે અંગે સમજ મળેવી શકશા ેઅન ેતેનાે ઉપયાેગ કરી શકશા ે  
 ટેȌ ડાેȂુમɰે (દƺતાવે̀ે) બનાવવા અને સાચવવા અંગે ̀ણકારી મેળવી શકશા ે 
 ટેȌ ડાેȂુમɰેને ˗વ̗˺ત ફાેમ̳ટ કરવાના ̍વકˍાે અગેં ̀ણકારી મેળવી શકશા ે  
 લેખન અને ભાષા સુધારવાની કાૈશˑતા મળેવી શકશાે   
 અɥતન સંશાેધન અને ̋ડઝાઇન ટૂ˔ (સાધન)નાે ઉપયાેગ કરી શકશા.ે 
 ફાઈલમાં રહેલા ડેટાને સુર̐Ɩત રીતે સાચવતા અને શેર કરતા શીખી શકશા.ે 
 ̍વ̍વધ અાઉટપુટ ̍વકˍાેના ેઉપયાગે કરી શકશાે જમે કે ડાȂેુમɰેને PDF અથવા અʈ ફાેમ̳ટમાં સેવ 

કરવંુ તથા ̌ǐ̔ɰ̬ગ અને ડાȂેુમɰેને ̌ǐɰ કરતા પહેલા તેનું ̌ǐ˗ુ ̀ેવું. 
 સહયાેગ માટે Track Changesનાે ઉપયાેગ કરી શકશાે.  
 વાƺત̍વક ͂વનમાં શƖૈ̒ણક, ˗ાવસા̍યક અને ˗̘Ǹગત ડાેȂુમɰ્ેસ બનાવવા, ǐાેજǶે ̋રપાેટƙ, 

બાયાેડેટા વગેરે તૈયાર કરવા માટે Microsoft Word 2019 ના ેઉપયાેગ કરી શકશાે. 
 

2. Microsoft Word 2019 પ̋રચય (Introduction) 

Microsoft Word 2019 અ ેMicrosoft Office Suite નાે અકે મહɗપૂણƙ વડƙ ǐાેસે̐સ̬ગ ǐાǁેામ છે જે  
દƺતાવે̀ે બનાવવા, તેમાં ફેરફાર કરવા અને તેને ફાેમ̳ટ કરવા માટે ખૂબ જ ઉપયાેગી છે. અા અે̖ ʕકેશન 
સાેʘવેરનાે ઉપયાેગ શƖૈ̒ણક, ˗ાવસા̍યક અન ે˗̘Ǹગત ƺતરે થાય છે. તે અગાઉના વઝƙન કરતા વડƙ 
ǐાેસે̐સ̬ગ માટેની નવી સુ̍વધાઅાે અને સુધારાઅા ેસાથે અાવે છે, જ ેતેને વધુ સƖમ અને કાયƙƖમ બનાવે છે. 

Microsoft Word 2019માં સરળ દેખાવ, અેક કરતા વધારે વપરાશકતાƙ અને અɥતન ફીચસƙ છે જ ે
દƺતાવે̀ેની ગુણવɇા અને કાયƙƖમતાને વધારે છે. અા ǐકરણ અંતગƙત, તમે ડાેȂુમɰે બનાવતા પહેલા અને 
તે પછીની બધી જͅરી ǐ̋ƿયાઅાેને સરળતાથી શીખી શકશાે. 

Microsoft Word 2019 ના મȕુ લƖણાે: 

1. સુંદર અને અાધુ̏નક દેખાવ: Microsoft Word 2019માં દેખાવની નવી ̋ડઝાઇન છે. ̋ રબન-˶ાઇલનુ ં
મેનુ બાર અલગ-અલગ સાધન અને સુ̍વધાને સરળતાથી મળેવવા માટે ઉપયાેગી છે. 

2. ફાેમ̳̋ટ̬ગ માટે ̍વકˍાે: તે લખાણને સશુાેભન કરવા માટે ̍વ̍વધ ફાૅɰ ˶ાઇલ, ટેȌ કલર, ટેȌ 
હાઈલાઈ̋ટ̬ગ, પરેાǁાફ ˶ાઇલ, બુલેટ પાેઈɰ્સ અને નંબ̋રગ̬ જવેા ̍વકˍાે અાપે છે. 
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3. ટેʱલેટ્સ (Templates): Microsoft Word 2019માં અનેક તૈયાર ટેʱલેટ્સ છે જમે કે ̋ રƣયૂમ, લેટર, 
̋રપાેટƙ, અને ǐાેજǶે ̋ડઝાઇન. અા ટેʱલેટ્સનાે ઉપયાેગ કરીને તમે સરળતાથી ˗ાવસા̍યક ડાેȂુમેɰ 
બનાવી શકાે છાે. 

4. સહયાેગની સુ̍વɥા (Collaboration Features): ઘણા લાેકાે અેક જ ડાેȂુમેɰ પર સાથે કામ કરી 
શકે છે તથા સમીƖાઅાે (Review) અને ̋ ટʑણીઅાે (Comments)ની સુ̍વɥાથી કાયƙ કરવામાં સરળતા 
રહે છે. 

5. કલાઉડ ઇ̔ɰǁેશનની સુ̍ વધા: OneDrive સાથે ̀ેડાણ કરી ફાઇલને ȃાઉડમાં સાચવી શકાય છે. 
ડાેȂુમɰે પર અાૅનલાઈન અને અાૅફલાઈન બંને રીતે કામ કરી શકાય છે. 

6. અાકષƙક ડાેȂુમɰે બનાવવા માટેના સાધનાે: તેમાં કાેˠક (Tables), ̎ચǋાે (Pictures), અાકારાે 
(Shapes), અને અાકૃ̍તઅાે ઉમેરવા માટે સરળ ̍વકˍા ેઉપલʤ છે. તમે  અાલેખ (Charts) ઉમેરી 
દƺતાવેજને વધુ ǐભાવશાળી બનાવી શકાે છાે. 

7. લખાણની ભાષાને સધુારવા માટે મદદ: Spelling અને Grammar Check તથા Thesaurus અને 
Word Suggestionsની મદદથી લખાણની ભાષાને સુધારવા માટે મદદ મળે છે.    

8. અɥતન સુ̍ વધાઅાે: તે Text-to-Speech, Dictation (બાેલીને લખાણ લખવા માટેની સુ̍વɥા) તથા 
Translation ટૂલ જવેી અધતન સુ̍ વɥા પૂરી પાડે છે  

કેમ Microsoft Word 2019 પસંદ કરવું ̀ેઈઅ?ે 

Microsoft Word 2019 વપરાશકતાƙઅાે માટે સરળતાથી સમ͂ શકાય તેવાે દેખાવ (યુઝર-Ǒેɱલી 
ઇɰરફેસ) પરૂાે પાડે છે જ ેઅાેછા સમયમાં ǐભાવશાળી ડાેȂુમેɰ્સ બનાવવા માટે અનુકૂળ છે. તેની નવી 
સુ̍ વધાઅાે અને ટૂ˔ તમને કામગીરી સુધારવામાં મદદ કરે છે અને સમય બચાવે છે. 

Microsoft Word 2019 અે પǋા,ે ̍વ̍વધ ̋રપાેટ્ƙસ, બાયાેડેટા, નાેટ્સ અને પƺુતક બનાવવા, શૈƖ̒ણક 
ડાેȂુમɰે તૈયાર કરવા, અામંǋણ પ̍ǋકા બનાવવા તેમજ તબીબી અથવા કાનૂની ના̲ધાે સાચવવા વગેરે માટે 
ઉપયાેગી છે.  

3. વડƙ ǐાેસે̐ સ̬ગના મૂળભતૂ ̐સɡાંતાે (Word Processing Basics) 

વડƙ ǐાેસે̐ સ̬ગ શું છે? 

વડƙ ǐાેસે̐સ̬ગ અે લખાણ વાળા દƺતાવે̀ે તૈયાર કરવા, તેમાં ફેરફાર કરવા, તેને સુશાેભન (ફાેમ̳ટ) કરવા અને 
̌ǐɰ કરવા માટેની પɡ̍ત છે. તે પǋાે, ̋રપાેટƙ, ના̲ધ, બાયાેડેટા અને અʈ ǐકારના દƺતાવે̀ે તૈયાર કરવા માટે 
ઉપયાેગી છે. 

Microsoft Word 2019 અે વડƙ ǐાેસે̐સ̬ગ માટેની અɔારના સમયની સાૈથી લાેક̌ǐય અને ખૂબજ  ઉપયાેગી 
સાેʘવેર છે જ ેસરળતાથી સમ͂ શકાય તેવા દેખાવ (ઈɰરફેસ) અને અɥતન સુ̍ વɥાઅાે સાથે દરેક ǐકારના 
વપરાશકતાƙઅાે (યુઝર) માટે ǐભાવી કાયƙƖમતા ǐદાન કરે છે. 

વડƙ ǐાેસે̐ સ̬ગમાં નીચેની કામગીરીનાે સમાવેશ થાય છે: 

1. લખાણનંુ સંપાદન (ટેȌ અે̋ડ̋ટ̬ગ): નવંુ લખાણ લખવું, લખાણમાં ફેરફાર કરવાે, લખાણને કટ કરવું, 
કાેપી કરવું અને પે˶ કરવું. 
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2. સુશાેભન (ફાેમ̳̋ટ̬ગ): લખાણની ફાɰૅ શૈલી (˶ાઇલ), કદ (સાઈઝ) અને રંગ બદલવંુ. લખાણને બાે̂  
(ઘાટંુ) , ઇટા̏લક (ǋાસુ) અથવા અɱરલાઇન કરવંુ, પરેાǁાફ અને લાઈન ˾ે̐સ̬ગના ̍વકˍા ેવગેરે. 

3. ટેબ˔ અને ડાયાǁાʼ ઉમરેવા: ડેટાને કાેˠક ̄ͅપે દશાƙવવા માટે ટેબલ બનાવવા, અાકષƙક રજૂઅાત 
માટે ̎ચǋાે અને અાકારા ેઉમેરવા. 

4. પેજ લેઅાઉટ: પેજ મા̏જ̭ન અને લેઅાઉટ નǲી કરવી, હેડર, ફૂટર અને પેજ નંબર ઉમેરવા. 

5. દƺતાવેજ સાચવવંુ અને શેર કરવંુ: ડાȂેુમɰેને ̍વ̍વધ ફાેમ̳ટમા ંસાચવવંુ (સેવ કરવંુ) જમે કે DOCX, 
PDF તથા  ડાȂેુમɰેને ઈમેલ ɦારા અથવા ȃાઉડ પર શેર કરવંુ. 

6. ̌ǐ̔ɰ̬ગ: ડાેȂુમɰે ̌ǐɰ કરવાની તૈયારી કરવી, ̌ǐɰ ̌ǐ˗ુ ̀ેવા અને અાઉટપુટ ચકાસવા. 

3.1 Microsoft Word 2019 શ̈́ કરવંુ (Opening Word Processing Package) 

̀ે Microsoft Word 2019 તમારા કƳʔુટર પર ઇʊાેલ ન હાયે, તાે સાૈ ǐથમ તેને Microsoft Office 
Suiteમાંથી ઇʊાેલ કરવંુ પડશે. ̀ે તમારા કƳʔુટર પહેલેથી જ Microsoft Word 2019 ઇʊાેલ હાયે તા ે
તેને શ̈́ કરવા માટે તમે નીચનેા માથંી કાેઇપણ અેક રીત અપનાવી શકાે છાે .  

1. ડે˱ટાેપ અાઇકાેનથી ખાેલવંુ: 

o તમારા કƳʔુટરના ડે˱ટાેપ પર Microsoft Word 2019 અાઇકાેન   શાેધાે. 

o અા અાઇકાેન પર ડબલ-̚ȃક કરાે. 

o Microsoft Word 2019 ખલૂી જશે અને નવંુ ડાેȂુમɰે બનાવવા માટે તૈયાર રહેશે. 

2. ˶ાટƙ મેʈુથી ખાેલવંુ: 

o કી-બાેડƙ પર અાવેલ Windows Key  દબાવાે અથવા ˲ીનના નીચે બાજુના ખૂણે અાવેલી 
Start બટન પર ̚ȃક કરાે. 

o Microsoft Word કે Word 2019 શાેધાે. 

o ̏લ˶માંથી Word 2019 પસંદ કરીને ̚ȃક કરાે. 

3. સચƙ બારનાે ઉપયાેગ કરીન ેખાેલવંુ: 

o  (Windows Key)  + S દબાવાે અથવા Search Bar  પર ̚ȃક કરાે. 

o Word લખા ે  અને Microsoft Word 2019 પર ̚ȃક કરાે. 

4. ડાેȂુમɰેથી ખાેલવંુ: 

o ̀ે તમારા કƳʔુટર પર Microsoft Word ફામ̳ેટમાં (DOCX) ડાȂેુમɰે સેવ થયેલ છે, તાે તેના 
અાઇકાેન પર ડબલ-̚ȃક કરાે. 

o ȃાઉડથી ડાȂેુમɰે ખાેલવા માટે Microsoft Accountમાં સાઇન ઇન થવું જͅરી છે. 

o અા ડાȂેુમɰે Microsoft Word 2019 પેકેજમાં ખુલી જશે. 
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ǐારં̐ભક ˲ીનના મȕુ ભાગાે: 

Microsoft Word 2019 ખાેˑ ા બાદ, તમન ેનીચે મુજબની અેક ǐારં̑ભક ˲ીન (Start Screen) દેખાય 
છે જ ેનીચે દશાƙવેલ ̍વ̍વધ ̍વકˍાે ǐદાન કરે છે: 

 Templates: નવંુ ડાેȂુમɰે બનાવવા માટે અલગ-અલગ ટેʱલેટ્સ ઉપલʤ કરાવે છે. 

 Blank Document: નવું ડાȂેુમɰે બનાવવા માટે Blank Document ̍વકˍ પસંદ કરી શકાે 
છા.ે 

 Recent: તેની મદદથી તમ ેતાજતેરમાં સેવ કરેલા ડાȂેુમɰ્ેસ ખાલેી શકાે છાે. 

 

3.2  મેનુબાર (Menu bar) 

Microsoft Word 2019માં મેનુબાર અે મુȕ ભાગ છે, જે તેમાં ઉપલʤ બધી જ સુ̍ વધાઅાે અને સાધના ે
સુધી પહા̲ચવાનાે માગƙ ǐદાન કરે છે. મેનુબાર ǐાǁેામની ટાચે પર હાેય છે અને તે જુદા જુદા ટેʪના ̄ͅપમાં 
દેખાય છે. તેનાથી વપરાશકતાƙ તમામ ફીચસƙ અને કાયા ̳ સરળતાથી મેળવી શકે છે. તનેી ̀ળવણી અને 
ઉપયાેગીતા Microsoft Word 2019ને વધુ કાયƙƖમ અને તેનાે ઉપયાેગ સરળ બનાવે છે. 

મેનુબારના લાભાે: 

 વપરાશકતાƙને ટૂ˔ સાથે કાયƙ કરવાનું માɪમ ǐદાન કરે છે. 

 દરેક ટેબમાં તેની જͅરીયાત મુજબ સાધનાે (ટૂ˔) અને ̍વકˍ (અાેƯશʉ) ઉપલʤ છે, જ ેસમય 
બચાવે છે અને વધુ સચાેટતા, ગુણવɇા અને કાયƙƖમતામા ંવધારાે કરે છે. 

  

મેનુબારના મȕુ ટેʪ અન ેતેમનાં ઉપયાગે: નીચેની  અાકૃ̍તમાં તમે મેનુબાર ̀ેઈ શકાે છાે.  

 

Templates 



 

  
SARDAR PATEL INSTITUTE OF PUBLIC ADMINISTRATION, AHMEDABAD 65 

 

ટેબનું નામ ઉપયાેગા ે

File (ફાઇલ)  નવું ડાેȂુમɰે બનાવવું. 

 અગાઉ બનેલ તેમજ તાજતેરમાં બનેલ ડાેȂુમɰે ખાેલવું. 

 ડાેȂુમેɰ સેવ કરવું, ̌ǐɰ કરવું અથવા PDF ફાેમ̳ટમાં સવે કરવું. 

 ફાઈલ બંધ કરવી તેમજ ફાઈલને અȋેપાેટƙ કરવા માટેના ̍વકˍા.ે 

Home (હાેમ)  ફાૅɰ ˶ાઇલ, સાઈઝ, અને કલર બદલવા માટેના ̍વકˍાે. 

 લખાણને બાે̂ , ઇટા̏લક અથવા અɱરલાઇન કરવું. 

 બુલેટ્સ અને નબં̋રગ̬ ઉમેરવા. 

 Find અને Replace માટે ટૂ˔. 

Insert (ઇʉટƙ)  ̎ચǋાે, અાકારા,ે ચાટ્ƙસ, અને ટેબ˔ ઉમેરવા. 

 હેડર અને ફૂટર ઉમેરવા. 

 પેજ નંબર, ડેટ અને ટાઇમ દાખલ કરવા. 

Draw (ǉાે)  હાથથી દાેરેલા અાકારાે, રેખાઅાે અને લખાણ ઉમેરા ે

Design (̋ડઝાઇન)  પેજ લેઅાઉટ માટે થીમ પસંદ કરવી. 

 બાેડƙસƙ અને પેજના બેકǁાઉɱમાં ફેરફાર કરવાે. 

Layout (લેઅાઉટ)  પેજ મા̏જ̭ન, સાઇઝ અને અાે̋ રઅેɰેશનને સેટ કરવું. 

 લખાણને કાેલમમાં ̍વભા̏જત કરવું. 

References (રેફરʉ)  ટેબલ અાેફ કɰેɰ્સ (અનુƿમ̒ણકા) બનાવવી. 

 Citation અને Bibliography ઉમેરવી. 

 ફૂટનાેટ અને અેɱનાેટ ઉમેરવા માટે 

Mailing (મેઈલ̯ગ)  મેઈલ મજƙ કરવા માટે  

 ˗̘Ǹગત પǋાે, પરબી̋ડયા અને લેબલ બનાવવા દે છે. 

Review (̋ર˗ુ)  Spelling અને Grammar તપાસવા માટે. 

 ડાેȂુમેɰમાં Track Changes શ̈́ કરવું. 

 ̋ટʑણીઅાે ઉમરેવા અને ડાેȂુમɰેનું અનુસંધાન રાખવંુ. 

View (˗ુ)  ડાેȂુમેɰને જુદા જુદા દેખાવમાં ̀ેવા માટે ̍વકˍાે. 

 Zoom In/Out કરવા માટેની સુ̍વધા. 

 ફૂટપȳી અને ̎ǁડલાઈન દશાƙવવાના ̍વકˍાે. 
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3.3 મદદ નાે ઉપયાેગ (Using the Help) 

Microsoft Word 2019 અે તેની સુ̍ વધાઅાે અને ટૂ˔ના ઉપયાેગને સરળ બનાવવાના ઉɠેƸયથી સારી મદદ 
(Help) ǐદાન કરે છે. ̀ે તમ ેકાેઈ ટુ˔નાે ઉપયાેગ કેવી રીત ેકરવાે તે ન ̀ણતા હા,ે અથવા તમને કાઈેપણ 
કાયƙમાં મદદ ̀ેઈતી હાયે, તા ેHelp તમને માગƙદશƙન પૂ̈́ ં  પાડે છે. ̀ે તમે Microsoft  Word 2019નાે વધુ 
સારી રીતે ઉપયાેગ શીખવા માંગાે છા ેઅથવા કાેઇપણ ǐ˜નાે ઉકેલ શાેધી ર̈ા છા ેતાે Helpની સુ̍ વધા તમારી 
ખૂબ મદદ કરશે. 

Helpના ઉપયાેગ કરવાના લાભાે: 

 સમયની બચત: જ ેબાબત ̍વશે તમે નથી ̀ણતા તે અંગે ઝડપથી શીખવા માટે મદદͅપ થાય છે. 

 સપˠ માગƙદ̐શ̭કા: તે દરેક ટૂલ અને ǐ˜ ̍વશે ̍વગતવાર સમજણ અાપે છે. 

 ̍વ˝સનીય: Microsoft Word 2019 ની Help તમને ચાǲેસ અને સચાેટ મા̋હતી ǐદાન કરે છે. 

Help સુ̍ વધાનાે ઉપયાેગ કેમ કરવાે? 

તમે નીચે વણƙવેલ ǋણ માંથી કાેઇપણ ̍વકˍનાે ઉપયાગે કરી મદદ મેળવી શકાે છાે   

a. Help શાેટƙકટ: Keyboard Shortcut: તમારા કી-બાેડƙ પર ફંȆન કી F1 દબાવાે, જે નીચેની અાકૃ̍તમા ં
જમણી બાજુમાં દશાƙ˗ા મુજબની Help ̍વɱાે ખાેલે છે જમેાં તમારે જ ે̍વષે મદદ ̀ેઈતી હાેય તેની ̍વગત  
ટાઇપ કરી મદદ મેળવી શકાે છાે. જમે કે Find ̍વષે મદદ ̀ેઈતી હાેય તાે Find ટાઈપ કરા.ે   

 
b. Search Bar નાે ઉપયાગે: 

 Microsoft Word 2019ના ટાેપ-મેનુમાં સચƙ બાર છે. 
 અહ̯ તમારે જનેા ̍વષે મદદ ̀ેઈતી હાેય તે લખી શકાે છાે, અને Microsoft Word 2019 તમે જે 

શાેધી ર̈ા છાે તે અંગે સૂચનાે અાપવાનું શͅ કરશ.ે તમારી જ̋ͅરયાત મુજબનું ̍વકˍ પસંદ કરી તેના 
પર ̚ȃક કરી તમે મદદ મેળવી શકાે છાે.  
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c. લાઈવ અાેનલાઈન Help: ̀ે તમા̈́ં કƳʔુટર ઇɰરનેટ સાથે ̀ેડાયેલ હાેય તાે Microsoft Word 

2019 તમને Office Support વેબસાઇટ પર લઇ ̀ય છે ȱાં તમ ેતમારા ǐ˜નાે ઉકેલ શાેધી શકા ેછા.ે 

3.4 મેનુબારની નીચેના અાઇકાેʉનાે ઉપયાેગ (Using the Icons below Menu 
Bar) 

મેનુબારની નીચેના અાઇકાʉેને Ribbon Toolbar કહેવામાં અાવે છે. અા અાઇકાʉે ɦારા તમે ઝડપી અન ે
અસરકારક રીતે ̍વ̍વધ ટૂ˔ અન ેકાયƙǐવૃ̍ ɇઅાેને અȋૅસે કરી શકાે છાે. 

Ribbon Toolbar ̍ વ̍વધ ટેʪ સાથ ેટૂ˔ ǐદાન કરે છે. દરેક ટેબ અન ેતેની સાથેના અાઇકાેʉ નીચે ǐમાણે 
છે: 

Ribbon Toolbar ના લાભાે: 

a. સામાʈ રીતે ઉપયાેગમા ંઅાવતા ̍વકˍા ેતરત જ ઉપલʤ કરાવ ેછે. 

b. દરેક ટેબમાં તેનાથી સંબં̍ ધત કમાંડ અન ેટૂ˔ ઉપલʤ છે. 

c. અાઇકાʉેથી ટૂ˔ની અાેળખ સરળ છે. 

d. તમે તમારી જ̋ͅરયાત મુજબ ટૂલબારમાં ફેરફાર કરી શકાે છા ેજમે કે તમે તમા̈́ં પાેતાનું ટેબ પણ ઉમેરી 
શકાે છાે જમેાં તમારી જ̋ͅરયાત મુજબના અલગ અલગ ટેબના કમાંડ અેક સાથે હાઈે શકે. 

4. દƺતાવજે ખાેલવા અને બધં કરવાની પɡ̍તઅાે (Opening and closing 
Documents) 

દƺતાવેજને (Document) ખાેલવા અન ેબંધ કરવા અેકદમ સરળ છે.   

4.1 દƺતાવજે (Document) ખાેલવાની પɡ̍ત: 

તમે નીચે દશાƙવેલ ચાર માંથી કાેઇપણ અેક રીતે ડાȂેુમɰે ખાેલી શકાે છાે.    

a. File Menu ɦારા: 

 Microsoft Word 2019 ખાેˑા પછી File ટેબ પર ̚ȃક કરાે. 

 Open ̍વકˍ પસંદ કરાે. 

 તમારી ફાઇલ ȱાં સેવ થયેલ હાેય તે ˺ ાન (નીચેની અાકૃ̍તમાં દશાƙ˗ા મુજબ This PC, OneDrive 
અથવા Browse) પસંદ કરાે. 
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 Open બટન પર ̚ȃક કરીને પસંદ કરેલી ફાઇલ ખાેલાે. 

b. Shortcut Key નાે ઉપયાેગ: 

 Ctrl + O દબાવા,ે ઉપર મુજબની ˲ીન ખુલશે જમેાં Browse ̚ȃક કરતા નીચે મુજબનાે Open 
Dialog Box ખાેલે છે. 

 
 

 ફાઇલ ̐સલેǶ કરાે અને Open બટન ̚ȃક કરી અથવા અɰેર કી દબાવી ફાઇલ ખાલેાે. 

c. તાજેતરમાં અાેપન થયેલ દƺતાવેજ (Document) ખાેલવા: 

 Microsoft Word 2019 ખાેˑા પછી Recent Documentsમાંથી તાજતેરના દƺતાવેજ પસંદ કરા.ે 
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d. Microsoft Word ડાȂેુમɰે પર ડબલ-̚ȃક કરવંુ: 

 Windows + E કી  દબાવાે અથવા Desktop પર અાવેલ This PC અાઇકાેન પર ̚ȃક કરાે જથેી  
નીચે મુજબ File Explorer ખુલશે જમેાથંી તમારા કƳʔુટરના લાેકેશનમાં Microsoft Word 2019 
ફાઇલ શાેધાે. 

 
o ફાઇલ અાઇકાેન પર ડબલ-̚ȃક કરતા તે સીધી Microsoft Word 2019માં ખૂલે છે. 

દƺતાવેજ(Document) બધં (Close)  કરવાની પɡ̍ત: 

તમે ફાઈલન ેનીચે વણƙવેલ  ǋણ માંથી કાેઇપણ રીતનાે ઉપયાેગ કરી બંધ કરી શકાે છાે     

a. File Menu ɦારા: 

 File ટેબ પર ̚ȃક કરાે. Close ̍વકˍ પસદં કરાે. ̀ે તમ ે ફેરફારાે સેવ કયાƙ ̍વના ફાઈલ બંધ 
કરવાનાે ǐયાસ કરાે છા ેતાે Microsoft Word 2019 તમને ફેરફાર સેવ કરવા (Save), સેવ ન 
કરવા (Don’t Save) અથવા સેવ રદ કરવાની (Cancel) પસંદગી માટે કહે છે. 

 Save બટન ̚ȃક કરતા ડાȂેુમɰે સેવ થઇ બંધ થશે. Don’t Save ̚ȃક કરતા ફાઈલ સેવ થયા 
વગર બંધ થશે જયારે Cancel ̚ȃક કરતા ફાઈલ બંધ થતી નથી. 
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b.  Shortcut Key નાે ઉપયાેગ:     

 Ctrl + W દબાવા,ે ̀ ે તમ ેફેરફારા ેસેવ કયાƙ ̍ વના ફાઈલ બધં કરવાનાે ǐયાસ કરાે છા ેતા ેMicrosoft 
Word તમને ફેરફાર સેવ કરવા (Save), સેવ ન કરવા (Don’t Save) અથવા સેવ રદ કરવાની 
(Cancel) પસંદગી માટે કહે છે. 

 Save બટન ̚ȃક કરતા ડાȂેુમɰે સેવ થઇ બંધ થશે. 

c. Close બટનનાે ઉપયાગે: 

 Word ̍વɱાેની ટાેચના ખૂણામાંના Close (×) બટન પર ̚ȃક કરાે. 

અગɔના સૂચનાે: 

 AutoSave ̍વકˍ સેટ કરા:ે ખાસ કરીને ȃાઉડ ડાȂેુમɰે માટે, જથેી ફેરફાર અાપમેળે સવે થાય. 
AutoSave સેટ કરવા માટે File > Options > Save માં  જઈ AutoSave Files…̍વકˍ ચેક 
કરાે. અાૅટાસેેવ તમારી ફાઇલને દર થાેડી સેકંડમાં સેવ કરે છે. ȱારે કાેઈ ફાઇલ OneDrive,મા ં
સǁં̋હત હાેય ɔારે તે ̋ડફાે˄ અાેન હાેય છે.  
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 AutoSave ̍વકˍ નીચે દશાƙ˗ા મુજબ ટાઈટલબારમાં પણ ઉપલʤ હાેય છે.     

 

 ફાઇલનાે બેકઅપ રાખા:ે તમા̈́ં મહɗનું કાયƙ ગુમાવાના ̀ેખમથી બચવા માટે તમારી ફાઇ˔નુ ં
બેકઅપ પેન ǉાઈવ અથવા અʈ અેȌનƙલ ˶ાેરેજ ડીવાઈસ પર રાખવંુ ̀ેઈઅ.ે 

 પાવર કટ અથવા અʈ કારણાેસર કƳʔુટર અચાનક બંધ/હ̲ગ થઇ ̀ય ɔારે બચવા માટે: 
Microsoft Word 2019માં Recover Unsaved Documents ̍વકˍ છે. AutoSave સેટ 
કરવા માટે File > Options > Save માં  જઈ Save Auto Recover… ̍વકˍ ચેક કરાે.   

4.2 સેવ અને સેવ અેઝ (Save અને Save As) 

Microsoft Word 2019 માં દƺતાવે̀ેને સાચવવા અટેલે કે Save કરવા માટે બે ̍વકˍા ેઉપલʤ છે: સેવ 
(Save) અને સેવ અેઝ (Save As). અા બંને ̍વકˍાે દƺતાવેજને સેવ કરવા માટે ઉપયાેગમાં લેવાય છે, પરંત ુ
બંનેમાં મહɗપૂણƙ તફાવત છે. 

a. સેવ (Save):  સેવ ̍ વકˍના ેઉપયાેગ તે દƺતાવેજમાં થયેલા ફેરફારાેને સચવાવવા માટે થાય છે જ ેપહેલથેી 
જ સેવ કરેલ હાેય છે. ̀ે તમે ડાેȂુમɰેને પહેલથેી જ નામ સાથે કƳʔુટર પર કાેઈ જƝયાઅે ફાઈલ તરીકે 
સેવ કરેલ હાેય તાે ફેરફારાે સીધા જ તે ફાઇલમાં સેવ થાય છે. ફેરફારાે સેવ કરવા માટે શાેટƙકટ Ctrl + S 
નાે ઉપયાેગ કરી શકાય છે. ઉદાહરણ તરીકે, ̀ે તમે કાેઈ દƺતાવેજ પર કામ કરી ર̈ા છાે અને તેમાં નવાે 
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કɰેɰ ઉમેરાે છા,ે તાે Save દબાવતા જ તે બદલાવ ફાઇલમાં ઉમેરાઈ જશ.ે Microsoft Word 2019માં 
મૂળભૂત રીતે દરેક ફાઈલના નામની પાછળ અȌેેƮશન .docx લાગે છે.      

b. સેવ અેઝ (Save As):  સેવ અેઝ ̍ વકˍનાે ઉપયાેગ દƺતાવેજની નકલ બનાવવા અથવા તેને નવા નામ 
કે નવા ˺ાન પર સાચવવા માટે થાય છે. અા ̍ વકˍ તમને ફાઇલને મૂળ અથવા અʈ ફામે̳ટમા ંસેવ (જમે 
કે .docx, .pdf, વગેરે) કરવાની પરવાનગી અાપે છે. તમે મળૂ દƺતાવેજને રાખીને તનેી નકલને અલગ 
રીતે સǁં̋હત કરી શકાે છા.ે સેવ અેઝનાે ઉપયાેગ કરીને દƺતાવેજને નવી જƝયાઅે સાચવવા માટે કીબાેડƙ 
શાેટƙકટ F12 નાે ઉપયાેગ કરી શકાય છે. 

સેવ અને સેવ તરીકે વȝેનાે તફાવત: 

̍વશેષતા સેવ (Save) સેવ અેઝ (Save As) 

ઉપયાેગ ફાઇલમાં કરેલ ફેરફારાે સાચવવા નવી ફાઇલ તરીકે નકલ બનાવવી 

ફાઇલનું નામ અે જ રહે છે બદલવા માટે તક અાપે છે 

˺ાન અે જ રહે છે નવંુ ˺ાન પસંદ કરી શકાય છે 

ફાેમ̳ટ બદલવુ ં શȂ નથી ફાઇલનું ફામે̳ટ બદલી શકાય છે 

 

કેવી રીતે સેવ કરવંુ: 

a. સેવ માટે:  ફાઇલ મેન ુપર ̚ȃક કરાે અને "સેવ" ̍વકˍ પસંદ કરાે. અથવા Ctrl + S દબાવા.ે 

b. સેવ અેઝ માટે: ફાઇલ મેન ુપર ̚ȃક કરાે અને Save As ̍વકˍ પસંદ કરાે. નીચે મજુબ ̍વɱા ેઅાેપન 
થશ ે 

 
c. નવંુ ˺ાન, નામ, અથવા ફાેમ̳ટ પસંદ કરાે અને Save બટન દબાવાે. 
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Save અને  Save As અા બંને ̍વકˍાે દƺતાવેજને સુર̐Ɩત રાખવામા ંમદદͅપ છે અને દƺતાવેજ સાથ ેકામ 
કરવાનંુ સરળ બનાવે છે. 

4.3 પેજ સેટઅપ (Page Setup) 

પેજ સેટઅપ અે દƺતાવેજના પેજનાે દેખાવ અને સુશાેભન કરવા માટે ઉપયાેગમાં લેવાતી મહɗપૂણƙ સુ̍વધા 
છે. પેજ સેટઅપ ɦારા તમે પેજનું કદ (Size), માજ̰ʉ (Margins), અાે̋ રઅɰેેશન  (Orientation), અન ે
અʈ વૈક̕ˍક સુ̍ વધાઅાેન ે̏નયં̍ǋત કરી શકાે છાે. પેજ સેટઅપ કરવા માટે Layout ટેબમાં અાવેલ Page 
Setup ǁુપમાં નીચે દશાƙ˗ા મુજબના ̍વ̍વધ ̍વકˍાે ઉપલʤ છે, : 

 

 
a. મા̏જʉ (Margins): મા̏જʉ અે પેજની ચારે બાજુ (ઉપર, નીચ,ે ડાબે, અને જમણે) રહેલા ખાલી જƝયા 

છે.  
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મા̏જʉના ̍વ̍વધ ̍વકˍા ેઅાવેલા છે જમે કે : 

 નાેમƙલ (Normal): ̋ડફાે˄ મા̏જʉ (1 ઇંચ). 

 નરેાે (Narrow): પાતળા મા̏જʉ. 

 માડેરેટ (Moderate): મɪમ માજ̰ʉ   

 વાઇડ (Wide): ̍વશાળ મા̏જʉ. 

 ક˶મ મા̏જʉ ɦારા તમે તમારી જ̋ͅરયાત મુજબ મા̏જʉ સેટ 
કરી શકાે છાે. 

 

 
 

b. અ̐ભમુખતા (Orientation): અ̑ભમખુતા અે પેજની ̋દશા નǲી કરે છે: Portrait અેટલે ઊભી ̋દશા 
(̋ડફાે˄), Landscape અેટલે અાડી ̋દશા. 

 
c. પેજનું કદ (Page Size):  દƺતાવેજ માટે પેજની સાઈઝ પસંદ કરી શકાય છે, જમે કે A4 (8.27 × 11.69 

ઇંચ) (̋ડફાે˄), . લટેર (8.5 × 11 ઇંચ). વગેરે, તમે ક˶મ સાઈઝ પણ સેટ કરી શકા ેછે. 
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d. કાેલʼ (Columns):  દƺતાવેજને અેક અથવા વધુ કાલેʼમાં ̍ વભા̏જત કરી શકાય છે. ઉદાહરણ તરીકે, 

ʈૂઝલેટર અથવા મેગે̏ઝન માટે કાેલʼ ઉપયાેગી છે. 
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e. પેજ ǒેક (Page Break): પેજની લેઅાઉટમાં ફેરફાર કરવા માટે નવા પેજ પર સામǁી શ̈́ કરવા માટે 
પેજ ǒેક ઉમેરાય છે. 

f. ગટર (Gutter): ગટર અે બાઇ̒ɱ̬ગ માટે ફાળવેલી વધારાની જƝયા છે, જ ે મȕુɗે ̌ǐ̔ɰ̬ગ માટે 
ઉપયાેગમા ંલેવાય છે. 

પેજ સેટઅપ કેવી રીતે કરવંુ: 

a. લઅેાઉટ મેન ુપર ̚ȃક કરાે. 

 
b. તમારી જ̋ͅરયાત મુજબનાે ̍વકˍ પસંદ કરાે: 

 મા̏જʉ માટે Margins પર ̚ȃક કરાે અને પસંદગી કરા.ે 
 અ̑ભમખુતા માટે Orientation પર ̚ȃક કરાે. 
 પેજનંુ કદ બદલવા માટે Size પર ̚ȃક કરાે. 

c. ̀ે વધુ ફેરફાર જͅરી હાેય, તા ે ફાઇલ > ̌ ǐɰ > પેજ સટેઅપ પર ̚ ȃક કરા ેજથેી Page Setup Dialog 
Box ખુલશે. ȱાં જ̋ͅરયાત મુજબ ફેરફાર કરવા માટેના ̍વ̍વધ ̍વકˍાે ઉપલʤ છે.. 
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પેજ સેટઅપનું મહɊ: 

 દƺતાવેજને ˗વ̗˺ત અને ˗ાવસા̍યક બનાવે છે. 

 ̌ǐ̔ɰ̬ગ માટે યાƝેય લેઅાઉટ તૈયાર કરવામાં મદદ કરે છે. 

 વાચંકને વાચંવામાં સરળતા રહે તેવંુ ફાેમ̳ટ ǐદાન કરે છે. 

ટંૂકમાં પેજ સેટઅપ અે દƺતાવેજના પેજને ક˶માઇઝ કરવા માટે મહɗપૂણƙ સાધન છે. મા̏જʉ, અ̑ભમખુતા, 
અને પેજનું કદ બદલવાથી દƺતાવેજ વધુ અાકષƙક અને ̌ǐ̔ɰ̬ગ માટે યાƝેય બન ેછે. 

4.4 ̌ǐɰ ̌ǐ˗ુ (Print Preview) 

̌ǐɰ ̌ǐ˗ ુ (Print Preview) અે દƺતાવેજને ̌ǐɰ કરતા પહેલાં તે કેવી રીતે દેખાશે તે ̀ેવા માટેની 
મહɗપૂણƙ સુ̍ વધા છે. અા સુ̍વધા ɦારા તમ ેદƺતાવેજના લેઅાઉટ, માજ̰ʉ, અને ફામે̳̋ટ̬ગની સમીƖા કરી 
શકાે છાે અને જͅરી ફેરફારાે કરી શકાે છાે. 

̌ǐɰ ̌ǐ˗ુ ̀ેવા માટેના નીચનેા પગલા અનુસરા:ે 

a. Microsoft Wordમાં ઉપરના ખૂણામા ંFile મેન ુપર ̚ȃક કરાે. 

b. પછી Print ̍વકˍ પસંદ કરાે. 

c. નીચે દશાƙ̠ ા મુજબની Print Pane ખુલશે, જમેાં ડાબી બાજુઅે ̌ǐɰ સે̋ ટ̬Ɲસ અને જમણી બાજુઅે 
દƺતાવેજનું પૂવાƙવલાેકન દેખાશે. 

 
̌ǐɰ ̌ǐ-˗ુ દર̍મયાન ઉપલʤ ̍વકˍાે: 

a. ઝૂમ ઇન અને ઝૂમ અાઉટ: દƺતાવેજને ન͂કથી ̀ેવા માટે ઝૂમ ઇન કરાે અથવા સંપૂણƙ પેજ ̀ેવા માટે 
ઝૂમ અાઉટ કરાે. 

ઝૂમ ઇન અને ઝૂમ અાઉટ પેજ ǒાઉ̏ઝ̬ગ 

 સે̋ ટ̬Ɲસ બદલવા 
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b. પેજ ǒાઉ̎ઝ̬ગ: દરેક પેજને અલગથી ̀ેવા માટે અાગળ અને પાછળ જવા માટેના બટનાેનાે ઉપયાેગ કરાે. 

c. સે̋ ટ̬Ɲસ બદલવા: મા̏જʉ, પેજનંુ કદ, અને ̌ǐɰ અાે̋ રયɰેશન (Portrait અથવા Landscape) 
બદલવા માટે સે̋ટ̬Ɲસ પસંદ કરાે. 

̌ǐɰ ̌ǐ-˗ુના ફાયદા: ̌ǐɰ ̌ǐ˗ુથી નીચે મુજબના ફાયદા થાય છે    

 દƺતાવેજના પેજ મા̏જʉ, હેડર-ફૂટર, અને લેઅાઉટની સમીƖા કરી શકાય છે. 

 ટેȌ અને ̌પǴર યાેƝય રીતે ગાેઠવાઈ છે કે નહ̯ તે ̀ેઈ શકાય છે. 

 ̌ǐ̔ɰ̬ગ માટે કુલ કેટલા પેજ છે તે ̀ણી શકાય છે. 

 ̀ે દƺતાવેજમાં કાેઈ ભૂલાે હાયે, તાે ̌ǐɰ કરતા પહેલા તેન ેસુધારવા માટે તક મળ ેછે. 

̌ǐɰ ̌ǐ-˗ુનાે ઉપયાેગ શા માટે જͅરી છે? 

 દƺતાવેજના ̌ǐ̔ɰ̬ગ માટે યાેƝય લઅેાઉટ સુ̏ન̏˛ત કરવા. 

 પેજની અનાવƸયક ભૂલાે ટાળવા. 

 ̌ǐ̔ɰ̬ગ ǐ̋ƿયામાં સમય અન ેકાગળની બચત કરવા. 

ટંૂકમાં ̌ ǐɰ ̌ ǐ-˗ુ અે ̌ ǐ̔ɰ̬ગ પહેલાં દƺતાવેજની સમીƖા કરવાની Ǘેˤ રીત છે. અા સુ̍ વધા તમને દƺતાવેજને 
વધુ ˗ાવસા̍યક અને સંપૂણƙ બનાવવા માટે મદદͅપ બને છે. 

4.5 દƺતાવજેનું ̌ǐ̔ɰ̬ગ (Printing of Document) 

દƺતાવેજનું ̌ǐ̔ɰ̬ગ અે દƺતાવેજને કાગળ પર છાપવા માટેની સરળ અને ઉપયાેગી સુ̍વધા છે. ̌ǐ̔ɰ̬ગ ǐ̋ƿયા 
દર̌મયાન તમે દƺતાવેજના પેજ લેઅાઉટ, પે̀ ેની સંȕા, અને અʈ ̌ǐ̔ɰ̬ગ સે̋ટ̬Ɲસને ક˶માઇઝ કરી શકાે 
છાે. 

દƺતાવેજ ̌ǐɰ કરવા માટે નીચેના પગલાં અનુસરાે: 

a. ફાઇલ મેનુ ખાેલાે: ˲ીનના ઉપરના ખૂણામાં File મેનુ પર ̚ȃક કરાે. ɔાંથી Print ̍વકˍ પસંદ કરાે. 

b. ̌ǐɰ પેનલ: ̌ǐɰ પેનલમાં, તમા̈́ં દƺતાવેજ ̌ǐɰ કરવા માટેની ̍વ̍વધ સે̋ટ̬Ɲસ દેખાશે. જમણી બાજુઅ ે
દƺતાવેજનુ ં̌ǐɰ ̌ǐ-˗ુ (Print Preview) ̀ેવા મળશ.ે 

c. ̌ǐɰર પસંદ કરા:ે Printer ̍વભાગમાં ̌ǐɰ કરવા માટે ઉપલʤ ̌ǐɰરને પસંદ કરાે. 

d. ̌ǐɰ સે̋ટ̬Ɲસ બદલાે: 

o Copies: ̌ǐɰ કરવા માટેની નકલાેની સંȕા પસંદ કરાે. 

o Pages: ̌ǐɰ કરવા માટેના પે̀ેની Ǘેણી પસંદ કરાે (જમે કે, "All Pages," "Current Page," 
અથવા ખાસ પેજ નબંર 1-5). 

o Orientation: પજેનાે અ̑ભમુખતા પસંદ કરાે (Portrait અથવા Landscape). 

o Margins: પજેના મા̏જʉ સેટ કરાે. 

o Paper Size: પેજનું કદ પસંદ કરાે (જમે કે, A4, Letter). 
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e. ̌ǐɰ કરાે: બધા સે̋ ટ̬Ɲસ સમાʏ થયા પછી, Print બટન પર ̚ȃક કરાે. 

 
̌ǐ̔ɰ̬ગ દર̍મયાન ɪાનમાં રાખવા માટેની બાબતાે: 

 દƺતાવેજ ̌ǐɰ કરવા પહેલાં ત ેયાƝેય રીત ેદેખાય છે કે નહ̯ તે ચકાસાે. 

 ̌ǐɰર ̀ેડાયેલ છે અને તે કામ કરી ર̈ંુ છે કે નહ̯ તે ખાતરી કરાે. 

 ફǸ જͅરી પે̀ ેને ̌ǐɰ કરવા માટે પજે રેƮજ પસંદ કરાે. 

ટંૂકમાં દƺતાવેજનું ̌ǐ̔ɰ̬ગ અે Microsoft Word 2019 ની અેક મહɗપૂણƙ સુ̍વધા છે, જ ેદƺતાવેજને ̌ǐɰ 
કરીને હાડƙકાેપી ̄ͅપમાં ઉપયાેગમાં લેવા માટે મદદ કરે છે. ̌ǐ̔ɰ̬ગ પહેલાં ̌ǐɰ ̌ǐ˗ુ અને સે̋ટ̬Ɲસ 
ચકાસવાથી તમે દƺતાવેજને ˗ાવસા̍યક રીતે ǐƺતતુ કરી શકાે છાે અન ેભૂલાે ટાળી શકા ેછા.ે 

5. લખાણની રચના અન ેહેરફેર/ફેરફાર (Text Creation and Manipulation) 

Microsoft Word 2019 અે લખાણ વાળા ડાેȂુમɰ્ેસ બનાવવા, તમેાં સુશાભેન અને હેરફેર/ફેરફાર કરવા 
માટેની વપરાશકતાƙ માટે ઉપયાેગમાં સરળ અે̖ ʕકેશન છે. તે તમને દƺતાવેજમાં લખાણ ટાઇપ કરવા, ફામે̳̋ટ̬ગ 
કરવા, અને તેમાં હેરફેર/ફેરફાર કરવા માટે નીચે વણƙ˗ા મુજબના ̍વ̍વધ ̍વકˍા ેǐદાન કરે છે. જ ેHome 
ટેબમાંથી ઉપલʤ થાય છે.   

 
a. ટેȌ રચના (Text Creation) / લખાણ લખવા માટેના પગલાં: 

 નવાે દƺતાવજે ખાેલાે: Microsoft Word 2019ખાેલાે અને Blank Document પસંદ કરાે. 

 લખાણ ટાઇપ કરાે: કીબાેડƙનાે ઉપયાેગ કરીન ેતમા̈́ં લખાણ લખાે. 

 ફાેમ̳̋ટ̬ગ ઉમેરા:ે લખાણને વધુ અાકષƙક બનાવવા માટે Font Style, Size, અન ેColor પસંદ કરાે. 
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b. ટેȌ ફાેમ̳̋ટ̬ગ (Text Formatting): લખાણને સુંદર રીતે ǐƺતુત કરવા માટે ફાેમ̳̋ટ̬ગના ̍વ̍વધ 
̍વકˍાે ઉપલʤ છે: 

 ફાેɰ પસંદગી: લખાણ માટે ̍વ̍વધ ˶ાઇલઅા,ે જમે કે Arial, Times New Roman, વગેરે પસંદ 
કરાે. 

 ફાેɰ સાઇઝ: લખાણને માેટંુ કે નાનું બનાવાે. 

 ફાેɰ કલર: લખાણના રંગ બદલાે. 

 બાે̂  (Bold): લખાણને ઘાટંુ દેખાવ માટે બાેˆ કરાે. 

 ઇટા̏લક (Italic): લખાણને ǋાસુ  કરવા માટે. 

 અɱરલાઇન (Underline): લખાણની નીચે રેખા ઉમેરાે. 

c. લખાણમાં હેરફેર/ફેરફાર કરવાે (Text Manipulation): માઇƿાેસાેʘ વડƙમાં લખાણ સાથે હેરફેર 
કરવા માટેના ̍વકˍાે: 

 કટ, કાેપી, અને પે˶ (Cut, Copy, Paste): 

o Cut: લખાણને દƺતાવેજમાથંી કટ કરીને અʈ ˺ાન પર મુકવા. 

o Copy: લખાણની નકલ (કાેપી) કરવા. 

o Paste: કટ અથવા કાેપી કરેલા લખાણને અʈ ˺ાન પર મુકવા. 

 ફાઇɱ અન ે̋રʕેસ (Find and Replace): 

o Find: દƺતાવેજમાં ચાેǲસ શʣ અથવા વાȂ શાેધા.ે 

o Replace: શાેધેલા શʣને અʈ શʣ સાથે બદલા.ે 

 લખાણની ગાેઠવણ (Alignment): 

o લખાણને Left, Centre, Right, અથવા Justify ગાેઠવાે. 

d. લખાણન ે˶ાઇ̏લશ બનાવવંુ: 

 ટેȌ હાઇલાઇટ: લખાણને ̍વશેષ ͅપમાં દશાƙવવા માટે હાઇલાઇટ કરાે. 

 બુલેટ્સ અને નંબ̋ર̬ગ: યાદી બનાવવા માટે બુલેટ્સ અથવા નંબ̋રગ̬ ઉમેરા.ે 

 ટેબ અને ઇɱેɰ: લખાણને ગાેઠવવા માટે ટેʪ અને ઇɱેɰનાે ઉપયાેગ કરાે. 

e. ટેȌ સાથે ̍વશેષ સુ̍ વધાઅાે: 

 ǉાેપ કૅપ (Drop Cap): Insert ટેબમાં Text ǁુપમાં અાવેલ  અા ̍વકˍ લખાણના ǐથમ અƖરને 
માેટંુ અને અાકષƙક બનાવવા વપરાય છે. 
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 ટેȌ ઈફેǶ્સ: શેડા,ે Ɲલા,ે અથવા ̋રưલેȆન જવેા લખાણ પર ̍વશેષ ǐભાવ ઉમેરાે. 

 
લખાણ રચના, સશુાેભન અને ફેરફાર/હેરફેર અે Microsoft Word 2019ની મȕુ સુ̍વધાઅાેમાંની અેક 
છે. અા સુ̍ વધાઅાેનાે ઉપયાગે કરીન ે તમે લખાણન ે ˗વ̗˺ત અને અાકષƙક બનાવી શકાે છા,ે જ ેતમારા 
દƺતાવેજને વધુ ǐભાવશાળી બનાવે છે. 

5.1 દƺતાવજે રચના (Document Creation) 

Microsoft Word 2019 અે દƺતાવે̀ે બનાવવા માટેનંુ અેક લાકે̌ǐય અને શ̘Ǹશાળી સાધન છે. અા 
સાેʘવેરનાે ઉપયાેગ કરીને તમે નવાે દƺતાવેજ બનાવી શકાે છા,ે જમેાં લખાણ, ̌પǴર, ટેબલ, ̍ વ̍વધ અાકાર 
અને અʈ ઘટકા ેઉમેરવા માટેના ̍વકˍા ેઉપલʤ છે. માઇƿાેસાʘે વડƙમાં નવા ેદƺતાવેજ બનાવવા માટે 
Microsoft Word 2019 અે̖ʕકેશન શͅ કરા ેઅન ેBlank Document ̍વકˍ પસંદ કરાે, ̀ે જͅર હાેય, 
તાે Templates માંથી કાેઈ ̋ડઝાઇન પસંદ કરી શકાે છાે. ɔારબાદ તમે દƺતાવેજમા ંસામǁી ઉમેરી શકાે છાે, 
કીબાેડƙ ɦારા દƺતાવેજમાં લખાણ ટાઇપ કરાે. લખાણ માટે ફાેમ̳̋ટ̬ગ ̍વકˍાેના ેઉપયાેગ કરાે. જͅર હાયે તાે તમ ે
Insert મેનુમાંથી Pictures અથવા Shapes ઉમેરાે તેમજ ડેટા રજૂ કરવા માટે કાેɣ ક ઉમરેી શકાે છાે. દƺતાવેજ 
તૈયાર થયા બાદ File > Save As પર ̚ȃક કરા,ે ફાઇલનું નામ અાપાે અને તે સંǁ̋હત કરવા માટે ˺ાન 
પસંદ કરાે. .docx (̋ડફાે˄), .pdf, અથવા અʈ જͅરી ફાેમ̳ટ પસંદ કરી શકા ેછા.ે 
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દƺતાવેજ રચના Microsoft Word 2019 ની ǐાથ̌મક અને સાૈથી મહɗપૂણƙ સુ̍ વધા છે. તમે નવાે દƺતાવેજ 
બનાવી તેને ફાેમ̳̋ ટ̬ગ અને ̋ડઝાઇન ɦારા વધુ ˗ાવસા̍યક બનાવી શકાે છાે. અા સુ̍વધા દƺતાવેજને 
˗̋કતગત અને ǐાેફેશનલ જͅરીયાતાેને અનુͅ પ ગાેઠવવામાં મદદͅપ છે. 

5.2 ટેȌનું સંપાદન (Editing Text) 

ટેȌનંુ સંપાદન અે દƺતાવેજમાં લખેલ સામǁીમાં ફેરફાર કરવા માટેની મહɗપણૂƙ સુ̍ વધા છે. અા સુ̍વધા 
ɦારા તમે દƺતાવેજને વધુ ˗ાવસા̍યક અને સચાટે બનાવી શકાે છાે. ટેȌ અેડીટ̯ગમાં માઉસ કે કી-બાેડƙ વડે 
લખાણ પસંદ કરવું, લખાણને કટ, કાેપી, અને પે˶  કરવંુ, દƺતાવેજમાં શʣને અʈ શʣ સાથે બદલવાે, 
લખાણને દુર કરવું, ફાેમ̳̋ ટ̬ગ બદલવંુ, લખાણને ગાેઠવવંુ, લખાણને હાઇલાઇટ કરવંુ, લખાણ વȝે નવંુ 
લખાણ ઉમેરવંુ વગેરેનાે સમાવેશ થાય છે. અામ ટેȌ અેડીટ̯ગ  અે Microsoft Word 2019 ની મૂળભૂત 
અને ખૂબ જ ઉપયાેગી સુ̍વધા છે. અા સુ̍ વધા ɦારા તમ ેદƺતાવેજને વધુ ˗વ̗˺ત, ˾ˠ અને અાકષƙક 
બનાવી શકાે છા.ે લખાણમાં ફેરફાર કરવા માટે ઉપલʤ સાધનાેના યાેƝય ઉપયાગેથી તમે દƺતાવેજને 
˗ાવસા̍યક ƺતરે તૈયાર કરી શકાે છાે. 

5.3 લખાણ પસંદગી (Text Selection) 

લખાણની પસંદગી સામાʈ પરંતુ અɔંત ઉપયાેગી સુ̍વધા છે. તે લખાણ પર ̍વ̍વધ ̋ƿયાઅાે કરવા માટે અેક 
મહɊપૂણƙ પગલું છે. પસંદગીની યાેƝય પɡ̍તઅાે ̀ણવાથી તમે તમા̈́ં કાયƙ વધુ ઝડપી અને અસરકારક 
બનાવી શકાે છાે.  

લખાણ પસંદગીની ઉપયાે̎ગતાઅાે: લખાણ પસંદગી  અે દƺતાવેજ સાથે કાયƙ કરવા માટેનું ǐાથ̌મક અને 
મહɗપૂણƙ કાયƙ છે. લખાણ પસંદ કયાƙ પછી, તમે તેને કટ, કાેપી, પે˶ , ફાેમ̳̋ ટ̬ગ અથવા અʈ ફેરફારાે કરી શકા ે
છાે. 

 ફાેમ̳̋ટ̬ગ માટે: પસંદ કરેલા લખાણને બાે̂ , ઇટા̏લક, અɱરલાઇન, અથવા કલર બદલાે. 

 કટ, કાેપી, અને પે˶ માટે: પસંદ કરેલા લખાણ પર અા ̋ƿયાઅાે કરા.ે 

 ફાઇɱ અન ે̋રʕેસ માટે: ચાેǲસ લખાણ શાેધી તેને બદલવું. 

 ફાેɰ અથવા પેરાǁાફ ગાેઠવણ: પસંદ કરેલા લખાણ માટે લેઅાઉટ ફેરફાર કરાે. 

લખાણ પસંદ કરવા માટેની પɡ̍તઅા:ે 

a. માઉસનાે ઉપયાેગ: 

 લખાણ પસંદ કરવા માઉસનાે કસƙર લખાણની શͅઅાત પર મૂકાે અને ડાબું બટન દબાવીને 
લખાણની અંત સુધી ખ̲ચાે. 

 કાેઈ શʣ પસંદ કરવા માટે  શʣ પર ડબલ-̚ȃક કરાે. 

 વાȂ પસંદ કરવા  Ctrl કી દબાવી રાખીને વાȂ પર ̚ȃક કરાે. 

 પેરાǁાફ પસંદ કરવા પેરાǁાફની અંદર ઝડપથી ǋણવાર ̚ȃક કરાે. 

b. કીબાેડƙનાે ઉપયાેગ: 

 શʣ પસંદ કરવા માટે Ctrl + Shift + Arrow Keys નાે ઉપયાેગ કરાે. 
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 લાઇન પસંદ કરવા માટે Shift + End દબાવા.ે 

 સંપૂણƙ દƺતાવેજ પસંદ કરવા માટે Ctrl + A દબાવાે. 

c. કાેઈ ̍વ̐શˠ ̍વƺતાર પસંદ કરવાે: લખાણનાે ચાǲેસ ભાગ પસંદ કરવા માટે Alt કી દબાવીને માઉસ 
ખ̲ચાે. 

d. મ̓˄પલ ટેȌ પસંદગી: ̍વ̍વધ જƝયાઅાે પરના લખાણને પસંદ કરવા માટે Ctrl કી દબાવી રાખીને 
માઉસનાે ઉપયાગે કરાે. 

̀ે તમારાથી વધુ લખાણ પસંદ થઇ ̀ય તા ેShift + Arrow Keys ના ેઉપયાેગ કરીને પસંદગી ઘટાડા ેઅન ે
ફરીથી પસદં કરવા માટે માઉસ ̚ȃક કરાે અને નવી પસંદગી કરાે. 

5.4 કટ, કાેપી અને પે˶  (Cut, Copy and Paste)  

કટ, કાેપી અને પે˶અે લખાણ અથવા અʈ સામǁીને દƺતાવેજમાં ખસેડવા (Move) કરવા અથવા નકલ 
(Copy) કરવા માટેની મૂળભૂત અને ઉપયાેગી સુ̍ વધાઅાે છે. કટ, કાેપી અને પે˶ અે દƺતાવેજ સાથે કામ 
કરવાનંુ સરળ બનાવે છે. અા સુ̍ વધાઅાેનાે યાƝેય ઉપયાગે કરીને તમે લખાણ અને અʈ સામǁીને ગાેઠવીન ે
દƺતાવેજને વધુ કાયƙƖમ અને ˗વ̗˺ત બનાવી શકા ેછા.ે 
 

 
ઉદાહરણ માટે અેક પેરાǁાફન ેદƺતાવેજના અેક ભાગમાથંી બી̀ ભાગમાં ખસેડવા માટે તમે કટ અને પે˶ના ે
ઉપયાેગ કરી શકાે છા.ે અેક ટેબલ અથવા ̌પǴરની નકલ બનાવવા માટે તમ ેકાેપી અન ેપે˶ નાે ઉપયાેગ કરી 
શકાે છાે. 

કટ (Cut) નાે ઉપયાેગ: કટ ફંકશનનાે ઉપયાેગ કરીને તમે લખાણ અથવા અʈ સામǁીને દƺતાવેજમાંથી દૂર 
કરી તેને અʈ ˺ાન પર મૂકી શકાે છાે. 

 કટ કરવા માટે લખાણ અથવા વƺતુ પસંદ કરાે. 

 Home > Cut ̍વકˍ પર ̚ȃક કરાે અથવા Ctrl + X દબાવાે. 

 પસંદ કરેલું લખાણ દƺતાવેજમાંથી દૂર થઈ જશે અને ̚ȃપબાેડƙમાં ˶ાેર થશ.ે 

કાેપી (Copy)ના ેઉપયાેગ: કાેપી ફંકશનથી તમે લખાણ અથવા સામǁીની નકલ બનાવી શકાે છાે અને તે 
મૂળ ˺ાન પર જ રહે છે. 

 કાેપી કરવા માટે લખાણ અથવા વƺતુ પસંદ કરાે. 

 Home > Copy ̍વકˍ પર ̚ȃક કરાે અથવા Ctrl + C દબાવા.ે 
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 લખાણ ̚ȃપબાેડƙમાં નકલ થશે. 

પે˶  (Paste)ના ેઉપયાેગ: પે˶ ફંકશનથી તમે કટ અથવા કાેપી કરેલા લખાણને દƺતાવેજમાં પસંદ કરેલી 
જƝયાઅે મૂકી શકાે છા.ે 

 ȱાં તમ ેલખાણ મૂકવા માંગા ેછા ેતે ˺ાન પર કસƙર મૂકાે. 

 Home > Paste ̍વકˍ પર ̚ȃક કરાે અથવા Ctrl + V દબાવા.ે 

 લખાણ કે સામǁી નવી જƝયાઅે દાખલ થશ.ે 

 Paste Options: પે˶ કયાƙ પછી પે˶  કરેલા લખાણનું ફાેમ̳̋ટ̬ગ બદલવા માટે ̍વકˍાે ઉપલʤ છે 
(જમે કે Keep Source Formatting, Merge Formatting, Keep Text Only). 

 
 Clipboard History ̀ેવા માટે Windows Key + V દબાવાે.તમે ̚ȃપબાેડƙ પર નકલ કરેલા 

છે˒ા કેટલાક અાઇટʼની યાદી નીચે મુજબની ̍વɱામેાં ̀ેઈ શકાે છાે.  

 

1.1 ફાેમ̳ટ પેઇɰર સાથ ેપે˶ કરાે (Paste with Format Painter) 

ફાેમ̳ટ પેઇɰર શંુ છે? 
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ફાેમ̳ટ પેઇɰર અેક ઉપયાેગી ટૂલ છે, જનેાે ઉપયાેગ કરીને તમે કાેઈ લખાણ અથવા અાʠેેǶના ફાેમ̳̋ટ̬ગ (જમે 
કે ફાɰે, રંગ, સાઈઝ, બાેડƙર)ને કાૅપી કરીને બી̀ લખાણ અથવા અાેʠેǶ પર લાગુ કરી શકાે છાે. અા ટૂલ 
સમય બચાવવા અને દƺતાવજેમાં અેકસરખા ેદેખાવ લાવવા માટે ખૂબ ઉપયાેગી છે. 

ફાયદા: 

 ફાેમ̳ટ પેઇɰરનાે ઉપયાગે કરવાથી દƺતાવેજમાં સરખંુ ફામે̳̋ટ̬ગ ̀ળવવંુ સરળ બને છે. 

 સમય અને મહેનત બચાવ ેછે. 

 ǐાફેેશનલ અને અેકસરખા ેદેખાવ તૈયાર કરવામાં મદદͅપ છે. 

ફાેમ̳ટ પેઇɰરનાે ઉપયાગે કેવી રીતે કરવા?ે 

ફાેમ̳ટ પેઇɰર સાથે લખાણ પે˶ કરવા માટે નીચે મજુબના પગલાં અનુસરાે: 

ફાેમ̳ટ પસંદ કરા ે

 જનેા ફાેમ̳ટને તમે નકલ કરવા માંગાે છા ેતે લખાણ અથવા અાેʠેǶને પસંદ કરા.ે 

 "Home" ટેબમા ંફાેમ̳ટ પેઇɰર અાઇકાેન પર ̚ȃક કરાે. (ફાેમટ̳ પેઇɰર અાઇકાેન અેક ǒશ 
જવંુે દેખાય છે.) 

ફાેમ̳ટ લાગુ કરાે 

 હવે, માઉસનંુ કસƙર ǒશના અાકારમાં ફેરવાઈ જશે. 

 ȱાં તમ ેનકલ કરેલું ફાેમ̳ટ લાગુ કરવા માંગાે છા ેતે લખાણ અથવા અાેʠેǶ પર ̚ȃક કરાે. 

ફાેમ̳ટ પેઇɰરનાે ઉપયાેગ શેƯસ, ટેȌ બાȋે, અને ટેબલ સે̝  પર પણ થઈ શકે છે. ̀ે ફાેમ̳̋ટ̬ગ યાેƝય રીત ે
લાગુ ન થાય, તાે Undo કી (Ctrl + Z) દબાવીને ફરી ǐયાસ કરા.ે ફાેમટ̳ પેઇɰર Microsoft Word 2019માં 
કામ કરવાની ઝડપ અને કાયƙƖમતા વધારવાનું અેક Ǘેˤ સાધન છે. 

5.5 ફાɰે અને સાઇઝ પસંદગી (Font and Size selection) 

ફાેɰ અને ફાɰે સાઇઝ શું છે? 

ફાેɰ અને સાઇઝ પસંદગી દƺતાવેજના લખાણના દેખાવ અને સાઈઝને ̏નયં̍ǋત કરવા માટે મહɗપૂણƙ છે. 
ફાેɰ અટેલે  લખાણ લખવા માટેની ˶ાઇલ અથવા દેખાવ. ઉદાહરણ તરીકે Calibri, Times New 
Roman, Arial વગેરે. ફાɰે સાઇઝ લખાણના અƖરાનેા કદને દશાƙવે છે, જ ેપાઈેɰ્સ (pt)મા ંમાપવામાં અાવે 
છે. સામાʈ રીતે 11pt થી 14pt સાૈથી વધુ વપરાતી સાઇઝ છે. 

72 pt = 1 Inch  

ફાેɰ અને સાઇઝ કેવી રીત ેપસંદ કરવંુ? 

ફાેɰ પસંદ કરવા માટે: 

 દƺતાવેજમા ંતમે જનેા ફાɰે બદલવા માંગાે છાે તે લખાણ ̐સલેǶ કરાે. 

 Home ટેબમાં ફાેɰ ǉાૅપડાઉન મેનુ  પર ̚ȃક કરાે. 
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 ઉપલʤ ફાɰેમાંથી તમારી પસદંગી કરાે. જમે કે Calibri અથવા Arial. 

ફાેɰ સાઇઝ પસંદ કરવા માટે: 

 ̐સલેǶ કરેલા લખાણ માટે Home ટેબમા ંફાેɰ સાઇઝ ǉાૅપડાઉન મેનુ  પરથી યાƝેય સાઇઝ 
પસંદ કરાે. અથવા સાઇઝ ટાઇપ કરીને Enter દબાવાે. 

નǲી કરેલી ̋ડફાે˄  સે̋ટ̬Ɲસ બદલવા: 

 ̀ે તમારે ડીફાે˄  સે̋ટ̬Ɲસ બદલવા હાેય તાે તમે Font ડાયલાૅગ બાȋેનાે ઉપયાેગ કરી શકાે છાે  જનેે  
ખાેલવા માટે શાેટƙકટ કી Ctrl + D દબાવાે જથેી નીચે મુજબના ેFont ડાયલાગે બાƖે અાેપન થાય છે 
જમેાં  તમા̈́ં પસંદ કરેલંુ ફાɰે અને સાઇઝ સેટ કરીને Set as Default પર ̚ȃક કરાે. 

 

 
યાદ રાખાે: 

 ̀ે તમે ફાɰે અન ેસાઇઝ ઝડપી બદલવા માંગતા હાેવ તાે Shortcut કીનાે ઉપયાેગ કરી શકાે છાે: 

o Ctrl + Shift + F: ફાɰે બદલવા માટે. 

o Ctrl + Shift + P: સાઇઝ બદલવા માટે. 

 Grow Font અને Shrink Font  અાઇકાેનનાે ઉપયાગે કરીન ેસાઇઝ વધારી અથવા 
ઘટાડી શકા ેછા.ે 

ફાેɰ અને સાઈઝ સેટ કરવાના ફાયદા: 
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 લખાણને વાંચવા યાƝેય અન ેઅાકષƙક બનાવે છે. 

 ǐાફેેશનલ દƺતાવેજ તયૈાર કરવામાં મદદͅપ છે. 

 ǐાજેǶે અથવા લઅેાઉટ અનસુાર ફાેમ̳̋ટ̬ગને સરળ બનાવે છે. 

ફાેɰ અને સાઇઝ પસદંગીનાે યાેƝય ઉપયાેગ કરીને તમે દƺતાવેજને વધુ અાકષƙક અન ેǐભાવશાળી બનાવી 
શકાે છાે. 

5.6 લખાણનું અેલાઇʆેɰ (Alignment of Text) 

ટેȌ અેલાઇʆેɰ શંુ છે? 

લખાણનું અેલાઇʆેɰ અે ǐ̋ƿયા છે, જમેાં દƺતાવેજના પઇેજ પર લખાણ કેવી રીતે ગાેઠવવંુ તે નǲી કરાય 
છે. અેલાઇʆેɰ લખાણને વધુ સારા ેઅને ̠ ાવસા̍યક દેખાવ અાપવાનું મહɗપૂણƙ સાધન છે. વડƙમાં મુȕɗે 
ચાર ǐકારના અેલાઇʆેɰ ઉપલʤ છે જનેે Home ટેબમાં અાવેલા Paragraph ǁુપમાંથી મળેવી શકાય છે.   

 
અેલાઇʆેɰના ǐકારાે: 

a. લʘે અેલાઇɱ (Left Aligned): તેમાં લખાણ પજેની ડાબી બાજુ ગાેઠવાય છે. ̋ડફાે˄ માડે તરીકે 
ઉપયાેગ થાય છે. તેની શાેટƙકટ કી Ctrl + L છે. 

b. રાઇટ અેલાઇɱ (Right Aligned): તેમા ંલખાણ પેઇજના જમણી બાજુ ગાઠેવાય છે. તે ̍વ̍વધ ટેબલ 
અને શીષƙક માટે ઉપયાેગી છે. તેની શાેટƙકટ કી Ctrl + R છે.  

c. સɰેર અેલાઇɱ (Centre Aligned): તમેાં લખાણ પેઇજના મɪમાં ગાેઠવાય છે. તે શીષƙક અન ે
ટાઈટલ માટે અાદશƙ અેલાઇʆેɰ છે. તેની શાેટƙકટ કી Ctrl + E છે. 

d. જ̔˶ફાઈડ (Justified): તમેાં લખાણ ડાબી અન ેજમણી બંન ેબાજુ સમાન ગાઠેવાય છે. તે ˗ાવસા̍યક 
દƺતાવે̀ે અન ેઅખબારી લેઅાઉટ માટે ઉપયાેગી છે. તેની શાેટƙકટ કી Ctrl + J છે. 

લખાણનું અેલાઇʆેɰ કેવી રીતે બદલવંુ? 

જનેા અેલાઇʆેɰમાં ફેરફાર કરવાે છે તે લખાણ અથવા પેરાǁાફ પસંદ કરાે. Home ટેબમા ંParagraph પર 
̀અાે. તમારે જ ેઅેલાઇʆɰે કરવંુ હાેય તનેા અાઇકાેન પર  ̚ȃક કરાે. વૈક̕ˍક રીતે, તમ ે
અાગળ જણાવેલ શાેટƙકટ કીનાે ઉપયાેગ કરીને પણ અેલાઇʆેɰ બદલી શકાે છાે. ̀ે તમે માટેા દƺતાવેજ માટે 
અેકસમાન ગાેઠવણી ઇȞતા હાેવ, તાે Home ટેબમાં અાવેલ નીચે મુજબના Styles ǁુપના ેઉપયાેગ કરાે. 
લખાણ અને ̌પǴરના સમƮવય માટે યાƝેય અેલાઇʆɰે પસંદ કરાે. 
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Microsoft Word 2019માં ટેȌ અેલાઇʆેɰ અે દƺતાવેજને વધુ અાકષƙક અને ˗ાવસા̍યક બનાવવાનુ ં
ઉɇમ સાધન છે. તેનાે યાƝેય રીતે ઉપયાેગ કરીને દƺતાવેજને વધુ ǐભાવશાળી બનાવી શકાય છે. 

6. ટેȌ ફાેમ̳̋ટ̬ગ (Formatting the Text) 

ટેȌનું ફાેમ̳̋ટ̬ગ શું છે? 

લખાણનું ફાેમ̳̋ટ̬ગ અે Microsoft Word 2019માં ઉપલʤ સુ̍ વધા છે, જ ેદƺતાવેજના લખાણનાે દેખાવ 
અને ˶ાઇલમાં ફેરફાર કરવા માટે વપરાય છે. અામા ં ફાેɰ, સાઇઝ, રંગ, ˶ાઇલ, અેલાઈનમેɰ વગેરેના ે
સમાવેશ થાય છે. યાƝેય ફાેમ̳̋ટ̬ગ દƺતાવેજને વધુ અાકષƙક અને ˗વસા̍યક બનાવે છે. 

ફાયદા: ફાેમ̳̋ટ̬ગ દƺતાવેજને વધુ અાકષƙક અને વાચંવામાં સરળ બનાવે છે. ̠ ાવસા̍યક દƺતાવે̀ેની રચનામા ં
મદદͅપ છે અને સચાેટ મા̋હતી ǐƺતુત કરવા માટે ઉપયાેગી છે. 

 

ટેȌ ફાેમ̳̋ટ̬ગના મȕુ ઘટકાે: નીચે ટેȌ ફાેમ̳̋ટ̬ગ માટેના ̍વ̍વધ ઘટકાે ̍વષે સમ̀વેલ છે જનેાે ઉપયાગે 
કરી તમે દƺતાવેજને અાકષƙક બનાવી શકાે છા.ે  

 ફાેɰ અને સાઇઝ:  લખાણ માટે યાેƝય ફાɰે અન ેસાઇઝ પસંદ કરા.ે 

 ફાેɰ ˶ાઇલ બદલવા માટે Home ટેબમાં અાવેલ Font ǁુપ માંથી 
ǉાૅપડાઉન મેનુથી પસંદ કરાે.  

 ફાેɰ બદલવા માટેની શાેટƙકટ કી Ctrl + Shift + F તથા ફાɰે સાઇઝ બદલવા માટેની શાટેƙકટ કી 
Ctrl + Shift + P છે. 

a. ફાેɰ ˶ાઇલ:  

 Bold: લખાણને માેટંુ અને ઘાટંુ બનાવે છે. (Ctrl + B) 
 Italic: લખાણને ǋાસુ બનાવે છે. (Ctrl + I) 
 Underline: લખાણની નીચે રેખા દારેે છે. (Ctrl + U) 

b. લખાણનાે રંગ:  

 લખાણ ને કલર અાપી શકાય છે. 
 Home ટેબમાં Font ǁુપ માંથી Font Color અાઇકાેન પર ̚ȃક કરીન ે તમારી પસંદગી 

અનુસાર રંગ પસંદ કરાે. 

c. ટેȌ હાઇલાઇટ:  

 લખાણન ેકાેઈ રંગ વડે ચમકાવવંુ અથવા હાઈલાઈટ કરવંુ. 
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 Home ટેબમાં Font ǁુપ માંથી Text Highlight Color  અાઇકાેનનાે ઉપયાેગ કરીને લખાણ 
હાઇલાઇટ કરાે. 

d. ટેȌ અેલાઇʆેɰ: 

 લખાણને ડાબ,ે જમણે, મɪમાં અથવા જ̔˶ફાઈ (બંને બાજુ સરખી રીતે રહે તેમ) ગાેઠવાે. 
 Home ટેબમાં Paragraph ǁુપમાં અાવેલ   અાઇકાેન ̚ȃક કરાે. 
 શાેટƙકટ: Ctrl + L (Left Align), Ctrl + E (Centre Align), Ctrl + R (Right Align), Ctrl + J 

(Justified). 

e. બુલટે અને નʳ̋ર̬ગ: 

 બુલેટ પાેઈɰ્સ અથવા ƿમમાં સȕંા ઉમેરવા માટે ઉપયાેગ કરાે. 
 Home ટેબમાં Paragraph ǁુપમાં અાવેલ બુલેટ્સ અથવા નʳ̋રગ̬  અાઇકાને 

̚ȃક કરા.ે 

f. પેરાǁાફ ફાેમ̳̋ટ̬ગ: 

 Home ટેબમાં અાવેલ Paragraph ǁુપમાં જમણી બાજુ નીચે અેરાે પર ̚ȃક કરતા નીચે મુજબનાે 
Paragraph Dialog ખુલે છે જમેાં તમે લાઇન ˾ે̐સ̬ગ, મા̏જ̭ન અને ઈɱેɰ સેટ જવેા ̍વકˍાેના ે
ઉપયાેગ કરી શકાે છા.ે તેના માટે તમે શાટેƙકટ કી Alt + H + P + G નાે ઉપયાેCtrl ગ કરી શકાે છાે. 

 
ફાેમ̳̋ટ̬ગ કેવી રીતે કરવંુ? 
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ફાેમ̳ટ કરવા માટે સાૈ ǐથમ લખાણ પસંદ કરાે. Home ટેબમાંથી ઉપર વણƙવેલ માંથી જͅરી ̍વકˍાે પસંદ કરા.ે 
શાેટƙકટ કીનાે ઉપયાેગ કરીને ઝડપી ફેરફાર કરાે. અેકસમાન દેખાવ માટે Styles ̍વકˍનાે ઉપયાેગ કરાે. 
ફાેમ̳̋ટ̬ગના માટેા ફેરફારાે માટે Format Painter ટૂલના ેઉપયાેગ કરાે. 

Microsoft Word 2019માં ટેȌનંુ ફાેમ̳̋ટ̬ગ દƺતાવેજને સુંદર અને ˗વ̗˺ત બનાવવાનું અકે શ̘Ǹશાળી 
સાધન છે. યાƝેય ફાેમ̳̋ટ̬ગનાે ઉપયાેગ કરીન ેતમે તમા̈́ં કામ ǐભાવશાળી બનાવી શકા ેછા.ે 

6.1 પેરાǁાફ ઈɱે̔ɰ̬ગ (Paragraph Indenting) 

પેરાǁાફ ઈɱે̔ɰ̬ગ શંુ છે? 

પેરાǁાફ ઈɱે̔ɰ̬ગ અ ેપેરાǁાફની શͅઅાત અથવા પેરાǁાફના કેટલાક ભાગને મા̏જન̭થી દુર કરવા અથવા 
ન͂ક લાવવાની ǐ̋ƿયા છે. તે દƺતાવેજના લેખન ˶ાઇલમાં સુધારાે લાવવા અને તનેાે ˗ાવસા̍યક દેખાવ 
બનાવવા માટે ઉપયાેગી છે. પરેાǁાફ ઈɱે̔ɰ̬ગ દƺતાવેજની ગાેઠવણી વધુ ǐભાવશાળી અને ̠ વ̗˺ત બનાવે 
છે. અા સુ̍ વધાનાે યાેƝય ઉપયાગે કરીને તમે દƺતાવેજને ǐાેફેશનલ દેખાવ અાપી શકાે છાે. 

પેરાǁાફ ઈɱે̔ɰ̬ગના  ફાયદા: 

 દƺતાવેજને વાંચવામાં સરળતા અને ˗વ̗˺ત દેખાવ અાપે છે. 

 ˗ાવસા̍યક ǐƺતુ̍ ત અને ̍વવરણ માટે ઉપયાગેી. 

 મ˄ી-લેવલ સૂ̎ ચ અથવા ̋રપાેટƙમાં ˾ˠતા ̀ળવવામાં મદદ કરે છે. 

ઈɱે̔ɰ̬ગના ǐકારા:ે  

નીચે ચાર ǐકારના ઇɱેɰ ̍વષે સમ̀વેલ છે  

a. ફ ƙ˶ લાઇન ઈɱેɰ (First Line Indent): અા ઇɱેɰમાં પેરાǁાફની ǐથમ લાઇન મા̏જ̭નથી થાેડી દૂર 
હાેય છે. તેના માટે શાટેƙકટ કી Tab દબાવા.ે 

b. હ̲̎ગ̬ગ ઈɱેɰ (Hanging Indent): અા ઇɱેɰમાં ǐથમ લાઇન મા̏જ̭ન સાથે રહે છે, ȱારે બાકીની 
લાઇનાે મા̏જ̭નથી દૂર હાેય છે. અા ˶ાઇલનાે ઉપયાગે અવતરણાે અથવા બુલેટ ̏લ˶માં થાય છે. 

c. લʘે ઈɱેɰ (Left Indent): અા ઇɱેɰમાં પેરાǁાફની બધી લાઇનાે ડાબા મા̏જ̭નથી દૂર લાવવામા ં
અાવે છે. 

d. રાઇટ ઈɱેɰ (Right Indent): અા ઇɱેɰમાં પેરાǁાફની બધી લાઇનાે જમણા મા̏જન̭થી દૂર લાવવામા ં
અાવે છે. 

ઈɱેɰ કેવી રીતે લાગુ કરવી? 

તમારા દƺતાવેજમાં ઇɱેɰ લાગુ કરવા માટે નીચે ǋણ રીતા ેસમ̀વેલ છે.   

a. ̈́લરનાે ઉપયાેગ કરીને: View ટેબમાં જઈને Ruler અાેપશનને સ̋ƿય કરાે. ̈́ લર પર ̍ ǋકાેણ અાકારની 
ƺલાઇડરને ખ̲ચીને ઇ̗Ȟત ઈɱેɰ સેટ કરાે. 

b. પેરાǁાફ ડાયલાૅગ બાȋેનાે ઉપયાેગ: પેરાǁાફ પસંદ કરા,ે Home ટેબમાં Paragraph ǁુપના ખૂણાના 
 અાઇકાેન પર ̚ȃક કરાે. Special ̍ વકˍમાં First Line અથવા Hanging પસદં કરાે અને ઈ̗Ȟત 

માપ દાખલ કરાે. 
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c. શાેટƙકટ કીનાે ઉપયાગે: Ctrl + M: લેʘ ઈɱેɰ વધારવા માટે. Ctrl + Shift + M: લʘે ઈɱેɰ 
ઘટાડવા માટે. 

̀ે તમારે ઈɱે̔ɰ̬ગનું સમાન ફાેમ̳ટ દરેક પેરાǁાફ માટે લાગુ કરવું હાેય, તા ેStyles ટેબનાે ઉપયાેગ કરાે. ̋ ડફાૅ˄  
ઈɱે̔ɰ̬ગ ̍વકˍ સેટ કરવા માટે Set as Default બટનનાે ઉપયાેગ કરાે. 

6.2 બુલેટ્સ અને નબં̋ર̬ગ (Bullets and Numbering) 

બુલટ્ેસ અને નંબ̋ર̬ગ શું છે? 

બુલેટ્સ અને નબં̋રગ̬ સુ̍વધાનાે ઉપયાેગ સૂ̎ ચબɡ મા̋હતી રજૂ કરવા માટે થાય છે. તે દƺતાવેજને વધુ 
ગાેઠવાયેલંુ અન ેવાચંવામાં સરળ બનાવે છે. 

 બુલેટ્સ: ̎ચ̆ાે (જેમ કે ડાેટ્સ, ચેકમાકƙ )નાે ઉપયાેગ કરીને સૂ̎ચ બનાવવી. 

 નંબર̯ગ: ƿમમાં સȕંા અથવા અƖરાેના ેઉપયાેગ કરીને સૂ̎ચ બનાવી શકાય છે. 

બુલટ્ેસ અને નંબ̋ર̬ગ કેવી રીતે લાગુ કરવું? 

તમે જ ે લખાણને બુલેટ અથવા નંબ̋રગ̬માં ͅપાંત̋રત કરવા માંગાે છા,ે તેને પસંદ કરાે. Home ટેબમા ં
Paragraph ǁુપ પર ̀ અાે. Bullets અાઇકાને પર ̚ ȃક કરાે. નીચે મુજબનું ǉાેપ ડાઉન લી˶ દેખાશે જમેાંથી 
તમારી પસંદગી ǐમાણે બુલેટ ˶ાઇલ પસંદ કરાે. 

 
નંબર̯ગ ઉમેરવા માટે Paragraph ǁુપમા ંNumbering અાઇકાેન પર ̚ȃક કરા.ે નીચે મુજબનંુ ǉાેપ ડાઉન 
લી˶  દેખાય છે તેમાંથી ઉપલʤ નંબ̋રગ̬ ફાેમ̳ટમાથંી પસંદ કરાે (જમે કે 1, 2, 3 અથવા A, B, C). 
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મ˄ી-લેવલ ̏લ˶ બનાવવા માટે માટે Paragraph ǁુપમા ંMultilevel List ̍વકˍનાે ઉપયાેગ કરા.ે નીચ ે
મુજબનું ǉાેપ ડાઉન લી˶ દેખાય છે તમેાંથી પેટા-સૂ̎ચ (Sub-list) બનાવી શકાય છે. 
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બુલટ્ેસ અને નંબ̋ર̬ગ ક˶માઇઝ કરવા: 

a. ̋ડફાૅ˄ બુલેટ્સ અથવા નંબ̋રગ̬ બદલવા માટે Define New Bullet અથવા Define New Number 
Format ̍વકˍ પર ̚ȃક કરાે. ̎ચ̆ા,ે ̎ચǋાે અથવા ક˶મ ફાેમ̳ટ પસંદ કરાે. 

b. ̏લ˶નું ફાેમ̳̋ટ̬ગ બદલાે: Increase Indent અથવા Decrease Indent ̍વકˍનાે ઉપયાેગ કરીન ે
̏લ˶ને અદંર અથવા બહાર ખસેડાે. Font ̍વકˍથી બુલેટ્સ અથવા નબંરનું ˶ાઇલ બદલવંુ. 

Microsoft Word 2019માં બુલેટ્સ અને નંબ̋રગ̬ દƺતાવેજને ગાેઠવવામાં અને સારી રીતે રજૂ કરવામા ં
મદદͅપ છે. તેનાે યાેƝય ઉપયાગે કરીને દƺતાવેજને વધુ ǐભાવશાળી બનાવી શકાય છે. 

6.3 લખાણનું કેસ બદલવું (Changing case) 

કેસ બદલવાનું મહɗ શંુ છે? 

કેસ ચƮેજ સુ̍ વધાનાે ઉપયાેગ કરીને તમે દƺતાવેજમાં લખાયેલ લખાણના અƖરાેના અાકાર (માેટા/કે̌પટલ 
અƖરાે કે નાના/́ાેલ અƖરાે)માં સરળતાથી ફેરફાર કરી શકાે છાે. અા સુ̍વધા દƺતાવજેને ǐાેફેશનલ દેખાવ 
અાપવા અને સમય બચાવવાનું સરળ સાધન છે. 

કેસ બદલવાના ǐકારાે: Microsoft Word 2019માં નીચેના કેસ બદલવાના ̍વકˍાે ઉપલʤ છે: 

a. Sentence Case: Sentence Case લખાણના ǐથમ અƖરને માટંુે બનાવે છે. ઉદાહરણ: This is a 
sentence. 
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b. lowercase: તમામ અƖરા ેનાના બનાવે છે. ઉદાહરણ: this is lowercase. 

c. UPPERCASE: તમામ અƖરા ેમાટેા બનાવે છે. ઉદાહરણ: THIS IS UPPERCASE. 

d. Capitalize Each Word: દરેક શʣના ǐથમ અƖરને માેટંુ બનાવે છે. ઉદાહરણ: This Is Capitalized. 

e. tOGGLE cASE: અƖરાનેા વતƙમાન કેસને ઉલટાવીને બદલવા માટે વપરાય છે. ઉદાહરણ: tOGGLE 
cASE TO tOGGLE cASE. 

કેસ કેવી રીતે બદલવંુ? 

જનેાે કેસ બદલવાે છે અે લખાણ હાઇલાઇટ કરાે. Home ટેબમાં ̀ અાે: Font ǁુપમા ંનીચે મુજબના Change 
Case અાઇકાેન પર ̚ȃક કરા ેઅને તમારી પસંદગીનાે કેસ પસંદ કરાે. Shift + F3 શાેટƙકટ કી નાે ઉપયાેગ 
કરીને પણ તમે lowercase, UPPERCASE અને Sentence Case વȝે ફેરફાર કરી શકાે છાે. 

 
  

સામાʈ રીતે ǐાેફેશનલ હે̋ડ̬ગ માટે UPPERCASE વપરાય છે . ̘Ȅક ટેȌ અે̋ડ̋ટ̬ગ માટે tOGGLE cASE 
વપરાય છે જયારે દƺતાવેજમા ંસુમેળ અને ˶ાઇલ ̀ળવવા માટે Capitalize Each Wordનાે ઉપયાગે થાય 
છે. 

Change Case ̍વકˍના ફાયદાઅાે છે જમે કે લખાણ ̀તે ફેરફાર કરવાનાે સમય બચાવે છે. દƺતાવેજન ે
વધુ સુમેળભયુ̫ અને ˗ાવસા̍યક બનાવે છે અને ̍વગતવાર લખાણને સરળતાથી ફેરફાર કરવંુ સરળ બને છે. 
અા સુ̍વધાનાે ઉપયાેગ કરતી વખતે હંમેશા ˾ે̏લ̬ગ ચકાસવાનું ભુલશાે નહ̯. 

Microsoft Word 2019માં Change Case અેક સારાે ̍વકˍ છે, જનેાે ઉપયાેગ કરીને તમા̈́ં કામ ઝડપી 
અને વધુ કાયƙƖમ બનાવી શકાય છે. 

7. ટેબલનાે ઉપયાેગ (Table Manipulation) 

ટેબલ મે̏નȂુલેશન શું છે? 

ટેબલ મે̏નȂુલેશન અેટલે ટેબ˔ બનાવવા, તેમાં ફેરફાર કરવા ે અને ગાેઠવવા માટેની ǐ̋ƿયા છે. તે 
દƺતાવેજમાં ડેટાન ેગાેઠવણભયુ̫ અન ે˗વ̗˺ત રીતે રજૂ કરવામાં મદદ કરે છે. અા સુ̍વધાનાે ઉપયાેગ ̋રપાેટƙ, 
ડેટાશીટ, ̏ લ˶ અને અʈ મા̋હતી ǐદ̏શ̭ત કરવા માટે થાય છે. દƺતાવેજમાં ટેબલ ઉમેરવા માટે નીચેના ̍ વકˍા ે
ઉપલʤ છે: 
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a. ટેબલ ઉમેરવા માટે: Insert ટેબ પર ̚ȃક કરાે. Table ̍વકˍ પસંદ કરા.ે માઉસથી ટેબલનું કદ પસંદ 
કરાે અથવા Insert Table પસંદ કરી પં̘Ǹઅાે (રા)ે અને ƺતંભ (કાૅલમ)ની સંȕા દાખલ કરાે. 

 
b. ǉાૅ ટેબલ: Draw Table ̍વકˍના માɪમથી ટેબલને મનપસંદ અાકારમાં દાેરાે. 

c. ટેબલ કƮવટƙ કરવી: લખાણને ટેબલમાં પ̋રવ̍ત̭ત કરવા માટે, લખાણ પસંદ કરા,ે પછી Insert Table 
̍વકˍનાે ઉપયાગે કરાે. 

ટેબલમાં ફેરફાર કરવા માટે કસƙર ને ટેબલની જે તે રાે અથવા કાેલમમા ં રાખાે. ̋રબન મેનુબારમાં Table 
Design અન ેTable Layout ટેબ અાપાઅેાપ ઉમેરાઈ ગયેલ દેખાશે.        

 
ટેબલ પર તમે નીચે મુજબના ફેરફાર કરી શકાે છાે.   

સે̝ ને મજƙ અથવા િƺʕટ કરવંુ: 

અેક કરતા વધ ુખાના (સે˔)ને ̀ેડવા માટે ̐સલેǶ કરી Table Layout ટેબમાંથી Merge Cell ̍વકˍના ે
ઉપયાેગ કરાે. અેક સેલને અનેક સે˔માં ̍વભા͂ત કરવા માટે ̐સલેǶ કરી Table Layout ટેબમાંથી Split 
Cell ̍વકˍનાે ઉપયાેગ કરાે. 

ટેબલનંુ કદ બદલવંુ: 
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ટેબલની સાઈઝ બદલવા માટે તેને  રા ે અથવા કાૅલમની ̋કનારે ̚ȃક કરીને તેને ખ̲ચાે. ટેબલની સંપૂણƙ 
પહાેળાઈ અથવા ઊંચાઈ બદલવા માટે Table Tools > Layout ટેબમાંથી Cell Size ǁુપ માંથી ̍વકˍ પસદં 
કરાે. 

ફાેમ̳̋ટ̬ગ ટેબલ: 

ટેબલને ફાેમ̳̋ટ̬ગ કરવા માટે કસƙર ને ટેબલની જ ેતે રાે અથવા કાેલમમા ં રાખા.ે ̋રબન મેનુબારમાં Table 
Design અન ેTable Layout ટેબ અાપાઅેાપ ઉમેરાઈ ગયેલ દેખાશે.        

 
a. ટેબલ ̋ ડઝાઇન: Table Design ટેબમાં ટેબલ ˶ ાઇલ પસંદ કરાે. બાેડƙર ˶ાઇલ, શે̋ડ̬ગ અને રંગ ઉમેરાે. 

b. ટેȌ અેલાઇનમɰે: સેલની અંદર લખાણને ડાબી, જમણી, મɪમાં અથવા ટાેચ/ત̐ળય ેગાઠેવા.ે Table 
Layout ટેબમાં અાવેલ Alignment ̍વકˍનાે ઉપયાગે કરાે. 

c. સાૅ̋ ટ̮ગ: ટેબલ ડેટાને વધતા અથવા ઘટતા ƿમમાં ગાઠેવવા માટે Table Layout ટેબમાં અાવેલ Sort 
̍વકˍનાે ઉપયાગે કરાે. 

d. લાઇન ˶ાઇલ અને રંગ: Table Design ટેબમાંથી ટેબલ ˶ાઇલ અને રંગ પસંદ કરાે. બાેડƙરની ̀ડાઈ 
બદલવા માટે Pen Weight ̍વકˍનાે ઉપયાેગ કરાે. 

e. ટેȌ અને ફાેમ̳̋ટ̬ગ: લખાણને સેલની અંદર ગાેઠવવા માટે Alignment ̍વકˍનાે ઉપયાેગ કરાે. ટેȌ 
ફાૅɰ, સાઇઝ, અને રંગ બદલાે. 

અગɔના સૂચનાે: 

 ટેબલને સમાન અને ગાઠેવણયǸુ બનાવવા માટે AutoFit ̍વકˍનાે ઉપયાગે કરા.ે 

 ટેબલના ̋ડઝાઇનમાં ફેરફાર કરતા પહેલા તેને સેવ કરાે. 

Microsoft Word 2019 તમને ટેબલ બનાવવાની સુ̍ વɥા અાપે છે. તેના ેયાેƝય અને અસરકારક ઉપયાેગ 
કરીને તમે તમારી મા̋હતી ǐદ̏શ̭ત કરવાની Ɩમતા વધારી શકાે છાે. 

7.1 ǉાૅ ટેબલ (Draw Table) 

ǉાૅ ટેબલ શંુ છે? 

ǉાૅ ટેબલ અેક અનʈ સુ̍વધા છે, જ ેતમન ેટેબલને ક˶મ અાકારમા ંદારેવાની મંજૂરી અાપે છે. અા સુ̍વધાના ે
ઉપયાેગ કરીને તમે સામાʈ ગાેઠવણવાળી ટેબલની બાજુમાં અેક જ̋ટલ અને ખાસ ̋ડઝાઇનવાળી ટેબલ 
બનાવી શકાે છાે. 

ǉાૅ ટેબલ કેવી રીતે બનાવવી? 

ǉાે ટેબલ કરવા માટે નીચેના પગલા અનુસરાે  

a. ǉાૅ ટેબલ ̍ વકˍ પસંદ કરાે: Insert ટેબ પર ̚ȃક કરાે. Table ̍ વકˍ પર ̚ ȃક કરીને Draw Table 
પસંદ કરાે. 
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b. ક˶મ અાકાર દાેરાે: માઉસ પાેઇɰર પેન ટૂલમાં ફેરવાઈ જશે. પને ટૂલનાે ઉપયાેગ કરીને ટેબલની 
અાઉટલાઇન દાેરાે. 

c. કાૅલમ અન ેપં̘Ǹઅાે ઉમેરાે: પને ટૂલથી ટેબલની અંદર લાઇન દાેરીને કાૅલમ અને પં̘Ǹઅાે બનાવાે. 

d. સે̝ ને િƺʕટ અથવા મજƙ કરાે: Table Tools > Layout ટેબમાં જઈન ેSplit Cells અથવા Merge 
Cells ̍વકˍનાે ઉપયાેગ કરાે. 

̀ે તમે હાથથી દાેરવામાં અચકૂ થઈ ર̈ા હાે, તાે ટેબલ ̈́ લર અથવા ગાઈડલાઇʉનાે ઉપયાેગ કરાે. વધુ જ̋ટલ 
ગાેઠવણ માટે, Eraser Toolનાે ઉપયાેગ કરીને લાઇનને દૂર કરાે અને ફરીથી દાેરા.ે ટેબલ પૂણƙ થયા પછી તેની 
ગાેઠવણી સુધારવા માટે AutoFit ̍વકˍનાે ઉપયાેગ કરાે. 

ǉાૅ ટેબલ ̍વકˍના ફાયદા: 

 ક˶મ ટેબલ ̋ડઝાઇન બનાવવા માટે ઉપયાેગી. 

 ̍વ̏શˠ લેઅાઉટ અથવા અસમાન પં̘Ǹઅાે અને કાૅલમ માટે Ǘેˤ. 

 ડેટાની ગાેઠવણને વધુ સજƙનાɒક અને અાકષƙક બનાવે છે. 

ǉાૅ ટેબલનાે ઉપયાેગ Ȃારે કરવાે ̀ેઈઅ?ે 

 ȱારે સામાʈ ટેબલ ̋ડઝાઇન દƺતાવેજ માટે યાેƝય ન હાેય. 

 સુંદર ǐાેફેશનલ લેઅાઉટની જͅર હાેય ɔારે. 

 ǁા̋ફȋ સાથેના ટેબલ બનાવવા માટે. 

Microsoft Word 2019માં ǉાૅ ટેબલ ઉપયાેગ કરીને, તમે તમારા દƺતાવેજને વધુ ǐભાવશાળી અને અનʈ 
બનાવી શકાે છાે. તમારા ̍વચારાેને ̍વƣયઅુલ ̄ͅપમાં રજૂ કરવા માટે અા સુ̍વધા Ǘેʕ  છે. 

7.2 સેલની પહાેળાઈ અને ઊંચાઈ બદલાે (Changing cell width and height) 

સેલની પહાેળાઈ અને ઊંચાઈ બદલવાનું મહɗ શું છે? 

Microsoft Word 2019માં સેલની પહાેળાઈ અને ઊંચાઈ બદલવાની સુ̍વધા તમને ટેબલને વધુ સુવાȢ 
ગાેઠવણ કરવા માટે મદદ કરે છે. તે દƺતાવેજને ̠ વસા̍યક દેખાવ અાપવાની સાથે, ડેટાને યાેƝય રીતે રજૂ કરવા 
માટે મહɗપૂણƙ છે. 

સેલની પહાેળાઈ અને ઊંચાઈ કેવી રીતે બદલવી? 

સેલની પહાેળાઈ અને ઊચંાઈ બદલવા માટેની રીતાે નીચે વણƙવેલ છે. 

a. માઉસનાે ઉપયાેગ કરીને: સલેની ̋ કનારે માઉસ પાેઇɰર મૂકાે, ȱાં પાેઇɰર ડબલ-હેડેડ તીરમાં બદલાઈ 
જશે. જ̋ͅરયાત મુજબ સેલની ઉચાઇ અને પહાેળાઈ બદલવા માટે માઉસની ડાબી ̚ȃક દબાવી ખસેડાે. 
અા પɡ̍ત ઝડપથી સેલનું કદ બદલવા માટે ખૂબ ઉપયાેગી છે. 

b. AutoFit ̍વકˍનાે ઉપયાગે: Table Layout ટેબમાં AutoFit ̍વકˍ પર ̚ȃક કરાે. ડેટાના અાધારે 
સેલનું કદ અાપમેળે ગાેઠવાઈ જશે. તેમાં નીચેના ̍વકˍા ેઉપલʤ છે: 

o AutoFit Contents: ટેબલ ડેટા ǐમાણે કાેલમની પહાેળાઈ ગાેઠવે છે. 
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o AutoFit Window: પાનાની પહાેળાઈ મુજબ ટેબલ કાલેમ ગાેઠવે છે. 

c. ̀તે કદ બદલવું: Table Layout ટેબમાં Cell Size ̍વભાગ પર ̀અાે. Height અને Width માટે 
ચાેǲસ માપ દાખલ કરાે. 

d. ટેબલ ̈́લરનાે ઉપયાેગ: View ટેબમાં Ruler સ̋ƿય કરાે. ̈́લર પર ટેબલના ̋કનારા ખ̲ચીને સેલનું કદ 
બદલાે. 

e. અેક કરતા વધારે સે̝  માટે કદ ગાેઠવવું: અેક કરતા વધારે સે̝  પસંદ કરાે. Table Tools > Layout 
ટેબમાં જઈને Distribute Rows અથવા Distribute Columns ̍વકˍનાે ઉપયાેગ કરાે. અા ̍વકˍ 
તમામ પસંદ કરેલી પં̘Ǹઅાે અને કાૅલમ માટે સમાન કદ ગાેઠવે છે. 

અગɔના સૂચનાે : 

 સેલની પહાેળાઈ અને ઊચંાઈ ગાેઠવતાં પહેલા ટેબલની મા̋હતી પર ɪાન અાપાે. 

 અાેછી મા̋હતી દશાƙવતા ટેબલમાં AutoFit Contents વધુ ઉપયાેગી છે. 

 ̀ે ટેબલ પાનાની જƝયા બહાર જઈ ર̈ંુ હાેય, તાે AutoFit Window ઉપયાેગમાં લાે. 

ફાયદા: 

 ટેબલ વધુ ગાેઠવણયુǸ બને છે. 

 ડેટા સરળતાથી વાંચી શકાય છે. 

 દƺતાવેજમાં સમાનતા ̀ળવવામાં મદદ કરે છે. 

સેલની પહાેળાઈ અને ઊંચાઈ બદલવી અે દƺતાવેજને વધુ અેકસુǋતા અાપવા  અને ǐભાવશાળી બનાવવા 
માટે અેક મહɗપૂણƙ સાધન છે. અા સુ̍વધાનાે યાેƝય ઉપયાેગ કરીને તમે તમારા ટેબ˔ને વધુ સારી રીતે ગાેઠવી 
શકાે છાે. 

7.3 સેલમાં લખાણની ગાેઠવણી (Alignment of Text in Cell) 

Microsoft Word 2019 તમને લખાણને ટેબલના સે̝ માં ગાેઠવવા માટે ̍વ̍વધ ̍વકˍાે પૂરા પાડે છે. ટેȌ 
અેલાઇનમેɰ (Alignment) અે પ̋રબળ છે જ ેલખાણને સેલમાં કઇ જƝયાઅે ǐદ̏શ̭ત કરવું છે તે નǲી કરે 
છે. ટેȌ અેલાઇનમેɰનાે ઉપયાેગ લખાણને ˗ાવસા̍યક અને સહજ દેખાવ માટે કરવામાં અાવે છે. 

ટેȌ અેલાઇનમેɰના ǐકારા ે

Microsoft Word 2019 માં સેલમાં લખાણ ગાેઠવવા માટે નીચેના ̍વકˍાે ઉપલʤ છે: 

a. અાડી ગાેઠવણ (Horizontal Alignment) 

 Left Alignment: લખાણ સેલની ડાબી ધાર સાથે ગાેઠવાય છે. 

 Centre Alignment: લખાણ સેલના મɪમાં ગાેઠવાય છે. 

 Right Alignment: લખાણ સેલની જમણી ધાર સાથે ગાેઠવાય છે. 

b. ઉભી ગાેઠવણ (Vertical Alignment) 
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 Top Alignment: લખાણ સેલની ઉપરની ધાર પાસે ગાેઠવાય છે. 

 Centre Alignment: લખાણ સેલની ઊંચાઈના મɪમા ંગાેઠવાય છે. 

 Bottom Alignment: લખાણ સેલની નીચેના ધાર પાસે ગાેઠવાય છે. 

લખાણની ગાઠેવણ કેવી રીતે બદલવી? 

લખાણની ગાેઠવણમાં ફેરફાર કરવા માટે નીચેના પગલાં અનુસરા:ે 

a. ȱાં લખાણ ગાેઠવવું છે તે સેલ ̐સલેǶ કરાે. 

b. Table Layout ટેબ પર ̚ȃક કરાે. 

c. Alignment Group મા ંનીચ ેમુજબ અાવેલ ̍વકˍ માંથી અનુકૂળ ̍વકˍ પસંદ કરાે. 

 
ઉદાહરણ: 

 ̀ે તમારે લખાણને ટેબલના મɪમાં મૂકવંુ હાેય, તા ે Centre Alignment (Horizontal and 
Vertical) પસંદ કરાે. 

 ǁા̋ફȋ કે અાકૃ̍ત સાથે સકં̏લત લખાણ માટે યાેƝય ગાેઠવણ પસંદ કરવાથી દેખાવમાં વધારાે થાય છે. 

ઉપયાે̎ ગતા: સરસ ગાેઠવણના કારણ ે દƺતાવેજ વધુ વાંચનયાƝેય અને ˗ાવસા̍યક બને છે. અા રીતે, 
Microsoft Word 2019 માં લખાણ ગાેઠવણની સુ̍વધાઅાે તમને Ǘેˤ ǐƺતુ̍ ત બનાવવા માટે મદદ કરે છે. 

7.4 રાે અને કાેલમ ઉમેરવી/દૂર કરવી (Deletion/Insertion of Row and Column) 

Microsoft Word 2019 માં ટેબલ સાથે કામ કરતી વખતે કેટલીકવાર રાે અથવા કાલેમ ઉમેરવાની અથવા 
કાઢવાની જͅર પડી શકે છે. Microsoft Word 2019મા ંઅા ǐ̋ƿયા ખૂબ જ સરળ અને સહજ બનાવવામા ં
અાવી છે. નીચે ટેબલમાં રા ેઅને કાેલમ ઉમેરવા અને દુર કરવા માટે જͅરી ̍વગત અાપવામાં અાવી છે. 

રા ેઅથવા કાેલમ ઉમેરવી (Insert Row/Column) 

રાે અથવા કાેલમ ઉમેરવા માટે તમે નીચેના પગલાં અનુસરશાે: 

a. રા ેઉમરેવા માટેના પગલા: 

 ટેબલમા ંજેના ઉપર અથવા નીચે નવી રા ેઉમેરવી છે તે રા ેપસંદ કરાે. 

 Table Layout ટેબ પર ̀અાે. 

 Rows & Columns ǁુપમાથંી Insert Row Above અથવા Insert Row Below ̍વકˍ પસંદ 
કરાે. 
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 પસંદ કરેલા ˺ાન પર નવી રાે ઉમેરાશ.ે 

b. કાેલમ ઉમેરવા માટેના પગલા: 

 જનેા ડાબી અથવા જમણી બાજુ નવી કાેલમ ઉમેરવી છે તે કાેલમ પસંદ કરાે. 

 Insert Column Left અથવા Insert Column Right ̍વકˍને પસંદ કરાે. 

 નવી કાેલમ પસંદ કરેલા ˺ાન પર ઉમેરાશે. 

રાે અથવા કાેલમ દૂર કરવી (Delete Row/Column) 

ટેબલમાંથી રાે અથવા કાેલમ કાઢવા માટે નીચેના પગલાં અનુસરાે: 

a. રાે દૂર કરવા માટેના પગલા: 

 જ ેરાે કાઢવી છે તે રાે પસંદ કરાે.  

 Table Layout ટેબ પર ̀અાે.  

 Delete ̍વકˍ પસંદ કરાે અને Delete Rows ̚ȃક કરાે.  

 પસંદ કરેલી પં̘Ǹ ટેબલમાંથી દૂર થશે. 

b. કાેલમ દૂર કરવા માટેના પગલા: 

 જ ેકાેલમ કાઢવી છે તે કાેલમ પસદં કરાે.  

 Delete ̍વકˍને ̚ȃક કરીન ેDelete Columns પસંદ કરાે. 

 પસંદ કરેલી કાેલમ ટેબલમાંથી દૂર થશે. 

અગɔના સૂચનાે: તમે કીબાેડƙ શાેટƙકટ્સ અને માઉસના સહયાેગથી પણ અા કાયƙ ઝડપથી કરી શકાે છાે. 
ટેબલની રચનાને વધારે ˗વ̗˺ત બનાવવા માટે પં̘Ǹ અને કાેલમ ઉમેરીને તે સંચા̏લત કરી શકાય છે. 

7.5 બાેડƙર અને શે̋ ડ̬ગ (Border and Shading) 

બાેડƙર અને શે̋ડ̬ગ અે ટેબલ, પરેાǁાફ અથવા પેજને અાકષƙક બનાવવાની અને તેને વધુ ˗ાવસા̍યક દેખાવ 
અાપવા માટેની મહɗપૂણƙ સુ̍ વધા છે. અા સુ̍વધાનાે ઉપયાેગ દƺતાવેજના ખાસ ભાગાેને હાઇલાઇટ કરવા 
અથવા તેને વધુ સારાે દેખાવ અાપવા માટે થાય છે. 

બાેડƙર (Border) અે લખાણ, પેરાǁાફ અથવા ટેબલની અાસપાસ અેક અાઉટલાઇન છે. અા ઉમેરવાથી 
દƺતાવેજના તɗાેને વધુ સુંદર બનાવી શકાય છે. 

બાેડƙર ઉમેરવા માટેના પગલાં: 
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a. ȱાં બાડેƙર ઉમેરવી છે તે લખાણ, પેરાǁાફ અથવા ટેબલ પસંદ કરાે. 

b. Home ટેબ હેઠળ Paragraph ǁુપમા ંBorders બટન પર ̚ȃક કરાે. 

c. બાજુની  અાકૃ̍તમાં દશાƙ˗ા મુજબના  ̍વકˍાે ખૂલશે: 

 Bottom Border: નીચે બાડેƙર ઉમેરવા માટે. 

 Top Border: ઉપર બાેડƙર ઉમેરવા માટે. 

 All Borders: બધી બાજુ બાેડƙર ઉમેરવા માટે. 

 No Border: બાેડƙર દૂર કરવા માટે. 

d. તમારા દƺતાવેજમાં પસદં કરેલા ભાગે બાેડƙર લાગુ થશે. 
 

શે̋ ડ̬ગ અે લખાણ અથવા પેરાǁાફ પાછળ રંગ ઉમેરવાની ǐ̋ƿયા છે, જનેાથી તે હાઇલાઇટ થાય છે અન ે
Ǎ̑ˠઅાકષƙક બને છે. 

શે̋ ડ̬ગ ઉમેરવા માટેના પગલાં: 

a. ȱાં શે̋ ડ̬ગ ઉમેરવંુ છે તે લખાણ અથવા પેરાǁાફ પસંદ કરાે. 

b. Home ટેબ હેઠળ Paragraph ǁુપમા ંShading બટન પર ̚ȃક કરાે. 

c. તમારી પસંદગી માટે નીચે મુજબ રંગાેની સૂ̎ ચ દશાƙવવામાં અાવશે. 

 
d. પસંદ કરેલાે રંગ તે પસંદ કરેલા લખાણ અથવા પેરાǁાફ પર લાગુ થશે. 

બાેડƙર અને શે̋ડ̬ગ અેકસાથ ેલાગુ કરવા: 

1. Design ટેબમાં જઈન ેPage Borders પર ̚ȃક કરાે. નીચે મુજબનાે ડાયલાેગ બાેƖ અાેપન થશે  
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2. અહ̯ તમને બાેડƙર ˶ાઇલ, રંગ અને ̀ડાઈ વગેરે પસંદ કરવાની સુ̍વધા મળશ.ે 

3. શે̋ડ̬ગ માટે શે̋ ડ̬ગ ટેબ પસંદ કરાે અને રંગ પસંદ કરાે. 

ઉપયાે̎ ગતા: 

 બાેડƙરનાે ઉપયાગે ટેબલને ˗ાવસા̍યક દેખાવ અાપવા માટે થાય છે. 

 શે̋ડ̬ગનાે ઉપયાેગ ̍વ̏શˠ મા̋હતી હાઇલાઇટ કરવા માટે થાય છે. 

 અા સુ̍વધાઅાે દƺતાવેજને વધુ અસરકારક બનાવે છે. 

Microsoft Word 2019 મા ંબાેડƙર અને શે̋ડ̬ગ નાે યાેƝય ઉપયાેગ દƺતાવેજને વધુ અાકષƙક અને ˗ાવસા̍યક 
બનાવી શકે છે. 

8. ઇˑુ˷ેશન દાખલ કરવા (Insert Illustration) 

Microsoft Word 2019 દƺતાવેજને અાકષƙક બનાવવા ̍વ̍વધ ǐકારના ̌પǴર, અાકૃ̍તઅાે, અાઇકાેન, 
3D માેડે˔, ́ાટƙઅાટƙ, ચાટƙ અને ˲ીનશાેટ ઉમેરવાની સુ̍ વધા ǐદાન કરે છે જનેે ઇˑુ˷ેશન કહેવાય છે. 
અા ઘટકા ેદƺતાવેજને વધુ રસǐદ અને સમજવામાં સહેલું બનાવે છે. Insert ટેબમાં અાવેલ Illustrations ǁુપ 
માંથી તમે ઇˑુ˷ેશન દાખલ કરી શકા ેછાે. 

 
ઇˑુ˷ેશનના ǐકારાે: 

Microsoft Word 2019 માં તમારે નીચનેા ǐકારના ઇˑુ˷ેશન દાખલ કરી શકાય છે: 

1. Pictures (છબીઅા)ે: દƺતાવેજમાં કƳʔુટર પર ˶ારે થયેલ ફાઇલ અથવા અાેનલાઈન ઉપલʤ 
̌પǴર ફાઈલ ઉમેરવા માટે. 
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2. Shapes (અાકૃ̍તઅાે): દƺતાવેજમાં રેખાઅાે, ̍ǋકાેણાે, વતુƙળાે અને અʈ અાકાર ઉમરેવા માટે. 

3. Icons (અાઇકાેન): મા̋હતી રજૂ કરવા માટે રેડીમેડ અાઇકાેન ઉમેરવંુ. 

4. SmartArt (́ાટƙઅાટƙ): મા̋હતીને ̍વ̍વધ ǐકારના અાકષƙક ǁા̋ફȋમાં ͅપાંત̋રત કરવા માટે. 

5. Charts (ચાટƙ): અાંકડાકીય ડેટાને રજુ કરવા માટે બાર, લાઇન, પાઈ વગેરે ચાટƙ ઉમેરવા. 

ઉપયાે̎ ગતા: 

 ઇˑુ˷ેશન દƺતાવેજને વધુ સરળ અને રસǐદ બનાવે છે. 

 ˾ˠતામા ંવધારાે કરીને મા̋હતીની સમજણ સરળ બનાવે છે. 

 ˗ાવસા̍યક ǐƺતુ̍ તઅાેમાં અસરકારકતાને વધારે છે. 

Microsoft Word 2019 ની Insert Illustration સુ̍વધા દƺતાવેજને સહજ અને અસરકારક બનાવવામા ં
સહાય કરે છે. 

8.1 ̌પǴર (Picture) 

Microsoft Word 2019માં ̌પǴર ઉમેરવાની સુ̍વધા તમારા દƺતાવેજને વધુ અાકષƙક બનાવે છે. તમ ે
દƺતાવેજમાં તમારા કƳʔુટર પર સેવ થયેલ ̌ પǴસƙ અથવા અાૅનલાઇન ઉપલʤ હાેય તેવા ̌ પǴર ડાઉનલાેડ 
કરી ઉમેરી શકાે છાે. ̌પǴરનાે ઉપયાગે દƺતાવેજમાં મા̋હતીને વધુ અાકષƙક બનાવવા માટે થાય છે. 

દƺતાવેજમાં છબી ઉમેરવા માટેના પગલાં: 

a. Insert Picture from Computer (કƳʔુટરમાંથી ̌પǴર ઉમેરવંુ): 

  
 Insert ટેબ પર ̀અાે. Illustrations ǁુપમાંથી Pictures ̍વકˍ પસંદ કરાે. 

 This Device ̍વકˍ પસંદ કરીન ેતમારા કƳʔુટર પર ̌પǴર શાધેાે. 

 યાƝેય ̌પǴર પસંદ કરીને Insert બટન ̚ȃક કરાે. 

b. Insert Picture Online (અાનેલાઇન છબી ઉમેરવી): 

 Insert ટેબ પર Pictures ̍વકˍ પસંદ કરાે. Online Pictures ̍વકˍ પર ̚ȃક કરાે. 

 Bing સચƙ બારનાે ઉપયાેગ કરીને તમારી પસંદગીની છબી શાધેાે. 

 ̌પǴર પસંદ કરીને Insert બટન પર ̚ȃક કરતા તે ̌પǴર ઉમેરાય ̀ય છે. 

̌પǴરના ͅપમાં ફેરફાર કરવા: 
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Microsoft Word 2019 તમને ̌પǴરની ͅપરેખા અને ˶ાઇલને બદલવા માટે ̍વ̍વધ ̍વકˍાે ǐદાન કરે 
છે, તે માટે ̌ પǴર ̐ સલેǶ કરતા ̋ રબન મેનુબારમાં અાપાઅેાપ નીચે મજુબનાે Picture Format ટેબ ઉમેરાય 
̀ય છે: 

 
a. Resize (કદ બદલી શકાે છા)ે: ̌પǴર પસંદ કરીને માઉસનાે ઉપયાેગ કરીને તેના કાેનƙરથી ખ̲ચીને કદ 

બદલા ેઅથવા Picture Format ટેબમાં Size ǁુપ માંથી ઈ̗Ȟત પહાેળાઈ અને ઉંચાઈ સેટ કરાે. 

b. Crop (̌પǴરનાે કાેઈ ભાગ દુર કરવા)ે: Picture Format ટેબમા ં Crop ̍વકˍ પસંદ કરાે. તમ ે
̌પǴરના ન ̀ેઈતા હાેય તે  ભાગાેન ેદૂર કરી શકા ેછા.ે 

c. Picture Styles (̌પǴર ˶ાઇલ): Picture Format ટેબમાં Picture Styles ̍વકˍાેના ેઉપયાગે 
કરીને બાેડƙર, શેડાે અથવા ઇફેǶ ઉમેરાે. 

d. Adjust Picture (̌પǴરને સારાે દેખાવ અાપવા)ે: તેજ̗̄તા (Brightness), કાƮેǇા˶ (Contrast), 
અને રંગાે સમાયાે̏ જત કરવા માટે Corrections અન ેColor ̍વકˍાેના ેઉપયાેગ કરા.ે 

̌પǴરનાે ઉપયાગે: 

 અાકષƙકતા : દƺતાવેજ વધુ અાકષƙક બને છે. 

 તɝનું ǐƺતુતીકરણ: જ̋ટલ મɠુાઅાેને ̌પǴર ɦારા સરળતાથી સમ̀વી શકાય છે. 

 ˗વસા̍યક દેખાવ : ǐાેજǶે અથવા ̋રપાેટƙને વધુ ˗ાવસા̍યક બનાવવામાં મદદͅપ થાય છે. 

Microsoft Word 2019 માં ̌પǴર ઉમેરવા અન ેતેને ક˶માઇઝ કરવાની સુ̍વધા દƺતાવેજને વધુ રસǐદ 
અને અસરકારક બનાવે છે. 

8.2 અાકૃ̍ત (Shape) 

Microsoft Word 2019 દƺતાવેજમાં અાકૃ̍તઅાે ઉમેરવાની સુ̍ વધા ǐદાન કરે છે, જ ેતમારા દƺતાવેજને વધુ 
અાકષƙક અને ǍƸયમય બનાવે છે. અાકૃ̍તઅાેનાે ઉપયાેગ દƺતાવેજમાં મા̋હતી રજૂ કરવા, ưલાેચાટƙ બનાવવા, 
અથવા ̍વ̍વધ અાલેખાે અને ̋ડઝાઇનમાં કરે છે. 

અાકૃ̍ત ઉમેરવા માટેના પગલા:ં 

 Insert ટેબ પર ̀અાે. 

 Illustrations ǁુપમાંથી Shapes ̍વકˍ પસંદ કરાે. નીચે મુજબ ̍વ̍વધ અાકૃ̍તઅાનેી યાદી ખૂલે 
છે, જમે કે રેખાઅાે, મૂળભૂત અાકૃ̍તઅા,ે તીર (Arrows), ưલાેચાટƙના અાકાર, વગેરે. 
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 તમા̈́ં પસંદ કરેલંુ અાકાર પસંદ કરાે અને માઉસનાે ઉપયાેગ કરીને દƺતાવેજમાં ઉમરેાે. 

અાકૃ̍તને ક˶માઇઝ કરવી: 

Microsoft Word 2019 માં તમે અાકૃ̍તને વૈ̍વɪમય અને અનકૂુળ બનાવવા માટે ̍વ̍વધ ̍વકˍાેના ે
ઉપયાેગ કરી શકાે છાે: 

 
a. Size (કદ બદલી શકાે): અાકૃ̍તને પસંદ કરીન ેમાઉસની મદદથી તેનાે કદ વધારાે અથવા અાેછાે કરાે. 

b. Shape Fill (અાકૃ̍ત ભરાે): 

 Shape Format ટેબમાંથી Shape Fill ̍વકˍ પસંદ કરાે. 

 રંગ, ǁે̋ડઅɰે અથવા પેટનƙનાે ઉપયાેગ કરીને અાકૃ̍ત ભરાે. 

c. Shape Outline (અાકૃ̍તની ͅપરેખા): Shape Outline ̍ વકˍનાે ઉપયાેગ કરીને અાકૃ̍તની બાેડƙરના ે
રંગ અને ̀ડાઈ બદલાે. 

d. Shape Effects (અાકૃ̍ત પર ઇફેǶ્સ): છાયા (Shadow), ચમક (Glow), અથવા 3D ઇફેǶ્સ 
ઉમેરવા માટે Shape Effects ̍વકˍ પસંદ કરાે. 

e. Text in Shape (અાકૃ̍તમાં લખાણ ઉમેરવું): 

 અાકૃ̍ત પર રાઇટ ̚ȃક કરીને Add Text ̍વકˍ પસંદ કરાે. 
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 લખાણ ઉમયેાƙ પછી, તેન ેફાૅɰ ˶ાઇલ અને કદ ǐમાણ ેક˶માઇઝ કરા.ે 

યાદ રાખાે: 

 વધુ ˗ાવસા̍યક દેખાવ માટે અાકૃ̍તઅાે અન ેલખાણ વȝે તાલમેલ સાધાે. 

 અાકૃ̍તઅાેને બી̀ તɗાે સાથે ગાેઠવવા માટે Align અન ેGroup ̍વકˍાેના ેઉપયાેગ કરાે. 

Microsoft Word 2019 માં અાકૃ̍ત ઉમેરવા અને ક˶માઇઝ કરવાની સુ̍ વધા દƺતાવેજને વધુ રાચેક અને 
મા̋હતીǐદ બનાવવામાં મદદ કરે છે. 

8.3 ́ાટƙઅાટƙ (SmartArt) 

́ાટƙઅાટƙ Microsoft Word 2019 ની અેવી સુ̍વધા છે જે દƺતાવેજમાં મા̋હતીને ગાેઠવેલા અને અાકષƙક 
̍વƣયુઅલ ગાળામા ંરજૂ કરવામાં મદદ કરે છે.  

́ાટƙઅાટƙનાે ઉપયાગે કરવા માટે ટંૂકા લખાણ અથવા ડેટાને ǁા̋ફȋમાં ͅપાંત̋રત કરી શકાય છે, જેથી તમારી 
મા̋હતી વધુ ǍƸયમય અને ǐભાવશાળી બને. 

́ાટƙઅાટƙ ઉમેરવા માટેના પગલાં: 

a.  Insert ટેબ પર ̚ȃક કરાે.  Illustrations ǁુપમાંથી SmartArt ̍વકˍ પસંદ કરાે. 

b. નીચે મુજબ ́ ાટƙઅાટƙ ગેલેરી ખુલશે, જમેાં ̍ વ̍વધ Ǘેણીઅાે જમે કે List, Process, Cycle, Hierarchy, 
Relationship, Matrix, Pyramid વગરેે દશાƙવવામાં અાવશે. 

 
c. તમારા દƺતાવેજ માટે યાેƝય ǁા̋ફȋ પસંદ કરીન ેOK પર ̚ȃક કરાે. 

d. લખાણ ઉમેરવંુ: 

o ́ાટƙઅાટƙમાં ફેરફાર કરવા માટે [Text] પર ̚ȃક કરીન ેતમા̈́ં લખાણ દાખલ કરાે. 

o Text Pane ɦારા લખાણ ઉમેરવા અથવા ફેરફાર કરી શકાય છે. 

́ાટƙઅાટƙ ક˶માઇઝ કરવી: 
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Microsoft Word 2019 ́ાટƙઅાટƙને વૈ̍વɪમય બનાવવા માટે ̍વ̍વધ ̍વકˍાે ǐદાન કરે છે: 
SmartArt Design ટેબ પર જઈને ̍વ̍વધ ˶ાઇલઅાે અને રંગાે પસદં કરી શકાય છે. Change Colors 
̍વકˍનાે ઉપયાેગ કરીને તમારા ́ાટƙઅાટƙને અલગ રંગ અને થીમ અાપી શકાે છાે. SmartArt Design 
ટેબમાં Add Shape ̍વકˍનાે ઉપયાગે કરીને નવી અાકૃ̍ત ઉમરેી શકા ેછાે. દƺતાવેજને વધુ ǐભાવશાળી 
બનાવવા માટે ́ાટƙઅાટƙના રંગાે અને ˶ાઇલઅાેનું સુમેળ સાધાે. 

 
લખાણનું ફાૅɰ, કદ, અને રંગ બદલવા માટે Home ટેબના ̍વકˍાેના ેઉપયાેગ કરા.ે 

́ાટƙઅાટƙના ઉપયાગેા:ે 

 ǐ̋ƿયાઅાે અને પગલાંને ǍƸયમય રીતે રજૂ કરવા માટે. 

 સંબં̍ધત તɝાેને ગાેઠવવા માટે. 

 ડેટાને ગાેઠવવા અને સમજવામાં સરળ બનાવવા. 

 સૂ̎ ચઅા ેઅને અનસુૂ̎ચ માટે ઉપયાેગી. 

́ાટƙઅાટƙ નાે ઉપયાેગ દƺતાવેજને વધુ ǍƸયમય, ˗વ̗˺ત અને ǐભાવશાળી બનાવવા માટે Ǘેˤ સાધન છે. 
અા સુ̍વધા ǐƺતુ̍ ત અને ̋રપાેટƙને વધુ ˗ાવસા̍યક ͅપ અાપે છે. 

8.4 ચાટƙ (Chart) 

Microsoft Word 2019 મા ંચાટƙ ઉમેરીન ે ડેટાને ǍƸયમય રીતે રજૂ કરી શકાય છે. ચાટƙનાે ઉપયાેગ ડેટા 
તુલનાઅા,ે ǖ̏ɡગ̍ત અથવા ડેટાના પેટનƙને સમજવા માટે થાય છે. અા સુ̍વધા ǐાેજǶે ̋રપાેટƙ, ǐƺતુ̍ તઅા,ે 
અથવા અʈ ˗વસા̍યક દƺતાવે̀ેમાં ઉપયાેગી થાય છે. 

ચાટƙ ઉમેરવા માટેના પગલા:ં 

a. Insert Chart (ચાટƙ ઉમેરવાે): Insert ટેબ પર ̚ȃક કરાે. Illustrations ǁુપમા ંChart ̍વકˍ પસંદ 
કરાે. ચાટƙ ǐકારાેની ગેલેરી ખલૂે છે.  
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b. તમારી જ̋ͅરયાત ǐમાણે ચાટƙ પસંદ કરાે અન ેOK પર ̚ȃક કરાે. 

c. Enter Data (ડેટા દાખલ કરાે): ચાટƙ ઉમયેાƙ પછી નીચે મુજબની અȋેેલ શીટ અાપેન થાય છે. 
અȋેેલમા ંડેટા દાખલ કરાે અથવા અે̋ ડટ કરાે. ડેટા સાથ ેચાટƙ અાપમેળે અપડેટ થાય છે. 

 

 
ચાટƙ પસંદ કરતા નીચે મુજબનું Chart Design અને Format ટેબ અાપાેઅાપ ઉમરેાય ̀ય છે જનેી મદદથી 
ચાટƙમાં ઈ̗Ȟત ફેરફાર કરી શકાે છાે.    

 

 
Chart Design ટેબથી તમે ચાટƙ ˶ ાઇલ અને રંગ બદલી શકાે છા.ે Change Chart Type ̍ વકˍથી ચાટƙના 
ǐકારને બદલી શકાે છા.ે 
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Chart Design ટેબમાંથી Add Chart Element ̍વકˍનાે ઉપયાેગ કરીને ટાઇટલ, લેબલ, લેજɱે વગરેે 
ઉમેરાે. 

̀ે ડેટા બદલવાે હાેય, તાે ચાટƙ પર રાઇટ-̚ȃક કરીને Edit Data ̍વકˍ પસંદ કરાે. 

Format Chart ટેબથી અાકૃ̍તનાે રંગ, બાેડƙર, અથવા છાયાં (Shadows) ઉમેરી શકાે છાે. 

ચાટƙના ǐકારાે અને તેનાે ઉપયાેગ: 

1. Column Chart (કાૅલમ ચાટƙ): તુલનાઅાે દશાƙવવા માટે ઉપયાેગી છે. 

2. Pie Chart (પાઈ ચાટƙ): Ǘણેીઅાેના ̍વતરણ દશાƙવવા માટે ઉપયાેગી છે. 

3. Line Chart (લાઇન ચાટƙ): સમયગાળા દર̌મયાન પ̋રવતƙનાે દશાƙવવા માટે ઉપયાેગી છે. 

4. Bar Chart (બાર ચાટƙ): લંબાવ માટે તુલનાઅાે દશાƙવવા ઉપયાેગી છે. 

5. Scatter Chart (˱ેટર ચાટƙ): બે અલગ ડેટા પાેઈɰ્સ વȝેના સંબંધ દશાƙવવા ઉપયાેગી છે. 

ઉપયાે̎ ગતા: 

 ડેટાને સરળતાથી સમ̀વવામાં સહાય કરે છે. 

 ǐાેજǶે ̋રપાેટƙ અને ˗વસા̍યક દƺતાવે̀ેને વધુ ˗ાવસા̍યક દેખાવ અાપે છે. 

 સȕંાɒક ડેટાને ǍƸયમય રીતે રજૂ કરે છે. 

Microsoft Word 2019 માં ચાટƙ ઉમેરવા અને તેને ક˶માઇઝ કરવાની સુ̍વધા દƺતાવેજને વધુ અાકષƙક 
અને રસǐદ બનાવે છે. 

8.5 ˲ીનશાૅટ (Screen Shot) 

˲ીનશાૅટ અે Microsoft Word 2019 માં ઉપલʤ મહɗપૂણƙ સુ̍વધા છે, જનેાે ઉપયાેગ દƺતાવેજમાં તમારી 
˲ીનનું કાેઈપણ ભાગ ǍƸયમય રીતે રજૂ કરવા માટે થાય છે. ˲ીનશાૅટ તમને અʈ ̍વ̬ડાેઝમાંથી ̘˽પેટ કે 
સંપૂણƙ ̍વ̬ડાે સરળતાથી તમારા દƺતાવેજમાં ઉમેરવાની સુ̍વધા અાપે છે. 

˲ીનશાૅટનાે ઉપયાેગ:  

દƺતાવેજમાં ǍƸયમય ડેટા અથવા GUI રેફરʉ ઉમેરવા માટે, ˲ીન પરની મહɗપણૂƙ મા̋હતી દશાƙવવા માટે 
તેમજ  સાેʘવેર અથવા ǐાેસેસના ˶ેƯસ દશાƙવવા માટે થાય છે. 

˲ીનશાૅટ ઉમેરવા માટેના પગલાં: 

a. Insert Tab (ઇʉટƙ ટેબ): Insert ટેબ પર ̚ȃક કરાે. Illustrations ǁુપમાંથી Screenshot ̍વકˍ 
પસંદ કરાે. 

b. ɔાં તમારી ˲ીનમાં ખૂલી રહેલી તમામ ̍વ̬ડાેઝની યાદી દેખાશે. ̀ે તમે સંપૂણƙ ̍વ̬ડાે ઉમેરવા માગતા હાે, તાે 
તે ̍વ̬ડાે પર ̚ȃક કરાે. 
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c. ̀ે તમે ̍વ̬ડાેના ેકાઈે ચાેǲસ ભાગ ઉમેરવા ઇȞા ેછા,ે તા ેScreen Clipping ̍વકˍ પર ̚ȃક કરાે. 

˲ીન ધંૂધળી થાય છે અને તમારે માઉસથી ̚ȃક કરીન ેજͅરી ભાગ પસંદ કરવાે પડે છે. 

˲ીનશાૅટ ક˶માઇઝ કરવી: 

 
˲ીનશાટૅ પસંદ કરીને તેને ખૂણેથી ખ̲ચીને તેનું કદ બદલી શકાે છાે. 

˲ીન શાેટમાં ફેરફાર કરવા માટે નીચે મુજબના ̍વ̍વધ ̍વકˍાે Picture Format ટેબમાં ઉપલʤ છે.  
Picture Format ટેબમા ં̀અાે અને ફાેટાે માટે ̍ વ̍વધ ˶ાઇલઅાે અન ેઇફેǶ્સ પસંદ કરાે. તમે બાડેƙર, શેડા,ે 
અથવા ̋રưલેકશન ઉમેરી શકાે છાે. ̀ે જͅરી હાયે, તાે ˲ીનશાૅટના અનાવƸયક ભાગાે દૂર કરવા માટે Crop 
̍વકˍનાે ઉપયાગે કરાે. 

દƺતાવેજ માટે ̋રલેવɰ ભાગનાે જ ˲ીનશાૅટ લાે જથેી તે વધુ ˾ˠ અાવે અને અાેછી જƝયા રાેકે. ˲ીનશાટૅ 
ઉમેયાƙ પછી તેને દƺતાવેજના અʈ તɗાે સાથે સારી રીતે ગાેઠવા.ે 

Microsoft Word 2019 મા ં ˲ીનશાૅટ ઉમેરવા અને ક˶માઇઝ કરવાની સુ̍વધા ǐાેફેશનલ દƺતાવેજ 
બનાવવા માટે ખૂબ ઉપયાેગી છે. 

9.  ̏લ̬કના ેઉપયાેગ (Using Link) 

Microsoft Word 2019 મા ં ̏લ̬ક ઉમેરવાની સુ̍ વધા છે, જ ેદƺતાવેજને વધુ ઇɰરે̖Ƕવ અને મા̋હતીǐદ 
બનાવે છે. ̏લ̬કનાે ઉપયાેગ દƺતાવેજમાં વેબસાઇટ્સ, ઈમલે સરનામા, અથવા દƺતાવેજના અʈ ભાગાે સાથ ે
̀ેડાણ માટે થાય છે. અા ફીચર ખાસ કરીને ̋રપાેટƙ, ǐાજેǶે, અને ̋ડ̏જટલ દƺતાવેજમાં ઉપયાેગી છે. 

9.1 હાઇપર̏લ̬ȋ (Hyperlinks) 

હાઇપર̏લ̬ȋ અે અેક મહɗપૂણƙ સુ̍ વધા છે, જનેાે ઉપયાેગ દƺતાવેજમાં ̍વ̍વધ વેબસાઇટ્સ, દƺતાવેજના 
અʈ ̍વભાગા,ે ઈમેલ સરનામાં અથવા બી͂ ફાઇલા ેસાથ ે̀ેડાણ માટે થાય છે. હાઇપર̏લ̬ȋ ǐɔƖ લખાણ 
અથવા અાʠેૅǶ તરીકે કામ કરે છે, જ ે̚ȃક કરતા સાથે વપરાશકતાƙને ̏ન̋દ̭ɣ  ˺ળે લઈ ̀ય છે. 

હાઇપર̏લ̬કના ઉપયાેગાે: 

1. કાેઈ વેબસાઈટ પરની ̏લ̬ક ઉમેરવા માટે. 

2. દƺતાવેજના અલગ-અલગ ̍વભાગાે વȝે સરળતાથી  મુવમɰે કરવા માટે. 

3. ઇમઈેલ સરનામા પર ̚ȃક કરતા તે સીધંુ ઈમઈેલ ȃાઈɰ ખૂલે તે માટે. 
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4. અʈ ફાઇલ અથવા નેટવકƙ  લાકેેશન સાથે દƺતાવેજને કનેǶ કરવા માટે. 

હાઇપર̏લ̬ક ઉમેરવા માટેના પગલાં: 

a. જમેાં હાઇપર̏લ̬ક ઉમેરવી છે તે લખાણ અથવા અાૅʠેǶ પસંદ કરાે. 

b. Insert ટેબ પર ̀અાે અને Links ǁુપમાંથી Link ̍વકˍ પર ̚ȃક કરા ેઅથવા, લખાણ પર રાઇટ-
̚ȃક કરીન ેLink ̍વકˍ પસંદ કરાે. 

 
c. નીચે મુજબની Insert Hyperlink ̍વɱાે ખુલે છે  

 
d. ઉપર દશાƙવેલ ̍વɱાેમાં અાવલે ̍વકˍાેમાંથી કાેઈ અેક પસદં કરાે: 

o Existing File or Web Page: URL દાખલ કરીને વેબ પેજ સાથ ે̀ેડાણ કરા.ે 

o Place in This Document: દƺતાવેજના અʈ ̍વભાગાે (Heading, Bookmark) સાથ ે
̀ેડાણ કરાે. 

o Create New Document: નવંુ દƺતાવેજ બનાવવું અને તે સાથે ̏લ̬ક ̀ેડવું. 

o Email Address: ઇમેલ સરનામા સાથે ̏લ̬ક બનાવવા માટે. 

e. હાઇપર̏લ̬ક દાખલ કરવી: જ̋ͅરયાત મુજબ URL અથવા પાથ દાખલ કરાે અને OK બટન ̚ȃક કરાે. 

હાઇપર̏લ̬કમાં ફેરફાર કરવા: 

 ̏લ̬ક માટેનું લખાણ ˾ˠ અન ેના̲ધપાǋ બનાવવા માટે Text to Display ફીˆમાં લખાણ દાખલ કરાે. 
 ̏લ̬ક પર માઉસ પાેઈɰર લઇ જતા કરતા જ ેમા̋હતી દેખાય તે માટે ScreenTip ̍વકˍમાં ̋ટʑણી ઉમેરાે. 
 હાઇપર̏લ̬ક પર રાઇટ-̚ȃક કરીને Edit Hyperlink અથવા Remove Hyperlink ̍ વકˍ પસંદ કરા.ે 

યાદ રાખાે: 

 હાઇપર̏લ̬ક ઉમેરતી વખતે તેનુ ંયાેƝય URL દાખલ કરા,ે જથેી તે બરાબર કામ કરે. 
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 હાઇપર̏લ̬કના લખાણને ˾ˠ રાખા,ે જથેી વપરાશકતાƙ માટે તે સમજવામાં સરળ રહે. 

 દƺતાવેજના ̌ǐɰ વઝƙન માટે ̏લ̬કના સંપૂણƙ URLને ˾ˠ કરાે. 

Microsoft Word 2019 મા ંહાઇપર̏લ̬ક ઉમેરવાથી દƺતાવેજમાં અેક જƝયાઅેથી બી͂ જƝયાઅે સરળતાથી 
જઈ શકાય છે. અા સુ̍વધા ǐાેજǶે ̋રપાેટƙ, વપરાશકતાƙ માગƙદ̏શ̭કા, અન ેઅાેનલાઈન દƺતાવે̀ેમાં અɔતં 
ઉપયાેગી છે. 

9.2 બુકમાકƙ  (Bookmark) 

બુકમાકƙ  અે Microsoft Word 2019 માં ઉપલʤ અેક સુ̍વધા છે, જે દƺતાવેજમાં ચાǲેસ ˺ ાનને અાેળખતી 
માકƙર તરીકે કાયƙ કરે છે. તે વપરાશકતાƙને દƺતાવેજના ̍વ̏શˠ ભાગ પર ઝડપથી પહા̲ચવામાં મદદ કરે છે. માેટા 
અને લાંબા દƺતાવે̀ેમાં બુકમાકƙનાે ઉપયાેગ દƺતાવેજને ˗વ̗˺ત રાખવામાં અને ઝડપથી નેવીગેટ કરવા 
માટે થાય છે. 

બુકમાકƙ ઉમેરવા માટેના પગલાં: 

a. ચાǲેસ લખાણ અથવા ˺ાન પસંદ કરાે: દƺતાવેજમાં ȱાં તમે બુકમાકƙ  ઉમેરવા માંગાે છા,ે તે ˺ાન 
પસંદ કરા.ે 

b. Insert Bookmark (બુકમાકƙ  ઉમેરવંુ): Insert ટેબ પર ̀અાે. Links ǁુપમાંથી Bookmark ̍વકˍ 
પર ̚ȃક કરાે. 

c. Bookmark Name: બુકમાકƙ  માટે અનʈ નામ દાખલ કરાે. નામમાં જƝયાઅાે (Spaces) ન હાેઈ શકે; 
તમે ડૅશ (_) અથવા અɱર˱ારેનાે ઉપયાેગ કરી શકાે છાે. 

 
d. Add બટન પર ̚ȃક કરીન ેબુકમાકƙ  ઉમેરાે. 

દƺતાવેજમાં નવેીગેટ કરવંુ:   

 Ctrl + G દબાવાે અથવા Go To ̍વકˍ પર ̚ȃક કરાે. નીચે મુજબની ̍વɱાે અાેપન થાય છે. 
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 Bookmark પસંદ કરાે અન ેતમા̈́ં બુકમાકƙ  પસંદ કરીન ેGo To બટન પર ̚ȃક કરા.ે 

હાઇપર̏લ̬ક સાથે બુકમાકƙ  ̀ેડવું: 

 જનેે હાઇપર̏લ̬ક બનાવવી હાેય તે લખાણ પસંદ કરાે. 

 Insert ટેબમાં જઈને Link ̍વકˍ પસંદ કરાે. 

 Place in This Document પસંદ કરાે અને તમા̈́ં બુકમાકƙ  પસંદ કરાે. 

બુકમાકƙને ક˶માઇઝ અથવા દૂર કરવંુ: 

 Insert ટેબ > Bookmark ̍વકˍ પર ̚ȃક કરાે. ɔાં બુકમાકƙની તમામ યાદી દેખાશે. 

 બુકમાકƙ  પસંદ કરાે અન ેDelete બટન પર ̚ȃક કરાે. 

સૂચના:ે 

 બુકમાકƙ  માટે ˗ાવહા̋રક અને તકƙસંગત નામાે અાપા ેજથેી તેમને અાેળખવંુ સરળ રહે. 

 બુકમાકƙ  ઉમરેતી વખત ેદƺતાવેજનું યાƝેય માળખું ̀ળવાે. 

 ̐બનજͅરી બુકમાકƙને હટાવા,ે જથેી દƺતાવેજ સાફ અન ે˗વ̗˺ત રહે. 

10. હેડર અન ેફુટર (Header and Footer) 

હેડર અને ફુટર દƺતાવેજમાં પાનાની ઉપર અન ેનીચેની જƝયામાં લખાણ અથવા મા̋હતી ઉમેરવા માટે ઉપયાેગ 
થાય છે. અા સુ̍ વધાનાે ઉપયાેગ પાનું નંબર, ̋દવસાંક, દƺતાવેજનું નામ અથવા શીષƙક જવેી માહીતી ઉમેરવા 
માટે થાય છે. 

હેડર અને ફુટરનાે ઉપયાેગ દƺતાવેજને વધુ ˗વ̗˺ત, ˗ાવસા̍યક, અને મા̋હતીǐદ બનાવવા માટે થાય છે. 

10.1 હેડર ઉમેરવંુ (Insert Header) 

હેડર અે દƺતાવેજના દરેક પાનાંના ઉપરના ભાગમાં મળતી જƝયા છે, ȱાં તમે શીષƙક, પાનાં નંબર, તારીખ, 
સમય અથવા અʈ મા̋હતી ઉમરેી શકાે છા.ે Microsoft Word 2019 માં હેડર ઉમેરવાની ǐ̋ƿયા સરળ છે 
અને અા સુ̍ વધાનાે ઉપયાેગ દƺતાવેજને વધુ ˗વ̗˺ત બનાવવા માટે થાય છે. 

હેડર ઉમેરવા માટેના પગલાં: 

a. Insert ટેબમાં ̀અાે અન ેHeader & Footer ̍વભાગમાંથી Header ̍વકˍ પસંદ કરાે. 
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b. હેડર ̚ȃક કરતા અેક ǉાેપડાઉન મેનુ ખુલશે. ɔાંથી ઉપલʤ ̋ડઝાઇનમાંથી કાેઈ અકે પસંદ કરાે. 

 
c. હેડરમાં ̚ȃક કરાે અન ેજͅરી લખાણ લખા,ે જમે કે દƺતાવેજનંુ નામ, પાનાં નબંર, અથવા અʈ મા̋હતી. 

d. ̀ે તમે તારીખ, સમય અથવા ̌ પǴર ઉમેરવું હાેય, તાે Insert ટેબમાંથી તે ̍ વકˍાેના ેઉપયાેગ કરાે. હેડરના 
લખાણ માટે ફાɰૅ ˶ાઇલ અથવા કદ બદલવા Home ટેબના ેઉપયાેગ કરા.ે 

e. Header & Footer Tools ટેબમાંથી Close Header and Footer બટન પર ̚ ȃક કરાે અથવા Esc 
કી દબાવાે. 

હેડરની ક˶માઇઝેશન માટે ̍વકˍાે: 

 ̀ે તમારે ǐથમ પાનાં માટે અલગ હેડર દશાƙવવી હાેય, તાે Header & Footer Tools માંથી Different 
First Page ̍વકˍ સ̋ƿય કરાે. 

 અલગ ̍વભાગાે માટે અલગ હેડર ઉમેરવા માટે Section Breaks નાે ઉપયાેગ કરા.ે 

 Insert ટેબમા ંDate & Time ̍વકˍ પસંદ કરાે. 

 હેડર ̍વƺતારમાં Insert Picture ̍વકˍનાે ઉપયાેગ કરીન ેલાેગા ેઅથવા ̌પǴર ઉમેરાે. 
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હેડરના ઉપયાેગા:ે 

1. દƺતાવેજનું નામ અથવા શીષƙક દરેક પાનાં પર દશાƙવવા માટે. 

2. દƺતાવેજ વધુ ˗વસા̍યક લાગે તે માટે પાનાં પર લાેગાે અથવા ટેગલાઇન ઉમેરવી. 

3. હેડરમાં તારીખ, સમય અથવા ǐાેજǶેના નામ જવેી જͅરી મા̋હતી ઉમેરવી. 

યાદ રાખાે: 

 હેડરના લખાણને ˾ˠ અને ˗વ̗˺ત રાખાે, જથેી તે દƺતાવેજના મુȕ ભાગ સાથે અાેવરલેપ ન 
થાય. 

 ̀ે તમારે અેકસાથે તમામ પાનાં માટે હેડર સમાન રાખવી હાેય, તાે તે ગાેઠવણમાં ફેરફાર ન કરાે. 

 દરેક ̍વભાગ માટે અલગ હેડર ઉમેરવા માટે Link to Previous ̍વકˍ અનચેક કરાે. 

Microsoft Word 2019 માં હેડર ઉમેરવી દƺતાવેજને વધુ ˗વ̗˺ત અને ǐાેફેશનલ બનાવે છે. અા 
સુ̍ વધાનાે ઉપયાેગ ̋રપાેટ્ƙસ, ǐાેજǶે ડાેȂુમેɰ, અને ̌ǐɰેડ ફાઇલાે માટે ખાસ કરીને ઉપયાેગી છે. 

10.2 ફુટર ઉમેરવું (Insert Footer) 

ફુટર અે દƺતાવેજના દરેક પાનાંના નીચેના ભાગમાં મળતી જƝયા છે, ȱાં તમે પાનાં નંબર, તારીખ, સમય, 
દƺતાવેજનું નામ અથવા અʈ મા̋હતી દાખલ કરી શકા ેછાે. Microsoft Word 2019 માં ફુટર ઉમેરવાની 
ǐ̋ƿયા સરળ છે અને અા સુ̍વધાનાે ઉપયાેગ દƺતાવેજને વધુ ˗વ̗˺ત બનાવવા માટે થાય છે. 

 

ફુટર ઉમેરવા માટેના પગલાં: 
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a. Insert Tab (ઇʉટƙ ટેબ): Insert ટેબમાં ̀અાે અન ે
Header & Footer ̍વભાગમાંથી Footer ̍વકˍ પસંદ 
કરાે. 

b. ફુટર ̋ડઝાઇન પસંદ કરાે: ઉપલʤ ̋ડઝાઇનમાંથી અેક 
પસંદ કરા,ે જમે કે ̐બ˄-ઇન ˶ાઈલ અથવા ક˶મ ફુટર. 

 

c. ફુટરમાં લખાણ ઉમેરાે: ફુટર Ɩેǋમાં ̚ ȃક કરાે અને જͅરી 
મા̋હતી લખાે, જમે કે પાના ં નંબર, ̋દવસાંક, અથવા 
ǐાેજǶે નામ. 

d. ક˶માઇઝેશન: ̀ે તમને પાનાં નંબર અથવા તારીખ 
ઉમેરવી હાેય, તા ેInsert ટેબમાંથી તે ̍વકˍાનેાે ઉપયાેગ 
કરાે. લખાણ માટે ફાɰૅ ˶ાઈલ અથવા કદ બદલી શકાય 
છે Home ટેબ ɦારા. 

e. Close Header and Footer: Header & Footer 
Tools ટેબ પરથી Close Header and Footer બટન 
પર ̚ȃક કરાે અથવા Esc કી દબાવાે.  

ફુટરની ક˶માઇઝેશન માટે ̍વકˍાે: 

 ̀ે તમારે ǐથમ પાનાં માટે અલગ ફુટર ઉમેરવંુ હાયે, તા ેHeader & Footer Tools માંથી Different 
First Page ̍વકˍ સ̋ƿય કરાે. 

 દƺતાવેજના અલગ ̍વભાગાે માટે અલગ ફુટર ઉમેરવા Section Breaks નાે ઉપયાેગ કરાે. 

 Insert ટેબમા ંDate & Time ̍વકˍથી તાજતેરના સમય અને તારીખ દાખલ કરાે. 

 લાેગાે અથવા ̌પǴર ઉમેરવા માટે Insert Picture ̍વકˍનાે ઉપયાેગ કરાે. 

ફુટરના ઉપયાેગા:ે 

1. દƺતાવેજના દરેક પાનાં પર ƿમ દશાƙવવા માટે. 

2. તારીખ, સમય, અથવા ફાઇલનું નામ દશાƙવવા માટે. 

3. ̋રપાેટƙ અથવા ̌ǐɰેડ દƺતાવેજને વધુ ˗વસા̍યક બનાવવા માટે. 

સૂચના:ે  

 ફુટરમાં મા̋હતી ˾ˠ રાખા ેઅને તે દƺતાવેજના મȕુ ભાગ સાથે અાેવરલેપ ન થાય તેની ખાતરી કરા.ે 

 Link to Previous ̍વકˍ અનચેક કરીને અલગ ̍વભાગાે માટે અલગ ફુટર ઉમેરા.ે 

 ફુટર ઉમેરતી વખતે દƺતાવેજના માળખાને યાƝેય રીતે ગાઠેવાે. 

Microsoft Word 2019 માં ફુટર ઉમેરવી દƺતાવેજને વધુ ˗વ̗˺ત અને ˗વસા̍યક બનાવે છે. પાના ં
નંબર, તારીખ અને અʈ મહɗપૂણƙ ̍વગતાે દશાƙવવા માટે અા અેક અગɔની સુ̍ વધા છે. 
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11. કɰેɰ ઉમેરવંુ (Insert Content) 

Microsoft Word 2019 મા ંકɰેɰ ઉમેરવા માટેની સુ̍ વધાઅાેનાે ઉપયાેગ દƺતાવેજમાં લખાણ, ̌પǴર, 
ચાટ્ƙસ, ટેબ˔, શƯેસ, અને અʈ ̍વ̍વધ ǁા̋ફકલ અથવા ટેȌ ઘટકાેને ઉમેરવા માટે થાય છે. અા સુ̍વધા 
દƺતાવેજને વધુ ǐભાવશાળી અને મા̋હતીǐદ બનાવે છે. તેના માટે Insert ટેબનાે ઉપયાગે થાય છે.   

 

11.1  ̐સȘેચર લાઇન (Signature Line) 

̐સȘેચર લાઇન અે દƺતાવેજમાં સહી ઉમેરવા માટેની ખાસ સુ̍વધા છે. Microsoft Word 2019 સહી માટે 
અેક નǲી કરેલી જƝયા બનાવે છે, ȱાં વપરાશકતાƙ ̋ડ̏જટલ અથવા હƺત̏લ̑ખત સહી ઉમેરી શકે છે. અા 
સુ̍ વધાનાે ઉપયાેગ મુȕɗે અ̍ધકૃત દƺતાવે̀ે, કરાર, અથવા સɇાવાર પǋાે માટે થાય છે. 

̐સȘેચર લાઇન ઉમરેવા માટેના પગલાં: 

a. Insert ટેબમાં ̀અાે અન ેText ̍વભાગમાંથી Signature Line ̍વકˍ પસંદ કરાે. 

 
b. ȱાં ̐સȘેચર લાઇન ઉમેરવી છે ɔાં ̚ȃક કરાે અને Microsoft Office Signature Line પસંદ 

કરાે. 

c. અેક નવી ̍વɱાે ખુલશ,ે ȱાં તમારે સહી અાપનારનું નામ તેમનાે હેતુ અથવા પદ અને અʈ સૂચનાઅા ે
(Optional) ઉમેરવાની છે 
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d. જͅરી મા̋હતી નાખીને OK બટન દબાવાે.  

e. ̐સȘેચર લાઇન દƺતાવેજમા ંઉમેરાઈ જશે. 

̋ડ̏જટલ સહી ઉમેરવા માટે: 

a. દƺતાવેજમાં ઉમરેેલી ̐સȘેચર લાઇન પર ̚ȃક કરાે. 

b. અેક પાેપ-અપ ̍વɱાે ખુલ ેછે, ȱાં તમા̈́ં નામ અને સહી ઉમેરવી છે. 

c. ̋ડ̏જટલ પેનથી હƺત̏લ̑ખત સહી કરાે અથવા સહીનું ̌પǴર ઉમેરાે. 

d. સહી ઉમેયાƙ પછી OK પર ̚ȃક કરાે, અને સહી દƺતાવેજમાં સેવ થશે. 

̐સȘેચર લાઇનના ઉપયાેગાે: 

1. કરાર, અાૈપચા̋રક પǋા,ે અથવા ̋રપાેટƙ માટે સહી ઉમેરવા માટે. 

2. સɇાવાર ̋ડ̏જટલ દƺતાવે̀નેે ǐમાણભતૂ બનાવવા માટે. 

3. કાેઈન ેસહી માટે દƺતાવેજ માકેલવા માટે. 

સૂચના:ે 

 દƺતાવેજના અંતમા ંઅથવા જ̋ͅરયાત મુજબ જƝયાઅે ઉમેરા.ે 

 ̀ે દƺતાવેજ ̌ǐɰ કરવામાં અાવે છે, તાે ફǸ ̋ફ̏ઝકલ સહી માટે ̐સȘેચર લાઇન છાેડી શકાય છે. 

 વધુ સુરƖા માટે ̋ડ̏જટલ સ̋ટ̭̋ફકેટનાે ઉપયાેગ કરાે. 

Microsoft Word 2019 મા ં ̐સȘેચર લાઇન દƺતાવેજને વધુ અ̍ધકૃત અન ે ǐાેફેશનલ બનાવે છે. અા 
સુ̍ વધાનાે ઉપયાેગ કરીને વપરાશકતાƙઅાે સહી માટે સરળ રીતે જƝયા બનાવી શકે છે અન ેસહી ઉમેરી શકે છે 

11.2  તારીખ અને સમય ઉમેરવું (Date and Time) 

તારીખ અને સમય ઉમેરવી Microsoft Word 2019 ની અેક સરળ અને ઉપયાેગી સુ̍ વધા છે. અા સુ̍ વધાના ે
ઉપયાેગ દƺતાવેજમાં વતƙમાન તારીખ અને સમય દશાƙવવા માટે થાય છે. તે ખાસ કરીને સɇાવાર પǋા,ે ̋રપાેટ્ƙસ, 
અને અʈ દƺતાવે̀ે માટે ઉપયાેગી છે, ȱાં સમયની મયાƙદા ના̲ધવાની જͅર હાેય છે. 

તારીખ અન ેસમય ઉમરેવા માટેના પગલા:ં 

a. Insert ટેબ પર ̚ȃક કરાે. 

b. Text ̍વભાગમા ંDate & Time બટન પર ̚ȃક કરાે. 
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c. Date and Time Dialog Box માંથી ઉપલʤ તારીખ અને સમયના ફાેમ̳ટ્સમાંથી તમા̈́ં પસદંગીનુ ં
ફાેમ̳ટ પસંદ કરાે. તમે માǋ તારીખ, માǋ સમય અથવા બંને અેકસાથે ઉમરેવા માટે ફામે̳ટ પસંદ કરી શકા ે
છા.ે 

 
d. ̀ે તમારે દƺતાવેજ ખાલેતી વખતે તારીખ અને સમય અાપમેળે અપડેટ થાય તેવંુ હાયે, તાે Update 

Automatically ચેકબાȋે પસંદ કરાે.  

e. પસંદગી કયાƙ પછી OK બટન પર ̚ȃક કરાે, અને તારીખ અને સમય દƺતાવેજમાં ઉમેરાઈ જશે. 

તારીખ અન ેસમયના ઉપયાેગાે: 

1. પǋ, ̋રપાેટƙ, અને મેમાેમાં તારીખ અને સમય ઉમેરવાથી તેઅાે વધુ ˗ાવસા̍યક બને છે. 

2. દƺતાવેજને સાચવતી વખતે તેની તારીખ અને સમય રેકાડેƙ કરવા માટે. 

3. Automatically Update ̍વકˍ સ̋ƿય કરીને દરેક વખત દƺતાવેજ ખાેલાે ɔારે નવી તારીખ અન ે
સમય ǐદ̏શ̭ત થાય છે. 

સૂચના:ે 

 દƺતાવેજના ǐકાર માટે યાેƝય તારીખ અને સમય ફામે̳ટ પસદં કરાે. ઉદાહરણ તરીકે, સɇાવાર દƺતાવે̀ે 
માટે, "DD/MM/YYYY" અથવા "Month DD, YYYY" વધુ યાƝેય છે. 

 ̀ે તમારે તારીખ અને સમય દરેક પાના ંપર બતાવવા હાયે, તાે તેન ેHeader અથવા Footer મા ં
ઉમેરાે. 

 ̀ે તમારે તારીખ અને સમય દƺતાવેજ સાચવવાના સમય ેજ દશાƙવવાે હાેય અને ત ેબદલાવવાે ન 
̀ેઈઅ,ે તાે Update Automatically ̍વકˍ અનચેક રાખાે. 

Microsoft Word 2019 મા ં તારીખ અને સમય ઉમેરવંુ દƺતાવેજને વધુ ˗વ̗˺ત, ǐામા̒ણક અન ે
˗ાવસા̍યક બનાવે છે. અા સુ̍ વધાનાે ઉપયાેગ કરવાથી દƺતાવેજમાં સમયસંવા̋દતા અને અા̍ધȂ ઉમેરવામા ં
મદદ મળે છે. 

11.3 સમીકરણ (Equation) 
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Microsoft Word 2019મા ંસમીકરણ ઉમેરવાની સુ̍વધા ̍વƗાન, ગ̒ણત, અને ઇજનરેી સંબં̍ ધત દƺતાવે̀ ે
માટે ̍વશેષ ઉપયાેગી છે. અા સુ̍ વધાનાે ઉપયાેગ કરીને વપરાશકતાƙ સરળતાથી જ̋ટલ ગ̒ણતીય અથવા 
વૈƗા̏નક સમીકરણાે બનાવી અને સંશાેધન અથવા શƖૈ̒ણક દƺતાવેજમાં રજૂ કરી શકે છે. 

સમીકરણ ઉમેરવા માટેના પગલાં: 

a. વડƙ દƺતાવેજમા ંInsert ટેબ પર ̚ȃક કરાે. 

b. Symbols ̍વભાગમા ંEquation બટન પર ̚ȃક કરાે. 

 
c. દƺતાવેજમાં અેક નવા સાદા સમીકરણ અે̋ ડટર સાથે Type equation here લખેલંુ બતાશે. 

 
d. સમીકરણ લખવા માટે કીબાડેƙનાે ઉપયાેગ કરા ેઅથવા Design Tab માંથી ઉપલʤ સમીકરણના ટૂ˔ 

અને ̌ǐ-̋ડઝાઇન ટેƳʕેટનાે ઉપયાેગ કરાે. 

ઉપલʤ ̍વકˍાે અને ટૂ˔: 

1. Microsoft Word 2019માં Equationમાં ǉાેપ ડાઉન મેનુમાં  કેટલાક ̐બ˄-ઇન સમીકરણાે ઉપલʤ 
છે જ ેનીચે દશાƙવેલ છે તે સમીકરણાેન ેદƺતાવેજમાં સીધા જ ઉમેરી શકાે છાે. 



 

  
SARDAR PATEL INSTITUTE OF PUBLIC ADMINISTRATION, AHMEDABAD 121 

 

 
2. ̍ǋકાેણ̌મ̍ત કાયા̳, ̎ચ̆ા,ે મળૂાકાર, ǑેȆન, તેમજ ǁીક અƖરાનેા ેઉપયાેગ કરી શકાે છાે. 

 
3. સમીકરણમાં ખાસ ̎ચ̆ાે ઉમરેવા માટે ̐સʳાે̝  ઉપલʤ છે. 

4. તમારે પાેતાનંુ સમીકરણ ઉમરેવંુ હાયે તા ે Ink Equation ̍વકˍનાે ઉપયાેગ કરી શકા ેછાે, ȱાં તમ ે
હાથેથી લખીને પણ સમીકરણ બનાવી શકાે છાે. 

સમીકરણના ઉપયાગેાે: 

1. ગા̒ણ̍તક સમીકરણ રજૂ કરવા માટે. 

2. ̍વƗાન સંબં̍ ધત સǋૂાે અને સમીકરણાે લખવા માટે. 

3. ǐાફેેસનલ ̋રપાેટƙ, અʬાસƿમ સામǁી અને પેપસƙ માટે સમીકરણ ઉમેરવા માટે. 

સૂચના:ે 

 તમારા દƺતાવેજની ˶ાઇલ સાથે સુસંગત રાખવા માટે સમીકરણના અાકાર, ˶ાઇલ અને કદ 
ક˶માઇઝ કરા.ે 

 Alt + = શાટેƙકટ કી દબાવતા સમીકરણ ટૂ˔ શͅ થાય છે. 

 વારંવાર ઉપયાગેમાં લવેાતા સમીકરણાેને ̐બ˄-ઇન ટેƳʕેટ તરીકે સેવ કરાે. 
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Microsoft Word 2019મા ંસમીકરણ સુ̍વધા દƺતાવેજને વધુ ˗ાવસા̍યક અને વૈƗા̏નક બનાવે છે. અા 
ટૂલના ેઉપયાેગ કરી તમે જ̋ટલ મા̋હતી પણ સરળતાથી રજૂ કરી શકાે છાે. 

11.4 ̐સʳાેલ (Symbol) 

Microsoft Word 2019મા ંǐતીક (Symbol) ઉમેરવાની સુ̍વધા દƺતાવેજમાં ̍ વ̏શˠ અƖરા,ે ̎ ચ̆ાે અથવા 
̎ચ̆ાɒક સંકેતાે ઉમેરવા માટે ઉપયાેગી છે. અા સુ̍ વધાનાે ઉપયાેગ ̎ચ̆ાɒક શʣાવ̏લ, ગ̒ણતીય ǐતીકાે, 
અને ̍વƗાન સંબં̍ ધત મા̋હતી માટે થાય છે. 

̐સʳાેલ ઉમેરવા માટેના પગલાં: 

a. Insert ટેબ પર ̚ȃક કરાે. 

b. Symbols ǁુપમા ંSymbol બટન પર ̚ȃક કરાે. અેક ǉાેપડાઉન મેનુ ખુલશ,ે ȱાં સામાʈ ǐતીકા ે
દેખાશે. 

 
c. ̀ે તમને જͅરી ̐સʳાેલ ǐારં̑ભક સૂ̎ ચમાં ન મળે, તાે More Symbols ̍વકˍ પર ̚ȃક કરાે. 

d. ખૂલેલી ̍વɱાેમાંથી તમા̈́ં પસદંગીનું ǐતીક શાેધાે. અલગ ǐકારના ǐતીકા ેમાટે Font અથવા Subset 
ǉાેપડાઉન મનેુનાે ઉપયાેગ કરાે, જમે કે: ǁીક અƖરાે, ગ̒ણતીય ̎ચ̆ા,ે ̍વશષે અƖરા ેવગેરે 

 
e. ǐતીક પસંદ કયાƙ પછી Insert બટન પર ̚ȃક કરા,ે અને તે દƺતાવેજમાં ઉમેરાશે. 

ǐતીકાેના ઉપયાેગા:ે 

1.  π (પાઈ), ∑ (̐સƝમા), √  વગેરે ǐતીકા ેઉમરેવા માટે. 

2.  α, µ, ø, λ જવેા ̍વ̏શˠ અƖરા,ે જ ેસામાʈ કીબાેડƙ પર ઉપલʤ નથી. 
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3. ચલણની ̏નશાની ($, €, ₹) અથવા Ǉેડમાકƙ  (™) ̎ચ̆ ઉમેરવા માટે. 

4. તબીબી ̎ચ̆ાે (∞, Δ) અથવા અʈ ̍વ̏શˠ ǐતીકાે. 

સૂચનાે: 

 કેટલીકવાર ̐સʳાેલ માટે કીબાેડƙ શાૅટƙકટ ઉપલʤ હાેય છે. ઉદાહરણ: Alt + 0176 -> ° (̋ડǁી 
̐સʳાેલ).  અાવા શાટૅƙકટ્સને ઝડપી ઉકેલ માટે યાદ રાખાે. 

 ̐સʳાેલની ˶ાઇલ પસંદ કરવા માટે Wingdings અન ેWebdings ફાૅɰસ ફાયદાકારક છે. 

 ઉમેરેલા ǐતીકાેના કદ, રંગ, અન ે˶ાઇલને લખાણ સાથે સુસંગત બનાવાે. 

Microsoft Word 2019ની ̐સʳાેલનીસુ̍ વધા દƺતાવજેમાં અƖરાેને વધારે અથƙસભર અને ǐભાવશાળી 
બનાવે છે. અા સુ̍વધાનાે ઉપયાેગ ખાસ કરીને શƖૈ̒ણક, ̍વƗાનસંબં̍ધત, અને ˗ાવસા̍યક દƺતાવે̀ે માટે 
અɔંત ઉપયાેગી છે 

12. પેજ બેકǁાઉɱ (Page Background) 

Microsoft Word 2019માં પજે બેકǁાઉɱ અે દƺતાવેજના પૃˤને અાકષƙક બનાવવા અને તેના ǐવેશને 
વધારાે અાપવા માટેની અેક ઉપયાેગી સુ̍વધા છે. તમે પૃˤ માટે રંગ, વાૅટરમાકƙ , અથવા બાેડƙર ઉમેરીન ે
દƺતાવેજને વધુ ˗વસા̍યક અને ɪાનઅાકષƙક બનાવી શકાે છાે. 

પેજ બેકǁાઉɱના મȕુ ̍વકˍાે: 

1. Page Color (પેજ રંગ): દƺતાવેજના પૃʕ  માટે પાછળનાે રંગ પસંદ કરવાે. 

2. Watermark (વાૅટરમાકƙ): દƺતાવેજમાં લખાણ અથવા છબી તરીકે પૃʕ  પર છંદǐકારનાે ̎ચ̆ 
ઉમેરવાે. 

3. Page Border (પજે બાેડƙર): દƺતાવેજના પાનું પર બાેડƙર ઉમેરવાે. 

પેજ બેકǁાઉɱના ઉપયાેગા:ે 

1. ̋રપાેટƙ, ǐƺતાવના અને પǋાે માટે ˾ˠતા અને સંકેત ઉમેરવા. 

2. શૈƖ̒ણક ǐાેજǶે અથવા સǁં̋હત દƺતાવે̀ે માટે અાકષƙક દેખાવ મેળવવા માટે. 

3. દƺતાવેજની ગાેપનીયતા સુ̏ન̏˛ત કરવા માટે (જમે કે Confidential, Sample). 

સૂચનાે: 

 પેજ કલર પસંદ કરતી વખતે અેવા રંગાે પસંદ કરાે જે વાંચવા માટે યાેƝય હાેય. હળવા રંગાે સામાʈ 
રીતે વધુ અનુકૂળ છે. 

 ̀ે દƺતાવેજ ̌ǐɰ કરવાનું હાેય તાે તમારે Background રંગ ન રાખવાે ̀ેઈઅે અથવા ̌ǐ̔ɰ̬ગ માટે 
તેને અનુકૂળ બનાવવા માટે અʈ પસંદગીઅાે પર ̍વચારવું ̀ેઈઅે. 

 કંપનીનાે લાેગાે અથવા તમા̈́ં નામ વાૅટરમાકƙ  તરીકે ઉમેરી શકાે છાે. 

Microsoft Word 2019માં પેજ બેકǁાઉɱની સુ̍ વધા દƺતાવેજને વધુ અાકષƙક, ગાેપનીય, અને ˗વસા̍યક 
બનાવે છે. અા સારા ǐેઝɰેશન માટે અેક મહɗપણૂƙ પગલું છે. 
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12.1  વાૅટરમાકƙ  (Watermark) 

વાટૅરમાકƙ  અ ે Microsoft Word 2019માં દƺતાવેજના પેજ પર લખાણ કે ̌પǴરના ̄ͅપમાં મા̋હતી 
ઉમેરવાની સુ̍ વધા છે. વાૅટરમાકƙનાે ઉપયાેગ દƺતાવેજને Confidential (ગાપેનીય), Draft (ǉાʘ), અથવા 
અનʈ અાેળખ અાપવા માટે થાય છે. અા દƺતાવેજમાં તે ઝાંખા ̄ͅપમાં દેખાય છે જથેી તે લખાણ કે અʈ 
મા̋હતીને અવરાેધે નહ̯ અને ડાȂેુમɰે સુવાȢ બન.ે 

વાૅટરમાકƙ  ઉમરેવા માટેના પગલાં: 

1. Microsoft Word ખાેલાે અન ેDesign Tab પર ̀અાે. 

2. Page Background ̍વભાગમા ંWatermark બટન પર ̚ȃક કરાે. 

 
3. મેનુમાંથી ઉપલʤ ̐ બ˄-ઇન વાૅટરમાકƙ  પસદં કરા,ે જમે કે: Confidential, Draft, Urgent ̀ ે તમારે 

ખાસ લખાણ અથવા છબી વાૅટરમાકƙ  તરીકે ઉમેરવી હાેય, તાે Custom Watermark ̍વકˍ પસંદ 
કરાે. અહ̯ બે ̍વકˍા ેમળશ:ે 
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 Text Watermark: લખાણ દાખલ કરા,ે ફાૅɰ અન ેરંગ પસંદ કરાે. 

 Picture Watermark: તમા̈́ં લાેગાે અથવા ̌પǴર અપલાેડ કરાે. 

4. દેખાવ પસંદ કરાે: 

o વાટૅરમાકƙની સપાટી હાે̋ રઝાેɰલ અથવા ડાયગનલ તરીકે સેટ કરાે. 

o પેજ પર તે કઈ રીતે દેખાશ ેતે માટે Transparency અન ેસાઈઝ ̍વકˍ સેટ કરાે. 

5. Apply કરાે અને OK પર ̚ȃક કરાે જથેી દƺતાવેજમાં વાૅટરમાકƙ  લાગુ થશે. 

 

વાૅટરમાકƙના ઉપયાેગાે: 

1. ડેટા સુરƖાને સુ̏ન̏˛ત કરવા માટે Confidential વાૅટરમાકƙ  ઉમેરવંુ. 

2. દƺતાવેજ મસુɠા ̄ͅપે છે તે બતાવવા માટે Draft વાૅટરમાકƙ  ઉમેરવંુ. 

3. ǒા̒ɱ̬ગ માટે કંપનીનું લાેગાે વાૅટરમાકƙ  તરીકે ઉમેરવંુ. 

4. દƺતાવેજની નકલ અથવા દુ̈́પયાેગ રાેકવા માટે વાટૅરમાકƙ  ઉમેરવંુ. 

 

સૂચના:ે 

 લખાણ અથવા છબી વાૅટરમાકƙને ˾ˠ બનાવવા માટે Transparency ̍વકˍનાે ઉપયાગે કરાે. 

 અાછા કલરવાળા અથવા ઝાખંા બેકǁાઉɱવાળા ̌પǴર વાટૅરમાકƙ  માટે Ǘેˤ છે. 

 વાટૅરમાકƙ  અાપમેળે સમǁ દƺતાવેજના પાનાંઅાે પર લાગુ થાય છે, પરંતુ ખાસ પાનાં માટે તેને દૂર 
કરવાની જͅર હાેય તાે Header/Footer સે̋ટ̬ગમાં ફેરફાર કરાે. 
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Microsoft Word 2019મા ંવાૅટરમાકƙ  દƺતાવેજની સુરƖા, ગાેપનીયતા અને ˗વસા̍યકતા વધારવા માટે 
મહɗપૂણƙ છે. તે દƺતાવેજને ̍વ̏શˠ ̎ચ̆ અાપી તેન ેવધુ ǐભાવશાળી બનાવે છે. 

12.2 પેજ રંગ (Page Color) 

Microsoft Word 2019મા ં પેજને રંગ (Page Color) ઉમેરવાની સુ̍વધા દƺતાવેજના પેજ માટે ̍વ̍વધ 
બેકǁાઉɱ રંગાે સેટ કરવા માટે વપરાય છે. અા સુ̍વધાનાે ઉપયાેગ દƺતાવેજને વધુ અાકષƙક અને ̠ ાવસા̍યક 
બનાવવા માટે થાય છે. 

પેજ રંગ ઉમરેવા માટેના પગલાં: 

1. Microsoft Wordખાલેીન ેDesign Tab પર ̀અાે. 

2. Page Background ̍વભાગમા ંPage Color બટન પર ̚ȃક કરાે. 

3. તમને ̍વ̍વધ રંગ ̍વકˍાે દેખાશે. તમા̈́ં પસંદગીનંુ રંગ પસદં કરા,ે અને તે દƺતાવેજના પાનાં પર લાગુ 
થશ.ે 

 
4. ̀ે ચાǲેસ રંગ ̀ેઈઅે હાેય, તાે More Colors ̍વકˍ પર ̚ȃક કરા.ે અહ̯ RGB અથવા HSL 

મૂˑ  ɦારા તમારી જ̋ͅરયાત ǐમાણ ેરંગ પસંદ કરી શકાે છાે. 
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5. Fill Effects પસંદ કરવા માટે Page Color મેનુમાંથી અા ̍વકˍ પસંદ કરા.ે અહ̯ ǁે̋ડયɰ, 

ટેȋચર, પેટનƙ અથવા ̌પǴર બેકǁાઉɱ તરીકે ઉમરેી શકાે છાે. 
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પેજ રંગના ઉપયાેગાે: 

1. શૈƖ̒ણક ǐાેજǶે, પાટ̰ અામǋંણ અથવા ǒાેશર માટે રંગીન પૃˤ ઉમેરવંુ. 

2. દƺતાવેજને વધુ અાકષƙક બનાવવા માટે. 

3. લખાણને વધુ ˾ˠ અને વાંચનસરલ બનાવવાની જͅર હાેય ɔારે પૃʕ ભૂ̌ મ રંગનાે ઉપયાેગ. 

સૂચનાે: 

 પેજ રંગનાે ઉપયાેગ કરતી વખતે, ̀ે દƺતાવેજ ̌ǐɰ કરવા જઈ ર̈ાે હાેય તાે Background રંગ 
હટાવવા માટે પસંદગી કરાે. File > Options > Display > Print Background Colors and 
Images ̍વકˍ તપાસાે. 

 હળવા રંગાે વાંચન માટે વધુ યાેƝય હાયે છે. અ̍ત ઉȨલ રંગાે લખાણ વાંચવામાં અવરાેધ લાવી શકે 
છે. 

 ǐાેફેશનલ દƺતાવે̀ે માટે રંગનાે ઉપયાેગ મયાƙ̋ દત રાખવાે. માǋ કેટલાક ̎ચ̆ાંકન માટે રંગ ઉમેરાે. 

Microsoft Word 2019માં પેજ રંગ દƺતાવેજને વૈ̍વɪપૂણƙ અને ̎ચǋમય બનાવવા માટે અેક મહɗપૂણƙ ટૂલ 
છે. તે દƺતાવેજના પાનાંને અનુકૂળતાના અાધારે ફાેમ̳ટ કરવાનું ̄તǋંતા અાપે છે. 

13. પેજ સેટઅપ (Page Setup) 

પેજ સેટઅપ (Page Setup) અે Microsoft Word 2019ની અેક મહɗપણૂƙ સુ̍ વધા છે, જ ે દƺતાવેજના 
પાનાંના માપ, મા̏જન, મા̏જ̭ન, અાે̋ રઅેɰેશન અને અʈ ફેરફાર કરવાની મંજૂરી અાપે છે. અા સુ̍ વધાના ે
ઉપયાેગ દƺતાવેજને ǐાેફેશનલ અને ǐƺતુ̍ ત લાયક બનાવવા માટે થાય છે. 

પેજ સેટઅપના મȕુ ̍વકˍામેાં Margins (મા̏જ̭ન), Orientation (અાે̋ રઅɰેેશન), Page Size (પાનાંનંુ 
કદ), Columns (કાૅલમ), Paper Source (કાગળ ˸ાેત),  Layout (લેઅાઉટ) નાે સમાવેશ થાય છે. 

Microsoft Word 2019માં પેજ સેટઅપ તમને દƺતાવેજની ̋ડઝાઇન અને રજૂઅાતને ક˶માઇઝ કરવા 
માટેની સંપૂણƙ સુ̍વધા અાપે છે. તે દƺતાવેજને ǐાેફેશનલ દેખાવ અાપવા માટે અɔતં ઉપયાેગી છે. 

13.1  મા̏જ̭ન (Margins) 

મા̏જ̭ન અે દƺતાવેજના પાનાંની ધાર અને લખાણ કે સામǁી વȝેની ખાલી જƝયા છે. મા̏જ̭નનાે ઉપયાેગ 
દƺતાવેજને ˗વ̗˺ત અને વાંચવા માટે અનુકૂળ બનાવવા માટે થાય છે. માઇƿાેસાેʘ વડƙમાં મા̏જ̭નને 
પાનાંના દરેક બાજુઅે સેટ કરી શકાય છે: ટાેચ (Top), નીચે (Bottom), ડાબી બાજુ (Left), અને જમણી 
બાજુ (Right). 

13.2 અાે̋રઅɰેેશન (Orientation) 

અાે̋રઅેɰેશન અે પાનાંના લેઅાઉટ માટે મહɗપૂણƙ સુ̍વધા છે. તે દƺતાવેજમાં પાનાનંી ̋દશા સેટ કરવા માટે 
વપરાય છે. વડƙમાં બે મુȕ ǐકારના અાે̋રઅેɰેશન ઉપલʤ છે: 

Portrait (ઉભું): પાનાંની ઊભી ̋દશા (ઊંચાઈ વધુ હાેય છે અને પહાેળાઈ અાેછી હાેય છે). સામાʈ રીતે 
̏નબંધ, ̋રપાટેƙ અને શૈƖ̒ણક દƺતાવેજ માટે ઉપયાેગી. 
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Landscape (અાડંુ): પાનાંની અાડી ̋દશા (પહાેળાઈ વધુ હાેય છે અને ઊંચાઈ અાેછી હાયે છે). ટેબલ, ǁાફ 
અથવા ̍વશાળ ઇમેજ જવેા દƺતાવે̀ે માટે ઉપયાેગી. 

અાે̋રઅɰેેશન અે દƺતાવેજને પાનું અાકારમા ં સંપૂણƙતાપૂવƙક ̋ફટ કરવા માટે મદદͅપ છે. તે લખાણ અને 
અાકૃ̍તઅાે બંનેને સ̀વટ કરવા માટે અɔંત ઉપયાેગી છે. 

13.3 કાૅલʼ (Columns) 

કાૅલʼ અેક મહɗપૂણƙ સુ̍વધા છે, જ ેદƺતાવેજમાં લખાણને અેકથી વધુ કાૅલમમાં ̍વભા̏જત કરવામાં મદદ 
કરે છે. અા સુ̍ વધાનાે ઉપયાગે મુȕɗે ʈૂઝલેટર, મગેે̏ ઝન અા̋ટ̭ક˔ અન ેǒાેશર જવેા દƺતાવે̀ે માટે થાય 
છે, ȱા ંǐાેફેશનલ દેખાવ માટે મ̔˄-કાૅલમ લેઅાઉટ જͅરી હાેય છે. 

કાૅલʼ સેટ કરવા માટેના પગલાં: 

1. Microsoft Wordખાલેીન ેLayout ટેબ પર ̀અાે. 

2. Page Setup ̍વભાગમા ંColumns બટન પર ̚ȃક કરાે. 

 
3. One (અેક), Two (બે), Three (ǋણ), Left (ડાબું ) અથવા Right (જમણંુ) જેવા ̍વકˍાેમાંથી કાઈે 

અેક ̍વકˍ પસંદ કરાે. 

4. ̀ે તમારે ક˶મ લેઅાઉટ સેટ કરવું હાેય, તા ેMore Columns ̍વકˍ પર ̚ȃક કરાે. તમે કાૅલમની 
ચાǲેસ સȕંા, કાૅલમ વȝનંુે અંતર (Spacing), અને લાઇન ̐ બȶીન ઉમેરવી હાેય તાે ̏ નધાƙ̋રત કરી શકા ે
છા.ે 
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5. તમા̈́ં લખાણ પસંદ કરાે અને પસદં કરેલ કાૅલમ ફાેમ̳ટ લાગુ કરાે. 

6. Apply To  ̍વકˍનાે ઉપયાેગ કરી કાલૅમ ફાેમટ̳ સંપૂણƙ દƺતાવેજ અથવા ચાǲેસ પસંદ કરેલ લખાણ 
પર લાગુ કરી શકાય છે. 

7. OK પર ̚ȃક કરતા જ તમારા દƺતાવેજમાં કાૅલʼ લાગુ થઈ જશે. 

કાૅલʼના ઉપયાગેાે: 

1. ʈૂઝલેટર, મેગે̏ઝન લેખાે અને મા̋હતીવાળંુ ǒાશેર તૈયાર કરવા માટે. 

2. લખાણને મ̔˄-કાૅલમ ફાેમ̳ટમાં ̍વભા̏જત કરીને ˾ˠ અને ̏શˠ દેખાવ મેળવવા માટે. 

3. ̍વ̍વધ ǐકારની મા̋હતી અેકસાથે ǐƺતુત કરવા માટે કાલૅʼ ઉપયાેગી છે. 

4. લખાણને ફǸ બાજુઅામેાં સંતુ̏ લત કરવા માટે. 

યાદ રાખાે: 

 ̀ે તમે દરેક કાૅલમ વȝે લાઇન ઉમેરવી હાેય, તાે Line Between ̍વકˍ પસંદ કરાે. 

 કાૅલʼ વȝેનું અતંર યાેƝય હાેવંુ ̀ેઈઅ,ે જથેી વાંચન સરળ બને. 

 ̌ǐ̔ɰ̬ગ કરતા પહેલા ̌ǐɰ ̌ǐ-˗ુ તપાસી ખાતરી કરાે કે કાૅલʼ યાેƝય રીતે ગાેઠવાયલેા છે. 

Microsoft Word 2019મા ં કાૅલʼ દƺતાવેજને વધુ સુશાે̑ભત અને ǐાેફેશનલ બનાવવા માટે અેક 
શ̘Ǹશાળી સાધન છે. તે વાંચકાે માટે દƺતાવેજને વધુ અાકષƙક અને પɡ̍તસર બનાવે છે. 

13.4 પેજ ǒેȋ (Page Breaks) 

પેજ ǒેȋ અે ઉપયાેગી સુ̍ વધા છે, જ ેદƺતાવેજમાં લખાણ અથવા સામǁીને અલગ પાનાં પર મૂકવા માટેના ે
̍વકˍ છે. પેજ ǒેȋનાે ઉપયાેગ દƺતાવેજને સુયાે̏ જત અને ˗વ̗˺ત રાખવા માટે થાય છે, ખાસ કરીને 
લાંબા દƺતાવે̀મેાં ȱાં પાનાંઅાનેી રચનાને ̏નયં̍ǋત કરવી જͅરી હાેય છે. 
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પેજ ǒેȋના ǐકારા:ે 

1. Manual Page Break: તમારા દƺતાવેજમાં નવા પાનાં શͅ કરવા માટે ̀ત ેપેજ ǒેક ઉમેરાે. 

2. Automatic Page Break: ȱારે પાનાં સંપૂણƙ ભરાય ̀ ય છે, ɔારે અાપમેળે નવા પેજ પર લખાણ 
લઈ ̀ય છે. 

પેજ ǒેક ઉમેરવા માટેના પગલાં: 

1. Insert ટેબ પર ̀અાે અને Page Break બટન પર ̚ȃક કરાે. 

 
2. Ctrl + Enter દબાવીને મʈુેઅલ પેજ ǒેક ઝડપથી ઉમરેા.ે 

3. Layout ટેબમા ંBreaks ̍વકˍ પસંદ કરાે. અહ̯થી ̍વ̍વધ ǐકારના ǒેȋ ઉદાહરણ તરીકે Page 
Break, Section Breaks, Continuous Breaks પસંદ કરી શકાય છે. 

 
યાદ રાખાે: 

 ઝડપથી પેજ ǒેક ઉમેરવા માટે Ctrl + Enter વાપરાે. 

 દƺતાવેજમાં ǒેક ̀ેઈ શકાય તે માટે Home ટેબમા ંShow/Hide ¶ ̐સʳાેલ અાેન કરાે. 

 ̀ે તમે પેજ ǒેક દૂર કરવી હાેય, તાે તે પસંદ કરાે અને Delete કી દબાવા.ે 
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Microsoft Word 2019માં પેજ ǒેȋ દƺતાવેજને વધુ ˗વ̗˺ત બનાવવા માટે અɔંત મદદͅપ છે. ત ે
દƺતાવેજના ભાગાેને ǐાેફેશનલ અને ̌ǐ̔ɰ̬ગ માટે અનકૂુળ બનાવે છે. 

14. સામǁી ગાેઠવા ે(Arrange Content) 

Arrange Content મહɗપૂણƙ ફીચર છે, જે દƺતાવેજમાં લખાણ, અાકૃ̍તઅાે, અાકારા,ે અને અʈ 
અાૅʠેǶ્સને ગાેઠવવા માટે ઉપયાેગમાં લેવામાં અાવે છે. અા સુ̍ વધા દƺતાવેજન ે વધુ ˗વ̗˺ત અન ે
ǐાેફેશનલ દેખાવ માટે મદદ કરે છે. અા ̍વકˍાે Layout ટેબમાં અાવેલ Arrange ǁુપમાંથી ǐાʏ થાય છે.     

 
Arrange ǁુપના મુȕ ̍વકˍાે: 

1. Align (ગાેઠવાે): લખાણ અથવા અાʠેૅǶને પાનામંા ંઉપર, નીચ,ે મɪમાં અથવા બાજુઅાે સાથ ે
ગાેઠવવા માટે ઉપયાેગ થાય છે. અાૅʠેǶ પસંદ કરી Layout ટેબ માંથી Align ̍વકˍ પર ̚ȃક 
કરાે. તમને મળેલ ̍વકˍામેાથંી પસંદ કરા,ે જમે કે: Align Left, Align Right, Centre, વગેરે. 

2. Bring Forward/Send Backward (અાગળ લાવાે/પાછળ માેકલાે): અકે બી̀ પર ઉપર 
ગાેઠવાતા (અાેવરલેપ થતા)  અાૅʠેǶ્સ માટે ǐાથ̌મકતા સટે કરવા માટે ઉપયાેગ થાય છે. અાʠેૅǶ 
પસંદ કરી Format ટેબ માંથી Bring Forward અથવા Send Backward ̍વકˍ પસંદ કરાે. 

3. Group (ǁુપ બનાવાે): અેક કરતા વધુ અાૅʠેǶ્સને ǁુપમાં ગાેઠવવા માટે વપરાય છે જથેી તે અેકમ 
તરીકે કાયƙ કરે. અાકૃ̍તઅાે અથવા ટેȌબાȋે પસંદ કરી Format ટેબ માંથી Group ̍વકˍ પર 
̚ȃક કરાે. 

4. Rotate (ઘમુાવા)ે: અાૅʠǶેને અલગ ̋દશામાં ફેરવવા માટે ઉપયાેગ થાય છે. અાૅʠેǶ પસંદ કરી 
Format ટેબ માંથી Rotate ̍ વકˍ પર ̚ ȃક કરાે. 90°, 180°, અથવા ક˶મ અ̲ગલ સેટ કરી શકાય 
છે. 

5. Distribute (̍વત̋રત કરાે): અેક કરતા ંવધુ અાૅʠેǶ્સ વȝે સમાન અંતર બનાવવા માટે ઉપયાગે 
થાય છે. તમામ અાʠૅǶે પસંદ કરી Align ટેબ માંથી Distribute Horizontally અથવા 
Distribute Vertically પસંદ કરાે. 

Arrange Contentના ઉપયાેગાે: 

1. દƺતાવેજને વધુ અાકષƙક અને ˗વ̗˺ત બનાવે છે. 

2. લખાણ, અાકૃ̍તઅાે અન ેટેબ˔ને યાેƝય રીત ેગાેઠવી દƺતાવેજને સુઘડ બનાવે છે. 

3. માેટી ફાઇ˔માં ફાેમ̳̋ટ̬ગ અન ેલેઅાઉટમાં ઝડપથી ફેરફાર કરવા માટે ઉપયાેગી છે. 

યાદ રાખાે: 

 ગાેઠવણના ફેરફારાેની ચકાસણી કરવા માટે Undo/Redo સુ̍વધાનાે ઉપયાેગ કરાે. 

 ̌ǐ̔ɰ̬ગ અથવા ફાઈનલ સબ̌મશન પહેલાં સમǁ દƺતાવેજનું ̌ǐɰ ̌ǐ-˗ુ જુઅાે. 
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Arrange Content ફીચર દƺતાવેજને વધુ ˗વ̗˺ત બનાવવા માટે મહɗપૂણƙ છે. તે લખાણ અને 
અાૅʠેǶ્સને યાƝેય ˺ાન પર ગાેઠવવા અને ǐાેફેશનલ ǐેઝɰેશન માટે અનુકૂળ બનાવે છે. 

14.1 પાે̎ ઝશન (Position) 

પાે̏ઝશન સુ̍વધા ટેȌબાેȋ, અાકૃ̍તઅા,ે છબીઅાે અને અʈ અાʠેૅǶ્સને દƺતાવેજમાં ચાǲેસ જƝયાઅ ે
ગાેઠવવા માટે ઉપયાેગી છે. અા સુ̍વધા દƺતાવેજના લેઅાઉટને વધુ ˗વ̗˺ત અને ǐાેફેશનલ બનાવે છે. 

પાે̏ઝશન નાે ઉપયાેગ કરીન ેઅાૅʠેǶ્સને પાનાં પર ચાǲેસ ˺ાન પર મુકી શકાય છે. તમ ેઅાʠેૅǶન ે
લખાણ સાથે ગાેઠવી અથવા લખાણમાંથી અલગ બનાવી શકાે છાે. 

પાે̎ ઝશન સેટ કરવા માટેના પગલાં: 

1. દƺતાવેજમાં જનેી પાે̏ઝશન સેટ કરવી હાેય તે અાૅʠેǶ પસંદ કરાે, જમે કે છબી, અાકૃ̍ત અથવા 
ટેȌબાેȋ. 

2. અાૅʠેǶ પસંદ કયાƙના પછી Format ટેબ પર ̚ȃક કરા.ે 

3. Arrange ̍વભાગમા ંPosition ̍વકˍ શાેધાે. 

4. નીચે મુજબના પાે̏ ઝશન માટેના ̍વકˍા ેઉપલʤ છે  

 
પાે̎ ઝશનના ઉપયાેગા:ે 

1. દƺતાવેજમાં છબીઅાે અથવા અાકૃ̍તઅાેને ˗ાવસા̍યક રીતે ગાેઠવવા. 

2. ફાેટાે અથવા અાકૃ̍તઅા ેસાથ ેશƖૈ̒ણક દƺતાવેજ બનાવવા માટે. 
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3. ચાેપાનીયા, પેƳʕેટ અથવા ǐઝેɰેશન ̋ડઝાઇનમાં કાયƙƖમતા વધારવા માટે. 

યાદ રાખાે: 

 ̀ે તમે દƺતાવેજને ફરી ગાઠેવી ર̈ા હાે, તાે મૂળ ગાેઠવણની નકલ રાખાે. 

 ̌ǐ̔ɰ̬ગ કરતા પહેલા સમǁ દƺતાવેજનું ̌ǐɰ ̌ǐ-˗ુ લાે જથેી ગાેઠવણ સાચી છે તે ખાતરી થાય. 

 

પાે̏ઝશન ફીચર દƺતાવેજને વધ ુઅાકષƙક અને ˗ાવસા̍યક બનાવવા માટે મહɗપૂણƙ છે. તે અાʠૅǶ્ેસન ે
ચાǲેસ અને સુસȦ ˺ાન પર ગાેઠવવા માટે મદદ કરે છે, જ ેǐƺતુ̍ ત માટે અ̏નવાયƙ છે. 

14.2 ટેȌને રેપ કરવું (Wrap Text) 

Wrap Text અેક મહɗપૂણƙ સુ̍ વધા છે, જ ે દƺતાવેજમાં છબી, અાકાર અથવા અʈ અાʠૅેǶ્સ સાથ ે
લખાણને ગાેઠવવામાં મદદ કરે છે. અા સુ̍વધા દƺતાવેજના લેઅાઉટને વધુ અાકષƙક અને ˗વ̗˺ત બનાવ ે
છે. અા સુ̍ વધા છબી અથવા અાʠૅેǶને લખાણની અાજુબાજુ ગાઠેવવાની સુ̍વધા અાપે છે. તે અાૅʠેǶને 
દƺતાવેજના અલગ-અલગ ˺ાન પર મૂકી, સાથે લખાણને સરળતાથી ગાેઠવવા માટે ઉપયાેગી છે. 

Wrap Textનાે ઉપયાેગ કેવી રીતે કરવાે: 

1. દƺતાવેજમાં છબી અથવા અʈ અાʠેૅǶ પસંદ કરાે.  

2. અાૅʠેǶ પસંદ કયાƙ પછી Format ટેબ પર ̚ȃક કરાે. 

3. Arrange ̍વભાગમા ંWrap Text ̍વકˍ પર ̚ȃક કરાે. 

અને ઉપલʤ ̍વકˍામેાંથી કાેઇ અેક પસંદ કરાે: 

 In Line with Text (લખાણ સાથે): અાʠેેǶ લખાણની 
જમે ગાેઠવાય છે. 

 Square (˳ેર): લખાણ અાʠેૅǶની અાસપાસ ચાેરસ 
અાકારમા ંગાેઠવાય છે. 

 Tight (ટાઈટ): લખાણ અાʠેેǶની ન͂ક ગાેઠવાય છે. 

 Through (ǌુ): લખાણ અાૅʠેǶની ખાલી જƝયાઅામેાથંી 
પસાર થાય છે. 

 Top and Bottom (ઉપર અને નીચે): લખાણ 
અાૅʠેǶની ઉપર અને નીચે ગાેઠવાય છે. 

 Behind Text (લખાણ પાછળ): અાૅʠેǶ લખાણની 
પાછળ રહે છે. 

 In Front of Text (લખાણ અાગળ): અાૅʠǶે 
લખાણની ઉપર રહે છે. 

Wrap Textના ઉપયાેગા:ે 
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1. ̌પǴર અને લખાણને ગાઠેવીને ̋ડઝાઇ̏ન̬ગ અન ેરજૂઅાતમા ંǗેˤતા મેળવવી. 

2. બુક લેઅાઉટ, ʈૂઝલેટર અથવા પેƳưલેટ બનાવવા માટે ઉપયાેગી. 

3. ̍વ̍વધ દેખાતા ઘટકાનેે ˗વ̗˺ત કરવા માટે. 

યાદ રાખાે: 

 અાેʠેǶ માટે Position સાથ ેWrap Text ના ેઉપયાેગ કરાે. 

 More Layout Options ̍વકˍ ɦારા અાʠેૅǶ અને લખાણ વȝેનું અતંર બદલી શકાય છે. 

 Wrap Textથી લખાણ વાંચવા માટે મુƸકેલ ન બને. 

Wrap Text સુ̍ વધા Microsoft Word 2019 માં ǐƺતુ̍ ત અને ̋ડઝાઇનમાં ˗વસા̍યકતા ઉમેરે છે. તે છબી 
અને લખાણને સરળતાથી ગાેઠવીને દƺતાવેજને વધુ અાકષƙક બનાવે છે. 

14.3 અેલાઇન (Align) 

Align અેક મહɗપૂણƙ સુ̍ વધા છે, જ ે દƺતાવેજમાં લખાણ, અાકૃ̍તઅાે, 
છબીઅાે અને અʈ સામǁીને પાનાંમાં ચાેǲસ રીત ેગાઠેવવામાં મદદ કરે છે. 
તે દƺતાવેજના લેઅાઉટને વધ ુ˗વ̗˺ત અને ˗ાવસા̍યક બનાવે છે. 

Alignના ǐકારાે:  

1. Left Align: લખાણ અથવા અાૅʠǶેને ડાબી બાજુથી ગાેઠવે છે. 
તે ̍વશાળ દƺતાવે̀મેાં વપરાશમાં અાવે છે ȱાં લખાણ ડાબી 
બાજુથી શͅ થવંુ જͅરી હાેય છે. 

2. Centre Align: લખાણ અથવા અાʠૅેǶને પાનાનંા મɪમાં 
ગાેઠવે છે. શીષƙકાે અથવા મȕુ અાકષƙણાે માટે ઉપયાેગી. 

3. Right Align: લખાણ અથવા અાʠૅǶેને પાનાંની જમણી બાજુ 
સાથે ગાેઠવે છે. સંȕાઅાે અથવા ખાસ ફાેમ̳ટ માટે ઉપયાગેી. 

4. Justify: લખાણ પાનાંની ડાબી અને જમણી બાજુ બંને સાથે 
ગાેઠવાય છે. ˗ાપક દƺતાવે̀ે, જમે કે અખબારના લખે માટે 
ઉપયાેગી. 

Align સેટ કરવા માટેના પગલાં: 

1. દƺતાવેજમાં તે ભાગ પસંદ કરાે જનેે ગાેઠવવંુ છે. 

2. Home ટેબ માંથી Paragraph ǁુપ શાેધાે. 

3. Left Align, Centre Align, Right Align અથવા Justify બટન પર ̚ȃક કરાે. 

અાʠેેǶ માટે Align: Format ટેબમાં ̀અાે અને Align ̍વકˍ પસંદ કરાે. અા અાʠેૅǶ્સને પાનાંના 
ટાેચ, ત̐ળય,ે મɪમાં અથવા બાજુઅાે સાથે ગાેઠવે છે. 

Alignના ઉપયાેગાે: 
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1. ˗વ̘˺ત દƺતાવેજ: પાનાંમાં લખાણ અને છબીઅાે સુસȦ રીતે ગાેઠવવામાં મદદ કરે છે. 

2. અકષƙક ǐƺતુ̍ ત: દƺતાવેજને ǐાેફેશનલ અને સંુદર દેખાવ માટે ઉપયાેગી. 

3. ટેબ˔ અને અાકૃ̍તઅાે માટે: ટેબ˔, અાકૃ̍તઅાે અને ટેȌબાેȋને સેટ કરવા માટે મદદͅપ. 

યાદ રાખાે: 

 સામǁીના ǐકાર પર અાધાર રાખીને Left, Centre, Right અથવા Justify પસંદ કરાે. 

 View ટેબમાં Gridlines સ̋ƿય કરીને પાનામંાં યાેƝય ગાેઠવણ સુ̏ ન̏˛ત કરાે. 

 Shortcut Keysનાે ઉપયાગે કરાે: 

o Left Align: Ctrl + L 

o Centre Align: Ctrl + E 

o Right Align: Ctrl + R 

o Justify: Ctrl + J 

Align સુ̍ વધા Microsoft Word 2019માં દƺતાવેજને વધુ ˗વ̗˺ત બનાવવા માટે અɔંત ઉપયાેગી છે. તે 
લખાણ અને અાૅʠેǶ્સને ચાેǲસ રીતે ગાેઠવવામાં મદદ કરે છે, જ ેદƺતાવેજને સુઘડ અને ǐાેફેશનલ દેખાવ 
અાપે છે. 

14.4 રાેટેટ (Rotate) 

Rotate અેક ઉપયાેગી સુ̍વધા છે, જ ેદƺતાવેજમાં છબી, અાકૃ̍ત, ટેȌબાેȋ અથવા અʈ અાʠેૅǶન ે
ફેરવવા અથવા અડધા ગાેળમાં ગાેઠવવા માટે મદદ કરે છે. અા સુ̍વધા ̋ડઝાઇ̏ન̬ગ માટે ઉપયાેગી છે અને 
દƺતાવેજને વધુ અાકષƙક બનાવે છે. તે અાૅʠǶેને 360 ̋ડǁી સુધી કાેઇ પણ ̋દશામાં ફેરવવાની સુ̍વધા અાપ ે
છે. તમે અાૅʠǶેને ધીમે ધીમે ફેરવી શકાે છાે અથવા ̌ǐસેટ પસંદગીઅાેનાે ઉપયાેગ કરી શકાે છાે. 

Rotate માટેના ̍વકˍાે: 

1. Rotate Right 90°: અાૅʠેǶને જમણી બાજુ 90 ̋ડǁી ફેરવ ેછે. 

2. Rotate Left 90°: અાૅʠǶેને ડાબી બાજુ 90 ̋ડǁી ફેરવે છે. 

3. Flip Vertical: અાૅʠǶેન ેઊભી ̋દશામાં પલટે છે. 

4. Flip Horizontal: અાૅʠǶેને અાડી ̋દશામાં પલટે છે. 

5. More Rotation Options  360 ̋ડǁી સુધી ચાેǲસ ઘુમાવ માટે ક˶મ માપ સેટ કરી શકાે છાે. 

Rotate ફીચરનાે ઉપયાેગ કેવી રીતે કરવાે: 

1. દƺતાવેજમાં તે છબી, અાકૃ̍ત અથવા ટેȌબાȋે પસંદ કરા,ે જનેે ફેરવવું છે. 

2. અાૅʠેǶ પસંદ કયાƙ પછી Format ટેબમાં ̀અાે. 

3. Arrange ̍વભાગમાં Rotate ̍વકˍ શાેધાે અને ̚ȃક કરાે. 

4. તમને જͅરી Rotate અથવા Flip ̍વકˍ પસંદ કરાે. 
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Manual Rotation (હાથથી ફેરવવંુ): 

 અાૅʠેǶ પરના નીચે દશાƙ̠ ા મજુબના ઘ̋ડયાળ જેવા અાઇકાેન પર ̚ȃક કરીને માઉસ સાથ ે
અાેʠેǶને મʈુેઅલી ફેરવી શકાે છાે. 

 
યાદ રાખાે: 

 રાટેેટ કરતા પહેલા અાʠૅેǶની પાે̏ ઝશન અને લેઅાઉટની ગાઠેવણ સાચવ̀ે. 

 રાટેેટ માટે મʈેુઅલ રીતે કામ કરવંુ સરળ છે, પરંતુ Format ટેબની મદદ વધુ ચાǲેસતા માટે કરા.ે 

 ̌ǐɰ કરવા પહેલાં દƺતાવેજમાં અાʠેેǶની ગાેઠવણ તપાસા.ે 

Rotate ફીચર Microsoft Word 2019માં દƺતાવેજને ̋ડઝાઇન કરવા અને વધુ અાકષƙક બનાવવામાં મદદ 
કરે છે. તે તમને અાʠેૅǶન ેમǸુ રીતે ફેરવવા અને દƺતાવેજને ǐાેફેશનલ લુક અાપવા માટે સપૂંણƙ કંǇાેલ 
અાપે છે. 

15. મઈેલ મજƙ (Mail Merge) 

મઈેલ મજƙ અે અેક શ̘Ǹશાળી ટૂલ છે, જ ે અેકસાથે અનેક પǋા,ે ઇમેઇ˔, લેબ˔, અેƮવલƯસ, અથવા 
̋ડરેǶરી બનાવવા માટે ઉપયાેગી થાય છે. તે મુȕ દƺતાવજેને ડેટા ફાઇલ સાથે ̀ેડે છે અને દરેક ǐાʏ કરનાર 
માટે ક˶માઇƣડ દƺતાવે̀ે બનાવવા માટે મદદ કરે છે. Mailing ટેબમાં અાવેલ Start Mail Merge ̍ વકˍ 
પસંદ કરાે તમને નીચ ેમુજબના ̍વકˍાે ǐાʏ થાય છે.   
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1. Letters: ̍ વશાળ સંȕામાં ̠ ̘Ǹગત પǋાે (જમેાં નામ, સરનામુ,ં વગેરે) માેકલવા માટે મેલ મજƙનાે ઉપયાેગ 
થાય છે. 

2. E-Mail Messages: અેકસાથે અનેક લાેકાનેે ˗̘Ǹગત ઇમઇેલ માેકલવા માટે મલે મજƙનાે ઉપયાેગ 
થાય છે. 

3. Envelope: પાસƙલ અથવા પǋ પર ǐાʏ કરનારનું સરનામું ̌ǐɰ કરવા માટે મલે મજƙ ઉપયાગેી છે. 

4. Labels: સરનામાં અથવા અʈ મા̋હતી ̌ǐɰ કરેલી લબે˔ને માેટી સંȕામા ંબનાવવામાં મદદ કરે છે. 

5. Directory: ક˶માઇઝ કરેલી મા̋હતી સાથે ̋ડરેǶરી અથવા સંપકƙ  યાદી તયૈાર કરવા માટે. 

6. Step by Step Mail Merge Wizard: મેલ મજƙ ǐ̋ƿયાને સરળ બનાવવા માટે વી̀ડƙ સહાય કરે છે. 

મેલ મજƙ કેવી રીતે કરવંુ: 

15.1  Letters (પǋ): 

 Start Mail Merge > Letters ̍વકˍ પસંદ કરાે. 

 મȕુ દƺતાવેજ લખાે, અને ડેટા ફાઇલ (મુǍકાંકાે અને મા̋હતી સાથે) ̏લ̬ક કરાે. 

 Insert Merge Fieldનાે ઉપયાેગ કરીન ેફીˆ ઉમેરા,ે જમે કે «Name» અથવા «Address». 

 Finish & Merge પર ̚ȃક કરીન ેપǋાનેે ̌ǐɰ અથવા સેવ કરી શકાય છે. 

15.2 E-Mail Messages (ઈમઇેલ): 

 Start Mail Merge > E-Mail Messages પસંદ કરાે. 

 ઈમેઇલ માટેનાે મȕુ દƺતાવેજ લખાે અને ડેટા ફાઇલ ̏લ̬ક કરાે. 

 ફીˆ ઉમેરાે અને Finish & Merge પર ̚ȃક કરીન ેઈમેઇલ માેકલવા માટે ǐાʏ કરનારની મા̋હતી 
સેટ કરાે. 
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15.3 Envelope (અƮેવલપ): 

 Start Mail Merge > Envelopes પસંદ કરાે. 

 અƮેવલપમાં સરનામું ઉમેરાે અને તેને ડેટા ફાઇલ સાથે ̏લ̬ક કરાે. 

 Insert Merge Field નાે ઉપયાેગ કરીને ǐાʏ કરનારનુ ંસરનામંુ ઉમેરાે. 

15.4 Labels (લેબલ): 

 Start Mail Merge > Labels ̍વકˍ પસંદ કરાે. 

 લેબલનું માપ અને ફાેમ̳ટ પસંદ કરાે. 

 ડેટા ફાઇલ સાથે ̏લ̬ક કરાે અને Insert Merge Field નાે ઉપયાેગ કરીને ǐાʏ કરનારની મા̋હતી 
ઉમેરાે. 

15.5 Directory (̋ડરેǶરી): 

 Start Mail Merge > Directory પસંદ કરાે. 

 ǐɔેક ǐાʏ કરનારની માટે જͅરી મા̋હતી સાથે ̋ડરેǶરીનું ફાેમ̳ટ તૈયાર કરાે. 

 ડેટા ફાઇલથી ડેટા ̏લ̬ક કરીન ેદરેક ǐાʏ કરનાર માટે યાેƝય મા̋હતી ઉમેરાે. 

15.6 Step by Step Mail Merge Wizard (મેલ મજƙ ̍વઝાડƙ): 

 Start Mail Merge > Step by Step Mail Merge Wizard પસંદ કરાે. 

 અા વી̀ડƙ 6 ˶ેપમાં માગƙદ̏શ̭કા અાપે છે: 

1. દƺતાવેજ ǐકાર પસંદ કરાે (Letters, Emails, Labels, વગરેે). 

2. દƺતાવેજ પસંદ કરાે (Current Document, Template). 

3. ડેટા ફાઇલ પસદં કરાે. 

4. ફીˆ્સ ઉમેરીને મુȕ દƺતાવેજને ક˶માઇઝ કરાે. 

5. પ̋રણામનું ̌ǐ˗ૂ જુઅાે. 

6. મજƙ પૂણƙ કરાે અને દƺતાવેજ સાચવાે અથવા ̌ǐɰ કરા.ે 

મેલ મજƙના લાભાે: 

 માેટાપાયે પǋાે, લેબ˔, અથવા ઇમેઇ˔ બનાવવા માટે ઉપયાેગી. 

 દરેક ǐાʏ કરનાર માટે મા̋હતી વૈ̍ વɪપણૂƙ બનાવી શકાય છે. 

 ˗̘Ǹગત અને ˗વસા̍યક બંને ǐકારના કાયƙ માટે સગવડǐદ. 

યાદ રાખાે: 

 ડેટા ફાઇલમાં કાેઈ ભૂલાે ન થાય તે માટે તેની ̀ણકારી તપાસાે. 
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 ફીˆ્સ અેકદમ યાેƝય જƝયાઅે મુકવાની ખાતરી કરા.ે 

 મેલ મજƙ પૂણƙ થાય તે પહેલાં ǐાʏ કરનાર માટેના દƺતાવે̀ ેને તપાસાે. 

Microsoft Word 2019મા ંમેલ મજƙ દƺતાવે̀ે માટે ક˶માઇઝેશન અને સમય બચાવના Ǘેˤ સાધન છે. 
તે દƺતાવે̀ેને વધુ ˗ાવસા̍યક અને અસરકારક બનાવે છે. 

16. ˾ ે̏લ̬ગ અને ˗ાકરણ (Spelling and Grammar) 

˾ે̏લ̬ગ અને ǁામર ચેકર અ ેદƺતાવેજ લખતી વખતે ટાઈ̌પ̬ગ ભૂલાે અને ˗ાકરણની ભૂલાે સુધારવા માટે  
મજબૂત સાધન છે. અા સુ̍વધા લેખનને વધુ ˗ાવસા̍યક અને સરળ બનાવવા માટે મદદ કરે છે.  ˾ે̏લ̬ગ 
અને ˗ાકરણ ચેકર દƺતાવજેમાં શʣાેની ટાઈ̌પ̬ગ ભૂલાે, ˗ાકરણની ભૂલાે, અને ગાેઠવણની ભૂલાે શાેધે છે. 
તે યાેƝય સુધારા સૂચવે છે અને તમારા લખાણની ગુણવɇા સુધારે છે. 

˾ે̏લ̬ગ અને ˗ાકરણ ચેક કેવી રીતે કરવી? 

1. મʈેુઅલ ચે̋ ક̬ગ: Review ટેબ માંથી Spelling & Grammar ̍વકˍ પસંદ કરાે. વડƙ અાપમેળે 
દƺતાવેજમાં ભૂલાે શાેધે છે અને યાેƝય સુધારા સૂચવે છે. ǐƺતા̍વત ̍ વકˍાેને પસંદ કરાે અથવા ભૂલાેને 
અવગણાે. 

2. અાેટાેમેટીક ચે̋ક̬ગ: વડƙ ̄ચા̏લત રીતે ˾ે̏લ̬ગ ભૂલાેને લાલ રેખા ɦારા અને ˗ાકરણ ભૂલાેને ભૂરી 
રેખા ɦારા હાઇલાઇટ કરે છે. તમે હાઇલાઇટ કરેલ શʣ પર જમણા બટનથી ̚ȃક કરીને સુધારાે કરી 
શકાે છાે. 

3. Dictionaryમાં શʣ ઉમેરવાે: ̀ ે કાેઇ શʣ ભૂલ તરીકે દશાƙય છે પરંતુ તે યાેƝય છે, તા ેતમે તેને Add 
to Dictionary ̍વકˍ ɦારા શʣકાેશમાં ઉમેરી શકાે છા.ે 

અʈ સુ̍વધાઅાે: 

 AutoCorrect: સામાʈ ટાઈ̌પ̬ગ ભૂલાે માટે Microsoft Word શʣાેને અાપમેળ ેઠીક કરે છે. અા 
સુ̍ વધાને File > Options > Proofing > AutoCorrect Options માંથી ક˶માઇઝ કરી શકાય 
છે. 

 Grammar Settings: તમે ˗ાકરણ ચે̋ ક̬ગ માટેના ̏નયમાેને ક˶માઇઝ કરી શકાે છાે. File > 
Options > Proofing > Writing Style > Settings માંથી ફેરફાર કરી શકાય છે. 

યાદ રાખાે: 

1. દƺતાવેજ માેકલતા પહેલા હંમેશા Spelling & Grammar Check ચલાવાે. 

2. ̀ે તમા̈́ં લખાણ ̍વ̍વધ ભાષાઅાેમાં છે, તાે Language ̍વકˍથી યાેƝય ભાષા સેટ કરાે. 

3. તમારા લેખન માટે યાેƝય અને ˗ાવસા̍યક શʣાે ઉમેરવા માટે Custom Dictionary નાે ઉપયાેગ 
કરાે. 

લાભાે: 

 ˾ે̏લ̬ગ અને ˗ાકરણની ભૂલાે દૂર કરવાથી દƺતાવેજ વધુ ǐભાવશાળી લાગે છે. 

 અાપમેળે ચે̋ક̬ગ કરવાથી સમય અને મહેનત બચે છે. 
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 વાȂ સુધારવાથી લેખન વધુ ˾ˠ અને સǁંુ̎થત બને છે. 

Microsoft Word 2019ની ˾ે̏લ̬ગ અને ˗ાકરણ સુ̍ વધા તમારા લખાણને વધુ ગુણવɇાયુǸ અને 
˗ાવસા̍યક બનાવવા માટે ખૂબ જ મહɗપણૂƙ છે. અા ટૂલનાે યાેƝય ઉપયાેગ કરી તમે તમારા દƺતાવે̀ ેને 
̏નખારી શકાે છાે. 

17. ̎ થસાેરસ (Thesaurus) 

̎થસાેરસ Microsoft Word 2019માં અાપેલંુ અેક ઉપયાેગી સાધન છે, જ ે શʣાેના પયાƙયવાચી અથવા 
સમાનથ̰ શʣાે (Synonyms) અને ̍વરાેધાથ̰ શʣાે (Antonyms) શાેધવામાં મદદ કરે છે. અા સુ̍વધાના ે
ઉપયાેગ કરીને તમે દƺતાવેજમાં વધુ સારી અને ˗ાવસા̍યક ભાષાનાે ઉપયાેગ કરી શકાે છાે. 

̎થસાેરસ શું છે? 

̎થસાેરસ અે અેક સાધન છે જે શʣ માટેના પયાƙયવાચી અને ̍વરાેધી શʣાે ǐદાન કરે છે. તે તમારા લખાણને 
વધુ સશǸ અને સુǁં̎થત બનાવવા માટે ઉપયાેગી છે. 

̎થસાેરસનાે ઉપયાેગ કેવી રીતે કરવાે? 

જ ેશʣ માટે પયાƙયવાચી અથવા ̍વપ̋રત શʣાે શાેધવા માંગાે છાે તે પસંદ કરાે. Review ટેબ પર ̀અાે અને 
Thesaurus ̍વકˍ પસદં કરાે. અથવા, પસંદ કરેલા શʣ પર જમણા બટનથી ̚ȃક કરીને Synonyms 
પસંદ કરાે. ̎થસાેરસ પેનમાં ǐદ̏શ̭ત થતી સૂ̎ચમાંથી યાેƝય શʣ પસંદ કરાે. તમા̈́ં પસંદ કરેલું શʣ Insert 
બટન ɦારા દƺતાવેજમાં ઉમેરા.ે  પસંદ કરેલા શʣને સીધા જ અા˄રને̋ ટવ શʣ સાથે બદલી શકાય છે. 

યાદ રાખાે: 

1. પયાƙયવાચી પસંદ કરતી વખતે ɪાન રાખાે કે તે શʣ દƺતાવેજના ǐસંગ સાથે અનુͅપ છે. 

2. ̍વપ̋રત અથƙ ધરાવતા શʣાનેાે ઉપયાેગ કરીને લખાણમાં વૈ̍વɪ ઉમેરાે. 

3. કાેઈ શʣ પર ̚ȃક કરીન ેShift + F7 દબાવી તમે ઝડપથી ̎થસાેરસ ખાેલી શકાે છાે. 

લાભાે: 

 ̎થસાેરસ વાપરીને તમે નાનાં અથવા પુનરાવૃɇ શʣાેને ટાળી શકાે છાે. 

 દƺતાવેજમાં વધુ ǐભાવશાળી ભાષાનાે ઉપયાેગ કરી શકાે છાે. 

 યાેƝય શʣ પસંદ કરીને લખાણ વધુ અથƙસભર અને ̍વ˝સનીય બને છે. 

Microsoft Word 2019મા ં̎ થસાેરસનાે ઉપયાેગ કરીને તમે તમારા દƺતાવેજને વધુ રસǐદ અને ̠ ાવસા̍યક 
બનાવી શકાે છાે. અા ટૂલ લેખન Ɩમતાને સુધારવામાં અને દƺતાવેજને ̏નખારવામાં સહાયક છે. 

18. Ǉેક ચƮેજ (Track Changes) 

Track Changes સુ̍ વધા અે અેક શ̘Ǹશાળી ટૂલ છે, જ ેદƺતાવેજમાં કરાયેલા ફેરફારાેને Ǉેક કરવા અને 
તેનાે રેકાેડƙ રાખવા માટે ઉપયાેગ થાય છે. અા સુ̍વધાનાે ઉપયાેગ ખાસ કરીને સંકલનાɒક કાયƙમાં થાય છે, 
ȱાં અલગ-અલગ ˗̘Ǹઅાે દƺતાવેજ પર કામ કરે છે અને ફેરફારાેની સમીƖા કરવાની જͅર હાેય છે. 
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Track Changes સ̋ƿય કરવી: Track Changes સ̋ƿય કરવા માટેની પɡ̍ત નીચે મુજબ છે: 

1. મેનુબારમા ંReview ટેબ પર ̚ȃક કરાે. 

2. Tracking ǁૂપમા ંTrack Changes અાઇકાેન પર ̚ȃક કરાે. Track Changes સ̋ƿય થઈ જશે, 
અને તમે કરેલા દરેક ફેરફાર હાઇલાઇટ થશે. 

3. Ctrl + Shift + E દબાવા,ે જ ેTrack Changesને ઝડપથી સ̋ƿય અથવા ̏ન̒˟ય કરે છે. 

Track Changes ઉપયાગેમાં લેવાયેલા ફેરફાર: 

1. Text Insertions: તમે લખાણ ઉમેરશાે ɔારે તે નીચે લાલ અંડરલાઇન સાથે દશાƙવશે. 

2. Deletions: જ ેલખાણ કાઢવામાં અા˗ું  હશે તે લખાણ પર અાડી લાલ લાઇન દેખાશે. 

3. Formatting Changes: ફામે̳̋ટ̬ગમાં ફેરફાર (જમે કે બાે̂ , ઇટા̏લક, અથવા ફાɰૅ કલર) Ǉેક 
કરવામાં અાવે છે અને ડાȂેુમɰેની સાઇડબારમાં ના̲ધાવવામાં અાવે છે. 

4. Comments ઉમેરવી: દƺતાવેજના ચાેǲસ ભાગ પર ̋ટʑણીઅાે ઉમેરવા માટે Review > New 
Comment ̍વકˍ પસંદ કરાે. 

Track Changes ની સમીƖા કરવી: 

1. Reviewing Pane:  દƺતાવેજમાં થયેલા તમામ Track Changes અને Commentsને યાદી (List) 
̄ͅપે બતાવે છે. અા ફીચર ખાસ કરીને ɔારે ઉપયાેગી છે ȱારે: તમારે બધા બદલાવ અેક સાથ ે
̀ેવા હાેય અથવા તમ ેલાંબા દƺતાવેજ પર કામ કરી ર̈ા હાે તથા તમારે ફેરફારાેની સરળતાથી તપાસ 
કરવી હાેય. 

2.  Review ટેબમા ંChanges ǁૂપ માંથી Accept અથવા Reject ̍વકˍ પસંદ કરાે. દરેક ફેરફારની 
સમીƖા કરીન ેતેને મંજુર અથવા રદ કરાે. 

3. Shortcut Key: 

o Alt + Shift + A દબાવા,ે બધા ફેરફારાે ̄ીકારવા માટે. 

o Alt + Shift + R દબાવાે, બધા ફેરફારાે રદ કરવા માટે. 

Track Changesનાે ઉપયાગે કરવાના લાભાે: 

1. દƺતાવેજમાં કરેલા દરેક ફેરફારને ̀ણી શકાય છે. 

2. અેક કરતા વધુ વપરાશકતાƙઅાે માટે સહકાર અને ફેરફારાેની સરળ સમીƖા માટે અાદશƙ. 

3. ફેરફારાેનાે રેકાેડƙ ̀ળવી શકાય છે, જથેી મૂળ દƺતાવેજ સાથે તુલના કરવી સરળ બને છે. 
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યાદ રાખાે: 

 દƺતાવેજ માેકલતા પહેલા Track Changesને બંધ કરી અને બધા ફેરફારાે ̄ીકારીને Final ͅપે 
સેવ કરાે. 

Track Changes સુ̍ વધા સાૈથી મહɗપૂણƙ અને ઉપયાેગી ટૂ˔માંની અેક છે. અા સુ̍વધા સાથે, તમે 
દƺતાવેજને વધુ ˗વસા̍યક રીતે મેનેજ કરી શકાે છાે, અને સહયાેગી કાયƙ વધુ સુગમ બનાવી શકાે છાે. 

18.1 લાૅક ચƮેજ (Lock Changes) 

Lock Changes સુ̍ વધા અકે મહɗપણૂƙ ટૂલ છે, જ ેતમારા દƺતાવેજમાં Track Changes સ̋ƿય હાેવાથી ત ે
હંમેશા સુર̐Ɩત રહે તે માટે ઉપયાેગમાં લેવાય છે. અા સુ̍વધા ખાસ કરીને ɔારે ઉપયાેગી છે ȱારે તમે દƺતાવેજ 
પર અʈ લાેકાે સાથે સહયાગે કરવાનું હાેય અને તમારાં ફેરફારાેમાં કાેઈ અન̍ધકૃત ફેરફાર ન કરે. 

Lock Changes સ̋ƿય કરવી: 

1. Review ટેબ પર જઈને Track Changes બટન ̚ȃક કરાે અથવા Ctrl + Shift + E દબાવી 
Track Changes સ̋ƿય કરા.ે 

2. Review ટેબ પર Tracking ǁૂપ માંથી Track Changes ǉાેપડાઉન પર ̚ȃક કરાે. "Lock 
Tracking" ̍વકˍ પસંદ કરા.ે 

3. લાૅક Ǉે̋ક̬ગ સ̋ƿય કરતી વખતે, Microsoft Word તમારાં ફેરફારાેને સુર̐Ɩત કરવા માટે પાસવડƙ 
પૂછશે. મજબૂત પાસવડƙ સેટ કરાે અને તેને ફરીથી ચકાસવા માટે ટાઇપ કરા.ે 

4. Track Changes હવે લાૅક થશે, અને અʈ વપરાશકતાƙઅાે તેને બંધ કરી શકશે નહ̯ અથવા તમારી 
પરવાનગી ̍વના ફેરફારાે કરી શકશે નહ̯. 

Lock Changes ફીચરનાે ઉપયાેગ: 

1. કાેઈ ˗̘Ǹ દƺતાવેજના Ǉેક કરાયેલા ફેરફારાેને બંધ કરવા અથવા દૂર કરવાનાે ǐયાસ કરે છે, તા ે
પાસવડƙ જͅરી બનશે. 

2. બધા ફેરફારાે દƺતાવેજમાં નાધ̲ાયેલા રહેશે અને અેમના ફેરફાર ̀ેઈ શકાશે. 

3. ટીમ સાથે સહયાેગ કરતી વખતે દરેકનું કામ રેકાેડƙમાં રહે છે અન ેતેને મંજુર કે રદ કરવા માટે ̄તǋંતા 
રહે છે. 

Lock Tracking બંધ કરવી: 

1. Review ટેબ પર ̀અાે અન ેTrack Changes પર ̚ȃક કરાે. Unlock Tracking ̍વકˍ પસંદ 
કરાે. 

2. Microsoft Word પાસવડƙ પૂછશે. સાચાે પાસવડƙ દાખલ કયાƙ પછી Track Changes અનલાૅક 
થશે. 

લાભાે: 

1. કાેઈ અ̀Ʃયા અથવા અનમુ̍ત વગરના ફેરફારાે ટાળી શકાય છે. 
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2. ફેરફારાે સાથે દƺતાવેજની સચાેટતા ̀ળવી રાખે છે. 

3. ડાેȂુમɰે પર સામૂ̋હક કાયƙમાં વધુ ˾ˠતા લાવ ેછે. 

યાદ રાખાે: 

 પાસવડƙ સેટ કરતી વખતે મજબૂત અને યાદ રાખી શકાય તેવાે પાસવડƙ પસંદ કરાે. 

 લાૅ̋ક̬ગના અગાઉના ˶ેજ પર દરેક મહɗપૂણƙ ફેરફારાે ડબલ ચેક કરાે. 

 ̀ે પાસવડƙ ગુમાવશાે, તાે તમારાં ફેરફારાે લાૅક રહેલા ડાેȂમુɰેને પુનઃǐાʏ કરવું મુƸકેલ બને શકે છે. 

Lock Changes અેક શ̘Ǹશાળી સુરƖા સુ̍ વધા છે, જ ે દƺતાવેજની અખં̋ડતતા ̀ળવી રાખે છે. અા 
સુ̍ વધાનાે ઉપયાેગ સાથ,ે તમ ેદƺતાવેજને વધુ સુર̐Ɩત અને ˗વસા̍યક બનાવી શકાે છાે. 

 

 

19. Macros 

Microsoft Word 2019 મા ં મƿૅાેઝ (Macros) અે અેક અɥતન સુ̍વધા છે, જ ે વારંવાર થતા કાયા̳ન ે
̄ચા̏લત (Automate) કરવા માટે ઉપયાેગી થાય છે. મૅƿાેઝ તમારાે સમય બચાવે છે અને તમારી કાયƙƖમતા 
વધારવા માટે ઉપયાેગી થાય છે, ખાસ કરીને ȱારે તમારા દƺતાવેજમાં સમાન ǐકારના ટા˱ વારંવાર કરવાની 
જͅર હાેય. 

મૅƿાે અે Microsoft Word ɦારા રેકાેડƙ કરેલંુ કમાંડ્સનું અેક સેટ છે, જે તમને અેક બટન દબાવવાથી અથવા 
કીબાેડƙ શાટૅƙકટના માɪમથી ઘણા કમાંડ્સને અાેટાેમટેેડ રીતે ચલાવવાની મંજૂરી અાપે છે. 

મƿૅાેઝ બનાવવા માટેની પɡ̍ત: 

1. ̀ે Developer ટેબ ͆Ƹયમાં નથી, તાે તેને સ̋ƿય કરવા માટે: File > Options પર ̀અાે. 
Customize Ribbon પસંદ કરાે. Developer ચેકબાેȋ ̐સલેǶ કરાે અને OK દબાવાે. 
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2. Developer ટેબ પર ̚ȃક કરાે. Record Macro બટન પસંદ કરાે. નીચે મુજબનાે ડાયલાેગ બાેƖ 

અાેપન થશે 

 
o મƿૅાે માટે નામ અાપા ેઅને તે કઈ રીતે શ̈́ થશે તે માટે શાટૅƙકટ કી અથવા કમાɱ પસંદ કરાે. 

o OK પર ̚ȃક કયાƙ પછી Word તમારા તમામ ̋ƿયાને રેકાેડƙ કરશે. 
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3. Word અે તમારી પસંદગીઅા,ે લખાણ, ફાેમ̳̋ટ̬ગ અથવા અʈ કાયા̳ને રેકાેડƙ કરશે.   

4. ȱારે રેકાે̋ ડ̮ગ પૂણƙ થાય, Stop Recording બટન ̚ȃક કરાે. 

મƿૅાેઝ ચલાવવી: 

1. Ribbon ɦારા: Developer ટેબ > Macros પર ̚ȃક કરાે. તમારા મƿૅાેનું નામ પસદં કરાે અન ે
Run બટન પર ̚ȃક કરાે. 

 
2.  તમે મૅƿાે બનાવવા સમયે સટે કરેલા શાૅટƙકટ કીનાે ઉપયાગે કરી શકાે છાે. 

3. Quick Access Toolbar: મƿૅાે બટનન ેQuick Access Toolbar મા ંઉમરેાે અને ઝડપી અૅȋેસ 
મેળવાે. 

મƿૅાેઝના ઉપયાગેના ઉદાહરણ: 

1. વારંવાર લખાતી લાઇન અથવા લખાણ દાખલ કરવું. 

2. દƺતાવેજમાં ફામે̳̋ટ̬ગ ˶ાઇલ બદલવી. 

3. ટેબલ અથવા પેજ લેઅાઉટ માટે ̋રફાેમટ̳ કરવું. 

4. ખાસ અાૅ̋ફસ ǐ̋ƿયાઅા,ે જમે કે મા̋હતી મજƙ કરવી અથવા ǁા̋ફȋ ઉમેરવી. 

મƿૅાેઝને મેનેજ કરવંુ: 

 ̀ે મૅƿાેમાં ફેરફાર કરવાની જͅર હાેય, તાે Developer ટેબના Macros ̍વકˍમાંથી તનેે Edit કરાે. 

 મƿૅાે ̋ડલીટ કરવા માટે Macros > Organizer ના ેઉપયાગે કરાે. 

 મƿૅાેઝની સુરƖા સુ̏ ન̏˛ત કરવા માટે File > Options > Trust Centre > Trust Centre 
Settings પર જઈ મૅƿાે સે̋ ટ̬Ɲસ ગાેઠવાે. 

મƿૅાેઝના લાભાે: 

1. વારંવાર થતી ǐ̋ƿયાઅાે માટે સમય બચાવે છે. 

2. મƿૅાેઝ કાયƙનાે સમાન સેટ ચલાવે છે, જ ેમાનવભૂલાે ઘટાડે છે. 
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3. ̍વȱુલ યુઝર ઇɰરફેસ ɦારા ઉપયાેગમાં સરળતા. 

સાવચેતીઅાે: 

 મૅƿાેઝ માટે મજબૂત સુરƖા સેટ કરવી, કારણ કે તેઅાે માલવેરનાે ˸ાેત બની શકે છે. 

 અા ફીચરનાે ઉપયાેગ ખાતરીપૂવƙક અને વધુ સુ̍ વધા માટે હાેવાે ̀ેઈઅે. 

મƿૅાેઝ Microsoft Word 2019 ની અેક અસરકારક સુ̍વધા છે, જ ેકાયƙƖમતામાં વધારાે કરે છે અને દƺતાવેજ 
પરના અવારનવારના કાયƙન ેઅાૅટાેમેટ કરવાનું કાયƙ સરળ બનાવે છે. ̀ે યાƝેય રીતે ઉપયાેગ કરવામાં અાવ,ે 
તાે તે તમને સમય બચાવવા અને વધુ ઉɎાદક બનવામાં મદદͅપ થાય છે 

20. નમુનાͅપ ǐ˜ાે અને જવાબાે (Model Questions and Answers) 

1. Microsoft Word 2019 કઈ ǐકારનું સાેʘવેર છે? 
a) Drawing Software 
b) Spreadsheet Software 
c) Word Processing Software  
d) Operating System 

2. Microsoft Word 2019 શͅ કરવા માટે કઈ શાેટƙકટ કી ઉપયાેગી છે? 
a) Ctrl + W 
b) Ctrl + O 
c) Windows Key + S  
d) Alt + D 

3. Word 2019 માં કયું ફાેમ̳ટ ̋ડફાે˄ રીતે સેવ થાય છે? 
a) .txt 
b) .pdf 
c) .doc 
d) .docx  

4. ટેȌ Bold કરવા માટે કઈ શાેટƙકટ કી છે? 
a) Ctrl + U 
b) Ctrl + I 
c) Ctrl + B  
d) Ctrl + E 

5. ડાેȂુમɰેમાં લખાણને Highlight કરવા માટે કયાે ̍વકˍ છે? 
a) Font Color 
b) Background Color 
c) Text Highlight Color 
d) Font Effects 

6. Track Changes કયા ટેબમા ંમળે છે? 
a) View 
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b) Insert 
c) Review 
d) File 

7. Clipboard history ̀ેવા માટે કઈ કી દબાવવી પડે? 
a) Ctrl + Alt + V 
b) Windows + V  
c) Ctrl + Shift + V 
d) Alt + V 

8. Change Case નાે ઉપયાેગ શું માટે થાય છે? 
a) ફાેɰ બદલવા 
b) ટેȌ ˶ાઇલ બદલવા 
c) અƖરાેના કદ બદલવા 
d) માેટા/નાના અƖર બદલવા 

9. Text Alignment ના કેટલા ǐકારાે છે? 
a) 2 
b) 3 
c) 4  
d) 5 

10. લખાણને Centre Alignment અાપવા માટે કઈ શાેટƙકટ કી છે? 
a) Ctrl + L 
b) Ctrl + R 
c) Ctrl + J 
d) Ctrl + E  

11. Insert ટેબનાે ઉપયાેગ શું માટે થાય છે? 
a) ફાેમ̳̋ટ̬ગ માટે 
b) ̋રબન છુપાવવા માટે 
c) ̎ચǋા,ે ટેબ˔ ઉમેરવા માટે  
d) પેજ સેટ કરવા માટે 

12. Find and Replace કયા ટેબમાં હાેય છે? 
a) File 
b) Insert 
c) Home  
d) Design 

13. Microsoft Word 2019માં ટેʱલેટ શું છે? 
a) ǁાફ બનાવવાનું સાધન 
b) પહેલેથી બનાવેલ ડાેȂમુɰે ફાેમ̳ટ  
c) ̌ǐ̔ɰ̬ગ સાધન 
d) ˾ેલ ચેક ટૂલ 
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14. Spell Check માટે કઈ શાેટƙકટ કી છે? 
a) F5 
b) F7  
c) F9 
d) F12 

15. Paste કરવા માટે કઈ શાેટƙકટ કી છે? 
a) Ctrl + C 
b) Ctrl + X 
c) Ctrl + V  
d) Ctrl + P 

16. Word 2019 માં ‘Save As’ ̍વકˍનાે ઉપયાેગ Ȃારે થાય છે? 
a) ફાઇલને બંધ કરવા માટે 
b) નવી ફાઇલ બનાવવા માટે 
c) ફાઇલને નવા નામથી અથવા નવા ફાેમ̳ટમાં સેવ કરવા માટે  
d) ફાઇલ ̌ǐɰ કરવા માટે 

17. Page Orientation બદલવા માટે કયાે ટેબ ઉપયાેગી છે? 
a) Insert 
b) Layout  
c) View 
d) Review 
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માઈƿાેસાેʘ અȋેેલ 2019 
 

1. ઉɠેશાે  

અા ǐકરણનાે અʬાસ કયાƙ બાદ તમે Microsoft Excel 2019નાે સંપૂણƙ અને અસરકારક ઉપયાેગ કરી 
શકશાે. અા ǐકરણના અંતે તમે:   

 Microsoft Excel 2019ના ઇɰરફેસ અને તેના ̍વ̍વધ તɗાેને અાેળખી શકશાે તમેજ વકƙશીટ અન ે
વકƙબુક સાથે કાયƙ કરવાની પɡ̍ત ̍વષે સમજ મેળવી શકશાે. 

 નવી વકƙશીટ બનાવવી, સેવ કરવી, અાેપન (ખાેલવી) કરવી, ̌ǐɰ કરવી, નામ બદલવું, દુર કરવી  વગેરે 
ǐ̋ƿયા કરી શકશા.ે  

 સે̝ , રાે અને કાૅલમ ઉમેરવાની, ડીલીટ કરવાની, ફેરફાર કરવાની કુશળતા ̍વકસાવી શકશાે અને 
અǉેે̐સ̬ગ અને તેના ǐકાર ̍વષે ̀ણી શકશાે. 

 લખાણ, નંબર, તારીખ જવેી મા̋હતી દાખલ કરી શકશાે અને તેને ફાેમ̳̋ટ̬ગ કરી શકશાે  
 ગણતરી અને ̍વƸલેષણ માટે ફાેʸુƙલા અને ફંȆʉ (SUM, AVERAGE, IF વગેરે) નાે ઉપયાેગ કરી 

શકશાે. 
 ̍વ̍વધ ǐકારના ચાટ્ƙસ અને ǁાʟ બનાવવાનંુ કાૈશˑ ̍વકસાવી શકશા.ે   
 મા̋હતી પર સાૅટƙ, ̋ફ˄ર અન ેઅેડવાʉ ̋ફ˄રનાે ઉપયાેગ કરી શકશાે   
 ̌પવાેટ ટેબલ અને ̌પવાેટ ચાટƙનાે ઉપયાેગ કરીને ડેટા ̍વƸલેષણ કરી શકશા.ે 

 

2. પ̋રચય (Introduction) 

Microsoft Excel 2019 અે અેક ખુબજ ઉપયાેગી ˿ેડશીટ ǐાેǁામ છે, જ ેમાઇƿાસેાેʘ અાૅ̋ફસ ̃ટુનાે ભાગ 
છે. અા ǐાǁેામ ડેટા મેનેજમેɰ, ̍વƸલેષણ, ગણતરીઅાે, ǁાʟ અને ચાટ્ƙસ ɦારા મા̋હતીના અસરકારક ǐદશƙન 
અને અʈ ̠ વસા̍યક તથા ̠ ̘Ǹગત હેતુઅાે માટે ઉપયાગેમાં લેવાય છે. તે ખાસ કરીન ેડેટાને વધુ ˗વ̗˺ત 
રીતે રાખવા અને તેની ઉપર કાયƙƖમ ǐ̋ƿયા માટે ઉપયાેગી છે. 

Excel 2019 ના મȕુ ઉપયાેગાે: 

1. ડેટા સંચાલન (Data Management): Excel તમને ડેટાને રાે અને કાૅલમના ̄ͅપમાં દાખલ કરવા 
માટેની સુ̍વધા ǐદાન કરે છે. 

2. ગણતરીઅાે અને ફાેʸુƙલા (Calculations & Formulas): વપરાશકતાƙઅાે સરળ તેમજ જ̋ટલ ગણતરી 
માટે ફાેʸુƙલા લખી શકે છે. 

3. ડેટા ̍વƸલેષણ (Data Analysis): ડેટા ̋ફ˄ર, સાૅટƙ અને ̌પવાેટ ટેબલ જવેા ટૂ˔નાે ઉપયાેગ કરીન ે
ડેટાનું ̍વƸલેષણ કરી શકાય છે. 

4. ડેટા ͆Ƹયીકરણ (Data Visualization): ચાટ્ƙસ, ǁાʟ અને કɱીશનલ ફાેમ̳̋ટ̬ગના માɪમથી ડેટાને 
વધુ ͆Ƹયમાન અને સમજવા યાેƝય બનાવે છે. 
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5. અાટાેમેશન (Automation): મૅƿાેઝનાે ઉપયાેગ કરીને વારંવાર થતા કાયા̳ને અાટૅાેમેટ કરી શકાય છે. 

Microsoft Excel 2019 ના મȕુ લƖણાે: 

1. પ̋ર̎ચત ઇɰરફેસ: Microsoft Excel 2019 ̋રબન અાધા̋રત ઇɰરફેસ સાથે અાવે છે, જ ેઉપયાેગમાં 
સરળ છે. 

2. અɥતન ફંȆʉ: વધુ સારા ડેટા સંચાલન માટે નવીન ગણતરીઅાે અને ફંȆʉ જેમ કે TEXTJOIN, 
IFS અને SWITCH સામેલ છે. 

3. ચાેકસાઇવાળી ટૂ˔: પાવર Ȅેરી (Power Query) અને પાવર ̌પવાેટ (Power Pivot) જવેા ટૂ˔ ડેટા 
સંકલન અને ̍વƸલેષણ માટે ઉપયાેગી છે. 

4. નવા ચાટƙ ǐકારાે: Microsoft Excel 2019માં નવા ǐકારના ચાટƙ જમે કે Funnel ચાટƙ અને મૅપ ચાટƙ 
ઉમેરવામાં અા˗ા છે. 

5. સહયાેગ (Collaboration): Microsoft Excel 2019માં ȃાઉડ અાધા̋રત ફાઇલ સંકલન અને 
સહયાેગની સુ̍વધા છે, જ ેટીમ સાથે સરળતાથી કાયƙ કરવા દે છે. 

Microsoft Excel 2019 અે ડેટાને સંચા̏લત કરવા, ̍વƸલષેણ કરવા અને રજૂ કરવા માટેનું અɔંત કાયƙƖમ 
સાધન છે. તે માǋ ગણતરી અથવા મા̋હતીના સંǁહ સુધી મયાƙ̋ દત નથી, પરંતુ ˗વસા̍યક ǐાેજǶ્ેસના 
̏નયંǋણ અને જ̋ટલ ડેટા ̍વƸલેષણ માટે પણ મદદͅપ છે. Microsoft Excel 2019  ɦારા વપરાશકતાƙ તમેની 
કાયƙƖમતા વધારી શકે છે અને વધુ બાૈ̏ɡક ̏નણƙય લઈ શકે છે. 

3. ઇલƛેǇાે̏નક ˿ેડશીટના તɗાે (Elements of Electronic Spreadsheet) 

Microsoft Excel 2019 અેક અાધુ̏નક ઇલેƛǇાે̏નક ˿ેડશીટ સાેʘવેર છે, જ ેડેટાના સંચાલન, ̍વƸલેષણ 
અને ͆Ƹયીકરણ માટે ઉપયાગેમાં લેવાય છે. Excel માં કાયƙ કરવા માટેના ̍વ̍વધ તɗા ેછે, જ ેતેના સંǁહ અને 
કાયƙƖમતાને સરળ અને ǐભાવશાળી બનાવે છે. 

Microsoft Excel 2019 શ̈́ કરવું  

̀ે Microsoft Excel 2019 તમારા કƳʔુટર પર ઇʊાલે ન હાેય, તાે સાૈ ǐથમ તેન ેMicrosoft Office 
Suiteમાંથી ઇʊાેલ કરવું પડશે. ̀ે તમારા કƳʔુટર પહેલેથી જ Microsoft Excel 2019 ઇʊાેલ હાેય તાે 
તેને શ̈́ કરવા માટે તમે નીચનેા માંથી કાેઇપણ અેક રીત અપનાવી શકાે છાે .  

ડે˱ટાેપ અાઇકાેનથી ખાેલવંુ: 

5. તમારા કƳʔુટરના ડે˱ટાેપ પર Microsoft Excel અાઇકાને   શાેધાે. 

6. અા અાઇકાેન પર ડબલ-̚ȃક કરાે. 

7. Microsoft Excel ખૂલી જશે અને નવું ડાેȂુમેɰ બનાવવા માટે તયૈાર રહેશે. 

˶ાટƙ મેʈુથી ખાેલવું: 

8. કી-બાેડƙ પર અાવેલ Windows Key  દબાવાે અથવા ˲ીનના નીચે બાજુના ખૂણે અાવેલી Start 
બટન પર ̚ȃક કરાે. 
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9. "Microsoft Excel" કે "Excel 2019" શાેધાે. 

10. ̏લ˶માંથી Excel 2019 પસંદ કરીન ે̚ȃક કરા.ે 

સચƙ બારનાે ઉપયાેગ કરીન ેખાેલવંુ: 

11. Windows Key  + S દબાવાે અથવા Search Bar  પર ̚ȃક કરાે. 

12. "Excel" લખાે  અને "Microsoft Excel 2019" પર ̚ȃક કરાે. 

ડાેȂુમɰેથી ખાેલવંુ: 

13. ̀ે તમારા કƳʔુટર પર Microsoft Excel ફાેમ̳ટમા ં(XLSX) ડાȂેુમɰે સેવ થયેલ છે, તાે તનેા અાઇકાેન 
પર ડબલ-̚ȃક કરાે. 

14. ȃાઉડથી ડાȂેુમɰે ખાેલવા માટે Microsoft Accountમાં સાઇન ઇન થવું જͅરી છે. 

15. અા ડાȂેુમɰે Microsoft Excel 2019 પેકેજમાં ખુલી જશે. 

ǐારં̐ભક ˲ીનના મȕુ ભાગાે: 

નીચે દશાƙવેલ ˲ ીન Microsoft Excel 2019ની ǐારં̑ભક ˲ ીન છે, જનેે Excel Start Screen કહેવામાં અાવે 
છે. અા ˲ીન વપરાશકતાƙને Excelમાં નવી ફાઇલ બનાવવા, તાજતેરની ફાઇલાે ખાેલવા, અથવા ટેƳʕેટ પસંદ 
કરવાની સુ̍વધા અાપે છે. અહ̯ મુȕ ભાગાે નીચે સમ̀વવામા ંઅા˗ા છે: 

 

ડાબી બાજુના ̍વકˍાે (Navigation Pane) 

 Home: Excelનું મુȕ પૃˤ, ȱાં તાજતેરની ફાઇલાે (Recent Files) અને ટેƳʕેટ્સ ̀ેવા મળે છે. 

 New: નવી ફાઇલ બનાવવાના ̍વકˍાે અને Excel ટેƳʕેટ્સ ઉપલʤ છે. 

 Open: અગાઉથી બનેલી Excel ફાઇલાે ખાેલવા માટે. 
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મɪ ભાગ (Main Area) 

 New Section: અહ̯થી તમે Blank Workbook પસંદ કરીને ખાલી ફાઇલ શͅ કરી શકાે છાે. 

 Excelના ફીચસƙ શીખવા માટે ȵુટાે̋રયલ ટેƳʕેટ્સ (Take a Tour, Formula Tutorial, Power 
Query Tutorial વગરેે) ઉપલʤ છે. 

 Recent Files: તાજતેરમાં ખાેલેલી Excel ફાઇલાેની યાદી દશાƙવે છે. ફાઇલનું નામ, ˺ાન (Ǘેણી), અને 
ફાઇલ ખાેલવાની તારીખ/સમય દશાƙવાય છે. 

 Pinned Files: ̀ે કાેઈ ફાઇલને મહɗપૂણƙ તરીકે "Pinned" કરશાે, તાે તે અહ̯ ̀ેવા મળશે. 

 Shared with Me: અʈ લાેકાે ɦારા શેર કરેલી Excel ફાઇલાે અહ̯ ̀ેવા મળશે. 

શાેધ બાર (Search Bar) 

 તમે Excel ફાઇલાેને નામ ɦારા શાેધી શકાે છાે. 

ટેƳʕેટ્સ (Templates) 

 Excelમાં પૂવƙ̏ન̌મ̭ત ̋ડઝાઇન અથવા ફાેમ̳ટ્સ ઉપલʤ છે, જમે કે ̌પવાેટ ટેબલ, અાેગ̳નાઇઝેશન ચાટƙ 
વગરેે. 

 More Templates પર ̚ȃક કરીને Excelના અʈ ટેƳʕેટ્સને અૅȋેસ કરી શકાય છે. 

ઉપરનાે ભાગ (Top Right Section) 

 Microsoft Account: વપરાશકતાƙનું લાે̎ગન અેકાઉɰ અને ǐાેફાઇલ મા̋હતી. 

 Minimize, Maximize, Close Buttons: ̍વɱાે મેનજે કરવા માટે. 

અા ˲ીનનાે ઉપયાેગ કેવી રીતે કરવાે? 

 નવાં ǐાેજેǶ માટે: "Blank Workbook" પસંદ કરાે અથવા ટેƳʕેટ્સમાંથી પસંદ કરાે. 

 તાજેતરની ફાઇલાે ખાેલવા માટે: Recent Filesમાંથી પસંદ કરાે. 

 ફાઇલ શાેધવા માટે: સચƙ બારનાે ઉપયાેગ કરાે. 

 ȵુટાે̋રયલ શીખવા માટે: Take a Tour અથવા અʈ ȵુટાે̋ રયલ ટેƳʕેટ્સ પસદં કરાે. 

Blank Workbook પસંદ કરતા નીચે મુજબની અેક નવી વકƙબુક ખુલે છે જમેાં નીચે મુજબના ભાગાે ̀ેવા 
મળે છે. 

વકƙબુક (Workbook): વકƙબુક અેȋેલમાં તમે જ ેફાઈલમાં કાયƙ કરાે છાે તેને વકƙબુક ફાઈલ કહે છે. તેમાં 
અનેક વકƙશીટનાે સમાવેશ થાય છે.  Microsoft Excel 2019માં ફાઈલનુ ંઅȌેેƮશન .xlsx હાેય છે. દરેક 
વકƙબુક અેક અથવા વધુ વકƙશીટની બનેલી હાેય છે. વકƙશીટ સેલ (Cell) ની બનેલી હાેય છે. વકƙશીટમા ં
̌પǴર, ડાયાǁામ કે ચાટƙ પણ દાખલ કરી શકાય છે. વકƙશીટ તમન ેમા̋હતીનંુ અાયાેજન અને સરળતાથી કામ 
કરવામાં મદદ કરે છે. 
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દરેક વકƙશીટમાં રા ેઅને કાૅલમના ેસમાવેશ થાય છે. રાેના નબંર 1 થી 10,48,576 સુધી હાેય છે જયારે કાૅલમના ં
નામ A, B, .. Z ɔારબાદ AA, AB... અાવે છે. AZ પછી BA, BB ... અેમ XFD સુધી કુલ 16384 કાૅલમ અાવેલા 
હાેય છે. અેક રાે અન ેકાૅલમ ભેગા થાય તેન ેસેલ કહે છે. કાેઇ પણ સમયે, અેક સેલ સ̋ƿય સેલ હાેય છે. તમ ે
તેને ઘાટી બાેડƙરથી અાેળખી શકાે છા.ે અેક વકƙશીટમાં કુલ 17 અબજથી વધારે સેલ અાવેલ હાેય છે.અેક સેલમા ં
વધુમાં વધુ 32,767 અƖર દાખલ કરી શકાય છે. 

વકƙશીટ (Worksheet):  વકƙશીટ અે Excel નાે મȕુ કાયƙƖેǋ છે, ȱાં ડેટા પં̘Ǹઅાે અને કાૅલમમાં સǁં̋હત 
થાય છે. શીટ ટૅબ ɦારા તમે વકƙશીટ બદલી અથવા નવી ઉમેરી શકાે છાે. 

 

સેલ (Cell): વકƙશીટમા ંરાે અને કાૅલમના ȱાં મળે છે તનેે સેલ કહે છે. દરેક સેલને તેના અનʈ સેલ અǉેેસ 
(જમે કે A1, B2) ɦારા અાેળખી શકાય છે. દરેક સેલમા ંઅંક, લખાણ અથવા સǋૂ લખી શકાય છે 

રાે અને કાૅલમ (Rows & Columns): રા ે(Row) અ ેઅાડી લાઇન છે, જ ેનંબર 1, 2, 3... વગેરે ɦારા અાેળખાય 
છે. કાૅલમ (Column) અ ેઊભી લાઇન છે, જ ેA, B, C... વગેરે અƖરાથેી અાેળખાય છે. રા ેઅને કાૅલમ સાથ ે
મળીને સે˔ બનાવે છે. 

̋રબન (Ribbon): Ribbon અે Excelનું મેનુ બાર છે, જમેાં ટૂ˔ અને કમાંડ્સનું ગાેઠવણી હાેય છે. ̋રબનન ે
̍વ̍વધ ટૅબમા ંવહ̲ચવામાં અા˗ું છે જમે કે Home, Insert, Page Layout, Formulas, Data, Review 
અને View. 

ફાેʸુƙલા બાર (Formula Bar): Formula Bar સેલમા ં દાખલ કરાયેલ ડેટા અથવા ફાેʸુƙલા ̀ેવા અને 
સંપા̋દત કરવા માટે ઉપયાગેમાં લેવાય છે. અહ̯ તમે ગુણાકાર, સરવાળાે, સરેરાશ વગેરેના ફાેʸુƙલા દાખલ કરી 
શકાે છાે. 

˶ેટસ બાર (Status Bar): Excel ̍વɱાેના ેનીચનેાે ભાગ, ȱાં વતƙમાન ̋ƿયાǐ̋ƿયા અથવા સે̝  સંબં̍ ધત 
મા̋હતી દેખાય છે. ઉદાહરણ તરીકે, તમા̈́ં કામ Ready, Edit અથવા Enter ̗˺̍તમાં છે ત ેદશાƙવે છે. 

Formula Bar 
Cell 

Row 

Column 

Status bar 
Sheet Tab 

Scrollbars 

Name box 
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શીટ ટૅબ (Sheet Tab): વકƙબુકમાં અલગ-અલગ વકƙશીટ વȝે ન̍વગેટ કરવા માટે Sheet Tab ǐદાન 
કરાયું છે. તમે શીટ ટૅબ પર ̚ȃક કરીન ેશીટનું નામ બદલાવી અથવા નવી શીટ ઉમેરી શકાે છાે. 

˲ાેલ બાર (Scroll Bar): ˲ાેલ બારનાે ઉપયાેગ વડે વકƙશીટના ̍વ̍વધ ભાગાેમાં ને̍ વગેટ કરી શકાય છે. ત ે
અાડંુ (Horizontal) અને ઊભું (Vertical) હાેય છે. 

નેમ બાȋૅ (Name Box): Name Box અે વતƙમાન સેલની અેǉેસ બતાવે છે. ઉદાહરણ તરીકે, ̀ે તમે A1 
સેલ પસંદ કરશા,ે તાે Name Box અે "A1" બતાવશ.ે 

3.1 ˿ેડશીટ ખાેલવી (Opening a Spreadsheet) 

Microsoft Excel 2019 માં નવી અથવા અગાઉથી બનલેી ˿ેડશીટ ખાેલવી ખૂબ જ સરળ છે. અા ǐ̋ƿયાથી 
તમે Excel ની વકƙબુકમાં કામ શ̈́ કરી શકાે છાે અને ડેટાની સાથે કાયƙ કરવાની તજƗતા ǐાʏ કરી શકાે છાે. 

નવી (New) ˿ેડશીટ ખાેલવાની પɡ̍ત: 

1. Excel ǐારંભ કરાે: અાગળ જણા˗ા મુજબ Microsoft Excel 2019 ǐાǁેામ શ̈́ કરા.ે 

2. નવંુ દƺતાવેજ બનાવાે: Excel શ̈́ થતાં જ, તમ ેNew Workbook ̍વકˍ પસંદ કરી શકાે છાે અથવા 
File > New પર ̚ȃક કરાે અન ેBlank Workbook ̍વકˍ પસંદ કરાે. 

3. અાકાર અને માળખુ ંઅપાવવંુ: હવે તમે તમારા ડેટા માટે પં̘Ǹઅાે અને કાૅલમમાં મા̋હતી દાખલ કરી શકા ે
છા.ે 

અગાઉ બનેલ (Existing) ˿ેડશીટ ખાેલવાની પɡ̍ત: 

1. Excel ǐારંભ કરાે: અાગળ જણા˗ા મુજબ Microsoft Excel 2019 ǐાǁેામ શ̈́ કરા.ે 

2. File મેનુ પર ̚ȃક કરાે: ̋રબનના File ટૅબ પર ̚ȃક કરાે. 

3. Open ̍વકˍ પસંદ કરાે: File મેનુમાંથી Open ̍વકˍ પસંદ કરાે. નીચે મુજબની ̍વɱા ેઅાેપન થશે 
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4. ˺ાન પસંદ કરાે: તમા̈́ં દƺતાવેજ ȱાં સǁં̋હત છે તે ˺ાન પસદં કરાે (જેમ કે This PC, OneDrive, 
SharePoint અથવા અʈ લાેકેશન). 

5. ફાઇલ પસંદ કરાે: ખાેલવા માંગતા દƺતાવેજ પર ̚ȃક કરાે અને Open બટન દબાવાે. 

શાૅટƙકટ ɦારા ˿ેડશીટ ખાલેવી: તમે Excel 2019 ના શાૅટƙકટ Ctrl + O નાે ઉપયાગે કરીને પણ દƺતાવેજ 
ખાેલી શકાે છાે. તે ɗ̋રત અને સમય બચાવનારી પɡ̍ત છે. 

અેકથી વધુ દƺતાવજે ખાેલવી: Excel તમને અેક સાથે ઘણા દƺતાવેજ ખાેલવાની મંજૂરી અાપે છે. અેક કરતાં 
વધુ વકƙબુક વȝે ̗̄ચ કરવા માટે, તમે View > Switch Windows ̍વકˍનાે ઉપયાેગ કરી શકાે છાે. 

સામાʈ સમ̃ાઅાે અને ઉકેલાે: 

1. ફાઇલ નું ˺ાન ખબર ન હાયે: તમે જ ેફાઈલ ખાેલવા માંગતા હાેત તેનું ˺ાન ખબર ન હાેય તા ેSearch 
Bar માં ફાઇલનંુ નામ શાેધા.ે 

2. ફાઇલ પાશવડƙથી સુર̐Ɩત હાેય: તમારે ખાેલવા માટે યાેƝય પાસવડƙ દાખલ કરવાે પડશે. 

3. અ̀ણી ફાેમ̳ટ ફાઇલ: Excel 2019 અે સામાʈ Excel ફાેમ̳ટ (.xlsx) ને સપાેટƙ કરે છે. ̀ે ફાઇલ અʈ 
ફાેમ̳ટમાં હાેય, તાે તેને Excel-સહમત ફાેમ̳ટમાં ͅપાંત̋રત કરાે. 

Microsoft Excel 2019 માં નવી ˿ેડશીટ બનાવવી અથવા અગાઉ બનેલ ˿ેડશીટ ખાેલવી અે તમામ 
કામગીરી શ̈́ કરવા માટે ǐથમ સાેપાન છે. અા ǐ̋ƿયાન ેસારી રીતે ̀ણવી અે Microsoft Excel 2019ની 
કામગીરીને વધુ સƖમ બનાવે છે. 

3.2 સેલ અેǉે̐સ̬ગ (Addressing Cell) 

માઇƿાેસાેʘ અȋેેલ 2019 મા ંસેલ અǉેે̐સ̬ગનાે ઉપયાગે અે દરેક સેલની અાેળખ માટે થાય છે. વકƙશીટમા ં
સેલ અેǉેસનાે ઉપયાેગ ડેટાને સંબાેધન કરવા, ફાેમુƙલા લાગુ કરવા, અને ડેટા સાથે હેરફેર કરવા માટે થાય છે. 

સેલ અǉેેસ શંુ છે? 

અȋેેલમાં દરેક સેલને અેક અનાેખંુ નામ હાેય છે, જ ેકાેલમનું નામ અને રાે નંબર પરથી બનલેું હાેય છે. 
ઉદાહરણ તરીકે A1 સેલ અેǉેસમા ંA અે કાેલમનંુ નામ છે અને 1 અે રાે નંબર છે. 

સેલ અǉેેસના ǐકારાે  

સેલ અǉેેસ બે ǐકારના હાેય છે. સાપƖે (Relative) અને ̏નરપેƖ (Absolute) મૂળભૂત રીતે સેલ અǉેેસ 
સાપƖે હાેય છે. જયારે તમે સેલની નકલ કરાે છાે અથવા ફીલ કરાે  છાે ɔારે, ફાેʸુƙલા રા ેઅન ેકાૅલમ સબંં̍ધત 
̗˺̍ત અાધા̋રત બદલાય છે. દા.ત.  ̀ે તમ ેબી͂ રાેમાંથી પહેલી રાેમાં ફાેʸુƙલા (=C4+D4+E4) ની નકલ 
કરશા,ે તાે અા સǋૂ ફેરફાર થઈ (=C5+D5+E5) બની જશે. 

̏નરપેƖ સંદભƙનાે ઉપયાેગ કરી જયારે તમ ેસેલની નકલ કરાે છાે અથવા ફીલ કરાે છાે ɔારે બદલાતા નથી અન ે
જયારે ̋ ક̬મત બદલવાની ન હાેય ɔારે વપરાય છે. ̏ નરપેƖ સંદભƙ અાપવા માટે સǋૂમા ંડાેલરની સƗંા ($) વપરાય 
છે.  

સાપેƖ સેલ અǉેેસ (Relative Cell Address): 
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 ફાેમુƙલામાં તેનાે ઉપયાેગ સેલના ˺ાન પર અાધાર રાખે છે. 

 ઉદાહરણ: =A1 + B1 અહ̯ ફાેમુƙલા ̀ેડાયેલા સેલના ˺ાન પર અાધાર રાખે છે. 

̏નરપેƖ સેલ અǉેેસ (Absolute Cell Address): 

 સેલ અેǉેસને ̗˺ર રાખવા માટે $ ̎ચ̆નાે ઉપયાેગ થાય છે. 

 ઉદાહરણ: =$A$1 + $B$1 અહ̯ A1 અને B1 સેલ અેǉેસ ̗˺ર રહેશ,ે ભલે ફાેમુƙલા કાેપી કરાે. 

̍મǗ સેલ અǉેેસ (Mixed Cell Address): 

 અામાં કાેલમ અથવા રાે માંથી અેક ̗˺ર રહે છે. 

 ઉદાહરણ: =$A1 (કાેલમ ̗˺ર છે) અથવા A$1 (રાે ̗˺ર છે). 

સેલ અǉેેસનાે ઉપયાેગ: 

 ફાેમુƙલા અને ફંȆન: ફાેમુƙલા લખવા માટે, જમે કે =SUM(A1:A10). 

 ડેટા રેફરʉ: અેક સેલનાે ડેટા બી̀ સેલમાં ઉપયાેગ કરવા માટે. 

 Ǘેણી (Range): સેલના સમૂહને ઉપયાેગ કરવા માટે, જમે કે A1:B10. 

સેલ અǉેેસ કઈ રીતે શાેધવું? 

 Name Box: અȋેેલમાં સેલની પસંદગી કયાƙ પછી તેની અાેળખ માટે Name Box માં સેલ અેǉેસ 
દેખાશે. 

 કસƙર મૂવમેɰ: કીબાેડƙના અેરાે કીનાે ઉપયાેગ કરીને સેલ બદલા,ે અને Name Boxમાં અેǉેસ જુઅાે. 

5. ઉદાહરણ: 

 સંપૂણƙ અેǉેસ: A1: કાેલમ A, પં̘ Ǹ 1. 

 Ǘેણી: A1:A5: કાેલમ A ની પં̘Ǹઅાે 1 થી 5. 

 ફાેમુƙલા: =SUM(A1:A5): કાેલમ A ની પં̘Ǹઅા ે1 થી 5 ના મૂˑાેનાે સરવાળાે. 

સેલ અેǉે̐સ̬ગ અે માઇƿાેસાેʘ અેȋેલ 2019 ની મહɗપૂણƙ સુ̍ વધા છે, જ ેદƺતાવેજમાં ડેટાને અાેળખવા 
અને સંબાેધવા માટેની કી છે. યાેƝય સેલ અેǉેસનાે ઉપયાેગ કરીને તમે ફાેમુƙલા અને ડેટા હેરફેરને વધુ કાયƙƖમ 
બનાવી શકાે છાે. 

3.3 ˿ેડશીટનું ̌ǐ̔ɰ̬ગ (Printing of Spreadsheet) 

Microsoft Excel 2019 માં ˿ેડશીટના ડેટાને કાગળ પર ̌ǐɰ કરવાનાે ̍વકˍ ઉપલʤ છે. ̌ǐ̔ɰ̬ગની 
̍વ̍ધ ˿ેડશીટને ˗વ̗˺ત રીતે ǐƺતતુ કરવા માટે અɔતં ઉપયાેગી છે. Microsoft Excel 2019માં ̌ǐ̔ɰ̬ગ 
કરતી વખતે તમે ̍વ̍વધ મા̏જ̭ન, પેજ લેઅાઉટ, અને ̌ǐɰ Ɩેǋાે પર ̏નયંǋણ મેળવી શકાે છાે. 

˿ેડશીટ ̌ǐɰ કરવાની ̍વ̍ધ: 
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1. ̌ǐɰ ̌ǐ-˗ુ (Print Preview): Excel માં તમારા ડેટાને ̌ǐɰ કરતાં પહેલા File > Print પર ̀અાે. 
અહ̯ તમ ેPrint Preview માં ̀ેઈ શકાે છાે કે તમારી ˿ેડશીટ કેવી રીતે ̌ǐɰ થશે. 

2. ̌ǐɰ ટૅબ ખાેલાે: File > Print ̍વકˍ પસંદ કરાે અથવા Ctrl + P કી દબાવાે. નીચ ેમુજબની ̍વɱા ે
અાેપન થાય છે. 

 

3. ̌ǐɰર પસંદ કરાે: તમારા કƳʔુટર સાથે ̀ેડાયેલ ̌ǐɰર પસંદ કરાે અથવા Microsoft Print to PDF 
̍વકˍ પસંદ કરી શકાે છાે. 

4. પેજ અને ̌ǐɰ ̍વƺતાર પસદં કરાે: 

o Print Active Sheets: અા ̍વકˍ વતƙમાન શીટને ̌ǐɰ કરે છે. 

o Print Entire Workbook: અા સમǁ વકƙબુકને ̌ǐɰ કરે છે. 

o Print Selection: તમે પસદં કરેલા ચાǲેસ Ɩેǋ (Range) ને ̌ǐɰ કરે છે. 

5. ̌ǐɰની સȕંા: તમે ̌ǐɰની ચાેǲસ સȕંાની કાૅપીઅાે દાખલ કરી શકાે છાે. 

6. માગƙદશƙક ̍વકˍાે (Page Setup Options): 

o Margins: મા̏જ̭ન બદલીને પાનું ગાેઠવાે. 

o Orientation: પાનું ન ેPortrait (ઉભંુ) અથવા Landscape (અાડંુ) બનાવાે. 

o Scaling: ડેટાને પેજ પર ગાેઠવવા માટે ˱ે̏લ̬ગ ̍વકˍાનેા ેઉપયાેગ કરાે. 

̌ǐɰ કરતી વખતે ઉપયાગેી ̍વકˍાે: 
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1. પેજ લેઅાઉટ (Page Layout): Page Layout ટૅબમાં તમે હેડર, ફૂટર, અને પજેના મા̏જ̭ન ગાેઠવી 
શકાે છાે. 

2. ̌ǐɰ ̍વƺતાર પસંદ કરવાે: ફǸ ચાેǲસ ડેટાને ̌ǐɰ કરવા માટે, Page Layout > Print Area 
> Set Print Area નાે ઉપયાેગ કરાે. 

3. હેડર અને ફૂટર ઉમરેવંુ: હેડર (Header) અથવા ફુટર (Footer) ઉમેરવા માટે Insert > 
Header/Footer નાે ઉપયાગે કરાે. 

4. ̎ǁડલાઇન ̌ǐɰ કરવી: ̎ǁડલાઇનને ͆Ƹયમાન રાખવા માટે, Page Layout > Sheet Options 
> Gridlines અંતગƙત "Print" ̍વકˍ પસંદ કરાે. 

̌ǐɰ કરતી વખતે સામાʈ સમ̃ાઅાે અને ઉકેલ: 

1. ડેટા પેજ પર ̋ફટ ન થાય: તમે Scaling ̍વકˍનાે ઉપયાેગ કરીને ડેટાને અેક પેજમાં ગાેઠવી શકાે છાે 
તેના માટે Fit Sheet on One Page ̍વકˍ પસંદ કરાે. 

2. ખાેટા ̍વƺતારાે ̌ǐɰ થાય છે: Print Area સેટ કરાે અને ફǸ જͅરી ડેટાને ̌ǐɰ કરાે. 

3. અ˾ˠ ̌ǐɰ: ખાતરી કરાે કે ̌ǐɰર Ȅાે̏લટી યાેƝય રીતે ગાેઠવેલ છે. 

̌ǐ̔ɰ̬ગ માટે સૂચના:ે 

 તમારા ડેટાનું  ફાેમ̳̋ટ̬ગ ચકાસાે જેથી તે સુ˗વ̗˺ત લાગે. 

 ખૂબ માેટા ડેટાને ̌ǐɰ કરતાં પહેલાં તેને યાેƝય રીતે ગાેઠવાે. 

 Preview ̌ǐɰ કરતા પહેલાં ચકાસવા માટે Ǘેˤ સાધન છે. 

Microsoft Excel 2019માં ˿ેડશીટ ̌ǐɰ કરવાની ̍વ̍ધ સુ˗વ̗˺ત અને સરળ છે. ̌ǐ̔ɰ̬ગ સાથ ે
સંકળાયેલા ̍વ̍વધ ̍વકˍાે ઉપયાેગ કરીને ડેટાને સારી રીતે ǐƺતતુ કરી શકાય છે. Excel 2019ના ̌ǐ̔ɰ̬ગ 
સાધનાે કાયƙƖમતાને વધુ સુધારે છે અને ǐƺતુ̍ તને ǐભાવશાળી બનાવે છે. 

3.4 વકƙબકુને સંǁ̋હત કરવી (Saving Workbooks) 

Microsoft Excel 2019 માં, વકƙબુકને સાચવવું (Save) અે મહɗપણૂƙ ǐ̋ƿયા છે. અા સુ̍વધા તમા̈́ં કાયƙ 
સુર̐Ɩત રાખે છે અને જ̋ͅરયાત મુજબ ઉપયાેગમાં લેવા માટે ઉપલʤ બનાવે છે. Excel 2019 કાયƙને સુર̐Ɩત 
રીતે સંǁ̋હત કરવા માટે ̍વ̍વધ ̍વકˍાે ǐદાન કરે છે. 

ǐથમ વખત વકƙબુક સાચવવાની ǐ̋ƿયા: 

1. ફાઇલ મેનુ ખાેલાે: ̋રબનમાંથી File ટૅબ પર ̚ȃક કરાે. 

2. Save As ̍વકˍ પસંદ કરાે: Save As ̍વકˍ પર ̚ȃક કરાે. તમારી ફાઈલ Ȃાં સંǁ̋હત કરવી 
હાેય તે ˺ાન પસંદ કરાે, જેમ કે This PC, OneDrive, અથવા Browse ɦારા અʈ ફાે̂ ર પસંદ 
કરાે. 
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Browse બટન દબાવતા નીચે મુજબનાે ડાયલાેગ બાેƖ અાેપન થાય છે 

 

 

3. ફાઇલ નામ અાપાે: ફાઇલનું અનʈ નામ દાખલ કરાે જથેી તે અાળેખવા માટે સરળ બને. 

4. ફાઇલ ફાેમ̳ટ પસંદ કરાે: Excel 2019 મા,ં તમે ̍વ̍વધ ફામે̳ટમાં ફાઇલ સાચવી શકાે છાે જમે કે .xlsx 
(Excel વકƙબુક): ̋ ડફાે˄ ફાઇલ ફાેમ̳ટ,  .xls: જૂના વઝƙન સાથે સુસંગત ફાઇલ, .csv: કાેમા સપેરેટેડ 
ફાઇલ ફાેમ̳ટ વગેરે. 
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5. Save બટન પર ̚ȃક કરા:ે અાખરે Save બટન ̚ȃક કરીન ેફાઇલને સાચવાે. 

અગાઉ બનાવેલ ફાઈલ સેવ કરવી (Saving Updates): 

 કાયƙ દર̌મયાન થતા ફેરફારાનેે સǁં̋હત કરવા માટે: Ctrl + S કી દબાવાે અથવા File > Save ̍વકˍ પર 
̚ȃક કરાે. અા ǐ̋ƿયા ફાઈલમાં થયેલ ફેરફાર સેવ કરે છે. 

અલગ ફાઈલ તરીકે સાચવવી (Save As): ̀ે તમને હાલમાં અાેપન કરેલ ફાઇલની કાેપી કરવી હાેય અથવા 
અʈ નામથી સેવ કરવી હાયે, તા:ે File > Save As પર ̀અાે. નવંુ ˺ાન અથવા નામ પસંદ કરાે. નવી 
ફાઇલને સાચવાે. 

અાટેામેે̋ ટક સેવ કરવંુ (AutoSave): 

 Excel 2019 મા ંAutoSave સુ̍ વધા ઉપલʤ છે. ̀ે AutoSave ચાલુ હાેય, તાે તમારી ફાઇલ ̏નય̌મત 
રીતે ̄યં સંǁ̋હત થશે. ખાસ કરીને, OneDrive અથવા SharePoint પર સંǁ̋હત ફાઇલાે માટે અા 
ખૂબ ઉપયાેગી છે. 

બેકઅપ અને રીકવરી: 

 Auto Recover: Excel 2019 અાપમેળે તમા̈́ં કાયƙ સભંાળે છે ̀ ે ઇમરજʉી કે ǐાǁેામ ƿેશ થાય. Auto 
Recover માટે File > Info > Manage Workbook > Recover Unsaved Workbooks ના ે
ઉપયાેગ કરાે. 

 

 બેકઅપ ફાઇલ: File > Save As > Browse બટન ̚ȃક કરાે જથેી નીચે દશાƙવેલ Save As ડાયલાગે 
બાેƖ અાપેન થાય છે જમેાં તમે Tools > General Options હેઠળ Always create backup ̍ વકˍ 
સ̋ƿય કરી શકા ેછા.ે 
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યાદ રાખાે: 

 કામ કરતી વખતે ̏નય̌મત રીત ેCtrl + S દબાવાે. 

 ફાઇલને અનʈ અન ેયાƝેય નામ અાપાે જથેી તનેે સરળતાથી અાળેખી શકાય. 

 માળખા અથવા માેડેલ ટાઇપની ફાઇલાેને Template (.xltx) ફામ̳ેટમાં સાચવાે. 

Excel 2019 માં વકƙબુકને સાચવવી અે દરેક ઉપયાેગકતાƙ માટે અાવƸયક કાયƙ છે. સાચવેલી ફાઇલ સમયાંતરે 
સંશાે̍ ધત અને ફરીથી ઉપયાેગમા ં લેવાય છે. સǁંહણ ǐ̋ƿયાની સંપૂણƙ સમજદારી કાયƙƖમતા વધારવામા ં
મદદͅપ થાય છે અન ેમહɗપૂણƙ ડેટાના નુકસાનથી બચાવે છે. 

4. સે˔નુ ંમનેીʔુલેશન (Manipulation of Cells) 

Microsoft Excel 2019 માં સે̝ નું મનેીʔુલેશન અે ડેટાને અસરકારક અને ˗વ̗˺ત કરવા માટેની 
મહɗની ǐ̋ƿયા છે. Microsoft Excel 2019માં સે˔ સાથે ̍વ̍વધ ǐકારની ̋ƿયાઅા ેકરીને ડેટાને અે̋ ડટ, 
ફાેમ̳ટ, અને ̀ળવણી કરી શકાય છે. નીચે સે˔ સાથે કરી શકાતી ̍વ̍વધ ǐ̋ƿયાઅાે અગેં સમ̀વેલ છે: 

1. સેલ ̐સલેȆન (Cell Selection) 

 સે̝ ને પસંદ કરવા માટે માઉસ અથવા કીબાડેƙનાે ઉપયાેગ કરી શકાય છે. 

 અેક ̐સ̬ગલ સલે, મ̔˄પલ સે˔ અથવા અાખી ર̲જને પસંદ કરી શકાય છે. 
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 કીબાેડƙ શાટેƙકટ્સ જમે કે Shift + Arrow Keys અન ેCtrl + A પસંદગીમાં મદદͅપ થાય છે. 

2. કɰેɰ અે̋ડ̋ટ̬ગ (Editing Cell Content) 

 સેલમાં ડબલ ̚ȃક કરીને તમેાંનાે ડેટા ફેરફાર કરી શકાય છે. 

 સેલમાં લખાણ, નંબસƙ, ફાેમુƙલા, અથવા તારીખ દાખલ કરી શકાય છે. 

 ભૂલ સુધારવા માટે Backspace અથવા Delete કીનાે ઉપયાેગ થાય છે. 

3. કટ, કાેપી અને પે˶ (Cut, Copy, Paste) 

 Ctrl + X થી કટ, Ctrl + C થી કાેપી અને Ctrl + V થી પે˶ કરી શકાય છે. 

 ડેટાને બી͂ જƝયા પર ખસેડવા માટે ǉેગ અને ǉાેપ પણ ઉપયાેગી છે. 

4. ફાેમ̳̋ટ̬ગ (Formatting) 

 સે̝ ના દેખાવને બદલવા માટે ફાેમ̳̋ટ̬ગ ̍વકˍાે ઉપલʤ છે. 

 લખાણનું ફાૅɰ, રંગ, સાઇઝ, અને ˶ાઇલ બદલી શકાય છે. 

 સેલ બાેડƙર અને શે̋ડ̬ગ ઉમેરવા માટે Home ટેબનાે ઉપયાગે થાય છે. 

5. મજƙ અન ેિƺʕટ (Merge and Split) 

 અેકથી વધુ સે˔ને મજƙ કરીને અેક માેટંુ સેલ બનાવી શકાય છે. 

 અા ̍વકˍનાે ઉપયાેગ હે̋ડ̬ગ અથવા ટાઇટલ માટે થાય છે. 

 મજƙ કરેલા સે̝ ને િƺʕટ કરવા માટે Unmerge ̍વકˍ ઉપયાેગી છે. 

6. ̋ફલ અને ̚ȃયર અાેપરેશʉ (Fill and Clear Operations) 

 Fill Handle નાે ઉપયાેગ કરીને ડેટાને ઝડપથી નકલ કરી શકાય છે. 

 સેલની અંદરનાે ડેટા કે ફાેમ̳ટ ̚ȃયર કરવા માટે Clear ̍વકˍ છે. 

7. ̋ફ˄ર અને સાેટƙ (Filter and Sort) 

 ડેટાને ̍વધેયાɒક રીતે ગાેઠવવા માટે સાે̋ટ̮ગ અને ̋ફ˄̋રગ̬નાે ઉપયાેગ થાય છે. 

 અા સાથે જͅરી મા̋હતી સરળતાથી શાેધી શકાય છે. 

8. ફાેમુƙલા અને ફંȆન (Formulas and Functions) 

 સે̝ માં ગણતરી કરવા માટે ફાેમુƙલા અને ફંȆʉ દાખલ કરી શકાય છે. 

 ઉદાહરણ તરીકે, =SUM(A1:A10) અે A1 થી A10 સુધીના તમામ મૂˑાેનાે સરવાળાે કરે છે. 

Microsoft Excel 2019 માં સે̝ નું મેનીʔુલેશન ડેટા મેનેજમેɰને સરળ અને વધુ ǐભાવશાળી બનાવે છે. 
અા મેʈુઅલ ટે̚ǽȋનાે ઉપયાેગ કરીને, યુઝસƙ ઝડપી અને સચાેટ રીતે ડેટા સાથે કામ કરી શકે છે. 
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4.1 લખાણ, અાંકડા અને તારીખાે ઉમેરવા (Entering Text, Numbers and Dates) 

Microsoft Excel 2019 અે ડેટા અેƮǇી માટે અેક શ̘Ǹશાળી ટૂલ છે. તેમા ંલખાણ, અાંકડા અને તારીખા ે
દાખલ કરીને ડેટાને સુગમ રીત ેસાચવી શકાય છે. Microsoft Excel 2019ના વકƙશીટમાં અા ǋણે ǐકારના 
ડેટાને કેવી રીતે દાખલ કરવંુ તે નીચે સમ̀˗ું છે: 

લખાણ (ટેȌ) દાખલ કરવંુ (Entering Text) 

 લખાણ અે કાેઈ પણ ǐકારની અƖરાે અને સંȕાઅાેનંુ ̌મǗણ હાેઈ શકે છે જ ેગણતરીમાં ઉપયાેગમા ં
લેવામાં નથી અાવતું. 

 લખાણ દાખલ કરવા માટે: 

1. સેલ પસંદ કરાે. 

2. કીબાેડƙથી લખાણ ટાઇપ કરાે. 

3. લખાણ દાખલ કરવા માટે Enter દબાવાે. 

 લખાણને ફાેમ̳ટ કરવા માટે Home ટેબમાં અાવેલ Font અને Alignment ̍વકˍાેના ેઉપયાેગ કરી 
શકાય છે. 

 

અાકંડા દાખલ કરવા (Entering Numbers) 

 નંબસƙ અે ડેટાને ગણતરી કરવા માટે ઉપયાેગી છે. 

 Microsoft Excel 2019માં નંબસƙ દાખલ કરવા માટે: 

1. સેલ પસંદ કરાે. 

2. કીબાેડƙ પરથી નંબર ટાઇપ કરાે (ઉદાહરણ: 12345). 

3. Enter દબાવીને તે સેલમા ંસǁં̋હત કરાે. 

 Excel માં નંબસƙ અાપમેળે ડાબી કે જમણી બાજુ ગાેઠવાય છે, જ ેતેમના ǐકાર પર અાધાર રાખે છે. 

 નંબર ફાેમ̳̋ટ̬ગ માટે Home ટેબમાં અાવેલ Number Groupમાં અાવેલ કમાંડ ઉપયાેગી છે જનેી મદદથી 
તમે ડેસીમલ પાેઇɰ, ચલણ (₹), ટકા (%) વગેરે ઉમરેી શકાે છાે . 
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3. તારીખાે દાખલ કરવી (Entering Dates) 

 Excel માં તારીખ અન ેસમય દાખલ કરવા માટે ̏ન̏˛ત ફામે̳ટ છે. 

 તારીખ દાખલ કરવા માટે: 

1. સેલ પસંદ કરાે. 

2. તારીખ ટાઇપ કરાે (ઉદાહરણ: 26/12/2024 અથવા December 26, 2024). 

3. Enter દબાવા.ે 

 Excel અાપમેળે તારીખને અાેળખે છે અને તેન ેDate Formatમાં ͅપાંત̋રત કરે છે. 

 તારીખ અને સમયને ક˶માઇઝ કરવા માટે Home ટેબમાં અાવેલ Number Groupમાં જમણી બાજુ 
નીચે અાવેલ તીર પર ̚ȃક કરતા Format Cell ડાયલાગે બાેƖ અાેપન થાય છે જમેાથંી ડેટ ફારેમટે સેટ 
કરી શકાય છે. 

 

4. ડેટા અેƮǇી માટે સચૂનાે 

 AutoFill નાે ઉપયાેગ: સેલમાં અેક વખત લખાણ, નબંસƙ અથવા તારીખ દાખલ કયાƙ પછી, Fill Handle 
નાે ઉપયાેગ કરીન ેતેને બી̀ સે˔માં નકલ કરી શકાય છે. 
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 Undo અને Redo: ભૂલ સુધારવા માટે Ctrl + Z (Undo) અને પાછંુ લાવવા માટે Ctrl + Y (Redo) ના ે
ઉપયાેગ કરી શકાય છે. 

 Keyboard Navigation: ડેટા અƮેǇી ઝડપી બનાવવા માટે કીબાેડƙ શાેટƙકટ્સ જમે કે Tab, Enter, અન ે
Arrow Keys ઉપયાેગી છે. 

Excel 2019 માં લખાણ, અાંકડા અને તારીખાે દાખલ કરવી સરળ છે. અા સામાʈ ડેટા અƮેǇી ǐ̋ƿયાના ે
ઉપયાેગ કરીને તમે કાયƙƖમ રીતે વકƙશીટ તયૈાર કરી શકા ેછાે. 

4.2 લખાણ, અાંકડા અને તારીખની Ǘેણી બનાવવી (Creating Text, Number and 
Date Series) 

Microsoft Excel 2019 અે ડેટાની Ǘેણી ઝડપથી બનાવવાનંુ અેક શ̘Ǹશાળી ટૂલ છે. લખાણ, અાંકડા અને 
તારીખાનેી Ǘેણી બનાવીને ડેટાની ગાેઠવણી કરી કાયƙને સરળ બનાવી શકાય છે. નીચે તેની ̍વગતવાર ǐ̋ƿયા 
અાપવામાં અાવી છે: 

લખાણ Ǘેણી બનાવવી (Creating Text Series) 

 Microsoft Excelમાં લખાણ Ǘેણી બનાવવા માટે AutoFill ફીચરનાે ઉપયાેગ થાય છે. 

 ઉદાહરણ: 

1. "મંડે" (Monday) સેલમાં ટાઇપ કરાે. 

2. સેલને પસંદ કરાે અને Fill Handle ખ̲ચાે. 

3. Excel અાપમેળે "Tuesday", "Wednesday" વગેરે ઉમેરે છે. 
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 અા ફીચર અƖરાે સાથે સȕંાઅાે માટે પણ કાયƙ કરે છે (જમે કે, "Chap-1", "Chap-2"). 

અાકંડાની Ǘેણી બનાવવી (Creating Number Series) 

 Excel માં નંબરાનેી Ǘેણી બનાવવા માટે: 

1. ǐથમ નબંર (જમે કે, 1) અને બી̀ે નંબર (જેમ કે, 2) બે અલગ સેલમા ંદાખલ કરા.ે 

2. બંને સે˔ પસંદ કરાે. 

3. Fill Handle ખ̲ચાે. Excel તફાવતના અાધારે Ǘેણી બનાવે છે. 

 

̐સરીઝ ડાયલાેગ બાȋેનાે ઉપયાગે: 

 Home ટેબમાં અાવેલ Editing કમાંડ ǁપુમાં Fill ǉાેપ ડાઉન માંથી Series ̍વકˍ પસંદ કરાે. 
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 નીચે મુજબનાે ડાયલાેગ બાƖે અાેપન થાય છે જમેાં Ǘેણી માટે Linear, Growth, અથવા Date ̍વકˍ 
પસંદ કરાે. 

 

o ˶ેપ વેˑુ અન ે˶ાેપ વેˑુ દાખલ કરાે. 

 ઉદાહરણ: 1, 2, 3... અથવા 5, 10, 15... 

તારીખની Ǘેણી બનાવવી (Creating Date Series) 

 Excel માં તારીખાેની Ǘેણી ઝડપથી બનાવી શકાય છે: 

1. ǐથમ તારીખ (જમે કે, 01/01/2024) દાખલ કરાે. 

2. Fill Handle ખ̲ચાે. Excel ̋દવસાેની Ǘેણી ઉમરેે છે. 
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ક˶મ તારીખ Ǘેણી: 

 Home ટેબમાં અાવેલ Editing કમાંડ ǁુપમાં Fill ǉાેપડાઉન માંથી Series ̍વકˍ પસંદ કરાે. 

 Date ̍વકˍ પસંદ કરીન ેDay, Month, અથવા Year પસદં કરાે. 

 ˶ેપ વેˑુ દાખલ કરાે. 

 ઉદાહરણ: 

 01/01/2024, 02/01/2024... 

 01/01/2024, 01/02/2024... 

Ǘેણી બનાવવા માટે મહɗના સૂચનાે  

 Custom Lists: Excel મા ંક˶મ Ǘેણી બનાવવા માટે File ટેબમાં Options ̍વકˍ ̚ȃક કરતા નીચ ે
મુબનાે ડાયલાેગ બાƖે અાેપન થાય છે જમેાં Advanced ̍વકˍ ̚ȃક કરી જમણી બાજુ નીચે અાવેલ  
Edit Custom Lists પર ̚ȃક કરાે . 
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 Edit Custom List પર ̚ȃક કરતા નીચ ેમુજબનાે ડાયલાેગ બાƖે અાેપન થાય છે જમેા ંNEW LIST 
̐સલેǶ કરી બાજુમાં અાપેલ ટેȌ બાƖેમાં ટાઇપ કરી તમ ેપાેતાની Ǘેણી બનાવી શકાે છાે અને Add 
બટન ̚ȃક કરતા નવી Ǘેણી ઉમેરાય ̀ય છે. OK બટન ̚ȃક કરાે. હવે તમે નવી બનાવેલ Ǘેણીનાે 
ગમે ɔારે ઉપયાેગ કરી શકાે છાે.    
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 AutoFill Options: Ǘેણી બનાવવા પછી AutoFill Options બટન પર ̚ȃક કરીને Ǘેણીને 
ક˶માઇઝ કરા.ે 

 Keyboard Shortcuts: Ǘેણી ઝડપથી બનાવવા માટે Ctrl + D (Fill Down) અન ેCtrl + R (Fill 
Right) નાે ઉપયાેગ કરાે. 

Excel 2019 માં લખાણ, અાંકડા અને તારીખની Ǘેણી બનાવવા માટેના અા સરળ પગલાંઅાે ડેટાને વધુ 
કાયƙƖમ અને ˗વ̗˺ત રીતે સંભાળવામા ં મદદ કરે છે. અા ફીચર ખાસ કરીન ે વારંવાર પુનરાવ̍ત̭ત થતી 
મા̋હતી માટે સમય બચાવે છે. 

4.3 વકƙશીટ ડેટા અે̋ડટ કરવું (Editing Worksheet Data) 

Microsoft Excel 2019 માં વકƙશીટના ડેટાને અે̋ડટ કરવી અે મહɗપણૂƙ કાયƙ છે, જે તમને ડેટા સુધારવા, 
અપડેટ કરવા અને વધુ સારી રીતે ગાેઠવવામાં મદદ કરે છે. Excel અે ડેટા અે̋ડ̋ટ̬ગ માટે ̍વ̍વધ ટૂ˔ અને 
̍વકˍાે ǐદાન કરે છે. Excel 2019 માં વકƙશીટ ડેટાને અે̋ડટ કરવંુ સરળ છે અન ેતે ડેટા મેનેજમેɰને વધુ 
કાયƙƖમ બનાવે છે. ડેટાને ઝડપથી સુધારવા અને ગાઠેવવા માટેના અા ટૂ˔ કાયƙƖમતા વધારવામાં મદદ કરે 
છે. 

સેલ ડેટા અે̋ ડટ કરવું (Editing Cell Data) 

 સેલ ખાેલવી: ડબલ ̚ȃક કરીને સેલ ખાેલાે અથવા સેલ પસંદ કયાƙ પછી F2 દબાવા.ે 

 ડેટા સુધારવાે: કીબાેડƙનાે ઉપયાેગ કરીને લખાણ અથવા નંબર બદલા.ે 

 ડેટા ̋ડલીટ કરવાે: Delete કી દબાવીને સેલનું કɰેɰ કાઢી નાખા.ે 

 Undo અને Redo: ભૂલ સુધારવા માટે Ctrl + Z (Undo) અને પાછંુ લાવવા માટે Ctrl + Y (Redo) 
નાે ઉપયાેગ કરાે. 

કટ, કાેપી અને પે˶ (Cut, Copy, Paste) 

 Cut: Ctrl + X નાે ઉપયાેગ કરીને ડેટાને ખસેડાે. 

 Copy: Ctrl + C નાે ઉપયાેગ કરીને ડેટાની નકલ કરાે. 

 Paste: Ctrl + V નાે ઉપયાેગ કરીને પસંદ કરેલી જƝયાઅે ડેટા પે˶  કરાે. 

 Paste Options: ડેટાને ફાેમ̳ટ સાથે અથવા ફાેમ̳ટ ̍વના પે˶ કરવા માટે Paste Options ઉપલʤ 
છે. 

Find અને Replace (Find and Replace) 

 Find: ચાǲેસ લખાણ અથવા નંબર શાેધવા માટે Ctrl + F નાે ઉપયાેગ કરાે. 

 Replace: લખાણ અથવા નંબરને બદલવા માટે Ctrl + H નાે ઉપયાેગ કરાે. ઉદાહરણ: "2023" ને 
"2024" થી બદલાે. 
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ફાેમ̳ટ અે̋ડટ કરવંુ (Editing Cell Formatting) 

 

 ફાેɰ અને રંગ બદલવાે: Home ટેબમા ંFont ̍વકˍનાે ઉપયાેગ કરીને લખાણના ફાɰૅ, સાઇઝ, 
અને રંગ બદલાે. 

 બાેડƙર અને શે̋ડ̬ગ: સેલમાં બાડેƙર ઉમેરાે અથવા બેકǁાઉɱ કલર બદલા.ે 

 Alignment: લખાણને ડાબી, જમણી, કે મɪમાં ગાેઠવાે. 

ડેટા ̚ȃયર કરવંુ (Clearing Data): Home ટેબમાં અાવેલ Editing ǁુપમાં Clear ̍વકˍ પસંદ કરતા 
નીચે મુજબના ̍વકˍાે મળે છે.    

 

 Clear All: ડેટા અને ફામે̳ટ બનંેને દૂર કરવા માટે Clear All નાે ઉપયાેગ કરાે. 

 Clear Formats: ફǸ ફાેમ̳ટ દૂર કરવા માટે Clear Formats નાે ઉપયાેગ કરા.ે 

 Clear Contents: ફǸ ડેટા દૂર કરવા માટે Clear Contents નાે ઉપયાેગ કરાે. 

ડેટા મુવ અને કાૅપી કરવું (Moving and Copying Data) 
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 Drag and Drop: માઉસથી સે˔ને ખ̲ચીને ખસેડાે. 

 Copy with Drag: Ctrl કી દબાવી રાખીને સે˔ને નકલ કરાે. 

Ǘેણી અને Autofill અે̋ડટ કરવંુ (Editing Series and Autofill) 

 Fill Handle નાે ઉપયાેગ કરીને Ǘેણી સુધારાે અથવા નવી Ǘેણી બનાવા.ે 

 AutoFill Options બટન પર ̚ȃક કરીન ેǗેણીને ક˶માઇઝ કરા.ે 

4.4 વકƙશીટ ડેટાનું ફાેમ̳̋ટ̬ગ (Formatting Worksheet Data) 

Microsoft Excel 2019માં વકƙશીટ ડેટાનું ફાેમ̳̋ટ̬ગ ડેટાને વધુ પૃથક અને સમજવા યાƝેય બનાવે છે. 
ફાેમ̳̋ટ̬ગનાે ઉપયાગે ડેટાના દેખાવમાં સુધારાે કરવા અને તેને વધુ ˗ાવસા̍યક બનાવવામાં થાય છે. Excel મા ં
ડેટાને ફાેમ̳ટ કરવા માટે Home ટેબમા ં̍વ̍વધ ટૂ˔ ઉપલʤ છે. 

 

1. ફાɰૅ ફાેમ̳̋ટ̬ગ (Font Formatting) 

 ફાૅɰ શૈલી અને અાકાર: લખાણ માટે ફાૅɰ ટાઇપ, સાઇઝ, અને શૈલી પસંદ કરવા માટે Home 
ટેબમાં ફાɰૅ ǁુપના ેઉપયાેગ કરાે. 

 બાે̂ , ઇટા̏લક અને અંડરલાઇન: B (Bold), I (Italic), અને U (Underline) બટનનાે ઉપયાેગ 
કરીને લખાણન ેહાઇલાઇટ કરાે. 

 ફાૅɰ રંગ: લખાણના રંગ બદલવા માટે Font Color ̍વકˍનાે ઉપયાેગ કરાે. 

2. સેલ બાેડƙર અને શે̋ડ̬ગ (Cell Borders and Shading) 

 બાેડƙર ઉમેરવી: સેલને હાઇલાઇટ કરવા માટે બાેડƙર ઉમેરાે. Home → Borders માથંી ̍વ̍વધ બાેડƙર 
શૈલીઅાે પસંદ કરા.ે 

 શે̋ ડ̬ગ: સેલના પૃˤભૂ̌ મ રંગ બદલવા માટે Fill Color ̍વકˍનાે ઉપયાેગ કરાે. 

3. લખાણ ગાેઠવણ (Text Alignment) 

 હાે̋ રઝાɰેલ અને વ̋ટ̭કલ ગાેઠવણ: લખાણને ડાબી, જમણી, કે મɪમાં ગાેઠવવા માટે Alignment 
̍વકˍનાે ઉપયાગે કરાે. 

 ટેȌ રાેટેશન: લખાણને ફેરવવા માટે Orientation ̍વકˍનાે ઉપયાેગ કરા.ે 

 Wrap Text: લાંબા લખાણને સેલની અદંર ગાેઠવવા માટે Wrap Text ̍વકˍ પસંદ કરાે. 

4. નંબર ફાેમ̳̋ટ̬ગ (Number Formatting) 

 સામાʈ નંબર ફાેમ̳ટ: ડેટાન ે̍વ̍વધ ફામે̳ટમાં દશાƙવવા માટે Number ǁુપનાે ઉપયાેગ કરાે. 
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 કરʉી અને ટકા: મૂˑ ને કરʉી અથવા ટકા ͅપે ફાેમ̳ટ કરવા માટે Currency અને Percentage 
̍વકˍ પસંદ કરાે. 

 ડેસીમલ પાેઇɰ: ડેસીમલની સંȕા વધારવા અથવા ઘટાડવા માટે Increase Decimal અને 
Decrease Decimal બટનનાે ઉપયાેગ કરાે. 

5. તારીખ અને સમયનું ફાેમ̳̋ ટ̬ગ (Date and Time Formatting) 

 તારીખ ફાેમ̳ટ: તારીખને ̍વ̍વધ શૈલીઅાેમાં દશાƙવવા માટે Short Date અથવા Long Date ̍વકˍ 
પસંદ કરાે. 

 ક˶મ ફાેમ̳ટ: Format Cells ડાયલાેગ બાȋેનાે ઉપયાેગ કરીને ક˶મ તારીખ અથવા સમય ફાેમ̳ટ 
બનાવાે. 

6. ટેબલ ફાેમ̳̋ટ̬ગ (Table Formatting) 

 Excel ટેબલ શૈલીઅાે: ડેટાને ટેબલમાં ͅપાંત̋રત કરવા માટે Format as Table ̍વકˍનાે ઉપયાેગ 
કરાે. 

 ˶ાયલ પસંદ કરવી: Excel ̍વ̍વધ ̌ǐ-̋ડફાઇɱ ટેબલ શૈલીઅાે ǐદાન કરે છે, જ ે ડેટાને વધુ 
˗ાવસા̍યક બનાવે છે. 

7. Ǘેણી અને AutoFormat (Range and AutoFormat) 

 Ǘેણી ફાેમ̳̋ટ̬ગ: પસંદ કરેલી Ǘેણી માટે અાકાર અને રંગ બદલાે. 

 AutoFormat: Excel માં તૈયાર ફાેમ̳ટ શૈલીઅાેનાે ઉપયાગે કરીને ડેટાને ઝડપી રીતે ફાેમ̳ટ કરાે. 

8. ફાેમ̳ટ પેઇɰર (Format Painter) 

 ફાેમ̳ટ નકલ કરવી: અેક સેલના ફાેમ̳ટને બી̀ સેલ પર લાગુ કરવા માટે Format Painter ટૂલનાે 
ઉપયાેગ કરાે. 

Excel 2019 માં વકƙશીટ ડેટાનું ફાેમ̳̋ટ̬ગ માǋ ડેટાને અાકષƙક નથી બનાવતંુ પરંતુ તેને વધુ ઉપયાેગી અને પૃથક 
પણ બનાવે છે. ફાેમ̳̋ટ̬ગ ટૂ˔નાે ઉપયાેગ કરીને, તમે ડેટાને ǐƺતતુ કરવા માટે વધુ ˗ાવસા̍યક અ̑ભગમ 
અપનાવી શકાે છા.ે 

4.5 રાે અને કાૅલમ ઉમેરવી અને દૂર કરવી (Inserting and Deleting Rows and 
Columns) 

Microsoft Excel 2019 માં રાે (Rows) અને કાૅલમ (Columns) ઉમેરવા અને દૂર કરવા અે વકƙશીટમાં ડેટાન ે
ગાેઠવવા અને સંચા̏લત કરવા માટેની મહɗપણૂƙ ǐ̋ƿયા છે. Microsoft Excel 2019, અા કામગીરી માટે સરળ 
અને ઝડપી ̍વકˍાે ǐદાન કરે છે. 

પં̘Ǹઅાે ઉમેરવી (Inserting Rows) 

 Excel માં નવી પં̘Ǹ ઉમેરવા માટે: 
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1. જનેી ઉપર નવી રા ેઉમેરવી છે તે રાે ની ઉપર સેલ અથવા રા ેપસંદ કરાે. 

2. Home ટેબ → Insert → Insert Sheet Rows ̍વકˍ પસંદ કરાે. 

 

3. નવી ખાલી રા ેઉમેરાશ.ે 

 શાેટƙકટ: 

o Ctrl + Shift + + દબાવીને પં̘Ǹ ઉમેરાે. 

કાૅલમ ઉમેરવી (Inserting Columns) 

 Excel માં નવી કાૅલમ ઉમરેવા માટે: 

1. જનેી બાજુ નવી કાૅલમ ઉમેરવી છે તે કાૅલમની ડાબી બાજુ સેલ અથવા કાૅલમ પસદં કરાે. 

2. ઉપરની અાકૃ̍તમાં દશાƙ̠ ા ǐમાણે Home ટેબ → Insert → Insert Sheet Columns 
̍વકˍ પસંદ કરાે. 

3. નવંુ ખાલી કાૅલમ ઉમેરાશે. 

 શાેટƙકટ: 

o Ctrl + Shift + + દબાવીને કાૅલમ ઉમેરા.ે 

રા ેદૂર કરવી (Deleting Rows) 

 Excel માં પં̘Ǹ દૂર કરવા માટે: 

1. જ ેરાે તમે દૂર કરવા માંગા ેછાે તે રાે પસંદ કરાે. 

2. Home ટેબ → Delete → Delete Sheet Rows ̍વકˍ પસંદ કરાે. 
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3. પસંદ કરેલી પં̘Ǹ દૂર કરવામાં અાવશ.ે 

 શાેટƙકટ: 

o Ctrl + - દબાવીને પં̘Ǹ દૂર કરાે. 

કાૅલમ દૂર કરવી (Deleting Columns) 

 Excel માં કાૅલમ દૂર કરવા માટે: 

1. તે કાૅલમ પસંદ કરાે જનેી તમે દૂર કરવા માંગાે છાે. 

2. ઉપરની અાકૃ̍તમાં દશાƙ̠ ા ǐમાણ ેHome ટેબ → Delete → Delete Sheet Columns 
̍વકˍ પસંદ કરાે. 

3. પસંદ કરેલું કાૅલમ દૂર કરવામાં અાવશે. 

 શાેટƙકટ: 

o Ctrl + - દબાવીને કાૅલમ દૂર કરાે. 

રા ેઅને કાૅલમનું અાેટાે અેડજ˶ (Auto Adjustment) 

 Row Height: પં̘Ǹની ઊચંાઈ ગાેઠવવા માટે, Home ટેબમાં અાવેલ Cells કમાંડ ǁુપમાં અાવેલ 
Format → Row Height ̍વકˍ પસંદ કરાે. 
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 Column Width: કાલૅમની પહાળેાઈ ગાઠેવવા માટે, Home ટેબમાં અાવેલ Cells કમાંડ ǁુપમા ં
અાવેલ Format → Column Width ̍વકˍ પસંદ કરાે. 

 AutoFit: પં̘ Ǹઅાે અને કાલૅમને તેમના ડેટા ǐમાણે ગાેઠવવા માટે AutoFit ̍ વકˍના ેઉપયાેગ કરા.ે 

ડેટાને ખસેડવંુ (Moving Rows and Columns) 

 Drag and Drop: માઉસનાે ઉપયાેગ કરીને પં̘ Ǹઅાે અથવા કાૅલમને ખસેડાે. 

 Cut and Paste: Ctrl + X નાે ઉપયાેગ કરીને ડેટાને કાપાે અન ેCtrl + V ના ેઉપયાેગ કરીને નવી 
જƝયાઅે પે˶ કરાે. 

યાદ રાખાે: 

 Multiple Rows/Columns: અેક સાથે અનેક રાે અથવા કાૅલમ ઉમેરવા અથવા દૂર કરવા માટે, ત ે
રા ેઅથવા કાૅલમને પસંદ કરા.ે 

 Undo: ભલૂથી રાે અથવા કાલૅમ દૂર થઈ ̀ય તા ેCtrl + Z નાે ઉપયાેગ કરા.ે 

Excel 2019 માં રાે અને કાૅલમ ઉમેરવી અને દૂર કરવી સરળ છે, જ ેવકƙશીટને વધુ કાયƙƖમ અને ગાેઠવાયેલ 
બનાવવામાં મદદ કરે છે. અા પગલાંઅાેનાે ઉપયાેગ કરીને તમે તમારી વકƙશીટમાં જ̋ͅરયાત મજુબ ફેરફાર કરી 
શકાે છાે. 
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4.6 સેલની ઊંચાઈ અને પહાેળાઈ બદલવી (Changing Cell Height and Width) 

Microsoft Excel 2019 માં સેલની ઊંચાઈ (Row Height) અને પહાેળાઈ (Column Width) બદલવંુ અ ે
ડેટાને વધુ સારી રીતે ગાેઠવવા માટેની મહɗપૂણƙ ǐ̋ƿયા છે. અા ǐ̋ƿયા ડેટાન ેવાંચવા માટે સરળ બનાવે છે 
અને વકƙશીટના લેઅાઉટને વધુ ˗વ̗˺ત બનાવે છે. 

રાનેી ઊંચાઈ બદલવી (Changing Row Height) 

 મʈેુનાે ઉપયાેગ કરીને: 

1. જનેી ઊંચાઈ બદલવી છે તે અેક અથવા અેક કરતા વધુ રાે પસંદ કરાે. 

2. અગાઉ જણા˗ા મુજબ Home ટેબ → Format → Row Height પસંદ કરાે. 

3. પસંદ કરેલી રાે માટે ઇ̗Ȟત ઊંચાઈ દાખલ કરાે અને OK ̚ȃક કરા.ે 

 

 માઉસનાે ઉપયાેગ કરીન:ે 

o રાે  નંબરના બાજુમા ંલાઇન પર માઉસ લાવાે. 

o કસƙર ડબલ હેડેડ તીરમાં  ફેરવાય છે. 

o લાઇનને ઉપર અથવા નીચે ખ̲ચીને ઊંચાઈ બદલાે. 

 AutoFit Row Height: 

o લખાણની ઊંચાઈ ǐમાણ ે પં̘ Ǹ ગાેઠવવા માટે Format → AutoFit Row Height 
̍વકˍનાે ઉપયાગે કરાે. 

કાૅલમની પહાેળાઈ બદલવી (Changing Column Width) 

 મʈેુનાે ઉપયાેગ કરીને: 

1. જનેી પહાેળાઈ બદલવી છે તે અેક અથવા વધુ કાૅલમ પસંદ કરાે. 

2. Home ટેબ → Format → Column Width પસદં કરાે. 
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3. પસંદ કરેલી કાૅલમ માટે ઇ̗Ȟત પહાેળાઈ દાખલ કરાે અન ેOK ̚ȃક કરાે. 

 માઉસનાે ઉપયાેગ કરીન:ે 

o કાૅલમ હેડર વȝેની લાઇન પર માઉસ લાવાે. 

o કસƙર ડબલ હેડેડ તીરમાં  ફેરવાય છે. 

o લાઇનને ડાબી અથવા જમણી તરફ ખ̲ચીને પહાળેાઈ બદલાે. 

 AutoFit Column Width: 

o ડેટાની લંબાઈ ǐમાણ ે કાૅલમ ગાેઠવવા માટે Format → AutoFit Column Width 
̍વકˍનાે ઉપયાગે કરાે. 

અેક કરતા વધુ રાે અને કાૅલમ માટે ફેરફાર (Adjusting Multiple Rows and Columns) 

 અેક સાથે અનકે પં̘Ǹઅાે અથવા કાૅલʼ પસંદ કરાે. 

 ઉપરાેǸ મʈુે અથવા માઉસ પɡ̍તઅાેનાે ઉપયાેગ કરીને બધા માટે ઊંચાઈ અથવા પહાેળાઈ બદલાે. 

̋ડફાૅ˄  માપ પર પાછા જવંુ (Reset to Default Size) 

 પં̘ Ǹઅા ેમાટે: પં̘Ǹઅાેને 15 પાેઇɰ ઊંચાઈ પર રીસેટ કરવા માટે, Format → Row Height → 
15 દાખલ કરાે. 

 કાૅલʼ માટે: કાૅલʼને 8.43 પાેઇɰ પહાેળાઈ પર રીસેટ કરવા માટે, Format → Column Width 
→ 8.43 દાખલ કરાે. 

યાદ રાખાે: 

 Wrap Text:  ̀ે લખાણ લાંબું હાયે અને ફીટ ન થતું હાેય, તા ેWrap Text ̍વકˍનાે ઉપયાેગ કરાે. 

 Shortcut Keys: AutoFit માટે ડબલ ̚ȃક કરાે અથવા Alt + H + O + I નાે ઉપયાેગ કરાે. 

 Consistency: દરેક પં̘ Ǹ અને કાૅલમ માટે સમાન માપ રાખવા માટે તે બધા પસંદ કરા ેઅને અેક જ 
માપ દાખલ કરાે. 

Excel 2019 માં સેલની ઊંચાઈ અને પહાેળાઈ બદલવાની અા પɡ̍તઅાે ડેટાને વધુ ગાેઠવાયેલ અન ે̠ વ̗˺ત 
બનાવે છે, જ ેડેટાની ǐƺતુ̍ તને વધુ ˗ાવસા̍યક બનાવે છે. 
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4.7 કટ, કાેપી, પે˶ અને સેલ મૂવ કરવું (Cut, Copy, Paste and Move Cell 
Value) 

Microsoft Excel 2019 માં કટ (Cut), કાેપી (Copy), પે˶ (Paste) અને સેલ મૂવ (Move) કરવી અે ડેટાને 
ગાેઠવવા અને સંચા̏લત કરવા માટેની મહɗપણૂƙ ǐ̋ƿયા છે. અા ટૂ˔નાે ઉપયાેગ કરીને તમે ડેટાને ઝડપથી 
અને સરળતાથી મેનેજ કરી શકાે છાે. 

કટ કરવું (Cut Cell Value) 

 સેલના  લખાણને અેક જƝયાથી બી͂ જƝયાઅે ખસેડવા માટે કટ ટૂલનાે ઉપયાેગ થાય છે. 

 પɡ̍ત: 

o જ ેસેલ અથવા Ǘેણી ખસેડવી છે, તેને પસંદ કરાે. 

o Ctrl + X દબાવાે અથવા Home ટેબ → Cut ̍વકˍ પસંદ કરાે. 

o સેલ ખસેડવા માટે નવી જƝયાઅે ̚ȃક કરાે અને Ctrl + V દબાવાે અથવા Paste ̍વકˍ પસંદ 
કરાે. 

કાેપી કરવું (Copy Cell Value) 

 સેલની મૂˑને નકલ કરવા માટે કાેપી ટૂલનાે ઉપયાેગ થાય છે. 

 પɡ̍ત: 

o જ ેસેલ અથવા Ǘેણી નકલ કરવી છે, તેને પસંદ કરાે. 
o Ctrl + C દબાવાે અથવા Home ટેબ → Copy ̍વકˍ પસંદ કરાે. 
o નકલ કરેલી મૂˑને પે˶ કરવા માટે નવી જƝયાઅે ̚ȃક કરાે અને Ctrl + V દબાવાે. 

પે˶ કરવું (Paste Cell Value) 

 કટ અથવા કાેપી કરેલી મૂˑને પસંદ કરેલી જƝયાઅે મૂકવા માટે પે˶ ટૂલનાે ઉપયાેગ થાય છે. 

 પે˶ ̍વકˍાે: 
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o Paste: મૂળ મૂˑ અન ેફાેમ̳ટ સાથે પે˶ કરે છે. 

o Paste Values: ફǸ મૂˑ પે˶ કરે છે. 

o Paste Formatting: ફǸ ફાેમ̳̋ટ̬ગ પે˶ કરે છે. 

o Transpose: પં̘Ǹઅાેને કાલૅમમા ંઅથવા કાૅલમને પં̘Ǹઅાેમા ંͅપાંત̋રત કરે છે. 

 Shortcut Key: 

o Ctrl + V પે˶ માટે. 

સેલ મૂવ કરવંુ (Move Cell Value) 

 માઉસ ɦારા ખસેડવંુ: 

1. જ ેસલે ખસેડવી છે, તેને પસંદ કરાે. 

2. માઉસથી સેલની બાેડƙર પર ̚ȃક કરીન ેતેને ખ̲ચાે અને નવી જƝયાઅે મૂકાે. 

 કટ અને પે˶ ɦારા: 

1. Ctrl + X નાે ઉપયાેગ કરીને સેલ કટ કરાે. 

2. Ctrl + V નાે ઉપયાેગ કરીને નવી જƝયાઅે પે˶ કરા.ે 

અેક કરતા વધુ સે̝  માટે કટ, કાપેી અને પે˶ 
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 અેક સાથે અનકે સે˔ અથવા Ǘેણી પસંદ કરાે. 

 ઉપરાેǸ પɡ̍તઅાેનાે ઉપયાગે કરીને બધા સે˔ પર ǐ̋ƿયા કરાે. 

Undo અને Redo (ભૂલ સુધારવા માટે) 

 Undo: ભૂલથી કટ, કાેપી, અથવા પે˶ થઈ ̀ય તાે Ctrl + Z નાે ઉપયાેગ કરાે. 

 Redo: પાછંુ લાવવા માટે Ctrl + Y નાે ઉપયાેગ કરાે. 

યાદ રાખાે: 

 Quick Access Toolbar: Cut, Copy, અને Paste ટૂલબારમાં ઉમેરાે જેથી તે ઝડપી ઉપલʤ રહે. 

 Keyboard Efficiency: શાેટƙકટ કીઝનાે ઉપયાેગ કાયƙƖમતા વધારવામાં મદદ કરે છે. 

 Paste Special: Ctrl + Alt + V નાે ઉપયાેગ કરીને પે˶ માટે વધુ ̍વકˍાે પસંદ કરાે. 

Excel 2019 માં કટ, કાેપી, પે˶ અને મૂવ ટૂ˔ ડેટાને ગાેઠવવા અને ગ̍તશીલ બનાવવા માટે અɔંત ઉપયાેગી 
છે. અા ટૂ˔નાે યાેƝય ઉપયાેગ ડેટા સંચાલનને વધુ કાયƙƖમ બનાવે છે. 

 

 

5. ફાેy ુƙલા અન ેફંȆʉ (Microsoft Excel 2019) 

Microsoft Excel 2019 માં ફાેʸુƙલા અને ફંȆʉનાે ઉપયાેગ ડેટાને ગણતરી કરવા, ̍વƸલેષણ કરવા અન ે
સંચા̏લત કરવા માટે થાય છે. ફાેʸુƙલા અે કાેઈ સǋૂ મુજબની ગણતરી છે ȱારે ફંȆʉ અે અગાઉથી તૈયાર  
કરેલ ઉપયાેગમાં લઇ શકાય તેવી  (ǐી-̋ડફાઇનડ) ગણતરીઅાે છે. 

ફાેʸુƙલા શંુ છે? 

 Excel માં ફાેy ુƙલા અે ગણતરી કરવા માટેના ̏નયમાે અથવા સૂચનાઅાે છે. 

 ફાેʸુƙલા હંમેશા = ̎ચ̆થી શͅ થાય છે. 

ફાેʸુƙલા લખવાની પɡ̍ત: 

 જ ેસેલમાં ગણતરી કરવી હાેય તે સેલ પસંદ કરાે. 
 = ટાઇપ કરાે, પછી ગણતરી દાખલ કરાે (જમે કે =A1+B1). 
 Enter દબાવાે. 

ઉદાહરણ: 

 બે સેલની ̋ક̬મત ઉમેરવા માટે: =A1+B1 

 બે સેલની ̋ક̬મતના ભાગાકાર માટે: =A1/B1 
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ફંȆન શું છે? 

 Excel માં ફંȆʉ અે ǐી-̋ડફાઇનડ ફાેʸુƙલા છે જ ેચાેǲસ કાયƙ માટે ̋ડઝાઇન કરવામાં અા˗ા છે. 
 ફંȆનનંુ ̄ͅપ છે: =FunctionName(arguments) 

ફંȆન દાખલ કરવી: 

 જ ેસેલમાં ગણતરી કરવી હાેય તે સેલ પસંદ કરાે. 
 = ટાઇપ કરાે અને ફંȆનનું નામ લખાે (જમે કે =SUM). 
 કા̵સમાં અાƝયુƙમેɰ્સ દાખલ કરાે (જમે કે =SUM(A1:A5)). 
 Enter દબાવાે. 

કેટલાક સામાʈ ફંȆʉ (Common Functions) 

 SUM: અા ફંȆન નંબરનાે સરવાળાે કરે છે. ઉદાહરણ: =SUM(A1:A5) 

 AVERAGE: અા ફંȆન સરેરાશ શાેધે છે. ઉદાહરણ: =AVERAGE(A1:A5) 

 IF: શરત અાધા̋રત પ̋રણામ માટે. ઉદાહરણ: =IF(A1>10, "High", "Low") 

 VLOOKUP: ̍વ̏શˠ મૂˑ શાેધવા માટે. ઉદાહરણ: =VLOOKUP(101, A1:B10, 2, FALSE) 

 CONCATENATE (અથવા CONCAT): લખાણ ̀ેડવા માટે. ઉદાહરણ: =CONCAT(A1, " ", B1) 

ફંȆન ઇʉટƙર ટૂલ (Function Inserter Tool) 

 Formulas ટેબનાે ઉપયાેગ: 

o Formulas ટેબ → Insert Function ̍વકˍનાે ઉપયાેગ કરાે. 
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o ફંȆન શાેધાે અને દાખલ કરાે. 

 AutoComplete:  = લખતા જ ફંȆનના નામ સૂચવવામાં અાવે છે. 

ફાેʸુƙલા અને ફંȆʉના ઉપયાગે માટે સૂચના:ે 

 સેલ રેફરʉ: ફાેʸુƙલામાં સીધા સેલ રેફરʉનાે ઉપયાેગ કરાે (જમે કે =A1+B1) જથેી ડેટા બદલાતા 
પ̋રણામ અાપમેળે અપડેટ થાય. 

 રેલે̋ ટવ અન ેઅેʪાેˑ ુટ રેફરʉ: રેલે̋ ટવ: A1, અʪેાેˑ ુટ: $A$1 

 Error Checking: ̀ે ફાેy ુƙલા ખાેટંુ હાેય, તાે Excel ભૂલ સદંેશ દશાƙવે છે (જેમ કે #DIV/0!). 

ઉદાહરણ: 

 અેક વકƙશીટમાં મયાƙ̋દત ડેટા માટે સરવાળા ેઅને સરેરાશ શાેધવા: 

o =SUM(A1:A10) 

o =AVERAGE(A1:A10) 

Excel 2019 માં ફાેʸુƙલા અને ફંȆʉનાે ઉપયાેગ ડેટાને ઝડપી અને કાયƙƖમ રીતે સંચા̏લત કરવામાં મદદ 
કરે છે. અા સુ̍ વધાઅાે તમને ગણતરીઅાેને સરળ અન ેગાઠેવાયેલ બનાવે છે. 

5.1 ફાેy ુƙલાનાે ઉપયાગે (Using Formula) 
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Microsoft Excel 2019 માં ફાેy ુƙલાનાે ઉપયાેગ ડેટાને ઝડપી અને સચાેટ રીતે ગણતરી કરવા માટે થાય છે. 
Excel માં ફાેʸુƙલા અે ખાસ સૂચનાઅાે છે જનેાે ઉપયાેગ ̍વ̍વધ ǐકારની ગણતરીઅા ેમાટે થાય છે, જમે કે 
સરવાળાે, બાદબાકી, ગણુાકાર, ̍વભાજન, અને વધુ. 

Excel માં ફાેʸુƙલાનું મહɗ 

 Excel ફાેʸુƙલા ડેટાને અાૅટાેમે̋ટક રીતે અપડેટ કરવા માટે ઉપયાેગી છે. 

 ફાેʸુƙલા ɦારા ગણતરીઅાે ઝડપથી કરી શકાય છે. 

 ડેટા બદલાય ɔારે પ̋રણામ અાપમેળે બદલાય છે. 

ફાેʸુƙલા કેવી રીતે લખવી (How to Write a Formula) 

 ̏નયમ: Excel માં ફાેʸુƙલા હંમેશા = ̎ચ̆થી શͅ થાય છે. 

 પɡ̍ત: 

o જ ેસેલમાં ગણતરી કરવી હાેય તે સેલ પસંદ કરાે. 
o = લખાે અને તે પછી ગણતરી દાખલ કરાે. 
o ઉદાહરણ: 

 સરવાળા માટે: =A1+B1 
 બાદબાકી માટે: =A1-B1 
 ગુણાકાર માટે: =A1*B1 
 ભાગાકાર માટે: =A1/B1 

o Enter દબાવાે. 

સેલ રેફરʉનાે ઉપયાેગ (Using Cell References) 

 રેલે̋ટવ રેફરʉ: ઉદાહરણ: =A1+B1, રેલે̋ટવ રેફરʉનાે અથƙ છે કે ફાેʸુƙલા કાેપી કરવાથી સેલ 
રેફરʉ બદલાશે. 

 અʪેાેˑ ુટ રેફરʉ: ઉદાહરણ: =$A$1+$B$1, અʪેાેˑ ુટ રેફરʉનાે અથƙ છે કે ફાેʸુƙલા કાેપી 
કરવાથી સેલ રેફરʉ બદલાશે નહ̯. 

 ̍મǗ રેફરʉ: ઉદાહરણ: =A$1+$B1 

4. સામાʈ ફાેy ુƙલાના ઉદાહરણાે (Common Formula Examples) 

 કુલ ઉમેરવું: =A1+A2+A3 

 સરેરાશ શાેધવી: =(A1+A2+A3)/3 

 લખાણ ̀ેડવું: =A1 & " " & B1 

 ̍વ̐શˠ શરત માટે પ̋રણામ: =IF(A1>10, "Pass", "Fail") 

AutoFill સાથે ફાેʸુƙલા ઉપયાેગ કરવુ ં
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 ફાેʸુƙલાને નીચેના સે˔માં કાેપી કરવા માટે AutoFill નાે ઉપયાેગ કરાે. 

 ફાેʸુƙલા દાખલ કયાƙ પછી, સલેના ખૂણેથી ǉેગ કરાે. 

ફાેʸુƙલાના શાેટƙકટ્સ 

 ફાેʸુƙલા લખવા માટે: = ટાઇપ કરાે અને ફાેʸુƙલા દાખલ કરાે. 

 AutoSum: Alt + = દબાવીને ઝડપી રીતે સરવાળાે શાેધાે. 

ભૂલ સુધારવા માટે ̋ટƯસ (Error Checking) 

 #DIV/0!: ̍વભાજન માટેના ̋ડવાઇડરમાં શૂʈ છે. 

 #VALUE!: ફાેʸુƙલામાં અસગંત મૂˑ છે. 

 Solution: Formulas ટેબ → Error Checking ટૂલનાે ઉપયાેગ કરાે. 

8. ઉદાહરણ: 

 સરવાળાે: =SUM(A1:A10) 

 શરત અાધા̋રત ફાેʸુƙલા: =IF(B1>50, "Pass", "Fail") 

 ગણતરી માટે: =(A1*B1)/C1 

Excel 2019 માં ફાેʸુƙલાનાે યાેƝય ઉપયાેગ ડેટાને ઝડપી, કાયƙƖમ અને સચાેટ રીતે સંચા̏લત કરવામાં મદદ કરે 
છે. ફાેʸુƙલા અે Excel ના મજબૂત ̍વશેષતામાંથી અેક છે જેનાે ઉપયાેગ દરેક ǐકારની ગણતરી માટે થઈ શકે 
છે. 

5.2 ̍વ̍વધ ફંȆʉનાે ઉપયાેગ 

માઇƿાેસાેʘ અȋેેલ 2019 અે ડેટા મેનેજમેɰ અને ̍વƸલેષણ માટે અેક શ̘Ǹશાળી ટૂલ છે. અેȋેલમા ં
̍વ̍વધ ફંȆʉનાે ઉપયાેગ કરીને તમે ડેટા ǐાેસે̐ સ̬ગ સરળ બનાવી શકાે છાે અને ઝડપથી યાેƝય પ̋રણામ 
મેળવી શકાે છાે. અહ̯ અȋેેલના કેટલાક મહɗપૂણƙ ફંȆʉની ̍વગતાે છે અને તે કેવી રીતે ઉપયાેગી છે 
તેની સમજ અાપવામાં અાવી છે. 

1. SUM (સȕંા ઉમેરવી) 

 ઉપયાેગ: અા ફંȆનનાે ઉપયાેગ અેકસાથે ઘણા નંબસƙ ઉમેરવા માટે થાય છે. 

 Syntax: =SUM(A1:A10) 

 ઉદાહરણ: ̀ે તમારે સેલ A1 થી A10 સુધીની નંબરાેનાે સરવાળાે કરવાે હાેય, તાે =SUM(A1:A10) 
ટાઇપ કરા.ે 

2. AVERAGE (સરેરાશ) 

 ઉપયાેગ: અા ફંȆન સરેરાશ મૂˑ શાેધવા માટે ઉપયાેગી છે. 
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 Syntax: =AVERAGE(A1:A10) 

 ઉદાહરણ: ̀ે તમારે 10 મૂ̊ાેની સરેરાશ મેળવવી હાેય, તાે અા ફંȆનનાે ઉપયાેગ કરાે. 

3. IF (શરતી લાે̏જક) 

 ઉપયાેગ: શરતના અાધાર પર પ̋રણામ અાપતા ફંȆન માટે. 

 Syntax: =IF(LOGICAL_TEST, VALUE_IF_TRUE, VALUE_IF_FALSE) 

 ઉદાહરણ: =IF(A1>50, "PASS", "FAIL") જણાવે છે કે A1નંુ મૂˑ 50 કરતાં વધારે છે તાે "PASS" 
દશાƙવશે, ન̋હતર "FAIL". 

4. VLOOKUP (વ̋ટ̭કલ લુકઅપ) 

 ઉપયાેગ: ટેબલમાથંી ડેટા શાધેવા માટે ઉપયાેગી. 

 Syntax: =VLOOKUP(LOOKUP_VALUE, TABLE_ARRAY, COLUMN_INDEX, 
[RANGE_LOOKUP]) 

 ઉદાહરણ: ̀ે તમારે અેક ટેબલમાંથી ચાેǲસ મૂˑ શાેધવું હાેય, તાે અા ફંȆન વાપરાે. 

5. CONCATENATE (લખાણ ̀ેડવું) 

 ઉપયાેગ: બંને લખાણને ̀ેડવા માટે. 

 Syntax: =CONCATENATE(TEXT1, TEXT2) 

 ઉદાહરણ: =CONCATENATE("Hello", " World") પ̋રણામે "Hello World" થશે. 

6. NOW (વતƙમાન તારીખ અને સમય) 

 ઉપયાેગ: વતƙમાન તારીખ અને સમય દશાƙવવા માટે. 

 Syntax: =NOW() 

 ઉદાહરણ: અા ફંȆન વાપરવાથી સેલમાં વતƙમાન તારીખ અને સમય દેખાશ.ે 

7. LEN (લખાણની લંબાઈ) 

 ઉપયાેગ: કાેઈ લખાણમાં અƖરાેની સȕંા શાેધવા માટે. 

 Syntax: =LEN(TEXT) 

 ઉદાહરણ: =LEN("Excel") પ̋રણામે 5 અાવશ.ે 

8. LEFT અને RIGHT (લખાણના ભાગાે કાઢવા) 

 LEFT: લખાણના શͅના અƖરાે અાપે છે. 

 Syntax: =LEFT(TEXT, NUM_CHARS) 
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 RIGHT: લખાણના અંતના અƖરાે અાપે છે. 
Syntax: =RIGHT(TEXT, NUM_CHARS) 

 ઉદાહરણ: =LEFT("Excel", 2) પ̋રણામે "Ex" અાવશે અને =RIGHT("Excel", 2) પ̋રણામે "el" 
અાવશે. 

ઉપયાેગી સૂચના:ે 

1. ફંȆʉ લખતી વખત ેતેમની યાેƝય ǐમાણભતૂ રચનાના ેઉપયાેગ કરાે. 

2. શાેટƙકટ કી અને ફાેy ુƙલાના ̍વકˍાેથી કામ ઝડપથી કરાે. 

3. ડેટાના ̏નમાƙણ અને ̍વƸલેષણ માટે ̍વ̍વધ ફંȆʉની સાથે ̋ફ˄ર અને સાેટƙ ̍વકˍાેનાે ઉપયાેગ 
કરાે. 

માઇƿાેસાʘે અȋેેલમા ં અા ફંȆʉનાે ઉપયાેગ કરી તમે તમારા કાયƙને વધુ કાયƙƖમ અને અસરકારક 
બનાવી શકાે છાે. 

6. ચાટ્ƙસ  (Charts) 

માઇƿાેસાʘે અેȋેલ 2019 અે ડેટાને સમજવામાં વધ ુસરળ બનાવવા માટે ચાટ્ƙસ બનાવવાની સુ̍વધા અાપ ે
છે. ચાટ્ƙસનાે ઉપયાેગ તમે તમારા ડેટાને ̎ચǋ ̄ͅપ ેરજૂ કરવા માટે કરી શકાે છાે, જનેાથી ડેટાનાે અથƙ ઝડપથી 
સમ̀વી શકાય છે. 

ચાટƙ શંુ છે? 

ચાટƙ અે ǁા̋ફકલ ǐદશƙન છે જનેાથી ડેટા ̍વƸલેષણ વધુ સરળ બને છે. તે ડેટાની તલુના, વલણ અને ̄ͅપને 
˾ˠ રીતે દશાƙવવા માટે ઉપયાેગી છે. 

ચાટƙ ǐકારા ે

માઇƿાેસાʘે અȋેેલમા ંInsert ટેબમાં અાવેલ Charts ǁુપમાં ̍વ̍વધ ǐકારના ચાટƙ ઉપલʤ છે.  જ ેનીચે 
દશાƙ˗ા છે: 

 

1. કાેલમ ચાટƙ (Column Chart) 

 ઉપયાેગ: Ǘેણીબɡ ડેટાની તલુના કરવા માટે. 

 ઉદાહરણ: દરેક મ̋હનામાં થયેલ વેચાણની સરખામણી માટે અા ચાટƙ ઉપયાેગી છે. 

 ǐકાર: 2D કાેલમ, 3D કાેલમ. 
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2. લાઇન ચાટƙ (Line Chart) 

 ઉપયાેગ: ̏ન̏˛ત સમયગાળા દર̌મયાન ડેટાના વલણ દશાƙવવા માટે. 

 ઉદાહરણ: 12 મ̋હના દર̌મયાન કમાણીમાં ફેરફારા ેદશાƙવવંુ. 

3. પાઈ ચાટƙ (Pie Chart) 

 ઉપયાેગ: કુલમાં અલગ-અલગ ઘટકાેના ǐɔેક ભાગનંુ ǐ̍ત̏ન̍ધɗ કરવા માટે. 

 ઉદાહરણ: બજટેમાં ̍વ̍વધ ખચા̳ની વાટાઘાટ દશાƙવવી. 

4. બાર ચાટƙ (Bar Chart) 

 ઉપયાેગ: ડેટાની તુલનાન ેઅાડા ǍƸયͅપે રજૂ કરવું. 

 ઉદાહરણ: ̍વ̍વધ ǐાેડǶ્સનું વેચાણ દશાƙવવંુ. 

5. અેરીયા ચાટƙ (Area Chart) 

 ઉપયાેગ: લાઇન ચાટƙ જવેા જ છે, પરંતુ અ ેડેટાના કુલ ǐમાણને વધુ ˾ˠ રીતે દશાƙવે છે. 

 ઉદાહરણ: વા̍ષ̭ક વેચાણમાં વૃ̏ ɡ દશાƙવવી. 

6. ˱ેટર ચાટƙ (Scatter Chart) 

 ઉપયાેગ: બંને અƖ પરના ડેટા વȝેના સંબંધ દશાƙવવાે. 

 ઉદાહરણ: ઉંચાઈ અને વજન વȝેના સંબંધની તપાસ કરવી. 

ચાટƙ બનાવવાની રીત 

1. ડેટા પસંદ કરા:ે ચાટƙ માટે જͅરી ડેટાને ̐સલેǶ કરા.ે 

2. ઇʉટƙ ટેબ પર ̚ȃક કરા:ે ̋રબન મેનમુાં "Insert" ટેબ પર ̀અાે. 

3. ચાટƙ પસંદ કરાે: "Charts" ̍વભાગમાથંી તમારી જ̋ͅરયાત અનસુાર ચાટƙ પસંદ કરાે. 

4. ̋ડઝાઇનમાં ફેરફાર કરા:ે ચાટƙ પસંદ કયાƙ બાદ, તેન ેવધુ અાકષƙક બનાવવા માટે "Chart Design" 
અને “Format” ટેબનાે ઉપયાગે કરાે. 

 

 

ચાટƙ ક˶માઇઝેશન 

1. ચાટƙ ટાઇટલ ઉમેરવંુ: ચાટƙ ટાઇટલમાં ડેટા ̍વશેનું નામ અાપા.ે 
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2. લેબ˔ ઉમેરવી: અે̚ȋસ લેબ˔ ઉમેરવાથી ચાટƙ વધુ ˾ˠ બને છે. 

3. કલસƙ અને ˶ાઇ˔: ચાટƙને અાકષƙક બનાવવા માટે ̍વ̍વધ રંગ અને ̋ડઝાઇન ઉમેરાે. 

4. ડેટા ̐સ̋રઝ ફેરફાર: ડેટા ઉમેરવા અથવા દૂર કરવા માટે "Select Data" ̍વકˍનાે ઉપયાેગ કરાે. 

ચાટ્ƙસના ફાયદા 

 ડેટાને ǍƸય ͅપમાં સરળતાથી સમ̀વી શકાય છે. 

 ડેટાના Ǉેɱ્સ અને પેટʉƙ ઝડપથી અાેળખી શકાય છે. 

 ǐેઝɰેશનમાં ˗ાવસા̍યક દેખાવ મળે છે. 

માઇƿાેસાેʘ અેȋેલ 2019માં ચાટ્ƙસનાે ઉપયાેગ કરવાથી તમે તમા̈́ં ડેટા ǐƺતુ̍ તકરણ વધુ અસરકારક અને 
અાકષƙક બનાવી શકાે છાે. 

6.1 કાેલમ ચાટƙ (Column Chart) 

કાેલમ ચાટƙ અે માઇƿાેસાેʘ અેȋેલમાં ઉપલʤ અેક લાેક̌ǐય અને ઉપયાેગી ǁા̋ફકલ ટૂલ છે. અા ચાટƙના ે
ઉપયાેગ ડેટાની તુલનાને ˾ˠ અને અાકષƙક રીતે ǐƺતુત કરવા માટે થાય છે. કાેલમ ચાટƙમાં ડેટા અાડા (X-
અƖ) અને ઉભા (Y-અƖ) ƺતંભાેમાં રજૂ થાય છે. 

કાેલમ ચાટƙ શંુ છે? 

કાેલમ ચાટƙ ડેટાને ƺતંભાકાર ǁાફ તરીકે દશાƙવે છે, ȱાં દરેક ƺતંભ ડેટાના મૂˑનું ǐ̍ત̏ન̍ધɗ કરે છે. તે 
મુȕɗે તુલનાɒક મા̋હતી દશાƙવવા અને સમયગાળા દર̌મયાનના ફેરફારાેની ચકાસણી માટે ઉપયાેગમા ં
લેવાય છે. 

કાેલમ ચાટƙના ઉપયાેગા ે

1. Ǘેણીબɡ ડેટાની તુલના: અલગ-અલગ કેટેગરીઝ વȝેના ડેટાની તુલના કરવા માટે. 

2. Ǉેɱ્સની અાેળખ: સમયગાળા દર̌મયાન ડેટામાં વધારાે અથવા ઘટાડાે દશાƙવવા માટે. 

3. ǐાǁેેસ Ǉે̋ક̬ગ: ટાગ̳ટ અને અચીવમેɰ વȝેના તફાવત દશાƙવવાે. 

કાેલમ ચાટƙ કેવી રીતે બનાવવાે? 

1. ડેટા પસંદ કરાે: જ ેડેટાને ચાટƙમાં ͅપાંત̋રત કરવી છે તે પસંદ કરાે. 

2. Insert ટેબમાં ̀અાે: ̋રબન મેનુમાં "Insert" ટેબ પર ̚ȃક કરાે. 

3. કાેલમ ચાટƙ પસંદ કરાે: "Charts" ̍વભાગમાં "Column Chart" પર ̚ȃક કરાે. 

4. ̋ડઝાઇન અને ક˶માઇઝ કરાે: ચાટƙના રંગ, શૈલી, અને લેબ˔ને ક˶માઇઝ કરાે. 
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કાેલમ ચાટƙ ક˶માઇઝ કરવા માટે ̍વકˍા ે

1. ચાટƙ ટાઇટલ ઉમેરવંુ: ચાટƙનું નામ ˾ˠ કરવા માટે ટાઇટલ ઉમેરાે. 

2. અે̚ ȋસ લેબ˔: X અને Y અƖમાં ˾ˠ લેબ˔ ઉમેરાે. 

3. ડેટા લેબ˔: દરેક કાેલમના શીષƙ પર ડેટાના મૂˑાે દશાƙવા.ે 

4. રંગાેની પસંદગી: અલગ-અલગ ડેટા Ǘેણી માટે ̍વ̍વધ રંગ પસંદ કરાે. 

કાેલમ ચાટƙના ફાયદા 

 ડેટાની તુલના વધુ સરળ બને છે. 

 ǁા̋ફકલ ǐƺતુ̍ ત ɦારા ડેટાની અસરકારક રજૂઅાત. 

 ડેટાની રજૂઅાતમાં ˗ાવસા̍યક દેખાવ. 

 ડેટાના Ǉેɱ્સ અને પેટʉƙ ઝડપથી અાેળખી શકાય છે. 

ઉદાહરણ:  માનાે કે તમારી પાસ ેનીચેની ડેટા ટેબલ છે: 

મ̋હનાે વેચાણ (ͅ.) 

̀ʈુઅારી 50,000 

ફેǒુઅારી 60,000 

માચƙ 70,000 
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અા ડેટાને કાેલમ ચાટƙમાં રજૂ કરીને, દરેક મ̋હના માટે કુલ વેચાણની તુલનાને ˾ˠ રીતે ̀ેઈ શકાય છે. 

 

માઇƿાેસાેʘ અȋેેલ 2019માં કાેલમ ચાટƙનાે ઉપયાેગ કરીને તમે તમારા ડેટાને વધુ ǍƸયમાન અને સમજવા 
જવેી રીતે રજૂ કરી શકાે છાે. 

6.2 પાઈ ચાટƙ (Pie Chart) 

પાઈ ચાટƙ અે માઇƿાેસાʘે અȋેેલમાં ઉપલʤ અેક લાેક̌ǐય ચાટƙ છે. તે ડેટાના સરવાળામાં અલગ-અલગ 
ઘટકાેનાે ફાળાે (ǐ̍તશત) દશાƙવવા માટે ઉપયાેગમાં લેવાય છે. પાઈ ચાટƙનાે અાકાર વતુƙળ જવેાે હાેય છે, ȱા ં
દરેક ભાગ ડેટાના ǐɔેક અાકંડાના ǐમાણને દશાƙવે છે. 

પાઈ ચાટƙ શંુ છે? 

પાઈ ચાટƙ અે અેક વતુƙળાકાર ચાટƙ છે, જમેાં ǐɔેક ƺલાઇસ (ભાગ) ̍વ̍વધ Ǘેણી અથવા કેટેગરીના સરવાળામા ં
જ ેતે ભાગના ટકા દશાƙવે છે. અા ચાટƙનાે ઉપયાેગ મુȕɗે ડેટાના તુલનાɒક ̍વƸલેષણ માટે થાય છે. 

પાઈ ચાટƙના ઉપયાેગા ે

1. ǐ̍તશત ફાળાે દશાƙવવા:ે કુલ મૂˑમાં દરેક કેટેગરીનાે ̋હ̅ાે દશાƙવવા માટે. 

2. ̐સ̬ગલ Ǘેણી ડેટા ǐદ̏શ̭ત કરવું: અા ચાટƙનાે ઉપયાેગ અેક સમયે માǋ અેક ડેટા Ǘેણી માટે થાય છે. 

3. સાદગીપૂવƙક ડેટા રજૂ કરવંુ: ડેટાની સરળ અને ǍƸયમાન રીતે રજૂઅાત માટે. 

પાઈ ચાટƙ કેવી રીતે બનાવવાે? 

1. ડેટા પસંદ કરાે: જ ેડેટાને પાઈ ચાટƙમાં ͅપાંત̋રત કરવી છે તે ̐સલǶે કરાે. 

2. Insert ટેબ પર ̚ȃક કરા:ે ̋રબન મેનુમાં "Insert" ટેબ પર ̀અાે. 

3. પાઈ ચાટƙ પસંદ કરા:ે "Charts" ̍વભાગમાં "Pie Chart" પર ̚ȃક કરાે. 

4. ̋ડઝાઇન અને ક˶માઇઝ કરાે: ચાટƙને વધુ અાકષƙક બનાવવા માટે રંગાે અને લેબ˔ ઉમેરાે. 
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પાઈ ચાટƙ ક˶માઇઝ કરવા માટેના ̍વકˍા ે

1. ચાટƙ ટાઇટલ ઉમેરવંુ: પાઈ ચાટƙ માટે બરાેબર વણƙનાɒક ટાઇટલ અાપાે. 

2. ડેટા લેબ˔ ઉમેરવંુ: દરેક ƺલાઇસ પર મૂˑ  અથવા ǐ̍તશત દશાƙવા.ે 

3. રંગાેની પસંદગી: દરેક ƺલાઇસ માટે અલગ-અલગ રંગાે પસંદ કરાે. 

4. અેક ƺલાઇસને હાઇલાઇટ કરવંુ: ̀ે કાેઈ ખાસ ƺલાઇસને હાઇલાઇટ કરવી હાેય, તાે તે સાઇડમા ં
ખ̲ચી શકાે છાે. 

ઉદાહરણ: માનાે કે તમારી પાસે નીચનેી ડેટા ટેબલ છે: અા ડેટાને પાઈ ચાટƙમાં રજૂ કરવાથી તમે દરેક કેટેગરીના ે
કુલ ખચƙમાં ફાળાે (ǐ̍તશત) ̀ેઈ શકાે છાે. 

કેટેગરી ખચƙ (ͅ.) 

ભાેજન 30,000 

ǐવાસ 20,000 

મનાેરંજન 10,000 

̏શƖણ 40,000 
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પાઈ ચાટƙના ફાયદા 

 ડેટાનું સરળ અને ઝડપી ǍƸય ǐદશƙન. 

 કુલમાં દરેક ઘટકનાે ફાળાે સરળતાથી દશાƙવવા.ે 

 ˗વસા̍યક ǐેઝɰેશન માટે અાદશƙ. 

 ̍વ̏શˠ ડેટા Ǘેણી માટે ˾ˠતા. 

માઇƿાેસાેʘ અȋેેલ 2019માં પાઈ ચાટƙનાે ઉપયાેગ તમા̈́ં ડેટા ̍ વƸલેષણ વધુ ǍƸયમાન અને અાકષƙક બનાવે 
છે. 

6.3 લાઇન ચાટƙ (Line Chart) 

લાઇન ચાટƙ અે માઇƿાેસાʘે અȋેેલમાં ઉપલʤ અેક મહɗપૂણƙ ǁા̋ફકલ ટૂલ છે, જ ે ડેટામાં સમયગાળા 
દર̌મયાનના Ǉેɱ્સને દશાƙવવા માટે ઉપયાેગી છે. અા ચાટƙ ડેટાને લાઇનના ͅપમાં ǐƺતુત કરે છે, જે બે અƖ (X 
અને Y) વȝેના સંબંધાેને ˾ˠ રીતે દશાƙવે છે. 

લાઇન ચાટƙ શંુ છે? 

લાઇન ચાટƙ અે ડેટાના મૂˑમાં સમયગાળા ǐમાણે કે અʈ ƿમ ǐમાણે થતા ફેરફારાનેે લાઇન ɦારા દશાƙવે છે. 
દરેક ડેટા પાેઈɰ લાઇન ɦારા ̀ેડાયેલ હાેય છે, જ ેડેટાના સતત Ǉેɱને ˾ˠ રીતે દશાƙવે છે. 

લાઇન ચાટƙના ઉપયાેગાે 

1. સમયગાળા દર̍મયાનના Ǉેɱ્સ: લાંબા સમયગાળા દરʸાન ડેટાના વધારાે અથવા ઘટાડાને દશાƙવવા 
માટે. 

2. તુલનાɒક ડેટા ̍વƸલેષણ: બે અથવા વધુ Ǘેણી વȝેના તુલનાɒક ફેરફારાે દશાƙવવા માટે. 

3. અǁંેખા Ǉે̋ક̬ગ: વતƙમાન મૂˑ અને ટાગ̳ટના અવલાેકન માટે. 
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લાઇન ચાટƙ કેવી રીતે બનાવવા?ે 

1. ડેટા પસંદ કરા:ે જ ેડેટાને લાઇન ચાટƙમાં ͅપાંત̋રત કરવી છે તે પસંદ કરાે. 

2. Insert ટેબમાં ̀અા:ે ̋રબન મેનુમાં "Insert" ટેબ પર ̚ȃક કરાે. 

3. લાઇન ચાટƙ પસંદ કરાે: "Charts" ̍વભાગમાં "Line Chart" પસંદ કરાે. 

4. ̋ડઝાઇન અને ક˶માઇઝ કરાે: ચાટƙના રંગાે, લેબ˔, અને શૈલીને વૈ̍વɪપૂવƙક ક˶માઇઝ કરા.ે 

 

લાઇન ચાટƙ ક˶માઇઝ કરવા માટેના ̍વકˍા ે

1. ટાઇટલ ઉમેરવંુ: ચાટƙ માટે ˾ˠ ટાઇટલ અાપાે. 

2. ડેટા લેબ˔ ઉમેરવંુ: દરેક ડેટા પાેઈɰના મૂˑાે દશાƙવાે. 

3. ̎ǁડલાઇʉ અેડજ˶ કરવી: ̎ǁડલાઇન ɦારા ડેટાને વધુ ˾ˠ બનાવા.ે 

4. રંગ અને શૈલી બદલવી: અલગ-અલગ લાઇન માટે વૈ̍વɪપૂણƙ રંગાે પસંદ કરાે. 

ઉદાહરણ:  માનાે કે તમારી પાસ ેનીચેના ડેટા છે: 

મ̋હનાે વેચાણ (ͅ.) 

̀ʈુઅારી 50,000 

ફેǒુઅારી 60,000 

માચƙ 55,000 

અે̌ ǐલ 70,000 
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અા ડેટાને લાઇન ચાટƙમાં રજૂ કરવાથી દરેક મ̋હના માટે વચેાણનાે Ǉેɱ ˾ˠપણે ̀ેવા મળે છે. 

 

લાઇન ચાટƙના ફાયદા 

 સમયગાળા દર̌મયાન ડેટાના ફેરફારાે સરળતાથી દશાƙવે છે. 

 તુલનાɒક ̍વƸલેષણ માટે અાદશƙ. 

 સતત ડેટા Ǉેɱ અને અનુમાન માટે ઉપયાેગી. 

 ǍƸયમાન ǐેઝɰેશન માટે ˗ાવસા̍યક દેખાવ. 

માઇƿાેસાેʘ અેȋેલ 2019માં લાઇન ચાટƙનાે ઉપયાેગ કરીને તમે તમારા ડેટાને વધુ અસરકારક રીતે રજૂ કરી 
શકાે છાે અને મહɗપૂણƙ Ǉેɱ્સને સરળતાથી અાેળખી શકાે છાે. 

6.4 બાર ચાટƙ (Bar Chart) 

બાર ચાટƙ અે માઇƿાેસાʘે અેȋેલમાં ઉપલʤ અેક ઉપયાેગી અને લાેક̌ǐય ટૂલ છે, જ ે ડેટાને અાડા 
(હાે̋રઝાેɰલ) ƺતંભાે ɦારા રજૂ કરે છે. તે મુȕɗે તુલનાɒક ડેટાને ˾ ˠતા સાથે ǐદ̏શ̭ત કરવા માટે ઉપયાેગમા ં
લેવાય છે. 

બાર ચાટƙ શું છે? 

બાર ચાટƙ અે ડેટાને અાડા ƺતંભાે (બાર) ɦારા દશાƙવતાે અેક ǁાફ છે. ડેટાના મૂˑ ǐમાણે બારની લંબાઈ વધે છે. 

બાર ચાટƙના ઉપયાેગાે 

1. ડેટાની તુલના: અલગ-અલગ Ǘેણી વȝે તુલનાɒક ડેટા દશાƙવવા માટે. 

2. Ǘેણીઅાેનું ǐદશƙન: માેટાં ડેટાસેટમાં ̍વ̍વધ Ǘેણીઅાેનું સરળ ǐદશƙન કરવા માટે. 

3. Ǉેɱ્સ અને પેટʉƙ: સમયગાળામાં ફેરફારાે અથવા ડેટાના Ǉેɱ્સ શાેધવા માટે. 

બાર ચાટƙ કેવી રીતે બનાવવાે? 
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1. ડેટા પસંદ કરાે: જ ેડેટાને બાર ચાટƙમાં ͅપાંત̋રત કરવી છે તે પસંદ કરાે. 

2. Insert ટેબમાં ̀અાે: ̋રબન મેનુમાં "Insert" પર ̚ȃક કરાે. 

3. બાર ચાટƙ પસંદ કરા:ે "Charts" ̍વભાગમાં "Bar Chart" પસંદ કરાે. 

4. ̋ડઝાઇન અને ક˶માઇઝ કરાે: ચાટƙમાં રંગાે, લેબ˔, અને શૈલી ઉમેરાે. 

બાર ચાટƙ ક˶માઇઝ કરવા માટેના ̍વકˍા ે

1. ચાટƙ ટાઇટલ ઉમેરવું: ˾ˠ અને વણƙનાɒક ટાઇટલ અાપાે. 

2. ડેટા લેબ˔ ઉમેરવું: દરેક બાર પર ડેટાના મૂˑ દશાƙવાે. 

3. રંગાેની પસંદગી: Ǘેણી અથવા બાર માટે વૈ̍વɪપૂણƙ રંગાે પસંદ કરાે. 

4. અે̚ ȋસ લેબ˔ ઉમેરવુ:ં X અને Y અƖ પર વણƙનાɒક લેબ˔ ઉમેરાે. 

ઉદાહરણ: માનાે કે તમારી પાસે નીચેના ડેટા છે: 

ǐાેડǶ વેચાણ (ͅ.) 

ǐાેડǶ A 80,000 

ǐાેડǶ B 60,000 

ǐાેડǶ C 40,000 

ǐાેડǶ D 70,000 

 

અા ડેટાને બાર ચાટƙમાં રજૂ કરવાથી દરેક ǐાેડǶના વેચાણની તુલના સરળતાથી કરી શકાય છે. 

 

બાર ચાટƙના ફાયદા 
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 ડેટાની તુલના વધુ ˾ˠ અને સરળ બને છે. 

 ̍વશાળ ડેટાસેટના ̍વƣયુઅલ ǐદશƙન માટે ઉપયાેગી. 

 સમયગાળામાં Ǉેɱ્સ અથવા ફેરફારાે શાેધવા માટે ઉપયાેગી. 

 ડેટા માટે અાકષƙક અને ˗વસા̍યક દેખાવ. 

માઇƿાેસાેʘ અેȋેલ 2019માં બાર ચાટƙનાે ઉપયાેગ કરીને તમે તમારા ડેટાને વધુ અસરકારક અને ǍƸયમાન 
રીતે રજૂ કરી શકાે છાે. 

7. ̋ફ˄ર ફંȆનનાે ઉપયાગે (Use of Filter Function) 

̋ફ˄ર ફંȆન માઇƿાેસાેʘ અȋેેલ 2019માં ઉપલʤ અેક શ̘Ǹશાળી સાધન છે, જ ેમાેટી ડેટાસીટમાથંી 
જͅરી મા̋હતી ઝડપી અને સરળતાથી મેળવવા માટે ઉપયાેગી છે. અા ફંȆનનાે ઉપયાેગ ખાસ કરીને ɔારે 
થાય છે ȱારે ડેટાન ેચાેǲસ શરતાે ǐમાણે ગાેઠવવા અથવા શાેધવા જͅરી હાેય. 

̋ફ˄ર ફંȆન શું છે? 

̋ફ˄ર ફંȆન માઇƿાેસાʘે અેȋેલમાં ડેટા છાનવીન કરવા માટે ઉપયાેગમાં લેવાય છે. તે ડેટામાંથી ચાેǲસ 
માપદંડાે અનુસાર મા̋હતી શાેધીને ǐદ̏શ̭ત કરે છે, અને બાકીનાે ડેટા છુપાવી દે છે. 

̋ફ˄ર ફંȆનના ઉપયાેગા ે

1. ચાǲેસ ડેટા શાેધવા માટે: માેટી ડેટાસીટમાથંી ચાǲેસ Ǘણેી અથવા મૂˑને શાેધવા માટે. 

2. મહɗપૂણƙ ડેટા શાેધવા: ̍વ̍વધ માપદંડાે ǐમાણે જ̋ͅરયાત મુજબ ડેટા દશાƙવવાે. 

3. ̍વƸલેષણ માટે સરળતા: ડેટાને ગાેઠવીને તેનંુ ̍વƸલષેણ કરવંુ વધુ સરળ બને છે. 

̋ફ˄ર ફંȆન કેવી રીતે ઉપયાેગમાં લેવાય? 

1. ડેટા પસંદ કરાે: જનેે ̋ફ˄ર લાગુ કરવંુ છે તે ડેટાની પસંદગી કરાે. 

2. ̋ફ˄ર ̍વકˍ પસંદ કરાે: ̋રબન મેનુમાં "Data" ટેબમાં ̀અાે અને "Filter" ̍વકˍ પસંદ કરાે. 

3. ǉાેપડાઉન મેનથુી પસંદગી કરાે દરેક કાેલમ હેડર પર ǉાેપડાઉન અાઇકાેન દેખાશે. તમે મૂˑ , લખાણ, 
તારીખ, કે નંબરના અાધારે ̋ફ˄ર કરી શકાે છાે. 

4. ̋ફ˄ર લાગુ કરાે તમારી જ̋ͅરયાત મુજબ શરતાે પસંદ કરાે અને જͅરી ડેટા દશાƙવાે. 

ઉદાહરણ: માનાે કે નીચેની ડેટા ટેબલ છે: 

કમƙચારીનું નામ ̍વભાગ પગાર (ͅ.) 

અજય વેચાણ 50,000 

ર̍વ માક̳̋ટ̬ગ 40,000 



 

  
SARDAR PATEL INSTITUTE OF PUBLIC ADMINISTRATION, AHMEDABAD 199 

 

Ǘુ̍ત અેચઅાર 60,000 

̌મ̋હર વેચાણ 55,000 

તમે "̍વભાગ" કાેલમને ̋ફ˄ર કરીને ફǸ "વેચાણ" ̍વભાગના અેƳʕાેયીઝનું ડેટા ̀ેઈ શકાે છાે. 

̋ફ˄ર ફંȆનના ફાયદા 

1. સમયની બચત: માેટા ડેટાસેટમાંથી ચાેǲસ મા̋હતી ઝડપથી મેળવવી. 

2. સરળ સંચાલન: ̍વ̍વધ માપદંડાે ǐમાણે ડેટાને ગાેઠવવી સરળ બને છે. 

3. ̍વƸલેષણમાં સહાય: ચાǲેસ Ǘેણી અથવા માપદંડાે પર અાધા̋રત ડેટાનું ̍વƸલેષણ કરવું સરળ બને 
છે. 

અɥતન ̋ફ˄રનાે ઉપયાેગ (Advanced Filter) 

1. ̋ફ˄ર રેƮજ ̏નધાƙ̋રત કરા:ે ડેટાને નકલ કરવું અથવા મૂળ ડેટાને બદલીને ǐદ̏શ̭ત કરવું. 

2. શરતાે ̏નધાƙ̋રત કરા:ે "Advanced Filter" ̍વકˍમાં તમા̈́ં માપદંડ દાખલ કરાે. 

માઇƿાેસાેʘ અેȋેલ 2019માં ̋ફ˄ર ફંȆનનાે ઉપયાેગ કરીને તમે તમારા ડેટાને વધુ ˗વ̗˺ત, ˾ˠ અને 
કાયƙƖમ રીતે સંચા̏લત કરી શકાે છાે. તે ̍વશાળ ડેટાબેઝને સંભાળવા માટે અેક અ̏નવાયƙ સાધન છે. 

7.1 અાેટાે ̋ફ˄ર (Auto Filter) 

અાેટાે ̋ફ˄ર માઇƿાેસાʘે અેȋેલ 2019માં ઉપલʤ અેક સરળ અને ઉપયાેગી સુ̍ વધા છે, જ ેડેટાને શાેધવા 
અને ચાǲેસ માપદંડાે અનસુાર મા̋હતી દશાƙવવા માટે ઉપયાેગમાં લેવાય છે. અાેટાે ̋ફ˄રનાે ઉપયાેગ કરીન ે
તમે માેટી ડેટાસીટમાંથી જͅરી ડેટા ઝડપથી શાેધી શકાે છાે અને બાકીના ડેટાને છુપાવી શકાે છાે. 

અાેટાે ̋ફ˄ર શું છે? 

અાેટાે ̋ફ˄ર ડેટાને ƿમાનુસાર ગાેઠવવા (Sort) અથવા શાેધવા (Filter) કરવાનું સરળ મȜમ છે. તે દરેક 
કાેલમ માટે ̋ફ˄ર ̍વકˍ ǐદાન કરે છે, જનેાથી તમે અાંકડાઅાે, લખાણ, કે તારીખ પર અાધા̋રત ̋ફ˄ર કરી 
શકાે છાે. 

અાેટાે ̋ફ˄રનાે ઉપયાેગ Ȃાં થાય છે? 

1. ચાǲેસ Ǘેણી શાેધવા માટે: ̍વશાળ ડેટાબેઝમાંથી ચાેǲસ Ǘેણીનું ડેટા શાેધવા માટે. 

2. ડેટાની ̍વ̍ધવત ગાેઠવણી: ડેટાને ̏નયત માપદંડાે મુજબ ગાેઠવવા માટે. 

3. અાંકડા ̍વƸલેષણ: ડેટાના ચાેǲસ પેટનƙ અને Ǉેɱ્સ શાધેવા માટે. 

અાેટાે ̋ફ˄ર કેવી રીતે લાગુ કરવું? 

1. ડેટા પસંદ કરાે: જે ડેટાને અાેટાે ̋ફ˄ર લાગુ કરવું છે તે પસંદ કરાે. 

2. ̋ફ˄ર ઉમેરા:ે ̋રબન મેનમુાં "Data" ટેબ પર ̀અાે., "Filter" બટન પર ̚ȃક કરાે. 
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3. ǉાેપડાઉન મેનુનાે ઉપયાેગ કરાે: જ ેકાેલમ માટે ̋ફ˄ર કરવું છે, તે હેડર પરના ǉાેપડાઉન અાઇકાેન પર 
̚ȃક કરાે. તમા̈́ં માપદંડ પસંદ કરાે, જમે કે: ચાેǲસ લખાણ અથવા અાંકડા., Ǘેણી (Range) પસંદ કરવું., 
ક˶મ ̋ફ˄ર લાગુ કરવાે. 

4. ડેટા દશાƙવાે: તમા̈́ં માપદંડ પસંદ કયાƙ પછી  ડેટા ત ેમુજબ ǐદ̏શ̭ત કરશે, બાકીની મા̋હતી છુપાશે. 

ક˶મ ̋ફ˄રનાે ઉપયાેગ: 

ક˶મ ̋ફ˄ર ̍વકˍનાે ઉપયાેગ કરીને તમે વધુ અાધુ̏નક માપદંડાે લગાવી શકાે છાે, જમે કે: 

 અાંકડાઅાે માટે: "Greater than," "Less than," "Equal to," વગેરે. 

 તારીખ માટે: "Last Month," "Next Week," વગરેે. 

 લખાણ માટે: "Begins with," "Contains," વગેરે. 

ઉદાહરણ: 

માનાે કે તમારી પાસે નીચેનાે ડેટા છે: 

કમƙચારીનું નામ ̍વભાગ પગાર (ͅ.) 

અજય વેચાણ 50,000 

ર̍વ માક̳̋ટ̬ગ 40,000 

Ǘુ̍ત અેચઅાર 60,000 

̌મ̋હર વેચાણ 55,000 

તમે "̍વભાગ" કાેલમમાં "વેચાણ" ̋ફ˄ર લાગુ કરીને ફǸ વેચાણ ̍વભાગના અેƳʕાેયીઝનંુ ડેટા ̀ેઈ શકાે છાે. 

અાેટાે ̋ફ˄રના ફાયદા: 

1. સમયની બચત: માેટી ડેટાસીટમાંથી જͅરી મા̋હતી ઝડપથી મેળવાે. 

2. સરળ સંચાલન: માપદંડાે અનુસાર ડેટાને ગાેઠવવું સરળ છે. 

3. ̍વƸલેષણ માટે ઉɇમ: ચાેǲસ Ǘેણી અથવા માપદંડાેને અાધારે ડેટાનું ̍વƸલેષણ સરળતાથી કરી 
શકાય છે. 

4. મ̓˄પલ ̋ફ˄ર: અેક સાથે અેક કરતાં વધુ કાેલમ પર ̋ફ˄ર લાગુ કરી શકાય છે. 

માઇƿાેસાેʘ અેȋેલ 2019માં અાેટાે ̋ફ˄ર અે અેક શ̘Ǹશાળી ટૂલ છે, જ ેતમને ડેટાને ઝડપથી ગાઠેવવા 
અને જͅરી મા̋હતી શાેધવામા ંમદદ કરે છે. તે ડેટા સંચાલન અને ̍વƸલેષણ માટે અેક અ̏નવાયƙ સાધન છે, જ ે
સમય બચાવે છે અને કાયƙƖમતા વધારે છે. 

7.2 અેડવાʉ ̋ફ˄ર (Advanced Filter) 
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અેડવાʉ ̋ફ˄ર માઇƿાેસાેʘ અેȋેલ 2019માં ઉપલʤ અેક મજબૂત અને વધુ વૈ̍વɪપૂણƙ સાધન છે, જ ે
તમને ડેટાને વધુ ચાેǲસ માપદંડાે સાથે છાનવીન કરવા અથવા નકલ કરીને નવી જƝયાઅે પે˶ કરવા માટે 
સƖમ બનાવે છે. અેડવાʉ ̋ફ˄રનાે ઉપયાેગ ખાસ કરીને વધુ જ̋ટલ ̍વƸલેષણ માટે થાય છે, ȱાં અાેટાે 
̋ફ˄ર પૂરતાે નથી. 

અેડવાʉ ̋ફ˄ર શું છે? 

અેડવાʉ ̋ફ˄ર અેȋેલમા ંડેટાને શાેધખાેળ કરવાની સુ̍વધા ǐદાન કરે છે, જનેાથી તમે: 

 ડેટાને મૂળ Ǘેણીમાં ̋ફ˄ર કરી શકાે છાે. 

 શાેધેલા ડેટાને અʈ જƝયાઅ ેનકલ કરી શકાે છાે. 

 અનેક માપદંડાે સાથે ̋ફ˄ર કરી શકાે છાે. 

અેડવાʉ ̋ફ˄રનાે ઉપયાગે Ȃાં થાય છે? 

1. જ̋ટલ માપદંડાે લાગુ કરવું: અેક કરતાં વધુ શરતાે અને ̏નયમાે સાથે ડેટાને ̋ફ˄ર કરવા. 

2. શાેધેલી મા̋હતીની નકલ કરવા: ̋ફ˄ર કરેલા ડેટાને અલગ રેƮજમાં નકલ કરવા માટે. 

3. ડેટા ̍વƸલેષણ માટે: ̍વશાળ ડેટાસેટમાંથી ચાǲેસ મા̋હતી મેળવવા માટે. 

અેડવાʉ ̋ફ˄ર કેવી રીતે ઉપયાેગમાં લેવાય? 

1. ડેટા પસંદ કરા ે

 અે ડેટા પસંદ કરાે જ ેપર અેડવાʉ ̋ફ˄ર લાગુ કરવું છે. 

2. માપદંડાે ̏નધાƙ̋રત કરા ે

 ડેટાની ઉપર કે બાજુમાં માપદંડાે માટે અલગ કાેˠક બનાવા.ે 

 માપદંડ માટે હેડર મૂળ ડેટાના હેડર જેવાે જ હાેવાે ̀ેઈઅે. 

 ઉદાહરણ: 

̍વભાગ પગાર 

વેચાણ >50,000 

3. અેડવાʉ ̋ફ˄રનાે ઉપયાેગ કરા ે

 ̋રબન મેનમુાં "Data" ટેબ પર ̀અાે અને "Advanced" ̍વકˍ પસંદ કરાે. 

 "Filter the list, in-place" અથવા "Copy to another location" ̍વકˍ પસંદ કરાે. 

 "Criteria Range" માં માપદંડાે માટેનું રેƮજ પસંદ કરાે. 

 "Copy to" ̍વકˍમાં તે જƝયા પસંદ કરાે ȱાં ̋ફ˄ર કરેલંુ ડેટા નકલ કરવું છે. 
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4. OK ̚ȃક કરાે 

 અેડવાʉ ̋ફ˄ર લાગુ થશે અને ફǸ તમારી શરતાે પૂણƙ કરતું ડેટા દશાƙવશે. 

ઉદાહરણ: માનાે કે તમારી પાસે નીચેનાે ડેટા છે: 

કમƙચારીનું નામ ̍વભાગ પગાર (ͅ.) 

અજય વેચાણ 50,000 

ર̍વ માક̳̋ટ̬ગ 40,000 

Ǘુ̍ત અેચઅાર 60,000 

̌મ̋હર વેચાણ 55,000 

માપદંડ ̏નધાƙ̋રત કરા:ે 

̍વભાગ પગાર 
વેચાણ >50,000 

 

અેડવાʉ ̋ફ˄ર લાગુ કયાƙ પછી ફǸ "̌મ̋હર" નાે ડેટા ǐદ̏શ̭ત થશે. 

અેડવાʉ ̋ફ˄રના ફાયદા 

1. ચાȋેાઈ: જ̋ટલ માપદંડાે સાથે ઉંડાણપવૂƙક ડેટાની શાેધખાેળ કરી શકાય છે. 

2. લચીલાપણું: ̋ફ˄ર કરેલા ડેટાને નકલ કરીને અલગ જƝયા પર રાખી શકાય છે. 

3. સમયની બચત: ̍વશાળ ડેટાસેટમાથંી યાેƝય મા̋હતી ઝડપથી મેળવી શકાય છે. 

4. અેક કરતા વધુ શરતાે: ડેટાને ̍વ̍વધ શરતાે પર અાધા̋રત શાેધખાેળ કરવું શȂ છે. 

માઇƿાેસાેʘ અȋેેલ 2019માં અેડવાʉ ̋ફ˄ર અે ડેટા સંચાલન અને ̍વƸલેષણ માટે અેક શ̘Ǹશાળી 
સાધન છે. તે યુઝસƙને જ̋ટલ માપદંડાે સાથે ડેટાને ગાેઠવવા અને ઉȝ ƺતરે ̍વƸલેષણ કરવાની સુ̍વધા ǐદાન 
કરે છે. 

8. ̌પવટ ટેબલ (Pivot Table) 

̌પવટ ટેબલ માઇƿાેસાેʘ અેȋેલ 2019માં ઉપલʤ અેક શ̘Ǹશાળી ફીચર છે, જ ેડેટાનું ̍વƸલેષણ અને 
સƖેંપ કરવામાં ઉપયાેગી છે. તે માેટી ડેટાસીટમાંથી મહɗપણૂƙ મા̋હતી ̏ નકાળવા, Ǉેɱ્સ અાેળખવા, અને ડેટાને 
સરળ રીતે રજૂ કરવા માટે ઉપયાેગમાં લેવાય છે. 

8.1 ̌પવટ ટેબલ શું છે? 

̌પવટ ટેબલ અે ડેટાને સં̐Ɩʏ અને ગાેઠવેલા ͅપમાં ǐદ̏શ̭ત કરવાની પɡ̍ત છે. તે યુઝસƙને ડેટાને ખ̲ચી-છાેડીન ે
(Drag-and-Drop) ̍વ̍વધ રીતે ગાેઠવવાની અને ̍વ̍વધ કાેˠકાેમાં Ǉેɱ્સ અને પેટʉƙ શાેધવાની તક અાપે 
છે. 
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̌પવટ ટેબલના ઉપયાેગાે 

1. ડેટાનું સંƖેપ કરવુ:ં ̍વƺતૃત ડેટાને સરળ ફાેમ̳ટમાં ગાેઠવવુ.ં 

2. Ǉેɱ્સ અાેળખવા: અાંકડાઅાેના Ǉેɱ્સ અને પેટʉƙ શાધેવા. 

3. ̋ફ˄ર કરવું: ડેટાને ગુણવɇાપૂવƙક ̋ફ˄ર કરીને ǐƺતુત કરવંુ. 

4. ગણનાઅાે કરવી: સરવાળા,ે સરેરાશ, ગણતરી વગેરે માટે. 

̌પવટ ટેબલ કેવી રીતે બનાવવું? 

1. ડેટા પસંદ કરાે: જે ડેટા ટેબલ માટે ̌પવટ ટેબલ ઉપયાેગ કરવંુ છે તે પસંદ કરાે. 

2. ̌પવટ ટેબલ પસંદ કરાે: ̋રબન મેનુમાં "Insert" ટેબ પર ̀અાે અને "Pivot Table" ̍વકˍ પસંદ કરાે. 

3. જƝયા પસંદ કરાે: નવી વકƙશીટ અથવા હાલની વકƙશીટ પર ̌પવટ ટેબલ ગાેઠવવા માટે જƝયા પસંદ કરાે. 

4. ફીˆ ̏લ˶ ગાેઠવાે: ડેટાના હેડસƙને Rows, Columns, Values, અને Filters માં ખ̲ચીને ગાેઠવાે. 

5. ̍વƸલેષણ કરાે: ̌પવટ ટેબલ અાપમેળે ડેટાને ગાેઠવીને સં̐Ɩʏ ̄ͅપે ǐદ̏શ̭ત કરશે. 

ઉદાહરણ: માનાે કે તમારી પાસે નીચેનાે ડેટા છે: 

ǐાેડǶ ̍વƺતાર વેચાણ (ͅ.) 
ǐાેડǶ A ઉɇર 50,000 
ǐાેડǶ B દ̐Ɩણ 40,000 
ǐાેડǶ A દ̐Ɩણ 30,000 
ǐાેડǶ B ઉɇર 60,000 

 

̌પવટ ટેબલ બના˗ા પછી: 

̍વƺતાર ǐાેડǶ A ǐાેડǶ B કુલ વચેાણ 
ઉɇર 50,000 60,000 1,10,000 
દ̐Ɩણ 30,000 40,000 70,000 

 

̌પવટ ટેબલના ફાયદા 

1. સમય બચાવવું: ડેટાને ઝડપથી ગાેઠવવા અને ̍વƸલષેણ કરવા માટે મદદͅપ. 

2. લવચીકતા: ડેટાને ̍વ̍વધ ͆̑ˠઅે ગાેઠવી શકાય છે. 

3. ̋ફ˄ર અને સાૅ̋ટ̮ગ: સરળ રીતે ડેટાને ગાેઠવવા અને ̋ફ˄ર કરવા માટે. 

4. ગણતરી માટે ઉપયાેગી: સરવાળા,ે સરેરાશ, ગણતરી વગરેે ઝડપથી કરી શકાય છે. 

અɥતન ̍વકˍાે: 
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 ǁાʟ અને ચાટ્ƙસ: ̌પવટ ચાટƙ સાથે ǍƸયમાન ǐƺતુ̍ ત. 

 ગણતરીના ફાેમુƙલા: ક˶મ ફાેમુƙલા ઉમેરવા. 

 ટાઇમલાઇન અને ƺલાઇસર: ડેટાને વધુ અસરકારક રીતે ̋ફ˄ર કરવા માટે. 

̌પવટ ટેબલ માઇƿાેસાʘે અȋેેલ 2019નું અેક અ̏નવાયƙ સાધન છે, જ ે ડેટાના ̍વƸલેષણને ઝડપી અને 
અસરકારક બનાવે છે. તે માેટી ડેટાસીટને સરળ અને સમજવા યાેƝય ̄ͅપમાં ગાેઠવીને ˗ાવસા̍યક અને 
˗̘Ǹગત ઉપયાેગ માટે અાદશƙ છે. 

8.2 ̌પવાેટ ચાટƙ 

Microsoft Excel 2019 માં ̌પવાેટ ચાટƙ અે ̌પવાેટ ટેબલનાે ̍વƣયુઅલ ǐદશƙન છે, જનેાે ઉપયાેગ ડેટાને 
સરળતાથી સમજૂતી અને ̍વƸલેષણ માટે થાય છે. તે યુઝસƙને ̍વશાળ ડેટાને ǁા̋ફકલી રજૂ કરવા અને તેના 
અાધાર પર મહɗપણૂƙ ̏નણƙય લેવા માટે મદદ કરે છે. 

̌પવાેટ ચાટƙનાે ઉપયાગે કેમ કરવાે? 

̌પવાેટ ચાટƙ બનાવવા માટે નીચેના પગલાં અનુસરાે: 

1. ડેટા પસંદ કરાે: અે ડેટા પસંદ કરાે જેનાે ઉપયાેગ ̌પવાેટ ટેબલ બનાવવા માટે થાય છે. 

2. ̌પવાેટ ટેબલ બનાવાે: "Insert" ટેબમાં જઈને "Pivot Table" ̍વકˍ પસંદ કરાે. 

3. ̌પવાેટ ચાટƙ ઉમરેાે: ̌ પવાેટ ટેબલ ̐ સલǶે કયાƙ પછી, "Analyze" ટેબમાં "Pivot Chart" ̍ વકˍ પસંદ 
કરાે. 

4. ચાટƙ ǐકાર પસંદ કરાે: બાર, લાઇન, પાઇ વગેરે જમે નકશાના ̍વ̍વધ ǐકારમાંથી પસંદ કરાે. 

̌પવાેટ ચાટƙના ફાયદા 

 ̍વƣયુઅલ ˾ˠતા: અાંકડાઅાેને ǁાફ ɦારા ̀ેઈ શકાય છે, જનેાથી Ǉેɱ અને પેટનƙ સમ͂ શકાય 
છે. 

 ડાયને̍ મક અપડેટ: ̌પવાેટ ટેબલમાં ફેરફાર થતાં જ ̌પવાટે ચાટƙ અાપમેળે અપડેટ થાય છે. 

 ̋ફ˄ર અને ̋ǉલ-ડાઉન: સેટ કરેલી ̋ફ˄ર અાેƯશન ɦારા ચાેǲસ મા̋હતી મેળવવામાં સરળતા થાય 
છે. 

 સમય બચાવવાે: ડેટાનુ ંતુલનાɒક રીતે ̍વƸલેષણ કરવામાં અાેછાે સમય લાગે છે. 

̌પવાેટ ચાટƙના સામાʈ ǐકાર 

1. કાેલમ ચાટƙ: ડેટાને વગ̰કૃત રીતે દશાƙવવા માટે Ǘેˤ. 

2. લાઇન ચાટƙ: સમયગાળા દર̌મયાન ડેટા બદલાવ દશાƙવવા માટે ઉપયાેગી. 

3. પાઇ ચાટƙ: ડેટાનું ̍વતરણ અને ટેકાવારી દશાƙવવા માટે. 
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4. બાર ચાટƙ: ડેટાને અાડા ǐકારમાં ǐƺતતુ કરવા માટે. 

ઉદાહરણ તરીકે, ̀ે અાપની પાસે વેચાણનાે ડેટા હાેય અને ̍વ̍વધ ̍વƺતારાેમાં વચેાણના અાંકડાઅાેનંુ 
તુલનાɒક ̍વƸલેષણ કરવું હાેય, તાે ̌પવાેટ ચાટƙ તમને ǍƸયમાન ˾ˠતા ǐદાન કરે છે. 

Excel 2019 માં ̌પવાેટ ચાટƙનાે ઉપયાેગ કરીને, તમે તમારા ડેટાને વધુ ǐભાવશાળી રીતે દશાƙવી શકાે છાે અન ે
ઝડપી અને સચાેટ ̏નણƙય લઈ શકાે છાે. 

̌પવાેટ ચાટƙમાં વધુ સારી સમજ માટે ચાટƙ ટાઇટલ, લેજɱે, અને ડેટા લેબલ ઉમેરવા માટે ક˶માઇઝેશનના 
̍વકˍાે ઉપલʤ છે. 

Microsoft Excel 2019 અે ̍વ˝˗ાપી રીતે ǐȕાત ˿ેડશીટ સાેʘવેર છે, જેનાે ઉપયાેગ ડેટા સંચાલન, 
̍વƸલેષણ, અને ǐƺતુ̍ ત માટે થાય છે. અા ચેʍરનું સારાંશ ̍વ̍વધ ફીચર અને તકાેને સમજવામાં મદદͅપ છે, 
જ ેExcel 2019 ને વધુ સƖમ અને ǐયાેગશીલ બનાવે છે. 

9. સારાંશ 

Excel 2019 માં, તમે ̍વ̍વધ કાયા̳ કરી શકાે છાે, જમે કે ડેટા અƮેǇી અને અે̋ ડ̋ટ̬ગ, સરળ ફાેy ુƙલા અને 
ફંȆʉનાે ઉપયાેગ, શીટનું ફાેમ̳̋ટ̬ગ અને અેલાઇનમેɰ, અને ચાટ્ƙસ અને ̌પવાટે ટેબ˔નંુ ̏નમાƙણ.   

10. નમુનાͅપ ǐ˜ાે અને જવાબાે Model Questions and Answers 

1. Microsoft Excel 2019 કયા ǐકારનું સાેʘવેર છે? 
a) Word Processor 
b) Spreadsheet  
c) Presentation 
d) Database 

2. Excel 2019 માં નવી વકƙબુક શͅ કરવા માટે શંુ પસંદ કરવું ̀ેઈઅે? 
a) Recent Files 
b) Blank Workbook  
c) Templates 
d) Shared with Me 

3. Excel ફાઇલનું ̋ડફાે˄ અેȌેƮશન શું છે? 
a) .docx 
b) .xlsx  
c) .xls 
d) .txt 

4. Rows Excel 2019 માં કેટલા હાેય છે? 
a) 1,048,576  
b) 10,000 
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c) 65,536 
d) 100,000 

5. Excel માં સેલ અેǉેસ “B2” માં “B” શું દશાƙવે છે? 
a) Row 
b) Sheet 
c) Column  
d) Cell Name 

6. Excel માં કાેઈ સેલનું સરનામું કેવી રીતે અાેળખી શકાય? 
a) Scroll Bar 
b) Name Box  
c) Status Bar 
d) Ribbon 

7. Excel માં AutoSum માટે કઈ શાેટƙકટ કી છે? 
a) Ctrl + S 
b) Alt + =  
c) Ctrl + Alt + A 
d) Shift + = 

8. જમેના ફાેટા અને ચાટ્ƙસ ̀ેવા મળે તે Excel નંુ ફીચર કયું છે? 
a) Data Filter 
b) Data Validation 
c) Data Visualization  
d) Power Pivot 

9. Insert Function નાે ઉપયાેગ કઈ ટેબમાં થાય છે? 
a) Home 
b) View 
c) Formulas  
d) Data 

10. IF ફંȆનનાે ઉપયાેગ કઈ માટે થાય છે? 
a) સરેરાશ કાઢવા 
b) શરતી લાે̏જક માટે  
c) ચાટƙ બનાવવા 
d) Worksheet સેવ કરવા 

11. Excel માં Worksheet ના નીચલા ભાગે શું ̀ેવા મળે છે? 
a) Scroll Bar 
b) Sheet Tab 
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c) Formula Bar 
d) Title Bar 

12. Paste Special માટે કઈ શાેટƙકટ કી છે? 
a) Ctrl + P 
b) Ctrl + Alt + V  
c) Ctrl + V 
d) Ctrl + Shift + V 

13. Excel માં શું ફંȆન સરેરાશ મૂˑ અાપે છે? 
a) COUNT 
b) AVERAGE  
c) SUM 
d) TOTAL 

14. Excel માં ˶ેટસ બાર Ȃાં હાેય છે? 
a) Top 
b) Left 
c) Right 
d) Bottom  

15. ડેટા સાૅટƙ કરવા માટે કઈ ટેબનાે ઉપયાેગ થાય છે? 
a) Home 
b) Data  
c) Review 
d) Insert 

16. Excel માં Cell ને ̀ેડવા માટે કયાે ̍વકˍ છે? 
a) Format 
b) Merge & Centre  
c) Cut & Paste 
d) Border 

17. Excel માં ચાટƙ ઉમેરવા માટે કઈ ટેબ વપરાય છે? 
a) File 
b) Data 
c) Insert  
d) View 
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 માઈƿાેસાેʘ પાવરપાેઈɰ 2019 
 

1. ઉɠેશાે (Objectives) 

અા ǐકરણનાે અʬાસ કયાƙ બાદ તમે Microsoft PowerPoint 2019નાે સંપૂણƙ અને અસરકારક ઉપયાેગ 
કરી શકશાે. અા ǐકરણનાે અʬાસ કયાƙ બાદ, તમે નીચનેા કાૈશˑમાં ̏નપુણતા મેળવી શકશાે: 

 Microsoft PowerPoint 2019 ના મૂળભૂત તɗાે અને લાƖ̒ણકતાઅાે સમજવા. 

 ટેƳʕેટ્સ અને થીʼનાે ઉપયાેગ કરીને ǐેઝɰેશન ̋ડઝાઇન કરવી. 

 લખાણ, ̎ચǋા,ે અાકૃ̍તઅાે, અને ચાટ્ƙસ ઉમેરવા અને ક˶માઇઝ કરવા. 

 અે̏ નમેશન અને Ǉાં̏ઝશન અસરકારક રીતે લાગુ કરવી. 

 ǐેઝɰેશનને ˗વસા̍યક અને અાકષƙક બનાવવા માટે ǐƺતુ̍ ત માેડનાે ઉપયાેગ કરવાે. 

 ǐેઝɰેશનને સેવ કરવું, શેર કરવું અને ̍વ̍વધ ફાેમ̳ટમાં અેȋપાેટƙ કરવું. 

 ǐેઝɰેશનના ǐભાવને વધારવા માટે મ˄ીમી̋ડયા સામǁી ઉમેરવી. 

2. પ̋રચય (Introduction) 

Microsoft PowerPoint 2019 અે ǐƺતુ̍ ત (Presentation) બનાવવા માટેનાે સાૈથી લાેક̌ǐય અને સƖમ 
સાેʘવેર છે. તે ˗ાવસા̍યક, શૈƖ̒ણક અને ˗̘Ǹગત ઉપયાેગ માટે ઉɇમ છે, જ ેવપરાશકતાƙઅાેને લખાણ, 
̎ચǋા,ે અાકૃ̍તઅાે, ǁાʟ અને અે̏નમેશન ɦારા ǍƸયમય અને અાકષƙક ǐƺતુ̍ તઅાે તૈયાર કરવામાં મદદ કરે છે. 

PowerPoint 2019 Microsoft Office સુટનાે અેક ભાગ છે અને તે અગાઉના સં˱રણાે કરતાં વધુ નવીન 
સુ̍ વધાઅા ેǐદાન કરે છે. તે અɔાધુ̏નક ǐƺતાવના સાધનાે અને ̋ડઝાઇન તકાે સાથે ǐƺતુ̍ તને વધુ અાકષƙક 
અને અસરકારક બનાવે છે. 

પાવરપાેઈɰના મૂળભૂત ઉપયાેગ 

Microsoft PowerPoint 2019 નાે ઉપયાેગ શાળા-કાેલેજ, કાૅપા̳રેટ મી̋ટ̬Ɲસ, Ǉે̏નગ̬ ǐાેǁાʼ અને ઇવɰે 
ǐેઝɰેશનમાં થાય છે. તે મા̋હતીને સરળ અને અાકષƙક ͅપમાં રજૂ કરવા માટે મદદͅપ છે. તેનાે મȕુ ઉɠેƸય 
વપરાશકતાƙઅાેને ǐƺતુ̍ તઅા ે બનાવવામાં સહાય પૂરી પાડવાનાે છે, જથેી મા̋હતી અને ̍વચારાેને ǍƸયમય, 
˾ˠ અને ǐભાવશાળી રીત ેરજૂ કરી શકાય. અા સાેʘવરેનાે ઉપયાેગ ̍વ̍વધ ˗ાવસા̍યક, શૈƖ̒ણક અન ે
˗̘Ǹગત ǐવૃ̍ ɇઅાેમાં થાય છે, ȱાં સરળ અને અાકષƙક ǐƺતુ̍ તઅાે તૈયાર કરવાની જͅર હાેય છે. 

Microsoft PowerPoint 2019 અે ǐƺતુ̍ તઅાે બનાવવા માટેનું અેક શ̘Ǹશાળી સાધન છે, જ ેવપરાશકતાƙને 
ડેટાને અાકષƙક અને સુ˗વ̗˺ત રીતે રજૂ કરવા માટે મદદͅપ થાય છે. પાવરપાેઈɰનાે ઉપયાેગ શૈƖ̒ણક, 
˗ાવસા̍યક તમેજ ˗̘Ǹગત Ɩેǋાેમાં ˗ાપક છે. 

 ̐બઝનેસ: ǐાેજǶે ǐƺતુ̍ ત, વા̍ષ̭ક ̋રપાેટƙ અને માક̳̋ટ̬ગ ˷ેટે͂ રજૂ કરવા માટે. 
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 ̐શƖણ: ̏શƖકાે અને ̍વɥાથ̰અાે માટે ભણતરને ǐાેɘા̋હત કરવા. 

 ǐ̐શƖણ: ઇવેɰ્સ અને Ǉે̏ન̬ગ કાયƙƿમામેાં સરળ સમજ માટે. 

 ˗̘Ǹગત: સામા̏જક ઇવɰ્ેસ અને ̋ƿઅે̋ ટવ ǐાેજǶ્ેસ માટે. 

Microsoft PowerPoint 2019 ના ઉɠેƸયાે તેના ̍વ̍વધ Ɩેǋાેમાં ઉપયાેગ અને નવી સુ̍ વધાઅાે ɦારા સા̐બત 
થાય છે. તે માǋ ǐƺતુ̍ ત બનાવવા પૂરતું નથી, પરંતુ તે ǐભાવશાળી સંચારનું મજબૂત માɪમ પણ છે. 

Microsoft PowerPoint 2019ની મȕુ લાƖ̒ણકતાઅાે 

ƺલાઇડ્સ અને ટેƳʕેટ્સ: 

 રેડીમેડ ̋ડઝાઇન ટેƳʕેટ્સના ેઉપયાેગ કરીને ઝડપી ǐƺતુ̍ ત બનાવવી. 
 ક˶મ ƺલાઇડ્સ સાથે ̋ડઝાઇનને ˗̘Ǹગત બનાવવું. 

̍વƣયુઅલ અે̏લમેɰ્સ: 

 ̎ચǋા,ે શેƯસ, અાઇકાʉે અને ચાટ̳ ͅપમાં ǍƸય ઘટકાે ઉમરેવા માટેના ̍વકˍાે. 
 બાર, લાઇન અને પાઇ ચાટƙ જવેા ǁાʟનાે સમાવેશ. 

અે̏ નમેશન અને Ǉાિɯશʉ: 

 ǐƺતુ̍ તને ͂વંત બનાવવા માટે ̍વ̍વધ અે̏નમેશન અને Ǉાિɯશન ઇફેǶ્સ. 
 ̚ȃક પર અથવા અાૅટામેે̋ટક અે̏નમેશન સેટ કરવી. 

સાઉɱ અને ̍વડીયાે: 

 ǐƺતુ̍ તમાં અાૅ̋ ડઅાે અને ̍વડીયાે ફાઇલાે ઉમેરવાની Ɩમતા. 
 ̍વડીયાે અે̋ ડ̋ટ̬ગ માટે ઇન-̐બ˄ ટૂ˔. 

કાેલેબરેશન ફીચસƙ: 

 OneDrive અથવા SharePoint નાે ઉપયાેગ કરીને ǐƺતુ̍ તઅાે પર સહયાેગ કરવાે. 
 ડાેȂુમɰ્ેસ પર સામૂ̋હક ǐ̋ƿયા અને ̋ટʑણીઅાે ઉમેરવા માટેના સાધના.ે 

3. પાવરપાઈેɰના મૂળભૂત તɗાે (Basics of PowerPoint) 

Microsoft PowerPoint 2019 અે ˗વસા̍યક તમેજ શƖૈ̒ણક વપરાશ માટેનું અસરકારક ટૂલ છે, જ ે
ǐƺતુ̍ તઅાે બનાવવા અને અʈ સાથે વહેચવાની Ǘેˤ સુ̍ વધાઅાે ǐદાન કરે છે. પાવરપાેઈɰના મૂળભતૂ 
તɗાે સમજવા માટે ǐƺતુ̍ તની રચના અને ̍વ̍વધ ફંȆʉ ̍વશે ̀ણવું મહɗપણૂƙ છે. 

1. ƺલાઇડ (Slide): ƺલાઇડ અે પાવરપાેઈɰ ǐેઝɰેશનનાે પાયાે છે, ȱાં તમે લખાણ, ̎ચǋાે, અાકૃ̍તઅાે, 
અને અે̏ નમશેન ઉમેરા.ે દરેક ƺલાઇડમાં શીષƙક (Title), મુȕ ̍વભાગ (Content) અને પાદ̋ટʑણીઅા ે
(Footer) ઉમેરવામાં અાવે છે. 
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2. ટેȌ બાેȋ: મા̋હતી દાખલ કરવા માટે ટેȌ બાેȋનાે ઉપયાેગ થાય છે. અા બાȋેને સરળતાથી 
ખસેડી અથવા માપ બદલવા માટે ̏નયં̍ǋત કરી શકાય છે. 

3. ટેƳʕેટ્સ અને થીʼ: ટેƳʕેટ્સ અેટલે તૈયાર ̋ડઝાઇનવાળી ƺલાઇડ લેઅાઉટનાે સેટ. થીમ અેટલે  રંગાે, 
ફાૅɰ્સ, અને બેકǁાઉɱ ̋ડઝાઇનનાે સમૂહ, જ ેǐƺતુ̍ તની સમાનતા ̀ળવે છે. 

4. ઇʉટƙ ̍વકˍાે: ̎ચǋા,ે અાકૃ̍તઅા,ે અાઇકાʉે, ચાટƙ, ǁાફ, અાે̋ ડઅાે અને ̍વડીયાે ફાઇલાે ઉમેરવી. 

5. અે̏ નમેશન અને Ǉાિɯશન: અે̏નમેશન: ˗̘Ǹગત રીતે ƺલાઇડના તɗાે પર અસર ઉમેરી શકાય છે. 
Ǉાિɯશન: ƺલાઇડથી બી͂ ƺલાઇડ પર જતાંના ̍વƣયુઅલ અસર માટે. 

6. ǐƺતુ̍ ત માેડ (Presentation Mode): ƺલાઇડ શાે ɦારા તમારી ǐƺતુ̍ ત ǐદ̏શ̭ત કરવી. ǐƺતુ̍ ત દરʸાન 
̋ટʑણીઅાે અથવા પેન ટૂલનાે ઉપયાેગ કરી શકાય છે. 

7. ̋રબન અને ટૂલબાર: ટૂલબારમાં ઉપલʤ Tabs જમે કે Home, Insert, Design, Animations, Slide 
Show વગેરેમાં ઉપલʤ ̍વકˍાે ઝડપી અે̋ડ̋ટ̬ગ અને ̋ડઝાઇન માટે ઉપયાેગમાં લેવાય છે. 

3.1 પાવરપાેઈɰનાે ઉપયાેગ કેવી રીતે કરવા?ે 

નીચે પાવરપાેઈɰના ઉપયાેગ કરવા માટેના પગ̎થયા અાʔા છે.  

 ǐƺતાવના શͅ કરવી: PowerPoint 2019 ખાેલાે અને "Blank Presentation" અથવા "Template" 
પસંદ કરાે. શીષƙક ƺલાઇડમાં ǐƺતુ̍ તનું નામ અને ઉપશીષƙક દાખલ કરાે. 

 ƺલાઇડ ઉમેરવી: "Home" ટેબમાં "New Slide" ̍વકˍ પર ̚ȃક કરીને નવી ƺલાઇડ ઉમેરાે. ̍વ̍વધ 
લેઅાઉટ જવેી કે Title Slide, Content Slide, Comparison Slide પસંદ કરાે. 

 મા̋હતી દાખલ કરવી: ટેȌ બાȋેમાં શીષƙક અને સામǁી ઉમેરાે. ̎ચǋા,ે અાકૃ̍તઅાે, ǁાફ, અને ચાટƙ 
જવેા ǍƸયમય તɗાે ઉમેરાે. 

 ƺલાઇડ ̋ડઝાઇન કરવી: "Design" ટેબમાં થીʼ પસંદ કરીને ƺલાઇડને ̋ડઝાઇન કરાે. બેકǁાઉɱ, રંગ, 
અને ફાɰૅ ક˶માઇઝ કરાે. 

 અે̏ નમેશન અને Ǉાિɯશન ઉમેરવી: "Animations" ટેબમાં ƺલાઇડના તɗાે માટે અે̏ નમેશન પસદં 
કરાે. "Transitions" ટેબમાં ƺલાઇડ બદલીની રીત ઉમેરાે. 

 ǐƺતુ̍ ત ̍વƣયુલ ફાેમ̳ટમાં અાપવી: "Insert" ટેબ ɦારા અાૅ̋ડઅાે અને ̍વડીયાે ફાઇલાે ઉમેરાે. 3D માેડે˔ 
અને અાઇકાેʉનાે ઉપયાેગ કરીને ǐƺતુ̍ તને અાધુ̏નક બનાવાે. 

 ƺલાઇડ શાે ચલાવવી: "Slide Show" ટેબમાં જઈ "From Beginning" ̚ȃક કરીને ǐƺતુ̍ ત શͅ કરાે. 
ƺલાઇડ્સને ƿમમાં રજૂ કરવા માટે હેડલાઇʉને યાેƝય રીતે સેટ કરાે. 

 ǐƺતુ̍ ત સેવ અને શેર કરવી: "File" મેનમુાં "Save" અથવા "Save As" ̍વકˍથી ફાઇલ સાચવાે. 
ǐƺતુ̍ તને PDF, Video અથવા PowerPoint Show ફાેમ̳ટમાં અેȋપાેટƙ કરી શકાય છે. 
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સૂચનાે: 

 ǐƺતુ̍ તને અસરકારક બનાવવા માટે ટંૂકા અને ˾ˠ લખાણનાે ઉપયાેગ કરાે. 

 ǍƸયમય અાકષƙણ વધારવા માટે હાઇ-Ȅાે̏ લટી ̎ચǋાે અને અે̏નમેશન ઉમેરાે. 

 ǐે̖Ƕસ ɦારા ƺલાઇડ શાે માટે અાɒ̍વ˝ાસ મેળવાે. 

PowerPoint 2019 નાે યાેƝય ઉપયાેગ ડેટાને ǍƸયમય અને અસરકારક રીતે રજૂ કરવાની કળા ̍વક̐સત 
કરવામાં મદદͅપ થાય છે, જ ેદરેક ǐƺતુ̍ તને Ǘેˤ બનાવે છે. 

3.2 પાવરપાેઈɰ ǐેઝɰેશન ખાેલવી 

Microsoft PowerPoint 2019 માં અગાઉ તૈયાર કરેલી ǐેઝɰેશન ખાેલવી ખૂબ સરળ છે. તે ફાઇલને 
ફેરફાર કરવા, રજૂ કરવા, અથવા નવી મા̋હતી ઉમેરવા માટે ઉપયાેગી છે. નીચે ǐેઝɰેશન ખાેલવાની ǐ̋ƿયા 
અને જͅરી પાસાઅાે જણાવવામાં અા˗ા છે. 

ǐેઝɰેશન ખાેલવાની પɡ̍ત 

PowerPoint ǐારંભ કરવું: Start મેનુમાંથી Microsoft PowerPoint 2019 ખાેલાે અથવા ડે˱ટાેપ પરના 
શાેટƙકટ પર ડબલ ̚ȃક કરાે. નીચે મુજબની ˲ીન ̀ેવા મળશે 

ફાઇલ ખાેલવા માટેના ̍વકˍાે: 

 File મેનુ: PowerPoint ખાેˑ ા પછી ટાેપ-લેʘ કાેનƙર પર "File" ̍વકˍ પસંદ કરાે. "Open" 
̍વકˍ પર ̚ȃક કરા.ે 

 શાેટƙકટ કી: કીબાેડƙ પર Ctrl + O દબાવી ǐેઝɰેશન ખાેલવાની ̍વɱાે ખાેલાે. 

ફાઇલ ˺ાન પસંદ કરવું: 

 "Open" ̍વકˍમાં ફાઇલ શાેધવા માટે નીચેના ̍વકˍાે મળશે: 

o Recent: તાજતેરમાં ખાેલેલી ફાઇલાે. 

o This PC: લાેકલ કƳʔુટર પર સેવ કરેલી ફાઇલાે. 

o Browse: ફાઇલ શાેધવા માટે ફાઇલ અેȋʕાેરર ખાેલાે. 

o OneDrive: ȃાઉડમાં સેવ કરેલી ફાઇલાે. 
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ફાઇલ પસંદ કરવી: 

 ǐƺતુ̍ તની ફાઇલને લાેકેશન પરથી શાેધી અને તેના પર ̚ȃક કરાે. 

 "Open" બટન પર ̚ȃક કરીને ફાઇલ ખાેલાે. 

ǉેગ અને ǉાેપ પɡ̍ત: 

 ̀ે પાવરપાેઈɰ ખલૂેલંુ હાેય તા ેડે˱ટાેપથી ફાઇલને પાવરપાેઈɰ ̍વɱા ેપર ǉેગ કરીને ǉાેપ કરા.ે 

ફાેમ̳ટ્સ અને સુસંગતતા 

 PowerPoint 2019 અે .pptx, .ppt, .odp, અને .ppsx જવેા ફાઇલ ફાેમ̳ટન ેસપાેટƙ કરે છે. 

 જૂના વઝƙનની ફાઇલાે ખાેલવા માટે, ફાઇલ ફાેમ̳ટનું ͅપાંતરણ કરવું ̀ેઈઅે. 

પાવરપાેઈɰ ǐેઝɰેશન ખાલેતી વખત ે̋ટƯસ 

 ફાઇલ સાચવેલી છે તે લાેકેશન યાદ રાખા,ે જથેી તે ઝડપથી મળી શકે. 

PowerPoint 2019 માં ǐેઝɰેશન ખાેલવા માટે "File > Open" ̍વકˍ સાૈથી સરળ પɡ̍ત છે. અા ǐ̋ƿયા 
તમારી ફાઇલને ફરીથી અȋૅસે કરવા અને નવા સંશાેધન માટે તયૈાર કરવામા ંમદદͅપ થાય છે. 

3.3 ǐેઝɰેશન સાચવવી 

Microsoft PowerPoint 2019 માં તમારી ǐેઝɰેશનને યાેƝય રીતે સેવ કરવંુ અɔંત મહɗપૂણƙ છે, જેથી તમ ે
તેને ભ̍વˮમાં ફરીથી ખાલેી શકાે. ǐેઝɰેશન સેવ કરવા માટેના ̍વ̍વધ ̍વકˍાે ઉપલʤ છે, જ ે
વપરાશકતાƙના જ̋ͅરયાત અનસુાર મદદͅપ થાય છે. 
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ǐેઝɰેશન સેવ કરવાની પɡ̍ત 

ફાઇલ સાચવવાનું ǐાથ̍મક પગલંુ: 

 PowerPoint ̍વɱાે ખાેલીને ફાઇલ મેનુમાં જઈ "Save" અથવા "Save As" ̍વકˍ પર ̚ȃક કરાે. 

 કીબાેડƙ પર Ctrl + S દબાવીને ફાઇલ ઝડપથી સાચવી શકાય છે. 

 

ફાઇલ નામ અાપવંુ અને ˺ાન પસદં કરવંુ: 

 ડાયલાગે બાȋે ખૂˑ ા પછી ફાઇલન ેનામ અાપા.ે 

 ફાઇલ સાચવવા માટે કƳʔુટરના લાેકેશન, જમે કે Desktop, Documents, અથવા Drive પસંદ 
કરાે. 
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ફાઇલ ફાેમ̳ટ પસદં કરવંુ: 

 PowerPoint 2019 ફાઇલાે માટે ̋ડફાૅ˄  ફાેમ̳ટ .pptx છે. 

 ̀ે તમે જૂના વઝƙન સાથે સુસંગતતા ̀ળવવા માંગાે છાે, તાે .ppt ફામે̳ટ પસંદ કરા.ે 

 ǐેઝɰેશનને PDF તરીકે અȋેપાેટƙ કરવા માટે, "Save as type"માંથી PDF પસદં કરા.ે 
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અાટેાેસેવ સે̋ટ̬Ɲસ: 

 OneDrive અથવા SharePoint સાથે કનેǶેડ હાેય, તાે અાેટાેસેવ ફીચર અાપમેળે ફેરફારાે સાચવે 
છે. 

 File > Options > Save માં જઈ અાેટાેસેવ ̍વકˍ સ̋ƿય કરા.ે 

̍વકˍાે ɦારા ǐેઝɰેશન સાચવવી 

પહેલીવાર સાચવવી: 

 "Save As" ̍વકˍ પસંદ કરાે, જ ેફાઇલને ǐથમ વખત સાચવવા માટે છે. 

 તમા̈́ં લાેકેશન અને ફાેમ̳ટ પસંદ કરાે અને "Save" ̚ȃક કરાે. 

ફાઇલ અપડેટ કરવી: 

 ȱારે પહેલેથી સાચવેલી ફાઇલમાં ફેરફાર કરા,ે ɔારે "Save" ̍વકˍ પર ̚ȃક કરીને ફેરફારાે 
સાચવાે. 
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ફાઇલના બે વઝƙન બનાવવું: 

 ̀ે તમારે ǐેઝɰેશનના જુદા વઝƙન બનાવવા હાેય, તાે "Save As" નાે ઉપયાેગ કરીને નવા નામથી 
સાચવાે. 

ȃાઉડ પર સાચવવંુ: 

 "Save As" માંથી OneDrive અથવા SharePoint પસંદ કરીને ફાઇલ ȃાઉડમાં સાચવાે. 

̋ટƯસ અને ɪાનમાં રાખવાના મુɠા 

 ફાઇલને વપરાશકતાƙને સરળતાથી અાેળખી શકાય તેવા નામથી સાચવાે. 

 ̏નય̌મત રીતે Ctrl + S દબાવાે જથેી મહેનત બરબાદ ન થાય. 

 ફાઇલનું બેકઅપ OneDrive અથવા પƮેǉાઇવમાં રાખાે. 

ǐેઝɰેશન સાચવવાની ǐારં̑ભક ̋ƿયા PowerPoint 2019 માં ફાઇલને સુર̐Ɩત રાખે છે અને ̋રયલ-ટાઇમ 
સહયાેગ માટે પણ ઉપયાેગી છે. ફાઇલને યાેƝય ફાેમ̳ટ અને લાેકેશનમાં સાચવવી ǐાેફેશનલ અને શૈƖ̒ણક 
કામમાં અ̏નવાયƙ છે. 

4. ǐેઝɰેશનની રચના (Creation of Presentation) 

Microsoft PowerPoint 2019 અે ǐેઝɰેશન બનાવવા માટેનું શ̘Ǹશાળી સાધન છે. ǐેઝɰેશન બનાવવા 
માટે ̍વ̍વધ સાધનાે અને ̍વકˍાે ǐદાન કરવામાં અા˗ા છે, જેનાે ઉપયાેગ કરીને ǍƸયમય અને અસરકારક 
ǐƺતુ̍ ત તૈયાર કરી શકાય છે. 

ǐેઝɰેશન બનાવવાની ǐ̋ƿયા 

PowerPoint ǐારંભ કરવું: 

 Start મેનુમાંથી Microsoft PowerPoint 2019 અાેપન કરાે અથવા ડે˱ટાેપ પરના શાેટƙકટ પર 
̚ȃક કરાે. 

 ǐારં̑ભક ̍વɱાેમાં "Blank Presentation" અથવા પવૂ̳ બનાવેલી "Template" પસંદ કરાે. 
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શીષƙક ƺલાઇડ ઉમેરવી: 

 શીષƙક ƺલાઇડ અે ǐેઝɰેશનની ǐથમ ƺલાઇડ છે. 

 અહ̯ ǐેઝɰેશનનંુ શીષƙક અને ઉપશીષƙક લખાે. 

નવી ƺલાઇડ ઉમેરવી: 

 "Home" ટેબમાં "New Slide" ̍વકˍ પર ̚ȃક કરાે. 

 લેઅાઉટ પસંદ કરાે જમે કે Title and Content, Comparison, Picture with Caption વગેરે. 
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મા̋હતી દાખલ કરવી: 

 ટેȌ બાȋેમાં જͅરી મા̋હતી લખાે. 

 ̎ચǋા,ે અાકૃ̍તઅા,ે ચાટƙ અન ેટેબ˔ ઉમેરા.ે 

̋ડઝાઇન અને થીમ પસંદ કરવી: 

 "Design" ટેબમાં જઈને થીમ પસંદ કરા.ે 

 ƺલાઇડનંુ બેકǁાઉɱ અન ેરંગ-સંયાેજન વૈ̍વɪસભર ̋ડઝાઇન માટે ક˶માઇઝ કરા.ે 

 

અે̏ નમેશન અને Ǉાિɯશન ઉમેરવી: 

 "Animations" ટેબ ɦારા ƺલાઇડના તɗાે પર અે̏ નમેશન અસર ઉમેરા.ે 

 

 "Transitions" ટેબમાં ƺલાઇડ્સ બદલાવ માટે ̍વƣયઅુલ અસર પસંદ કરાે. 
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ǐેઝɰેશનની સમીƖા: 

 "Slide Show" ટેબમાં "From Beginning" પર ̚ȃક કરીન ેǐેઝɰેશન જુઅા.ે 

 બગ અથવા ભૂલ શાેધીને સુધારાઅાે કરાે. 

 

ǐેઝɰેશન સાચવવી: 

 "File" મેનુમા ં"Save" અથવા "Save As" ̍વકˍથી ફાઇલ સાચવાે. 

 ફાઇલન ે.pptx, PDF, અથવા વી̋ડયા ેફાેમ̳ટમા ંસાચવાે. 

ǐેઝɰેશન બનાવતી વખતે યાદ રાખાે: 

 ǐેઝɰેશન માટે ટંૂકા અને ˾ˠ પાેઈɰ્સ ઉમેરાે. 

 ǍƸયમય અાકષƙક બનાવવા માટે ઉȝ ગુણવɇાવાળા ̎ચǋાે અને અે̏નમેશનનાે ઉપયાગે કરાે. 

 બધા ƺલાઇડ્સ માટે સમાન ̋ડઝાઇન ̀ળવાે. 

 સાૈથી મહɗપૂણƙ મા̋હતીને હાઇલાઇટ કરાે. 

ઉદાહરણ 

માનાે કે તમારે અેક શૈƖ̒ણક ǐાજેǶે માટે ǐેઝɰેશન બનાવવું છે: 

 ǐથમ ƺલાઇડમાં ǐાેજǶેનું શીષƙક ઉમેરાે. 

 બી͂ ƺલાઇડમાં પ̋રચય લખાે. 

 પછીની ƺલાઇડ્સમાં માળખંુ, અાધારભતૂ ડેટા અને ઉપસંહાર ઉમેરા.ે 

 અંતે ǐાɘેાહન અાપવા માટે ̎ચǋાે અને અે̏નમેશન ઉમેરા.ે 

Microsoft PowerPoint 2019 ǐેઝɰેશન બનાવવાની ǐ̋ƿયાને સરળ અન ે સુગમ બનાવે છે. યાƝેય 
ʕા̏ન̬ગ, ̋ડઝાઇન, અને ǍƸયમય ǐભાવથી ǐેઝɰેશન વધુ અસરકારક બને છે. 

4.1 ટેƳʕેટના ે ઉપયાેગ કરીને ǐેઝɰેશન બનાવવી (Creating a Presentation 
Using a Template) 

Micros oft PowerPoint 2019 માં ǐેઝɰેશન બનાવવા માટે ટેƳʕેટ્સ અેક સરળ અને ઝડપી ̍ વકˍ ǐદાન 
કરે છે. ટેƳʕેટ્સ અે પૂવƙ̏નધાƙ̋રત લેઅાઉટ્સ અને ̋ડઝાઇન છે, જ ે સમય બચાવે છે અને ǐેઝɰેશનને 
˗ાવસા̍યક દેખાવ અાપે છે. 
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ટેƳʕેટનાે ઉપયાેગ કરીને ǐઝેɰેશન બનાવવાની ǐ̋ƿયા 

1. PowerPoint ખાેલા:ે Microsoft PowerPoint 2019 ચાલુ કરાે. હામે ̍વɱામેાથંી "New" ̍વકˍ 
પસંદ કરાે. 

 

2. ટેƳʕેટ પસંદ કરવંુ: 

o "Templates" હેઠળ ઉપલʤ ટેƳʕેટ્સમાંથી પસદં કરાે. 

o ̀ે તમે ઈȞા ેતાે "Search" બારનાે ઉપયાેગ કરીન ે̍વ̏શˠ ǐકારના ટેƳʕેટ માટે શાેધ કરી 
શકાે છા,ે જમે કે ̐બઝનેસ, અેȱુકેશન, માક̳̋ટ̬ગ વગેરે. 

3. ટેƳʕેટ લાેડ કરવંુ: 

o પસંદ કરેલા ટેƳʕેટ પર ̚ȃક કરાે અને "Create" બટન પર ̚ȃક કરાે. 

o ટેƳʕેટ લાેડ થયા પછી તનેી અદંર કɰેɰને ક˶માઇઝ કરી શકાય છે. 

 

4. મા̋હતી ઉમેરવી: 
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o શીષƙક અન ેઉપશીષƙક ઉમેરાે: શીષƙક ƺલાઇડમાં ǐેઝɰેશનનું નામ અને વધારાની ̍વગતાે 
લખાે. 

o સામǁી ઉમેરવી: દરેક ƺલાઇડમાં લખાણ, ̎ચǋા,ે અાકૃ̍તઅાે અન ેચાટ્ƙસ ઉમરેાે. 

 

5. ̋ડઝાઇનને ક˶માઇઝ કરવંુ: 

o ̀ે જͅરી હાેય, તાે "Design" ટેબમાં જઈન ેબેકǁાઉɱ રંગ, ફાɰૅ ˶ાઇલ અથવા થીમ 
પ̋રવ̍ત̭ત કરાે. 

o ટેƳʕેટન ેતમારા જ̋ͅરયાત ǐમાણ ેઅેડજ˶ કરા.ે 

6. અે̏ નમેશન અને Ǉાિɯશન ઉમેરવા: 

o "Animations" અને "Transitions" ટેબ ɦારા અે̏નમેશન અને Ǉાિɯશન અસર ઉમેરાે. 

o દરેક ƺલાઇડમાં અેકસરખી અને ̏ન̏˛ત શૈલી ̀ળવા.ે 

7. ǐેઝɰેશન સાચવવું: 

o "File" મેનુમાં "Save As" ̍વકˍને પસંદ કરીને ફાઇલ સાચવાે. 

o તે .pptx, PDF અથવા ̍વ̋ડઅાે ફાેમ̳ટમાં સેવ કરી શકાય છે. 

ટેƳʕેટ્સના ફાયદા 

 સમય બચાવે: ǐેઝɰેશન માટે અાધારભતૂ લેઅાઉટ તયૈાર હાેય છે. 

 ˗ાવસા̍યક દેખાવ: ǐેઝɰેશનના ̋ડઝાઇન તɗાે ˗ાવસા̍યક ગુણવɇાવાળા હાેય છે. 

 ન̍વકરણ માટે સરળતા: ટેƳʕેટન ેવપરાશકતાƙની જ̋ͅરયાત અનુસાર ક˶માઇઝ કરી શકાય છે. 
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યાદ રાખાે: 

 તમારા ̍વષય માટે યાેƝય ટેƳʕેટ પસંદ કરાે. 

 ̋ડઝાઇનમાં અાકષƙક દેખાવ માટે ફાેɰ્સ અને રંગાેનું ̌મǗણ યાેƝય રીતે કરાે. 

 સમાન ̋ડઝાઇન ̀ળવીને દરેક ƺલાઇડમાં ̗˺રતા રાખાે. 

ટેƳʕેટનાે ઉપયાેગ કરીને ǐેઝɰેશન બનાવવું સરળ અને કાયƙƖમ છે. તે તમને સમય બચાવવા ઉપરાંત 
ǐેઝɰેશનને અાકષƙક અને ˗ાવસા̍યક બનાવવામાં મદદ કરે છે. PowerPoint 2019 માં ઉપલʤ ટેƳʕેટ્સ 
નવું ǐેઝɰેશન બનાવવા માટે Ǘેˤ સાધન છે. 

4.2 ખાલી ǐેઝɰેશન બનાવવી (Creating a Blank Presentation) 

માઇƿાેસાેʘ પાવરપાેઈɰ 2019 અે ǐેઝɰેશʉ બનાવવા માટે અેક શ̘Ǹશાળી ટૂલ છે. તમે ȱારે નવાે 
ǐાેજǶે શͅ કરાે છાે, ɔારે અેક ખાલી ǐેઝɰેશનથી શͅઅાત કરવી અે Ǘેˤ ̍વકˍ હાેઈ શકે છે. નીચેના 
પગલાંઅાે ɦારા તમે ખાલી ǐેઝɰેશન બનાવી શકાે છાે: 

ખાલી ǐેઝɰેશન શͅ કરવું 

1. પાવરપાેઈɰ શͅ કરા ે
તમારા કƳʔુટર પર માઇƿાેસાેʘ પાવરપાેઈɰ અાેપન કરાે. 

2. "Blank Presentation" પસંદ કરાે 

˲ીન પર "New" ̍વકˍ હેઠળ "Blank Presentation" અાઇકન દેખાશે. અા પર ̚ȃક કરાે. 

3. ટાઈટલ ƺલાઇડ ઉમેરાે 

તમે ȱાં થી શ̈́ કરશાે, ɔાં પહેલી ƺલાઇડ ટાઈટલ ƺલાઇડ હશે. અામાં ǐેઝɰેશનનંુ શીષƙક અને 
ઉપશીષƙક ઉમેરાે 
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. 

નવી ƺલાઇડ્સ ઉમેરવી 

1. "Home" મેનુમાં "New Slide" બટન 
"Home" ટેબમાં જઈને "New Slide" બટન પર ̚ȃક કરાે. 

2. લેઅાઉટ પસંદ કરા ે
ǐƺતા̍વત મા̋હતીના ǐકાર માટે યાƝેય લેઅાઉટ પસંદ કરા,ે જમે કે "Title and Content" અથવા 
"Comparison". 

ક˶માઇઝેશન કરવંુ 

 ̋ડઝાઇનનાે ઉપયાગે 
"Design" ટેબમાં ̍વ̍વધ ટેʱલેટ્સ છે, તેમાંથી પસંદ કરીન ેતમા̈́ં ǐેઝɰેશન અાકષƙક બનાવા.ે 

 ફાેɰ્સ અને રંગાે ફેરફાર 
"Home" ટેબમાંથી તમારાં લખાણ માટે ̍વ̍વધ ફાɰ્ેસ અને રંગાે પસંદ કરી શકાય છે. 

અા રીત,ે તમે પાવરપાઈેɰ 2019 માં સરળતાથી અેક નવંુ અને ક˶માઇઝ ǐેઝɰેશન તૈયાર કરી શકાે છા.ે 

4.3 લખાણ દાખલ કરવું અને અે̋ડટ કરવુ ં(Entering and Editing Text) 

ǐેઝɰેશનમાં મા̋હતી ǐદાન કરવા માટે લખાણ અે મȕુ તɗ છે. માઇƿાસેાʘે પાવરપાેઈɰ 2019 તમને 
લખાણ દાખલ કરવા અને અે̋ ડટ કરવા માટે સરળ અન ેકાયƙƖમ સાધનાે ǐદાન કરે છે. અા કાયƙ કરવા માટે 
નીચેના પગલાં અનુસરા:ે 

ટેȌ બાેȋ પસંદ કરવંુ 
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 નવી ƺલાઇડ ઉમેરાે અથવા અમેાં રહેલા ટેȌ બાȋે પર ̚ȃક કરાે. ̀ે ટેȌ બાȋે ઉપલʤ ન હાેય, 
તાે "Insert" ટેબમાં જઈને "Text Box" ̍વકˍ પસંદ કરાે અને તમા̈́ં ટેȌ બાȋે ̋ƿયેટ કરા.ે 

 લખાણ દાખલ કરા ે

ટેȌ બાȋેમાં ̚ȃક કરીન ેતમારી કીબાેડƙ ɦારા લખાણ ટાઇપ કરાે. ǐƺતા̍વત મɠુાઅાનેે સં̐Ɩʏ અન ે˾ˠ 
રાખાે. 

લખાણમાં ફેરફાર (ટેȌ અે̋ડટ) કરવંુ 

 લખાણ પસંદ કરવંુ 

o અે̋ ડટ કરવા માટે ટેȌ બાȋેમાં ̚ȃક કરાે અને લખાણને હાઇલાઇટ કરા.ે 

o તમે માઉસ અથવા કીબાડેƙના શાટૅƙકટ્સનાે ઉપયાેગ કરીને લખાણ પસંદ કરી શકાે છાે. 

 ફાેɰ અને ફાેમ̳̋ટ̬ગ ફેરફાર 

 

o "Home" ટેબમાં ઉપલʤ ̍વકˍાેનાે ઉપયાેગ કરીન ે લખાણના ફાɰૅ, સાઇઝ, રંગ, અને 
અેલાઈʆેɰ બદલી શકાય છે. 

o ટુલબારમાં Bold, Italic, અન ેUnderline જવેા ̍વકˍા ેપણ ઉપલʤ છે. 

 ટેȌ ̋રʕેસ અથવા ̋ડલીટ કરવું 

o જૂનું લખાણ દૂર કરવા માટે લખાણ પસંદ કરીને "Delete" કી દબાવા.ે 

o નવંુ લખાણ દાખલ કરવા માટે ફરીથી ટાઇપ કરા.ે 

 બુલટ્ેસ અને નંબ̋ર̬ગ ઉમેરવી 

o "Paragraph" ̍વભાગમાં બલેુટ્સ અથવા નબં̋રગ̬નાે ઉપયાેગ કરીન ેલખાણને વધુ ̍વભા̏જત 
અને ઠાેસ બનાવાે. 

 અેલાઇનમɰે બદલાે 

o લખાણ ડાબે, જમણે અથવા મɪમાં ગાેઠવવા માટે "Alignment" ̍વકˍનાે ઉપયાગે કરાે. 

અા રીત,ે માઇƿાેસાʘે પાવરપાેઈɰ 2019 તમને તમારા લખાણને સરળતાથી દાખલ અને સંપા̋દત કરવાની 
સુ̍ વધા અાપે છે, જ ેǐેઝɰેશનને વધ ુǐભાવશાળી બનાવે છે. 
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4.4 ǐેઝɰેશનમાં ƺલાઇડ્સ ઉમરેવી અને દૂર કરવી (Inserting and Deleting 
Slides in a Presentation) 

ǐેઝɰેશન બનાવતી વખતે તમે નવી મા̋હતી ઉમેરવા માટે ƺલાઇડ્સ ઉમેરી શકાે છાે અથવા જͅરીયાતના 
અાધારે અનાવƸયક ƺલાઇડ્સ હટાવી શકાે છાે. માઇƿાેસાʘે પાવરપાેઈɰ 2019 અે અા ǐ̋ƿયા સરળ બનાવે 
છે. 

ƺલાઇડ ઉમેરવી 

 "Home" મેનુમાંથી "New Slide" ̍વકˍ પસંદ કરવા ે

o પાવરપાેઈɰની "Home" ટેબ પર ̀અાે. 

o "Slides" ̍વભાગમાં "New Slide" બટન પર ̚ȃક કરાે. 

o તમારી જ̋ͅરયાત અનુસાર લેઅાઉટ પસંદ કરાે, જમે કે "Title Slide", "Title and Content", 
"Section Header" વગરેે. 

 શાૅટƙકટ કીનાે ઉપયાેગ કરવાે 

o નવી ƺલાઇડ ઉમેરવા માટે, કીબાેડƙ પર Ctrl + M દબાવાે. 

o અા તમને તȿાલ નવું ƺલાઇડ ઉમેરવા દે છે. 

 ̍વ̐શˠ ƺલાઇડનાે નકલ કરવાે 

o ̀ે તમે પહેલા થી ǐƺતુત ƺલાઇડને નકલ કરીને નવંુ ƺલાઇડ બનાવવા માંગતા હાે, તાે તે ƺલાઇડ 
પર રાઇટ-̚ȃક કરાે અને "Duplicate Slide" ̍વકˍ પસંદ કરાે. 

ƺલાઇડ દૂર કરવી 

 ƺલાઇડ પસંદ કરવી: જ ેƺલાઇડ હટાવવી છે તેના થંબનેલ પર ̚ȃક કરાે. 

 રાઇટ-̚ȃક કરી "Delete Slide" પસદં કરવંુ: રાઇટ-̚ȃક કરવાથી મળેલ મેનુમાંથી "Delete 
Slide" ̍વકˍ પસંદ કરાે. 

 ̋કબાેડƙનાે ઉપયાેગ: ƺલાઇડ પસંદ કયાƙ પછી Delete કી દબાવાે. 

 

 મ̓˄પલ ƺલાઇડ્સ પસંદ કરવી 

o કƮǇાેલ કી દબાવી રાખીને અનેક ƺલાઇડ્સ પર ̚ȃક કરાે અને પછી તે તમામને અેક સાથે 
ઉમેરાે અથવા હટાવા.ે 

 ƺલાઇડ્સનું ˺ાન બદલવું 
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o ̀ે તમારે ƺલાઇડ્સનું ƿમ બદલવંુ હાેય, તાે તે થંબનેલથી ǉેગ અને ǉાેપ કરીને અનƿુ̌મત કરાે. 

માઈƿાેસાʘે પાવરપાેઈɰ 2019 માં ƺલાઇડ્સ ઉમેરવી અને દૂર કરવી અ ેǐેઝɰેશનને સુગમ અને ˗વ̗˺ત 
બનાવવા માટે અɔતં મહɗપૂણƙ કાયƙ છે. 

5. ƺલાઇડ્સ તૈયાર કરવી 

માઇƿાેસાʘે પાવરપાઈેɰ 2019 ƺલાઇડ્સને સુ˗વ̗˺ત રીતે ̋ડઝાઇન અને તૈયાર કરવા માટે સગવડ ǐદાન 
કરે છે. ǐેઝɰેશનને અાકષƙક અને અસરકારક બનાવતી Ǘેˤ ƺલાઇડ્સ તૈયાર કરવા માટે નીચનેા પગલાં 
અનુસરા:ે 

નવી ǐેઝɰેશન શͅ કરવી 

 ખાલી ǐેઝɰેશન પસંદ કરવંુ: પાવરપાેઈɰ શͅ કરીને "Blank Presentation" પર ̚ȃક કરાે. 

 ટેʱલટે પસંદ કરવું: "File" મેનુમાં જઈને "New" ̍વકˍમાંથી તૈયાર ̋ડઝાઇનવાળી ટેʱલેટ પસંદ 
કરાે. 

લઅેાઉટ પસંદ કરવંુ 

 ƺલાઇડ લેઅાઉટ પસંદ કરવંુ: 
"Home" ટેબમાં "Layout" ̍વકˍથી પસંદ કરા,ે જમે કે "Title Slide", "Title and Content", 
"Comparison" વગેરે. 

 ક˶મ લેઅાઉટ બનાવવંુ: 
તમારાં જ̋ͅરયાતાે મુજબ નવંુ લઅેાઉટ ક˶માઇઝ કરા.ે 

સામǁી ઉમેરવી 

ƺલાઈડમાં લખાણ, ̌પǴર, ǁા̋ફȋ, ચાટƙ, ̍વડીઅાે અન ેઅાેડીઅાે વગેરે ઉમેરવા માટે Insert  ટેબનાે 
ઉપયાેગ થાય છે.      

 

 લખાણ ઉમેરવંુ:  ƺલાઇડમાં ટેȌ બાȋેમાં ટાઈપ કરાે. "Insert" ટેબનાે ઉપયાેગ કરીને નવા ટેȌ 
બાેȋ ઉમેરાે. 

 ̌પǴર ઉમેરવંુ: "Insert" ટેબથી "Pictures" ̍વકˍ પર ̚ȃક કરીને તમારા કƳʔટુરમાં અાવેલ 
છબીઅા ેઉમેરાે. 

 ǁાʟ અને ચાટ્ƙસ ઉમરેવંુ: અાંકડાઅાે દશાƙવવા "Insert" ટેબથી "Chart" ̍વકˍનાે ઉપયાેગ કરાે. 
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 ̍વ̋ડઅાે અને અાૅ̋ડઅાે: જͅરી હાેય ɔારે મી̋ડયા ફાઇલાે ઉમેરવા માટે "Insert" ટેબમાં "Video" 
અથવા "Audio" પસંદ કરાે. 

̋ડઝાઇન લાગુ કરવી 

 ̎થʼ અન ે̋ડઝાઇʉ: "Design" ટેબમાં થીʼ પસંદ કરીને ƺલાઇડ્સને ˗ાવસા̍યક દેખાવ 
અાપાે. 

 બેકǁાઉɱ ક˶માઇઝ કરવુ:ં "Format Background" ̍વકˍથી રંગ અથવા પૃˤભૂ̌મ છબી 
ઉમેરાે. 

5. અે̏ નમેશન અને Ǉાં̎ ઝશન ઉમેરવું 

 અે̏ નમેશન: "Animations" ટેબમાંથી લખાણ અથવા ̎ચǋાે માટે અે̏નમેશન ઇફેǶ્સ પસંદ કરાે. 

 ƺલાઇડ Ǉાં̎ ઝશન: "Transitions" ટેબમાંથી અેક ƺલાઇડ્સ પરથી બી͂ ƺલાઈડ પર  જતી વખતે 
દેખાડવા માટે ઈફેǶ પસંદ કરાે. 

6. ƺલાઇડ્સનું પૂવાƙવલાેકન 

 ƺલાઇડ શાે: "Slide Show" ટેબમાં "From Beginning" પર ̚ȃક કરીને ǐેઝɰેશનનું 
પૂવાƙવલાેકન કરાે. 

 તકેદારીથી ચકાસણી:  લખાણ, ̋ડઝાઇન અને સામǁીમાં ભૂલાે તપાસાે અને તેને સુધારાે. 

ƺલાઇડ્સની તૈયારી અેક રચનાɒક અને ˗વ̗˺ત ǐ̋ƿયા છે જે પાવરપાેઈɰ 2019 ના સાધનાે અને 
̍વકˍાેની મદદથી સરળતાથી કરવામાં અાવી શકે છે. 

5.1 વડƙ ટેબલ અથવા અȋેેલ વકƙશીટ ઉમેરવી (Inserting Word Table or an 
Excel Worksheet) 

માઇƿાેસાેʘ પાવરપાેઈɰ 2019 માં તમે વડƙ ટેબલ અથવા અેȋેલ વકƙશીટ ઉમેરીને ǐેઝɰેશનને વધુ 
મા̋હતીǐદ અને અાકષƙક બનાવી શકાે છાે. અા ખાસ સુ̍ વધા ǐƺતુ̍ ત દર̌મયાન ડેટાને વધુ સા̈́ં ǐદ̏શ̭ત 
કરવામાં મદદͅપ બને છે. 

વડƙ ટેબલ ઉમેરવી 

 ƺલાઇડ પસંદ કરવી: ƺલાઇડમાં ȱાં તમે ટેબલ ઉમેરવા માંગતા હા,ે તે ˺ાન પસંદ કરાે. 

 "Insert" મેનુનાે ઉપયાેગ: 

o "Insert" ટેબ પર ̚ȃક કરાે અને પછી "Table" ̍વકˍ પસંદ કરાે. 

o ટેબલની પં̘Ǹ અને ƺતંભની સંȕા પસંદ કરાે. 
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̀તે ટેબલ ̋ડઝાઇન કરવંુ: 

 તમે ટેબલની ̋ડઝાઇનને "Table Design" ટેબમાંથી ક˶માઇઝ કરી શકાે છા.ે 

 રંગ, બાેડƙર ˶ાઇલ અને શે̋ડ̬ગ ઉમેરાે. 

અȋેેલ વકƙશીટ ઉમરેવી 

 ƺલાઇડમાં અાેʠેǶ ઉમેરવંુ: 

 "Insert" ટેબમાં જઈન ે"Object" ̍વકˍ પર ̚ȃક કરાે. 

 ખૂલીને બાેȋમાં "Microsoft Excel Worksheet" પસંદ કરાે અને "OK" બટન પર ̚ȃક કરાે. 

 

 ડેટા દાખલ કરવંુ: 

o અȋેેલ શીટ ƺલાઇડમાં ઉમેરાઈ જશે, ȱાં તમે અાંકડાઅાે દાખલ કરી અને સેવ કરી શકાે છાે. 
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o અȋેેલ શીટને તમારી જ̋ͅરયાત અનસુાર નાની અથવા માેટી કરી શકાય છે. 

 

 અેકસેલ ફાઇલ ̏લ̬ક કરવી (̍વકˍ તરીકે): 

o ̀ે તમારે પવૂƙ̗˺ત અȋેેલ ફાઇલ ̏લ̬ક કરવાની હાેય, તા ે"Insert Object" ̍વɱાેમાં "Create 
from file" ̍વકˍ પસંદ કરાે અને ફાઇલનાે પાથ અાપા.ે 

ડેટાને ફાેમ̳ટ કરવંુ 

 ડેટાને અૅ̋ડટ કરવંુ: ટેબલ અથવા વકƙશીટ પર ડબલ-̚ȃક કરીન ેસામǁીમાં ફેરફાર કરા.ે 

 અે̏ નમેશન ઉમેરવું: "Animations" ટેબથી ટેબલ અથવા વકƙશીટ માટે અે̏નમેશન લાગુ કરાે. 

̋ટƯસ 

 ̏લ̬ક કરેલ ડેટા અપડેટ: ̀ે અેȋેલ ફાઇલ ̏લ̬ક કરેલ હાેય, તાે તેને અપડેટ કરાે જથેી ǐેઝɰેશનમાં 
નવાે ડેટા રહે. 

 ટેબલના કદને ગાેઠવવંુ: ટેબલ અથવા વકƙશીટને માઉસથી ǉેગ કરીને ̋ફટ કરાે. 

અા રીત,ે પાવરપાેઈɰ 2019 માં વડƙ ટેબલ અથવા અȋેલે વકƙશીટ ઉમરેીને ǐેઝɰેશનને વધુ ǐભાવશાળી 
બનાવી શકાય છે. 

5.2 ̚ȃપ અાટƙ છબીઅાે ઉમેરવી (Adding Clip Art Pictures) 

̚ȃપ અાટƙ છબીઅાેનાે ઉપયાેગ ǐેઝɰેશનને અાકષƙક બનાવવામાં અને મા̋હતીને ͆Ƹયમાન બનાવવામા ં
મદદͅપ થાય છે. માઇƿાેસાʘે પાવરપાેઈɰ 2019 અે સરળતાથી ̚ȃપ અાટƙ ઉમેરવા માટેના સાધનાે ǐદાન 
કરે છે. 

̚ȃપ અાટƙ ઉમેરવાનું મહɗ 
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̚ȃપ અાટƙ છબીઅાેનાે ઉપયાગે કરવા પાછળના ફાયદા: 

 ǐેઝɰેશનને અાકષƙક બનાવે છે. 

 દશƙકાેને મા̋હતીને સરળતાથી સમજવામાં મદદ કરે છે. 

 ǐƺતાવનાને વધુ રસǐદ બનાવે છે. 

̚ȃપ અાટƙ ઉમેરવાના પગલાં 

1. "Insert" મેનુનાે ઉપયાેગ કરવાે: પાવરપાેઈɰની "Insert" ટેબ પર ̀ અાે. "Pictures" ̍ વકˍ પર ̚ ȃક 
કરાે અને પછી "Online Pictures" પસંદ કરાે. 

 

2. છબી શાધેવી: ખૂલીને ̍વɱાેમા,ં શાેધબારમાં તમારી જ̋ͅરયાત મુજબ કીવડƙ દાખલ કરા,ે જમે કે 
"Animals", "Technology", "Education" વગેરે. ǐƺતુત છબીઅામેાંથી પસંદ કરાે. 

 

3. છબી પસંદ કરવી અને ઉમરેવી: 

o તમારી પસંદગીની છબી પર ̚ȃક કરાે અને "Insert" બટન દબાવા.ે 
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o છબી ƺલાઇડમાં ઉમેરવામાં અાવશે. 

 

4. ̚ȃપ અાટƙ ક˶માઇઝ કરવી 

 છબીનું કદ ગાેઠવવંુ: માઉસનાે ઉપયાેગ કરીને છબીને ǉેગ કરીને તેનું કદ વધારવંુ કે ઘટાડવું. 

 છબીની ̘˺̍ત બદલવી: છબીને માઉસથી ǉેગ કરીને ƺલાઇડમાં ઇ̗Ȟત ˺ાન પર મકૂાે. 

 છબીમાં ફેરફાર કરવાે: "Picture Format" ટેબમાં ઉપલʤ ̍વકˍાેના ેઉપયાેગ કરીને છબીમાં 
ઇફેǶ્સ ઉમેરા,ે બાેડƙર નાખા ેઅથવા રંગ ક˶માઇઝ કરા.ે 

સૂચના ે
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 ગુણવɇાવાળી છબીઅાે: હંમેશા ઉȝ ગુણવɇાવાળી છબીઅાે પસંદ કરાે જથેી ǐેઝɰેશન 
˗ાવસા̍યક લાગે. 

 ǐમાણ ̀ળવા:ે ખુબજ વધુ છબીઅાે ઉમરેવાથી ǐેઝɰેશન ભરેલું લાગશ,ે તેથી માǋ જͅરી છબીઅા ે
જ ઉમેરાે. 

 ̚ȃપ અાટƙનાે યાƝેય ઉપયાગે કરીને તમે તમારી ǐેઝɰેશનને અસરકારક બનાવી શકાે છાે. 

5.3 અʈ અાેʠેǶ્સ ઉમેરવા (Inserting Other Objects) 

ǐેઝɰેશનમાં મા̋હતી વધુ ͂વંત બનાવવા માટે માઇƿાસેાʘે પાવરપાેઈɰ 2019માં ̍વ̍વધ ǐકારના અʈ 
અાેʠેǶ્સ ઉમેરવાની સુ̍ વધા છે. અા અાેʠેǶ્સમા ં શƯેસ, ચાટ̳, ́ાટƙઅાટƙ, ̍વ̋ડઅાેઝ, અને અʈ 
ઘટકાેનાે સમાવેશ થાય છે, જ ેǐેઝɰેશનને વધુ ͆Ƹયમાન અને અાકષƙક બનાવે છે. 

શƯેસ ઉમેરવા 

 "Insert" મેનુથી "Shapes" પસદં કરવંુ: "Insert" ટેબ પર ̚ ȃક કરા.ે "Shapes" ̍ વકˍ પર ̚ ȃક 
કરીને ̏લ˶માંથી ઇ̗Ȟત અાકાર (શેપ) પસંદ કરાે, જમે કે વતુƙળ, ચાેરસ અથવા તીર. 

 

 ƺલાઇડ પર શપે બનાવવંુ: માઉસની મદદથી શેપને ǉેગ કરીને ખૂણા અથવા કદ ગાઠેવા.ે 

 ફાેમ̳̋ટ̬ગ કરવું: "Shape Format" ટેબમાં રંગ, અાઉટલાઇન, અથવા શેડાે અʕેાય કરાે. 

́ાટƙઅાટƙ ઉમેરવા 
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 "Insert" મેનુથી "SmartArt" પસંદ કરવંુ: "Insert" ટેબ પર જઈને "SmartArt" ̍ વકˍ પસદં કરાે. 

 ́ાટƙઅાટƙ ગેલેરીમાંથી પસદંગી: ગેલેરીમાં ઉપલʤ ̋ડઝાઇʉમાંથી, તમારા ડેટાને દશાƙવતી યાƝેય 
́ાટƙ અાટƙ પસંદ કરાે. 

 

 ડેટા દાખલ કરવાે: પેનલમાં મા̋હતી દાખલ કરાે કે જ ેઅાપમેળે ́ાટƙઅાટƙમાં દેખાશે. 

 

ચાટ્ƙસ ઉમરેવા 

 "Insert" મેનુથી "Chart" પસંદ કરવંુ: "Insert" ટેબ પર ̚ȃક કરાે અને "Chart" ̍વકˍ પસંદ 
કરાે. 
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 ચાટƙ ǐકાર પસંદ કરવા:ે બાર, પાઈ, લાઇન અથવા અʈ અાંકડાકીય ચાટ્ƙસમાંથી પસંદ કરાે. 

 ડેટા દાખલ કરવાે: અȋેેલ શીટ અાેપન થાય છે, ȱાં તમે ચાટƙ માટે ડેટા દાખલ કરી શકાે છા ે

. 

મી̋ડયા ફાઇલાે ઉમેરવી 
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 ̍વ̋ડઅાે અથવા અાૅ̋ ડઅાે ઉમેરવંુ: "Insert" મેનુમાં "Video" અથવા "Audio" ̍વકˍ પસંદ કરીને 
મ˄ીમી̋ડયા ફાઇલાે ઉમેરા.ે તમે ફાઇલ તમારા કƳʔુટરથી લઈ શકાે છા ેઅથવા અાૅનલાઇન ̍ વ̋ડઅાેઝ 
̏લ̬ક કરી શકાે છાે. 

                                 

 ફાઇ˔: પીડીઅેફ, ડાેȂુમɰે અથવા અʈ અાʠેેǶ્સ માટે "Object" ̍વકˍનાે ઉપયાેગ કરાે. 

 

નીચે મુજબનાે ડાયલાેગ બાેƖ ઉમેરાઈ જશે જમેાં ફાઈલનાે ǐકાર પસંદ કરી OK બટન ̚ȃક કરાે  

 

યાદ રાખા ે

 સંપાદન સુ̍વધા: ઉમેરવામાં અાવેલા દરેક અાેʠેǶને "Format" ટેબથી ક˶માઇઝ કરી શકાય છે. 
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 મયાƙદા ̀ળવાે: વધુ અાેʠેǶ્સ ઉમેરીને ǐેઝɰેશનને ભરેલંુ ન બનાવાે. 

માઇƿાેસાʘે પાવરપાઈેɰ 2019માં અʈ અાʠેેǶ્સ ઉમેરીન,ે તમે તમારી ǐેઝɰેશનને વધ ુǐભાવશાળી 
અને ˗ાવસા̍યક બનાવી શકાે છાે. 

5.4 અાેʠેǶનું કદ બદલવંુ અને ˱ેલ કરવું (Resizing and Scaling an Object) 

માઇƿાેસાʘે પાવરપાેઈɰ 2019માં તમે તમારા ǐેઝɰેશનમાં ઉમેરેલા અાʠેǶ્ેસ (જમે કે ̎ચǋા,ે શેƯસ, ટેȌ 
બાȋે, વગેરે)નું કદ ગાેઠવી શકાે છાે અથવા તેને ˱ેલ કરીને યાƝેય માપમાં લાવી શકાે છાે. અા સુ̍ વધા 
ǐેઝɰેશનને વધુ સુ̠ વ̗˺ત અને અાકષƙક બનાવવામાં મદદ કરે છે. 

અાʠેેǶનું કદ બદલવાનું મહɗ 

 અાેʠેǶ્સને યાƝેય માપમાં લાવવા માટે. 
 ̋ડઝાઇનને ˗વ̗˺ત રાખવા માટે. 
 દરેક ઘટકને ɪાનાકષƙક બનાવવા માટે. 

અાʠેેǶનું કદ બદલવાના પગલા ં

 અાʠેેǶ પસંદ કરવંુ: ǐેઝɰેશનમાં જનેા કદમાં ફેરફાર કરવાે છે તે અાʠેેǶ પર ̚ȃક કરાે,. 

 ǉેગ અને ǉાપે વડે કદ બદલવંુ: અાેʠેǶની બાેડƙર પર નજરે પડતા માઉસ પાેઈɰસƙને (હેɱ˔) 
ઉપયાેગમા ંલા.ે માઉસથી તેને ǉેગ કરીને અાકૃ̍ત માેટંુ અથવા નાનું કરા.ે 

 ̏નધાƙ̋રત ǐમાણમા ંકદ ગાેઠવવું: "Shift" કી દબાવી રાખીને હેɱલ ખ̲ચા,ે જથેી અાʠેǶે તેના મૂળ 
ગુણાɇેરમાં રહે. 

અાʠેેǶનું ˱ેલ કરવાનુ ં

 "Format" ટેબનાે ઉપયાેગ:  અાʠેેǶ પસંદ કયાƙ પછી, "Picture Format" અથવા "Shape Format" 
ટેબ પર ̚ȃક કરાે. "Size" ̍વભાગમાં ચાǲેસ કદ (Height અને Width) દાખલ કરાે. 

 

 ǐમાણમા ં ˱ે̏લ̬ગ:Object પર Right Click કરતા નીચે મુજબ ǐથમ અાકૃ̍તમાં દશાƙવેલ Context 
Menu અાેપન થાય છે જમેાં "Size and Position" ̍વકˍને પસંદ કરતા જમણી બાજુ દશાƙવેલ ડાયલાેગ 
બાેƖ અાેપન થાય છે જમેાં "Scale" ̍વકˍમાં ચાǲેસ ટકા દશાƙવા,ે જમે કે 150% અથવા 75%. 
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યાદ રાખા ે

 અનુપાત ̀ળવાે: કદ (Size) બદલતી વખત,ે Lock Aspect Ratio ̍વકˍ ચેક રાખા ે જથેી 
અાેʠેǶના ેદેખાવ બદલાઈ ન ̀ય. 

 ફાેમ̳̋ટ̬ગ ̀ળવી રાખાે: ̎ચǋાે અથવા ǁા̋ફકલ ઘટકાનેી ગુણવɇા ̀ળવવા માટે અાʠેેǶને અનુકૂળ 
રીતે ˱ેલ કરા.ે 

 મયાƙ̋દત ફેરફાર: અાેʠǶેને અટેલંુ નાનું અથવા માટંુે ન કરાે કે તે ˾ˠ રીતે ન દેખાય. 

માઇƿાેસાʘે પાવરપાેઈɰ 2019 માં અાʠેેǶ્સનું યાƝેય રીતે કદ બદલવું અને ˱ ેલ કરવંુ તમારા ǐેઝɰેશનન ે
વધુ ˗ાવસા̍યક અને અસરકારક બનાવ ેછે. 

6. અાકષƙકતા ǐદાન કરવી (Providing Aesthetic) 

ǐેઝɰેશનને ǐભાવશાળી અને અાકષƙક બનાવવા માટે તનેા ǍƸય ઘટકાેને યાેƝય રીતે ̋ડઝાઇન કરવું ખૂબ જ 
મહɗનું છે. માઇƿાેસાʘે પાવરપાેઈɰ 2019માં ̍વ̍વધ સાધનાે ઉપલʤ છે, જ ેતમારી ǐેઝɰેશનને અાકષƙક 
દેખાવ સાથે ˗ાવસા̍યક બનાવે છે. તે દેખાવ સારાે બનાવે છે દશƙકાેનું ɪાન કેિƮǍત રાખે છે અને  મા̋હતીન ે
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સરળતાથી સમજવામાં મદદ કરે છે. તમે નીચે વણƙવેલ ̍વ̍વધ સુ̍વધાઅાેનાે ઉપયાેગ કરી અાકષƙકતા વધારી 
શકાે છાે.   

થીʼ અન ેશલૈીઅાે 

 ̌ǐ-̋ડઝાઇન ̎થʼ: Design ટેબ પર જઈને તયૈાર થીʼ પસંદ કરાે.  થીમ સાથે ફાેɰ, રંગ, અને 
બેકǁાઉɱ અાપમેળે બદલાઈ ̀ય છે. 

 ક˶મ રંગ અને ફાેɰ:  Customize Colors ̍વકˍનાે ઉપયાેગ કરીને થીમના રંગાે બદલાે. 
Customize Fonts નાે ઉપયાેગ કરીને લખાણને તમારી જ̋ͅરયાત મુજબનું બનાવાે. 

બેકǁાઉɱ અને શે̋ ડ̬ગ 

 ફાેમ̳ટ બેકǁાઉɱ: Design ટેબમાંથી Format Background ̍ વકˍ પસંદ કરાે. રંગ, ǁે̋ડયɰ, અથવા 
ટેȋચર ઉમેરાે. 

 ̌પǴરનાે ઉપયાેગ: બેકǁાઉɱ માટે ̌પǴર ઉમેરા,ે જે ̍વષય સાથે સરખાવી શકાય. 

ટેȌ અને ટાઇપાેǁાફી 

 ફાેɰ શૈલીઅાે: ફાેમ̳ટ બારમાંથી રાેચક ફાેɰ શૈલીઅાે પસંદ કરા.ે  "Bold", "Italic", અને "Underline" 
જવેા ǐભાવનાે ઉપયાેગ કરાે. 

 ફાેɰ સાઈઝ અને રંગ: મુȕ લખાણ માટે માટેાે ફાેɰ અને સાઇડ લખાણ માટે નાનાે ફાેɰ રાખા.ે 
લખાણને બેકǁાઉɱના રંગ સાથે સુમેળ રાખાે. 

̎ચǋાે અને ǁા̋ફકલ ઘટકા ે

 ઊંચી ગુણવɇાવાળા ̎ચǋાે: છબીઅાે અેચડીમાં ઉમેરાે, જ ે̋ડઝાઇનને ̍વƺતૃત બનાવે છે. 

 અાકાર અને અાઇકʉ: "Shapes" અને "Icons" નાે ઉપયાેગ કરીને ƺલાઇડ્સને સુંદર બનાવાે. 

અે̏ નમેશન અને Ǉાં̎ ઝશʉ 

 સƽૂમ અે̏નમેશન: "Animations" ટેબમાંથી અસરકારક અને મયાƙ̋ દત અે̏નમેશન પસંદ કરાે. વધુ 
અે̏ નમેશનથી ƺલાઇડને ભરી ન દાે. 

 ƺલાઈડ Ǉાં̎ ઝશʉ:  "Transitions" ટેબમાંથી ́ૂથ અને ǐાસં̎ગક Ǉાં̏ઝશʉ ઉમેરાે. 

સુમેળ અને સંતુલન 

 દરેક ƺલાઇડમાં સમાન ̋ડઝાઇન શૈલી ̀ળવાે. 

 લખાણ અને ̎ચǋાે વȝે સંતુલન રાખાે. 

યાદ રાખા ે
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 સરળતાનાે ઉપયાેગ: ̋ડઝાઇન ̌મ̏નમલ રાખા,ે જથેી દશƙકાેનું ɪાન ભંગ ન થાય. 

 ̍વષય સાથ ેસુમેળ:  ̋ડઝાઇન ̍વષય અને ǐƺતુ̍ તની ǐાથ̌મકતા સાથે ̀ેડાયેલી હાેવી ̀ેઈઅે. 

અા રીતે, પાવરપાેઈɰ 2019ના ̍વ̍વધ સાધનાેનાે ઉપયાગે કરીને તમે તમારી ǐેઝɰેશનને ǍƸયમય, અાકષƙક 
અને અસરકારક બનાવી શકાે છાે. 

6.1 લખાણની ǐƺતુ̍તને વધુ અાકષƙક બનાવવી 

માઇƿાેસાʘે પાવરપાઈેɰ 2019માં લખાણન ે વધુ ǐભાવશાળી બનાવવા માટે ̍વ̍વધ ટુ˔ અને ફીચસƙ 
ઉપલʤ છે. અા સાધનાેનાે ઉપયાેગ કરીન ેતમે લખાણને સરળ, અાકષƙક અને ǐભાવશાળી બનાવી શકાે છાે, 
જ ેǐƺતુ̍ ત દર̌મયાન દશƙકાેનુ ંɪાન કેિƮǍત રાખવામા ંમદદͅપ થાય છે. 

લખાણ ફાેમ̳̋ટ̬ગ 

લખાણને ફાેમ̳̋ટ̬ગ કરવા  Home ટેબમા ંઅાવેલ Font અને Paragraph ǁુપના ેઉપયાેગ કરી શકાય છે     

 

 ફાેɰ ˶ાઇલ અને કદ: પાવરપાેઈɰમાં ̍વ̍વધ ǐકારના ફાɰ્ેસ ઉપલʤ છે. મથાળાઅાે માટે માેટા 
ફાેɰ અન ેસમાન ƺલાઇડ માટે નાનાે ફાɰે પસંદ કરાે. 

 રંગ અને હાઇલાઇટ કરવંુ: લખાણના મહɗને દશાƙવવા માટે ̍વ̍વધ રંગાનેાે ઉપયાેગ કરાે. મુȕ 
મɠુાઅાેને Bold, Italic, અથવા Underline કરવંુ. 

 ટેȌ અેલાઇનમેɰ: લખાણને બરાબર ગાઠેવવા માટે Left, Centre, Right, અથવા Justify 
અેલાઇનમɰેનાે ઉપયાેગ કરાે. 

લખાણના ફાેમ̳ટમાં અસરાે ઉમેરવી 

 વડƙ અાટƙ:  Insert મેનુમાંથી WordArt ̍વકˍ પસંદ કરતા નીચે મજુબ દેખાય છે જનેાે ઉપયાેગ 
કરીને ટેȌને અાકષƙક શલૈીમાં ફેરવી શકાય છે. . 
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 છાયા (Shadow) અને ǐ̍ત̐બ̬બ (Reflection): Word Art Select કરી ̋રબનમાં Shape 
Format ટેબ અાવી ̀ય છે જમેાંથી Text Effects ̍વકˍનાે ઉપયાેગ કરીને છાયા, ǐ̍ત̐બ̬બ, 
અથવા Glow અસર ઉમરેાે. 

 

 
 ટેȌ ફેરમાવવંુ: Transform ̍વકˍથી ટેȌને વƿતા અથવા ઢાળમાં ગાેઠવાે. 

ટેȌને મુɠાસર કરવંુ 
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 બુલેટ પાેઇɰ્સ અને નંબ̋ર̬ગ: Home ટેબમાંથી Bullets અથવા Numbering ̍વકˍના ે
ઉપયાેગ કરીને લખાણને સરળતાથી વંચાય તે રીતે ગાેઠવાે. 

 મɠુા ˾ˠ કરવા: મȕુ મુɠાઅાેને લખાણના ટુકડાઅાેમા ં̍વભા̏જત કરા,ે જથેી તે સરળતાથી સમ͂ 
શકાય. 

  
બેકǁાઉɱ સાથે સુમેળ 

 ટેȌ માટે બેકǁાઉɱ રંગ પસંદ કરવાે: બેકǁાઉɱ સાથે ટેȌના ેરંગ સમુેળમાં હાવેાે ̀ેઈઅે. 

 પારદશƙકતા ઉમેરવી: ̀ે લખાણ છબી પર છે, તાે બકેǁાઉɱને થાડંુે ઝાંખંુ બનાવાે. 

અે̏ નમેશન અને Ǉાં̎ ઝશન 

 ટેȌ અે̏નમેશન: "Animations" ટેબમાંથી લખાણને અાવતા અથવા દૂર જતાં ǐભાવાે અાપાે. 

 અવાજ સાથે ટેȌ: ટેȌ અે̏નમેશનમાં અવાજ ઉમેરા,ે ̀ે તે જ̈́રી હાેય. 

યાદ રાખા ે

 સરળતા ̀ળવાે: ǐેઝɰેશન સરળ રાખાે અને ખૂબ વધુ અસરા ેન વાપરા.ે 
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 પુનરાવતƙન તપાસા:ે બધા ƺલાઇડમાં સમાન ફાેમ̳̋ટ̬ગ અને ̋ડઝાઇન ̀ળવાે. 

 વાંચવામાં સરળતા: ફાળવેલ સમયમયાƙદામાં લખાણ વાંચી શકાય તેવંુ હાેવંુ ̀ેઈઅે. 

અાવા ̍વ̍વધ સાધનાેનાે ઉપયાેગ કરીને તમે તમારા લખાણને વધુ અાકષƙક અને સમજણભયુ̫ બનાવી શકશાે, 
જ ેǐેઝɰેશનને વધુ ˗ાવસા̍યક બનાવે છે. 

6.2 રંગ અને રેખાની શલૈી સાથે કામ કરવુ ં(Working with Color and Line Style) 

ǐેઝɰેશનને અાકષƙક અને ˗ાવસા̍યક બનાવવામાં રંગ અને રેખાની શૈલી મહɗપૂણƙ ભૂ̌મકા ભજવે છે. 
માઇƿાેસાʘે પાવરપાઈેɰ 2019માં ̍વ̍વધ ટૂ˔ ઉપલʤ છે, જનેી મદદથી તમે રંગ અને રેખાની શલૈીને 
ક˶માઇઝ કરી શકાે છા.ે અાથી, તમે ǐઝેɰેશનને ǍƸયમય અને મનાેરમ બનાવી શકાે છાે. 

1. રંગ સાથે કામ કરવંુ 

 ̐ભɿ ભાગામેાં રંગ ઉમેરવાે: 

o ટેȌ માટે રંગ: લખાણ પસંદ કરાે અને Font Color ̍વકˍનાે ઉપયાેગ કરીને તે માટે યાƝેય રંગ 
પસંદ કરાે. 

o શેપ માટે રંગ: શેપ પર જમણી ̚ȃક કરાે અને Format Shape ડાયલાગે બાƖે ખુલે છે જમેા ં 
Fill ̍વકˍથી Fill Color પસંદ કરાે. 

  
o ƺલાઈડ બેકǁાઉɱ માટે રંગ: Design ટેબમા ંજઈ Format Background ̍ વકˍના ેઉપયાેગ 

કરાે. નીચે મુજબનાે Format Background ડાયલાેગ બાƖે ખુલે છે.   
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o ǁે̋ડયɰ રંગાે: રંગાેની ગંૂચવણ માટે ǁે̋ડયɰ રંગ પસંદ કરા.ે Gradient Fill ̍વકˍથી ̍વ̍વધ 
રંગ શેડ ઉમેરાે. 

o પારદશƙકતા ઉમરેવી: Format Background મા ંTransparency ƺલાઇડરનાે ઉપયાેગ કરીન ે
પૃʕ ભૂ̌મને પારદશƙક બનાવાે. 

રેખાની શૈલી (Line Style) સાથે કામ કરવંુ 

1. રેખાની ̀ડાઈ અને શૈલી ગાેઠવવી: અાેʠેǶ ̐સલેǶ કરાે અને Shape Format ટેબમાંથી  
Shape Outline પર ̚ȃક કરા.ે Weight ̍વકˍથી રેખાની ̀ડાઈ ગાેઠવાે અને "Dashes" 
̍વકˍથી શલૈી પસંદ કરાે (જમે કે ખૂણાવાળી, તૂટેલી). 

2. રેખાનાે રંગ બદલવાે: Shape Outline ̍વકˍમાંથી ઇ̗Ȟત રંગ પસંદ કરાે. 

3. રેખાના પેટનƙ: "Format Shape" ̍ વકˍમાં Sketched/Dashes પર ̚ ȃક કરીને રેખા માટે અલગ-
અલગ પેટનƙ અથવા અાકાર પસંદ કરાે. 
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રંગ અને રેખાના ઉપયાગે માટેના ǐɔƖ ઉદાહરણા ે

1. ચાટƙમા ંરંગ અન ેરેખા ઉમેરવી: ǁાʟ અને ચાટ્ƙસને વધુ ˾ˠ બનાવવા માટે, રંગીન રેખાઅાે અને રંગ 
ઉમેરાે. 

2. ટેબલ અને બાઉɱરીઝ: ટેબલમાં ̍વ̍વધ સે˔ માટે અલગ રંગાે અને બાઉɱરી શૈલી ગાઠેવા.ે 

3. ́ાટƙઅાટƙ ̋ ડઝાઇન: ́ ાટƙઅાટƙને ક˶માઇઝ કરવા માટે, દરેક ભાગ માટે અલગ-અલગ રંગાે અને રેખાની 
શલૈી પસંદ કરાે. 

યાદ રાખા ે

 મયાƙ̋દત રંગાેનાે ઉપયાેગ કરા:ે બહુ વધારે રંગાેનાે ઉપયાેગ ǐેઝɰેશનને અ˗વ̗˺ત બનાવે છે, તેથી 
પસંદ કરેલા રંગાેની ચાેǲસ યાજેના બનાવા.ે 

 ̍વષય સાથ ેમેળ: રંગ અને રેખાની શૈલી ǐેઝɰેશનના ̍વષય સાથે મેળ ખાતી હાેવી ̀ેઈઅે. 

 વાȢપાન ̀ળવાે: બેકǁાઉɱ અને લખાણ વȝેનાે કાેƮǇા˶ યાƝેય હાેય, જથેી તે ˾ ˠ રીત ેદેખાય. 

માઇƿાેસાʘે પાવરપાેઈɰ 2019મા ં રંગાે અને રેખાની શૈલીના સમાન ઉપયાેગથી તમે ǐેઝɰેશનને વધુ 
ǐભાવશાળી અને ɪાનાકષƙક બનાવી શકાે છા.ે 
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6.3 મૂવી અને અવાજ ઉમેરવા ે(Adding Movie and Sound) 

માઇƿાેસાʘે પાવરપાઈેɰ 2019માં તમા̈́ં ǐેઝɰેશન વધુ અાકષƙક અને ઇɰરે̖Ƕવ બનાવવા માટે મૂવી અન ે
અવાજ (સાઉɱ) ફાઇલાે ઉમેરવાની સુ̍વધા છે. અા ફીચર દશƙકાેનું ɪાન વધુ કેિƮǍત રાખવામાં અન ે
સંદેશાઅાેને વધુ અસરકારક રીત ેપહા̲ચાડવામાં મદદͅપ થાય છે. 

1. મૂવી (̍વ̋ડઅાે) ઉમેરવંુ 

 ̍વ̋ડઅાે ફાઇલ ઉમરેવા માટેના પગલાં: Insert ટેબમાં ̀અાે. Video ̍વકˍ પસંદ કરાે અને નીચનેા 
̍વકˍામેાંથી અકે પસંદ કરાે: 

o This Device: તમારી કƳʔટુર પર રહેલી ̍વ̋ડઅાે ફાઇલ ઉમેરાે. 

o Online Video: ઇɰરનેટ પરથી ̍વ̋ડઅાે ̀ેડા.ે 

 

 ̍વ̋ડઅાે પસંદ કયાƙ પછી, તે ƺલાઇડમાં ǐદ̏શ̭ત થશ.ે 

 

 ̍વ̋ડઅાેનું ફાેમ̳̋ટ̬ગ: ̍વ̋ડઅાેની સાઇઝ ગાેઠવવા માટે માઉસ પાેઈɰરને ખૂણામાં લઇ જઈ ખ̲ચાે. 
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o Playback ટેબમાં જઈન,ે ̍વ̋ડઅાે અાપમેળે ચલાવવું કે ̚ȃક પર ચલાવવંુ છે ત ેપસંદ કરાે. 

 

 ̍વ̋ડઅાે માટે ̍વƺતતૃ ̍વકˍાે: 

o ̋Ǉમ ̍વ̋ડઅાે: ̍વ̋ડઅાેને તમારી જ̋ͅરયાત અનસુાર કાપાે. 

 

o ફેડ ઇન/અાઉટ: શͅ અથવા અંતે ̍વ̋ડઅાે માટે ફે̋ડ̬ગ અસર ઉમેરા.ે 

o Loop Until Stopped: ̍વ̋ડઅાે સતત શ̈́ રહે તે સુ̏ન̏˛ત કરાે. 
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2. અવાજ (સાઉɱ) ઉમેરવંુ 

 અવાજ ફાઇલ ઉમેરવા માટેના પગલાં: Insert ટેબ પર ̀અાે. Audio ̍વકˍ પસદં કરાે અને 
નીચેના ̍વકˍાેમાંથી અકે પસંદ કરાે: 

o Audio on My PC: તમારા કƳʔુટર પર રહેલી અવાજ ફાઇલ ઉમેરા.ે 

o Record Audio: પાવરપાેઈɰમાં નવા અવાજ રેકાેડƙ કરાે. 

 

o અવાજ ઉમેયાƙ પછી, ƺલાઇડ પર અેક ˾ીકર અાઇકન દેખાશે. 

 

 અવાજના ̏નયǋંણાે: "Playback" ટેબમાં અવાજના ǐારંભ ̍વકˍાે પસંદ કરા:ે 

1. Automatically: ǐƺતુ̍ ત શͅ થતાં જ અવાજ વગાડા.ે 

2. On Click: ̚ȃક પર અવાજ વગાડાે. 

o અવાજની અવકાશ (Volume) ગાેઠવાે અને "Loop Until Stopped" ̍વકˍ સેટ કરાે. 
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 ̋Ǉમ અવાજ: 

o અવાજના જͅરી ભાગાેને રાખવા માટે "Trim Audio" ̍વકˍનાે ઉપયાેગ કરા.ે 

 

મૂવી અન ેઅવાજના ફાયદા 

 ǐ̍તભાવ વધારવાે: ǍƸય અને Ǘા˗ ઘટકાે દશƙકાેન ેવધુ મȘ રાખે છે. 

 મȕૂ મુɠાઅાેને મજબતૂ બનાવાે: ̍ વ̋ડઅાે અથવા અવાજના ેઉપયાેગ કરીને જ̋ટલ ̍ વચારધારાઅાને ે
સરળ બનાવાે. 

 મનાેરંજન: ǐેઝɰેશનને વધ ુ͂વંત અને અાકષƙક બનાવાે. 

યાદ રાખા ે

 ફાઇલ માપ: ફાઇલનું માપ વધારે ન હાેય તે જુઅા,ે જથેી ǐેઝɰેશન સરળતાથી ચાલે. 

 મયાƙ̋દત ઉપયાેગ: માǋ જͅરી જƝયાઅે જ મૂવી અને અવાજ ઉમેરાે. 

 ફાેમ̳ટ: પાવરપાેઈɰમાં સપાટ̳ેડ ફાેમ̳ટ્સ (જમે કે MP4 અને MP3) વાપરા.ે 

માઇƿાેસાʘે પાવરપાઈેɰ 2019માં મૂવી અને અવાજ ઉમેરવાની સુ̍ વધા તમા̈́ં ǐેઝɰેશન વધુ કાયƙƖમ, 
ǐભાવશાળી અને મનારંેજક બનાવવા માટે મદદͅપ થાય છે. 

6.4 હેડર અને ફૂટર ઉમેરવા 

ǐેઝɰેશનમાં હેડર અને ફૂટર ઉમેરવાથી મા̋હતી વધુ ˗વ̗˺ત અને ˗ાવસા̍યક દેખાય છે. હેડર અન ે
ફૂટરમાં તારીખ, સમય, પાનું નબંર, અથવા ક˶મ ટેȌ ઉમરેવા માટે માઇƿાેસાʘે પાવરપાેઈɰ 2019માં સરળ 
ટૂ˔ ઉપલʤ છે. 

હેડર અને ફૂટર શંુ છે? 
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 હેડર: ƺલાઇડના ઉપરના ભાગમાં દેખાતું લખાણ અથવા મા̋હતી. 

 ફૂટર: ƺલાઇડના નીચેના ભાગમાં દેખાતું લખાણ અથવા મા̋હતી. 

 બંનેનાે ઉપયાેગ ƺલાઇડમાં વૈ̍વɪસભર મા̋હતી ઉમેરવા માટે થાય છે, જમે કે પેજ નંબર, તારીખ, 
અથવા લાેગાે. 

 

હેડર અને ફૂટર ઉમેરવા માટેના પગલા ં

 હેડર અને ફૂટર ટૂલને ખાેલા:ે Insert ટેબ પર ̚ȃક કરાે. Header & Footer ̍વકˍ પસંદ કરા.ે નીચ ે
મુજબનાે ડાયલાેગ બાƖે અાપેન થાય છે. 

 

 ફૂટર માટે ̍વકˍ પસંદ કરા:ે 

o Slide ટેબમાં નીચેના ̍વકˍાે દશાƙવવામાં અાવે છે: 

1. Date and Time: ǐƺતુત તારીખ અને સમય અથવા અકે નǲી તારીખ ઉમેરાે. 

2. Slide Number: ƺલાઇડ નંબર ǐદ̏શ̭ત કરાે. 

3. Footer: ફૂટર લખાણ દાખલ કરા,ે જમે કે ǐેઝɰેશનનું નામ અથવા સંદેશાે. 

 હેડર માટે ̍વકˍ પસંદ કરાે (નાેટ્સ માટે): 
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o ̀ે નાેટ્સ અને હેɱઅાઉટ્સ માટે હેડર ઉમેરવંુ હાયે, તાે "Notes and Handouts" ટેબ પર 
̚ȃક કરાે અને તમારી પસંદગી દાખલ કરાે. 

 લાગુ કરાે: 

o Apply: ફǸ કરɰ ƺલાઇડ માટે ફેરફાર લાગુ કરાે. 

o Apply to All: બધાં ƺલાઇડ્સ પર હેડર અને ફૂટર ઉમેરાે. 

 

હેડર અન ેફૂટર ક˶માઇઝ કરવું 

1. ફાૅɰ શૈલી અને સાઇઝ બદલવું: હેડર અથવા ફૂટર પસંદ કરાે અને Home ટેબમાંથી ફાૅɰ ˶ાઈલ 
અથવા સાઇઝ બદલા.ે 

2. ˺ાન ગાેઠવવંુ: ફૂટર બાેȋને ખ̲ચીને તેની ̗˺̍ત બદલાે. 

3. રંગ અન ેઅાકાર ઉમેરાે: વધુ અાકષƙક બનાવવા માટે ટેȌનાે રંગ બદલાે અથવા બાેડƙર ઉમેરાે. 

હેડર અન ેફૂટરના ઉપયાેગના ફાયદા 

 ǐેઝɰેશનની અાેળખ: ફૂટરમાં ǐાેજǶેનું નામ અથવા લાેગાે ઉમેરવાથી તે અલગ દેખાય છે. 

 ˗વ˺ા: દરેક ƺલાઇડ પર પેજ નંબર અને તારીખ ઉમેરવાથી ǐેઝɰેશન વધુ ˗વ̗˺ત લાગ ેછે. 

 ǐાસં̎ ગકતા: મહɗપૂણƙ મા̋હતી દશાƙવવા માટે ઉપયાેગી છે. 

યાદ રાખા ે

 મયાƙ̋દત મા̋હતી ઉમરેાે: હેડર અને ફૂટરમાં વધુ લખાણ ન ઉમેરાે, જથેી ƺલાઇડ ભરાયેલા ન લાગ.ે 

 અાઉટપુટ તપાસા:ે ǐેઝɰેશન શͅ કરવાના પહેલા હેડર અને ફૂટર બરાબર દેખાય છે કે નહ̯ તે 
તપાસાે. 

હેડર અને ફૂટર ઉમેરવાથી ǐેઝɰેશન વધુ ˗વ̗˺ત અને ˗ાવસા̍યક બને છે. માઇƿાેસાેʘ પાવરપાેઈɰ 
2019ના ટૂ˔ ɦારા તમે સરળતાથી અા ̍વગતાે ઉમેરીને તમારી ǐેઝɰેશનને વધુ અસરકારક બનાવી શકાે છા.ે 

7. ƺલાઇડ્સની ǐƺતુ̍ત 

ǐેઝɰેશનને સફળ બનાવવા માટે ƺલાઇડ્સની ǐƺતુ̍ તની યાેƝય તૈયારી અને રજૂઅાત મહɗપણૂƙ છે. 
માઇƿાેસાેʘ પાવરપાેઈɰ 2019માં ƺલાઇડ્સને ǐƺતુત કરવા માટે ̍વ̍વધ ટૂ˔ અને ̍વકˍાે ઉપલʤ છે, જે 
તમને સુંદર અને ǐભાવશાળી ǐેઝɰેશન બનાવવામાં મદદ કરે છે. 

ǐેઝɰેશન શͅ કરવું 
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1. Slide Show માડે ચાલુ કરવંુ: Slide Show ટેબ પર ̀અાે. From Beginning ̍વકˍ પસંદ 
કરીને ǐેઝɰેશનની શͅઅાતથી શͅ કરાે. From Current Slide ̍ વકˍ પસદં કરીને તમા̈́ં ǐƺતુત 
ƺલાઇડથી શͅ કરાે. 

 

2. શાૅટƙકટ કી: 

o "F5" દબાવીન ેǐઝેɰેશન શͅ કરાે. 

o "Shift + F5" દબાવીને વતƙમાન ƺલાઇડથી શͅ કરાે. 

ǐેઝɰેશન દર̍મયાન ̏નયǋંણ 

1. ƺલાઇડ બદલાે: માઉસ ̚ȃક, કીબાેડƙના અૅરા ેકી, અથવા ̋રમાેટ ̋ડવાઇસનાે ઉપયાેગ કરીને અાગળ 
અથવા પાછળની ƺલાઇડ પર ̀અાે. 

2. ƺલાઇડ શાૅ રાેકાે: Esc કી દબાવવાથી ǐેઝɰેશન બંધ થાય છે. 

3. ˲ીન Ʊલકે અથવા ˚ાઇટ કરવું: "B" દબાવવાથી ˲ીન Ʊલેક થાય છે અને "W" દબાવવાથી ˲ીન 
˚ાઇટ થાય છે. 

 

ǐેઝɰેશન ̍વકˍા ે

1. લેસર પાેઇɰર અને પેન ટૂલ: ǐેઝɰેશન દર̌મયાન ɪાન ખ̲ચવા માટે Ctrl + P દબાવાે અને પેન 
ટૂલથી લખાણ કરા.ે લેસર પાેઇɰર માટે Ctrl + L નાે ઉપયાેગ કરાે. 
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2. ̋ટʑણીઅાે (Notes): ǐેઝɰેશન દર̌મયાન ̋ટʑણીઅાે (Notes)નાે ઉપયાેગ કરીને જ̋ટલ મુɠાઅા ે
સરળતાથી સમ̀વાે. 

3. Slide Timing: ̀ે તમે ƺલાઇડ અાપમેળે અાગળ વધારવા માંગતા હાે, તાે "Rehearse Timings" ના ે
ઉપયાેગ કરાે. 

ǐેઝɰેશન પૂણƙ કરવુ ં

1. ƺલાઇડ શાૅ બંધ કરવું: અાખરે Esc કી દબાવાે અથવા End Slide Show ̍વકˍ પસંદ કરાે. 

2. ǐ̍તસાદ માટે સમય અાપાે: દશƙકાેના ǐ˜ાે અથવા ǐ̍તસાદ માટે સમય ગાેઠવાે. 

યાદ રાખા ે

 અʬાસ: ǐેઝɰેશનની તૈયારી પહેલા વારંવાર ǐે̖Ƕસ કરાે. 

 સાધનાેનાે ઉપયાેગ: લેસર પાેઇɰર, પેન ટૂલ, અને ટાઈ̌મ̬ગ જવેા સાધનાેનાે યાેƝય ઉપયાેગ કરાે. 

 સરળ અને ˾ˠતા: ǍƸયાે અને લખાણ સાહ̏જક અને ˾ˠ હાેવું ̀ેઈઅે. 

માઇƿાેસાેʘ પાવરપાેઈɰ 2019ના Slide Show ફીચરનાે યાેƝય ઉપયાેગ કરીને તમે તમારી ǐેઝɰેશનને વધુ 
ǐભાવશાળી અને ˗ાવસા̍યક બનાવી શકાે છા,ે જ ેદશƙકાે પર ઉɇમ છાપ છાેડે છે. 

7.1 ǐેઝɰેશન ̀ેવુ ં(Viewing A Presentation) 

માઇƿાેસાેʘ પાવરપાેઈɰ 2019માં ǐેઝɰેશન ̀ેવાની ǐ̋ƿયા ખૂબ જ સરળ છે. ̍વ̍વધ દેખાવના ̍વકˍાેના ે
ઉપયાેગ કરીને તમે ǐેઝɰેશનની ગાેઠવણ અને અʬાસ કરી શકાે છાે. અા ̍વ̍વધ ǐકારના દેખાવ 
ǐેઝɰેશનને ગાેઠવવા અને સમજૂતી માટે મદદͅપ થાય છે. 

ǐેઝɰેશન ̀ેવાની ̍વ̍વધ પɡ̍તઅાે 

a. નાેમƙલ ˗ુ (Normal View): અા દેખાવમાં તમે ƺલાઇડ, ƺલાઇડના નાેટ્સ, અને થંબનેલ પેન ̀ેઈ શકાે 
છાે. અા ̗˺̍ત ǐેઝɰેશન બનાવવા અને અે̋ડટ કરવા માટે ઉપયાેગી છે. View ટેબમાં જઈ Normal ̍વકˍ 
પસંદ કરાે. 
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b. ƺલાઇડ સાેટƙર ˗ુ (Slide Sorter View): અા ̗˺̍તમાં તમામ ƺલાઇડ્સ થંબનલે ̄ͅપે દેખાય છે. તમે 
ƺલાઇડની ƿમ બદલી શકાે છા ેઅને પુનઃગાેઠવણ કરી શકાે છાે. View ટેબમાં Slide Sorter ̍વકˍ પસંદ 
કરાે. 

 

c. રી̋ડ̬ગ ˗ુ (Reading View): 

 અા ˗ુમાં તમે  ફૂલ ˲ીન માેડમાં ગયા વગર ǐેઝɰેશન ̀ેતા હાે અેવાે અનુભવ કરી શકાે છાે . 

  "View" ટેબમાં "Reading View" ̍વકˍ પસંદ કરાે. 
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d. ƺલાઇડ શાે ˗ુ (Slide Show View): અા ̗˺̍ત ǐેઝɰેશન દશાƙવતી હાેય છે. દશƙકાેન ેǐƺતુ̍ ત કરતા 
પહેલા અા માેડનું પરીƖણ કરાે. Slide Show ટેબમાં From Beginning અથવા From Current Slide 
પસંદ કરાે. 

શાટૅƙકટ કી ɦારા ǐેઝɰેશન ̀ેવંુ 

 F5: ǐેઝɰેશનની શͅઅાતથી શાે જુઅા.ે 

 Shift + F5: વતƙમાન ƺલાઇડથી શાે જુઅાે. 

ǐેઝɰેશનની સુ̍વધાઅાે 

1. ઝૂમ કાયા̳ (Zoom Features): તમે દરેક ƺલાઇડ પર ઝૂમ ઇન અથવા અાઉટ કરી શકાે છાે. View 
ટેબમાં Zoom ̍વકˍ પસંદ કરાે. 

2. ƺલાઇડ નાેટ્સ ̀ ેવા: દરેક ƺલાઇડ સાથે નાેટ્સ ઉમેરી શકાય છે જ ેǐેઝɰર માટે માગƙદ̏શ̭કા ͅપે કામ 
કરે છે. Notes પેન પર જઈને નાેટ્સ લખાે. 

3. મ˄ી-̍વ̬ડા ે˗ુ: અેક સાથે ̍વ̍વધ ƺલાઇડસ પર કામ કરવા માટે મ˄ી-̍વ̬ડાે માેડ પસદં કરાે. View 
ટેબમાં New Window ̚ȃક કરાે. 

યાદ રાખા ે

 અʬાસ કરા:ે ǐેઝɰેશન બતાવવાના પહેલા દરેક દેખાવનું મૂˑ ાંકન કરાે. 

 ɔાં સુધી ̀ેવા ̀વ: નાેમƙલ, ƺલાઇડ સાેટƙર અને ƺલાઇડ શાે ˗ુ વȝે ̗̄ચ કરી ગાેઠવણ અન ે
Ǘેણી સુ̏ ન̏˛ત કરાે. 

 ઝડપી Ǎ̑ˠ: ̀ે તમે ઝડપથી ƺલાઇડ ̀ેવા માંગતા હાે, તાે ƺલાઇડ પેનલનાે ઉપયાેગ કરાે. 
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માઇƿાેસાʘે પાવરપાેઈɰ 2019માં ǐેઝɰેશન ̀ ેવાની ̍ વ̍વધ રીતાે તમને ƺલાઇડ્સને વધુ સચાટે બનાવવામાં 
અને Ǘેˤ ǐƺતુ̍ ત સુ̏ ન̏˛ત કરવામાં મદદ કરે છે. 

7.2 ǐેઝɰેશન માટે સેટઅપ પસંદ કરવું (Choosing a Set Up for Presentation) 

ǐેઝɰેશન માટે યાƝેય સેટઅપ પસંદ કરવું ખૂબ જ મહɗનું છે, કેમ કે તે તમારા ǐેઝɰેશનના રજુઅાતના 
ǐભાવને ̏નયં̍ǋત કરે છે. માઇƿાેસાʘે પાવરપાેઈɰ 2019માં ̍વ̍વધ સેટઅપ ̍વકˍાે ઉપલʤ છે, જ ે
ǐેઝɰેશનની ͅપરેખા અને દેખાવમાં મદદͅપ થાય છે. 

ǐેઝɰેશન સેટઅપનું મહɗ 

 દશƙકાે માટે અનુકૂળતા: તમારી ǐેઝɰેશન કેટલા લાકેાે ̀ેઈ ર̈ા છે અને તે કાેના માટે છે તે અાધાર 
પર સેટઅપ પસંદ કરાે. 

 ફાેમ̳̋ટ̬ગ અને ગાઠેવણ: તમારી સામǁી યાƝેય રીત ેદશાƙવવા માટે સટેઅપની જ̋ͅરયાત છે. 

 ઉપકરણ સુસગંતતા: ǐાેજǶેર અથવા ˲ીન માટે યાƝેય ̋રઝાેˑુશન અને સાઇઝ પસંદ કરાે. 

 

 

ǐેઝɰેશન સેટઅપ માટેના ̍વકˍા ે

a. ˲ીન સાઇઝ અને ̋દશા (Slide Size and Orientation): Design ટેબ પર ̀અાે અને Slide 
Size પસંદ કરાે. બે ̍વકˍામેાંથી પસંદ કરા:ે 

 

o Standard (4:3): પરંપરાગત ˲ીન માટે યાƝેય. 

o Widescreen (16:9): અાધુ̏નક ǐાેજǶેર અને માે̏નટર માટે યાેƝય. 
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o Custom Slide Size પર ̚ȃક કરતા નીચે મુજબનાે ડાયલાેગ બાƖે અાેપન થાય છે જમેા ં
ƺલાઇડની ̋દશા બદલવા માટે Portrait અથવા Landscape પસંદ કરાે. 

 

b. ǐેઝɰેશન માેડ (Presentation Mode): Slide Show ટેબમાં ̀અાે. Set Up Slide Show 
̍વકˍ પસંદ કરાે અને નીચનેા ̍વકˍાેમાંથી અેક પસંદ કરાે: 

o Presented by a Speaker: ફુલ-˲ીન ǐેઝɰેશન. 

o Browsed by an Individual: ̍વજટે અાપમેળે અાગળ વધે. 

o Browsed at a Kiosk: ̄ચા̏લત અન ેલૂપ માેડ માટે. 
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c. ̋રઝાેˑ ુશન સેટઅપ: Slide Show ટેબમાં Monitor ̍વભાગ પર ̀અાે. ˲ીન માટે યાƝેય ̋રઝાેˑુશન 
પસંદ કરાે. 

 

ǐેઝɰેશન સેટઅપના પગલા ં

1. Slide Show સેટઅપ ખાેલાે: Slide Show ટેબ પર ̚ȃક કરાે અને Set Up Slide Show 
̍વકˍ પસંદ કરાે. 

2. અાપમેળે અથવા હાથથી ǐƺતુ̍ ત: ̀ે ǐેઝɰેશન રજુઅાત અાપવી હાેય, તાે મેʈુઅલ સેટઅપ 
પસંદ કરાે. ̄ચા̏લત ǐેઝɰેશન માટે Browsed at a Kiosk ̍વકˍ પસંદ કરાે. 

3. ƺલાઇડ ટાઈ̍મ̬ગ ગાઠેવાે: Rehearse Timings ̍વકˍનાે ઉપયાગે કરીને ǐɔેક ƺલાઇડ માટે 
સમય ̏નધાƙ̋ રત કરાે. 

4. ઉપકરણ પસંદ કરાે: ǐાેજǶેર કે માે̏ નટર માટે Monitor ̍વભાગમાં યાƝેય ̋ડƺʕે પસંદ કરાે. 
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યાદ રાખા ે

 દશƙકાેને ɪાનમાં રાખાે: ̀ે તમે માેટી ˲ીન પર રજુઅાત કરી ર̈ા છા,ે તાે Widescreen (16:9) 
સાઇઝ પસંદ કરા.ે 

 રંગાેની ચકાસણી કરાે: ǐાેજǶેર સાથે રંગાેની સુસંગતતા તપાસાે. 

 ǐયાેગશાળાના સેટઅપનું પરીƖણ કરા:ે ǐેઝɰેશનની ગ̍તશીલતા અને દેખાવ ચકાસવા માટે 
̋રહસƙલ માેડમાં ચલાવાે. 

ǐેઝɰેશન સેટઅપના ફાયદા 

 ˗વ̘˺તતા: દરેક ƺલાઇડ યાેƝય રીતે ǐદ̏શ̭ત થાય છે. 

 અનુકૂળતા: રજુઅાતનંુ અાકાર અને ̋દશા દશƙકાે માટે વધુ અનુકૂળ બને છે. 

 ˗ાવસા̍યક અસર: યાેƝય સેટઅપ તમારી ǐેઝɰેશનને વધુ ˗ાવસા̍યક બનાવે છે. 

માઇƿાેસાેʘ પાવરપાેઈɰ 2019માં ǐેઝɰેશન માટે યાેƝય સેટઅપ પસંદ કરીન,ે તમે તમારી રજુઅાતને વધુ 
ǐભાવશાળી અને દશƙકાે માટે યાેƝય બનાવી શકાે છાે. 

7.3 ƺલાઇડ્સ અને હેɱઅાઉટ્સ ̌ǐɰ કરવી (Printing Slides And Hand-outs) 

ƺલાઇડ્સ અને હેɱઅાઉટ્સ ̌ǐɰ કરવાથી ǐેઝɰેશનને વધુ ˗વ̗˺ત અને ˗વસા̍યક બનાવવામાં 
મદદ મળે છે. અા ̌ǐɰઅાઉટ્સ ǐેઝɰેશન દર̌મયાન દશƙકાેને જͅરી મા̋હતી પૂરી પાડવામાં ઉપયાેગી થાય છે. 
માઇƿાેસાેʘ પાવરપાેઈɰ 2019માં ƺલાઇડ્સ અને હેɱઅાઉટ્સ ̌ǐɰ કરવા માટે સરળ અને સુ̍વધાજનક 
̍વકˍાે ઉપલʤ છે. 

̌ǐɰ કરવા માટેની તૈયારી 

1. ̌ǐɰ સે̋ટ̬ગ તપાસાે: તમા̈́ં ̌ǐɰર ̀ેડાયેલ છે તે સુ̏ન̏˛ત કરાે. ƺલાઇડ્સમાં યાેƝય માપ, રંગ, અન ે
ફાેમ̳ટ ગાેઠવાે. 

2. ̐સલેǶ કરાે કે શું ̌ǐɰ કરવંુ છે: સંપૂણƙ ǐેઝɰેશન ̌ǐɰ કરવી છે કે ફǸ પસંદ કરેલી ƺલાઇડ્સ. 
હેɱઅાઉટ્સ, નાટ્ેસ, અથવા અાઉટલાઇન માટેના ̍વકˍ પસંદ કરાે. 

ƺલાઇડ્સ ̌ǐɰ કરવાના પગલાં 

1. ̌ǐɰ ̍વɱાે ખાેલાે: File મનૂે પર ̚ȃક કરાે અને "Print" ̍વકˍ પસંદ કરાે. 

2. ̌ǐɰર પસંદ કરા:ે ઉપલʤ ̌ǐɰરમાંથી તમારી પસંદગી કરાે. 

3. ̌ǐɰ રેƮજ ̏નધાƙ̋રત કરાે: "Print All Slides" પસંદ કરીને તમામ ƺલાઇડ્સ ̌ǐɰ કરાે. ̀ે ફǸ 
કેટલીક ƺલાઇડ્સ ̌ǐɰ કરવી હાેય, તાે તેમની રેƮજ દાખલ કરાે (જમે કે 1-5). 
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લઅેાઉટ પસંદ કરાે: 

o Full Page Slides: દરેક પાનાં પર અકે ƺલાઇડ. 

o Handouts: દરેક પાના ંપર અનેક ƺલાઇડ્સ (2, 4, 6, વગેરે). 

o Notes Pages: ƺલાઇડ સાથે નાેટ્સનાે સમાવેશ. 

o Outline: ફǸ ટેȌ ̌ǐɰ કરવા માટે. 

રંગ ̍વકˍ પસંદ કરાે: 

o Color: રંગીન ̌ǐɰ માટે. 

o Grayscale: શેડ્સ સાથે. 

o Pure Black and White: ˝ેત-કાળું ફાેમ̳ટ. 

̌ǐɰ શͅ કરાે: 

o "Print" બટન પર ̚ȃક કરાે. 

હેɱઅાઉટ્સ માટે ખાસ ગાઠેવણ 

 હેɱઅાઉટ્સ માટે અેક પાના ંપર કેટલી ƺલાઇડ્સ રાખવી તે પસંદ કરાે. 

 ̀ે દશƙકાે નાેટ્સ લખવા માંગે છે, તાે દરેક ƺલાઇડ સાથે લાઇન ઉમેરવા માટે ̍વકˍ પસદં કરાે. 
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યાદ રાખા ે

 ̌ǐ̔ɰ̬ગ પહેલા તપાસા:ે Print Preview માં ̌ǐɰની ગાેઠવણ અને દેખાવ તપાસાે. 

 પેપર સાચવાે: વધુ ƺલાઇડ્સને અેક પાનાં પર ̌ǐɰ કરાે, ખાસ કરીને હેɱઅાઉટ્સ માટે. 

 રંગાેની જ̋ͅરયાત મૂલવવંુ: ̀ે રંગ જͅરી ન હાેય, તાે Grayscale અથવા Black and White પસંદ 
કરાે. 

 અપડેટેડ ફાઇલ ̌ǐɰ કરાે: બધી સુધારાઅાે પછી ફાઇનલ વઝƙન જ ̌ǐɰ કરાે. 

ઉપયાેગના ફાયદા 

 દશƙકાે માટે ઉપયાેગી: હેɱઅાઉટ્સ દશƙકાેને ના̲ધ લેવા માટે મદદ કરે છે. 

 સૂચનમાળાની ˗વ˺ા: ̌ǐɰઅાઉટ્સ ɦારા તમા̈́ં ǐેઝɰેશન વધુ સુ˗વ̗˺ત બને છે. 

 ǐથમ Ǎ̑ˠમાં મા̋હતી ઉપલʤ: નાેટ્સ અને અાઉટલાઇન ̌ǐɰ કરી ǐƺતુ̍ ત માટે તૈયારી સરળ 
બને છે. 

માઇƿાેસાેʘ પાવરપાેઈɰ 2019માં ̌ǐ̔ɰ̬ગની સુ̍ વધાઅાનેાે ઉપયાેગ કરીને તમે દશƙકાે માટે વધુ અસરકારક 
ǐેઝɰેશન તૈયાર કરી શકાે છાે. 

8. ƺલાઇડ શાે (Slide Show) 

ƺલાઇડ શાે પાવરપાેઈɰમાં અેવી ǐ̋ƿયા છે ȱાં ǐેઝɰેશન સંપૂણƙ-˲ીન માેડમાં ̀ેવા અને રજૂ કરવા માટે 
તૈયાર થાય છે. ƺલાઇડ શાેનાે ઉપયાેગ દશƙકાેને સામǁી રજૂ કરવા માટે કરવામાં અાવે છે. માઇƿાેસાʘે 
પાવરપાેઈɰ 2019માં ƺલાઇડ શાે ફીચસƙનાે ઉપયાેગ કરવાે સરળ અને અસરકારક છે. 

ƺલાઇડ શાે માટે ̋ટƯસ 

 ǐે̖Ƕસ કરવી: ̋રહસƙલ માેડમાં ǐવેશીને ǐેઝɰેશનની તયૈારી કરાે. 

 ઉપકરણનું પરીƖણ: ǐાેજǶેર અને સાઉɱ ̐સ˶મ યાƝેય રીતે કામ કરી રહી છે તે ̏ન̏˛ત કરાે. 

 સરળતાથી ƿમ બદલાે: ̀ે જͅર હાેય, તાે "Slide Sorter View"માં જઈને ƺલાઇડ્સનાે ƿમ બદલાે. 

ઉપયાેગના ફાયદા 

 ˗વસા̍યક દેખાવ: ƺલાઇડ શાે ǐેઝɰેશનને વધુ અાકષƙક બનાવે છે. 

 સરળતાથી રજુઅાત: સંપૂણƙ-˲ીનમાં ǐેઝɰેશન કરવું સરળ બને છે. 

 દશƙકાે માટે ɪાન કેિƮǍત કરે છે: ̄Ȟ અને ˗વ̗˺ત શૈલીમાં મા̋હતી ǐદ̏શ̭ત થાય છે. 

માઇƿાેસાેʘ પાવરપાેઈɰ 2019માં ƺલાઇડ શાે સુ̍વધાઅાનેાે ઉપયાેગ કરીને તમે તમારી ǐેઝɰેશનને વધુ 
ǐભાવશાળી અને ˗ાવસા̍યક બનાવી શકાે છા ે
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8.1 ƺલાઇડ શાે ચલાવવુ ં(Running a Slide Show) 

માઇƿાેસાʘે પાવરપાેઈɰ 2019માં ƺલાઇડ શાે ચલાવવંુ અે ǐેઝɰેશન રજુઅાતનાે સાૈથી મહɗનાે ભાગ છે. 
ƺલાઇડ શાે ǐƺતુત કરવાનું Ǘેˤ માɪમ છે, જ ેદશƙકાે માટે તમારી સામǁીને અાકષƙક રીતે રજૂ કરે છે. 

ƺલાઇડ શાે શͅ કરવાનું મહɗ 

ƺલાઇડ શાે ɦારા તમે ǐેઝɰેશનને સંપૂણƙ-˲ીન માેડમાં ચલાવી શકાે છાે. 

 દશƙકાે માટે ǐાેફેશનલ ǐેઝɰેશન દશાƙવવા માટે. 

 ǐેઝɰેશનના ǐવાહન ે̏ન̏˛ત કરવા માટે. 

 કાેઈ ̍વƖેપ ̍વના સરળ ǐƺતુ̍ ત માટે. 

ƺલાઇડ શાે શͅ કરવાના પગલા ં

1. Slide Show ટેબથી શા ેશͅ કરવાે: પાવરપાેઈɰના Slide Show ટેબ પર ̚ȃક કરાે. From 
Beginning ̍વકˍ પસંદ કરીને ǐેઝɰેશનની શͅઅાતથી શા ેશͅ કરાે. From Current Slide 
̍વકˍ પસંદ કરીન ેવતƙમાન ƺલાઇડથી શાે શͅ કરાે. 

 

2. શાૅટƙકટ કીનાે ઉપયાગે: F5: ǐેઝɰેશનની શͅઅાતથી શાે શͅ કરવા માટે. Shift + F5: વતƙમાન 
ƺલાઇડથી શાે શͅ કરવા માટે. 

3. ક˶મ શા ેશͅ કરવાે: ̀ે પસંદ કરેલી ƺલાઇડ્સ સાથે શા ેચલાવવાે હાેય, તાે Custom Slide Show 
̍વકˍનાે ઉપયાગે કરાે. 

શા ેદર̍મયાન કામ કરવાનું મેનેજ કરવંુ 

1. ƺલાઇડ્સ ને̍ વગેટ કરવી: અાગળ જવા માટે માઉસ ̚ȃક કરાે અથવા  ࿸࿹࿺ અૅરા ેકી દબાવા.ે પાછળ 
જવા માટે  ငစဆ અૅરા ેકી દબાવા.ે 

2. ˲ીન કંǇાે̝ : B દબાવાે: ˲ીન Ʊલેક કરવા માટે. W દબાવાે: ˲ીન ˚ાઇટ કરવા માટે. 

3. લેસર પાેઇɰર અને પેન ટૂલ: Ctrl + L: લેસર પાેઇɰર ચાલુ કરવા માટે. Ctrl + P: પેન ટૂલથી 
લખવા માટે. 

4. અાક̖́ક જ̋ͅરયાત માટે: Esc: ƺલાઇડ શાે બંધ કરવા માટે. Right-click Menu: ̀ે તમે 
̍વ̏શˠ ƺલાઇડ પર જવા માંગાે છાે અથવા ǐƺતુ̍ ત રદ કરવી હાેય. 



 

  
SARDAR PATEL INSTITUTE OF PUBLIC ADMINISTRATION, AHMEDABAD 262 

 

 

શાે માટે ટાઈ̍મ̬ગ ગાેઠવવું 

 Rehearse Timings: ̋રહસƙલ માેડમાં જઈને દરેક ƺલાઇડ માટે સમય ગાેઠવા.ે ǐેઝɰેશન અાપમેળે 
ચાલે તે સુ̏ન̏˛ત કરા.ે 

 Set Up Slide Show: ̄ચા̏લત અથવા મેʈુઅલ માેડ પસંદ કરાે. ̀ે "Browsed at a Kiosk" 
̍વકˍ પસંદ કરવાે હાેય, તાે ǐેઝɰેશન અાપમેળે ચલાવાય છે. 

યાદ રાખા ે

 અનુકૂળ ǐદ̐શ̭ત કરાે: દશƙકાનેી અાસપાસની ̗˺̍ત ǐમાણે ƺલાઇડ શાે માટે ˲ીન સાઇઝ અને 
̋રઝાેˑુશન ગાેઠવાે. 

 ǐથમ પરીƖણ કરાે: ǐેઝɰેશન પહેલાં "Slide Show" માેડમાં બધંુ તપાસાે. 

 Annotation નાે ઉપયાેગ: ̀ે ƺલાઇડ શાે દર̌મયાન નાધ̲ાેની જͅર હાેય, તાે પેન ટૂલ અથવા 
હાઇલાઇટરનાે ઉપયાેગ કરા.ે 

 ̍વ˝ાસપૂવƙક રજૂઅાત કરાે: શાૅટƙકટ કીઅાે પર ઝડપથી ǐભુɗ મેળવાે જથેી તમા̈́ં ǐઝેɰેશન 
˗ાવસા̍યક દેખાય. 

ફાયદા 

 દશƙકાે માટે Ǘેˤ ǐભાવ: ƺલાઇડ શાે તમને સરળતાથી તમારી વાત રજૂ કરવામાં મદદ કરે છે. 

 ˗ાવસા̍યક ǐƺતુ̍ત: ǐાેફેશનલ અને ́ૂથ રજુઅાત ɦારા તમે વધુ અસર પાડી શકાે છાે. 

 સમયની બચત: ̄ચા̏લત ગ̍તશીલતા ɦારા. 

માઇƿાેસાેʘ પાવરપાેઈɰ 2019માં ƺલાઇડ શાે ચલાવવી સરળ છે અને ǐેઝɰેશનને વધુ અાકષƙક અને 
ǐભાવશાળી બનાવે છે. 

8.2 Ǉાં̎ઝશન અને ƺલાઇડ ટાઈ̍મ̬ગ (Transition and Slide Timings) 

Ǉાં̏ઝશન અને ƺલાઇડ ટાઈ̌મ̬ગ ǐેઝɰેશનને વધુ અાકષƙક અને ˗ાવસા̍યક બનાવ ેછે. Ǉાં̏ઝશન અે 
ƺલાઇડમાંથી ƺલાઇડમાં જવા માટેના ̍વƣયુઅલ ઈફેǶસ છે, ȱારે ƺલાઇડ ટાઈ̌મ̬ગ ɦારા ƺલાઇડની 
ǐƺતુ̍ તનાે સમય ગાેઠવાય છે. 

Ǉાં̎ ઝશન શું છે? 

Ǉાં̏ઝશન અે ƺલાઇડમાંથી બી̀ ƺલાઇડમાં પ̋રવતƙન લાવવા માટે ઉપયાેગમાં લેવાતા ઈફેǶસ છે. 

 અાને પસંદ કરી ƺલાઇડના ǐવાહને વધુ માેહક બનાવી શકાય છે. 
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 પાવરપાેઈɰ 2019માં ̍વ̍વધ ǐકારના Ǉાં̏ ઝશન ઈફેǶસ ઉપલʤ છે, જમે કે Fade, Wipe, Push, 
Split વગેરે. 

Ǉાં̎ ઝશન લાગુ કરવાના પગલા ં

 

1. ƺલાઇડ પસંદ કરાે: Ǉાં̏ ઝશન માટે જ ેƺલાઇડ પર ઈફેǶસ લાગુ કરવાે છે તે પસંદ કરાે. 

2. Transitional Effect પસંદ કરા:ે Transitions ટેબ પર ̚ȃક કરાે. Ǉાં̏ ઝશન ˶ાઈલ પસદં કરવા 
માટે ̍વ̍વધ ̍વકˍામેાંથી પસંદ કરા.ે 

 

3. ઈફેǶસ ̍વકˍાેને ક˶માઈઝ કરાે: Effect Options પર ̚ȃક કરીન ે̋દશા અથવા શલૈી 
બદલવા માટે ̍વકˍ પસંદ કરાે. 

 

4. Duration સેટ કરાે: "Duration" ફીˆમાં સમય (સેકɱમાં) દાખલ કરીને Ǉાં̏ ઝશનની ગ̍ત ગાઠેવાે. 
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5. Sound ઉમેરવંુ: Ǉાં̏ ઝશન સાથે સાઉɱ ફાઇલ ઉમેરવા માટે Sound ̍વકˍનાે ઉપયાગે કરાે. 

 

6. લાગુ કરાે: Apply To All: અા ̍ વકˍથી તમામ ƺલાઇડ્સ પર Ǉાં̏ ઝશન લાગુ થાય છે. અલગ અલગ 
ƺલાઇડ માટે અલગ Ǉાં̏ ઝશન પસંદ કરી શકાય છે. 

 



 

  
SARDAR PATEL INSTITUTE OF PUBLIC ADMINISTRATION, AHMEDABAD 265 

 

ƺલાઇડ ટાઈ̍મ̬ગ શું છે? 

ƺલાઇડ ટાઈ̌મ̬ગ અે દરેક ƺલાઇડ પર કેટલાે સમય રહેવું છે તે ̏નધાƙ̋રત કરે છે. 

 અાપમેળે ƺલાઇડ્સ બદલવા માટે ઉપયાેગી છે. 

 વારંવાર ̋રહસƙલ ɦારા ǐેઝɰેશનનાે ˗વ̗˺ત સમય ગાઠેવી શકાય છે. 

ƺલાઇડ ટાઈ̍મ̬ગ ગાેઠવવાના પગલાં 

1. Rehearse Timings ફીચર: 

o "Slide Show" ટેબ પર ̚ȃક કરાે અને "Rehearse Timings" ̍વકˍ પસંદ કરાે. 

o દરેક ƺલાઇડ માટે સમય માપાે. 

2. Slide Timing સટે કરવું: 

o દરેક ƺલાઇડ માટે સમય પસંદ કરાે. 

o Advance Slide ̍વભાગમા ંAfter ̍વકˍ પસંદ કરાે અને સમય નાખાે. 

3. ǐ̋ƿયા સાચવવી: 

o પસંદ કરેલા ટાઈ̌મ̬ગ ƺલાઇડશાે સાથે સાચવાઈ જશે. 

Ǉાં̎ ઝશન અને ટાઈ̍મ̬ગનું મહɗ 

 ˗વ̘˺ત ǐવાહ: Ǉાં̏ ઝશન અને ટાઈ̌મ̬ગ ǐેઝɰેશનને ˗વ̗˺ત બનાવે છે. 

 અાકષƙક ǐભાવ: દશƙકાેને ǐઝેɰેશનમાં જકડી રાખવા માટે ઉપયાેગી છે. 

 ̄ચા̏લત ǐƺતુ̍ ત: ટાઈ̌મ̬ગના ઉપયાેગથી ǐેઝɰેશન અાપમેળે ચલાવી શકાય છે. 

યાદ રાખા ે

 સરળ અને મયાƙ̋દત Ǉાં̎ ઝશન ઉપયાેગ કરાે: દરેક ƺલાઇડ માટે અલગ Ǉાં̏ ઝશનથી પણ ǐેઝɰેશન 
˗વ̗˺ત લાગે છે. 

 સમયની સાચી પસદંગી કરા:ે દરેક ƺલાઇડ માટે સમય દશƙકાેને સમ͂ શકાય તે રીતે સેટ કરાે. 

 અ̎ǁમ ̋રહસƙલ કરાે: "Rehearse Timings" નાે ઉપયાેગ કરીને ƺલાઇડની ગ̍તશીલતા અને 
સમયના બહેતર અાયાેજન માટે પુનરાવતƙન કરા.ે 

Ǉાં̏ઝશન અને ƺલાઇડ ટાઈ̌મ̬ગનાે યાેƝય ઉપયાેગ કરીને તમે તમા̈́ં ǐેઝɰેશન ˗ાવસા̍યક અને દશƙકાે 
માટે વધુ અાકષƙક બનાવી શકાે છાે. 

8.3 ƺલાઇડ શાે અાપમેળે ચલાવવું (Automating a Slide Show) 
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અાપમેળે ƺલાઇડ શાે (Automated Slide Show) અે પાવરપાેઈɰમાં અેવી ǐ̋ƿયા છે ȱાં ǐેઝɰેશન 
ƺલાઇડ્સ ̍વના માઉસ અથવા કીબાેડƙની મદદથી અાપમેળ ેઅાગળ વધે છે. અા સુ̍વધા ખાસ કરીને ̋કયાૅ˱, 
ǐદશƙન, અથવા ̀તે ચલાવાતા ǐેઝɰેશન માટે ઉપયાેગી છે. 

અાપમેળે ƺલાઇડ શાે શું છે? 

અાપમેળે ƺલાઇડ શાે અે અેવી ǐ̋ƿયા છે ȱાં દરેક ƺલાઇડ ̏ન̏˛ત સમયગાળા પછી અાપમેળે બદલાય છે. 

 Ǉાં̏ઝશન અને ટાઈ̌મ̬ગને ̌ǐ-સેટ કરી શકાય છે. 

 ǐેઝɰેશન અાપમેળે અેક અથવા વધુ વખત પુનરાવતƙન થાય તે રીતે ગાેઠવાય છે. 

અાપમેળે ƺલાઇડ શાે સેટ કરવાના પગલા ં

1. Slide Timing ગાેઠવાે: 

o "Slide Show" ટેબ પર ̚ȃક કરાે. 

o "Rehearse Timings" ̍વકˍ પસંદ કરાે. 

o ǐેઝɰેશન દરʸાન દરેક ƺલાઇડ પર લાગતા સમયને માપાે અને સાચવાે. 

2. Set Up Slide Show ̍વકˍ: 

o "Slide Show" ટેબમાં "Set Up Slide Show" ̍વકˍ પર ̚ȃક કરાે. 

o "Browsed at a kiosk (full screen)" ̍વકˍ પસંદ કરાે. 

o અા ̍વકˍથી ƺલાઇડ અાપમેળે ચાલે છે અને અંતે ફરીથી શͅ થાય છે. 

3. Transition Timing: 

o "Transitions" ટેબમાં "Advance Slide" હેઠળ "After" ̍વકˍ સ̋ƿય કરાે. 

o દરેક ƺલાઇડ માટે સમય સેટ કરાે. 

4. ǐેઝɰેશન સાચવવંુ: 

o ફાઇલને સાચવાે અને તપાસાે કે અાપમેળે ƺલાઇડ શાે સરસ રીતે ચાલી ર̈ંુ છે કે નહ̯. 

લૂપ ƺલાઇડ શાે 

 લૂપ માેડ સેટ કરવાે: Set Up Slide Show ̍વɱાેમાં Loop continuously until 'Esc" ̍વકˍ 
પસંદ કરાે. અા સે̋ ટ̬ગથી ǐેઝɰેશન વારંવાર ચાલુ રહે છે ȱાં સુધી તમે "Esc" દબાવીને તેને બંધ ન 
કરાે. 

અાપમેળે ƺલાઇડ શાે માટે યાદ રાખા ે
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1. ટાઈ̍મ̬ગ સાચું ગાેઠવાે: દરેક ƺલાઇડ માટે સમયગાળાે દશƙકાે માટે યાેƝય હાયે તે રીતે પસંદ કરાે. 

2. ̍વƣયુઅ˔ અને Ǉાં̎ ઝશન સરળ રાખાે: ખૂબ વધુ જ̋ટલ Ǉાં̏ઝશનથી ટાળાે. સરળ Ǉાં̏ ઝશન વધુ 
˗ાવસા̍યક લાગે છે. 

3. ̋રહસƙલ કરવું: ̀ે તમારી ǐેઝɰેશન મહɗની છે, તાે ̋રહસƙલ કરી વધુ સચાેટ બનાવાે. 

4. સાઉɱ અને વી̋ડયાે ઉમેરાે: ̀ે જͅરી હાેય, તાે સાઉɱ Ǉેક અથવા ̍વ̋ડઅાેઝ ઉમેરાે જથેી દશƙકાે 
માટે તે વધુ અાકષƙક બને. 

ફાયદા 

 હાથ ̍વના ǐેઝɰેશન: Ȃાૅ˱  અથવા ǐદશƙનમાં ઉપયાેગી. 

 વારંવાર ǐદ̐શ̭ત થાય: ǐેઝɰેશન અાપમેળે પુનરાવ̍ત̭ત થાય છે. 

 સમયની બચત: દરેક ƺલાઇડ માટે ̏નયત સમય પરફેǶ રીતે ગાેઠવવા માટે મદદͅપ. 

ઉપયાેગના ઉદાહરણાે 

 ǐદશƙનાે અને મેળા: ̍વ̍વધ ǐાેડǶ્સનું ǐદશƙન અાપમેળે કરવું. 

 સં˺ ાના લાેબીમાં: અાવનારાઅાે માટે સામાʈ મા̋હતી ǐદ̏શ̭ત કરવી. 

 શƖૈ̒ણક ǐાેજેǶ્સ: ̍વɥાથ̰ ǐેઝɰેશનને વધુ ˗ાવસા̍યક બનાવવું. 

અાપમેળે ƺલાઇડ શાેનાે ઉપયાેગ કરીને તમે તમારી ǐઝેɰેશનને ˗વ̗˺ત અને સરળતાથી રજૂ કરી શકાે 
છાે. 

9. સારાંશ (Summary) 

માઇƿાેસાેʘ પાવરપાેઈɰ 2019 અે અેક શ̘Ǹશાળી અને બહુમુખી ટૂલ છે, જ ેǐેઝɰેશન બનાવવા અને 
રજુઅાત કરવાની ǐ̋ƿયાને સરળ બનાવે છે. અા ǐાેફેશનલ સાેʘવેરનાે ઉપયાેગ શૈƖ̒ણક, ˗ાવસા̍યક 
અને ˗̘Ǹગત હેતુઅાે માટે ˗ાપકપણે થાય છે. 

મહɗપૂણƙ ખા̐સયતા ે

માઇƿાેસાેʘ પાવરપાેઈɰ 2019ની કેટલીક મુȕ ̍વશેષતાઅાે નીચે મુજબ છે: 

 ƺલાઇડ ̋ડઝાઇન: ǐઝેɰેશન માટે પસંદ કરવા માટે અનેક ̋ડઝાઇન ટેƳʕેટ્સ ઉપલʤ છે. 

 મ˄ીમી̋ડયા ઇ̔ɰǁેશન: ટેȌ, ઈમેજ, ̍વડીયાે અને સાઉɱનાે સમાવેશ કરવા માટેની સગવડ. 

 અનુકૂળ Ǉાં̎ ઝશન અન ેઅે̏નમેશન: ǐેઝɰેશનને વધુ અાકષƙક બનાવતા માેƮશન ઇફેǶ્સ. 

 ̄ચા̏લતતા: અાપમેળે ƺલાઇડ શાે માટે ટાઈ̌મ̬ગ અને લૂ̌પ̬ગ ̍વકˍાે. 

 ̌ǐ̔ɰ̬ગ ̍વકˍાે: હેɱઅાઉટ્સ અને ƺલાઇડ્સને ̌ǐɰ કરવા માટેની સગવડ. 
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ǐેઝɰેશન બનાવવા માટેના મુȕ તબǲા 

1. ƺલાઇડ્સની તૈયારી: નવાે ǐાેજǶે શͅ કરવાે અને યાેƝય ̋ડઝાઇન પસંદ કરવી. 

2. ટેȌ અને મ˄ીમી̋ડયાનાે ઉમેરાે: અાપણી સામǁીને સરળતાથી ટેȌ બાેȋ, ટેબ˔, અથવા 
ǁા̋ફȋનાે ઉપયાેગ કરીને રજૂ કરવી. 

3. અે̏ નમેશન અને Ǉાં̎ ઝશન: ƺલાઇડ્સ અને અાૅʠેǶ્સમાં માેƮશન ઇફેǶ્સ ઉમેરવાથી 
ǐેઝɰેશન વધુ ͂વંત બને છે. 

4. ƺલાઇડ શાે: ̋રહસƙલ કરવું, ટાઈ̌મ̬ગ સેટ કરવું, અને ƺલાઇડ શાે રજૂ કરવું. 

માઇƿાેસાેʘ પાવરપાેઈɰ 2019ના ફાયદા 

 ǐભાવી ǐƺતુ̍ત: વધુ ˗ાવસા̍યક અને ǐભાવશાળી ǐેઝɰેશન. 

 સમય બચાવવાે: સરળ ટૂ˔ અને ઇɰરફેસ ɦારા ઝડપી કામ. 

 ̋ƿઅે̋ ટવ લાભ: સાેʘવેરની ̍વશાળ ̋ડઝાઇન અને ક˶માઈઝેશન Ɩમતાઅાે. 

માઇƿાેસાેʘ પાવરપાેઈɰ 2019 અે ǐેઝɰેશનની જ̋ટલ ǐ̋ƿયાને સરળ બનાવી તેને વધુ ˗ાવસા̍યક અને 
અાકષƙક બનાવે છે. ̀ે સાેʘવેરના ̍વ̍વધ ફીચસƙનાે યાેƝય ઉપયાેગ કરવામાં અાવ,ે તાે કાેઈપણ ̠ ̘Ǹ તમેની 
̍વચારશીલતાને સરળતાથી સાકાર બનાવી શકે છે. 

̍વɥાથ̰અાે અને ˗ાવસા̍યકાે બંને માટે પાવરપાેઈɰ અેક અ̏નવાયƙ સાધન છે, જ ે કાેઈ પણ ǐકારની 
ǐેઝɰેશન માટે સરળ અને અસરકારક સાધન છે. 

10. નમુનાͅપ ǐ˜ાે અને જવાબાે Model Questions and Answers 

 
1. PowerPoint 2019 કયા સાેʘવેરનાે ભાગ છે? 

A) Windows OS 
B) Microsoft Excel 
C) Microsoft Office 
D) Google Docs 

2. PowerPoint 2019માં "Blank Presentation" શેના માટે વપરાય છે? 
A) અાે̋ ડયાે ઉમેરવા માટે 
B) નવંુ ǐેઝɰેશન શͅ કરવા માટે 
C) ̍વ̋ડઅાે કાપવા માટે 
D) ફાેટાે શૂટ માટે 

3. PowerPoint 2019માં ǐેઝɰેશન સાચવવા માટે કઈ કીનાે ઉપયાેગ થાય છે? 
A) Ctrl + A 



 

  
SARDAR PATEL INSTITUTE OF PUBLIC ADMINISTRATION, AHMEDABAD 269 

 

B) Ctrl + P 
C) Ctrl + S 
D) Ctrl + D 

4. PowerPointમાં ƺલાઇડ્સની ƿમ બદલવા માટે કયાે દેખાવ ઉપયાેગી છે? 
A) Normal View 
B) Reading View 
C) Slide Sorter View 
D) Outline View 

5. પાવરપાેઈɰમાં કયું ફાેમ̳ટ ̋ડફાે˄  ફાઇલ ફાેમ̳ટ છે? 
A) .docx 
B) .xlsx 
C) .pptx 
D) .pdf 

6. ǐેઝɰેશન દર̌મયાન દશƙકાેનું ɪાન ખ̲ચવા માટે કઈ ટૂલ ઉપયાેગી છે? 
A) Notes 
B) Slide Master 
C) Laser Pointer 
D) Handouts  

7. PowerPointમાં SmartArt નાે ઉપયાેગ શે માટે થાય છે? 
A) સાઉɱ ઉમેરવા 
B) અાેʠેǶ ˱ેલ કરવા 
C) મા̋હતીના ǁા̋ફકલ રજૂઅાત માટે 
D) ǐેઝɰેશન સાચવવા 

8. ƺલાઇડમાં અાૅ̋ડઅાે ઉમેરવા માટે કયાે ટેબ ઉપયાેગી છે? 
A) Design 
B) View 
C) Insert 
D) Review 

9. Slide Show શͅ કરવા માટે કયાે કી શાૅટƙકટ છે? 
A) F2 
B) F5 
C) F3 
D) Ctrl + L 

10. PowerPointમાં Clip Art ઉમેરવા માટે કયા ̍વકˍનાે ઉપયાેગ થાય છે? 
A) File > Save 
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B) Insert > Pictures > Online Pictures 
C) Home > Layout 
D) Slide Show > Setup 

11. PowerPointમાં ƺલાઇડ ̋ડઝાઇન માટે કયાે ટેબ ઉપયાેગ થાય છે? 
A) View 
B) Insert 
C) Design 
D) Animation 

12. Presentation Modeમાં Annotate કરવા માટે કઈ ટૂલ વપરાય છે? 
A) Format Painter 
B) Laser Pointer 
C) Pen Tool 
D) Text Box 

13. PowerPointમાં Word Table ઉમેરવા માટે કયાે ̍વકˍ વાપરી શકાય? 
A) Insert > Text Box 
B) Insert > Table 
C) Design > Table Style 
D) File > Table 

14. PowerPointમાં ƺલાઇડના ̍વષય અનુસાર બેકǁાઉɱ રંગ બદલવા માટે કયાે ̍વકˍ છે? 
A) Format > Font 
B) Design > Format Background 
C) Insert > Colors 
D) Home > Background 

15. PowerPoint 2019માં કયાે અાʠેેǶ ̍વકˍ Excel Worksheet ઉમેરવા માટે વપરાય છે? 
A) Insert > Table 
B) Insert > Object > Excel Worksheet 
C) Insert > Graph 
D) Insert > Data Sheet 

16. ƺલાઇડ્સ હટાવવા માટે કઈ કી વાપરાય છે? 
A) Shift 
B) Delete 
C) Ctrl 
D) Alt 

17. PowerPointમાં લખાણનું અેલાઇનમેɰ બદલવા માટે કયાે ટેબ ઉપયાેગ થાય છે? 
A) Insert 
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B) Design 
C) View 
D) Home 

18. ƺલાઇડમાં Movie (Video) ઉમેરવા માટે શું કરશાે? 
A) Insert > Chart 
B) Insert > Object 
C) Insert > Video 
D) Insert > SmartArt 

19. Slide Showના સમયગાળા માટે કયાે ̍વકˍ ઉપયાેગી છે? 
A) Set Up Slide Show 
B) Rehearse Timings 
C) Zoom Slide 
D) Presentation Coach 

20. PowerPointમાં હેડર અને ફૂટર ઉમેરવા માટે શંુ કરશાે? 
A) Design > Footer 
B) View > Header 
C) Insert > Header & Footer 
D) File > Add Footer 
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ઇɰરનેટ અȋૅેસ અને વેબ ǒાઉઝર 
 

1. ઉɠેશાે (Objectives) 

અા ǐકરણના અતંે ̍વɥાથ̰:   

 ઇɰરનેટ અને કƳʔુટર નેટવકƙના મૂળ તɗાેને અાેળખી શકશે 
 લાેકલ અને વાઇડ અે̋ રયા નેટવકƙ  (LAN/WAN) વȝે તફાવત સમ͂અ ે
 ઇɰરનેટ અȋૅેસ માટેના ̍વ̍વધ સાધનાે અને પɡ̍તઅાે સમ͂અ ે
 વેબ ǒાઉઝર શું છે અને તે કેવી રીતે કામ કરે છે તે સમ͂અ ે
 ઇɰરનેટ સ̍વ̭સીસ અને તમેની ઉપયાે̎ ગતા ̍વશે ̀ણશ ે
 વેબ પેજ અૅȋેસ, બુકમાકƙ  ઉમેરવંુ અન ેફેવ̋રટ ફાે̂ રનાે ઉપયાેગ શીખશ ે
 વેબ પેજમાથંી મા̋હતી ડાઉનલાેડ અને ̌ǐɰ કરવાની રીત શીખશે 
 સચƙ અેિƮજનાે અને મા̋હતી શાધેવાની ટે̚ǽક ̀ણશ ે
 FTP અને VPN જવેી ટેǽાલેાે͂  અન ેતેમની ઉપયાે̎ ગતા સમ͂અ ે
 ફાયરવાલે, DNS અને URL જવેી અગɔની ઈɰરનેટ સલંȘ બાબતાે અંગે Ɨાન મેળવે 
 ઇɰરનેટ પર સંચારનાં માɪમાે (ઇમેઇલ, મેસે̏ જ̬ગ, ̍વ̋ડયા ેકાેલ વગેરે) સમ͂અ ે
 ઇɰરનેટ અને વ ƙ̂ વાઇડ વેબ (WWW) વȝે તફાવત ̀ણી શકશ ે
 કƳʔુટરન ેઇɰરનેટ માટે કેવી રીત ેતૈયાર કરવાે તે ̀ણી શકશ ે
 ǒાઉઝર કાે̔ ʃƝયુરેશન અન ેǐાઇવસી સે̋ ટ̬Ɲસ ̀ણશ ે
 ઇɰરનેટના ફાયદા અને ̀ખેમાે અગં ેજવાબદારીપૂવƙક ̍વચાર કરશે 

2. પ̋રચય  

અાજના ̋ ડ̏જટલ યુગમાં ઇɰરનેટ અાપણા ͂ વનનાે અ̑ભɿ ભાગ બની ગયાે છે. ઇɰરનેટનાે ઉપયાેગ માǋ 
મા̋હતી મળેવવા પૂરતાે જ ર̈ાે નથી, પણ હવે ત ે̏શƖણ, ˗વસાય, મનાેરંજન, સામા̏જક ̀ેડાણ અને ઇ-
સેવાનાં અનેક Ɩેǋાેમાં અɔતં ઉપયાેગી સા̐બત થયાે છે. ઇɰરનેટનાે લાભ લેવા માટે અાપણે જ ેસાધનનાે 
સાૈથી વધુ ઉપયાેગ કરીઅે છીઅ,ે તે છે વેબ ǒાઉઝર. 

અા ǐકરણમાં તમે ઇɰરનેટ અને તેની ̍વ̍વધ અૅȋેસ પɡ̍તઅાે ̍વશે ̀ણશાે. વેબ ǒાઉઝર શું છે, તે કેવી 
રીતે કાયƙ કરે છે અને તનેા ેયાƝેય ઉપયાેગ કેવી રીતે કરવાે તે અંગે ̍વƺતૃત મા̋હતી મળશે. સાથે સાથે તમે સચƙ 
અેિƮજન, બુકમાકƙ , ફાઇલ ડાઉનલાે̋ડ̬ગ, વેબ પેજ ̌ ǐ̔ɰ̬ગ, FTP, VPN, ફાયરવાેલ અને DNS જવેી ટેǽાેલાે͂  
પણ શીખશા,ે જે તમારા ઇɰરનેટ Ɨાનને વધુ ઘ̏નˤ બનાવશે. 

અા ǐકરણનાે મુȕ ઉɠેશ અે છે કે ̍વɥાથ̰અાેન ેઇɰરનેટના મૂળ તɗાેથી લઈને તેના ˗વહા̋રક ઉપયાેગ 
સુધીની સંપૂણƙ સમજ મળે અન ેતેઅાે ઈɰરનેટનું સુર̐Ɩત, જવાબદારીપૂવƙક અન ેઅસરકારક રીતે ઉપયાેગ 
શીખી શકે.  
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3. કƳʔુટર નેટવકƙના મૂળ તɗાે (Basics of Computer Networks) 

અાજના ̋ડ̏જટલ યુગમાં મા̋હતીનાે ǐવાહ ઝડપથી અને સચાેટ રીતે અેક ˺ાનથી બી̀ં ˺ાન સુધી 
પહા̲ચાડવાે અɔંત જͅરી બની ગયાે છે. ઘરે Wi-Fi મારફતે માેબાઇલ અથવા લૅપટાેપ ચલાવવાે હાેય કે 
અાે̋ફસમાં ફાઈલાે શેર કરવી હાેય, દરેક જƝયાઅે કƳʔુટર નેટવકƙની જ̋ͅરયાત હાેય છે. કƳʔુટર નેટવકƙ  અે 
̍વ̍વધ ઉપકરણાેને ̀ેડતી અને મા̋હતીને વહ̲ચતી ˗વ˺ા છે જ ેઇɰરનેટ અૅȋેસ અને વેબ ǒાઉ̏ઝ̬ગ 
માટે મૂળભૂત ભૂ̌મકા ભજવે છે. 

કƳʔુટર નેટવકƙ અેટલે શુ?ં 

ȱારે બે કે તેથી વધુ કƳʔુટર કે ઉપકરણાે અેકબી̀ સાથે મા̋હતી વહ̲ચવા માટે ̀ેડાય છે ɔારે તેને કƳʔુટર 
નેટવકƙ  કહેવાય છે. અા ̀ેડાણ વાયર વડે કે વાયરલેસ પɡ̍ત વડે થઈ શકે છે. નેટવકƙના માɪમથી ઉપકરણા ે
વȝે ફાઈલ, ડાેȂુમેɰ, ̌ǐɰર અને ઇɰરનેટ જવેી ̍વ̍વધ સુ̍વધાઅાે વહ̲ચી શકાય છે. 

નેટવકƙના મȕુ ઘટકાે 

કƳʔુટર નેટવકƙ  નીચેના મȕુ તɗાે ɦારા બનેલું હાયે છે: 

 Nodes (નાેડ્સ): કƳʔુટર, માેબાઇલ, ̌ǐɰર જવેા ઉપકરણાે જ ેનેટવકƙમાં ̀ેડાયેલા હાેય છે. 
 Transmission Media (Ǉાʉ̌મશન માɪમ): મા̋હતી પહા̲ચાડવા માટે ઉપયાેગમાં લેવાતા માɪમ  જમે 

કે વાયર (Twisted Pair, Fiber Optic) અથવા વાયલ̳સ (Wi-Fi, Radio Waves). 
 NIC (Network Interface Card): દરેક કƳʔુટરમાં હાેય છે અને નેટવકƙથી કનેǶ થવા માટે જͅરી હાેય 

છે. 
 Switch / Hub: નેટવકƙમાં અનેક ઉપકરણાેને ̀ેડીને મા̋હતીની ̋દશા નǲી કરે છે. 
 Router: અાતં̋રક નેટવકƙને ઇɰરનેટ સાથે ̀ેડે છે. ઘરેલુ અને ˗ાવસા̍યક બંને માટે ઉપયાેગી. 

ȱારે નેટવકƙમાં ̀ેડાયેલ ઉપકરણાે રાઉટરના માɪમથી ઇɰરનેટ સાથે ̀ેડાય છે ɔારે ઇɰરનેટ અૅȋસે 
ǐાʏ થાય છે. ઇɰરનેટ ɦારા યુઝર વેબ ǒાઉ̏ઝ̬ગ, ઇમેઇલ, અાેનલાઈન ̏શƖણ, ડાઉનલાે̋ડ̬ગ અને સાે̏શયલ 
મી̋ડયા જવેી અનેક ǐવૃ̍ ɇઅાે કરી શકે છે. 

 ISP (Internet Service Provider): કંપનીઅાે જવેી કે Jio, Airtel, BSNL ઇɰરનેટ સેવા અાપે છે. 
 Web Browser: Chrome, Firefox, Edge જવેા ǒાઉઝરાે ઇɰરનેટમાં મા̋હતી અૅȋેસ કરવા માટે 

વપરાય છે. 

નેટવકƙ  સલામતી (Network Security) 

ȱાં નેટવકƙ  છે ɔાં મા̋હતી ચાેરી, હે̋ક̬ગ અને વાયરસ જવેી સમ̃ાઅાેની પણ શȂતા હાેય છે. તેથી 
નેટવકƙમાં અɰેીવાયરસ, ફાયરવાેલ, પાસવડƙ ǐાેટેȆન અને અેન̋ƿƯશન જવેી સુરƖા પɡ̍તઅાેનાે ઉપયાેગ 
અાવƸયક છે. 

કƳʔુટર નેટવકƙ  અે અાજે ઇɰરનેટ અૅȋેસ અને મા̋હતી વહ̲ચણ માટેનું અેક મહɗપણૂƙ સાધન બની ગયુ ં
છે. તેની મદદથી અાપણે ન માǋ ઇમેઇલ કે વેબસાઈટ ખાેલી શકીઅે છીઅે, પણ ડેટા શે̋રગ̬, ̌ǐ̔ɰ̬ગ, ̍વ̋ડયા ે
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કાેʃર̘ʉ̬ગ જવેી ઘણી ǐવૃ̍ ɇઅાે સરળતાથી કરી શકીઅે છીઅે. દરેક વપરાશકતાƙઅે નેટવકƙના મૂળ તɗા ે
અને ઉપયાેગ ̍વશે સમજ હાવેી ̀ેઈઅે જથેી ટેકનાેલાે͂નાે યાેƝય અને સુર̐Ɩત ઉપયાેગ કરી શકાય. 

3.1 લાેકલ અેરીયા નેટવકƙ  (Local Area Network) 

Internet Access અને Web Browsing માટે લાેકલ નેટવકƙ  સાૈથી મહɗપણૂƙ ભૂ̌મકા ભજવે છે. ȱારે તમે 
ઘરે Wi-Fi વડે માેબાઇલ કે લૅપટાેપ ચલાવાે છાે અથવા અાે̋ફસમાં ઘણા કƳʔુટરાે અેક સાથે ̀ ેડેલા હાેય, ɔારે 
તે બધંુ Local Area Network (LAN) ɦારા શȂ બને છે. LAN અે નટેવકƙનાે અેવા ેǐકાર છે, જ ેમયાƙ̋ દત 
̍વƺતારમાં (જમે કે ઘર, અાે̋ ફસ, લેબ, ˱ૂલ વગેરે) ઘણા ઉપકરણાેને અેકબી̀ સાથે કનǶે કરે છે. 

LAN શું છે? 

Local Area Network (LAN) અે નેટવકƙનાે અેવાે ǐકાર છે જમેાં અાેછા અંતર સુધી (સામાʈ રીતે 100 મીટર 
સુધી) અાવેલા ઉપકરણાે જેમ કે કƳʔુટર, લૅપટાેપ, ̌ǐɰર, ˱ેનર વગરેેને કેબલ કે વાયરલસે માɪમ ɦારા 
અેકબી̀ને ̀ેડવામાં અાવે છે. LAN નાે હેતુ મા̋હતી અને સંસાધનાે વહ̲ચવા માટે ઝડપી અને ̏નˤાપૂવƙકનંુ 
માɪમ પૂ̈́ં પાડવાે છે. 

 

Image source: 
https://commons.wikimedia.org/wiki/File:Home_LAN_local_area_network_example_di

agram.png  

LAN ની લાƖ̒ણકતા 

 સી̌મત ̍વƺતાર માટે: સામાʈ રીતે અેક ̐બ̓ˆ̬ગ, ͅમ અથવા કેʱસમાં કાયƙ કરે છે. 
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 ̀ેડાણની ઝડપ વધારે: સામાʈ રીતે 100 Mbps થી 1 Gbps સુધીની ઝડપ. 
 વાયર અને વાયરલેસ બંને પɡ̍ત સંભવ: કેબલ (Ethernet) કે Wi-Fi ɦારા. 
 હાેઈચે ˺ા̏નક ̏નયંǋણ: નેટવકƙનાે ઉપયાેગ અને સંચાલન ˺ા̏નક ƺતરે થતંુ હાેય છે. 
 સાંધા સાધનાેનાે વહ̲ચાયેલ ઉપયાેગ: ̌ǐɰર, ઇɰરનેટ, ફાઈ˔ વગેરે દરેક કƳʔુટર માટે ઉપલʤ હાેય 

છે. 

LAN ના ઘટકાે (Components) 

ઘટક વણƙન 
Computer/Devices નેટવકƙમાં ̀ેડાયેલા કƳʔુટર, લૅપટાેપ વગરેે 
Switch/Hub નેટવકƙ  ઉપકરણાે વȝે ડેટા વહ̲ચવાનું કાયƙ કરે છે 
Router LAN ને ઇɰરનેટ સાથે ̀ેડે છે 
NIC (Network Interface Card) દરેક કƳʔુટરમાં LAN ̀ેડવા માટે જͅરી 
Cables/Wi-Fi મા̋હતી Ǉાʉફર માટે માɪમ 

LAN ના ફાયદા 

 ફાઈલ શે̋ રગ̬ સરળ: યુઝસƙ અેકબી̀ની ફાઈલાે ઝડપથી અૅȋેસ કરી શકે છે. 
 ̌ǐɰર અને ઇɰરનેટ શે̋ રગ̬: અેક ̌ǐɰર કે ઈɰરનેટ કનેȆન દરેક ઉપકરણ માટે ઉપલʤ. 
 ખચƙમાં ઘટાડાે:  ̋રસાેસƙ વહ̲ચવાથી ખચƙમાં ઘટાડાે થાય છે. 
 અનેક વપરાશકતાƙ સાથે ̀ેડાણ કરવું સરળ:  માેટી અાે̋ફસ કે ˱ૂલમાં ઘણા વપરાશકતાƙ ɦારા નેટવકƙ 

˗વ̗˺ત રીતે સંચા̏લત થઈ શકે છે. 
 Security & Central Control: નેટવકƙનાે ̏નયંǋણ અેક કે બે અેડ̌મ̏ન˷ેટર ɦારા શȂ છે. 

LAN નાે ઉપયાેગ Ȃાં થાય છે? 

 ઘરાેમા:ં Wi-Fi નેટવકƙ  ɦારા માેબાઇલ, ટીવી અને કƳʔુટર ̀ેડવા માટે. 
 ˱ૂલાે અને કાેલે̀ેમાં: કƳʔટુર લેબમાં બધા કƳʔટુરાે કનǶે કરવા માટે. 
 અાે̋ફસાેમાં: ફાઈ˔, ઇમેઇ˔ અને ઇɰરનેટ શેર કરવા માટે. 
 બ̲̋ક̬ગ અને સરકાર ̍વભાગાેમાં: અાંત̋રક મા̋હતી વહ̲ચણી માટે. 

ȱારે LAN ને રાઉટર મારફતે ઇɰરનેટ સાથે ̀ ેડવામાં અાવે છે, ɔારે તમેાં ̀ ેડાયેલા દરેક ઉપકરણ ઇɰરનેટ 
અȋૅેસ મેળવી શકે છે. ǒાઉઝર (જમે કે Chrome, Firefox) મારફતે યુઝર વેબસાઇટ્સ ઉઘાડી શકે છે, 
ઇમેઇલ માેકલી શકે છે અને અʈ અાેનલાઇન કાયƙ કરી શકે છે. 

Local Area Network (LAN) અે ઇɰરનેટ અૅȋેસ અને ઉપકરણાે વȝેની મા̋હતી વહ̲ચણી માટેનંુ 
અાધુ̏નક, કાયƙƖમ અને અ̏નવાયƙ માɪમ છે. દરેક ઘરથી લઈ અાૅ̋ફસ, શાળા અને કંપનીઅાે સુધી LAN ની 
જ̋ͅરયાત વધતી ̀ય છે. નેટવકƙના મૂળ તɗાે અને LANના ઉપયાેગ ̍વશે સમજ રાખવી અાજના યુગમા ં
ટેકનાેલાે͂ǐેમી દરેક ˗̘Ǹ માટે અાવƸયક છે. 

3.2 વાઈડ અેરીયા નેટવકƙ (Wide Area Network - WAN) 
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જમે જમે ટેǽાેલાે͂ નાે ̍વકાસ થયાે છે તેમ તેમ લાેકાેની મા̋હતી માેટા અંતર સુધી વહ̲ચવાની જ̋ͅરયાત પણ 
વધતી ગઈ છે. ȱારે અેક શહેરના અનેક અાે̋ ફસાે કે દેશના ̍વ̍વધ ભાગામેાં અાવલેી શાખાઅાે વȝે ડેટા 
વહ̲ચવાની જͅર પડે છે, ɔારે Wide Area Network (WAN) ઉપયાેગી બને છે. WAN અે કƳʔુટર 
નેટવકƙનાે અેવાે ǐકાર છે, જ ે̍વશાળ ભાૈગાે̏ લક ̍વƺતાર (શહેરાે, રાȱ, દેશાે) સુધી કનેǶ કરે છે અને ઘણા 
માઈલ જટેલા અતંર સુધી કામ કરે છે. 

WAN શંુ છે? 

Wide Area Network (WAN) અે નેટવકƙ  છે જે અનેક લાેકલ અેરીયા નેટવકƙ  (LAN) અન ેમેǇાેપાે̏ લટન 
નેટવકƙ  (MAN) ને ̀ેડે છે. WANનાે ˗ાપ કાઈે અેક ઇમારત સુધી મયાƙ̋દત નથી, પણ શહેરાે અને દેશાે સુધી 
̍વƺતરતાે હાેય છે. ઇɰરનટે અે સાૈથી માટંુે અને લાેક̌ǐય WAN છે, જનેા ɦારા દુ̏નયાના કરાેડાે કƳʔુટરા ે
̀ેડાયેલા છે. 

 

Image Source: https://www.edrawsoft.com/wan-diagrams.html 

WAN ની લાƖ̒ણકતાઅા ે

 ̍વશાળ ̍વƺતાર માટે ઉપયાેગી: શહેરથી દેશ સુધી 
 અɔાધુ̏ નક માɪમાે: ફાઇબર અાે̐ ʍક કેબલ, સેટેલાઈટ, માઈƿાવેવે વગેરે 
 અʈ નેટવȋƙને કનǶે કરે છે: જમે કે LAN, MAN 
 મા̲ધુ અન ેજ̋ટલ નેટવકƙ : કારણ કે વધુ અંતર અને ઇƮǑા˷Ǵર જͅરી હાેય છે 
 અંતરરાˢીય ƺતરે ડેટા વહેચવા માટે ઉપયાેગી 
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WAN ના ઘટકાે (Components of WAN) 

ઘટક વણƙન 

Router ̍વ̍વધ નેટવȋƙ વȝે મા̋હતી Ǉા̋ફકનું ̏નયંǋણ કરે છે 

Modem ̋ડ̏જટલ ડેટાને Ǉાʉ̌મશન માટે ͅપાંતર કરે છે 

Communication Links સેટેલાઈટ, ફાઇબર અાે̐ʍક, ટેલીફાેન લાઈનાે વગેરે 

LANs & MANs જ ેWANનાે ભાગ બને છે 

Service Provider જમે કે BSNL, Airtel, Reliance Jio, Tata Communication વગેરે 

WAN ના ફાયદા 

 ̍વ˝˗ાપી કને̖Ƕ̍વટી: ઇમેઇલ, વેબસાઇટ, ̍વ̋ડયાે કાેલ અને ȃાઉડ સેવાનાે ઉપયાેગ માટે જͅરી. 
 ડેટા અને સંસાધનાેનંુ કેિƮǍયકરણ: માટેી કંપનીઅાે માટે મા̋હતી હેડઅાે̋ ફસમાં સંǁ̋હત રહે છે. 
 તȿાળ સંચાર: મેસેજ, ઇમેઇલ અને ડેટા રીઅલ ટાઈમમાં ઉપલʤ થાય છે. 
 અંતરરાˢીય ˗વહારાે માટે અાધારભતૂ: ̐બઝનેસ, શૈƖ̒ણક અને સરકારી કાયા̳ માટે ઉપયાેગી. 

WAN નાે ઉપયાેગ 

 બ̲̋ક̬ગ Ɩેǋ: ̍વ̍વધ શાખાઅા ેવȝે ̋રયલ ટાઈમ ડેટા Ǉાʉફર. 
 ટે̏લકાેʸુ̏નકેશન: માેબાઇલ નેટવકƙ  માટે. 
 ઇɰરનેટ સેવા: ઈɰરનેટ અ ેઅેક વૈ̏˝ક WAN છે. 
 શૈƖ̒ણક Ɩેǋ: ̍વ˝̍વɥાલયા ેઅને સંશાેધન સં˺ાઅાે વȝે મા̋હતી વહ̲ચવા. 
 મ˄ીનેશનલ કંપનીઅાે: ̍વ̍વધ દેશાેમાં શાખાઅાે વȝે ફાઈલ અને અે̖ʕકેશન શે̋રગ̬ માટે. 

LAN અન ેWAN વȝેનાે તફાવત 

તફાવતનાે માપદંડ LAN WAN 

̍વƺતાર મયાƙ̋ દત (અેક ̐બ̓ˆ̬ગ) ̍વશાળ (શહેરાે/દેશાે) 

ગ̍ત વધુ (Fast) સાદારણ (Moderate) 

મા̏લકી ખાનગી ખાનગી કે સરકારી ISP 

ખચƙ અાેછંુ વધુ 

ઉદાહરણ ઘરેલુ Wi-Fi ઇɰરનેટ, બ̲ક નેટવકƙ  

Wide Area Network (WAN) અે ̍વ˝ના ̍વ̍વધ ˺ળાેને ટેક̏નકલ રીતે ̀ેડતું નેટવકƙ  છે. અાજના 
ઇɰરનેટ યુગમા,ં WAN ̍વના ન તાે વેબ ǒાઉ̏ઝ̬ગ શȂ છે અને ન તાે વૈ̏˝ક સંચાર. WAN અે માǋ અેક 
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નેટવકƙ  જ નહ̯, પણ અાખી દુ̏નયાને ̀ેડતંુ માɪમ છે જથેી લાેકાે, સં˺ ાઅાે અને ˗વસાય અેકસાથે કાયƙ 
કરી શકે છે. 

4. ઈɰરનેટ (Internet). 

ઇɰરનેટ અે અાજના યૂગની સાૈથી મહɊપૂણƙ શાેધાેમાંથી અેક છે. તે ̀ણકારી મેળવવાનાે, સંચાર કરવાના,ે 
શીખવાનાે અને ̍વ˝ સાથે ̀ેડાવાનાે સાૈથી ઝડપથી વધતાે માɪમ છે. ઇɰરનેટ અે અેવું વૈ̏˝ક નેટવકƙ  છે, 
જ ેલાખાે કƳʔુટરાે અને ̋ડ̏જટલ ઉપકરણાેને ̀ેડે છે જથેી મા̋હતીને તુરંત અેક ˺ાનથી બી̀ં ˺ાન સુધી 
માેકલી શકાય. 

̍વɥાથ̰અાે માટે તે વાંચન, સશંાેધન અને ǐાેજǶ્ેસ માટે સહાયક છે, ȱારે ˗વસા̍યક Ɩેǋે તે ઇમેઇલ, ડેટા 
Ǉાʉફર, વેબસાઇટ સંચાલન, અને અાેનલાઈન વેપાર માટે ઉપયાેગ થાય છે. 

4.1 ઇɰરનેટનાે ȕાલ (Concept of Internet) 

Internet શʣ Interconnected Networks પરથી અા˗ા ે છે, જનેાે અથƙ છે – "પર˾ર ̀ેડાયેલ 
નેટવȋƙનું નેટવકƙ ". અેટલ ેકે ઇɰરનેટ અે અનેક નેટવȋƙ (LAN, MAN, WAN) નંુ ̀ેડાણ છે જે સાથે 
મળીન ેમા̋હતી વહ̲ચે છે. 

અા નેટવકƙ  ̍વ̑ભɿ ઉપકરણાે (કƳʔુટર, માબેાઇલ, સવƙર, લૅપટાેપ) ને અેકબી̀ સાથે મા̋હતી મેળવવા માટે 
̀ેડે છે — Ȃારેક કેબલથી, તાે Ȃારેક વાયલ̳સ. 

ઇɰરનેટના મુȕ ઉપયાેગા ે

ઉપયાેગ Ɩǋે ઉદાહરણ 

̏શƖણ Wikipedia, Google Classroom, Coursera 

સંચાર Gmail, WhatsApp, Zoom 

ખરીદી Amazon, Flipkart, Meesho 

મનાેરંજન YouTube, Netflix, Spotify 

બ̲̋ક̬ગ SBI Net Banking, Google Pay, PhonePe 

સમાચાર Google News, BBC, Times of India 

ઇɰરનેટની મહɗપૂણƙ સેવાઅા ે

 Email (ઇમેઇલ): ઝડપથી સંદેશાે માેકલવા માટે,  ઉદાહરણ: Gmail, Yahoo Mail 
 WWW (World Wide Web): ઇɰરનેટ પર ચાલતી વેબસાઇટ્સ અને વેબપે̀ેની ˗ાપક ˗વ˺ા, 

વેબ ǒાઉઝર (Chrome, Firefox) મારફતે અૅȋેસ થાય છે 
 FTP (File Transfer Protocol): ફાઈલાે ઇɰરનેટ મારફતે માેકલવા માટેનાે ǐાેટાેકાેલ 
 Search Engine: ̀ણકારી શાેધવા માટે, ઉદાહરણ: Google, Bing, Yahoo 
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 Social Media: લાેકાે સાથે ̀ેડાવા અને મા̋હતી વહ̲ચવા માટે, ઉદાહરણ: Facebook, Instagram, 
LinkedIn 

ઇɰરનેટ કેવી રીતે કાયƙ કરે છે? 

 વપરાશકતાƙ ǒાઉઝરમાં કાેઈ વેબસાઇટ (જમે કે www.google.com) ખાેલે છે. 
 ǒાઉઝર DNS (Domain Name System) ɦારા તેનું IP Address શાેધે છે. 
 અા IP Address ɦારા તે વબેસાઇટ ȱાં હાે˶ છે તે સવƙર સુધી મા̋હતી પહા̲ચે છે. 
 સવƙર વેબપેજ માેકલે છે જ ેવપરાશકતાƙના ˲ીન પર દેખાય છે. 

ઇɰરનેટ કનેȆન માટે જͅરી ઘટકા ે

ઘટક કાયƙ 

ISP (Internet Service Provider) ઇɰરનેટ સેવા અાપે છે (જમે કે Jio, Airtel) 

Modem/Router ડેટા કનેȆન કરે છે અને Wi-Fi અાપે છે 

Browser વેબસાઇટ ખાેલવા માટેની સુ̍ વધા અાપ ેછે (Chrome, Firefox) 

IP Address દરેક ઉપકરણને નેટવકƙમાં અાેળખ અાપે છે 

DNS ડાેમેનને IP અેǉેસમાં ફેરવ ેછે 

ઇɰરનેટના લƖણાે 

 ̍વ˝˗ાપી: દરેક દેશ અને શહેરમાં ઉપલʤ 
 ઝડપી: મા̋હતી તરત ǐાʏ થાય છે 
 સƺતું: ઘરના વપરાશ માટે ખચƙ ઘણાે અાેછાે 
 અાધુ̏નકતા: નવી ટેǽાેલાે͂ માટે અાધારભતૂ માɪમ 
 અંતર̋ƿયાɒકતા: વપરાશકતાƙ વેબસાઇટ્સ સાથે સીધાે સંવાદ કરી શકે છે 

ઇɰરનેટના લાભાે 

 ઝડપથી મા̋હતી મળ ે
 અાે̋ફસ અને ̏શƖણ કાયƙ સરળ બને 
 ઘેર બેસીને જ શાે̌પ̬ગ કે ̐બલ પેમેɰ થાય 
 દુ̏નયાના કાેઈ પણ ખૂણે વાત કરી શકાય 
 ઘેર બેઠાં અાેનલાઇન ̏શƖણ ǐાʏ થાય 

ઇɰરનેટના નુકસાન (̀ે યાેƝય ઉપયાેગ ન થાય તાે) 

 નકલી સમાચાર અને ગરેમાગ ̳દાેરનારી મા̋હતી 
 ગે̌ મ̬ગ કે સાે̏શયલ મી̋ડયાના ે˗સન 
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 હે̋ક̬ગ અને મા̋હતી ચાેરીનાે ભય 
 ˗̘Ǹગત ͂વનમાં ગુʏતાની અછત 

ઇɰરનેટ અે અાજ ે͂વનનું અ̑ભɿ અંગ બની ગયું છે. ભલે તમે ̍વɥાથ̰ હાે કે ˗વસાયી, ઈɰરનેટ ̍વના 
તમા̈́ં દૈ̏નક ͂ વન અધૂͅં લાગે. પણ તેનાે યાેƝય અને સરુ̐Ɩત ઉપયાેગ કરવાે અɔતં જͅરી છે. ̀ે તેનું યાેƝય 
રીતે ઉપયાેગ થાય, તાે અે અાપનું ભ̍વˮ ઉȦવળ બનાવી શકે છે. 

4.2 ઇɰરનેટ અા̋ક̭ટેǴરના મૂળ તɗા ે(Basics of Internet Architecture) 

ઇɰરનેટ પૃʕ ભૂ̌મમાં અનેક ઘટકાે સાથે કાયƙ કરે છે. દરેક ̍વગતાે ઇɰરનેટ ɦારા અેક ચાેǲસ ͅટ અને 
̏નયમ મુજબ અાગળ વધી રહી હાેય છે. અા માળખાને અાપણે Internet Architecture કહીઅે છીઅે. 

1. Client (ȃાયɰ) 

 વપરાશકતાƙનું ઉપકરણ (Computer, Mobile, Tablet). 
 તે સવƙરથી મા̋હતીની માંગ કરે છે. 
 ઉદાહરણ: તમે ǒાઉઝરમાં YouTube ખાેલાે છાે. 

2. Server (સવƙર) 

 ̍વશાળ શ̘Ǹવાળું કƳʔુટર કે ȱાં મા̋હતી (જમે કે વેબસાઇટ) ˶ાેર હાેય છે. 
 ȃાયɰની ̍વનંતી અનુસાર જવાબ અાપે છે. 
 ઉદાહરણ: YouTube Video સવƙર. 

3. ISP (Internet Service Provider) 

 ઈɰરનેટ સેવા પૂરી પાડે છે. 
 ISP ના ̀ેડાણ ̍વના ઇɰરનેટ અૅȋેસ શȂ નથી. 
 ઉદાહરણ: Jio, Airtel, BSNL, ACT. 

4. IP Address (Internet Protocol Address) 

 દરેક ઉપકરણને મળતી ̍વ̏શˠ અાેળખ સȕંા. 
 ઉદાહરણ: 192.168.0.1 
 અાના અાધારે સવƙર ̀ણે છે કે જવાબ કયા ઉપકરણ પર માેકલવાે છે. 

5. DNS (Domain Name System) 

 નામ (જમે કે google.com) ને IP અǉેેસમાં ફેરવે છે. 
 DNS વગર અાપણે વેબસાઇટના નંબર યાદ રાખવા પડશે! 

6. Router (રાઉટર) 

 ઘર કે અાૅ̋ફસમાં ̍વ̍વધ ઉપકરણાેને ઇɰરનેટ સાથે ̀ેડે છે. 
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 અેક ઉપકરણથી બીજંુ સુધી ડેટા પહા̲ચાડે છે. 

7. Protocols (ǐાેટાેકાે˔) 

 ઇɰરનેટ પર મા̋હતી માેકલવા માટેના ̏નયમા.ે 
 મુȕ ǐાેટાેકાેલ: 

o HTTP / HTTPS: વેબ પેજ માટે 
o FTP: ફાઈલ Ǉાʉફર માટે 
o TCP/IP: ઇɰરનેટનાે અાધારભૂત ǐાટેાેકાેલ 

ઇɰરનેટ કેવી રીતે કાયƙ કરે છે? (Internet Workflow) 

1. વપરાશકતાƙ ǒાઉઝરમાં "www.google.com" લખે છે. 
2. DNS અે ડાેમેનને IP અǉેેસમાં ફેરવે છે. 
3. રાઉટર અને ISP મારફતે અે ̍વનંતી Google ના સવƙર સુધી પહા̲ચે છે. 
4. Google નાે સવƙર જͅરી વેબપેજ માેકલે છે. 
5. વપરાશકતાƙને તેમની ˲ીન પર જવાબ મળે છે. 

સરળ ઉદાહરણ: 

 તમે ǒાઉઝરમાં YouTube ખાેલાે. 
 YouTube અે અેક સવƙર છે. 
 તમા̈́ં લૅપટાેપ અે ȃાયɰ છે. 
 તમારા ISP (જમે કે Jio) તમા̈́ં ડેટા Google સુધી પહા̲ચાડે છે. 
 Google નાે સવƙર તમને Video માેકલે છે. 
 તમા̈́ં ǒાઉઝર તે Video બતાવે છે. 

ઇɰરનેટ અે માǋ અેક નેટવકƙ  નથી, પણ દુ̏નયાની મા̋હતીનાે દરવા̀ે છે. તેનંુ અા̋ક̭ટેǴર ̍વ̍વધ ઘટકા ે
અને ટેકનાેલાે͂થી બનેલું છે જ ે સાૈને સુર̐Ɩત અને ઝડપી રીતે મા̋હતી પૂરી પાડે છે. ̍વɥાથ̰ તરીકે 
ઇɰરનેટના ȕાલ અને તેની પૃʕ ભૂ̌મ કાયƙǐણાલી સમજવી ખૂબ જͅરી છે, જથેી તેનાે ઉપયાેગ Ɨાનવધƙન 
અને ̍વકાસ માટે થઈ શકે. 

5. ઇɰરનેટ પરની સેવાઅાે (Services on Internet) 

ઇɰરનેટ અે માǋ વેબસાઇટ્સ ̀ેવા માટેનાે માɪમ નથી, પરંતુ તે અનેક ǐકારની ઉપયાેગી સેવાઅાે માટે 
અાધારભતૂ ʕેટફાેમƙ છે. અાજ ેઇɰરનેટનાે ઉપયાેગ ̏શƖણથી માંડીને મનાેરંજન, વેપાર, સંચાર, અને બ̲̋ક̬ગ 
જવેી અઢળક સેવાઅાે માટે થાય છે. અાવી સ̍વ̭સીઝ ઇɰરનેટના ˗ાપક ઉપયાેગને સરળ, ઝડપી અને 
અસરકારક બનાવે છે. 
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ઇɰરનેટ પર ઉપલʤ સેવાઅાેઅે ͂વનના દરેક Ɩેǋને ˾Ƹયુ̫ છે. અાજની દુ̏નયામાં કામ, અʬાસ કે 
મનાેરંજન માટે ઇɰરનેટ સેવાઅાે અ̏નવાયƙ બની ગઈ છે. દરેક વપરાશકતાƙઅે અા સેવાઅાેનાે યાેƝય અને 
સુર̐Ɩત રીતે ઉપયાેગ કરવાે ̀ેઈઅે જથેી ટેǽાેલાે͂ અાપણ ેમાટે ઉપયાેગી સા̐બત થાય. 

5.1 વ ƙ̂ વાઇડ વેબ અને વેબસાઇટ્સ (World Wide Web and Websites) 

ઇɰરનેટ અેટલે અાખી દુ̏નયાના કƳʔટુરાેનું નેટવકƙ  (Network), ȱારે World Wide Web (WWW) 
અે અે નેટવકƙમાં ઉપલʤ મા̋હતીનાે સમૂહ છે. તમે ȱારે કાેઈ વેબસાઇટ ખાેલાે છાે, ɔારે તમે વાƺતવમાં 
World Wide Web નાે ઉપયાેગ કરી ર̈ાં હાેય છે. WWW અે ઇɰરનેટ પર મા̋હતી મેળવી અાપતી સાૈથી 
લાેક̌ǐય અને ઉપયાેગી સેવા છે. 

વ ƙ̂ વાઇડ વેબ (World Wide Web) શું છે? 

World Wide Web અથવા WWW અે ઇɰરનેટ પર હાજર અનેક વેબસાઇટ્સ અને વેબ પેƢસનાે સમૂહ 
છે, જને ેǒાઉઝર ɦારા અૅȋસે કરી શકાય છે. 

તે 1989માં ̋ટમ બનƙસƙ લી (Tim Berners-Lee) ɦારા ̍વકસાવવામાં અા˗ું હતું. WWW વેબ સવƙસƙ પર 
સાચવવામાં અાવેલી મા̋હતીને HTML ફાેમ̳ટમાં યઝુસƙ સુધી પહા̲ચાડે છે. 

WWW ની ̍વશેષતાઅાે: 

 લખાણ, છબીઅાે, ̍વ̋ડયાે અને ̏લ̬ȋ સાથે મા̋હતી ǐƺતુત કરે છે. 
 ǒાઉઝર (Chrome, Firefox) ɦારા અૅȋેસ થાય છે. 
 HTTP અથવા HTTPS ǐાેટાેકાેલનાે ઉપયાેગ થાય છે. 
 ̍વ̍વધ ǐકારની વેબસાઇટ્સ સાથે ̀ેડાણ કરે છે. 

વેબસાઇટ શું છે? 

Website અે World Wide Web પર ઉપલʤ અેવી મા̋હતીનાે સમૂહ છે, જે ̍વ̍વધ વેબ પેજસથી બનેલાે 
હાેય છે. દરેક વેબસાઇટને અાેળખવા માટે તેની પાેતાની ̍વ̏શˠ અાેળખ અેટલે કે ડાેમેન નામ હાેય છે. 

ઉદાહરણ: www.google.com, www.bbc.com, www.wikipedia.org 

વેબસાઇટના મુȕ ઘટકાે: 

ઘટક વણƙન 

હાેમ પેજ (Home Page)  વેબસાઇટનું ǐથમ પેજ 

વેબ પજે (Web Pages) અʈ મા̋હતી ધરાવતા પે̀ ે

હાયપર̏લ̬ક (Hyperlinks) અેક પેજમાંથી બી̀ં પેજ પર જવા માટે 

URL (Uniform Resource Locator) વેબસાઇટનું સરનામું (જમે કે www.baou.edu.in) 
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વેબસાઇટના ǐકારા ે

ǐકાર ઉદાહરણ ઉપયાેગ 

મા̋હતીǐદ (Informational) Wikipedia, Govt Sites મા̋હતી માટે 

મનાેરંજનાɒક (Entertainment) YouTube, Netflix ̍વ̋ડયાે, સંગીત માટે 

શૈƖ̒ણક (Educational) Coursera, BYJU’S અʬાસ માટે 

˗ાપા̋રક (Commercial) Amazon, Flipkart ખરીદી/વેચાણ માટે 

સામા̏જક (Social) Facebook, Instagram લાેકાે સાથે ̀ેડાવા માટે 

વેબ ǒાઉઝર શંુ છે? 

Web Browser અે અેવી સાેʘવેર અે̖ ʕકેશન છે જ ેWorld Wide Web પર વેબસાઇટ્સ અૅȋેસ કરવા 
માટે વપરાય છે. 

લાેક̌ǐય ǒાઉઝસƙ: Google Chrome, Mozilla Firefox, Microsoft Edge, Safari, Opera 

World Wide Web અને ઇɰરનેટ વȝે તફાવત 

તફાવતનું માપદંડ ઇɰરનેટ વ ƙ̂ વાઇડ વેબ (WWW) 

˗ાȕા કƳʔુટરાેનું નેટવકƙ  વેબસાઇટ્સ અને મા̋હતીનાે જƫથા ે

કાયƙ ̀ેડાણ પૂ̈́ં પાડે છે મા̋હતી અાપે છે 

માɪમ વાયર, ઉપકરણાે, ǐાટેાેકાેલ વેબ પેજ અને ǒાઉઝર 

ઉદાહરણ ISP, Server, Router www.google.com, www.wikipedia.org 

World Wide Web અે ઇɰરનેટની સાૈથી ǐȕાત અને ઉપયાેગી સેવા છે, જનેાથી વપરાશકતાƙ ̍વ̍વધ 
ǐકારની વેબસાઇટ્સ અને મા̋હતી સુધી પહા̲ચી શકે છે. વેબસાઇટ્સના ̍વ̍વધ ǐકારાે ̍વ̍વધ હેતુઅાે માટે 
કામ અાવે છે – જમે કે ̏શƖણ, મનાેરંજન, વેપાર અને ̀ણકારી. દરેક વપરાશકતાƙઅે વેબસાઇટ્સ અને 
WWW નાે યાેƝય અને સમજદારીપૂવƙક ઉપયાેગ કરવાે ̀ેઈઅે. 

5.2 ઇɰરનેટ પર સંચાર (Communication on Internet) 

ઇɰરનેટ માǋ મા̋હતી મેળવવાનંુ સાધન નથી, પણ તે ̍વ˝ના લાેકાે વȝે સંચાર સાધન તરીકે પણ કાયƙ કરે 
છે. ઇɰરનેટના માɪમથી અાજ ેઅાપણે દુ̏નયાના કાેઈ પણ ખૂણે બેઠેલા માણસ સાથે માૈ̑ખક, લે̑ખત કે 
͆Ƹય સંચાર કરી શકીઅે છીઅે — તે પણ તુરંત અને ખૂબ અાેછા ખચ̳. ઇɰરનેટ સચંારના ̍વ̍વધ માɪમાે 
વતƙમાન યુગમાં અ̑ભɿ બની ગયા છે. 

ઇɰરનેટ સંચારના મુȕ માɪમા ે
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1. ઇમેઇલ (Email) 

 ઇલƛેǇાે̏ નક મેઇલ. 
 ˗̘Ǹગત અને ˗ાવસા̍યક સંદેશા માેકલવા માટે ઉપયાેગી. 
 ફાઈ˔ પણ ̀ેડીને માેકલી શકાય છે. 
 લાેક̌ǐય સેવા: Gmail, Outlook, Yahoo Mail 

2. ઇʊɰ મેસે̏જ̬ગ (Instant Messaging) 

 ̋રયલ ટાઈમ (તȿાળ) લખાણ સંદેશા માેકલવા માટે. 
 ǁુપ ચેટ, ઇમાે͂, ફાેટાે શે̋રગ̬ વગેરે સુ̍વધા. 
 લાેક̌ǐય અેƯસ: WhatsApp, Telegram, Signal 

3.વાેઈસ કાે̏લ̬ગ (Voice Calling) 

 ઇɰરનેટ મારફતે મફત અથવા અાેછા દરે ફાેન કાેલ કરવા માટે. 
 VoIP (Voice over Internet Protocol) ટેǽાેલાે͂  અાધા̋રત. 
 અƯેસ: WhatsApp Call, Skype, Google Voice 

4.̍વ̋ડયાે કાે̏લ̬ગ (Video Calling) 

 સામસામે ̀ેઈને વાતચીત કરવાની સુ̍ વધા. 
 વૈ̏ ˝ક ˗ાપાર, ̏શƖણ અને ˗̘Ǹગત ઉપયાેગ માટે ઉપયાેગી. 
 લાેક̌ǐય ʕેટફાેમƙ: Zoom, Google Meet, Microsoft Teams 

5. ફાેરમ અને અાેનલાઇન સમૂહાે (Discussion Forums & Online Groups) 

 અલગ અલગ ̍વષય પર લાેકાે વȝે ચચાƙ માટે. 
 ǐ˜ાે પૂછવા, જવાબ અાપવા અને Ɨાન વહ̲ચવા માટે ʕેટફાેમƙ. 
 ઉદાહરણ: Reddit, Quora, Stack Overflow 

6. સામા̏જક માɪમાે (Social Media Communication) 

 ˗̘Ǹગત અને સામા̏જક સંપકƙ  માટેનું અાધુ̏નક સાધન. 
 પાે˶, કાેમેɰ, મેસેજ, લાઇવ વી̋ડયાે વગરેે ɦારા સંચાર. 
 લાેક̌ǐય ʕેટફાેમƙ: Facebook, Instagram, Twitter, LinkedIn 

ઇɰરનેટ સંચારની ̍વશેષતાઅા ે

લƖણ વણƙન 

ઝડપી તȿાળ સંદેશા અને જવાબ ǐાʏ થાય છે 

વૈ̏ ˝ક દુ̏નયાના કાેઈ પણ ખૂણામાં સંપકƙ  શȂ 
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અાેછાે ખચાƙળ ફાેન અને મેસેજ કરતા વધુ સƺતુ ં

મ̔˄મી̋ડયા અાધા̋રત લખાણ, છબી, અવાજ અને ̍વ̋ડયાે પણ માેકલી શકાય 

શૈƖ̒ણક અને ˗વસા̍યક અાેનલાઈન ȃાસ, વે̐ બનાર અને ̌મ̋ટ̬Ɲસ માટે ઉપયાેગી 

 

ઇɰરનેટ સંચારના લાભા ે

 ̍વ˝માં Ȃારેય પણ, Ȃાંય પણ સંપકƙ  
 પ̋રવાર, ̌મǋાે અને ˗વસાય સાથે ̀ેડાયેલા રહેવું સરળ 
 ̏શƖણ અને તાલીમ માટે નવી રીત 
 ǁુપ પર ચચાƙ અને Ɨાન વહ̲ચણી 
 દƺતાવે̀ે અને મા̋હતી તરત માેકલવી 

ઇɰરનેટ સંચારના અવગણનાઅાે (̀ે ખાેટી રીતે વપરાય તાે) 

 ખાેટી મા̋હતી (Fake News) નાે ફેલાવાે 
 ગʏુતા (Privacy) નાે ભંગ 
 સાે̏શયલ મી̋ડયા ˗સન 
 ˾ામ અને ̋ફ̏શ̬ગ મેઇ˔ 
 અવાજ અને ̍વ̋ડયાે કાેલ દર̌મયાન ટેક̏નકલ સમ̃ાઅા ે

ઇɰરનેટ પર સંચાર અે અાજના યુગની જͅરીયાત બની ગઈ છે. ˗̋કતગત ͂વનથી લઈને ˗વસાય અને 
̏શƖણ સુધીના દરેક Ɩેǋમાં ઇɰરનેટ સંચાર મહɗની ભૂ̌મકા ભજવે છે. વપરાશકતાƙઅે તેનાે યાેƝય, 
જવાબદાર અને સુર̐Ɩત રીત ેઉપયાેગ કરવાે ̀ેઈઅે જથેી ટેǽાેલાે͂ નું પૂ̈́ ં  લાભ મળી શકે. 

5.3 ઇɰરનેટ સેવાઅાે (Internet Services) 

ઇɰરનેટ અે માǋ વેબસાઈટ ǒાઉઝ કરવા માટેનું માɪમ નથી, પણ તે અનેક ǐકારની સેવાઅાે પરૂી પાડે છે 
જ ેઅાજ ેદરેક Ɩેǋમાં ઉપયાેગી સા̐બત થઈ છે. અા સેવાઅાે ˗̘Ǹગત, શૈƖ̒ણક, ˗વસા̍યક અને સરકારી 
લેવલે મહɗપૂણƙ બની ગઈ છે. અા સ̍વ̭સીસ ઇɰરનેટને બહુપƖીય અને બહુપયાેગી બનાવે છે. 

ઇɰરનેટ સેવાઅાે (Internet Services) 

મȕુ ઇɰરનેટ સેવાઅાે 

1. ઇમેઇલ સવેા (Email Service) 

 ઇમેઇલ અે ઇલƛેǇાે̏ નક મેઇલ છે, જેનાથી તમે લખેલ સંદેશાે અને ફાઈ˔ થાેડી પળાેમાં ̍વ˝ના કાેઈપણ 
ખૂણામાં માેકલી શકાે છા.ે 

 લાેક̌ǐય ઉદાહરણ: Gmail, Yahoo Mail, Outlook 
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2. વેબ ǒાઉ̎ઝ̬ગ (Web Browsing) 

 ̍વ̍વધ ̍વષયાેની મા̋હતી મેળવવા માટે તમે ǒાઉઝર મારફતે વેબસાઇટ્સ પર જઈ શકાે છાે. 
 લાેક̌ǐય ǒાઉઝસƙ: Google Chrome, Mozilla Firefox, Microsoft Edge 

3. ઇʊɰ મેસે̏જ̬ગ અને ચે̋ટ̬ગ 

 તȿાળ સંદેશા માેકલવા અને ǐાʏ કરવા માટે ઇɰરનેટ મેસે̏જ̬ગ અે̖ʕકેશʉ ઉપયાગેી છે. 
 લાેક̌ǐય અેƯસ: WhatsApp, Telegram, Facebook Messenger 

4. ̍વ̋ડયાે કાે̏લ̬ગ અને કાʃેર̙ʉ̬ગ 

 દુ̏નયાભરના લાેકાે સાથે ̀ેઈને વાતચીત કરવા માટે ̍વ̋ડયાે કાʃેર̘ʉ̬ગ ખૂબ ઉપયાેગી છે. 
 લાેક̌ǐય ʕેટફાેમƙ: Zoom, Google Meet, Microsoft Teams 

5. ઇ-લ̏ન̮ગ (E-Learning) 

 ̍વɥાથ̰અાે માટે અાેનલાઇન અʬાસની સહાયથી ઇɰરનેટ ̏શƖણને ઘરઅાંગણે લાવે છે. 
 લાેક̌ǐય ʕેટફાેમƙ: SWAYAM, BYJU’S, Coursera, Khan Academy 

6. ઈ-કાેમસƙ અન ેઅાેનલાઈન ખરીદી 

 તમે ઘેર બેઠાં વƺતઅુાે ખરીદી શકાે છાે અને વેચી પણ શકાે છાે. 
 લાેક̌ǐય સાઇટ્સ: Amazon, Flipkart, Meesho 

7. મ˄ી̍મડીયા અન ેમનાેરંજન 

 ̋ફːાે ̀ેવી, સંગીત સાંભળવાે અને રમતાે રમવી – અા બધંુ ઇɰરનેટની દેણ છે. 
 લાેક̌ǐય ʕેટફાેમƙ: YouTube, Netflix, Spotify 

8. ઇ-બ̲̋ક̬ગ અને અાેનલાઇન પેમેɰ 

 ઇɰરનેટ ɦારા બ̲ક ખાતું ચકાસવું, પસૈા Ǉાʉફર કરવાે અને ̐બલ ભરવું શȂ છે. 
 લાેક̌ǐય સેવાઅાે: SBI Net Banking, Google Pay, PhonePe, Paytm 

9. ʈુઝ અને ઈ-પેપર 

 તા͂ અને ̍વ˝સનીય મા̋હતી માટે ઇɰરનેટથી અાેનલાઇન સમાચાર વાંચી શકાય છે. 
 લાેક̌ǐય સાઇટ્સ: BBC, Divya Bhaskar, Times of India 

ઇɰરનેટ સેવાઅાેઅે અાજનંુ ͂વન સરળ, ઝડપી અને વધુ કાયƙƖમ બનાવી દીધંુ છે. દરેક વય જૂથના લાેકાે 
માટે ઇɰરનેટ પર કાેઈ ને કાેઈ ઉપયાેગી સેવા ઉપલʤ છે. ઇɰરનેટ સેવાઅાેનાે યાેƝય અને સુર̐Ɩત ઉપયાેગ 
કરીને ˗̘Ǹગત અને સામૂ̋હક ̍વકાસ શȂ બને છે. 
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6. કƳʔુટરને ઇɰરનેટ વાપરવા માટે તૈયાર કરવું (Preparing Computer for 
Internet Access) 

ઇɰરનેટનાે ઉપયાેગ કરવા માટે તમા̈́ં કƳʔુટર કે લૅપટાેપ યાેƝય રીતે તૈયાર હાેવું જͅરી છે. યાેƝય hardware, 
software, settings અને connection ̍વના ઇɰરનેટ અૅȋેસ શȂ નથી. અા ǐ̋ƿયાને અાપણ ે
"Preparing Computer for Internet Access" તરીકે અાેળખી છીઅે. 

કƳʔુટર ઇɰરનેટ માટે કેવી રીતે તૈયાર કરવું? 

1. Hardware તૈયાર કરા ે

 Computer / Laptop: કાયƙƖમ ̗˺̍તમાં હાેવાે ̀ેઈઅે. 
 Network Interface Card (NIC): વાયર (Ethernet) અથવા વાયરલેસ (Wi-Fi) માટે જͅરી. 
 Modem / Router: ઇɰરનેટ સગવડ માટે. 
 Cables / Wi-Fi Adapter: ̀ે વાયર કનȆેન હાેય તાે કેબલ જͅરી; ન હાેય તાે Wi-Fi card/adapter 

હાેવાે જͅરી. 

2. ઈɰરનેટ ̀ેડાણ લા ે

 કાેઈ ̍વ˝સનીય Internet Service Provider (ISP) પસંદ કરાે. ઉદાહરણ: Jio, Airtel, BSNL, ACT 
 Monthly Plan અથવા Prepaid/Unlimited Plan પસંદ કરાે. 
 ISP તરફથી મળેલું username-password અથવા configuration settings સાચવી રાખાે. 

3. નેટવકƙ  સેટઅપ કરાે 

 Wi-Fi કનȆેન માટે: Wireless settings માંથી તમા̈́ં Wi-Fi name (SSID) પસદં કરાે. Password 
નાખીને કનેǶ થાઅાે. 

 Ethernet કેબલ માટે: કેબલ NIC પાેટƙમાં લગાવાે. Connection automatic અાેળખાશે. 

4. અાેપરેટ̯ગ સી˶મ અન ેǉાઈવર અપડેટ કરા ે

 Windows/Linux/Mac OS માં યાેƝય network drivers ઇʊાેલ કરાે. 
 OS ની network settings તપાસાે — IP address, DNS settings, Proxy વગેરે. 

5. Firewall અને Antivirus ચેક કરાે 

 Security settings તપાસાે. 
 Firewall settings ɦારા ઇɰરનેટ અૅȋેસ પર અડચણ ન અાવે અે ખાતરી કરાે. 
 Antivirus ઇɰરનેટથી અાવતા વાયરસ સામે રƖણ અાપ ેછે. 

6. Web Browser ઇʊાેલ કરાે 

 Google Chrome, Mozilla Firefox, Microsoft Edge, Safari વગેરે ǒાઉઝર ઇʊાેલ કરાે. 
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 Browser update રાખાે જથેી તમે નવી વેબ ટેǽાેલાે͂  અૅȋેસ કરી શકાે. 

7. ઇɰરનેટ ̀ેડાણ ટે˶ કરા ે

 ǒાઉઝર ખાેલીને કાેઈ વેબસાઇટ (જમે કે www.google.com) ટાઇપ કરાે. 
 ̀ે પેજ ખુલે છે તાે ઇɰરનેટ સƖમ છે. 
 ન ખૂલે તાે: 

o કેબલ / Wi-Fi કનેȆન તપાસા ે
o Network settings ફરીથી તપાસાે 
o ISP ને સંપકƙ  કરાે 

જͅરી સાધનાેની યાદી 

સાધન ઉપયાેગ 

NIC Card નેટવકƙથી કનેǶ થવા માટે 

Router / Modem ઇɰરનેટ સાથે ̀ેડાણ 

Web Browser વેબસાઇટ ̀ેવા માટે 

Antivirus સુરƖા માટે 

ISP Plan ઇɰરનેટ સેવા માટે 

કƳʔુટરને ઇɰરનેટ માટે તયૈાર કરવંુ અે સરળ પરંતુ મહɗપણૂƙ ǐ̋ƿયા છે. યાેƝય hardware, network 
settings અને software સાથે, તમે સરળતાથી ઇɰરનેટથી કનેǶ થઇ શકાે છાે અને તેની ̍વ̍વધ 
સેવાઅાેનાે લાભ લઈ શકાે છાે. સાૈ ǐથમ, તમારા ઉપકરણની તૈયારી તપાસાે પછી જ ઇɰરનેટ અૅȋેસ કરા.ે 

6.1 ઇɰરનેટ અȋૅેસ કરવાની પɡ̍તઅા ે(Internet Access Techniques) 

ઇɰરનેટનાે લાભ લેવા માટે અાપણા ઉપકરણને ઇɰરનેટ સાથે ̀ેડાણ (access) અાપવંુ પડે છે. અાજ ે
ઇɰરનેટ અૅȋેસ કરવા માટે ̍ વ̍વધ પɡ̍તઅાે ઉપલʤ છે — વાયરથી લઈને વાયરલેસ, માબેાઇલથી લઈને 
સેટેલાઈટ સુધી. દરેક પɡ̍તમાં ઝડપ, ખચƙ અને ઉપલʤતાના અાધારે ̑ભɿતા હાેય છે. અા ̍વષયમાં અાપણે 
ઈɰરનેટ અૅȋેસ કરવાની મુȕ પɡ̍તઅાેની સમજૂતી મેળવીશું. 

ઇɰરનેટ અȋૅેસ કરવાની મુȕ પɡ̍તઅાે 

1.  Dial-up Connection: સાૈથી જૂની પɡ̍ત ડાયલ-અપ કનેȆન હતી, જમેાં ટે̏લફાેન લાઇન ɦારા 
ઇɰરનેટ મળે છે. તે ખૂબ ધીમી ગ̍ત અને સમય ̍ વલંબવાળી પɡ̍ત છે, અને અાજ ેલગભગ ઉપયાેગમાં લેવામા ં
અાવતી નથી.  
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 2.  DSL (Digital Subscriber Line): ડાયલ-અપ પછી DSL અા˗,ુ જ ેટે̏લફાેન લાઇન ઉપર અાધારીત 
છે પરંતુ તેનાે ˾ીડ વધુ છે અને ટે̏લફાેનનાે ઉપયાેગ અેકસાથે શȂ છે. માેટા ભાગે ઘરેલુ અને અાે̋ફસ 
ઉપયાેગ માટે અાજયે DSL ǐમાણભૂત પસંદગીઅામેાં ગણાય છે.  

3. Cable Internet: કેબલ ઇɰરનેટ અે ટે̏લ̍વઝન કેબલ લાઇન મારફતે અાપવામાં અાવતું ǒાેડબેɱ છે, 
જ ેસારી ગ̍ત અને ̍વ˝સનીયતા ધરાવે છે અને શહેરાેમાં ખાસ કરીને વધુ લાેક̌ǐય છે. 

4. Mobile Internet (2G/3G/4G/5G): વાયરલેસ પɡ̍તઅાેમાં સાૈથી લાેક̌ǐય અને સરળ ઉપલʤ 
સેવા છે માેબાઇલ ઇɰરનેટ. અાજ ેલાેકાે માેટા ǐમાણમાં 4G અને હવે 5G જવેી ઝડપી ટેǽાેલાે͂ નાે ઉપયાેગ 
કરે છે, જ ેમાેબાઇલ નેટવકƙ  મારફતે ડેટા અૅȋેસ અાપે છે.  

5. Wi-Fi (Wireless Fidelity): માેબાઇલ ડેટા સાથે ̀ેડાયેલી બી͂ પɡ̍ત છે Wi-Fi, જમેાં રાઉટર ɦારા 
વાયરલેસ કનેȆન અાપવામાં અાવે છે. ઘરાે, અાે̋ ફસાે, કાૅલે̀ે અને કેફે જવેા ˺ળાેઅે Wi-Fi ખૂબ સામાʈ 
છે, કારણ કે અેક જ નેટવકƙ  પર અનેક ઉપકરણાે ̀ેડાઈ શકે છે. 

6. Satellite Internet: ̀ે તમે અેવા ̍વƺતારામેાં રહા ેછાે ȱાં કેબલ કે માેબાઇલ નેટવકƙ  ઉપલʤ નથી, 
તાે તમારે સેટેલાઈટ ઇɰરનેટ પસંદ કરવું પડે. તેમાં ઉપર અવકાશમાં ̗˺ત સેટેલાઈટ ɦારા કનȆેન મળે છે. 
અાવા કનેȆન ખાસ કરીને ǁાʸ કે દૂર˺ ̍વƺતારાેમાં ઉપયાેગી થાય છે, પરંતુ તેમાં ખચƙ વધારે અને વારંવાર 
̍વલંબ (Latency)નાે સામનાે થાય છે.  

7. Leased Line Connection: માટેી કંપની કે ઉɥાે̎ ગક ƺતરે ખાસ કને̖Ƕ̍વટી માટે લીƣડ લાઇન 
કનેȆન વધુ ǐચ̏લત છે, જમેાં કંપનીઅાે માટે સતત, ઉȝ-ઝડપવાળું અને ̐સȂાેર કનેȆન ઉપલʤ થાય 
છે. 

સરખામણી ટેબલ:  

પɡ̍ત માɪમ ઝડપ ઉપયાે̎ગતા 

Dial-up Telephone line ઘણી ધીમી જૂની પɡ̍ત 

DSL Telephone line મɪમ ઘર અને અાે̋ફસ 

Cable Cable TV line વધુ શહેરાેમા ં

Mobile Mobile Network વધુ (4G/5G) અંગત ઉપકરણાે માટે 

Wi-Fi Wireless Router મɪમ/ઉȝ ઘરાે અને ˱ૂલા ે

Satellite Dish & Modem મɪમ ǁાʸ ̍વƺતારાે માટે 

Leased Line Dedicated Cable ઊંચી ઉɥાેગાે માટે 
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ઇɰરનેટ અૅȋેસ કરવાની પɡ̍તઅાે સમય અને ટેǽાલેાે͂ સાથે બદલાતી રહી છે. અાજ,ે માેબાઇલ અને 
Wi-Fi સાૈથી વધુ ઉપયાેગમાં લેવાતી પɡ̍તઅાે છે, ȱારે અાે̋ ફસાે માટે કેબલ અને લીƣડ લાઇન વધુ ઉપયાેગી 
છે. દરેક વપરાશકતાƙઅે પાેતાની જ̋ͅરયાત અને ̍વƺતાર અનુસાર યાƝેય પɡ̍ત પસંદ કરવી ̀ેઈઅે જથેી 
ઇɰરનેટનાે પૂરતાે લાભ લઈ શકાય. 

7. વેબ ǒાઉ̎ઝ̬ગ સાʘેવરે (Web Browsing Software) 

ઇɰરનેટનાે ઉપયાેગ ɔારે શȂ બને છે ȱારે અાપણે વેબસાઇટ્સ અȋૅેસ કરી શકીઅે — અને અે માટે 
જͅરી હાેય છે વબે ǒાઉઝર. વેબ ǒાઉ̏ઝ̬ગ સાેʘવેર અે અેવું સાધન છે જે World Wide Web (WWW) 
પર હાજર ̍વ̍વધ વબેપેજ અને મા̋હતી સુધી વપરાશકતાƙને પહા̲ચાડે છે. તે યુઝર અને ઇɰરનેટ વȝેનું અેક 
મહɗપૂણƙ માɪમ છે. 

વેબ ǒાઉ̎ઝ̬ગ સાʘેવેર શંુ છે? 

Web Browser અેટલે કે વેબ ǒાઉઝર અે અેક ǐકારનંુ અે̖ʕકેશન સાʘેવેર છે જ ેવપરાશકતાƙને ઈɰરનેટ 
પર ̍ વ̍વધ વેબસાઈટ્સ ̀ેઈ શકાય અેવી સુ̍વધા અાપ ેછે. ȱારે તમે કાેઈ વેબ અેǉેસ (URL) લખાે છાે, ɔારે 
ǒાઉઝર તે વેબસાઇટના સવƙર સાથે સંપકƙ  સાધે છે અને વેબ પેજ તમારી ˲ીન પર ǐદ̏શ̭ત કરે છે. તે HTML, 
CSS, JavaScript જવેી ભાષાઅાે સમ͂ શકે છે અને વેબપેજને માનવી સમ͂ શકે અવેી રીતે દશાƙવે છે. 

વેબ ǒાઉઝર ની મુȕ કામગીરી 

 URL લખીને વેબસાઇટ ખાેલવી 
 વેબપેજને વાંચવા યાેƝય બનાવવુ ં
 ઇમેજ, ̍વ̋ડયા,ે ટેȌ જેવી મા̋હતી બતાવવી 
 બુકમાકƙ , ડાઉનલાેડ, ̋હ˷ી (History) સાચવી રાખવી 
 ǒાઉ̏ઝ̬ગ ̐સȂુ̋રટી અને ǐાઇવસી સુરƖા પૂરી પાડવી 

વેબ ǒાઉઝર અને તેનંુ ઇɰરફેસ 

બધા ǒાઉઝર નીચેના ઘટકાે ધરાવે છે: 

 Address Bar (અǉેેસ બાર): ȱાં તમે વેબસાઇટનું નામ લખાે છાે (જમે કે www.google.com) 
 Navigation Buttons: Back, Forward, Reload વગેરે 
 Tabs: અનેક પેજ અેકસાથે ખાેલવા માટે 
 Bookmarks: મહɗપૂણƙ વેબસાઇટ્સ સાચવવા માટે 
 History: પહેલાં ખાેલેલી વેબસાઈટ્સની યાદી 

વેબ ǒાઉ̎ઝ̬ગ સલામતી માટે સચૂનાે 

 હંમેશાં HTTPS સાઇટ્સ જ વાપરા ે
 ǒાઉઝર અપડેટ રાખા ે
 અ̀ણી સાઇટ્સ પર ˗̘Ǹગત મા̋હતી ન અાપાે 
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 Ad-blocker અથવા Antivirus Extensions વાપરાે 
 ǒાઉ̏ઝ̬ગ પછી History અને Cache સાફ કરાે 

વેબ ǒાઉ̏ઝ̬ગ સાેʘવેર ̍વના ઇɰરનેટ ઉપયાેગ અસંભવ છે. તે વપરાશકતાƙને વેબસાઇટ્સ સાથે કનǶે કરે 
છે અને ઇɰરનેટના અɣતુ ̍વ˝માં ǐવેશ અપાવે છે. Chrome, Firefox, Edge વગેરે ̍વ̍વધ ̍વકˍાે છે  
દરેકના પાેતાના ફાયદા અન ે લƖણાે છે. યાેƝય ǒાઉઝર પસંદ કરીને અાપણે ઝડપી, સુર̐Ɩત અને સુગમ 
ઇɰરનેટ અનુભવ મેળવી શકીઅે છીઅ.ે 

7.1 લાેક̌ǐય વબે ǒાઉ̎ઝ̬ગ સાʘેવેર (Popular Web Browsing Software) 

ઇɰરનેટ પર વેબસાઇટ્સ ǒાઉઝ કરવા માટે અાપણે વેબ ǒાઉઝરનાે ઉપયાેગ કરીઅે છીઅે. અાવી અનેક 
ǒાઉ̏ઝ̬ગ સાેʘવેર ઉપલʤ છે, પરંતુ કેટલાક ǒાઉઝસƙ તેમના ઝડપી ǐ̍તસાદ, સુરƖા, યુઝર ઈɰરફેસ અને 
સુ̍ વધાઅાેને કારણે ̍વ˝ભરમાં સાૈથી વધુ લાેક̌ǐય બʈા છે. અા ̍વષયમાં અાપણે અેવા કેટલાક ̀ણીતા 
અને લાેક̌ǐય વેબ ǒાઉ̏ઝ̬ગ સાેʘવેર ̍વશે ̀ણશું. 

1. Google Chrome: Google Chrome અે અાજકાલ ̍વ˝નાે સાૈથી વધુ વપરાતાે વેબ ǒાઉઝર છે. તે 
2008માં Google ɦારા લાેƮચ થયાે હતાે. Chrome પાેતાના ઝડપી લાે̋ ડ̬ગ, સરળ ઇɰરફેસ અને હ̀રાે 
અȌેેƮશʉ (Extensions) માટે અાેળખાય છે. 

̍વશેષતાઅાે: 

 ઝડપથી પેજ લાેડ થાય છે 
 Google સ̍વ̭સીસ સાથે સંપૂણƙ અેકીકરણ 
 ˗̘Ǹગત અાƯેશન, બુકમાકƙ , ઇɬાે̗ Șટાે માેડ 
 Cross-platform સપાેટƙ (Windows, Android, iOS) 

2. Mozilla Firefox: Firefox અે Mozilla Foundation ɦારા ̍વક̐સત અેક અાેપન સાેસƙ ǒાઉઝર છે. તે 
ખાસ કરીને યુઝર ǐાઇવસી અને સુરƖાને મહɗ અાપ ેછે. Firefox હળવાે અને ક˶માઇઝેશન માટે સરળ 
ǒાઉઝર છે. 

̍વશેષતાઅાે: 

 ǐાઇવસી ફાેકƺડ ǒાઉઝર 
 ʕ̎ગʉ અને ̎થʼ માટે સપાેટƙ 
 અાેપન સાેસƙ અને ̏ન:શુʿ  
 Windows, Linux અને Mac માટે ઉપલʤ 

3. Microsoft Edge: Microsoft Edge અે Microsoft કંપનીનું ǒાઉઝર છે, જ ે પહેલાં Internet 
Explorer તરીકે અાેળખાતું હતું. નવી અાવૃ̍ɇ Chromium પર અાધા̋રત છે, જ ેChrome જવેી જ ટેǽાેલાે͂  
પર કાયƙ કરે છે. 

̍વશેષતાઅાે: 
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 ઝડપી અને લાઇટવેઇટ ǒાઉ̏ઝ̬ગ 
 Windows 10/11 માં ̐બ˄-ઇન 
 Reading Mode અને PDF viewer જેવી સુ̍વધાઅાે 
 Chrome Extensions સપાેટƙ કરે છે 

4. Apple Safari: Safari અે Apple ɦારા ̍વક̐સત ǒાઉઝર છે અને મુȕɗે Mac, iPhone, iPad જવેા 
ઉપકરણાેમાં ઉપયાેગ થાય છે. Safari અાેટાેમે̋ટક પાવર મનેેજમેɰ અને ˾ીડ માટે અાેળખાય છે. 

̍વશેષતાઅાે: 

 Mac અને iOS માટે ખાસ ̍વક̐સત 
 શ̘Ǹશાળી ǐાઇવસી ફીચસƙ 
 ઝડપી પફા̳મƙʉ અને કમ ઊ̀ƙ વપરાશ 
 Reading List અને iCloud Sync 

5. Opera: Opera અેક પાતળું અને ઝડપી ǒાઉઝર છે જ ેપાેતાના અનાેખા ફીચસƙ માટે અાેળખાય છે. તેમા ં
built-in VPN, ad blocker અને news feed જવેી સુ̍વધાઅાે છે. 

̍વશેષતાઅાે: 

 Free VPN સેવાનું સપાેટƙ 
 ઝડપી પેજ લાે̋ડ̬ગ અને ડેટા સે̍વ̬ગ માેડ 
 ̐બ˄-ઇન મેસે̏જ̬ગ અે̖ ʕકેશʉ (WhatsApp, Facebook) 
 Windows, Android, Mac માટે ઉપલʤ 

6. Brave Browser: Brave અે નવી ટેǽાેલાે͂  અાધા̋રત ǒાઉઝર છે જ ે̀હેરાતાેને અવરાેધે છે અન ે
યુઝર ǐાઇવસી માટે વધુ સુરƖા અાપે છે. 

̍વશેષતાઅાે: 

 Built-in ad blocker 
 ઝડપી ǒાઉ̏ઝ̬ગ 
 BAT ̋રવાેડƙ ̐સ˶મ 
 અાેપન સાેસƙ અને ખાનગી ǒાઉ̏ઝ̬ગ 

અાજના યુગમાં વેબ ǒાઉઝર માǋ વબેસાઇટ ̀ેવા માટે નહ̯, પણ સુરƖા, ગ̍ત, ક˶માઇઝેશન અને અનેક 
સેવાઅાે માટે જવાબદાર બની ગયાે છે. Google Chrome સાૈથી વધુ વપરાતાે ǒાઉઝર છે, ȱારે Firefox 
અને Brave વધુ સુર̐Ɩત ̍ વકˍ અાપે છે. Microsoft Edge Windows માટે અને Safari Apple માટે Ǘેˤ 
છે. વપરાશકતાƙઅે પાેતાના ઉપકરણ, જ̋ͅરયાત અને પસંદગીને ɪાને રાખીને યાેƝય ǒાઉઝર પસંદ કરવાે 
̀ેઈઅે. 
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8. વેબ ǒાઉઝરનું કાે̔ʃƝયુરેશન (Configuring Web Browser) 

ઇɰરનેટ પર સુર̐Ɩત, ઝડપી અને ˗વ̗˺ત ǒાઉ̏ઝ̬ગ માટે તમારા વબે ǒાઉઝરનું યાેƝય રીતે કાે̔ ʃƝયરેુશન 
(Configuration) કરવંુ અɔંત અાવƸયક છે. ǒાઉઝર કઈ રીતે કાયƙ કરે છે, શું દેખાય છે, કઈ ભાષા અાવ ે
છે, કઈ વેબસાઇટ ખૂલ ેછે, અને તમે કેટલું ખાનગી બની શકાે છાે — તે બધંુ તેના કાે̔ʃƝયુરેશન પર અાધાર 
રાખે છે. દરેક વબે ǒાઉઝર (જમે કે Chrome, Firefox, Edge વગેરે) કાે̔ʃƝયુરેશન માટે ̍વ̍વધ ̍વકˍા ે
અાપે છે. 

વેબ ǒાઉઝર કાે̔ʃƝયુરેશનનું મહɗ 

 ǒાઉઝરનાે દેખાવ અને વતƙન ̏નયં̍ǋત કરવા માટે 
 વેબસાઈટ ખાેલતી વખતે ગ̍ત અને કાયƙƖમતામાં સધુાર કરવા માટે 
 યુઝર ǐાઇવસી અને સુરƖા સુ̏ ન̏˛ત કરવા માટે 
 લાૅ̎ગન, પાસવડ્ƙસ, ડાઉનલાડે અને અૅȌેƮશન સંચા̏લત કરવા માટે 
 શૈƖ̒ણક અથવા ˗વસા̍યક જ̋ͅરયાતાે અનુસાર ǒાઉઝરને ઢાળવા માટે 

સામાʈ કાે̔ ʃƝયુરેશન ̍વકˍાે (Common Configuration Options) 

1. Homepage સુયાે̏ જત કરવી 

 ȱારે ǒાઉઝર ખૂલે ɔારે કઈ વેબસાઈટ ǐથમ દેખાવવી તે ̏નધાƙ̋રત કરી શકાય છે. 
 ઉદાહરણ: www.google.com, www.school.edu 

2. Default Search Engine પસંદ કરવી 

 ǒાઉઝરનાે અેǉેસ બારમાંથી શાેધતી વખતે કઈ Search Engine વાપરવી — જેવી કે Google, Bing, 
Yahoo વગેરે. 

3. Privacy Settings (ગુʏતા સે̋ટ̬Ɲસ) 

 Cookies, Browsing history, Autofill અને Tracking ની̍ત ̏નયં̍ ǋત કરી શકાય છે. 
 Incognito Mode / Private Browsing પસંદ કરીને ગુʏતા વધારી શકાય છે. 

4. Security Settings (સરુƖા સે̋ટ̬Ɲસ) 

 HTTPS સાઇટ્સ માટે સાવચેતી, ̋ફ̏શ̬ગ રાેકટામ, પાેપ-અપ અવરાેધન અને સાઇટ પર Permissions 
̏નયં̍ǋત કરવી. 

5. Download Location પસંદ કરવી 

 ǒાઉઝરથી ફાઈલ ડાઉનલાેડ થાય ɔારે તે કઈ ફાેˆર / ˺ાન પર સેવ થવી ̀ેઈઅે. 

6. Language અને Appearance (ભાષા અને દેખાવ) 

 ǒાઉઝર કઈ ભાષામાં બતાવવાે ̀ેઈઅે — જમે કે English, Hindi, Gujarati. 
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 ̎થમ અને ફાɰ્ેસ પસંદ કરી શકાય છે. 

7. Extensions અને Plugins સંચાલન 

 Ad blocker, Grammar checker, PDF viewer જવેી Utility Extensions 
ઇʊાેલ/અનઇʊાેલ/̏ન̒˟ય કરી શકાય છે. 

8. Sync Settings (ખાતું ̀ેડાવંુ) 

 Google કે Firefox અેકાઉɰ સાથે ǒાઉ̏ઝ̬ગ ડેટા (History, Bookmarks, Passwords) sync કરવા 
માટે ઉપયાેગી. 

Chrome ǒાઉઝર કાે̔ ʃƝયુરેશન માટે પગલા ં

1. ǒાઉઝર ખાલેાે → ઉપર જમણી બાજુઅ ે“噣” પર ̚ȃક કરાે 

 

2. “Settings” પસદં કરા ે
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3. ̍વ̍વધ ̍વભાગાે ̀ેવા મળશે: Privacy, Appearance, Search Engine, Extensions વગેરે 

4. તમારી જ̋ͅરયાત ǐમાણે બદલાે 

5. ǒાઉઝર ̋ર˶ાટƙ કરીને ફેરફારાે લાગુ કરા ે

અʈ ǒાઉઝરાે માટે પણ કાે̔ ʃƝયુરેશન સમાન છે: 

 Firefox: Menu > Settings 
 Edge: Settings and more > Settings 
 Safari: Preferences 

વેબ ǒાઉઝરનું યાેƝય કાે̔ ʃƝયુરેશન કરવાથી ન માǋ ǒાઉ̏ઝ̬ગ અનુભવ વધુ સારાે બને છે, પણ તે યૂઝરની 
સુરƖા અને ǐાઇવસી માટે પણ અ̏નવાયƙ છે. હાેમપજેથી લઈને સેવાઅાે અને ગુʏતા સુધી દરેક સે̋ટ̬ગ 
ǒાઉ̏ઝ̬ગ રીતને અસર કરે છે. દરેક વપરાશકતાƙઅે ǒાઉઝરનું કાે̔ʃƝયરેુશન પાેતાની જ̋ͅરયાત મુજબ 
ચાેǲસ રીતે કરવું ̀ેઈઅે જથેી ઇɰરનેટનાે સકારાɒક અને સુર̐Ɩત ઉપયાેગ કરી શકાય. 

9. સચƙ અેિƮજન (Search Engines) 
 

ઇɰરનેટ અેક ̍વશાળ મા̋હતીનાે સમુǍ છે. પરંતુ અા મા̋હતીમાંથી જͅરની મા̋હતી શાેધવી અે સહેલુ ંકાયƙ 
નથી. અહ̯ સચƙ અેિƮજન (Search Engines) અાપણને મદદ કરે છે. વેબ પર ઉપલʤ લાખાે 
વેબસાઇટ્સમાંથી જͅરી મા̋હતી શાેધીને યુઝર સુધી પહા̲ચાડવાનું કામ સચƙ અેિƮજન કરે છે. તેનાે ઉપયાેગ 
અાજ ે̏શƖણ, ˗વસાય, અʬાસ અન ેમનાેરંજન જવેી તમામ ǐવૃ̍ ɇઅાેમાં થાય છે. 

સચƙ અેિƮજન અેટલે શું? 

સચƙ અેિƮજન અે અેક ǐકારની અાૅનલાઇન સેવા છે કે જ ેવપરાશકતાƙ ɦારા દાખલ કરાયેલા શʣાે અથવા 
ǐ˜ાેના અાધાર પર ઇɰરનેટ પરથી સંબં̍ધત વેબસાઇટ્સ, છબીઅાે, ̍વ̋ડયા,ે ʈૂઝ અને અʈ ǐકારની 
મા̋હતી શાેધીને અાપે છે. ઉદાહરણ તરીકે, ̀ે તમે “મહાɒા ગાંધીનાે ઇ̍તહાસ” લખા,ે તાે સચƙ અેિƮજન અાપને 
તેનાે સંબં̍ધત પ̋રણામાે બતાવે છે જેવી કે લેખાે, છબીઅાે, ̍વ̋ડયાે, અને સંબં̍ધત ̏લȋ̬. 

9.1 લાેક̌ǐય શાેધ અેિƮજનાે / મા̋હતી માટે શાેધ (Popular Search Engines / 
Search for Content) 

ઈɰરનેટ પર અ̀ેડ માǋામા ંમા̋હતી ઉપલʤ છે. અાપણે ȱારે કાેઈ ̍વષય અંગ ેમા̋હતી શાેધવા ઈȞીઅ,ે 
ɔારે "શાેધ અેિƮજન" (Search Engine) અે અાપણું સાૈથી મહɗપણૂƙ સાધન બની ̀ય છે. શાેધ અેિƮજન 
અે ઇɰરનેટ પર હાજર લાખાે વેબપેજમાંથી જͅરી મા̋હતી શાેધીને અાપતું સાધન છે. અાજ ે̍વ̍વધ ǐકારના 
લાેક̌ǐય શાેધ અેિƮજનાે ઉપલʤ છે, જ ે ̏શƖણ, સમાચાર, છબીઅાે, ̍વ̋ડયાે અને અʈ કેટલાય ̍વષયાે 
પરની મા̋હતી માટે ઉપયાેગી છે. 



 

  
SARDAR PATEL INSTITUTE OF PUBLIC ADMINISTRATION, AHMEDABAD 296 

 

શાેધ અેિƮજન અે અેવું અાૅનલાઇન સાધન છે જમેાં યુઝર કાેઇપણ શʣ, ǐ˜ અથવા ̍વષય લખે છે અને અે 
અાધારે ઇɰરનેટ પરથી સબંં̍ધત વેબસાઈટ્સ, છબીઅાે, ̍વ̋ડયાે અને અʈ મા̋હતી શાેધી અાપે છે. શાેધ 
અેિƮજન અાપણા સમય અને મહેનત બચાવે છે અને કાેઈપણ ̍વષય પર મા̋હતી ઝડપથી મેળવવા મદદͅપ 
બને છે. 

લાેક̌ǐય શાેધ અેિƮજના ે

1. Google 

 દુ̏નયાનાે સાૈથી લાેક̌ǐય અને ઝડપી શાેધ અેિƮજન. 
 ̍વ̍વધ ભાષાઅાેમાં ઉપલʤ. 
 વેબસાઈટ્સ, છબીઅાે, નકશા, સમાચાર, ̍વ̋ડયાે વગેરે માટે ̍વ̏શˠ ̍વભાગા.ે 

2. Bing 

 Microsoft ɦારા બનાવાયેલ છે. 
 ͆Ƹય શાેધ (visual search) માટે ̀ણીતંુ છે. 
 સુંદર ઇɰરફેસ અને ઇમેજ સચƙ માટે લાેક̌ǐય. 

3. Yahoo 

 ઇમેઇલ અને ʈૂઝ સાથે ̀ેડાયેલું સંપૂણƙ પાેટƙલ. 
 શાેધ ઉપરાંત સમાચાર, ફાઇનાʉ અને હાેરાે˱ાેપ જવેી સેવાઅાે અાપે છે. 

4. DuckDuckGo 

 વપરાશકતાƙની ǐાઇવસી ̀ળવે છે. 
 કાેઈ પણ ˗̘Ǹગત મા̋હતી સાચવતું નથી. 
 ̀હેરાતાે અાેછા ǐમાણમાં હાેય છે. 

5. Ask.com 

 ǐ˜ાેતરી અાધા̋રત શાેધ અેિƮજન. 
 સરળ ભાષામાં જવાબ અાપવા માટે ̀ણીતંુ છે. 

6. Wolfram Alpha 

 ગ̒ણત, ગણતરી, વƗૈા̏નક અને શૈƖ̒ણક મા̋હતી માટે ̍વ̏શˠ. 
 ડેટા અાધા̋રત ચાǲેસ જવાબ અાપે છે. 

મા̋હતી કેવી રીતે શાેધવી? 

1. ǒાઉઝર (જમે કે Chrome, Firefox) ખાેલાે. 
2. તમારા પસંદગીના શાેધ અેિƮજન (જમે કે www.google.com) પર ̀અાે. 
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3. શાેધ બાȋેમાં તમા̈́ં ̍વષય લખાે (જેમ કે “ભારતનાે ઈ̍તહાસ”). 
4. Enter દબાવાે. 
5. પ̋રણામાેની યાદીમાંથી યાેƝય ̏લ̬ક પસંદ કરાે. 
6. તમા̈́ં ɪાન મળતી વેબસાઇટ્સમાંથી મા̋હતી વાંચાે અથવા નાેટ કરા.ે 

શાેધ અેિƮજનના લાભા ે

 મા̋હતી તુરંત અને સરળતાથી મળ ે
 દરેક ̍વષય માટે અલગ અલગ ǐકારના પ̋રણામાે — વેબ, ઈમેજ, ̍વ̋ડયા,ે ʈૂઝ 
 ઘણા ભાષાઅામેાં શાેધ શȂ 
 મફતમાં ઉપલʤ અને 24x7 ઉપયાેગી 
 શૈƖ̒ણક, ˗વસા̍યક અને અંગત ઉપયાેગ માટે સહાયક 

શાેધ કરતી વખતે ɪાનમાં રાખવાના મુɠા 

 માǋ ̍વ˝સનીય વેબસાઈટ્સ પરથી મા̋હતી લાે (જમે કે gov.in, wikipedia.org) 
 ̀હેરાત (Ads) અને Ǔામક મા̋હતીથી સાવચેત રહાે 
 મુɠા̋કય શʣાે (Keywords) જ વાપરાે 
 ઉપયાેગી વેબસાઈટ્સને બુકમાકƙ  કરા ે
 કɰેɰ કાેપી કરતા પહેલા તેનું સાચું ˸ાેત ના̲ધાે 

શાેધ અેિƮજન અાજ ેઇɰરનેટના દરવા̀ને ખુ˒ા કરે છે. Google, Bing, Yahoo, DuckDuckGo જવેા 
લાેક̌ǐય અેિƮજનાેની મદદથી અાપણને ઘેર બેઠાં ̍વ˝ભરની મા̋હતી મળી શકે છે. ̀ે અાપણે શાેધ કળા 
બરાબર શીખી લઈઅ,ે તાે કાેઈપણ ̍વષય અાપણાથી દૂર નથી. અાજના યુગમાં મા̋હતી મેળવવા માટે શાેધ 
અેિƮજન અેક અɔંત શ̘Ǹશાળી અને ઉપયાેગી સાધન છે. 

9.2 વેબ ǒાઉઝર અȋૅેસ કરવુ ં(Accessing Web Browser) 

અાજના ̋ડ̏જટલ યુગમાં વેબ ǒાઉઝર અે ઇɰરનેટના દરવા̀ સમાન છે. ઇɰરનેટ પર ઉપલʤ ̍વ̍વધ 
ǐકારની મા̋હતી, સેવાઅાે અને વેબસાઇટ્સ સુધી પહા̲ચવા માટે ઉપયાેગમાં લેવાતું મુȕ સાધન અેટલે વબે 
ǒાઉઝર. પરંતુ માǋ ǒાઉઝર ઇʊાેલ કરવાે પૂરતું નથી તેનાે યાેƝય રીતે અૅȋેસ અને ઉપયાેગ કરવા ે
અાવƸયક છે. અા ǐ̋ƿયામા ં કાેƳʔુ̋ટ̬ગ Ɨાનની સારી સમજ હાેવી ̀ેઈઅે, કેમ કે ǒાઉઝરનાે ǐવેશ̐બ̬દુ 
ટે̚ǽકલ પɡ̍તઅાેથી સંકળાયેલાે છે. 

વેબ ǒાઉઝર અૅȋેસ કરવાની પɡ̍ત 

1. ǒાઉઝર શ̈́ કરવું (Launching the Browser) 

વેબ ǒાઉઝર અૅȋેસ કરવા માટે સાૈથી પહેલા તમારા કƳʔુટર અથવા ́ાટƙફાેનમાં ઇʊાેલ થયેલ ǒાઉઝર 
શાેધાે. Windows માં "Start Menu" પરથી, MacOS માં "Launchpad" ɦારા અથવા Android/iOS માં 
અાઇકાેન પર ટચ કરીને તમે ǒાઉઝર ખાેલી શકાે છાે. 
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ઉદાહરણ: 

 Windows: Start > Google Chrome 
 macOS: Dock > Safari 
 Mobile: Home Screen > Chrome / Edge / Firefox 

2. અǉેેસ બારનાે ઉપયાગે (Using the Address Bar) 

ǒાઉઝર ખુˑા પછી ઉપરનું "અેǉેસ બાર" અે અેકમાǋ અવંુે ˺ાન છે ȱાં તમે સીધી વેબસાઇટ ટાઇપ કરીને 
અȋૅેસ મેળવી શકાે છાે. ઉદાહરણͅપ,ે ̀ે તમે www.wikipedia.org લખાે અને Enter દબાવાે, તાે ત ે
વેબસાઇટ તમારા માટે લાેડ થશે. 

અા અેǉેસ બાર અાજકાલ "અાે̕ʰબાȋે" તરીકે પણ અાેળખાય છે, કારણ કે તેમાં URL ઉપરાંત સીધા કીવડƙ 
સચƙ પણ કરી શકાય છે. 

3. ̋ડફાે˄  હાેમપેજ અથવા ટૅબ અૅȋેસ (Accessing Homepage or Tabs) 

અʈ ̍વકˍ તરીકે, ǒાઉઝર ખુલતાં સાથે ̀ે તમા̈́ં હાેમપેજ ગૂગલ કે કાેઈ ˾ˠ વેબસાઇટ સેટ કરેલું હાેય, 
તાે અે પૃʕ  પાેતે ખુલે છે. નવી ટૅબ ખાેલવાથી તમે બી͂ સાઇટ માટે સચƙ કે URL દાખલ કરી શકાે છાે. 

4. ǒાઉ̎ઝ̬ગ ̋હ˷ી, બુકમાકƙ  અને અેȌેƮશʉનાે ઉપયાેગ 

વેબ ǒાઉઝર માǋ સાઇટ્સ દશાƙવવા પૂરતું નથી, પણ પહેલેથી જ મુલાકાત લીધી વેબસાઇટ્સ (History), 
તમારાં પસંદગીના પે͂સ (Bookmarks) અને ફંȆન વધારતી યૂ̋ટ̏લટીઝ (Extensions) પણ અȋૅેસ કરી 
શકાય છે. અા રીતે વપરાશકતાƙ પાેતાનાં ǒાઉ̏ઝ̬ગ અનુભવાેને વધુ કાયƙƖમ બનાવી શકે છે. 

̍વ̍વધ ઉપકરણાે પર ǒાઉઝર અૅȋેસ 

ઉપકરણ અȋૅેસ પɡ̍ત 

કƳʔુટર / લૅપટાેપ Start Menu → Browser Name → Enter 

́ાટƙફાેન Home Screen → Browser App Icon 

ટેƱલેટ Touch Interface → App Drawer → Browser 

Voice Assistants (AI-based) "Open Chrome" કે "Search on Web" જેવા વાેઈસ કમાંડ ɦારા 

વેબ ǒાઉઝર અૅȋેસ કરવું અે અેક ̐ બનજͅરી વƺતુ લાગે, પણ તે માǋ અેક ̚ ȃક ન̋હ — પણ અેક ̏ નયં̍ǋત 
ǐ̋ƿયા છે, જ ેઅાપણને ઇɰરનેટની દુ̏નયામાં ǐવેશ અપાવે છે. યાેƝય રીતે ǒાઉઝર અૅȋેસ કરવાથી તમન ે
સરળતા, ઝડપ અને સુરƖા ǋણેયમાં લાભ મળે છે. વપરાશકતાƙઅે પાેતાના ઉપકરણ ǐમાણે યાેƝય રીતે ǒાઉઝર 
અȋૅેસ કરવાની રીત શીખવી ̀ેઈઅે — જથેી તેનું ઇɰરનેટનાે ઉપયાેગ વધુ અસરકારક બને. 

9.3 ફેવ̋રટ્સ ફાેˆરનાે ઉપયાેગ (Using Favourites Folder) 
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ȱારે અાપણે રાેજબરાેજ કાેઈ ખાસ વેબસાઇટ્સ પર જઈઅે છીઅે  જમે કે ̏શƖણ સંબં̍ધત પેજ, ʈૂઝ પાેટƙલ, 
ઇમેઇલ સાઇટ કે સાે̏શયલ મી̋ડયા ɔારે દર વખતઅે અે વેબસાઇટનું નામ ટાઈપ કરવું મુƸકેલ લાગે. અાવી 
̗˺̍તમાં વેબ ǒાઉઝર અાપને “Favourites Folder” જવેી સુ̍વધા અાપે છે, જેને “Bookmarks” તરીકે 
પણ અાેળખવામાં અાવે છે. અા ફાેˆરનાે ઉપયાેગ કરીને તમે તમારી પસંદગીની વેબસાઇટ્સ સાચવી શકાે છા ે
અને જͅર પȻે અેક ̚ȃકમાં અૅȋેસ મેળવી શકાે છાે. 

ફેવ̋રટ્સ ફાેˆર શું છે? 

Favourites Folder અે ǒાઉઝરમાં રહેલી અેવી સુ̍વધા છે, જમેાં વપરાશકતાƙ પાેતાની પસંદગીની 
વેબસાઇટ્સને સાચવી શકે છે. તેને “Bookmarks Folder” પણ કહેવામાં અાવે છે. ફેવ̋રટ્સમાં સાચવેલી 
વેબસાઈટ્સને જͅર પડે ɔારે તુરંત ખાેલી શકાય છે — અે પણ ફરીથી અેǉેસ લȕા ̍વના. 

ફેવ̋રટ્સ ફાેˆરનાે ઉપયાેગ કેવી રીતે કરવાે? 

 චඡ Google Chrome માં: 

1. જ ેવેબસાઇટ તમે સાચવવી હાેય તે ખાેલાે 
2. અǉેેસ બારના ધાેરણ ઉપર બનેલા તારાે (★) ̎ચ̆ પર ̚ȃક કરા ે
3. “Bookmark added” બાેȋ અાવશ ે
4. ɔાંથી “Folder” પસંદ કરાે – જમે કે Favourites 
5. “Done” ̚ȃક કરા ે

 චඡ Mozilla Firefox, Microsoft Edge, Safari વગેરેમાં પણ ǐ̋ƿયા લગભગ સમાન છે. 

ફેવ̋રટ્સ ફાેˆરના લાભાે 

લાભ વણƙન 

ઝડપથી અȋૅેસ મહɗની વેબસાઇટ્સ અેક ̚ȃકમાં ખુલશે 

સમય બચાવ વારંવાર URL ટાઈપ કરવાની જͅર નહ̯ પડે 

શૈƖ̒ણક ઉપયાેગ ̍વɥાથ̰અાે માટે મહɗપણૂƙ ̏લ̬ક સાચવી શકાય 

˗વ̗˺ત મેનેજમેɰ ફાેˆર બનાવી વેબસાઈટ્સ કેટેગરી મુજબ ગાેઠવી શકાય 

અાૅફલાઈન ઉપયાેગ માટે પણ કેટલાક ǒાઉઝસƙમાં ફેવ̋રટ પેજ કેશમાં ˶ાેર થાય છે 

 

ફેવ̋રટ્સ ફાેˆર માટેના ̍વકˍા ે

 Edit / Rename: Bookmark નામ બદલી શકાય 
 Create Folders: ̍વષય ǐમાણે ફાેˆર બનાવી શકાય (જમે કે Study, News, Work) 
 Move Bookmarks: જુદી-જુદી જƝયા પર ખસેડી શકાય 
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 Delete: જͅર ન હાેય ɔારે Bookmark દૂર કરી શકાય 

ઉદાહરણ: ̍વɥાથ̰ www.baou.edu.in વેબસાઈટને Education ફાેˆરમાં Bookmark કરી શકે છે. 
કાેઈ રાેજ ʈૂઝ વાંચનાર www.divyabhaskar.co.in ને News ફાેˆરમાં સાચવી શકે છે. 

Favourites Folder અે ǒાઉઝરનું અેક અɔતં ઉપયાેગી સાધન છે, જ ેવપરાશકતાƙને સમય બચાવવાે, યાેƝય 
વેબસાઇટ તરત ખાેલવી અને મા̋હતી ˗વ̗˺ત રીતે ̀ળવવામાં મદદ કરે છે. શૈƖ̒ણક, ˗ાવસા̍યક કે 
અંગત ͂વનમાં પણ ફેવ̋રટ્સ ફાેˆરનાે યાેƝય ઉપયાેગ Productivity વધારવામાં મદદͅપ બને છે. દરેક 
ઇɰરનેટ વપરાશકતાƙઅે તેને કેવી રીતે કાયƙƖમ રીતે વાપરવાે તેની સમજ હાેવી ̀ેઈઅે. 

9.4 વેબ પેજમાંથી ડાઉનલાેડ કરવું (Downloading from Web Pages) 

ઇɰરનેટનાે મુȕ લાભ અે છે કે અાપણે ઘર બેઠાં કાઈેપણ ǐકારની મા̋હતી, ફાઈલ, ફાેટાે, ̍વ̋ડયાે કે 
સાેʘવેરને ડાઉનલાેડ કરી શકીઅે છીઅે. ȱારે અાપણે કાેઈ વેબસાઇટ પરથી ડાેȂુમɰે, પીડીઅેફ, ઈમેજ, 
સાેʘવેર કે મ˄ી̌મડીયા ફાઈલ ડાઉનલાેડ કરીઅે છીઅે, ɔારે તે ǐ̋ƿયાને “Downloading from Web 
Pages” કહેવામાં અાવે છે. ̍વɥાથ̰અાે, ̏શƖકા,ે અને સામાʈ વપરાશકતાƙઅાે માટે અા બહુજ ઉપયાેગી 
કામગીરી છે. 

ડાઉનલાેડ શંુ છે? 

ડાઉનલાેડ અેટલે ઇɰરનેટ પર ઉપલʤ ફાઈલને તમારા કƳʔુટર, લૅપટાેપ અથવા માેબાઇલમાં સાચવવી. 
અા ǐ̋ƿયામાં ફાઈલ સવƙર પરથી યુઝર તરફ અાવે છે. અટેલે કે ઇɰરનેટ પરથી મા̋હતી અાપણાં ઉપકરણમા ં 
લેવાઈ રહી છે. 

વેબ પેજમાંથી કેવી રીતે ડાઉનલાેડ કરવું? 

1. ફાઈલ ̏લ̬ક શાેધાે 

 વેબસાઇટ પર "Download", "Click Here to Download", "Save" જવેી ̏લ̬ક કે બટન હાેય છે. 
 કેટલાક પેજમાં સીધાે ફાઈલ નામ પણ ̏લ̬ક તરીકે હાેય છે (જમે કે file.pdf). 

2. ̏લ̬ક પર ̚ȃક કરા ે

 ̏લ̬ક પર ̚ȃક કરતાંજ ફાઈલ ડાઉનલાેડ થવા લાગે છે 
 અથવા “Save As” ̍વકˍ સાથે ̍વ̬ડાે ખુલશે 

3. ફાઈલ ˺ાન પસંદ કરાે 

 ȱાં ફાઈલ સાચવવી હાેય (Desktop, Downloads Folder વગેરે) તે ˺ાન પસંદ કરા ે
 પછી “Save” બટન ̚ȃક કરા ે

4. ડાઉનલાેડ પર ɪાન રાખાે 

 ǒાઉઝર નીચે કે ઉપરના ખૂણે ડાઉનલાેડની ǐગ̍ત બતાવે છે 
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 ડાઉનલાેડ પૂરી થાય પછી તે ફાઈલ ખાેલી શકાે છાે 

સામાʈ ડાઉનલાેડ ǐકારા ે

ǐકાર ઉદાહરણ 

દƺતાવેજ (Documents) PDF, DOCX, PPT 

છબીઅાે (Images) JPG, PNG 

સંગીત / અાૅ̋ડયાે MP3, WAV 

̍વ̋ડયા ે MP4, AVI 

સાેʘવેર / અેપ EXE, APK, ZIP 

ડાઉનલાેડ કરતી વખતે સલામતી 

 માǋ ̍વ˝સનીય વેબસાઈટ પરથી જ ડાઉનલાેડ કરાે 
 .EXE અથવા .ZIP ફાઈલ ખુલતી પહેલાં Antivirus ˱ેન કરા ે
 અ̀ણી સાઇટ્સના પાેપઅપ કે ફેક ડાઉનલાેડ બટનથી બચાે 
 ફાઈલનું કદ (size) અને ǐકાર તપાસાે 

ડાઉનલાેડ ̏લ˶ (History) કેવી રીતે જુઅા?ે 

 ǒાઉઝરમાં “Ctrl + J” દબાવા ે
 ડાઉનલાેડ થયેલ તમામ ફાઈલાેની યાદી ̀ેવા મળશે 
 ɔાંથી ફાઈલ “Open”, “Show in folder” કે “Remove” કરી શકાય છે 

ઉદાહરણ 

̍વɥાથ̰ “www.baou.edu.in” પરથી અʬાસસામǁી PDF તરીકે ડાઉનલાેડ કરે છે. 
̏શƖક "slideshare.net" પરથી PowerPoint ǐેઝɰેશન ડાઉનલાેડ કરે છે. 

Downloading from Web Pages અે ઇɰરનેટના ઉપયાેગમાં અેક અગɔની અને દૈ̏નક કામગીરી છે. 
કાેઈ મા̋હતી કે ફાઈલને લાેકલ ઉપકરણમાં સાચવી રાખવી હાેય ɔારે ડાઉનલાેડ કરવું સરળ અને અસરકારક 
રીત છે. ̀ે ઉપયાેગકતાƙ ડાઉનલાેડ કરતી વખતે યાેƝય પગલાં લે અને સુરƖા ̀ળવે, તાે તે ઇɰરનેટમાંથી 
યાેƝય રીતે મા̋હતી મેળવી શકે છે. 

9.5 બુકમાȋƙ ઉમેરવા (Add Bookmarks) 

ȱારે અાપણે કાેઈ મહɗપૂણƙ વેબસાઇટ ફરીથી ̀ેવા ઇȞીઅે છીઅ,ે ɔારે દર વખતે તેનું અેǉેસ (URL) યાદ 
રાખવું અથવા ફરીથી ટાઇપ કરવંુ મુƸકેલ હાેય શકે છે. અાવી ̗˺̍તમા ંBookmark સુ̍ વધા બહુ ઉપયાેગી 
સા̐બત થાય છે. Bookmark અેટલે કાેઈ પણ વેબપેજને અાપણા ǒાઉઝરમાં સાચવી રાખવું, જથેી ભ̍વˮમાં 
તેને સીધંુ અેક ̚ȃક ɦારા ફરીથી અȋૅેસ કરી શકાય. 



 

  
SARDAR PATEL INSTITUTE OF PUBLIC ADMINISTRATION, AHMEDABAD 302 

 

બુકમાકƙ  શું છે? 

Bookmark અે વેબ ǒાઉઝરમાં રહેલી સુ̍વધા છે, જ ેwebpages ને ના̲ધીને અથવા "ફેવ̋રટ" તરીકે સાચવી 
લે છે. Bookmark થયેલી સાઇટ્સ તમારા ǒાઉઝરમાં સǁં̋હત રહે છે અને તમને તરત જ ફરીથી અȋૅેસ 
કરવાની સુ̍વધા અાપે છે અે પણ અેǉેસ ફરીથી લȕા ̍વના. 

બુકમાકƙ  કેવી રીતે ઉમેરવું? 

Google Chrome માં: 

1. જ ેવેબસાઈટ Bookmark કરવી હાેય તે ખાેલાે. 
2. Address Bar માં જમણે Taru (★) ̎ચ̆ પર ̚ȃક કરાે. 
3. “Add bookmark” બાȋે ખુલે. 
4. તેમાં નામ લખાે અને Folder પસંદ કરાે. 
5. “Done” ̚ȃક કરાે. 

Mozilla Firefox, Microsoft Edge, Safari વગરેેમાં પણ અાવી જ રીત હાેય છે. 

બુકમાકƙ  ફાે̂ ર બનાવવી 

 તમે અલગ-અલગ ̍વષય માટે અલગ ફાેˆર બનાવી શકાે છાે: 
ઉદાહરણ: Study, News, University, Entertainment 

 ȱારે Bookmark કરાે ɔારે “Choose Folder” ̍વકˍ પસંદ કરીને નવી ફાેˆર બનાવી શકાય છે. 

Bookmark Manager શું છે? 

Bookmark Manager અ ેǒાઉઝરનું અેક ̍વɱાે છે જમેાં તમે તમારી બધી બુકમાȋƙ ̀ેઈ શકાે છાે, તેમન ે
ગાેઠવી શકાે છા,ે ફેરફાર કરી શકાે છાે, કે ̋ડલીટ પણ કરી શકાે છાે. 

Chrome માં Bookmark Manager ખાેલવા માટે: Menu (噣) → Bookmarks → Bookmark 
Manager 

9.6 વેબ પેજની છાપ કાઢવી (Printing Web Pages) 

કેટલાક સમયે ઇɰરનેટ પર મળતી મા̋હતી, લેખ, રેસીપી, ̋ટ̋કટ, ફાેમƙ અથવા શૈƖ̒ણક નાેટ્સને કાગળ પર 
છાપવી (Print) જͅરી બની ̀ય છે. અાવી ̗˺̍તમાં વેબ ǒાઉઝર અેક સહજ રીતે છાપવાની સુ̍વધા અાપ ે
છે. વબે પેજની છાપ કાઢવી અેટલે ˲ીન પર દેખાતા પજેને ̌ǐɰર ɦારા કાગળ પર ઉતારવાે. દરેક વેબ 
ǒાઉઝરમાં અા સુ̍વધા ઉપલʤ હાેય છે. 

̌ǐɰ̯ગની જ̋ͅરયાતના ઉદાહરણ 

 અાેનલાઇન ̋ટ̋કટ અથવા રસીદની કાેપી લેવા માટે 
 શૈƖ̒ણક લેખાે કે અʬાસ નાેટ્સ ˶ડી માટે 
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 ફાેમƙ અથવા ના̲ધાે ભરીને સબ̌મટ કરવા માટે 
 રેસીપી, મા̋હતી લેખ અથવા ʈૂઝના રેકાેડƙ માટે 

વેબ પેજની છાપ કેવી રીતે કાઢવી? 

પɡ̍ત 1: કીબાેડƙ શાેટƙકટ ɦારા 

1. ̌ǐɰ કરવા માંગતા હાે તે વેબ પેજ પર ̀અા ે
2. કીબાેડƙ પરથી Ctrl + P દબાવાે 
3. “Print” ̍વɱાે ખુલશે 
4. ̌ǐɰર, પેજ રેƮજ, કાેપી સȕંા વગેરે પસંદ કરાે 
5. “Print” બટન ̚ȃક કરાે 

પɡ̍ત 2: ǒાઉઝર મેનુ ɦારા 

1. ǒાઉઝરમાં ઉપર જમણે “噣” (મેનુ) પર ̚ȃક કરાે 
2. “Print” ̍વકˍ પસંદ કરા ે
3. અાગળની જ રીતે Print settings પસંદ કરીને છાપાે 

̌ǐɰ કરતી વખતે ɪાનમાં રાખવાના મુɠા 

 તમારી ̌ǐɰર યાેƝય રીતે કƳʔુટરમાં ̀ેડાયેલ હાેય 
 પેજ Preview ̀ેઈ લાે — કેટલી પે̀ ે છપાશ ે
 જͅર હાેય તાે માǋ ચાǲેસ પેજ (Page Range) પસંદ કરાે 
 રંગીન કે કાળાંસફેદ છાપ માટે ̍વકˍ પસંદ કરાે 
 Margin, Header/Footer અને Layout (Portrait / Landscape) પસંદ કરાે 

Save as PDF ̍વકˍ 

̀ે તમારે કાગળ પર છાપવી ન હાેય, પણ ફાઈલ ̄ͅપે સાચવી રાખવી હાેય તાે “Save as PDF” ̍વકˍ 
પસંદ કરી શકાે છાે. તે વેબ પેજને PDF ફાઈલ તરીકે તમારા કƳʔુટરમાં સાચવી દે છે, જ ેપછીથી પણ છાપી 
શકાય છે. 

ઉદાહરણ 

 ̍વɥાથ̰ BAOU ની વેબસાઇટ પરથી પૃȞાપǋની PDF ફાેમ̳ટમાં છાપ કાઢે છે 
 અાેનલાઈન ̐બલ અથવા ʈૂઝ લેખ ̌ǐɰ કરી સાચવવામાં અાવે છે 

છાપી શકાય અેવી વƺતુઅા ે

ǐકાર ઉદાહરણ 

દƺતાવે̀ ે અાેનલાઇન ફામેƙ, લેખા,ે નાેટ્સ 
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̋ટ̋કટ રેલવે / ưલાઇટ / ̐સનેમા ̋ટ̋કટ 

ʈૂઝ સમાચાર લેખાે અથવા ઈ-પેપર 

અʬાસસામǁી પીડીઅેફ નાેટ્સ, ̐સલેબસ, ǐ˜પǋા ે

 

વેબ પેજની છાપ કાઢવી અે અેક સરળ, પણ ઉપયાેગી ǐ̋ƿયા છે. અે ̍વɥાથ̰અા,ે ˗વસા̍યકાે અને સામાʈ 
વપરાશકતાƙઅાે માટે સમય બચાવનારી અને મા̋હ̍ત ̀ળવી રાખવાની સાૈથી સારી રીત છે. વેબ ǒાઉઝરમાં 
થતી ̌ǐ̔ɰ̬ગ સુ̍વધાનાે યાેƝય ઉપયાેગ કરીને ઈɰરનેટ પરની મા̋હતીને કાગળ પર પણ સરળતાથી મેળવવી 
શȂ બને છે. 

10. ઇɰરનેટ પરથી મા̋હતી અપલાેડ અને ડાઉનલાેડ કરવા માટે FTP નાે ઉપયાેગ 

ȱારે અાપણે ઇɰરનેટ ɦારા માેટા ǐમાણમાં ફાઈલાે માેકલવા કે મેળવવા માંગીઅે, ɔારે તે માટે ખાસ 
ટે̚ǽકનાે ઉપયાેગ કરવાે પડે છે. અાવી અેક ટેǽાેલાે͂ છે FTP, અેટલે કે File Transfer Protocol. FTP 
અે અેવું ǐાેટાેકાેલ છે જ ેઇɰરનેટના માɪમથી કƳʔુટરાે વȝે ફાઈલાે અપલાેડ અને ડાઉનલાેડ કરવાની 
ǐ̋ƿયાને સરળ અને સુર̐Ɩત બનાવે છે. માેટા ǐમાણમાં ડેટા Ǉાʉફર માટે અાજ ેપણ ઘણી વેબસાઈટાે અને 
સવƙરાે FTPનાે ઉપયાેગ કરે છે. 

FTP શું છે? 

FTP (File Transfer Protocol) અે ઇɰરનેટ પર ફાઈલ માેકલવા અને મેળવવા માટેનાે ̏નયમાેનાે સમૂહ છે. 
તે બે કƳʔુટરાે (અેક ȃાયɰ અને અેક સવƙર) વȝે ફાઈલ Ǉાʉફર કરવાની સુ̍ વધા અાપે છે. 
FTPનાે ઉપયાેગ ખાસ કરીને વેબસાઈટ ડેવલપમેɰ, સાʘેવેર અપલાેડ, ડેટાબેસ બેકઅપ અને માેટી ફાઈલાે 
વહ̲ચવા માટે થાય છે. 

FTP કેવી રીતે કાયƙ કરે છે? 

FTP કનȆેન માટે બે પાટ̰અાે હાેય છે: 

1. FTP Server – જ ેફાઈલાે સાચવે છે અને સેવા અાપે છે 

2. FTP Client – જ ેફાઈલ અપલાેડ કે ડાઉનલાેડ કરવા માટે સવƙર સાથે ̀ેડાય છે 

ȱારે વપરાશકતાƙ (client) સવƙર પર લાૅ̎ગન કરે છે, ɔારે તે ફાઈલસ યાદી ̀ેઈ શકે છે અને જͅરી ફાઈ˔ 
અપલાેડ કે ડાઉનલાેડ કરી શકે છે. 

FTPનાે ઉપયાેગ કેવી રીતે કરવાે? 

FTP નાે ઉપયાેગ માટે ખાસ software અથવા ǒાઉઝર પણ વાપરી શકાય છે: 

FTP Client Software (ઉદાહરણ: FileZilla) 
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1. FileZilla જવેા software ઇʊાેલ કરાે 
2. Hostname, username, password અને port દાખલ કરાે 
3. “Connect” બટન ̚ȃક કરાે 
4. કƳʔુટરના પેનલમાંથી ફાઈલ પસંદ કરાે અને સવƙર પર અપલાેડ કરાે 
5. સવƙરમાંથી ફાઈલ પસંદ કરીને ડાઉનલાેડ પણ કરી શકાે છાે 

FTP ના ઉપયાેગાે 

ઉપયાેગ ઉદાહરણ 

 વેબસાઈટ અપલાેડ વેબસવƙર પર HTML/CSS ફાઈ˔ અપલાેડ કરવી 

ડેટા ડાઉનલાેડ માેટાં સાેʘવેર અથવા બેકઅપ ફાઈ˔ ડાઉનલાેડ કરવી 

બેકઅપ ડેટાબેસ કે લાેજ ફાઈલાેનંુ ̏નય̌મત બેકઅપ લેવું 

ફાઈલ શે̋રગ̬ દીઠ ફાઈલ પાટƙનરાે સાથે વહ̲ચવી (private server મારફતે) 

 

FTPના લાભાે 

 માેટી ફાઈલાે Ǉાʉફર માટે યાેƝય 
 ઝડપથી ફાઈલ અપલાેડ / ડાઉનલાેડ થાય 
 automated backup માટે ઉપયાેગી 
 GUI ȃાયɰ ɦારા ઉપયાેગ સહેલાે 

FTPની મયાƙદાઅાે 

 ǐમાણભૂત FTP કનȆેન અેિƮƿʍેડ નથી 
 login credentials ̀ે સુર̐Ɩત ન હાેય તાે હે̋ક̬ગ શȂ 
 સાદા ǒાઉઝરથી પુણƙ ફંȆન̏લટી મળતી નથી 
 માેટા ǐમાણમાં ડેટા માટે બૅɱ̍વડ્થ પર અસર 

સુર̐Ɩત FTP (SFTP) 

FTPનાે વધુ સુર̐Ɩત ̍વકˍ છે SFTP (Secure FTP) તેમાં ડેટા અને લાૅ̎ગન બંને અેિƮƿʍ થયેલા હાેય છે, 
જથેી હે̋ક̬ગનાે ભય અાેછાે થાય છે. 

FTP અે ઇɰરનેટ પર ડેટા અપલાેડ અને ડાઉનલાેડ કરવાની અેક શ̘Ǹશાળી અન ે̍વ˝સનીય પɡ̍ત છે. 
ખાસ કરીને વેબ ડેવલપસƙ અને અેડ̌મ̏ન˷ેટર માટે તે જͅરી સાધન છે. ̀ે યાેƝય રીતે ઉપયાેગ કરવામાં અાવે, 
તાે FTP ̐બનરાેકટાેક ડેટા Ǉાʉફર માટે ખૂબ જ ઉપયાેગી બની શકે છે. સુરƖા ̀ેવી હાયે તાે SFTP પસંદ કરવુ ં
વધુ યાƝેય છે. 
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11. ફાયરવાેલ અને વȢુƙઅલ ǐાઇવેટ નેટવકƙ  (VPN) ના ̍વ̍વધ ǐકારાેની સમજ   

અાજના ̋ડ̏જટલ યુગમાં ȱારે ઇɰરનેટનાે ˗ાપ ઘણી વખત ˗̘Ǹગત અને ગʏુ મા̋હતી સુધી પહાેચી ગયાે 
છે, ɔારે અાપણા કƳʔુટર અને નેટવકƙને સુર̐Ɩત રાખવું ખૂબ જ જͅરી છે. અે માટે અમુક ટે̚ǽકલ 
સાેˑુશʉ જવેી કે ફાયરવાેલ (Firewall) અને VPN (Virtual Private Network) ખૂબ ઉપયાેગી છે. 
અા બંને ટેǽાેલાે͂ ઇɰરનેટ પર સુર̐Ɩત અને ખાનગી રીતે કામ કરવા માટે મદદͅપ બને છે. 

ફાયરવાેલ શું છે? 

ફાયરવાેલ અે કƳʔુટર નેટવકƙને સુર̐Ɩત રાખતી અેક ̋ડ̏જટલ દીવાલ જવેું સાધન છે. 
તે નેટવકƙમાં ǐવેશતી અને નીકળતી તમામ ડેટા Ǉા̋ફક પર નજર રાખે છે અને અયાેƝય ǐવેશ અથવા હે̋ક̬ગથી 
ઉપકરણને બચાવે છે. ફાયરવાેલ Software અને Hardware – બંને ̄ͅપમાં હાેઈ શકે છે. 

ફાયરવાેલના મુȕ કાયા̳: 

 અન̍ધકૃત અેȋેસને અવરાેધે છે 
 હે̋ક̬ગ, વાયરસ અને મેલવેરથી બચાવે છે 
 નેટવકƙ  Ǉા̋ફક ̋ફ˄ર કરે છે 
 વપરાશકતાƙની ની̍ત ǐમાણે ǐવેશની પરવાનગી અાપે છે 

ફાયરવાેલના ǐકારા:ે 

ǐકાર વણƙન 

Software Firewall કƳʔુટરમાં ઇʊાેલ થતું સાʘેવેર (જેમ કે Windows Firewall) 

Hardware Firewall નેટવકƙ  રાઉટરમાં લાગેલું ડે̋ડકેટેડ સાધન 

Network Firewall સમǁ નેટવકƙ  ƺતરે કામ કરે છે 

Proxy Firewall ડેટા સવƙર સુધી પહા̲ચે અે પહેલાં ચકાસે છે 

 

વȢુƙઅલ ǐાઇવટે નેટવકƙ  (VPN) શું છે? 

VPN (Virtual Private Network) અે અેવી ટે̚ǽક છે જ ે વપરાશકતાƙને ઇɰરનેટનાે સુર̐Ɩત અને 
ખાનગી માગƙ (Private Tunnel) અાપી શકે છે. તે વપરાશકતાƙના ડેટાને અેન̋ƿʍ કરીને ઇɰરનેટ પર માેકલે 
છે જથેી બા̈ ˗̘Ǹ તેને ̀ઈે કે ચાેરી ના શકે. 

VPN ના મȕુ લાભાે: 

 તમા̈́ં IP અǉેેસ છુપાવે છે 
 ̀હેર Wi-Fi પર સુરƖા અાપે છે 
 ભાૈગાે̏લક ǐ̍તબંધાે તાેડવા માટે ઉપયાેગી 
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 અાૅનલાઈન અાેળખ (identity) ગુʏ રાખે છે 

VPN ના મȕુ ǐકારા ે

ǐકાર વણƙન 

Remote Access VPN ˗̘Ǹગત યુઝરાે માટે, અાે̋ફસ નેટવકƙથી ઘરેથી કનેǶ થવા માટે 

Site-to-Site VPN બે અલગ-અલગ અાે̋ફસ નેટવકƙ  વȝે કનેȆન માટે 

Client-Based VPN ˗̘Ǹગત ઉપકરણમાં VPN સાેʘવેર ɦારા કનǶે થવું 

Cloud VPN (Hosted VPN) ȃાઉડ સ̍વ̭સ મારફતે અાપવામાં અાવતી સુર̐Ɩત કનȆેન સુ̍વધા 

 

ફાયરવાેલ અને VPN વȝેનાે તફાવત 

તફાવત Firewall VPN 

હેતુ નેટવકƙને સુર̐Ɩત રાખવા ે નેટવકƙ  કનેȆનને ગʏુ રાખવું 

ǐકાર Software / Hardware Mostly Software 

વપરાશ ઉકેલાે માટે ̏નયમાે બનાવે છે તમામ ડેટાને અેન̋ƿʍ કરે છે 

ઉદાહરણ Windows Firewall NordVPN, ExpressVPN, ProtonVPN 

 

ઉદાહરણ 

 ̍વɥાથ̰ ̀હેર Wi-Fi પર VPN નાે ઉપયાેગ કરીને પાેતાની મા̋હતી સુર̐Ɩત રાખે છે 
 અાે̋ફસમાં ફાયરવાેલ કે જ firewall rules સેટ કરવામાં અાવે છે જથેી માǋ ̏ નધાƙ̋રત યુઝસƙને જ અૅȋેસ 

મળ ે

ઇɰરનેટ પર સુર̐Ɩત રહેવા માટે ફાયરવાેલ અને VPN બંને અ̏નવાયƙ સાધનાે છે. ફાયરવાેલ નેટવકƙમાં ǐવશે 
̏નયં̍ǋત કરે છે, ȱારે VPN ડેટાને ગુʏ અને સુર̐Ɩત રાખે છે. બંનેની યાેƝય સમજ અને ઉપયાેગ ˗̘Ǹગત 
તથા ˗વસા̍યક ƺતરે ઇɰરનેટનાે સુર̐Ɩત અને યાેƝય ઉપયાેગ સુ̏ન̏˛ત કરે છે. 

12. DNS અને Uniform Resource Locators. 

ȱારે અાપણે કાેઈ વેબસાઇટ ખુ˒ી કરીઅે છીઅ,ે ɔારે તે પાછળ ઘણા તક̏નકી ǐ̋ƿયાઅાે કાયƙરત હાેય છે. 
જમેાંથી બે ખૂબ જ મહɗપણૂƙ તɗાે છે DNS (Domain Name System) અને URL (Uniform Resource 
Locator). DNS અે અેવી ̐સ˶મ છે જે વેબસાઇટના નામને IP અǉેેસમાં ફેરવે છે, ȱારે URL અે કાેઈ 
ચાેǲસ વેબ પેજ અથવા અાૅનલાઇન સંસાધનનું સરનામું હાેય છે. અા બંનેને સમજવી અાપણા માટે જͅરી 
છે, કારણ કે તેઅાે WWW (World Wide Web) સાથે ̀ેડાવાનાે અાધાર ƺતંભ છે. 
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DNS અેટલે શું? 

DNS (Domain Name System) અે ઇɰરનેટની અેક "ફાેનબુક" જવંુે કાયƙ કરે છે. 
તમે ȱારે તમારા ǒાઉઝરમા ંwww.google.com લખાે છાે, ɔારે DNS અે અા નામને તેના સબંં̍ધત IP 
અǉેેસ (જમે કે 142.250.195.68)માં ͅપાંતર કરે છે, જથેી ǒાઉઝર યાેƝય સવƙર સાથે કનǶે થઈ શકે. 

DNS કેવી રીતે કાયƙ કરે છે? 

1. વપરાશકતાƙ ǒાઉઝરમાં ડાેમને નામ લખે છે 
2. ǒાઉઝર DNS સવƙરને ̍વનંતી માેકલે છે 
3. DNS સવƙર તે ડાેમેનને સંબં̍ધત IP અǉેેસ અાપે છે 
4. ǒાઉઝર અે IP અેǉેસના અાધારે સવƙર સુધી પહા̲ચે છે 
5. સવƙર પાસેથી વેબપેજ દેખાડે છે 

DNS ના ફાયદા: 

 વપરાશકતાƙને IP અેǉેસ યાદ રાખવાની જͅર નથી 
 ઝડપથી ડાેમેન-ટૂ-IP ͅપાંતર થાય 
 ઇɰરનેટને ˗વ̗˺ત રીતે ચલાવવા માટે મહɗપણૂƙ 

URL અેટલે શુ?ં 

URL (Uniform Resource Locator) અે કાેઈ ચાેǲસ વેબપજે અથવા અાૅનલાઇન સસંાધનનું અનʈ 
સરનામું હાેય છે. અટેલે કે URL અે વપરાશકતાƙને ઈɰરનેટ પર કાેઈ ચાેǲસ ˺ાને પહા̲ચાડે છે. 

URL નંુ બંધારણ: https://www.example.com/page.html અહ̯, 

ભાગ અથƙ 

https:// ǐાેટાેકાેલ – HTTP અથવા HTTPS 

www.example.com ડાેમેન નામ 

/page.html ચાેǲસ ફાઈલ અથવા પાથ 

URL ના ǐકારા:ે 

 Static URL → ̗˺ર પૃʕ , જમે કે about.html 
 Dynamic URL → ડેટાબેસ અાધા̋રત, જમે કે product.php?id=101 

DNS અને URL વȝે તફાવત 

તફાવત DNS URL 

અથƙ નામને IP અેǉેસમાં ફેરવ ેછે વેબસાઈટનું સંપૂણƙ સરનામું અાપે છે 
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કાયƙ સવƙર શાેધે છે ચાેǲસ ફાઈલ અથવા પૃˤ શાેધે છે 

ઉદાહરણ google.com → 142.250.195.68 https://www.google.com/search 

 

ઉદાહરણ: દા. ત. ̀ે ̍વɥાથ̰અે ǒાઉઝરમાં લȕું: https://www.baou.edu.in/syllabus.html તા ે 
ǒાઉઝર DNS ɦારા baou.edu.in નાે IP અેǉેસ શાેધે છે ɔારબાદ તે URL પર રહેલી “syllabus.html” ફાઈલ 
સવƙર પરથી લાવી બતાવે છે 

DNS અને URL બંને ઈɰરનેટની મૂળભૂત રચનાના ભાગ છે. DNS હમણાંના નામ-અાધા̋રત વેબસાઇટાેને 
IP અેǉેસમાં ફેરવીને શાેધવામાં સહાય કરે છે, ȱારે URL અે કાેઈ ખાસ વેબપેજનું ચાેǲસ સરનામું છે. DNS 
̍વના ǒાઉઝર સવƙર સુધી પહા̲ચી શકતંુ નથી અને URL ̍વના અાપણે ચાǲેસ સંસાધન સુધી પહા̲ચી શકતા 
નથી. બંનેની સમજૂતી ઇɰરનેટના યાેƝય અને અસરકારક ઉપયાેગ માટે અɔંત જͅરી છે. 

13. સારાંશ (Summary) 

અા ǐકરણમાં અાપણે ઇɰરનેટ અને વેબ ǒાઉઝર સંબં̍ધત ̍વ̍વધ મહɗપણૂƙ ̍વષયાે ̍વશે શીȕા.ં 
ઈɰરનેટ શું છે, નેટવકƙના ǐકારાે જવેા કે LAN અને WAN કેવી રીતે કાયƙ કરે છે અને ઇɰરનેટ કેવી રીતે 
અȋૅેસ કરવામાં અાવે છે તેની સમજ મેળવી. ̍વ̍વધ ઇɰરનેટ સેવાઅાે જમે કે ઈમેઇલ, વેબ ǒાઉ̏ઝ̬ગ, 
મેસે̏ જ̬ગ, ઈ-લ̏ન̮ગ, ઈ-કાેમસƙ, ઈ-બ̲̋ ક̬ગ વગેરે પણ સમજવામાં અા˗ા. 

અા ǐકરણમાં અાપણે વેબ ǒાઉઝરના ેઉપયાેગ, બુકમાકƙ  ઉમેરવા, ફેવ̋રટ્સ ફાેˆર, વેબ પેજમાંથી મા̋હતી 
ડાઉનલાેડ કરવી અને ̌ǐɰ કાઢવાની રીત શીȕા. સાથે જ શાેધ અેિƮજનનાે ઉપયાેગ કરીને મા̋હતી કેવી રીત ે
શાેધવી તે સમȱા તથા FTP (ફાઈલ Ǉાʉફર ǐાેટાેકાેલ) અને VPN (વȢુƙઅલ ǐાઈવેટ નેટવકƙ ) જવેી તક̏નકી 
સેવાઅાે, ફાયરવાેલ, DNS (ડાેમેન નેમ ̐ સ˶મ) અને URL (યુ̏ નક ̋ રસાેસƙ લાેકેટર) જવેા માળખાઅાે ̍વશે પણ 
મા̋હતી મળી. વેબ ǒાઉઝરનુ ંક̔ʃƝયુરેશન (configuration) અને તેનંુ યાેƝય ઉપયાેગ પણ સમȱા. 

અા સમǁ ǐકરણ ɦારા ̍વɥાથ̰અાે ઇɰરનેટના મૂળભતૂ તɗા,ે ઉપયાેગની રીતાે અને તેની સુરƖા અંગ ે
̀ણકારી મેળવે છે, જથેી તઅેાે ઇɰરનેટનાે સમજદારીપૂવƙક અને યાેƝય રીતે ઉપયાેગ કરી શકે. 

14. નમુનાͅપ ǐ˜ાે અને જવાબાે (Model Questions and Answers) 

1. WWW નાે પૂણƙ ̄ͅપ શંુ છે? 
a) World Web Wide 
b) Web World Wide 
c) World Wide Web 
d) Wide World Web 
 Answer: c) World Wide Web 

2. ઇɰરનેટમાં ઉપયાેગ થતાે ǐાટેાેકાેલ કયાે છે? 
a) FTP 
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b) HTTP 
c) TCP/IP 
d) બધાં 
 Answer: d) બધાં 

3. કયું ǒાઉઝર સાૈથી વધુ વપરાય છે? 
a) Internet Explorer 
b) Firefox 
c) Safari 
d) Google Chrome 
 Answer: d) Google Chrome 

4. DNS નાે મુȕ હેતુ શંુ છે? 
a) વબેસાઇટ બનાવવા ે
b) ડેટા ˶ાેર કરવા ે
c) ડાેમેનને IP અેǉેસમાં ફેરવવાે 
d) ઈમેઇલ માેકલવાે 
 Answer: c) ડાેમેનને IP અǉેેસમાં ફેરવવાે 

5. URL નાે પૂ̈́ ં  ̄ͅપ શું છે? 
a) Unique Resource List 
b) Uniform Resource Locator 
c) Unified Reference Link 
d) User Reference Location 
 Answer: b) Uniform Resource Locator 

6. FTP નાે ઉપયાેગ શું માટે થાય છે? 
a) ચેટ કરવા માટે 
b) ઈમેઇલ માેકલવા માટે 
c) ફાઈલાે અપલાેડ/ડાઉનલાેડ કરવા માટે 
d) વેબસાઈટ ̀ેવા માટે 
 Answer: c) ફાઈલાે અપલાેડ/ડાઉનલાેડ કરવા માટે 

7. વાઈ-ફાઈ કઈ ǐકારની કને̖Ƕ̍વટી અાપે છે? 
a) વાયર 
b) વાયરલેસ 
c) મેʈુઅલ 
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d) અાેફલાઇન 
 Answer: b) વાયરલેસ 

8. Bookmark નાે ઉપયાેગ શંુ માટે થાય છે? 
a) ઈમેઇલ માેકલવા 
b) પૃʕ  છાપવા 
c) વેબસાઈટ્સ સાચવવા 
d) ǒાઉઝર બંધ કરવા 
 Answer: c) વેબસાઈટ્સ સાચવવા 

9. VPN નાે હેતુ શંુ છે? 
a) નેટવકƙ  ઝડપ વધારવી 
b) ગʏુ ǒાઉ̏ઝ̬ગ 
c) વેબસાઈટ લાેડ ઝડપ વધારવી 
d) ડેટા કાપી નાખવા ે
 Answer: b) ગુʏ ǒાઉ̎ઝ̬ગ 

10. ફાયરવાેલ શું કરે છે? 
a) ǒાઉઝર ખાેલે છે 
b) ઇમેઇલ માેકલે છે 
c) નેટવકƙ  સુરƖા અાપે છે 
d) ઈɰરનેટ કનેકشن અાપે છે 
 Answer: c) નેટવકƙ  સુરƖા અાપે છે 

11. HTTPS માં ‘S’ નાે અથƙ શું છે? 
a) Safe 
b) Secure 
c) Server 
d) Simple 
 Answer: b) Secure 

12. કયું સચƙ અેિƮજન વપરાશકતાƙની ખાનગી મા̋હતી સાચવતું નથી? 
a) Google 
b) Yahoo 
c) DuckDuckGo 
d) Bing 
 Answer: c) DuckDuckGo 
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13. Printing માટે કીબાેડƙ શાટેƙકટ શું છે? 
a) Ctrl + C 
b) Ctrl + S 
c) Ctrl + P 
d) Ctrl + D 
 Answer: c) Ctrl + P 

14. FTP નું પૂ̈́ં નામ શું છે? 
a) File Transfer Protocol 
b) Fast Transfer Process 
c) File Tracking Protocol 
d) Fast Tracking Program 
 Answer: a) File Transfer Protocol 

15. ǒાઉઝરમાં History ̀ેવા માટે કયાે કીબાેડƙ શાેટƙકટ છે? 
a) Ctrl + H 
b) Ctrl + J 
c) Ctrl + D 
d) Ctrl + B 
 Answer: a) Ctrl + H 

16. ઇɰરનેટ અૅȋેસ માટે નીચનેું કયંુ સાધન જͅરી છે? 
a) Printer 
b) Scanner 
c) Modem 
d) Speaker 
 Answer: c) Modem 

17. URL નાે કયાે ભાગ વેબસાઇટનું સરનામું બતાવે છે? 
a) HTTP 
b) .com 
c) www.example.com 
d) /page.html 
Answer: c) www.example.com 

18. કઈ વેબ ǒાઉઝર iOS માટે ̍વશેષ ઉપલʤ છે? 
a) Chrome 
b) Firefox 
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c) Safari 
d) Edge 
 Answer: c) Safari 

19. Search engine શું કરે છે? 
a) વેબસાઈટ બનાવે છે 
b) મા̋હતી શાેધી અાપ ેછે 
c) ઇમેઇલ માેકલે છે 
d) ફાઈલ અપલાેડ કરે છે 
 Answer: b) મા̋હતી શાેધી અાપે છે 

20. ǒાઉઝર ક̔ʃગરેશન માટે શુ ંકરવું પડે? 
a) કƳʔુટર બંધ કરવાે 
b) નેટવકƙ  કેબલ કાઢવી 
c) Settings માં જઈ ફેરફાર કરવાે 
d) નવું ǒાઉઝર ડાઉનલાેડ કરવું 
 Answer: c) Settings માં જઈ ફેરફાર કરવાે 
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Indic કી-બાેડƙ  (ગુજરાતી ટાઈપ̯ગ) 
 

1. પ̋રચય  

કƳʔુટરમાં કે માેબાઇલમાં માǋ અǁેં͂ જ નહ̯, ભારતીય ભાષાઅાે પણ સરળતાથી લખી શકાય છે. ખાસ 
કરીને ગુજરાતીમાં ટાઈ̌પ̬ગ માટે તમ ેIndic Keyboard જવેી યુઝર Ǒેɱલી ટૂ˔નાે ઉપયાેગ કરી શકા ેછાે. 
Indic Keyboard અે Government of India અને અʈ ડેવલપસƙ ɦારા ̍વક̐સત કીબાેડƙ છે જ ેગુજરાતી 
સ̋હત અનેક ભાષાઅાેને સપાેટƙ કરે છે. 

અા અકેમમાં અાપણ ેનીચેના મુɠાઅાેનું ̍વƺતૃત રીતે અʬાસ કરશું: 

2. Indic Keyboard નું ઈં˶ાેલેશન (Installation of the Indic.) 

Gujarati ટાઈ̌પ̬ગ માટે ǐથમ પગલું છે કે તમારે તમારા અાેપરે̋ટ̬ગ ̐સ˶મ મુજબ યાƝેય Indic Keyboard 
ઇʊાેલ કરવંુ પડે છે. 

Windows માટે: 

Microsoft Indic Input Tool (https://www.microsoft.com/en-in/bhashaindia/downloads)  

 
અથવા 

Google Input Tools (https://www.google.co.in/inputtools/) 
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અ̍ધકૃત વેબસાઇટ પરથી "Gujarati" ભાષા માટે Indic Tool ડાઉનલાેડ કરાે. 

1. ડાઉનલાેડ થયલેી .exe ફાઈલ પર ડબલ ̚ȃક કરીન ેઇʊાેલેશન ǐ̋ƿયા શͅ કરા.ે 
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Android માટે: 

1. Google Play Store માંથી “Indic Keyboard” અથવા “Google Indic Keyboard” ઇʊાેલ 
કરાે. 

2. ઇʊાેલ થયા પછી, Settings → Language & Input → Keyboard → Indic Keyboard પસંદ 
કરાે. 

3. તેમાં Gujarati ભાષા સેટ કરાે. 

Mac OS માટે: 

1. System Preferences → Keyboard → Input Sources → "+" ̚ȃક કરાે. 

2. Gujarati → Gujarati - QWERTY પસંદ કરાે. 

3. હવે તમારી system માં ગજુરાતી કીબાેડƙ ઉમેરાઈ જશે. 

3. Installing or adding Fonts. 

Installing or Adding Fonts (ફાેɰ ઇʊાેલ કરવી અથવા ઉમેરવી) 

Gujarati ટાઈ̌પ̬ગ માટે યાેƝય અને ˾ˠ લખાણ દશાƙવવાનું હાેય ɔારે યાેƝય ગુજરાતી ફાેɰ (Font) જͅરી 
છે. ખાસ કરીને Indic કીબાેડƙ ઉપયાેગ કરતાં સમયે, ̀ે તમા̈́ં કƳʔુટર અથવા ̋ડવાઇસ ફાɰેને સપાેટƙ ન કરે 
તાે લખાયેલ અƖરાે ખાેટા દેખાશે અથવા સરખા વાંચી શકાતા નથી. અાવાં સમયે ફાેɰ ઇʊાેલ કરવાની 
જ̋ͅરયાત પડી શકે છે. 

1. ફાેɰ (Font) શું છે? 

ફાેɰ અેટલે લખાણ દશાƙવવાની અેક શૈલી છે. દરેક ફાેɰમાં અƖરાેના અાકાર, કદ અને માપ જુદાં હાયે છે. 
ગુજરાતી ભાષા માટે કેટલીક ̀ણીતી Indic ફાેɰ્સ છે: 

 Shruti 

 Gujarati Saral-1 

 Rekha 

 Lohit Gujarati 

 Samyak Gujarati 

2. ફાેɰ કેવી રીતે ઇʊાેલ કરવી (Windows માટે)? 

Gujarati ફાેɰ્સ Windowsમાં ઇʊાેલ કરવા માટે નીચનેા પગલાં અનુસરાે: 

1. ગુજરાતી ફાેɰ (.ttf અથવા .otf ફાઇલ)ને ઈɰરનેટ પરથી ડાઉનલાેડ કરાે. 

2. ફાઇલ પર જમણી ̚ȃક કરીને “Install” ̍વકˍ પસંદ કરાે. 

o ̍વકˍ તરીકે "Install for all users" પણ હાેઈ શકે છે. 

3. થાડેી સેકંડમાં ફાેɰ ̐સ˶મમાં ઉમેરાઈ જશ.ે 
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4. હવે MS Word, Notepad અથવા કાેઇ પણ Softwareમાં ફાેɰ પસંદ કરીને ગુજરાતી લખાણ લખી 
શકાે છાે. 

3. ફાેɰ ઇʊાેલ કયાƙ પછી શું ચકાસવંુ? 

 Control Panel → Fonts માં newly added ફાેɰ દેખાય છે કે નહ̯. 

 Indic Keyboardમાંથી ગુજરાતી પસંદ કરીને ફાેɰ બદલવા. 

 કાેઈ વેબપેજ કે દƺતાવેજમાં ફાેɰ સાચી રીતે દેખાય છે કે નહ̯. 

4. માેબાઇલ માટે ફાેɰ ઉમેરવી (Android માટે): 

 ઘણા માેબાઇલમાં પહેલેથી ગજુરાતી ફાેɰ્સ હાેય છે. 

 ̀ે ન હાેય તાે કેટલાક Custom Launchers અથવા Android Settings ɦારા ફાɰે ઉમેરવામા ં
અાવે છે. 

 Root access જͅરી હાેઈ શકે છે જથેી સામાʈ વપરાશકતાƙ માટે ભલામણપાǋ નથી. 

5. ઉપયાેગી સૂચનાઅાે: 

 હંમેશા સરકારી અથવા ̍વ˝સનીય વેબસાઇટ પરથી ફાેɰ ડાઉનલાેડ કરાે. 

 બધાં સાેʘવેરમાં દરેક ફાેɰ સારી રીતે દેખાય અે જͅરી નથી Microsoft Word, LibreOffice, 
Photoshop વગરેેમાં અલગ દેખાવ હાેઈ શકે છે. 

4. કીબાેડƙ  બદલવાની ǐ̋ƿયા (Switching of Keyboard). 

Gujarati અથવા અʈ ભારતીય ભાષાઅામેાં ટાઈપ કરવા માટે Indic Keyboard નાે ઉપયાેગ થાય છે. ȱારે 
અેકથી વધુ ભાષાઅાે માટે કીબાેડƙ ઇʊાેલ કરેલ હાેય, ɔારે જͅરી ભાષા માટે કીબાેડƙ ̗̄ચ કરવાનાે ̍વકˍ 
હાેય છે. અા ǐ̋ƿયાન ેKeyboard Switching કહેવાય છે. 

કીબાેડƙ ̗̄̎ચ̬ગ અે અેવી ǐ̋ƿયા છે જમેાં તમે તમારા કƳʔુટર કે માેબાઇલમાં અેક ભાષાથી બી͂ ભાષાના 
કીબાેડƙ પર બદલાવ કરાે છાે. ઉદાહરણ તરીકે, તમે English કીબાેડƙ પરથી Gujarati કીબાેડƙ પર જઈ શકાે છાે 
અને પછી પાછા English પર અાવી શકાે છાે. 

Windows માટે કીબાેડƙ  કેવી રીતે ̘̄ચ કરવાે? 

A. Control Panelથી કીબાેડƙ ઉમેરવાે: 

1. Control Panel → Clock, Language and Region → Language પસંદ કરાે. 

2. "Add a language" પર ̚ȃક કરાે અન ેGujarati પસંદ કરાે. 

3. Gujarati ઉમેયાƙ પછી Gujarati Indic Keyboard અથવા Google Input Tools પસંદ કરી શકાે 
છાે. 

B. કીબાેડƙ ̘̄̎ચ̬ગ માટે શાટેƙકટ કી: 

 Alt + Shift અથવા Windows Key + Spacebar દબાવવાથી તમે અલગ-અલગ ભાષાના કીબાેડƙ 
પર જઈ શકાે છાે. 
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લ̲Ɲવેજ બાર (Language Bar)થી ̘̄ચ કરવુ ં

Windows Taskbar પર તારીખની બાજુઅે ભાષાની સૂચી દેખાય છે જમે કે ENG અથવા GUJ. અહ̯ ̚ȃક 
કરીને તમે સરળતાથી કીબાેડƙ બદલી શકાે છાે. 

 માેબાઇલમાં કીબાેડƙ  ̘̄̎ચ̬ગ (Android/iOS માટે) 

A. Google Indic Keyboard અથવા Gboard: 

1. Settings → Language & Input → Keyboard પસદં કરાે. 

2. ગુજરાતી કીબાેડƙ ઉમેરાે. 

3. ટાઈપ કરતી વખતે spacebar દબા˗ા વગર ડાબી કે જમણી બાજુ ƺલાઇડ કરવાથી  કીબાેડƙ બદલાશે. 

B. SwiftKey કે બી̀ કીબાેડƙમાં પણ ભાષા બદલવાની અેવી જ રીત હાેય છે. 

મહɗની સૂચનાઅાે: 

 શાેટƙકટ કી યાદ રાખાે  તે ઝડપથી ભાષા બદલવામાં મદદͅપ છે. 

 દરેક અે̖ʕકેશનમાં કીબાેડƙ ̗̄̎ચ̬ગ કાયƙ કરી શકે, પરંતુ કેટલીક જƝયા પર Setting ફરીથી કરવી 
પડી શકે છે. 

 ̀ે કીબાેડƙ ન દેખાય તાે Settingsમાં તપાસાે કે તે ઈʊાેલ થયેલ છે કે નહ̯. 

Gujarati ટાઈ̌પ̬ગ કરતાં પહેલા ખાતરી કરાે કે કીબાેડƙ Gujarati પર સેટ થયેલ છે. નહીતર તમે English 
કીબાેડƙમાં ટાઈપ કરતા ભૂલથી Gujarati અƖરાે ના અાવતાં હાેય. 

5. On-the-fly help. 

Gujarati જવેી ભારતીય ભાષાઅાેમાં ટાઈપ કરતી વખતે નવા નવા શʣાે, કી-કાે̗ʳનેશʉ, કે ફાેને̋ટક 
ઇનપુટમાં શંકા ઊભી થવી સામાʈ બાબત છે. અાવા સમયે On-the-fly Help અટેલે કે ટાઈપ કરતી વેળાઅ ે
તરત મળતી સહાય ખુબ ઉપયાેગી સા̐બત થાય છે. અા સુ̍વધા ઘણા Indic Keyboards અને Input Tools 
ɦારા અાપવામાં અાવે છે. 

 On-the-fly Help શું છે? 

On-the-fly Help અે અેવી સહાય છે જ ેટાઈપ કરતી વખતે તરતજ સૂચનાે અાપે છે. જમે કે: 

 યાેƝય ગજુરાતી શʣ માટે phonetic suggestion (ફાેને̋ટક સૂચન) 

 કઈ કીથી કયાે અƖર ટાઈપ થાય તેનું immediate display 

 શʣ પૂરાં કરતાં પહેલાં auto-suggestions 

અાને કારણે યુઝરને ટાઈ̌પ̬ગ કરતી વખતે અલગથી manual વાંચવાની કે lookup કરવાની જͅર પડતી 
નથી. 
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 કઈ રીતે મળે છે On-the-fly Help? 

A. Google Input Tools / Gboard / Indic Input Tools: 

 તમે "namaste" લખાે, ɔારે તરત જ "નમƺતે" જવેા ̍વકˍાે દેખાય છે. 

 દરેક શʣના અનેક ̍વકˍામેાંથી પસંદગી કરી શકાે છા.ે 

B. Tooltip Suggestion: 

 કેટલાક કીબાેડƙ અે̖ʕકેશનાેમાં કાેઈ કી પર માઉસ લાવતા ંજ તેના પરથી શું ટાઈપ થશે તે ̀ેવા મળે 
છે. 

 ખાસ કરીને INSCRIPT કીબાેડƙમાં અા ટૂલ̋ટપ મદદͅપ છે. 

C. Spell Check and Word Prediction: 

 ઘણા કીબાેડƙમાં યાેƝય શʣ માટે થતી ભૂલ સુધારવા પણ સુચન મળે છે. 

 ફાેને̋ટક કીબાેડƙમાં તમે જ ેરીતે ઉȝાર કરાે તે ǐમાણે તɠન ન͂કના શʣાે બતાવવામાં અાવે છે. 

On-the-fly Helpના ફાયદા: 

 ટાઈ̌પ̬ગની ઝડપ વધે છે. 

 શʣાે યાદ રાખવાની જͅર રહેતી નથી. 

 નવાં શીખનાર માટે માગƙદશƙન મળે છે. 

 ભાષાની ભૂલ અાેછી થાય છે. 

ઉપયાેગી સૂચનાે: 

 ̀ે તમે નવા શીખનાર છા,ે તાે ફાેને̋ ટક કીબાેડƙ અને On-the-fly suggestion સાથે શͅ કરવું સરળ 
રહેશે. 

 અે સુ̍ વધા ચાલુ છે કે નહ̯ તે પણ Settings માં તપાસાે. 

 ટાઈપ કરતી વખતે ̀ે તમારા શʣાે auto-suggest ન થાય, તાે કી-બાેડƙ ભાષા ચેક કરાે. 

 શીખવામાં સરળતા માટે હંમેશા તે કીબાેડƙ પસંદ કરાે જમેાં real-time suggestions મળે અે તમારાે સમય 
પણ બચાવે છે અને ટાઈ̌પ̬ગ શીખવાનું સરળ બનાવે છે. 
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સંચાર અન ેસહયાેગ (Communication 
and Collaboration) 

 

1. પ̋રચય (Introduction) 

અɔારના અાધુ̏નક ̋ડ̏જટલ જગતમાં, ખાસ કરીને ɔારે ȱારે તમે કƳʔુટર અને ટેǽાેલાે͂  સાથે કાયƙ 
કરતા હાે ɔારે સંચાર (કʸુ̏નકેશન) અન ેસહયાેગ (કાેલાǒેશન) અ ેઅ̏નવાયƙ કુશળતાઅાે બની ગઈ છે,  તમ ે
નાના ǁુપનાે ̋હ̅ા ેહા ેકે માટેી સં˺ાના,ે ̋ડ̏જટલ સાધનાે ɦારા અસરકારક રીત ેસંચાર કરવાનું અને સહયાગે 
કરવા કરવાનંુ કાૈશˑ કાયƙƖમતા, સમ̃ા ઉકેલવા અને નવીનતા માટે ખૂબ જ જͅરી છે. 

સંચારની સમજૂતી (Understanding Communication) 

સંચારનાે અથƙ છે ˗̘Ǹગત અથવા ǁુપ વȝે મા̋હતીનું અાદાનǐદાન કરવાની ǐ̋ƿયા. કƳʔુટર અન ે
ટેǽાેલાે͂ ના સંદભƙમાં, સંચાર માૈ̑ ખક અન ેલે̑ખત અેમ બɿે ǐકારનું હાેઈ શકે છે, જમેા ંલખાણ, ̍વ̋ડયા ે
કાેલ, ઈમેલ અને ફાઇલ શે̋રગ̬ના ેસમાવેશ થાય છે. 

કƳʔુ̋ટ̬ગમાં સંચારના ǐકારાે 

 ઈમેલ (Email): કામના ˺ ળ ેમા̋હતીની અાપ લે માટે અેક અાૈપચા̋રક અને ̠ ાપક રીતે ઉપયાેગમાં લેવામા ં
અાવતી પɡ̍ત. 

 ચેટ અે̖ ʕકેશʉ (Chat Applications): જમે કે WhatsApp, Slack, Microsoft Teams. 
 ̍વ̋ડઅાે કાેʃર̘ʉ̬ગ (Video Conferencing): Zoom, Google Meet, Skype જવેી અે̖ ʕકેશન. 
 સાે̏શયલ મી̋ડયા ʕેટફાેʼƙ: ̀હેર સંચાર, ǒા̒ɱ̬ગ અથવા ǁાહક સપાેટƙ માટે ઉપયાેગ થાય છે. 
 સં˺ ાકીય અાંત̋રક સંચાર: કાયƙ ˗વ˺ાપન અને અપડેટ માટે ઉપયાેગમાં લેવાતા સચંાર સાધનાે. 

સંચારનું મહɗ 

 કાયા̳ અન ેજવાબદારીઅાેની ˾ˠ સમજૂતીમાં મદદ કરે છે 
 ભૂલાે અને ગેરસમજ ઘટાડે છે 
 ટીમ વકƙ  અન ેસહયાેગમાં વધારા ેકરે છે 
 દૂર˺ અન ેͅબͅ કાયƙ˺ળમાં યાƝેય કાયƙપɡ̍ત સુ̏ ન̏˛ત કરે છે 

સહયાેગની સમજૂતી (Understanding Collaboration) 

સહયાેગનાે અથƙ છે અેકસાથે મળીને અેક સામાʈ હેતુ હાંસલ કરવા માટે કાયƙ કરવું. કƳʔુટર સંબં̍ ધત Ɩેǋામેા,ં 
સહયાેગનાે અથƙ માટેાભાગે દƺતાવે̀ે, ǐાજેǶે, ǐેઝɰેશન અને સમ̃ા ઉકેલવાના કાયƙ પર મળીને કામ કરવાે 
હાેય છે. 

કƳʔુ̋ટ̬ગમાં સહયાેગ સાધનાે 

 Google Workspace: Docs, Sheets, Slides વગેરે. 
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 Microsoft Office 365: Word, Excel, PowerPoint વગેરેનું ȃાઉડ અાધા̋રત સહયાેગ. 
 Trello / Asana: ǐાેજǶે મેનેજમેɰ ટૂ˔. 
 GitHub / GitLab: કાે̋ડ̬ગ અને વઝƙન ̏નયંǋણ માટે. 
 Google Drive / OneDrive: ફાઇલાેને ˶ાેર અને શેર કરવા માટે. 

સહયાેગના લાભા ે

 ̍વ̍વધ કુશળતાઅાે અને ̍વચારાેને અેકસાથે લાવે છે 
 કાયƙƖમતા અને ઉɎાદનƖમતા વધારે છે 
 ટીમ વકƙ  અને અાંતર˗̘Ǹ કાૈશˑાે ̍વકસાવે છે 
 ઝડપી ઉકેલ અને નવીનતા માટે મદદͅપ થાય છે 

 

 

̋ડ̏જટલ ̐શˠાચાર અને ને̋ ટકેટ (Digital Etiquette and Netiquette): 

અાૅનલાઇન સંચાર અને સહયાેગ કરતી વખતે યાેƝય ̋ડ̏જટલ ̏શˠાચાર, જનેે ને̋ટકેટ પણ કહેવામાં અાવે છે, 
તેનું પાલન કરવું મહɗપૂણƙ છે. 

સારી અપનાવવા યાેƝય રીતાે: 

 લેખીત સંચારમાં ̍વનǔતા અને ˗ાવસા̍યકતા ̀ળવવી ̀ેઈ. 
 માેટા અƖરાે (ALL CAPS)નાે ઉપયાેગ ટાળવાે ̀ેઈઅે. 
 સંદેશાને ˾ˠ અને સં̐ Ɩʏ રાખવા. 
 મહɗપૂણƙ ઈમેલ અથવા સંદેશાે મળવાની પુ̑ ˠ અાપવી. 
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 બી̀ સાથે શેર કરેલ ફાઇલાે અને ફાેˆરાે ને ˗વ̗˺ત ગાેઠવેલા રાખવા 

2. સંચાર અને સહયાેગના ઉɠેƸયાે (Objectives of Communication and 
Collaboration) 

સંચારની કˍનાને સમજવી 

➤̋ડ̏જટલ પ̋ર̗˺̍તમાં સંચારનાે અથƙ અને તેનું મહɗ સમ̀વવું. 

̍વ̐ભɿ સંચાર પɡ̍તઅાનેી અાેળખ કરવી 

➤ ̋ડ̏જટલ સંચાર માટે ઉપયાેગમાં લેવામાં અાવતાં ̍વ̍વધ સાધનાે અને ʕેટફામેƙની અાેળખ કરવી (જમે કે 
ઈમેલ, મેસે̏ જ̬ગ અƯેસ, ̍વ̋ડઅાે કાેʃર̘ʉ̬ગ). 

અસરકારક સંચાર કાૈશˑાે ̍વકસાવવંુ 

➤ લે̑ખત અને માૈ̑ખક ̄ͅપમાં ̍વચાર સરળતા, સં̐ Ɩʏતા અને ˗ાવસા̍યકતાથી રજૂ કરવાનું શીખવંુ. 

સહયાેગની કˍનાને સમજવી 

➤ સહયાેગ શંુ છે અને કƳʔુટર સંબં̍ ધત કાયƙ અને ǐાેજǶ્ેસમાં તેનંુ મહɗ સમ̀વવું. 

સહયાેગી સાધનાેનાે અસરકારક ઉપયાેગ કરવાે 

➤ Google Workspace, Microsoft Office 365, Trello, GitHub અને ȃાઉડ ˶ાેરેજ ̐સ˶ʼ જવેા 
સાધનાેનું ˗વહા̋રક Ɨાન મળેવવું. 

̋ડ̏જટલ ̐શˠાચાર (Netiquette) અʬાસમાં લેવાે 

➤ અાૅનલાઇન સંચાર અને ટીમ વકƙમાં યાેƝય વતƙન ǐદ̏શ̭ત કરવું. 

હકીકતના ǐસંગાેમાં સંચાર અને સહયાેગને લાગુ કરવાે 

➤ ̋ડ̏જટલ ʕેટફાેમƙનાે ઉપયાેગ કરીને ǁુપ ǐવૃ̍ ɇઅાે, સાથે કરવાના  કાયા̳ અને વȢુƙઅલ ̌મ̋ટ̬Ɲસમાં ભાગ 
લેવાે અથવા અનુસરણ કરવુ.ં 

ટીમ વકƙ ɦારા સમ̃ાઅાેનું સમાધાન વધારવું 

➤ સહયાેગી ̍વચારશ̘Ǹ અને જવાબદારી વહ̲ચણી ɦારા ઉકેલ લાવવાની Ɩમતા સધુારવી. 

દૂર˺ અન ેઅાૅનલાઇન કાયƙ પ̋ર̘˺̍ત સાથે સા̈́ં કામ કરવુ ં

➤ ̋ ડ̏જટલ સંચાર અને સહયાેગ સાધનાેનાે ઉપયાેગ કરીને દૂર˺ અથવા હાઇ̐ǒડ કાયƙ પɡ̍તમાં અસરકારક 
રીતે કાયƙ કરવાની તૈયારી કરવી. 

કાર̋કદ̰ માટે તૈયાર સચંાર કાૈશˑાે ̍વકસાવવંુ 
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➤ કƳʔુટર અને IT ઉɥાેગમાં સફળતા માટે જͅરી અાંતર˗̘Ǹ અને ̠ ાવસા̍યક સંચાર કાૈશˑાે ̍ વકસાવવું. 

3. ઇમેઇલનાે અાધારભૂત અʬાસ (Basics of E-mail) 

3.1 ઈલƛેǇાે̏નક મેલ શું છે? 

ઈમેઇલ અે ઇɰરનેટ સંચાર માટેના સાૈથી મૂળભૂત સાધનામેાંનંુ અેક છે. ઈમઇેલ, જનેે Electronic Mail તરીકે 
અાેળખવામાં અાવે છે, અે ̋ડ̏જટલ સંદેશાઅાેને ઇɰરનેટ ɦારા માેકલવા અને મેળવવાની અેક પɡ̍ત છે. ત ે
˗̘Ǹગત અને ˗ાવસા̍યક ǐકારના સંચારની અેક સામાʈ અને ̍વ˝સનીય પɡ̍ત છે. ઈમેઇલની મદદથી 
સામાʈ ટપાલની તુલનાઅે સમય અને પૈસાની બચત થાય છે. ઈમેઇલમાં લખાણ, ̎ચǋાે, ̏લȋ̬ અને સંલȘ 
ફાઇલાે હાેય શકે છે અને ̍વ˝ના કાેઈપણ ખૂણે તરત માકેલી શકાય છે. 

ઈમેઇલનાે ઈ̍તહાસ 

 ઈલƛેǇાે̏ નક મેલનાે ઉપયાેગ ઇɰરનેટના અાગમન પહેલાંથી થતાે હતાે. શͅઅાતના ̋દવસાેમાં (સાંǐત રીતે 
1965માં), MAILBOX નામના કƳʔુટર ǐાેǁામનાે ઉપયાેગ ઈલેƛǇાે̏નક ͅ પ ેસંદેશાે માેકલવા માટે થતાે હતા.ે 
અેક જ કƳʔુટરનાે ઉપયાેગ ઘણા બધા વપરાશકતાƙ ઈમેઇલ માેકલવા અને વાંચવા માટે કરતા હતા. 

 1969માં ARPANET (Advanced Research Projects Agency Network) અમલમાં અા˗ુ,ં જમેાં 
̍વ̍વધ ̍વભાગાેના ઘણા કƳʔુટસƙને ̀ેડીને ઇલેƛǇાે̏નક મેલ શેર કરવામાં અા˗ા.ે 

 1971માં Ray Tomlinson અે @ ̎ચ̆નાે ઉપયાેગ કરીને અલગ હાે˶ના યુઝસƙ વȝે સંદેશા માેકલવાની 
પɡ̍ત શાેધી. તે સમયે અા પɡ̍ત કાેઈ સંગઠનની અંદર જ મયાƙ̋ દત હતી. 

 ɔારબાદ, ȱારે અલગ સંગઠનાે વȝે પણ સંચારની જͅર પડી, ɔારે ઇɰરનેટના અા̍વ˞ારની શͅઅાત 
થઈ. 

મૂળભૂત ઈમેઇલ કાયા̳ (Basic Email Functions) 

• Send (માેકલવંુ): તૈયાર કરેલાે ઈમેઇલ મેળવનારને માેકલે છે. 
• Reply (ǐ̍તસાદ અાપવાે): માેકલનારને જવાબ અાપે છે. 
• Reply All (બધાને જવાબ અાપવાે): માેકલનાર અને બધા ઈમેઈલ મેળવનારને જવાબ અાપે છે. 
• Forward (અાગળ માેકલવાે): મળેલા ઈમેઇલને બી̀ને માેકલવા.ે 
• Delete (કાઢી નાંખવંુ): ઈમેઇલને તમારા મેઈલ બાેȋમાથંી દૂર કરે છે. 
• Search (શાેધવું): કીવડ્ƙસના અાધારે ઈમેઇલ શાેધે છે. 
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ઈમેઇલના લાભાે (Email Advantages) 

 Productivity Tools (ઉɎાદકતા વધારતા સાધનાે): ઈમેઇલ ઘણી વખત કેલેɱર, અǉેેસ બુક, ઇʊɰ 
મેસે̏જ̬ગ વગેરે સાથે અાવે છે, જ ેકાયƙƖમતા અને સુ̍ વધા માટે ઉપયાેગી છે. 

 Access to Web Services (વેબ સવેાઅાેમા ંǐવેશ): ̀ે તમે Facebook જવેી વેબસાઇટ પર અેકાઉɰ 
બનાવવા માંગાે છાે અથવા Amazon જવેી સેવાઅાેથી વƺતુઅાે મંગાવવી હાયે, તાે તમા̈́ં અાેળખાણ અને 
સંપકƙ  માટે ઈમેઇલ સરનામું જͅરી છે. 

 Easy Mail Management (સરળ ઈમેઇલ ̠ વ˺ાપન): ઈમેઇલ સેવાǐદાતાઅાે અેવાે ફાઇ̏લ̬ગ, લેબલ, 
ǐાથ̌મકતા અાપવી, શાેધવી, જૂથમાં ગાઠેવવી અને ̋ ફ˄ર કરવાનું સાધન અાપે છે. ˾ ામન ે̏ નયં̍ ǋત કરવુ ં
પણ સરળ બને છે. 

 Privacy (ગાેપનીયતા): તમા̈́ં ઈમેઇલ તમા̈́ં ˗̘Ǹગત અને ખાનગી અેકાઉɰ હાેય છે, જનેે પાસવડƙ 
ɦારા સુર̐Ɩત રાખવામા ંઅાવે છે. 
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 Communication with Multiple People (ઘણા લાેકાેને અેકસાથે સંચાર): તમે અેક જ ઈમેઇલ અનેક 
લાેકાેને માેકલી શકાે છા,ે જથેી સંવાદમાં જેટલા લાેકાે ̀ેડવા હાેય તેટલાને ̀ેડવામાં અાવે છે. 

 Accessible Anywhere Anytime (Ȃાંયે પણ Ȃારેય અૅȋેસ કરી શકાય): તમા̈́ં ઈમેઇલ મેળવવા 
માટે તમારે ઘરે હાેવાની જͅર નથી. ઈɰરનેટ ̀ેડાયેલ કાઇે પણ કƳʔુટર અથવા માેબાઇલ ઉપકરણથી 
અȋૅેસ કરી શકાય છે. 

ઈમેઇલના નુકસાનાે (Email Disadvantages) 

 ઈમેઇલ વાપરવા માટે ઇɰરનેટ જ̋ͅરયાત છે. 
 ˾ામ અને ̋ફ̏શ̬ગ અેટેȋ નાે ̀ેખમ રહે છે. 
 વધુ ǐમાણમાં મળતાં ઈમઇેલ મા̋હતીના ભાર વધારવાનાે ભય ઊભાે કરે છે. 
 ̀ેડાણમાં માેકલવામાં અાવતા ફાઇલના કદ પર મયાƙદા હાયે છે (ઉદાહરણ તરીકે Gmail માટે 25MB). 
 ˗̘Ǹગત સંપકƙમાં ઘટાડાે થઈ શકે છે અને માનવીય ˾શƙ ગુમાવી શકે છે. 
 લખાણમાં અવાજ કે હાવભાવ ના હાેવાને કારણ ેગેરસમજ થવાની શȂતા રહે છે. 
 ટેક̏નકલ તકલીફાે (જમે કે સવƙર ડાઉન હાેવું) ઈમેઇલ સેવા અટકાવી શકે છે. 
 તરત ǐ̍તસાદ મળવાની કાેઈ ખાતરી રહેતી નથી. 
 ઈમેઇલનાે જવાબદારીપૂવƙક અને અસરકારક રીતે ઉપયાગે કરવાે ̀ેઈઅે જમે કે ˾ˠ ̍વષય લાઇનાે 

ઉપયાેગ કરવાે, યાેƝય શીˠાચાર રાખવાે અને સુરƖા ̀ખેમાે સામે સતકƙ  રહેવું. 

સામાʈ ઇમેઇલ સેવાǐદાતા (Common E-mail Service Providers) 

અા અેવા ʕટેફાેʼƙ છે જ ેતમને ઈમેઇલ અેકાઉɰ બનાવવાની અને તેનાે ઉપયાેગ કરવાની સુ̍વધા અાપે છે: 

Gmail – Google ɦારા ǐદાન કરાયેલ 

Outlook – Microsoft ɦારા ǐદાન કરાયેલ 

Yahoo Mail – Yahoo ɦારા ǐદાન કરાયેલ 

Rediff mail – Rediff.com ɦારા ǐદાન કરાયેલ 

Zoho Mail – ˗ાવસા̍યક ઈમેઇલ માટે 
ઉપયાેગમાં લેવાતુ ં

અા પૈકી ઘણી સેવાઅાે મફત અેકાઉɰની સુ̍વધા અાપે છે અને સાથે સાથે પેઈડ અપǁેડ માટે ̍વકˍાે પણ 
ઉપલʤ હાેય છે. 

ઈમેઇલ કેવી રીતે કાયƙ કરે છે? (How does email work?) 

અેક સામાʈ વપરાશકતાƙ તરીકે, અાપણે અેટલું ̀ણીઅે છીઅે કે કાેઈ ˗̘Ǹ સદેંશાે લખે છે, ઈમેઈલ 
મેળવનાર નું ઈમેઇલ સરનામું "To" ફીˆમાં લખે છે અને પછી "Send Mail" બટન ̚ȃક કરે છે. ઈમેઈલ 
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મેળવનારને ઈમઇેલ તેમના ઇનબાȋેમાં મળી ̀ય છે. પરંતુ, ઈમેઇલ માેકલાવાની ǐ̋ƿયામાં અનેક પગલાં 
સામેલ હાેય છે: 

 વપરાશકતાƙ ઈમેઇલ માેકલે છે. 
 SMTP સવƙર માેકલનારની અાેળખની ચકાસણી કરે છે. 
 SMTP સવƙર  ઈમેઇલ મેળવનારના સરનામામાં દશાƙવેલા ડાેમેઇનની મા̋હતી ચકાસે છે. 
 SMTP સવƙર, ઈમેઈલ મેળવનારના ડાેમેઇન નેમ સવƙર (DNS) માંથી મળેલા MX રેકાડેƙને અાધારે ઈમેઇલને 

યાƝેય સવƙર પર માેકલ ેછે. 
 ઈમેઈલ મેળવનારનુ ંસવƙર ઈમેઇલ સરનામું માʈ છે કે નહ̯ તેની પુ̑ˠ કરે છે અને પછી ઈમેઇલ ̋ડ̏લવર 

કરે છે. 

 

ઈમેઇલ સરનામાની રચના (Structure of an E-mail Address) 

ઈમેઇલ સરનામંુ અે ઈમેઇલ અેકાઉɰ માટેનું અેક અનʈ અાેળખપǋ હાેય છે. તનેું બંધારણ નીચ ેǐમાણ ે
હાેય છે: 
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username@domain.com 
ઉદાહરણ: drnileshmodi@gmail.com 

ઈમેઇલ સરનામાના ઘટકાે: 

1. Username (વપરાશકતાƙ નામ): 

o વપરાશકતાƙ ɦારા પસંદ કરાયલે નામ કે અાેળખ. 

o ઉદાહરણ તરીકે: nilesh.modi 

2. @ ̎ચ̆ (Separator): 

o વપરાશકતાƙ નામ અને ડાેમેઇન વȝેનાે ̍વભાજક. 

o વાંચવામાં “અેટ” તરીકે ઉȝાર થાય છે. 

3. Domain Name (ડાેમેઇન નામ): 

o ઈમેઇલ સેવા અાપતી કંપનીના સવƙરને અાેળખે છે. 

o ઉદાહરણ તરીકે: gmail.com, yahoo.com 

ઉદાહરણ: 

drnileshmodi@gmail.com 
અહ̯ drnileshmodi અે વપરાશકતાƙ નામ છે 
@ અે ̍વભાજક છે 
gmail.com અે ડાેમેઇન નામ છે 

ઈમેઈલ સંદેશના ભાગાે    

મા̋હતી Ɩǋે વણƙન 

̍વષય (Subject) ઈમેઇલના ̍વષય અંગે મા̋હતી અાપે છે. 

ǐેષક (From) માેકલનારનંુ ઈમેઇલ સરનામુ ંદશાƙવે છે. 

ǐાʏકતાƙ (To) ǐાʏકતાƙનું ઈમેઇલ સરનામું દશાƙવે છે. 

તારીખ અને સમય (Date 
and time) 

ǐાʏકતાƙના ટાઇમ  ઝાેન મુજબ ઈમેઇલ ǐાʏ થયાની તારીખ અને સમય દશાƙવ ે
છે. 

ǐાʏકતાƙનું નામ 
(Recipient) 

ǐાʏકતાƙનું નામ દશાƙવે છે. 
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ǐ̍તસાદ માટે (Reply-to) ȱારે ǐાʏકતાƙ ǐાʏ થયેલા ઈમેઇલમાં Reply બટન પર ̚ȃક કરે છે, ɔારે 
To Ɩેǋ અાપમેળે Reply-to Ɩેǋમાં અાપેલા ઈમેઇલ IDના અાધારે ભરાઈ 
̀ય છે. 

કાબƙન કાેપી (Cc) ȱારે માેકલનાર ઈમેઇલની નકલ અʈ વપરાશકતાƙઅાેને માેકલવા માંગે 
ɔારે અાનાે ઉપયાેગ થાય છે. 

Ʊલાઇɱ કાબƙન કાેપી 
(Bcc) 

Bcc માં દાખલ કરાયેલ ઈમેઇલ સરનામંુ To અને Cc માં દાખલ કરાયેલા 
વપરાશકતાƙઅાેને દેખાય નહ̯. 

સંલȘ ફાઇલાે 
(Attachments) 

તે ફાઇલાે સમા̍વˠ હાેય છે જ ેમાેકલનાર ઈમેઇલના ̍વષયને અાધાર અાપતી 
રીતે ̀ેડે છે. 

 

ઈમેઇલ ઇɰરફેસના ઘટકાે (Components of an E-mail Interface) 

ȱારે તમે કાઈે ઈમેઇલ સેવા ખાેલાે છાે ɔારે નીચેના ̍વભાગાે ̀ેવા મળે છે: 

 Inbox (ઇનબાેȋ): ȱાં મળેલા ઈમેઇલ ˶ાેર થાય છે. 
 Sent Mail (માેકલેલા ઈમેઇલ): તમે જ ેઈમેઇલ માેકˑા છે તે દશાƙવે છે. 
 Drafts (કાચા સંદેશા): અેવા ઈમેઇલ જ ેતમે લખવાનું શͅ કયાƙ છે પણ હજુ માેકˑા નથી. 
 Spam અથવા Junk (˾ામ / જંક): તે અેવા ઈમેઇલનાે સમાવેશ કરે છે જ ેઅ̏નȞનીય કે હા̏નકારક 

હાેવાનાે સંદેહ હાેય. 
 Trash અથવા Deleted (Ǉેસ  / ડીલીટ): જ ેતમે કાઢી નાંȕા હાેય તે ઈમઇેલને સંǁહ કરે છે . 

ઈમેઇલ લખવાે (Writing / Composing an E-mail) 

ȱારે તમે "Compose" પર ̚ȃક કરાે છાે, ɔારે અેક નવી ̍વɱાે ખુલે છે જેમાં અાવલે મહɗના ભાગાે નીચ ે
મુજબ છે: 

 To (ǐાʏકતાƙ): ǐાʏકતાƙનું ઈમેઇલ સરનામુ.ં 
 Cc (કાબƙન કાેપી): અʈ ǐાʏકતાƙઅાેને નકલ માેકલે છે જ ેસાૈને દેખાય છે. 
 Bcc (Ʊલાઈɱ કાબƙન કાેપી): નકલ માેકલે છે પરંતુ તે ǐાʏકતાƙઅાેનું સરનામું બી̀ને દેખાતું નથી. 
 Subject (̍વષય): ઈમેઇલનાે ટંૂકમાં શીષƙક અથવા ઉɠેશ (જેમ કે "Assignment Submission"). 
 Body (મુȕ ̍વષયવƺતુ): સંદેશાનંુ મુȕ લખાણ. 
 Attachments (સંલȘ ફાઇલાે): ઈમઇેલ સાથે ̀ેડેલી ફાઇલાે (જમે કે PDF, Word દƺતાવે̀,ે 

છબીઅાે). 

3.2 નવંુ ઈમેઇલ ID બનાવવું (Make a new E-mail ID) 
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પગલું 1: ઈમેઇલ સેવાǐદાતા પસંદ કરાે: સાૈથી પહેલાં, તમારે નǲી કરવું પડશે કે તમે કયા ઈમેઇલ 
સેવાǐદાતાનાે ઉપયાેગ કરવા માંગાે છાે. કેટલાક લાેક̌ǐય ̍વકˍાેમાં સમાવેશ થાય છે: 

• Gmail (Google ɦારા) 
• Yahoo Mail (Yahoo ɦારા) 
• Outlook (Microsoft ɦારા) 
• Proton Mail (ગાેપનીયતાને મહɗ અાપતું ઈમઇેલ ʕેટફાેમƙ) 
• Zoho Mail (˗વસાય કેિƮǍત) 
• AOL Mail (અેક શ̈́અાતથી ǐચ̏લત ̍વકˍ) 

• દરેક સેવાઅે પાેતાની ̍વશેષતાઅાે અાપ ેછે, પણ ઈમેઇલ ID બનાવવાની સામાʈ ǐ̋ƿયા લગભગ સમાન 
જ હાેય છે. અા અʬાસ માટે, અાપણે ઉદાહરણ તરીકે Gmail નાે ઉપયાેગ કરીશંુ, પરંતુ અા પગલાં અʈ 
સેવાઅાે માટે પણ લાગુ પડે છે. 

 

પગલું 2: પસંદ કરેલી ઈમેઇલ સેવાનું સાઇન-અપ પેજ ખાેલાે 

વેબ ǒાઉઝર ખાેલાે: Google Chrome, Firefox, Safari જેવા કાેઈપણ વેબ ǒાઉઝર ખાેલાે. 

 ઈમેઇલ સાઇન-અપ પેજ પર ̀અાે: 
o Gmail માટે: ǒાઉઝરના અેǉેસ બારમાં www.gmail.com લખાે. 
o Yahoo માટે: mail.yahoo.com લખાે. 
o Outlook માટે: outlook.com પર ̀અાે. 

 ȱારે તમ ે પસંદ કરેલ ઈમઇેલ સેવા અાપનારના હામેપેજ પર પહા̲ચી ̀અા,ે ɔારે ɔાં “Create 
Account”, “Sign Up” અથવા તેના જવેા શʣાે હાયે અેવી ̏લ̬ક કે બટન શાેધાે અને તેના પર ̚ȃક 
કરાે. 
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પગલું 3: તમારી ˗̘Ǹગત મા̋હતી ભરા ે

ȱારે તમે “Create Account” અથવા “Sign Up” બટન પર ̚ȃક કરાે છાે, ɔારે તમા̈́ં ર͂˷ેશન ફાેમƙ 
ખુલશ,ે ȱાં તમારે નીચેની મા̋હતી ભરવી પડશે: 

 Full Name (પૂ̈́ ં  નામ): 
તમા̈́ં ǐથમ નામ અને છે˒ું નામ દાખલ કરાે. 

 Username (વપરાશકતાƙ નામ): 

અેક અનʈ યુઝરનેમ (નામ) પસંદ કરાે. અા તમા̈́ં ઈમેઇલ સરનામું બની જશે (જમે કે: 
username@gmail.com). 

o ̀ે તમે કામ અથવા અʬાસ માટે ઈમેઇલ બનાવી ર̈ા છાે તાે અેવું નામ પસંદ કરાે જે 
˗ાવસા̍યક અને યાદ રાખવામાં સરળ હાેય. 

o ̀ે પસંદ કરેલું યુઝરનામ પહેલાથી જ કાેઈઅે ઉપયાેગમાં લીધંુ હાેય, તાે ઈમેઇલ સેવાǐદાતા તમારા 
માટે ̍વકˍ સૂચવશે. 

 Password (પાસવડƙ): 
અેક મજબૂત પાસવડƙ બનાવા,ે જમેાં માેટાં અƖરા,ે નાનાં અƖરાે, નંબરાે અને ખાસ અƖરાે (જમે કે @, 
#, $) નાે સમાવેશ હાયે (અાેછામાં અાેછા 8 અƖરનું). 

o કેટલાક ǐદાતાઅાે પાસવડƙ ફરીથી ટાઇપ કરાવવા કહે છે. 

છે˒ે, “Next” અથવા "Create Account" બટન પર ̚ȃક કરાે. 

પગલું 4: ફાેન નંબરની ચકાસણી (Phone Number Verification) 
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ઘણા ઈમેઇલ સેવાǐદાતા સુરƖાના હેતુસર તમારાે માેબાઇલ નંબર ચકાસવા કહે છે જેની ǐ̋ƿયા નીચે ǐમાણે 
છે: 

 તમારાે ફાેન નંબર દાખલ કરાે: 

તમારાે માેબાઇલ નંબર દાખલ કરાે. અા નંબર તમે તમારાે પાસવડƙ ભૂલી ̀અાે ɔારે અેકાઉɰ પુનઃǐાʏ 
કરવા અથવા ȱારે ગૂગલ/સેવા અાપનારને સંકટજનક ǐવૃ̍ ɇ જણાય ɔારે ઉપયાેગી થાય છે. 

 ચકાસણી કાેડ મેળવાે: 

નંબર દાખલ કયાƙ પછી, સ̍વ̭સ ǐદાતા SMS ɦારા અેક ચકાસણી કાેડ માેકલશે (કેટલાક ̋ક̅ામાં QR 
કાેડ ˱ેન કરવાનું કહે છે). 

 કાેડ દાખલ કરાે: 

ǐાʏ થયેલાે 6 અંકનાે ચકાસણી કાેડ અાપેલા ફીˆમાં દાખલ કરાે અને Verify (ચકાસાે) બટન ̚ȃક 
કરાે. 

પગલું 5: વધારાની મા̋હતી (વકૈ̖ˍક) (Additional Information - Optional) 

કેટલાક ઈમેઇલ સેવાǐદાતા તમારાથી વધારાની મા̋હતી માંગે છે, જમે કે: 

 Recovery Email Address (પુનઃ ǐાʏ કરવા માટેનંુ ઈમેઇલ સરનામું): 
તમા̈́ં બીજંુ ઈમેઇલ સરનામુ ંઅાપાે, જનેાથી તમા̈́ં ખાતું ખાેટા પાસવડƙ કે સુરƖા ચેતવણી સમયે 
પુનઃǐાʏ કરી શકાય. 

 જʆ તારીખ (Date of Birth): 
સેવા ǐદાતા ખાતરી કરવા માગેં છે કે તમે તેમની સેવા માટે યાેƝય વયના છાે કે નહ̯. 

 ̏લ̬ગ (Gender): 
તમે Male (પુ̈́ ષ), Female (˸ી) અથવા Other (અʈ) ̍વકˍ પસંદ કરી શકાે છાે. 

˶ેપ 6: ̏નયમાે અન ેશરતાે ̄ીકારા ે

1. ǐાઈવસી પાે̏લસી અને ટʼƙ અાેફ સ̍વ̭સ વાંચાે: 
ઈમેલ ǐદાતાઅાે તેમના ̏નયમાે અને શરતાે, ગાેપનીયતા ની̍ત અને ઉપયાેગ કરાર દશાƙવશે. કૃપા કરીને 
તનેે ɪાનથી વાંચાે. 

2. ̏નયમાે સાથે સંમ̍ત અાપાે: 
સમીƖા કયાƙ પછી, "I Agree" અથવા "Accept" જવેા બટન પર ̚ȃક કરીને તેમના ̏નયમાે અને 
શરતાેને ̄ીકારાે. 

પગલું 7: તમા̈́ં અેકાઉɰ સેટ કરાે (Set Up Your Account) 
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 ǐાેફાઇલ સેટઅપ (વૈક̖ˍક): 
કેટલીક ઈમેઇલ સેવાઅાે તમને ǐાેફાઇલ ̌પǴર અથવા ̋ડƺʕે નામ સેટ કરવાનાે ̍વકˍ અાપે છે. અા 
પગલંુ પૂણƙપણે વૈક̕ˍક છે; તમે ઇȞાે તાે ̔˱પ પણ કરી શકાે છાે. 

 ક˶માઇઝેશન (વૈક̖ˍક): 

કેટલાક સેવાǐદાતા પૂછે છે કે તમે 2-˶ેપ વે̋ર̋ફકેશન, થીʼ, નાે̋ટ̋ફકેશન વગેરે સƖમ કરવા માંગાે છાે 
કે નહ̯. તમે અા સુ̍ વધાઅાે પછીથી પણ સેટ કરી શકાે છાે. 

 ફાઇનલાઇઝ સેટઅપ: 
ઉપરાેǸ તમામ મા̋હતી ભયાƙ પછી, “Done” અથવા “Finish” પર ̚ȃક કરાે અને તમા̈́ં અેકાઉɰ 
સફળતાપૂવƙક તૈયાર થઈ જશે. 

પગલું 8: તમા̈́ં નવંુ ઈમેઇલ અેકાઉɰ વાપરવાનું શͅ કરાે (Start Using Your New Email 
Account) 

 Inbox Access (ઇનબાેȋ અૅȋેસ): 
હવે તમા̈́ં અેકાઉɰ બʈા પછી, તમે તમા̈́ં ઇનબાેȋ ̀ેઈ શકાે છાે ȱાં તમે નવા સંદેશા મેળવી 
શકાે છાે, વાંચી શકાે છાે અન ે˗વ̗˺ત રાખી શકાે છાે. 

 તમા̈́ં પહેલંુ ઈમેઇલ માેકલાે: 

 Compose અથવા New Message બટન પર ̚ȃક કરાે. 

 To ફીˆમાં ǐાʏકતાƙનંુ ઈમેઇલ સરનામું દાખલ કરાે. 

 તમા̈́ં સદેંશ લખાે અને Send બટન ̚ȃક કરાે. 

પગલું 9: વધારાની સે̋ટ̬Ɲસ (વૈક̖ˍક) (Additional Settings – Optional) 

અેકાઉɰ સેટ કયાƙ પછી, તમે નીચે મુજબની વધારાની સે̋ટ̬Ɲસ પણ કરી શકાે છાે: 

 Email Signature (ઈમેઇલ હƺતાƖર) સેટ કરાે: 

o ઘણા લાેકાે દરેક ઈમેઇલના અંતમા ં

o  ̄ચા̏લત રીતે ઉમેરાતા હƺતાƖર મૂકે છે (જમે કે: "શુભેȞા સાથ,ે રવી"). 

 Display Name (̋ડƺʕે નામ) બદલાે: 

o તમે ઈમેઇલ માેકલતી વખતે તમારા નામને બી̀ યુઝસƙને કેવી રીતે બતાવવંુ તે બદલી શકાે છાે. 

 Email Forwarding અને Filters સેટ કરા:ે 

o કેટલીક ઈમેઇલ સેવાઅાે તમને અાપમેળે મેસે̀ે બી̀ સરનામે માેકલવાની અથવા ચાેǲસ 
માપદંડાે અાધારે ઈમઇેલને ̋ફ˄ર કરવાની સગવડ અાપે છે. 
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નવંુ  ઈમેઈલ અાઈડી બનાવવા માટે સૂચનાે (Tips for Creating a New Email ID): 

 ˗ાવસા̍યક ઈમેઇલ સરનામું પસંદ કરાે: 

o કામ, શાળા કે ˗ાવસા̍યક સંવાદ માટે સરળ અને ˗વસા̍યક યુઝરનામ પસંદ કરા.ે 

 સુરƖા: 

o મજબૂત પાસવડƙ વાપરાે અને Two Factor Authentication સ̋ƿય કરાે. 

 પુનઃǐા̍ʏ ̍વકˍાે: 

o હમેશા પુનઃǐા̍ʏ માટે ફાેન નબંર કે બીજંુ ઈમેઇલ સરનામુ ંઉમેરાે જેથી પાસવડƙ ભૂલી ̀અાે તા ે
અેકાઉɰ પાછંુ મેળવી શકાય. 

3.3 ઈમેલ અǉેે̐સ̬ગ 

 ઈમેલ અેǉેસ અે અેક અનʈ અાેળખ છે જે ઈɰરનેટ ઉપર સંદેશાઅાે માેકલવા અને ǐાʏ કરવા માટે 
ઉપયાેગમાં લેવાય છે. જમે તમારા ઘરનુ ંસરનામું તમને ડાક ɦારા પǋાે માેકલવામાં મદદ કરે છે, તેમ 
તમા̈́ં ઈમેલ અેǉેસ લાેકાે ɦારા તમને ̋ડ̏જટલ સંદેશાઅાે માેકલવા માટે ઉપયાેગી થાય છે. 

 ઈમેલ ǐાʏ કરવા માટે તમા̈́ં પાેતાનું ઈમેલ અેકાઉɰ અને ઈમેલ સરનામું હાેવું જͅરી છે. ̀ ે તમે અʈ 
લાેકાેને ઈમેલ માેકલવા માંગાે છાે, તાે તમારે તેમનું ઈમેલ સરનામું મેળવવંુ પડશે. 

 ઈમેલ સરનામું યાેƝય રીતે કેવી રીતે લખવું તે શીખવું ખૂબ મહɗપૂણƙ છે, કારણ કે ̀ે તમે તેને સાચી 
રીતે દાખલ નહ̯ કરાે તાે તમા̈́ં ઈમેલ પહા̲ચશે નહ̯ અથવા ખાેટા ˗̘Ǹ સુધી પહા̲ચી શકે છે. 

 ઈમેલ સરનામા હંમેશા અેક નǲી ફાેમ̳ટમાં લખવામાં અાવે છે જમેાં યુઝરનેમ, @ (અેટ) ̎ચ̆ અને 
ઈમેલ ǐદાતાનંુ ડાેમેન હાેય છે. 

o યુઝરનેમ: અા અે નામ છે જ ે તમે પાેતાને અાળેખાવવા માટે પસંદ કરા ે છાે. 

 
o ઈમેલ ǐદાતા: અા અે વેબસાઇટ છે જ ેતમા̈́ં ઈમેલ અેકાઉɰ હાે˶  કરે છે. 

 

o કેટલીક વખત ̐બઝનેસ અને સં˺ાઅાે તેમની પાેતાની વેબસાઈટના ડાેમેનવાળા ઈમેલ 
સરનામાનાે ઉપયાેગ કરે છે. 
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અાધારભતૂ ƺતરે, ઈમેલ સરનામા સામાʈ રીતે ǋણ અથવા ચાર ભાગાેથી બનેલા હાયે છે: 

1. યુઝરનેમ 

2. સેપરેટર (̍વભાજક) 

3. ડાેમેન નામ 

4. અને વૈક̕ˍક રીતે ટાેપ-લેવલ નામ 

 

 યુઝરનેમ: અા અે ઇમેલ અેકાઉɰનું નામ છે જ ેઅેકાઉɰ મા̏લક ɦારા બનાવવામાં અાવે છે. ઘણા 
લાેકાે પાેતાનું નામ, તેના ભાગાે અથવા નંબરનાે સંયાેજન ઉપયાેગ કરીને અેકાઉɰનું નામ બનાવે છે. 

 સેપરેટર: અા “અેટ” ̎ચ̆ (@) છે.   
 ડાેમેન નામ: અા અે સવƙરના નામને અાેળખાવે છે ȱાં ઈમેલ સંદેશાઅાે માેકલવામાં અને સંǁહવામાં 

અાવે છે. 
 ટાેપ-લેવલ નામ: અા અે દેશને અાેળખાવે છે જ ેઅા સરનામા સાથે સંકળાયેલાે હાેય છે. કેટલીકવાર 

અા મા̋હતી ઈમેલ સરનામાં સમા̍વˠ નથી હાેતી. 

ઈમેલ સરનામાના ǐકારા ે

ઈમે˔નાે ઉપયાેગ ˗̘Ǹગત તેમજ ˗વસા̍યક હેતુ માટે થઈ શકે છે અને ઉપયાેગના અાધારે ઈમેલ સરનામંુ 
બદલાય શકે છે. ˗ાવસા̍યક ઈમેલ સરનામાઅાેના બે ǐકાર હાેઈ શકે છે: 

 યૂઝર ઈમેલ અેǉેસ: અા તમારા સં˺ાના યુઝર/સદ̃નું ̠ ̘Ǹગત ઈમેલ સરનામું હાયે છે. ઉદાહરણ 
તરીકે: user@domainname.com 

 ǁુપ ઈમેલ અેǉેસ: અા અે સામાʈ ઈમેલ સરનામું છે જ ેઘણી વખત સં˺ાના અનેક સʬાે વȝે 
વહ̲ચાય છે. ઉદાહરણ તરીકે, કાેઈ સં˺ાની માક̳̋ટ̬ગ ટીમમાં ઘણા સʬાે હાઈે શકે છે અને ટીમને 
ઈમેલ માેકલવા માટે marketing@domainname.com જવેા ǁુપ ઈમેલ સરનામંુ બનાવવામાં અાવે 
છે. 

ઈમેલ અǉેેસનાે ફાેમ̳ટ 

ઇમેલ અેǉેસ સામાʈ રીતે અાવું હાેય છે: username@domain.com ચાલાે તેને ̍વગતે સમ͂અે: 

1. યૂઝરનેમ (Username) 

 અા અે ભાગ છે જ ે@ ̎ચ̆ના પહેલેથી અાવે છે. 



 

  
SARDAR PATEL INSTITUTE OF PUBLIC ADMINISTRATION, AHMEDABAD 335 

 

 અા ખાસ યુઝર અથવા અેકાઉɰને અાેળખાવે છે. 
 અામાં અƖરાે, અંકાે, ડાેટ (.), અને અંડર˱ાેર (_) શામેલ હાેઈ શકે છે. ઉદાહરણ: raj123, 

priya.kumar 

2. @ ̎ચ̆ (અેટ સાઇન) 

 યૂઝરનેમ અને ડામેેન નામ વȝેનાે ̍વભાજક છે. 
 તેને "અેટ" તરીકે ઉȝારવામાં અાવ ેછે. 

3. ડાેમેન નામ (Domain Name) 

 અા અે ભાગ છે જે @ પછી અાવે છે. 
 અા ઈમેલ સ̍વ̭સ ǐદાતા (જમે કે Gmail, Yahoo, Outlook)ને અાેળખાવે છે. 
 માેટાભાગે .com, .org, .edu વગરેેથી સમાʏ થાય છે. 

ડાેમેન નામાેના ઉદાહરણાે: 

 gmail.com → Google Mail 
 yahoo.com → Yahoo Mail 
 outlook.com → Microsoft Outlook 

ઈમેલ સરનામાના ઉદાહરણાે: 

 rahul.sharma@gmail.com → Gmail સરનામુ ં
 meena_k@outlook.com → Outlook સરનામું 
 student123@yahoo.com → Yahoo સરનામું 

ઈમેલ અǉેે̐સ̬ગના ̏નયમાે: 

 ઈમેલ સરનામાં ˾ેસ (ખાલી જƝયા) નહ̯ હાેય. 
 તેમાં માǋ અેક જ @ ̎ચ̆ હાેવું ̀ેઈઅે. 
 તેમાં માʈ ડાેમેન હાેવું ̀ેઈઅે (જમે કે gmail.com). 
 ઈમેલ અેǉેસ કેસ-સે̘ ʉ̋ટવ નથી (જમે કે Ravi123@gmail.com અને ravi123@gmail.com અેકજ 

ગણાય છે). 
 ̍વશેષ ̎ચ̆ાે (!, #, $, %, વગેરે) સામાʈ રીતે માʈ નથી, પણ યૂઝરનેમમાં dot (.), underscore (_) 

અને hyphen (-) ની મંજૂરી હાેય છે. 

ઈમેલ ǐાʏકતાƙના ǐકારા ે

ȱારે તમે કાઈે ઈમેલ માેકલાે છાે ɔારે તમે ̍વ̍વધ ફીˆ્સમાં સરનામાં દાખલ કરી શકાે છાે: 

 To: મȕુ ǐાʏકતાƙ/ǐાʏકતાƙઅાે 
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 Cc (Carbon Copy): અʈ લાેકાે જમેણે ઈમેલ ̀ેવું ̀ેઈઅે (બધા ǐાʏકતાƙઅાે અકેબી̀નંુ ઈમેલ 
સરનામું ̀ેઈ શકે છે) 

 Bcc (Blind Carbon Copy): અʈ લાેકાે જમેને ઈમેલ ગુʏ રીતે માેકલવામાં અાવે છે (બી̀ લાેકાે 
તેમનું ઈમેલ સરનામું ̀ેઈ શકતા નથી) 

3.4 ઈમેલ ȃાઈɰને ક̔ʃગર કરવુ ં

ઈમેલ ȃાઈɰ શું છે? 

ઈમેલ ȃાઈɰ અે અેક સાʘેવેર અે̖ ʕકેશન છે જ ેવપરાશકતાƙને પાેતાનું ઈમેલ અૅȋેસ કરવા અને મેનેજ 
કરવા માટે ઉપયાેગી છે (ઈમલે માેકલવા, મેળવવા અને સંǁહવા માટે). ઉદાહરણા:ે 

 Microsoft Outlook 
 Mozilla Thunderbird 
 Apple Mail 
 Windows Mail 
 માેબાઈલ ઈમેલ અેƯસ 

ઈમેલ ȃાઈɰ ક̔ʃગર કરવાની રીત (Gmail અને Outlook નાે ઉદાહરણ ઉપયાગે કરીને) 
ચાલાે Gmail ને Microsoft Outlook માં IMAP ɦારા ક̔ʃગર કરીઅે, જ ેતમારા ઈમે˔ને ̍વ̍વધ ̋ડવાઈસ 
પર સમƮવ̍યત (synced) રાખે છે. 

˶ેપ 1: Gmail માં IMAP અે̖ Ƕવ કરા ે
ક̔ʃગર કરવાની શͅઅાત કરતા પહેલા, તમા̈́ં Gmail સે̋ ટ̬Ɲસમાં IMAP સ̋ƿય છે તનેી ખાતરી કરા:ે 

1. ǒાઉઝર ɦારા તમા̈́ં Gmail ખાતું ખાેલાે. 
2. ̎ગયર (સે̋ટ̬Ɲસ) અાઇકન પર ̚ȃક કરાે > “See all settings” પસંદ કરાે. 
3. “Forwarding and POP/IMAP” ટેબ પર ̀અાે. 
4. IMAP Access હેઠળ “Enable IMAP” પસંદ કરાે. 
5. “Save Changes” પર ̚ȃક કરાે. 

˶ેપ 2: Outlook ખાેલાે અને નવું અેકાઉɰ ઉમેરાે 

1. Microsoft Outlook ખાેલાે. 
2. File > Add Account પર ̚ȃક કરાે. 
3. "Manual setup or additional server types" પસંદ કરાે, પછી Next પર ̚ȃક કરાે. 
4. "POP or IMAP" પસંદ કરાે અને Next પર ̚ȃક કરાે. 

˶ેપ 3: તમા̈́ં Gmail મા̋હતી દાખલ કરા ે

User Information (વપરાશકતાƙની મા̋હતી) 
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• Your Name: તમા̈́ં નામ લખાે જ ેઈમેલમાં દશાƙવા માંગાે છાે. 
• Email Address: ઉદાહરણ તરીકે, yourname@gmail.com 

Server Information (સવƙર મા̋હતી) 

 Account Type: IMAP 
 Incoming Mail Server: imap.gmail.com 
 Outgoing Mail Server (SMTP): smtp.gmail.com 

Login Information (લાે̎ગન મા̋હતી) 

• Username: તમા̈́ં સંપૂણƙ Gmail સરનામું (જમે કે yourname@gmail.com) 
• Password: તમા̈́ં Gmail પાસવડƙ (̀ે તમે 2-˶ેપ વે̋ર̋ફકેશન વાપરાે છાે તાે અેપ પાસવડƙ જͅરી પડશે) 

˶ેપ 4: વધુ સે̋ટ̬Ɲસ (More Settings) 

• More Settings” પર ̚ȃક કરા,ે પછી: 

Outgoing Server ટેબ પર ̀અાે: 

• “My outgoing server (SMTP) requires authentication” ને પસંદ કરાે 
• “Use same settings as my incoming mail server” પસંદ કરાે 

Advanced ટેબ પર ̀અાે: 

• Incoming server (IMAP): 993 
• Use the following type of encrypted connection: SSL 
• Outgoing server (SMTP): 587 
• Use the following type of encrypted connection: TLS 

OK પર ̚ȃક કરાે, પછી Next કરાે. 

˶ેપ 5: ટે˶ અન ેસમા̍ʏ 

• Outlook હવે તમા̈́ં અેકાઉɰ સે̋ટ̬Ɲસનું પરીƖણ કરશે. 
• ̀ે બધુ ંબરાબર હાેય, તાે “Completed” બંને Sending અને Receiving ટે˶ માટે ̀ેવા મળશે. 
• સેટઅપ પણૂƙ કરવા માટે Finish પર ̚ȃક કરાે. 

Common IMAP/SMTP Seƫngs for Gmail 

Seƫng Value 

Incoming Mail (IMAP) imap.gmail.com 

IMAP Port 993 

IMAP EncrypƟon SSL 
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Outgoing Mail (SMTP) smtp.gmail.com 

SMTP Port 587 

SMTP EncrypƟon TLS 

 

Windows 10 માં ઈમેલ ȃાઈɰ સેટઅપ 

Outlook સાથે, જ ે Windows અાેપરે̋ટ̬ગ ̐સ˶મમાં મળૂͅપ ે ઇʊાેલ થયેલ હાેય છે, તમે તમારા ઈમેલ 
અેકાઉɰને સરળતાથી કનǶે કરી શકાે છાે. પહેલા તમારે અા સાેʘવરે ખાેલવું પડશે, “File” પર ̚ȃક કરાે 
અને પછી “Add Account” પસંદ કરાે. 

 

અાગળ જ ે˲ીન ખુલશે તેમાં તમા̈́ં ઈમેલ સરનામું દાખલ કરાે, “Let me set up my account manually” 
અાેƯશન ચેકબાેȋને ચેક કરાે, અને પછી “Connect” બટન પર ̚ȃક કરાે, જમે નીચ ેદશાƙવેલ છે. 
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અહ̯ “IMAP” પસંદ કરાે અને બધા ફીˆ્સ cPanel ના ̏નદ̳શાે અનુસાર યાેƝય રીતે ભરાે. બધંુ પૂ̈́ં થયા 
પછી, “Next” પર ̚ȃક કરાે. 
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હવે તમા̈́ં પાસવડƙ દાખલ કરાે અને કાેન̋ફગરેશન ǐ̋ƿયા પૂણƙ કરવા માટે “Connect” બટન પર ̚ȃક કરાે. 

 

4. ઈમે˔નાે ઉપયાેગ 

અાજના સમયમાં ˗̘Ǹગત, શૈƖ̒ણક કે ˗ાવસા̍યક સદંભƙમાં ઈમેલ સંવાદ માટે સાથૈી વધુ ઉપયાેગ થતી 
ટેકનાેલાે͂ છે. અેકવાર તમે ઈમેલ ȃાઈɰ (અે̖ʕકેશન કે ǐાǁેામ જ ેઈમેલ માેકલવા, ǐાʏ કરવા અને મેનજે 
કરવા માટે વપરાય છે) સાથે કામ કરવાનંુ શીખી ̀અાે, પછી ઈમે˔નાે ઉપયાેગ કરવાે ખૂબ જ સરળ બની 
̀ય છે. 

4.1 ઈમેલ ȃાઈɰ ખાેલવું 

ઈમેલ ȃાઈɰ અે સાેʘવેર અથવા અે̖ʕકેશન છે જનેાે ઉપયાેગ તમે તમા̈́ં ઈમેલ અૅȋેસ કરવા માટે કરા ે
છાે. લાેક̌ǐય ઈમેલ ȃાઈɰાેમાં Microsoft Outlook, Apple Mail, Thunderbird તેમજ વેબ અાધા̋રત 
ȃાઈɰ જેમ કે Gmail, Yahoo Mail અને Outlook.com શામેલ છે. 

તમા̈́ં ઈમેલ ȃાઈɰ ખાેલવા માટે: 

1. ડે˱ટાેપ ȃાઈɰ (જેમ કે Outlook): 

o તમારા ડે˱ટાેપ કે ટા˱બાર પર તેના અાઇકન પર ̚ȃક કરીન ેઅે̖ ʕકેશન ખાેલાે. 
o ̀ે તમે હ͂ સુધી અેકાઉɰ સેટઅપ ન કયુ̫ હાેય, તાે તમારે સેટઅપના પગલાં અનુસરવા પડશે 

(અગાઉ બતાવેલ ઈમેલ ȃાઈɰ સેટઅપ જુઅાે). 

2. વેબ અાધા̋રત ઈમેલ (જેમ કે Gmail): 
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o તમા̈́ં વેબ ǒાઉઝર ખાેલાે (જમે કે Chrome, Firefox વગેરે). 
o તમારા ઈમેલ સેવા ǐદાતા ની વેબસાઈટ પર ̀અાે (જેમ કે www.gmail.com અથવા 

www.outlook.com). 
o તમા̈́ં યુઝરનેમ અને પાસવડƙ નાખીને લાે̎ગન કરાે. 

3. માેબાઈલ ઈમેલ ȃાઈɰ (જેમ કે Android/iOS માટે Gmail અેપ): 

o તમારા ફાેનમાં ઈમેલ અેપ ખાેલાે. 
o ̀ે તમે પહેલે વખત ઉપયાેગ કરી ર̈ા હાેવ, તાે તમારે અેપના સે̋ટ̬Ɲસમાં તમા̈́ં ઈમેલ અેકાઉɰ 

ઉમેરવું પડશે. 

4.2 મેઇલબાેȋ: ઈનબાેȋ અને અાઉટબાેȋ 

તમા̈́ં ઈમેલ ȃાઈɰ ̍વ̍વધ ફાેˆરાે સાથે અાવે છે જ ેતમારા સંદેશાઅાેને ˗વ̗˺ત કરવામાં મદદ કરે છે. 

ઈનબાેȋ (Inbox): 

• ઈનબાȋે અે તે ફાેˆર છે ȱા ંબધા અાવનારા ઈમે˔ ˶ાેર થાય છે. 
• અા મુȕ ફાેˆર છે જમેાં નવી મેઇલ ǐાʏ થાય છે. 
• ̌મǋા,ે પ̋રવારજના,ે સહકમƙચારીઅાે અથવા ʈુઝલેટરાે તરફથી અાવેલા ઈમેલ અહ̯ ̀વેા મળશે. 
• નવી ઇમે˔ boldમાં દશાƙવાય છે અથવા સૂચના (notification) અાપે છે. 

 

અાઉટબાેȋ (Outbox) 

• અાઉટબાેȋ અે ફાેˆર છે ȱાં ઈમે˔ માેકલવામાં અાવે તે પહેલાં તાȿા̏લક ͅપે ˶ાેર થાય છે. 
• ̀ે તમ ેઅાૅફલાઇન હાેવ અથવા ઈમેલ માેકલવામાં કાઈે સમ̃ા હાેય, તાે ઈમેલ અાઉટબાેȋમાં જ 

રહેશે ȱાં સુધી તે સફળતાપૂવƙક માેકલાઈ ન ̀ય. 
• ઈમેલ સફળતાપૂવƙક માેકલાઈ ગયા બાદ તે “Sent” (માેકલેલ ઇમેલ) ફાેˆરમાં ખસેડાઈ ̀ય છે. 

ઉદાહરણ: 

• તમને કાેઈ ઈમેલ તમારા ઈનબાેȋમાં મળે છે. 
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• તમે અેક ઈમેલ લખાે છાે, અને ȱારે તે માેકલાઈ રહી હાેય ɔારે તે અાઉટબાેȋમાં દેખાય છે. 
જમેજ ઈમેલ સફળતાપૂવƙક માેકલાઈ ̀ય, તે “Sent Items” અથવા “Sent Mail” ફાેˆરમાં ̀ેવા 
મળે છે. 

4.3 નવી ઇમેઇલ બનાવવી અને માેકલવી 

નવી ઇમેઇલ બનાવવા અને માેકલવા માટે નીચેના સરળ પગલાં અનુસરાે: 

1. તમા̈́ં ઇમેઇલ ȃાયંટ ખાેલાે: 
Outlook, Gmail વગેરે જવેી ઇમેઇલ અે̖ʕકેશન ખાેલાે. 

2. Compose/Write પર ̚ȃક કરાે: 
માેટાભાગના ઇમેઇલ ȃાયટંમાં “Compose” અથવા “New Message” નામનું બટન હાેય છે (તે 
પેન̐સલ અથવા ̏લફાફાનંુ ̎ચ̆ હાેઈ શકે છે). 

3. ̍વગતાે ભરાે: 

o Recipient(s): જનેે ઇમેઇલ માેકલવી હાેય તેનું ઇમેઇલ સરનામું લખાે. (જેમ કે 
someone@example.com) 

o Subject Line: ઇમેઇલનાે ̍વષય લખાે (જમે કે "Meeting Agenda") 

o Body: ઇમેઇલના મુȕ ભાગમાં તમા̈́ં સંદેશ લખાે.  

4. ફાઈલાે ̀ેડાે (વૈક̖ˍક): 
̀ે જͅરી હાેય તાે તમે ઈમેજ, દƺતાવેજ જવેી ફાઈલાે ̀ેડવા માટે attachment ̎ચ̆ (સામાʈ રીતે 
પેપર̚ȃપ) પર ̚ȃક કરી શકાે છાે. 

5. Send પર ̚ȃક કરાે: 
તમે તમામ મા̋હતી ભરી લીધા પછી, “Send” બટન પર ̚ȃક કરીને ઇમેઇલ માેકલાવાે. 

Gmail ઉદાહરણ: 
Compose પર ̚ȃક કરાે → ǐાʏકતાƙનું ઇમેઇલ સરનામું લખાે → Subject અને Body ભરાે → Send 
પર ̚ȃક કરાે. 
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4.4 ઈમેલ સંદેશનાે જવાબ અાપવાે 
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ȱારે તમે કાેઈ ઈમેલ મેળવા ેછાે, ɔારે તમે માેકલનારને અથવા બધાં ǐાʏકતાƙઅાેને જવાબ અાપી શકાે છા ે
(̀ે ઈમેલમાં અનેક લાેકાે હાયે). 

1. ઈમેલ ખાેલાે: 
• જનેે તમે જવાબ અાપવાે છે અે ઈમેલ સંદેશ પર ̚ȃક કરાે. 

2. Reply પર ̚ȃક કરાે: 
• માેટા ભાગના ઈમેલ ȃાઈɰમાં ઈમેલના ઉપર ભાગે “Reply” બટન હાેય છે. 
• ̀ે તમે ફǸ માેકલનારને જવાબ અાપવાે હાેય, તાે “Reply” પર ̚ȃક કરાે. 
• ̀ે તમે દરેકને જવાબ અાપવાે હાેય (જમે કે ǁુપ સંવાદમા)ં, તાે “Reply All” પર ̚ȃક કરાે. 

3. તમારાે સંદેશ લખાે: 
• અેક નવી ̍વɱાે ખુલી જશે જમેાં મૂળ ઈમેલ દશાƙવાઈ ર̈ંુ હશે. ɔાં તમારા જવાબનાે સંદેશ લખાે. 

4. Send પર ̚ȃક કરાે: 
• ȱારે તમા̈́ં જવાબ લખી લેવાય, ɔારબાદ “Send” બટન પર ̚ȃક કરાે. 

ઉદાહરણ: 
તમે અેક ઈમેલ મેળવાે છાે જમેાં તમારી ઉપલ̘ʤ ̍વશે પૂછવામાં અા˗ું છે. તમે “Reply” પર ̚ȃક કરાે, લખાે 
“હંુ મંગળવારે ઉપલʤ છંુ,” અને “Send” કરાે. 

 

4.5 ઈમેલ સંદેશ અાગળ માેકલવાે (Forward કરવાે) 

ઈમેલ ફાેરવડƙ કરવાથી તમે ǐાʏ કરેલ ઈમેલને કાેઈ બી̀ની સાથે શેર કરી શકાે છાે. અા રીતે કરા:ે 



 

  
SARDAR PATEL INSTITUTE OF PUBLIC ADMINISTRATION, AHMEDABAD 345 

 

1. ઈમેલ ખાેલાે: 
• જ ેઈમેલ તમે ફાેરવડƙ કરવી હાેય તે પર ̚ȃક કરાે. 

2. Forward પર ̚ȃક કરાે: 
• તમારા ઈમેલ ȃાઈɰમાં “Forward” બટન ̀ેવા મળશે (અે “Reply” બટનના ન͂ક હાેઈ શકે છે). 

3. ǐાʏકતાƙનું ઈમેલ લખાે: 
• “To” ફીˆમાં તે ˗̘Ǹનું ઈમેલ સરનામું લખાે જનેે તમે ઈમેલ માેકલવા માંગાે છાે. 

4. વૈક̖ˍક: 
• તમે forwarded ઈમેલના ઉપર પાેતાનાે સંદેશ ઉમેરી શકાે છાે અથવા મૂળ ઈમેલમાંથી અનાવƸયક 
મા̋હતી કાઢી શકાે છાે. 

5. Send પર ̚ȃક કરાે: 
• બધંુ તૈયાર થયા પછી “Send” બટન પર ̚ȃક કરાે. 

ઉદાહરણ: 
તમે HR તરફથી અેક મહɗપણૂƙ સૂચના મેળવાે છાે અને તમા̈́ં ટીમ તે ̀ણવા ̀ેઇઅે. તમે “Forward” પર 
̚ȃક કરા,ે તેમની ઈમેલ અાઈડીઅાે લખાે અને “Send” કરાે. 

 

 

4.6 ઇમેઇલને ગાેઠવવી અને શાેધવી 
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દૈ̏ નક ઘણા ઇમેઇલ મળતાં હાેવાથી, તમારાં સંદેશાઅાેને યાƝેય રીતે ગાેઠવવા અને ચાǲેસ ઈમેઇલ શાેધવાની 
Ɩમતા હાેવી મહɗપૂણƙ છે. 

ઇમેઇલ ગાેઠવવી (Sorting Emails) 

માેટાભાગના ઇમઇેલ ȃાયટંમાં ઇમઇેલને ̍વ̍વધ માપદંડાે પર ગાેઠવવાની સુ̍ વધા હાયે છે: 

 તારીખ ǐમાણ ે(By Date): નવીમાથી જૂની કે જૂનીથી નવી અેવી ƿમમાં ઇમઇેલ ગાેઠવી શકાય છે. 

 માેકલનાર મુજબ (By Sender): ચાǲેસ માેકલનારના સદંેશાઅાે દશાƙવા માટે ગાેઠવશા.ે 

 ̍વષય મુજબ (By Subject): ઈમેઇલના ̍વષયના અાધારે ગાેઠવણી કરા.ે 

ઇમેઇલ શાેધવી (Searching for Emails) 

̀ે તમે કાઈે ચાǲેસ ઈમેઇલ શાેધી ર̈ા હાેવ, તાે શાેધ બાર (Search bar) નાે ઉપયાેગ કરાે: 

1. કીવડƙ લખાે: માેકલનારનું નામ, ̍વષય કે ઈમેઇલના અશં જવેા શʣાે ટાઇપ કરાે. 

2. ̋ફ˄રાે: ઘણા ઇમેઇલ ȃાયંટમાં તારીખ, માેકલનાર અથવા ̀ ેડાણ મુજબ પ̋રણામાે ̋ ફ˄ર કરવાની 
સુ̍ વધા હાેય છે. 

ઉદાહરણ - Gmail માં: 

 ઉપરના શાેધ બારમાં “Meeting agenda” લખાે, અને Gmail તે શʣાે ધરાવતી તમામ ઇમેઇ˔ 
બતાવશ.ે 

 

Gmail માં અૅડવાʉ સચƙ (Advanced Search): 
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 શાેધ બારમાં નીચેની બાજુ તીણું તીર (downward arrow) ̚ȃક કરાે, ȱાં તમે ચાǲેસ તારીખની 
Ǘેણી, ̀ેડાણવાળા ઇમેઇલ વગેરે ǐમાણે શાેધી શકાે છા.ે 

5. અેડવાʉ ઈમેલ ફીચસƙ 

મૂળભૂત ઈમેલ ફંȆʉ ̐સવાય, અાધુ̏નક ઈમેલ સેવાઅાેમાં કેટલીક અેડવાʉ સુ̍વધાઅાે હાેય છે જે 
વપરાશકતાƙઅાેને વધુ સારાે અનુભવ અને કાયƙƖમતા ǐદાન કરે છે. 

5.1 દƺતાવેજ ઈમેલ ɦારા માેકલવાે 

ઈમેલ ɦારા દƺતાવેજ માેકલવા ેઅે ફાઈલાે શેર કરવાનાે સાૈથી સામાʈ રƺતાે છે. તમે ̍વ̍વધ ǐકારના દƺતાવે̀ે 
(Word, Excel, PDF વગેરે) સરળતાથી તમારા ઈમેલમાં ̀ેડીને ǐાʏકતાƙને માેકલી શકાે છાે. 

ઈમેલ ɦારા દƺતાવજે કેવી રીતે માેકલવાે: 

1. નવંુ ઈમેલ બનાવાે: 

o તમા̈́ં ઈમેલ ȃાયɰ ખાેલા ે(જેમ કે Gmail, Outlook, Yahoo Mail). 

o "Compose" અથવા "New Email" પર ̚ȃક કરાે. 

2. દƺતાવેજ ̀ેડાે: 

o અેટેચમɰે અાઇકાેન (સામાʈ રીતે ̚ȃપનું ̎ચ̆) શાેધાે. 

o ̚ȃક કરીને તમારી ફાઈલ ǒાઉઝર ખાેલાે. 

o તમારા કƳʔુટરમાંથી દƺતાવજે પસંદ કરાે (જમે કે Word ફાઈલ, PDF, Excel ફાઈલ). 

o ફાઈલ અેટેચમેɰ તરીકે અપલાેડ થશે. 

3. પૂણƙ કરાે અને માેકલાે: 

o તમા̈́ં ઈમેલ મેસેજ સામાʈ રીતે લખાે. 

o દƺતાવેજ ̀ેȻા પછી "Send" બટન પર ̚ȃક કરા.ે 

ઉદાહરણ: 
તમારે તમારા મેનેજરને અેક ̋રપાેટƙ (Word દƺતાવેજ) માેકલવાે છે. તમે ̚ȃપ અાઇકાેન પર ̚ȃક કરાે છાે, 
̋રપાેટƙ દƺતાવેજ પસંદ કરાે છાે અને મેસેજ બાેડીમાં “અા મહીનાનંુ ̋રપાેટƙ અહ̯ છે” લખી તેને માેકલશાે. 

5.2 ˾ેલ ચે̋ક̬ગ સ̋ƿય કરવી (Activating Spell Checking) 

˾ેલ ચે̋ક̬ગ તમારી ઇમેઇ˔ને ˗ાવસા̍યક અને ભૂલમુǸ બનાવવામાં મદદ કરે છે, કારણ કે તે અાપમેળે 
ખાેટા લખાયેલા શʣાેને અાેળખી લે છે. માટેાભાગના અાધુ̏નક ઇમેઇલ ȃાયɰમાં ̐બ˄-ઇન ˾ેલ ચેકર 
હાેય છે, પરંતુ કેટલાકમાં અા ફીચર સ̋ƿય કરવું પડે છે. 
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˾ેલ ચેક કેવી રીતે સ̋ƿય કરવી: 

1. Gmail: 
o Gmailમાં ˾ેલ ચેક સામાʈ રીતે મૂળભૂત ͅપે સ̋ƿય હાેય છે. 
o તપાસવા માટે, Settings (̎ગયર અાઇકાેન) પર ̚ȃક કરાે > See all settings > General. 
o ખાતરી કરાે કે "Spell check" સ̋ƿય છે. 
o ̀ે કાેઈ શʣ ખાેટાે લખાયાે હાેય તાે તે નીચે લાલ રેખા દેખાશે. તેને સુધારવા માટે Right-click કરાે. 

2. Outlook: 
o Outlook ખાેલાે. 
o File > Options > Mail પર ̀અાે. 
o Spelling and Autocorrect સુધી ˲ાેલ કરાે અને Spelling Options ̚ȃક કરાે. 
o "Check spelling as you type" પસંદ થયેલ છે તેની ખાતરી કરાે. 

Manual Spell Check: 
ઇમેઇલ ȃાયɰમાં F7 દબાવીને અથવા Right-click મેનૂમાં "Spelling" ̍વકˍ પસંદ કરીને તમે મેʈુઅલી 
˾ેલ ચેક શͅ કરી શકાે છાે. 

5.3 અǉેેસ બુકનાે ઉપયાેગ (Using Address Book) 

અǉેેસ બુક (કે જનેે Contacts List પણ કહે છે) અે લાેકાેના ઇમેઇલ સરનામા અને સંપકƙની મા̋હતી સંǁહે 
છે, જનેે તમે વારંવાર ઇમેઇલ કરાે છાે. અા ફીચર તમને દરેક વાર ઇમેઇલ સરનામું યાદ રાȕા ̍વના ઝડપથી 
ઇમેઇલ માેકલવામાં મદદ કરે છે. 

અǉેેસ બુકનાે ઉપયાેગ કેવી રીતે કરવાે: 

1. Contacts ઉમેરાે: 
o Gmail: 
o Google Apps ઉપર જમણા ખૂણે 3 ડાેટ્સ ̚ȃક કરા ે> Contacts પસંદ કરાે. 
o Create Contact પર ̚ȃક કરીને નવું ઇમેઇલ સરનામું ઉમેરાે. 
o Outlook: અેપ ખાેલા,ે People (અથવા Contacts) માં ̀અાે અને New Contact પસંદ કરાે. 
o Yahoo Mail: Contacts બટન (ઉપર જમણે) ̚ȃક કરાે > New Contact પસંદ કરાે. 

2. Contact ને ઇમેઇલ માેકલવી: 
o નવી ઇમેઇલ લખતી વખતે, Address Bookમાં સેવ કરેલા સંપકƙનું નામ અથવા ઇમઇેલ સરનામું 
ટાઇપ કરવાનું શͅ કરાે. 
o ઇમેઇલ ȃાયɰ અાપમેળે સરનામું પૂͅં કરશ,ે જનેા કારણે સમય બચશે. 

3. Contacts ના જૂથ બનાવાે: 
o કેટલાક ઇમેઇલ ȃાયɰ્સ તમને Contactsના ǁુપ બનાવવા દે છે (જમે કે "Team" અથવા 
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"Family"). 
o ȱારે તમે ǁુપનું નામ લખાે છાે, ɔારે ઇમેઇલ ̄ચા̏લત રીતે ǁુપના તમામ સʬાેને માેકલાય છે. 

 

 

5.4 સાʘેકાૅપીને અેટેચમેɰ તરીકે માેકલવી (Sending Softcopy as Attachment)  

સાેʘકાૅપી (̋ડ͂ટલ દƺતાવેજ અથવા ફાઇલ)ને અેટેચમɰે તરીકે માેકલવી અે ફાઇલ શેર કરવાનાે સાૈથી 
સામાʈ અને સરળ રીતાે પૈકી અેક છે. તમેાં દƺતાવે̀,ે છબીઅાે, ̍વ̋ડઅાેઝ અને અʈ ǐકારની ફાઇલાેનાે 
સમાવેશ થાય છે. 

સાેʘકાૅપી માેકલવાની રીત: 

1. નવી ઇમેઇલ લખાે: 
o તમા̈́ં ઇમઇેલ ȃાયɰ ખાેલાે (જવેી કે Gmail, Outlook, અથવા Yahoo Mail). 
o Compose પર ̚ȃક કરાે અને નવી ઇમેઇલ શͅ કરાે. 

2. સાેʘકાૅપી અેટેચ કરાે: 
o Attachment બટન (સામાʈ રીતે પેપર̚ȃપ ની ̏નશાની) પર ̚ȃક કરા.ે 
o તમારી ફાઇલ ǒાઉઝ કરાે અને જ ેફાઇલ માેકલવી છે તે પસંદ કરાે (જમે કે PDF અથવા Word 
દƺતાવેજ). 
o ફાઇલ અેટેચમેɰ તરીકે અપલાેડ થશે અને સામાʈ રીતે Subject લાઇનની નીચે દેખાશે. 

3. ઇમેઇલ માેકલાે: 
o સાેʘકાૅપી અેટેચ કયાƙ પછી તમા̈́ં ઇમેઇલ લખાે અન ેSend બટન ̚ȃક કરાે. 

ઉદાહરણ: 
તમે ǐાેજǶે માટેનું PDF દƺતાવેજ માેકલવંુ છે. તમે ઇમેઇલમાં તે ફાઇલ અેટેચ કરાે છાે અને તમારા 
સહકમƙચારીને માેકલાે છાે. 

 ˾ામ મેલનું મેનેજમેɰ (Manage SPAM Mail) 

˾ામ મેલ (કે જેને જંક મેલ પણ કહે છે) અે અ̏નȞનીય અને ઘણી વખત અમાʈ ઇમેઇ˔ હાેય છે, જે 
તમારા ઇનબાેȋને ભરાવી દે છે. માેટાભાગના ઇમેઇલ ȃાયɰમાં અાપમેળે ˾ામ ̋ફ˄ર હાેય છે, પણ તમારે 
પણ કેટલીક બાબતાેનું ɪાન રાખવું ̀ેઈઅે. 

5.5 ˾ામ મેલ મેનેજ કરવા માટેની રીત: 

1. ઇમેઇલને ˾ામ તરીકે ̎ચ̋̆ત કરાે: 
o ȱારે તમે ˾ામ મેલ મેળવાે, ɔારે તેને ˾ામ અથવા જંક તરીકે ̎ચ̋̆ત કરા.ે 
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o Gmail: ઇમેઇલ ખાેલાે અને Report Spam બટન ̚ȃક કરાે. 
o Outlook: ઇમેઇલ પસંદ કરાે > Junk બટન > Block Sender ̚ȃક કરાે. 

2. ˾ામ ̋ફ˄રનાે ઉપયાેગ કરાે: 
o Gmail: Google અાપમેળે ˾ામ ઇમેઇલને અાેળખે છે, પણ તમે ક˶મ ̋ફ˄સƙ પણ બનાવી શકાે 
છાે. Settings > Filters and Blocked Addresses > Create a new filter. 
o Outlook: Home > Junk > Junk E-mail Options > filtering level પસંદ કરાે. 

3. ʈૂઝલેટરથી અનસબ˲ાઇબ કરાે: 
o ̀ે તમને કાેઈ ʈૂઝલેટર અથવા ǐમાેશનલ ઇમેઇ˔ મળે છે અને તમે તે નથી ઈȞતા, તાે ઇમેઇલના 
નીચે અાપેલી "Unsubscribe" ̏લ̬ક પર ̚ȃક કરાે. 
o અાથી ભ̍વˮમાં તે માેકલનાર પાસેથી ઇમેઇલ મળવાનુ ંબંધ થઈ જશે. 

4. Spam Folder ચેક કરાે: 
o સમયાંતરે તમારા Spam અથવા Junk ફાેˆર ચકાસાે, કદાચ કાેઈ મહɗપૂણƙ ઇમેઇલ ɔાં ગયાે હાેય. 
o ̀ે તમે ɔાં કાેઈ મહɗપૂણƙ ઇમેઇલ જુઅાે, તાે તેને "Not Spam" તરીકે માકƙ  કરાે. 

6. તાȿા̏લક સંદેશા˗વહાર અને સહયાેગ (Instant Messaging and 
Collaboration) 

તાȿા̏લક સંદેશા˗વહાર (Instant Messaging - IM) ̠ ̘Ǹગત તેમજ ̠ ાવસા̍યક વાતચીત માટે અાજના 
સમયમાં અɔંત મહɗપૂણƙ સાધન બની ગયંુ છે. IM વપરાશકતાƙઅાેને ઇɰરનેટ ɦારા તરત જ લે̑ખત સંદેશા 
માેકલવા, ફાઇલાે શેર કરવા અને તુરંત સહયાેગ અાપવા માટે સƖમ બનાવે છે. 

અા ̍વભાગમાં અાપણે ́ાઈલી (ઇમાે̋ટકાʉૅ) ના ે ઉપયાેગ અને ઇɰરનેટ ̏શˠાચાર (Internet 
Etiquettes) અંગે વાત કરીશું જ ે અાેનલાઇન સંચારના અેવા મહɗપૂણƙ પાસાં છે જ ે વાતચીતને વધુ 
અાનંદદાયક અને ˗ાવસા̍યક બનાવે છે." 

6.1 ́ાઈલીનાે ઉપયાેગ (Using Smiley) 

́ાઈલી ચહેરા, જનેે ઇમાે̋ટકાેન અથવા ઈમાે͂ તરીકે પણ અાેળખવામાં અાવ ેછે, અે ǁા̋ફકલ ̎ચ̆ાે છે જ ે
અાેનલાઇન વાતચીતમાં લાગણીઅા,ે ǐ̍તસાદાે અને ભાવનાઅાે ˗Ǹ કરવા માટે ઉપયાેગમાં લેવાય છે. ટેȌ 
અાધા̋રત સંચારમાં ȱાં શરીરભાષા અથવા અવાજના તાલના અભાવને કારણે ભાવનાઅાે ˾ˠ થતી નથી, 
ɔાં ́ાઈલી સંદેશાને લાગણીસભર અને અથƙપણૂƙ બનાવે છે. 

́ાઈલી અને ઇમાે̋ટકાેન શું છે? 

• ઇમાે̋ટકાેન (Emoticons): 
અા લખાણના અƖરાેના સંયાેજન હાેય છે જે ચહેરાની ભાવભાવનાઅાે દશાƙવે છે. ઉદાહરણ તરીકે: 

  ϠϡϢ અથવા :-) → ખુશ કે ̖́ત ભયુ̫ ચહે̈́ં 
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  ϜϝϞ અથવા :-( → દુઃખી કે ઉદાસ ચહે̈́ં 

  ◝◞◟◠◡ → માેટંુ ̖́ત અથવા હસવું 

  ΠΡ΢ΣΤ → રમૂ͂  કે ͂ભ બહાર કાઢેલાે ચહેરાે 

  ͧͪͩͨ → અાંખ મારતાે ચહેરાે 

ઇમાે͂ (Emoji): 
અા નાનાં ̋ડ̏જટલ ̎ચǋાે કે ̎ચ̆ાે હાેય છે જ ે̍વચારાે, ભાવનાઅાે અથવા વƺતુઅાે રજૂ કરે છે. ઇમાે͂  ટેȌ 
કરતાં વધુ ͂વંત રીતે લાગણીઅાે ˗Ǹ કરે છે. ઉદાહરણ તરીકે: ́ાઈલી  সহ঺঻ અથવા થʼ અપ  ڒڑڐ. 

ઇમાે̋ટકાેન અને ઇમાે͂ Ȃા સં̀ેગાેમાં વાપરવા? 

• સામાʈ વાતચીતમાં: 
̌મǋા,ે કુટંુબ કે સાે̏શયલ ̌મ̋ડયા જવેી અનાૈપચા̋રક વાતચીતમાં ઇમાે̋ટકાેનનાે ઉપયાગે ખુશી, દુઃખ, ઉɘાહ 
વગરેે ˗Ǹ કરવા માટે થાય છે. 

• ˗ાવસા̍યક વાતચીતમાં: 
કેટલીક કંપનીઅાે ટીમ ચેટ્સ (Slack, Microsoft Teams જવેી) માં સાૈʸ વાતચીત માટે ઇમાે͂ નાે ઉપયાેગ 
કરે છે. ̀ેકે, અાૈપચા̋રક વાતચીતમાં તેનાે વાજબી અને સયં̌મત ઉપયાેગ જͅરી છે જથેી ˗વસા̍યકતા 
જળવાય. 

́ાઈલી અને ઇમાે͂ કેવી રીતે વાપરશાે? 

1. ટેȌમાં (ઇમાે̋ટકાેન): 
તમે સીધા ટેȌ ટાઈપ કરીને ઇમાે̋ટકાેન બનાવી શકાે છાે. જમે કે :) લખતા જ, માેટા ભાગે તે ́ાઈલી 
ચહેરામાં ફેરવાઈ ̀ય છે. 

2. ઈમાે͂નાે ઉપયાેગ: 

 ́ાટƙફાેનમા,ં કીબાેડƙમાં ઈમાે͂  અાયકન પર ટૅપ કરીને ઈમાે͂ પસંદ કરી શકાય છે. 

 કƳʔુટરમાં Windows + ; (સેમીકાેલન) દબાવાે અથવા Mac માં Command + Control + 
Space દબાવાે – ઈમાે͂  પીકર ખુલશે. 

 Slack, WhatsApp, Facebook Messenger જવેી અે̖ ʕકેશʉમાં પણ સીધા ઈમાે͂  પસંદ કરી 
શકાય છે. 

સામાʈ ઉદાહરણાે: 

 ખુશ/́ાઈ̏લ̬ગ: :)  সহ঺঻ 

 ઉદાસ/દુઃખી: :(  γδεζ 
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 અાંખ મારતા:ે ;)  ΦΧΨΩΪΫ 

 હસવું: :D  ●◐◑◒◓◔◕ 

 ગુ̅ ે ભયા̳: >:(  ρςστ 

 અા˛યƙ: :O  ➫➬➭ 

ના̲ધ: ̍વશેષͅપ ે અાૈપચા̋રક વાતચીતમાં ઇમાે̋ટકાેન અથવા ઈમાે͂નાે વધુ ઉપયાેગ ટાળવાે યાેƝય રહે છે, 
કારણ કે તે અ˗ાવસા̍યક લાગવા લાગે. શʣાેનાે સંપૂણƙ અથƙ ઠેકાણે રહે અને સંદેશ ˾ˠ રહે અે માટે ઈમાે͂  
માǋ સહાયક તરીકે ઉપયાેગ કરાે. 

6.2 ઈɰરનેટ ̐શƺત (Internet Etiquettes / Netiquette) 

ઇɰરનેટ ̏શƺત (ને̋ટકેટ) અે અાેનલાઈન વાતચીત દરʸાન યાેƝય અને અાદરપૂવƙક વતƙન કરવા માટેના 
̏નયમાે અને સામા̏જક માપદંડાેનાે સમૂહ છે. જમે અાપણે સામસામે વાત કરતી વખતે ̏શƺતભયુ̫ વતƙન કરીઅે 
છીઅ,ે તેમ અાેનલાઇન વાતચીતમાં પણ ̏શˠતા, ˾ˠતા અને ̍વચારપૂણƙતા ̀ળવવી જͅરી છે.                           
અહ̯ ઈɰરનેટ ̏શƺત માટેના મુȕ ̏નયમાે અને Ǘેˤ રીત દશાƙવવામાં અાવે છે: 

1. ˾ˠ અન ેસં̐Ɩʏ રહા ે
• તમારાે સંદેશ ટંૂકાે અને મુɠાસર હાેવાે ̀ેઈઅે. અાેનલાઇન વાંચન વખતે ˾ˠતા વધુ અસરકારક બને છે. 
• અǐયાેજક કે જ̋ટલ ભાષાનાે ટાળાે. સરળ અને સીધી ભાષા Ǘેˤ હાેય છે. 

2. અાૈપચા̋રક સંવાદમાં ˗ાવસા̍યક ભાષાનાે ઉપયાેગ કરાે 
• ઇમેઇલ કે કાયƙ સંબં̍ ધત સદેંશ માેકલતી વખતે ˗ાવસા̍યક ભાષાનાે ઉપયાેગ કરા,ે અ̏શˠ શʣાેનાે ટાળાે 
અને યાેƝય ˗ાકરણ તથા ̍વરામ̎ચ̆ાે વાપરાે. 
• સંવાદની શͅઅાત સાૈʸ અ̑ભવાદનથી કરાે ("Hello [Name]") અને અંતમાં નǔ વાȂથી પૂણƙ કરાે 
("Best regards", "Sincerely"). 

3. ALL CAPS નાે ઉપયાેગ ટાળાે 
• CAPITAL LETTERS માં લખવું અેટલે ઊંચા અવાજ ેબાેલવા જેટલું લાગ ેછે, જ ે̈́Ɩ કે અાƿમક લાગી શકે 
છે. 
• ખાસ ભાર અાપવા માટે કે̓ʱટલનાે ઉપયાેગ કરાે પણ સામાʈ સંવાદ માટે ટાળાે. 

4. હા̃ અને ̍વવાદા˾દ ̋ટʑણીઅાેથી બચા ે
• લખાણમાં હા̃ સમ̀વવામાં મુƸકેલ હાેય છે, ખાસ કરીને અ̀Ʃયા લાેકાે સાથે વાત કરતી વખતે. તમારાે 
̀ેકસ બી̀ને ખાેટંુ લાગવાથી ગેરસમજ થઈ શકે છે. 
• ̋ટʑણીઅાે (સાકાƙઝમ)થી પણ સાવચેત રહાે, કારણ કે અવાજ કે હાવભાવ વગર તેનાે અથƙ ખાેટાે લાગી 
શકે છે. 

5. બી̀ની ગાપેનીયતા સʆાનવાે 
• બી̀ની ˗̘Ǹગત કે ગુʏ મા̋હતી તેમની પરવાનગી ̍વના શેર ન કરાે જેમ કે ǁુપ ચેટ અથવા ઇમેઇલમાં 



 

  
SARDAR PATEL INSTITUTE OF PUBLIC ADMINISTRATION, AHMEDABAD 353 

 

પણ નહ̯. 
• કાેઈ બી̀ની ઈમેઇલ મા̋હતી શેર કરતા પહેલાં તેમની મંજૂરી મેળવવી જͅરી છે. 

6. તમા̈́ં ભાષા ǐમાણ અન ેભાષાનાે ̄ર ɪાનમાં લાે 
• ટેȌમાં ̄ર સમ̀વવાે મુƸકેલ હાેય છે. 
• ઇમાે̋ટકાેન કે યાેƝય ̍વરામ̎ચ̆ાેનાે ઉપયાેગ કરીને ભાવ ˗Ǹ કરાે, જથેી બી̀ને સાચાે અથƙ સમ̀ય. 
ઉદાહરણ: “I’m not sure about that” ની સાથે  ϠϡϢ ઉમેરવાથી તે વધુ નǔ લાગ ેછે. 

7. ˾ેમ ન માેકલાે 
• ˾ેમ અેટલે અનચાહેલા અથવા નકામા સંદેશાઅાેનાે માેટા પાયે માેકલવા. અાવું વતƙન અ̏શˠ અને 
અ˗ાવસા̍યક ગણાય છે. 
• ̀ે કાેઈને ǐમાેશનલ સામǁી માેકલવી હાેય તાે તેમની સહમ̍ત અને સંબં̍ ધતતા હાવેી ̀ેઈઅે. 

8. જͅર કરતાં વધુ મા̋હતી  ન અાપા ે
• અɔંત ˗̘Ǹગત અથવા સંબં̍ધત ન હાેય તેવી મા̋હતી સંવાદને ̐બનજͅરી બનાવી શકે છે. 
• વાતચીત હંમેશાં ̍વષયસર રાખાે. 

9. માેકલતાં પહેલાં વાંચી તપાસાે 
• સંદેશ માેકલતાં પહેલાં હમેશાં ˾ે̏લ̬ગ અને ˗ાકરણ તપાસાે, ખાસ કરીને ˗ાવસા̍યક વાતચીતમાં. 
• ઘણાં ઇમેઇલ કે મેસે̏જ̬ગ ʕેટફાેમƙમાં ̐બ˄-ઇન ˾ેલચેકર હાેય છે. 

10. સમયસર જવાબ અાપા ે
• સમયસર જવાબ અાપવાે ̏શˠાચાર માનવામાં અાવે છે. સામાʈ રીતે 24 થી 48 કલાકની અંદર જવાબ 
અપવાની અપેƖા હાેય છે. 
• ̀ે તરત જવાબ અાપી શકતા ન હાેવ, તાે જણાવી દાે કે Ȃારે અાપશાે. 

ઇɰરનેટ ̐શƺતના ઉદાહરણાે: 

1. નǔ અ̐ભવાદન અને અંત: 

 ખરાબ ઉદાહરણ: “Hey, I need that report by noon. Thanks.” 

 સાͅ ઉદાહરણ: “Dear John, I hope you're doing well. Could you kindly send me the 
report by noon? Thank you so much for your help. Best regards, [Your Name].” 

2. ALL CAPS ટાળવું: 

 ખરાબ ઉદાહરણ: “URGENT! NEED THE DOCUMENT NOW!” 

 સાͅ ઉદાહરણ: “Hi, I hope you’re well. Could you please send me the document 
when you get a chance? Thanks!” 

3. ˾ˠ અને સં̐Ɩʏ લખાણ: 
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 ખરાબ ઉદાહરણ: “Hey, do you have it? Need it soon for the project. I don’t have 
much time.” 

 સાͅ ઉદાહરણ: “Hello [Name], could you please send me the updated project file 
by 3 PM today? I need it for the final review. Thank you!” 

7. ˱ેનર સાેʘવેર વપરાશ / સહકાર પર મા̋હતી 

˱ેનર સાેʘવેર સહકાર વધારવામાં મહɗપૂણƙ ભૂ̌ મકા ભજવે છે, ખાસ કરીને ̐બઝનેસ વાતાવરણમાં ȱા ં
દƺતાવે̀ે અનેક લાેકાે ɦારા શેર અથવા અે̋ડટ કરવાની જͅર હાેય છે. અહ̯ ˱ેનર સાેʘવેર અને સહકાર 
સાધનાે કેવી રીતે સાથે કાયƙ કરે છે તે દશાƙવવું છે: 

1. દƺતાવે̀ેને ̋રયલ-ટાઇમમાં ˱ેન અને શેર કરવું 

• દƺતાવેજને ˱ ેન કયાƙ પછી, તેને તાȿા̏લક ઈમેઈલ અથવા ȃાઉડ ˶ ાેરેજ સેવાઅાે (જેમ કે Google 
Drive, OneDrive, Dropbox) ɦારા સહકમ̰અાે સાથે શરે કરી શકાે છાે. 

• ઘણાં ˱ેનર સાેʘવેર ǐાેǁાʼ ȃાઉડ ̐સ̬ƿનાઈઝેશન સુ̍વધાઅાે ǐદાન કરે છે, જ ે દƺતાવે̀ેને 
અાપાેઅાપ શેર કરેલા વકƙ˾ેસમાં અપલાેડ કરવામાં મદદ કરે છે. 

2. સહકારી સાધનાે સાથે સંકલન 

• ઘણાં ̐બઝનેસ Slack, Microsoft Teams, અથવા Google Workspace જવેા સહકાર સાધના ે
ઉપયાેગ કરે છે તાȿા̏લક સંચાર માટે. સંક̏લત ˱ેનર સાેʘવેર સાથ,ે ˱ેન કરેલા દƺતાવે̀ે અા 
ʕેટફાે̓ ƙ પર સીધા ˱ેનર સાેʘવેરમાંથી અપલાેડ કરી શકાય છે. 

• ઉદાહરણ તરીકે, ̀ે ટીમના અેક સʬે કરાર ˱ેન કયા̳ છે, તાે તે Teams ચેનલમાં શેર કરી શકે છે 
ȱાં અʈ ટીમના સʬાે ̋ટʑણી કરી શકે છે, સમીƖા કરી શકે છે અને ફેરફારની સલાહ અાપી શકે 
છે. 

3. OCR અને અે̋ડ̋ટ̬ગ માટે ટીમનાે સહકાર 

• OCR સુ̍ વધાઅાેનાે ઉપયાેગ કરીને, ˱ેન કરેલા દƺતાવે̀ ેઅે̋ડટેબલ ટેȌમાં ͅપાંત̋રત કરી શકાય 
છે. અા ટીમાેને દƺતાવે̀ે પર સહકા̋રત રીતે કાયƙ કરવામાં સરળ બનાવે છે, અેવામાં તે ̋ફ̏ઝકલ ફાેમƙ 
તરીકે શͅ થાય છે. ઉદાહરણ તરીકે, ˱ેન કરેલી મી̋ટ̬ગ અેજɱાને OCR પછી શેર કરેલ Google 
Docમાં અનેક લાેકાે ɦારા અે̋ડટ કરી શકાય છે. 

4. ̋ડ̏જટલ સહી 
˱ેન કરેલા દƺતાવે̀ેને સહીની જͅર હાેય તાે, ડાેȂુસાઇન અથવા અેડાેબ સાઇન જેવા સાધનાે ɦારા 
ઇલƛેǇાે̏ નક સહી માટે સરળતાથી શેર કરી શકાય છે. અા સાધનાેની મદદથી ઘણા લાેકાે દƺતાવેજ પર 
સહી કરી શકે છે, ̌ǐɰ અને ̋ફ̏ઝકલ સહી કરવાની જͅર કયાƙ ̍વના. 

5. સં˱ રણ ̏નયંǋણ અને દƺતાવેજ ˗વ˺ાપન 
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ȃાઉડ ˶ારેેજ અને દƺતાવેજ ˗વ˺ાપન સાધનાે (જમે કે SharePoint, Google Drive) સાથે 
સંક̏લત કરવું, જ ે ǐɔેક ˗̘Ǹને દƺતાવેજના તા̀ સં˱રણ સાથે કાયƙ કરવામાં સુ̏ન̏˛ત કરે છે. 
˱ેન કરેલ ફાઇલાે અાપાેઅાપ જ ેતે ફાેˆસƙમાં સǁં̋હત થઈ શકે છે, સંબં̍ધત મેટાડેટા (જમે કે દƺતાવેજનાે 
ǐકાર, ǐાેજǶે) સાથે ટૅગ કરી શકાય છે અને તાȿા̏લક અૅȋેસ અને અે̋ડ̋ટ̬ગ માટે ઉપલʤ કરાવી 
શકાય છે. 

8. સારાંશ 

સંચાર અને સહકાર" પર અાધા̋રત અા અેકમ  સચાેટ રીતે સમ̀વે છે કે કેવી રીતે ̋ડ̏જટલ સંચાર સાધનાે 
જમે કે ઈમેઈલ અને તાȿા̏લક સંદેશા˗વહાર ˗̘Ǹગત અને ˗ાવસા̍યક પ̋રǐેƽયાેમાં સંલȘતા અને 
સહકારને ǐભા̍વત કરે છે. અામાં ઈમઈેલ વપરાશના મળૂ ̐સɡાંતા,ે અેકાઉɰ બનાવવું, સંદેશાઅાે માેકલવા 
અને ǐાʏ કરવાનાે સમાવેશ થાય છે, અને અેડવાʉ ફીચસƙ જમે કે અેટેચમેɰ, ˾ેલ ચેક અને ˾ામ 
મેનેજમેɰ. તેમજ તાȿા̏લક સંદેશા˗વહાર ɦારા સહકાર, યાેƝય ને̋ટકેટ અને કેવી રીતે ́ાયલી અને અǉેેસ 
બુક જવેી ટૂ˔ સંચારને વધુ Ǘેˤ બનાવી શકે છે, તે પણ સમા̍વˠ છે. અા સાધનાેની મદદથી વપરાશકતાƙઅાે 
વધુ અસરકારક રીતે સંલȘ કરી શકે છે અને ̋ડ̏જટલ વાતાવરણમાં અસરકારક રીતે સહકાર અાપી શકે છે. 

9. નમુનાͅપ ǐ˜ાે અને જવાબાે (Model Questions and Answers) 

1. મેઈલમાં "CC" શંુ દશાƙવે છે? 
a) કાબƙન કાેપી 
b) કાેɰેǶ કાેપી 
c) કરંટ કાેપી 
d) ƿે̋ડટ કાેપી 
ઉɇર: a) કાબƙન કાેપી 

2. નીચેના પૈકી કઈ ઈમેઈલ અેǉેસ ફાેમ̳ટ માʈ નથી? 
a) example@domain.com 
b) example@domain.co.uk 
c) example@.com 
d) example@domain.org 
ઉɇર: c) example@.com 

3. "BCC" ફીˆનાે ઈમઈેલમાં શુ ંઉɠેશ છે? 
a) ǐાʏકતાƙઅાેને બીલાઇન કાેપી માેકલવી, જથેી અʈ ǐાʏકતાƙઅાેને ન જણાય 
b) દરેક ǐાʏકતાƙને કાેપી માેકલવી 
c) માેકલનારને કાેપી માેકલવી 
d) ઈમેઈલનાે જવાબ અાપવા ે
ઉɇર: a) ǐાʏકતાƙઅાેને બીલાઇન કાેપી માેકલવી, જેથી અʈ Ůाɑકતાƙઅાેને ન જણાય 
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4. ઈમેઈલનાે કઈ ભાગ મેસેજનાે ̍વષય સમા̍વˠ કરે છે? 
a) બાેડી 
b) હેડર 
c) ̍વષય ફીˆ 
d) સહી 
ઉɇર: c) ̍વષય ફીˆ 

5. ઈમેઈલ ȃાયંટમાં "Inbox" શું છે? 
a) તે ફાેˆર ȱાં માેકલેલ મેસે̀ે સંǁ̋હત થાય છે 
b) તે ફાેˆર ȱાં ǐાʏ થયેલ ઈમેઈ˔ સંǁ̋હત થાય છે 
c) તે ફાેˆર ȱાં ǉાʘ સાચવવામાં અાવે છે 
d) તે ફાેˆર ȱાં જંક મેલ સંǁ̋હત થાય છે 
ઉɇર: b) તે ફાે̂ ર ȱાં ǐાʏ થયેલ ઈમેઈ˔ સંǁ̋હત થાય છે 

6. તમે ઈમેઈલમાં દƺતાવેજ કેવી રીતે ̀ેડાે છાે? 
a) મેસેજ બાેડીમાં ફાઈલ ǉેગ કરીન ે
b) ઈમેઈલ ȃાયંટમાં "Attach File" પસંદ કરીને 
c) દƺતાવેજને સીધા મેસેજ બાેડીમાં કાેપી અને પે˶ કરીન ે
d) ̍વષય લાઇનમાં દƺતાવેજનાે કɰેɰ ટાઇપ કરીને 
ઉɇર: b) ઈમેઈલ ȃાયંટમાં "Attach File" પસંદ કરીને 

7. "Reply All" પર ̚ȃક કરવા પર શંુ થાય છે? 
a) તમા̈́ં જવાબ ફǸ માેકલનારને માેકલાય છે 
b) તમા̈́ં જવાબ માેકલનાર અને બધા અʈ ǐાʏકતાƙઅાનેે માેકલાય છે 
c) તમા̈́ં જવાબ ફǸ BCC ફીˆમાં માેકલાય છે 
d) તમા̈́ં જવાબ ફǸ CC ફીˆમાં માેકલાય છે 
ઉɇર: b) તમા̈́ં જવાબ માેકલનાર અને બધા અʈ ǐાʏકતાƙઅાેને માેકલાય છે 

8. નીચે પૈકી કઈ સુ̍વધા ઈમેઈલ માેકલતા પહેલા ˾ે̏લ̬ગની ખામીઅાે તપાસવામાં મદદ કરે છે? 
a) Attach File 
b) સહી 
c) ˾ેલ ચેક 
d) ફાેરવડƙ 
ઉɇર: c) ˾ેલ ચેક 

9. ઈમેઈલમાં "Spam" શંુ છે? 
a) અેકમાǋ ǐાʏકતાƙને માેકલવામાં અાવેલ ઈમેઈલ 
b) અેક માʈ ǐમાેશનલ ઈમઈેલ 
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c) અ̏નȞનીય અને સામાʈ રીતે અƗાત ǐા̍ʏ કરનાર પાસથેી મીલવાની ઈમેઈલ 
d) અેક ઈમેઈલ જનેાે જવાબ ̀ેઈઅે છે 
ઉɇર: c) અ̏નȞનીય અને सामाɊ રીતે અƗાત ǐા̍ʏ કરનાર પાસેથી મીલવાની ઈમેઈલ 

10. ઈમેઈલનાે "Subject" લાઇન શંુ દશાƙવે છે? 
a) ઈમેઈલનાે કɰેɰ 
b) ઈમેઈલની ફાઈલ સાઇઝ 
c) ઈમેઈલનાે ̍વષય અથવા હેતુ 
d) ઈમેઈલનાે ǐા̍ʏકતાƙ 
ઉɇર: c) ઈમેઈલનાે ̍વષય અથવા હેતુ 

11. નીચેમાંથી કઈ ઈમેઈલ અેટેચમેɰનું ઉદાહરણ છે? 
a) અેક જવાબ મેસેજ 
b) ઈમેઈલ સાથે ̀ેડાયેલ દƺતાવેજ અથવા છબી 
c) ઈમેઈલ બાેડી 
d) ǐાʏકતાƙનાે ઈમેઈલ અેǉેસ 
ઉɇર: b) ઈમેઈલ સાથે ̀ેડાયેલ દƺતાવજે અથવા છબી 

12. નીચેમાંથી કઈ ઈમેઈલ ȃાયટંની માʈ સુ̍વધા નથી? 
a) ઈમેઈલ માેકલવી અને ǐાʏ કરવી 
b) ઈમેઈલને ફાેˆસƙમાં અાયાેજન કરવું 
c) કેલɱેર મેનેજ કરવું 
d) ગે̓  રમવી 
ઉɇર: d) ગેʼ રમવી 

13. "ઈમઈેલ સહી" શું છે? 
a) ઈમેઈલનાે બાેડી 
b) ǐાʏકતાƙનાે ઈમેઈલ અેǉેસ 
c) ઈમેઈલના અંતે અાપાેઅાપ ઉમેરવામાં અાવતી પૂવƙ ̏નધાƙ̋રત લખાણ 
d) ઈમેઈલનાે ̍વષય લાઇન 
ઉɇર: c) ઈમેઈલના અતંે અાપાેઅાપ ઉમેરવામાં અાવતી પૂવƙ ̏નધાƙ̋રત લખાણ 

14. તમે કેવી રીતે ઈમેઈલને ˾ામ તરીકે ̎ચ̋̆ત કરી શકાે છાે? 
a) ફǸ મફત ઈમેઈલ સ̍વ̭સીસનાે ઉપયાેગ કરીન ે
b) ઈમેઈ˔માં અટેેચમેɰ વગર ઈમેઈલ માેકલીને 
c) ǐાʏકતાƙઅાેને તમારી ઈમેઈલ અેǉેસ ˚ાઇટ̏લ˶ કરવા માટે ̍વનંતી કરીન ે
d) ફǸ અેટેચમેɰ સાથે ઈમઈેલ માેકલીન ે
ઉɇર: c) ǐાʏકતાƙઅાેને તમારી ઈમેઈલ અેǉેસ ˚ાઇટ̏લ˶ કરવા માટે ̍વનંતી કરીન ે
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15. "Forward" પર ̚ȃક કરવાથી શું થાય છે? 
a) તમે મૂળ માેકલનારને જવાબ માેકલતા છાે 
b) તમે ઈમેઈલને નવાે ǐાʏકતાƙ અથવા ઘણી લાેકાેને માેકલતા છાે 
c) તમે ઈમેઈલ ̋ડલીટ કરતા છાે 
d) તમે ઈમેઈલ છાપતા છાે 
ઉɇર: b) તમે ઈમેઈલને નવાે ǐાʏકતાƙ અથવા ઘણી લાેકાેને માેકલતા છા ે

16. ઈમેઈલ ȃાયંટમાં "Outbox" નાે કાયƙ શંુ છે? 
a) તે ઈમેઈ˔ને સંǁ̋હત કરે છે જ ેપહા̲ચવા માટે રાહ ̀ેઈ રહી છે 
b) તે ǐાʏ થયેલ ઈમેઈ˔ને સંǁ̋હત કરે છે 
c) તે ̋ડલીટ કરેલા ઈમેઈ˔ને સંǁ̋હત કરે છે 
d) તે અાકાƙઇવ કરેલા ઈમેઈ˔ને સંǁ̋હત કરે છે 
ઉɇર: a) તે ઈમેઈ˔ન ેસǁં̋હત કરે છે જે પહા̲ચવા માટે રાહ ̀ેઈ રહી છે 

17. નીચેમાંથી કયાે ઈમેઈલ સ̍વ̭સ ǐદાતા સામાʈ રીતે ઉપયાેગમાં લેવામાં અાવે છે? 
a) અેડાેબ 
b) ગૂગલ (͂મેઈલ) 
c) માઇƿાેસાʘે (વડƙ) 
d) અેમેઝાેન 
ઉɇર: b) ગગૂલ (͂મેઈલ) 

18. "Reply" ફંȆન ઈમેઈલમાં શંુ કરે છે? 
a) મેસેજને અનેક recipientsને માેકલે છે 
b) ઈમેઈલને બી̀ ઈમેઈલ અેǉેસ પર ફાેરવડƙ કરે છે 
c) માǋ માેકલનારને જવાબ અાપ ેછે 
d) "CC" યાદી પર ઈમેઈલનાે કાેપી માેકલતા છે 
ઉɇર: c) માǋ માેકલનારને જવાબ અાપે છે 

19. નીચેમાંથી કઈ વƺતુ સામાʈ રીતે ઈમઈેલ ɦારા ફાઇલાે માકેલવામાં ઉપયાેગ થાય છે? 
a) અેટેચમેɰ્સ 
b) ̏લ̬ȋ 
c) ટેƝસ 
d) ̋ટʑણીઅાે 
ઉɇર: a) અેટેચમેɰ્સ 

20. કેવી રીતે તમે ̀ણશાે કે ઈમેઈલ સફળતાપૂવƙક માેકલવામાં અા˗ું છે? 
a) ઈમેઈલ તમારા Inbox માં દેખાવશે 
b) ઈમેઈલ "Outbox"માં સેવ કરવામાં અાવશે 
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c) તમને "Message Sent" નાે̋ ટ̋ફકેશન અથવા "Sent" ફાેˆર પુ̑ˠ મળશે 
d) ǐાʏકતાƙ તમને ફાેન કરશે 
ઉɇર: c) તમને "Message Sent" નાે̋ટ̋ફકેશન અથવા "Sent" ફાેˆર પુ̑ˠ મળશ ે

21. નીચેમાંથી કયાે ઈમેઈલ ǐાેટાેકાેલ મેસેજને ǐાʏ કરવા માટે ઉપયાેગ થાય છે? 
a) SMTP 
b) POP3 
c) HTTP 
d) FTP 
ઉɇર: b) POP3 

22. ̀ે તમે અƗાત sender પાસેથી અ̏નȞનીય ઈમેઈલ ǐાʏ કરાે છાે, તાે શંુ કરશાે? 
a) અેટેચમેɰ્સ ખાેલાે અને તમામ ̏લ̬ક પર ̚ȃક કરા ે
b) તે ̌મǋાે પાસે ફાેરવડƙ કરા ે
c) તેને ˾ામ તરીકે ̎ચ̋̆ત કરાે અથવા ̋ડલીટ કરાે 
d) વધુ મા̋હતી માટે તેનું જવાબ અાપા ે
ઉɇર: c) તેને ˾ામ તરીકે ̎ચ̋̆ત કરાે અથવા ̋ડલીટ કરા ે

23. નીચેમાંથી કઈ ઈમેઈલનાે ધાેરણ ભાગ નથી? 
a) બાેડી 
b) ̍વષય 
c) માેકલનારનાે ફાેન નંબર 
d) ǐાʏકતાƙનાે ઈમેઈલ અેǉેસ 
ઉɇર: c) માેકલનારનાે ફાેન નંબર 

24. ̀ ે ઈમેલ સંદેશને "પ̋ઠત" તરીકે ̎ચ̋̆ત કરવામાં અાવે છે, તાે તેનાે અથƙ શંુ છે? 
a) ઈમેલ કાઢી નાખવામાં અાવી છે 
b) ǐાʏકતાƙઅે ઈમેલ ખાેલી અને ̀ેવી છે 
c) ઈમેલ અાગળ માેકલવામાં અાવી છે 
d) ઈમેલ "અાઉટબાેȋ"માં છે 
ઉɇર: b) ǐાʏકતાƙઅે ઈમેલ ખાેલી અને ̀ેવી છે 

25. ઈમેલ ȃાયંટમાં અેǉેસ બુકનાે ઉપયાેગ કરવાથી શંુ ફાયદાે થાય છે? 
a) અા અǐેાʏ ઈમેલની ઈ̍તહાસ સંǁહ કરે છે 
b) અા વારંવાર ઉપયાેગમાં અાવતી ઈમેલ સરનામાં સુધી ઝડપી પહા̲ચ પહા̲ચવાને અનુકૂળ બનાવે છે 
c) અાIncoming emails ને ફાેˆરમાં સંǁ̋હત કરે છે 
d) અા ઈમેલમાં ખાેટી ˾ે̏લગ̬ તપાસે છે 
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ઉɇર: b) અા વારંવાર ઉપયાેગમાં અાવતી ઈમેલ સરનામાઅાે સુધી ઝડપી પહા̲ચ પહા̲ચવાને 
અનુકૂળ બનાવે છે 

26. નીચેના પૈકી IMAP ȱારે ઈમેલ મેનેજ કરે છે ɔારે કયાે ̋ƿયા કરે છે? 
a) ઈમેલ ડાઉનલાેડ કરે છે અને તેને સવƙરથી કાઢી નાખે છે 
b) ઈમેલને અનેક ઉપકરણાેમાં સમંક̏લત કરે છે અને સવƙર પર સંǁ̋હત કરે છે 
c) ઈમેલ સવƙર પર સંǁ̋હત નથી કરતા ે
d) ઈમેલ માેકલે છે પરંતુ ǐાʏ નથી કરે 
ઉɇર: b) ઈમેલને અનેક ઉપકરણાેમાં સમંક̏લત કરે છે અને સવƙર પર સંǁ̋હત કરે છે 

27. તમે ઈમેલમાં કેટલાય ફાઇલાે કેવી રીતે ̀ેડશા?ે 
a) “ફાઈલ ̀ેડાે” ̍વકˍને ઘણા વખત પસંદ કરીને દરેક ફાઈલ પસંદ કરાે 
b) ફાઈલાેને માǋ ̏લ̬ક તરીકે ̀ેડી શકાે છાે 
c) દરેક ફાઈલ માટે નવી ઈમેલ બનાવાે 
d) અેક કરતા વધારે ફાઈલ ̀ેડવાનાે ̍વકˍ નથી 
ઉɇર: a) “ફાઈલ ̀ેડાે” ̍વકˍને ઘણા વખત પસંદ કરીને દરેક ફાઈલ પસંદ કરાે 

28. ઈમેલ ȃાયંટમાં "અાઉટબાȋે" ફાેˆર શું દશાƙવે છે? 
a) તે ઈમેલ જે માેકલવા માટે રાહ ̀ેઈ રહી છે અથવા સફળતાપૂવƙક પહા̲ચવામાં નથી અાવી 
b) તે ઈમેલ જ ેવાંચવામાં અાવી છે અને જવાબ અાપવામાં અા˗ાે છે 
c) તે ઈમેલ જે અાકાƙઈવ કરવામાં અાવી છે 
d) તે ઈમેલ જ ે˾ેમ કરવામાં અાવી છે 
ઉɇર: a) તે ઈમેલ જે માેકલવા માટે રાહ ̀ેઈ રહી છે અથવા સફળતાપૂવƙક પહા̲ચવામાં નથી અાવી 

29. ઈમેલ સહી શું છે? 
a) ઈમેલના નીચેના ભાગમાં ઉમેરાયેલ ̚ȃક કરવા લાયક ̏લ̬ક 
b) અે પ̋રભા̍ષત લખાણ અથવા મા̋હતી જે ઈમેલના અંત ેઅાપાેઅાપ ̀ેડાય છે 
c) અેક ͆ƸયલƖણ કાેડ જ ેઈમેલ માેકલનારને ǐમા̒ણત કરવા માટે વપરાય છે 
d) અેક ખાસ ઈમેલ અેનકાે̋ડ̬ગ 
ઉɇર: b) અે પ̋રભા̍ષત લખાણ અથવા મા̋હતી જે ઈમેલના અંતે અાપાેઅાપ ̀ેડાય છે 

30. ̀ ે તમે ઈમેલ ગલત ǐા̍ʏ પર માેકલી દાે છા,ે તાે શંુ કરવું ̀ેઈઅે? 
a) ̀ે ઈમેલ ǐદાતા તેનંુ અનુમ̍ત અાપે તાે ઈમેલ ફરીથી માેકલવાનાે ǐયાસ કરાે (ઉદાહરણ તરીકે, 
Gmailની "Undo Send" ફીચર) 
b) ǐા̍ʏને અનુસરતા ઈમેલ માેકલીને તેમને અવગણવા માટે કહાે 
c) કંઈ ન̋હ, કારણ કે અેકવાર માેકલાવેલી ઈમેલ પાછી લેવામાં અાવી શકતી નથી 
d) IT સપાેટƙને સંપકƙ  કરાે ઈમેલ પુનઃǐાʏ કરવા માટે 
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ઉɇર: a) ̀ે ઈમેલ ǐદાતા તેનું અનુમ̍ત અાપે તાે ઈમેલ ફરીથી માેકલવાનાે ǐયાસ કરાે (ઉદાહરણ 
તરીકે, Gmailની "Undo Send" ફીચર) 
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ટેકનાેલાે͂  Ǉેક (Technology Track) 
 

 
1. Google ઉપયાે̎ગતા (Google Utilities) 

Google વપરાશકતાƙઅાેન ે ઉɎાદનƖમતા, સંચાર, ̍વકાસ અને વધમુાં મદદ કરવા માટે ̍વ̍વધ ǐકારના ં
સાધનાે અને સેવાઅાે પૂરી પાડે છે. અહ̯ ̍ વ̍વધ Google ઉપયાે̎ ગતાઅાેના ેવગƙવાર ̍ વહંગાવલાેકન અાપવામાં 
અા˗ું છે: 

 

Google Workspace (અગાઉ G Suite તરીકે અાેળખાતું) 

Google Workspace અે ȃાઉડ-અાધા̋રત ઉɎાદનƖમતા સાધનાેનાે સમૂહ છે, જ ે̠ ાવસા̍યકાે, શાળાઅા ે
અને ˗̘Ǹગત વપરાશકતાƙઅાે માટે રચાયેલ છે. તેમાં સમા̍વˠ છે: 

 Gmail: અેક લાકે̌ǐય ઇમેઇલ સેવા છે જેમા ંશ̘Ǹશાળી શાધે, અʈ Google સાધનાે સાથે સંકલન 
અને ̍વ̍વધ સંગઠન Ɩમતા હાેય છે. 

 Google Calendar: અેક સમયપǋક અને કેલɱેર ˗વ˺ાપન સાધન છે, જ ેGmail અને અʈ 
સેવાઅાે સાથે સંક̏લત થાય છે. 

 Google Drive: અેક ȃાઉડ ˶ાેરેજ સેવા છે જમેાં તમે ફાઇલાે સǁંહ કરી શકાે છાે, વહ̲ચી શકાે છાે 
અને સહકારથી કામ કરી શકાે છા.ે તે Docs, Sheets અને અʈ Google સાધનાે સાથે સરળતાથી 
સંક̏લત થાય છે. 

 Google Docs: અેક વડƙ ǐાેસે̐સ̬ગ સાધન છે જમેાં તમે ̋રયલ-ટાઇમમાં અʈ વપરાશકતાƙઅાે સાથ ે
સહકારથી કામ કરી શકા ેછા.ે તે Microsoft Word (.docx) જવેા ̍વ̍વધ ફાઇલ ફાેમ̳ટન ેઅાધાર 
અાપે છે. 

 Google Sheets: અેક ˿ ેડશીટ સાધન છે જ ેMicrosoft Excel સમાન છે, અને જમેા ં̋ રયલ-ટાઇમ 
સહકાર તથા Google Apps Script સાથે સંકલન સુલભ છે. 
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 Google Slides: અેક ǐેઝɰેશન સાધન છે જ ેMicrosoft PowerPoint સમાન છે, જમેાં તમ ે
ǐેઝɰેશન બનાવી શકાે છાે, સંપા̋દત કરી શકાે છાે અને વહ̲ચી શકાે છાે. 

 Google Meet: અેક ̍વ̋ડઅાે કાʃેર̘ʉ̬ગ સાધન છે જે સુર̐Ɩત સંચાર પૂરાે પાડે છે અને Google 
Calendar તથા Gmail સાથે સંક̏લત થાય છે. 

 Google Chat: ટીમ માટે મસેે̏જ̬ગ અને સહયાેગી સાધન છે, જમેાં સીધા સંદેશા અને ǁુપ ચેટ્સ કરી 
શકાય છે. 

 Google Keep: ના̲ધ લેવા અને કાયƙ ̠ વ˺ાપન માટેનુ ંસાધન છે, જ ેતમારા તમામ ઉપકરણાે વȝે 
સમƮવ̍યત રહે છે. 

 Google Forms: સવ,̳ ̘Ȅઝ અને મા̋હતી અેકǋ કરવા માટેના ફાેʼƙ બનાવવા માટેનંુ સાધન છે. 

 Google Sites: વેબસાઇટ બનાવવા માટેનંુ સરળ સાધન છે, જમેાં કાેઈ પણ કાે̋ડ̬ગ Ɨાનની જͅર 
નથી. 

Google Cloud Platform (GCP) 

Google Cloud Platform અે ̍વકાસકતાƙઅાે, ˗ાપારીઅાે અને ઉɥાેગાે માટે ȃાઉડ કƳʔુ̋ટ̬ગ સેવાઅાેના ે
સમૂહ છે. તેમાંનાં કેટલાક મુȕ સાધનાે અા મુજબ છે: 

 Google Compute Engine: Googleના ઇƮǑા˷Ǵર પર તમારા અે̖ʕકેશʉ ચલાવવા માટે 
વȢુƙઅલ મશીનાે (VMs). 

 Google Kubernetes Engine: કɰેનરાઇƣડ અે̖ʕકેશʉ ચલાવવા માટે મેનȬે 
Kubernetes ȃ˶રાે. 

 Google Cloud Storage: બેકઅપ, ̌મ̋ડયા ફાઇલાે અન ે અʈ માેટી ફાઇલાે જેવા ડેટા માટે 
અાૅʠેǶ ˶ાેરેજ. 

 Google BigQuery: માેટા ડેટાસેટ્સ પર ઝડપી SQL ̍વƸલેષણ માટે ̋ડઝાઇન કરાયલે સવƙરલેસ 
ડેટા વેરહાઉસ સાેˑુશન. 

 Google Firebase: માેબાઇલ અને વેબ અે̖ ʕકેશʉ બનાવવાનું ʕેટફાેમƙ જમેાં ̋રયલ-ટાઇમ 
ડેટાબઝે, અાેથે̔ ɰકેશન અન ેહાે̔˶̬ગ જવેા ફીચસƙ છે. 

 Google Cloud Functions: ઘટનાઅાેના ǐ̍તસાદમાં નાનું કાેડ ચલાવવા માટે સવƙરલેસ 
અેિƛઝȂુશન અેƮવાયનƙમɰે. 

Google Developer Tools 

અા સાધનાે ̍વકાસકતાƙઅાે (Developer) માટે બનાવેલા છે જ ેતેમને અે̖ʕકેશન ̐બˆ, ટે˶ અને ડીʕાેય 
કરવામાં સહાય કરે છે: 
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 Google Chrome Developer Tools: Chrome ǒાઉઝરમાં અાવલે ̐બ˄-ઇન સાધનાે જ ેવેબ 
અે̖ ʕકેશʉને તપાસવા, ̋ડબગ અને અાૅ̐ʍમાઇઝ કરવા માટે ઉપયાેગી છે. 

 Firebase: માેબાઇલ અે̖ ʕકેશન માટે ટૂ˔નાે સમૂહ જમેાં ̋રયલ-ટાઇમ ડેટાબેસ, ȃાઉડ ˶ાેરેજ 
અને યુઝર અાેથે̔ ɰકેશન સામેલ છે. 

 Google APIs: Google Maps, YouTube, Google Drive, Google Analytics વગેરે સેવાઅાે 
માટે APIનાે સમૂહ. 

 Google App Engine: ˱ેલેબલ વેબ અે̖ʕકેશʉ અને API બનાવવા અને ડીʕાેય કરવા 
માટેનું ʕેટફામેƙ. 

 Google Cloud SDK: Google Cloudના સંસાધનાે અને સેવાઅાે સંચા̏લત કરવા માટે કમાɱ-
લાઇન ટૂ˔નાે સમૂહ. 

Google Analytics અને Google Ads 

માક̳̋ટ̬ગ અને ડેટા ̍વƸલેષણ માટે: 

 Google Analytics: વેબસાઇટ Ǉા̋ફક, વપરાશકતાƙ વતƙન અને અʈ મે̋ Ǉȋને Ǉેક અને 
̍વƸલેષણ કરવા માટેનું સાધન. 

 Google Ads: પેઇડ સચƙ ̀હેરાતાે બનાવવા અને મેનેજ કરવા માટેનંુ ʕેટફાેમƙ જ ે Google 
Networkમાં YouTube, Google Search અને અʈ સાથી સાઇટ્સમાં સમાવેશ કરે છે. 

 Google Tag Manager: વેબસાઇટના કાેડને બદˑા ̍વના માક̳̋ટ̬ગ ટૅƝસ (જમે કે JavaScript 
અને HTML) મેનેજ અને ડીʕાેય કરવા માટેનું સાધન. 

 Google Search Console: Google Searchમાં વેબસાઇટની કામગીરી દેખરેખ રાખવા અન ે
સુધારવા માટેનું સાધન. 

Google Search અને મા̋હતી માટેની ઉપયાે̎ગતાઅાે 

Google Search સાૈથી વધુ ઉપયાેગમાં લેવાતી સેવાઅાેમાથંી અેક છે, પરંતુ તેમાં ઘણા ઉપયાેગી સાધનાે પણ 
સામેલ છે: 

 Google Translate: લખાણ, દƺતાવે̀ે અને વેબસાઇટ્સનું 100થી વધુ ભાષાઅાેમાં ̋રયલ-ટાઇમ 
ભાષાંતર માટેનું સાધન. 

 Google Lens: તમારા ફાેનના કેમેરા વડે ̎ચǋ લઈ અાેʠેǶ્સ, છાેડ, ̀નવરા ે અને લખાણ 
અાેળખવાનું સાધન. 

 Google Scholar: વƗૈા̏નક સા̋હɔ શાેધવા માટેનંુ સચƙ અેિƮજન જમે કે લેખા,ે થી̐સસ, પƺુતકા ે
અને રીસચƙ પપેસƙ. 
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 Google News: ˗̘Ǹગત રસǐદ સમાચાર માટેનું સાધન, જ ે̍વ˝ભરના હેડલાઇʉ અાપે છે. 

 Google Books: પƺુતકાેના પૂવાƙવલાેકન અને શાેધ માટેની અાૅનલાઇન સેવા. 

 Google Maps: માગƙદ̏શ̭કા, ̋રયલ-ટાઇમ Ǉા̋ફક મા̋હતી અને સેટેલાઇટ ઈમેજરી અાપતું નકશા 
સાધન. 

 Google Street View: Google Mapsની સુ̍વધા જ ે ̍વ˝ભરના પનેાેરે̌મક ˷ીટ-લેવલ ફાેટા 
અાપે છે. 

Google Chrome ઉપયાે̎ગતાઅાે 

Google Chrome અેક લાેક̌ǐય વબે ǒાઉઝર છે, પણ તેમાં ઘણા ઉપયાેગી સાધનાે અને અેȋટેƮશનાે પણ 
છે: 

 Chrome Extensions: Chromeની કાયƙƖમતામાં વધારાે કરતા ̍વ̍વધ અȋેટેƮશʉ જમે કે 
̀હેરાત અવરાેધકાે, પાસવડƙ મેનેજર, ઉɎાદનƖમતા સાધનાે અને ડેવલપર ટૂ˔. 

 Chrome Remote Desktop: Chrome ǒાઉઝર મારફતે અʈ કƳʔુટસƙને ̋રમાેટલી અૅȋેસ 
અને ̏નયં̍ǋત કરવાનાે સાધન. 

 Chrome Sync: તમા̈́ં ǒાઉઝરના ે ઇ̍તહાસ, બુકમાȋƙ, પાસવડ્ƙસ અને સે̋ટ̬Ɲસ તમામ 
ઉપકરણાેમાં સમƮવ̍યત કરે છે. 

 Google Password Manager: વેબસાઇટ્સ અને અે̖ʕકેશʉમાં પાસવડ્ƙસ સુર̐Ɩત રીત ે
સǁં̋હત અને અાેટાે-̋ફલ કરવાની સુ̍ વધા. 

Google સુરƖા સાધનાે 

Google સુરƖા અને ખાનગીપણું માટે અનેક સાધનાે અાપ ેછે: 

 Google Authenticator: સુર̐Ɩત લાૅ̎ગન માટે ટુ ફેǶર અાેથે̔ ɰકેશન (2FA) કાેડ અાપે છે. 

 Google Security Checkup: ખાતાની સુરƖા સે̋ ટ̬Ɲસની સમીƖા અને સુધાર માટેનું સાધન. 

 Google Find My Device: તમા̈́ં Android ઉપકરણ ખાેવાઈ ગયંુ હાેય તાે તેને શાેધવા, લાેક 
કરવાનું કે મા̋હતી કાઢવા માટેની સેવા. 

 Google One: વધારાની ˶ાેરેજ (Drive, Gmail, Photos) અને VPN જવેી સુ̍વધાઅાે સાથેનુ ં
સિƱ˲Ưશન ʕાન. 

અʈ ઉપયાે̎ગતાઅાે 

 Google Keep: કાેઇપણ ǐકારની ના̲ધ લેવા માટેની અે̖ʕકેશન જ ેતમામ ઉપકરણાેમાં ̋રયલ-
ટાઇમ સમƮવય અાપે છે. 
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 Google Earth: વȢુƙઅલ Ɲલાેબ અને નકશાનું સાધન, જમેાં ઉપયાેગકતાƙઅાે સેટેલાઇટ છબીઅાે 
̀ેઈ શકે છે. 

 Google Stadia: ȃાઉડ ગે̌મ̬ગ ʕેટફાેમƙ (હવે અʈ સેવાઅામેાં પ̋રવ̍ત̭ત થઈ ર̈ું છે), જ ેકʉાેલ 
̍વના ગેમ રમવાની મંજૂરી અાપે છે. 

 Google Play Store: Android માટેના અૅƯસ, ગે̓ , સંગીત, મૂવીઝ, પƺુતકાે અને વધુ માટેનુ ં
અાે̋ફ̏શયલ માક̳ટʕેસ. 

Google for Education 

 Google Classroom: ̏શƖકાે અને ̍વɥાથ̰અાે માટેનાે ̋ડ̏જટલ ȃાસͅમ ʕટેફાેમƙ, જમેા ં
અસાઇનમેɰ, સંચાર અને સહયાેગ સુલભ છે. 

 Google Forms: ̘Ȅઝ, સવ̳ અને ̍વɥાથ̰અાેની જવાબદારીઅાે અેકǋ કરવા માટે ̏શƖણƖેǋમાં 
˗ાપક ઉપયાેગ થાય છે. 

 Google Jamboard: સહયાેગી ̍વચારાે માટેનું ઇɰરઅૅ̖ Ƕવ ̊ ાઇટબાેડƙ, જ ે̏શƖણ અને ટીમ વકƙ  
માટે ઉપયાેગી છે. 

2. AI ચટેબાેટ (Artificial Intelligence Chatbot) 

AI અાધા̋રત ચેટબાેટ્સ અે અɥતન સાેʘવેર અે̖ ʕકેશʉ છે જ ેકૃ̍ǋમ બુ̏ɡ (AI) ટેǽાેલાે͂  ખાસ કરીને 
નેચરલ લ̲Ɲવેજ ǐાેસે̐ સ̬ગ (NLP) અને મશીન લ̏ન̮ગ (ML)નાે ઉપયાેગ કરીને માનવ જવેી વાતચીતનંુ 
અનુસરણ કરે છે. અા ચેટબાટ્ેસ તેમની જ̋ટલતા, Ɩમતા અને ઉપયાેગના Ɩેǋાે ǐમાણે અલગ-અલગ ǐકારના 
હાેય છે. ̏ નય̌મત ̏ નયમ અાધા̋રત બાેટ્સની તુલનામા,ં AI ચેટબાટ્ેસ ભાષાને પૃˤભૂ̌મ સાથે સમજવા, પર˾ર 
̋ƿયાઅામેાંથી શીખવા અને સમય જતાં સુધાર થવામાં સƖમ હાેય છે. 

AI ચેટબાેટ્સના ̍વ̍વધ ǐકારાે: 

 ̏નયમ અાધા̋રત ચેટબાેટ્સ (Rule-Based Chatbots) 

 AI અાધા̋રત ચેટબાેટ્સ (AI-Powered Chatbots) 

 વȢુƙઅલ સહાયક (Virtual Assistants) 

 સાે̏શયલ ચેટબાેટ્સ (Social Chatbots) 

 ǁાહક સેવા ચેટબાેટ્સ (Customer Service Chatbots) 

 ̍વષય ̍વ̏શˠ ચેટબાેટ્સ (Domain-Specific Chatbots) 

 વાતચીત અાધા̋રત AI ʕેટફાે ƙ̓ (Conversational AI Platforms) 
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ઉદાહરણાે: 

 ChatGPT (OpenAI ɦારા) 
 Google Bard (હવે Gemini નાે ભાગ) 
 Microsoft Copilot (અગાઉ Bing Chat પર અાધા̋રત) 
 Replika (Luka Inc. ɦારા) 
 Meta AI (ઉદાહરણ: BlenderBot, LLaMA સંકલન) 
 IBM Watson Assistant 
 Alexa Conversations (Amazon ɦારા) 
 YouChat (You.com ɦારા) 
 Xiaoice (Microsoft China ɦારા) 

AI ચેટબાેટ્સ પાછળની મુȕ ટેǽાેલાે͂: 

1. નેચરલ લ̲Ɲવેજ ǐાેસે̐ સ̬ગ (NLP): ચેટબાટેને માનવ ભાષાને સમજવા, ˗ાȕા̍યત કરવા અને ǐ̍તસાદ 
અાપવા માટે સƖમ બનાવે છે. તેમાં સામેલ છે: 

 ટાેકનાઈઝેશન 
 નેƳડ અે̔ ɰટી રેક̗Șશન 
 સ̲̋ટમેɰ ̍વƸલેષણ 
 ઇનટેɰ અાેળખ 

2. મશીન લ̏ન̮ગ (ML): અગાઉની વાતચીતમાંથી શીખી ને ચેટબાેટ સમય જતા ં વધુ ચાેકસાઇ અને 
ગુણવɇાયુǸ ǐ̍તસાદ અાપી શકે છે. 

3. ʈુરલ નેટવકƙ  / ડીપ લ̏ન̮ગ: ̍વશાળ ભાષા માેડે˔ (જમે કે GPT, BERT) માં ઉપયાેગ થાય છે જ ેકુદરતી 
અને સંદભƙ અાધા̋રત ǐ̍તસાદ અાપવામાં સહાયક છે. 

4. ̋રઇનફાેસƙમɰે લ̏ન̮ગ: કેટલાક માેડે˔ વપરાશકતાƙના ફીડબેક (જમે કે અપવાટે / ડાઉનવાેટ)ના અાધારે 
તેમનાં ǐ̍તસાદાે સુધારે છે. 

AI ચેટબાેટ કેવી રીતે કાયƙ કરે છે? 

1. ઇનપુટ ǐાેસે̐ સ̬ગ: વપરાશકતાƙ સંદેશ માેકલે છે. 

2. ઇનટેɰ અાેળખ: ચેટબાટે વપરાશકતાƙની માૈ̏લક ઇȞા કે હેતુ અાેળખે છે (જેમ કે ̋ટ̋કટ બુક કરવી, ǐ˜ 
પૂછવાે). 

3. અે̔ ɰટી અેȋǇેȆન: તારીખ, ˺ળ, નામ જવેી જͅરી ̍વગતાેને અાેળખે છે. 

4. ǐ̍તસાદ ઉɎ̎ɇ: AI ɦારા યાƝેય અને સદંભƙ અાધા̋રત ǐ̍તસાદ તૈયાર થાય છે. 

5. લ̏ન̮ગ લૂપ: વપરાશકતાƙ તરફથી મળેલ ફીડબેકના અાધારે અાગામી ǐ̍તસાદાેમાં સુધારાે થાય છે. 
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AI ચેટબાેટ્સની મુȕ કાયƙƖમતાઅાે (Key Functionalities of AI Chatbots) 

કાયƙƖમતા વણƙન ઉદાહરણ 

સંવાદ Ɩમતા (Conversational 
Ability) 

કુદરતી અને બહુ-વાȂવાળી 
વાતચીત કરવી 

ChatGPT ɦારા અનુગામી 
ǐ˜ાેના જવાબ 

˗̘Ǹગતરણ 
(Personalization) 

વપરાશકતાƙની પસંદગીઅા ે યાદ 
રાખવી અને તેને અનુͅ પ ǐ̍તસાદ 
અાપવા ે

Replika વપરાશકતાƙના શાેખ 
શીખે છે 

અેક કરતા વધુ ભાષા સપાેટƙ 
(Multi-language Support) 

અનેક ભાષાઅાેમાં વાતચીત કરી 
શકે છે 

Google Gemini >40 
ભાષાઅાે સપાેટƙ કરે છે 

કાયƙ ̄ચાલન (Task 
Automation) 

બુ̋ક̬ગ, શેȻૂ̏લ̬ગ જવેા કાયા̳ કરે છે Alexa રીમાઇɱર અથવા 
અેલામƙ સેટ કરે છે 

અેકીકરણ (Integration) ̍વ̍વધ અે̖ʕકેશʉ/સવેાઅા ે
સાથે કામ કરે છે 

Copilot Microsoft Wordમાં 
કામ કરે છે 

 

AI અાધા̋રત ચેટબાેટ્સના સામાʈ ઉપયાેગાે (Common Use Cases of AI-Powered 
Chatbots) 

Ɩેǋ ઉપયાેગ ઉદાહરણ 

ǁાહક સહાયતા 24/7 હેˍડે˱, ̋ટ̋કટ જનરેશન IBM Watson ટે̏લકાેમ Ɩેǋમા ં

̏શƖણ હાેમવકƙમાં સહાય, ˗̘Ǹગત ȵુશન ChatGPT, Khanmigo 

અારાેƝય લƖણ તપાસ, અપાેઇɰમેɰ બુ̋ક̬ગ Babylon Health 

ઈ-કાેમસƙ ǐાેડǶ ભલામણ, અાેડƙર Ǉે̋ક̬ગ H&M નું શાે̌પ̬ગ બાેટ 

નાણા ં બેલેʉ પૂછવું, Ǒાેડ અેલટƙ Erica (Bank of America) ɦારા 

માનવ સંસાધન ઉમેદવારની ˲ી̏ન̬ગ, અાેનબાે̋ડ̮ગ Mya Systems ચેટબાેટ 

મનાેવૈƗા̏નક સહાય ભાવનાઅાે માટે સપાેટƙ, જનƙ̏લ̬ગ Woebot, Replika 

 

 



 

  
SARDAR PATEL INSTITUTE OF PUBLIC ADMINISTRATION, AHMEDABAD 369 

 

AI ચટેબાેટ્સના લાભાે (Advantages of AI Chatbots) 

 ̍વƺતૃ̍ તƖમતા (Scalability): અેકસાથે હ̀રાે વપરાશકતાƙઅાેને હેɱલ કરે. 

 24/7 ઉપલʤતા: કાેઈ પણ સમયે સેવા અાપ ેછે, ̍વના ̍વલંબે. 

 સુસંગતતા (Consistency): અેકસરખી અને ̗˺ર સેવા અાપે છે. 

 ˗̘Ǹગતરણ: વપરાશકતાƙ માટે અનુકૂળ વાતચીત. 

 ડેટા ̍વƸલેષણ (Data Insights): વપરાશકતાƙ ̋ƿયાઅાેમાંથી Ǉેɱ્સ અને સુધારાની તક મળી શકે. 

AI ચટેબાેટ્સના પડકારાે (Challenges) 

 સƽુમ ભાષાને સમજવામાં અસમથƙતા. 

 ડેટા ǐાઇવસી સંબં̍ધત ̎ચ̬તાઅાે. 

 મયાƙ̋ દત ભાવનાɒક બુ̏ɡ. 

 ગુણવɇાપૂણƙ Ǉે̏ન̬ગ ડેટાની જ̋ͅરયાત. 

 જ̋ટલ બાટે બનાવવાની ઉંચી ̋ક̬મત. 

ChatGPT ̍વશ ે(OpenAI ɦારા) 

ChatGPT શંુ છે? 

ChatGPT અે OpenAI ɦારા ̍વક̐સત અેક AI અાધા̋રત ચેટબાેટ છે જે કુદરતી ભાષા ǐ̋ƿયા (Natural 
Language Processing - NLP) અને મશીન લ̏ન̮ગનાે ઉપયાેગ કરીને માનવ જવેી વાતચીત કરે છે. તે 
OpenAIના GPT (Generative Pre-trained Transformer) માેડલ અાધા̋રત છે. 2025 સુધીનાે તાજેતરનાે 
વઝƙન GPT-4-turbo પર અાધા̋રત છે. 

મȕુ ટેકનાેલાે͂  (Core Technology) 

 માેડલ માળખંુ: Ǉાʉફાેમƙર અાધા̋રત ભાષા માેડલ 

 હાલનંુ વઝƙન: GPT-4-turbo (GPT-4 કરતાં ઝડપી અને સƺતું) 

 Ǉે̏ન̬ગ: માેટા પાયે ઇɰરનેટ અાધા̋રત ડેટા (પƺુતકા,ે વેબસાઇટ્સ, વાતચીત) પરથી તાલીમ 

 લ̏ન̮ગ ˶ાઈલ: પૂવƙ-̏શ̐Ɩત + માનવ ǐ̍તસાદથી ̋રફાેસƙમɰે લ̏ન̮ગ (RLHF) 
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મȕુ કાયƙƖમતાઅાે (Key Functionalities) 

કાયƙƖમતા વણƙન 

કુદરતી વાતચીત ǐ˜ાે અને સૂચનાેને માનવ જેવી રીતે જવાબ અાપે છે 

સજƙનાɒક લેખન વાતાƙઅાે, કા˗, માક̳̋ટ̬ગ લખાણ વગેરે લખી શકે છે 

કાેડ સહાય કાેડ લખવામાં, ̋ડબ̎ગ̬ગમાં અને સમ̀વવામાં સહાય કરે છે 

ભાષા અનુવાદ ̍વ̍વધ ભાષાઅાેમાં ઉȝ સચાેટતાથી અનુવાદ કરે છે 

સારાંશ અન ેપ̋રભાષા લખાણને સં̐Ɩʏ અથવા પુન̏લ̭̑ખત કરે છે 

ગ̒ણતીય તારણ ગ̒ણત ǐ˜ાે ઉકેલી શકે છે અને પગલાં સમજ ેછે 

˗̘Ǹગત સહાયક સુ̍ વધાઅા ે ઇમેલ ǉાʘ કરવી, ̋રƣયમૂે લખવું, કામાે શેȻૂલ કરવું વગેરે 
 

ઉપયાેગના Ɩǋેાે (Use Cases) 

Ɩેǋ ઉપયાેગ 

̏શƖણ ȵુશન, સમ̀વાે, હામેવકƙ  સહાય 

˗વસાય દƺતાવેજ લખવું, ડેટા ̍વƸલેષણ, ǁાહક સહાય 

ǐાેǁા̌મ̬ગ કાેડ લખવંુ, સુધારવું, દƺતાવે͂ કરણમાં સહાય 

અારાેƝય દદ̰ પૃથǲરણ (નાૅન-ડાયȘાે̔˶ક), માન̐સક અારાેƝય સહાય 

લેખન Ʊલાૅગ, કથાઅાે, ઇમેલ, સારાશં લખવંુ 

ǁાહક સેવા FAQ હેɱ̏લ̬ગ, અપાેઇɰમɰે બુ̋ક̬ગ 

˗̘Ǹગત ઉપયાેગ જનƙ̏લ̬ગ, યાેજના બનાવવી, ભાષા શીખવી 
 

ChatGPT Pro ની ખા̐સયતાે (Key Features in ChatGPT Pro) 

 GPT-4-turbo: વધુ શ̘Ǹશાળી અને કાયƙƖમ વઝƙન સુધી અૅȋેસ 

 મેમાેરી: પૂવƙ સǋાેમાંથી મા̋હતી યાદ રાખે છે (વપરાશકતાƙ ̏નયંǋણ હેઠળ) 

 ક˶મ ̏નદ̳શાે: ChatGPTને ˗̘Ǹગત રીતે વતƙન માટે સુચનાઅાે અાપી શકાય 

 ફાઇલ અપલાેડ: PDF, ˿ેડશીટ્સ અને અʈ ફાઇલ સાથે સંવાદ 
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 મ˄ીમાેડલ Ɩમતા: છબીઅાે ̀ેઈ અને સમજવા સƖમ 

 ʕગઇન અને ટૂ˔: ǒાઉ̏ઝ̬ગ, કાેડ ઇɰર̌ǐટર, અને થડƙ પાટ̰ ʕગઇʉ (જમે કે ǐવાસ, ચાટƙ વગેરે 
માટે) 

ChatGPTના લાભાે (Advantages of ChatGPT) 

 ઝડપી, લવચીક અને સંવાદશીલ 

 અનેક Ɩેǋાેમાં ઉપયાેગી 

 મેમાેરી અને ક˶માઇઝેશનથી અનુકૂળ અનુભવ 

 વેબસાઇટ, માેબાઇલ અેƯસ અને API ɦારા ઉપલʤ 

મયાƙદાઅાે (Limitations) 

 Ȃારેક ખાેટી અથવા જૂની મા̋હતી અાપી શકે છે 

 ǒાઉ̏ઝ̬ગ સ̋ƿય ન હાેય તાે હકીકતાેના ͅપરેખા થકી ̀ણકારી અાપે છે 

 Ȃારેક યાેƝય ન હાેય તેવું અાઉટપુટ જનરેટ થઈ શકે છે (યાદગાર ̏નયંǋણ હાેવા છતાં) 

 ̏ન˧ાત માનવ સલાહ (કાનૂની, તબીબી, નાણાકીય)નું ˺ાન લઈ શકતું નથી 

3. વી̋ડયાે કાʃેર̙ʉ̬ગ અન ેઅાેનલાઈન ̍મ̋ટ̬ગ અે̖ ʕકેશʉ 

̍વ̋ડયાે કાેʃર̘ʉ̬ગ અે̖ʕકેશʉ અે સાેʘવેર ટૂ˔ છે જ ે˗̘Ǹઅાેને અલગ અલગ ˺ળેથી ઈɰરનેટ 
મારફતે ̋ રયલ-ટાઈમમાં ̍ વ̋ડયાે, અાૅ̋ડયાે અને લખાણ ɦારા સંવાદ કરવાની મંજૂરી અાપે છે. અાેનલાઈન ̌ મ̋ટ̬ગ 
અે̖ ʕકેશʉમાં ˲ીન શે̋ રગ̬, ચેટ, ˚ાઇટબાેડƙ, ફાઇલ શે̋રગ̬ અને રેકાે̋ડ̮ગ જવેી સહયાેગી સુ̍વધાઅાે પણ 
હાેય છે. 

હેતુ અને મહɗ 

 દૂર˺ સંવાદ અને સહકારને શȂ બનાવે 
 ˗વસા̍યક ̌મ̋ટ̬ગ, અાેનલાઈન ̏શƖણ, હેˉકેર (ટે̏લમે̋ ડ̐સન), ઇવેɰ્સ અને સામા̏જક સંપકƙમાં 

ઉપયાેગ થાય છે 
 COVID-19 પછી દૂર˺ કાયƙ માટે મહɗપણૂƙ બની ગઈ 

મȕુ સુ̍વધાઅાે 

સુ̍ વધા વણƙન 

̍વ̋ડયાે અને અાૅ̋ડયાે કાેલ વેબકેમ અને માઇƿાેફાેન ɦારા ̋રયલ-ટાઈમ સંવાદ 

˲ીન શે̋રગ̬ તમારી ˲ીનના કɰેɰ અʈ સʬાેને બતાવવાે 
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ચેટ મેસે̏જ̬ગ ̌મ̋ટ̬ગ દરʸાન લખાણ અાધા̋રત સદેંશાઅાે 

રેકાે̋ડ̮ગ ̌મ̋ટ̬ગને ભ̍વˮમાં ઉપયાેગ માટે સાચવવું 

̌મ̋ટ̬ગ શેȻુ̏લ̬ગ પૂવ̳થી ̌મ̋ટ̬ગ ̏નધાƙ̋રત કરવી (કૅલેɱર સાથે સંક̏લત) 

ǒેકઅાઉટ ͅમ સʬાેને નાના જૂથામેાં વહ̲ચવી 

વȢુƙઅલ બેકǁાઉɱ પૃʕ ભૂ̌મને બદલવી અથવા ધંૂધળી કરવી 

સુરƖા સુયાેજન પાસવડƙ સુરƖા, વેઇ̋ટ̬ગ ͅમ, અેિƮƿƯશન 

 

વી̋ડયાે કાેʃર̙ʉ̬ગના ǐકાર 

ǐકાર ઉદાહરણ ઉપયાેગ 

વન-ટુ-વન ̌મ̋ટ̬ગ ઇɰર˗ૂ, ખાનગી ચચાƙ 

જૂથ ̍વ̋ડયાે કાેલ ટીમ ̌મ̋ટ̬ગ, દૂર˺ વગા̳ 

વે̐ બનાર માેટી સȕંામાં દશƙકાે માટે ǐƺતુ̍ ત 

વȢુƙઅલ ઇવેɰ કાેʃરʉ, અƛે˾ાે, પનેલ ચચાƙ 

ટે̏લǐેઝʉ ̐સ˶મ ઉȝ ƺતરીય કાેપા̳રેટ સંવાદ માટે 

લાેક̌ǐય અે̖ʕકેશʉ 

 Zoom 

 Google Meet 

 Microsoft Teams 

 Cisco WebEx 

 Bharat VC / Say Namaste (ભારતના ̏નમાƙણ) 

લાભાે 

 સુ̍ વધાજનક: ̍વ˝ના Ȃાંયથી પણ ̀ેડાઈ શકાય 
 ખચƙમાં બચત: મુસાફરી અને રહેવાના ખચƙ બચાવ ે
 કાયƙƖમતા: ̋રયલ-ટાઈમ ̏નણƙય અને સહયાેગ 
 સવƙસમાવેશક: દૂર˺ અને ̍વકલાંગ કમƙચારીઅાે માટે સહાયક 
 ˱ેલે̐ બ̏લટી: 1 થી 1000+ લાેકાે માટે ઉપયાેગી 
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પડકારા ે

પડકાર વણƙન 

ઈɰરનેટ ̏નભƙરતા સારી ગુણવɇા માટે ̗˺ર ઈɰરનેટ જͅરી 

સુરƖા ̎ચ̬તાઅા ે ડેટા લીક, ઝૂમબાે̗ʳ̬ગ 

થાક લાંબા ̍વ̋ડયાે કાેલથી થાક 

ટેǽાેલાે͂  અવરાેધ બધા વપરાશકતાƙ ટેકનાેલાે͂ ના ̀ણકાર નથી હાેતા 

ટાઈમ ઝાેનનાે ભદે વૈ̏ ˝ક ટીમાેમાં સમય સુમેળ ̎ચ̬તાઅા ે

યાƝેય અેપ પસંદ કરવી 

જ̋ͅરયાત Ǘેˤ ̍વકˍ 

નાની ટીમ માટે સહયાેગ Google Meet, Teams 

માેટા વે̐બનાર / ઇવેɰ Zoom, WebEx 

સુરƖા કેિƮǍત ઉɥાેગ Cisco WebEx, Teams 

શૈƖ̒ણક ઉપયાેગ Google Meet, Zoom 

સરકાર / ભારતીય ડેટા માટે Bharat VC, Say Namaste 

કાેણ શું પસંદ કરે? 

 ̍વɥાથ̰ અને ̏શƖકા:ે Google Meet અથવા Zoom 

 ˗વસાય / ઉɥાેગ: Zoom, Microsoft Teams, WebEx 

 સરકાર અને સૈʈ: Bharat VC 

 ˗̘Ǹગત ઉપયાેગ: Zoom, Google Meet (મફત સં˱રણ) 

̍વ̋ડયાે કાેʃર̙ʉ̬ગ અેપ કેવી રીતે વાપરવી? 

1. અેપ પસંદ કરાે અને ઇʊાેલ કરાે 

o Zoom/WebEx/Teams: અાૅ̋ ફ̏શયલ વેબસાઇટ કે અેપ ˶ાેરથી ડાઉનલાેડ કરાે 

o Google Meet: ǒાઉઝરમાં ચાલે છે અથવા માેબાઇલ અેપ ઇʊાેલ કરા ે

o Bharat VC: સામાʈ રીતે સરકાર માટે, વેબ અાધા̋રત 

2. સાઇન અપ કરાે અથવા લાેગ ઇન કરાે 
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o ઇમેઇલ, Google અથવા Microsoft IDથી અેકાઉɰ બનાવાે 

o Zoom, Google Meet જવેી કેટલીક અેƯસ માટે ગે˶ તરીકે ̀ેડાવાનું ̍વકˍ છે 

3. તમા̈́ં અાૅ̋ડયાે અને ̍વ̋ડયાે સટે કરા ે

o કેમેરા અને માઇƿાેફાેનને અȋૅેસની મંજૂરી અાપા ે

o માઇક, ˾ીકર અને કેમેરા ટે˶ કરા ે

o વȢુƙઅલ બેકǁાઉɱ પસંદ કરા ે

4. ̍મ̋ટ̬ગ બનાવાે અથવા ̀ેડાવા માટે 
➤ ̌મ̋ટ̬ગ બનાવવા માટે: 

o “New Meeting” અથવા “Schedule” પર ̚ȃક કરાે 

o શીષƙક, સમય અને તારીખ સટે કરાે 

5. ̍મ̋ટ̬ગ ̏લ̬ક અથવા ID શેર કરા ે
➤ ̌મ̋ટ̬ગમાં ̀ેડાવા માટે: 

o “Join” પર ̚ȃક કરા ે

o ̌મ̋ટ̬ગ ID દાખલ કરાે અથવા ̏લ̬ક ̚ȃક કરા ે

o જͅર હાેય તાે પાસકાેડ દાખલ કરાે 

6. ̍મ̋ટ̬ગ કƮǇાે̝  વાપરા ે

કƮǇાેલ હેત ુ

માઇક ચાલુ/બંધ અવાજ ̏નયં̍ ǋત કરા ે

̍વ̋ડયાે ચાલુ/બંધ કેમેરા ચાલુ કે બંધ કરાે 

ચેટ સંદેશા માેકલા ે

˲ીન શેર ǐેઝેɰેશન, ડાેȂુમેɰ બતાવાે 

રેકાેડƙ ̌મ̋ટ̬ગ સાચવાે (̀ેઇɰ હાે˶  હાેય તાે) 

પા̋ટ̭̐સપɰ્સ કાેણ ̀ેડાયું છે તે જુઅા ે

લીવ / અેɱ બહાર નીકળાે અથવા ̌મ̋ટ̬ગ બંધ કરાે 

7. વૈક̖ˍક સુ̍વધાઅાે 
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o ǒેકઅાઉટ ͅમ (Zoom, WebEx) 

o Raise Hand (Zoom, Teams) 

o Live Captions (Google Meet, Teams) 

o Polling / Whiteboard (ફીડબેક માટે) 

સુરƖા સૂચના ે

 વેઇ̋ટ̬ગ ͅમ અને પાસવડƙનાે ઉપયાેગ કરાે 

 ̏લ̬ક ̀હેરમાં ન શેર કરા ે

 બધાને ̀ેડાઈ ગયા પછી ̌મ̋ટ̬ગ લાેક કરાે 

 અેપ ̏નય̌મત અપડેટ કરા ે

4. ̋ડ̏જટલ સલામતી, ̋ડ̏જટલ સુરƖા, સાયબર Ǒાેડ, સાયબર સુરƖા, નાણાકીય Ǒાેડ, 
નાણાકીય સુરƖા 

̋ડ̏જટલ સલામતી અને ̋ડ̏જટલ સુરƖા: 

 ̋ડ̏જટલ સલામતી અે ̋ડ̏જટલ ટેǽાેલાે͂ (જમે કે ઇɰરનેટ, સાે̏ શયલ મી̋ડયા, માેબાઇલ ̋ડવાઇસ અને 
અʈ અાૅનલાઇન ʕેટફાેમƙ) નાે સુર̐Ɩત અને જવાબદાર ઉપયાેગ છે. તેનાે હેતુ છે પાેતાની ̀તને, પાેતાની 
મા̋હતી અને ̋ ડ̏જટલ હાજરીને ˱ ેમ, સાયબરબુ̏ લ̬ગ, અાેળખ ચાેરી અને હા̏નકારક કɰેɰથી બચાવવી. 

 ̋ડ̏જટલ સુરƖા અે તકનીકી ટૂ˔, ̐ સ˶માે અને ǐાે̐ સજર છે જ ે̋ ડ̏જટલ ઉપકરણાે, નેટવȋƙ અને ડેટાને 
અન̍ધકૃત અૅȋેસ, નુકસાન અથવા હુમલાથી સુર̐Ɩત રાખે છે. તેનાે મુȕ ઉɠેશ ડેટાનું રહ̃ɗ 
(confidentiality), અખં̋ડતતા (integrity), અને ઉપલʤતા (availability) ̀ળવવાનું હાેય છે  જેન ે
"CIA ̍ǋકાેણ" કહેવામાં અાવ ેછે. 

 ̋ડ̏જટલ સલામતી અે અે વાત પર ɪાન અાપે છે કે તમે ટેǽાેલાે͂ નાે ઉપયાેગ કેવી રીતે સલામતીપૂવƙક 
કરાે છાે. ̋ડ̏જટલ સુરƖા અે અે બાબત છે કે કાેણ/શંુ તમારી ટેǽાેલાે͂ અને ડેટાને સરુ̐Ɩત રાખે છે. 

 ̋ડ̏જટલ સલામતી = લાેકાેમાં અાૅનલાઇન સલામત વતƙન માટે ̀ગૃતતા અને ̏શƖણ અાપવંુ. 
̋ડ̏જટલ સુરƖા = ડેટા અન ે ટેǽાેલાે͂  ઈƮǑા˷Ǵરને સુર̐Ɩત રાખવા માટેના ̐સ˶મ અને ટૂ˔ 
̍વકસાવવા. 

 ̀ે ̋ડ̏જટલ સલામતી ન હાેય, તાે Ǘેˤ સુરƖા સાધનાે પણ બાઈપાસ થઈ શકે છે (જેમ કે યુઝર ̋ફ̏શ̬ગ 
̏લ̬ક પર ̚ȃક કરી દે). અને ̀ે ̋ડ̏જટલ સુરƖા ન હાેય, તાે સાવચેત યુઝરાે પણ હે̋ક̬ગ જવેા ખતરા સામે 
બચી શકતા નથી. 
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̋ડ̏જટલ સુરƖા કેમ મહɗપૂણƙ છે? 
̋ડ̏જટલ રીતે સુર̐Ɩત રહેવું: 
● તમારી ˗̘Ǹગત મા̋હતીનું રƖણ કરે છે 
● સાઈબર ગુનાહીતાેથી તમને સુર̐Ɩત રાખે છે 
● ભાવનાɒક અને અા̎થ̭ક નુકસાનને અટકાવે છે 
● અાદરપૂવƙક અને જવાબદાર અાેનલાઈન વતƙનને ǐાɘેા̋હત કરે છે 

̋ડ̏જટલ સુરƖાના મુȕ તɊાે: 

1. ˗̘Ǹગત મા̋હતીનંુ રƖણ 
○ તમા̈́ં પૂ̈́ ં  નામ, સરનામુ,ં ફાેન નંબર અને પાસવડƙ જેવી ખાનગી મા̋હતી ̀હેર ʕેટફાેમƙ પર ન 
શેર કરાે. 

2. સુર̐Ɩત ǒાઉ̎ઝ̬ગની અાદતા ે
○ ફǸ ̍વ˝સનીય વેબસાઇટ્સ જ અાેપન કરાે ("https" અને ̐સȂાે̋રટી પડેલાેક ̀ેઈને 
અાેળખાે). 
○ શંકા˾દ ̏લ̬ȋ અથવા પાપે-અƯસ પર ̚ȃક ન કરાે. 

3. મજબૂત પાસવડ્ƙસનાે ઉપયાગે 
○ દરેક ખાતા માટે અનʈ અને જ̋ટલ પાસવડ્ƙસ વાપરા.ે 
○ વધારાની સુરƖા માટે 2-Factor Authentication (2FA) સƖમ કરાે. 

4. ઠગાઈ અને ̋ફ̐શ̬ગથી ̀ગતૃ રહાે 
○ ખાેટા ઈમે˔, મેસે̏જસ અથવા વેબસાઇટ્સથી સાવધાન રહાે, જ ેતમારી ખાનગી મા̋હતી 
મેળવવાનાે ǐયાસ કરે છે. 
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5. ǐાઈવસી સે̋ટ̬Ɲસનંુ સંચાલન 
○ અે̖ʕકેશʉ અને સાે̏શયલ મી̋ડયા પરના ǐાઈવસી સે̋ટ̬Ɲસ ̏નય̌મત રીતે તપાસા ેકે જથેી કાેણ 
તમારી મા̋હતી ̀ેઈ શકે તેનું ̏નયંǋણ રાખી શકાય. 

6. હા̏નકારક કɰેɰ અને સંપકા̳થી બચા ે
○ સાયબરબુલીઝ, અાેનલાઈન ̏શકારી અને અયાેƝય કɰેɰને ̋રપાેટƙ કરાે કે Ʊલાેક કરાે. 
○ બાળકાે માટે પેરેɰલ કંǇાેલનાે ઉપયાેગ કરાે. 

7. ̋ડ̏જટલ ફુટ̌ǐɰ ̍વશે ̀ગૃત રહા ે
○ કાેઈ પણ વƺતુ પાે˶ કરતા ંપહેલાં ̍વચાર કરાે, તમે અાેનલાઈન શું શેર કરાે છાે તે કાયમ માટે ɔાં 
રહી શકે છે. 

̋ડ̏જટલ સુરƖાના અʬાસના ઉદાહરણાે: 
● અ̀Ʃયા લાેકાે પાસેથી અાવેલા Ǒેɱ ̋રકવે˶ ̄ીકારવી નહ̯ 
● ̀હેર ʕેટફાેમƙ પર વાƺત̍વક નામની બદલે ઉપનામ વાપરવુ ં
● ઈમેલ અથવા મેસેજમાં અાવેલી શંકા˾દ ̏લ̬ȋ ̚ȃક ન કરવી 
● બાળકાેને અાેનલાઇન તેમની ˗̘Ǹગત મા̋હતી શેર ન કરવાનું શીખવવું 
● મજબૂત અને અનʈ પાસવડ્ƙસનાે ઉપયાેગ કરવાે 
● ̐સȂાે̋રટી ખામીઅાેને ઠીક કરવા માટે સાેʘવેર ̏નય̌મત રીતે અપડેટ કરવા 
● ȱારે જͅરી ન હાેય ɔારે લાેકેશન સ̍વ̭̐સસ બંધ રાખવી 
● અાેનલાઇન દુ ƙ̠વહાર કે ધમકી મળવા પર ʕેટફાેમƙ માડેરેટસƙ કે અ̍ધકારીઅાેને ̋રપાેટƙ કરવુ ં

̋ડ̏જટલ સુરƖાના મુȕ ઘટકાે: 

1. અાેથ̔ɰકેશન અને અેȋેસ કંǇાેલ: 
○ પાસવડ્ƙસ, ̌પન, બાયામેે̋Ǉȋ 
○ મ˄ી-ફેǶર અાથે̔ɰકેશન (MFA) 

2. મા̋હતીનું રƖણ: 
○ ઇમેઇ˔, ફાઇલાે, ડેટાબેઝ માટે અેિƮƿƯશન 
○ સુર̐Ɩત બેકઅƯસ 

3. મેલવેરથી સુરƖા: 
○ અેɰી વાયરસ અને અેɰી ˾ાયવેર સાેʘવરે 
○ અન̍ધકૃત ǐવેશ અટકાવવા માટે ફાયરવાેલ 

4. નેટવકƙ  સુરƖા: 
○ વાઈ-ફાઈ નેટવકƙ ને સુર̐Ɩત બનાવવુ ં
○ VPN (વȢુƙઅલ ǐાઈવેટ નેટવકƙ) નાે ઉપયાેગ 
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5. સાેʘવેર અપડેટ્સ અને પે̎ચ̬ગ: 
○ અાેપરે̋ટ̬ગ ̐સ˶મ અને અે̖ ʕકેશʉને ̏નય̌મત રીત ેઅપડેટ કરાે 

6. ઇ̙ʉડɰ ̋ર˾ાʉે ʕા̏ન̬ગ: 
○ ભંગાણાે, મા̋હતી લીક કે ̐સ˶મ ફેલ થવા જવેી ઘટનાઅાે માટે પહેલેથી ǐાેટાેકાેલ તૈયાર રાખવાે 

̋ડ̏જટલ સુરƖા અમલમાં કેવી રીતે દેખાય છે: 
● અન̍ધકૃત ǐવેશ અટકાવવા માટે ફાયરવાેલ ˺ા̌પત કરવી 
● Signal અથવા ProtonMail જવેી અેિƮƿʍેડ સંદેશા˗વહાર ટૂ˔નાે ઉપયાેગ 
● સં˺ ાઅાેમાં ̏નય̌મત સુરƖા અાે̋ડટ 
● મા̋હતીનંુ અાપમેળે ȃાઉડ ˶ાેરેજમાં બેકઅપ લેવાે 

̋ડ̏જટલ સુરƖા અને ̋ડ̏જટલ સલામતી વȝેનાે સંબંધ: 

પાસુ ં ̋ડ̏જટલ સલામતી ̋ડ̏જટલ સુરƖા 

કેƮǍ̐બ̬દુ વપરાશકતાƙનું વતƙન અને 
અાેનલાઈન ˗વહાર 

̐સ˶મ/મા̋હતીનું ટે̚ǽકલ રƖણ 

મȕુ હેતુ ˗̘Ǹને નુકસાનથી બચાવવાે મા̋હતી અને ઉપકરણાેને ભંગ અને 
દુ̈́પયાેગથી બચાવવાે 

ઉપયાેગમાં લેવાતા 
સાધના ે

̀ગૃ̍ ત, ̏શƖણ, ને̋ટકેટ અેિƮƿƯશન, ફાયરવાેલ, અાેથ̔ɰકેશન 
̐સ˶ʼ 

જવાબદારી અં̍ તમ વપરાશકતાƙ (˗̘Ǹગત) IT ̍વભાગાે, સાયબર̐સȂુ̋ રટી ̏ન˧ાતાે 

ઉદાહરણાે ઠગાઈથી બચવું, સુર̐Ɩત પાસવડƙ 
વાપરવા ે

અɰેી-વાયરસ સાʘેવેર, સુર̐Ɩત સવƙસƙ, 
અેિƮƿƯશન 

 

સાયબર ઠગાઈ અને સાયબર સુરƖા: 

 સાયબર ઠગાઈ (Cyber Fraud) અે ̋ડ̏જટલ માɪમાે (ઈɰરનેટ, કƳʔુટર, ́ાટƙફાેન વગરેે) ɦારા થતી 
અેવી ગુના̋હત ǐવૃ̍ ɇઅાેને કહે છે જમેાં ˗̘Ǹઅાે કે સં˺ ાઅાેને છેતરવા માટે ટેકનાેલાે͂નાે ઉપયાેગ 
થાય છે, જેનાે હેતુ નાણાકીય લાભ કે ˗̘Ǹગત લાભ મેળવવાે હાેય છે. ઠગાે ˗̘Ǹઅાેને પૈસા કે 
̐સ˶મની અૅȋેસ અાપવા માટે દબાણ કરે છે. 

 સાયબર સુરƖા (Cyber Security) અે કƳʔુટર, નેટવકƙ , સાેʘવેર અને મા̋હતીને અન̍ધકૃત ǐવેશ, 
સાયબર હુમલાઅાે કે નુકસાનથી રƖણ અાપતી ǐથાઅા,ે સાધનાે અને ̐સ˶ʼનાે સમાવેશ કરે છે. તેનાે 
હેતુ ̋ડ̏જટલ સંપ̍ɇનું રƖણ કરવાે અને મા̋હતીની Confidentiality (ગાેપનીયતા), Integrity 
(અખંડતા), Availability (ઉપલʤતા) સુ̏ ન̏˛ત કરવી છે. 
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 સાયબર ઠગાઈ અે ધમકી છે જ ેછેતર̌પ̬ડી અને ટેકનાેલાે͂  ɦારા ચાેરી અથવા દુͅપયાેગ કરે છે. સાયબર 
સુરƖા અે બચાવ છે જે અાવા ધમકીથી બચાવવા, શાેધવા અને જવાબ અાપવા માટે તમામ સાધનાે અને 
˗ૂહરચનાઅાેનાે સમાવેશ કરે છે. 

 ̀ે સાયબર ઠગાઈ અે અેક ચાેર છે જ ેતમને તમારાે દરવા̀ે ખાેલાવવાનાે ǐયાસ કરે છે, તાે સાયબર સુરƖા 
અે અે લાૅક છે, અેલામƙ છે અને વાૅચડાૅગ છે જ ેતમારા ઘરની રƖા કરે છે. 

સાયબર ઠગાઈના સામાʈ ǐકારા:ે 

1. ̋ફ̐શ̬ગ (Phishing): 
○ ખાેટા ઈમે˔ કે વેબસાઇટ્સ વપરાશકતાƙને પાસવડƙ, ƿે̋ડટ કાડƙ નંબર કે ˗̘Ǹગત મા̋હતી 
અાપવામાં ફસાવે છે. 

2. ̍વ̐શ̬ગ અને ̖́̐શ̬ગ (Vishing and Smishing): 
○ ̍વ̐શ̬ગ: ફાેન કાે˔ ɦારા ̋ફ̏શ̬ગ 
○ ̖́̐શ̬ગ: SMS ɦારા ̋ફ̏શ̬ગ 

3. અાેળખ ચાેરી (Identity Theft): 
○ કાેઈની ˗̘Ǹગત મા̋હતી (જમે કે અાધાર નંબર, સરનામું, બ̲ક ̍વગતાે) ચાેરીને તેમની અાેળખનાે 
દુͅપયાેગ કરવાે. 

4. અાેનલાઇન ઠગાઈ અને શાે̌પ̬ગ Ǒાેડ: 
○ ખાેટા અાેનલાઈન ˶ાેસƙ, Ǒાેડ વેચાણકતાƙઅાે, કે ચુકવણી પછી માલ ન માેકલવાે. 

5. રેʉમવેર હુમલા (Ransomware Attacks): 
○ મેલવેર ફાઇ˔ને અેિƮƿʍ કરે છે અને ડી̋ƿƯશન કી માટે પસૈા માંગે છે. 

6. ̐બઝનેસ ઈમેલ કʲાેમાઇઝ (BEC): 
○ હેકસƙ કાેઇ અેિƛઝȂુ̋ટવ કે સʕાયરનાે ભાસ કરીને કમƙચારીઅાેને પૈસા Ǉાʉફર કરવા માટે 
છેતરે છે. 

7. ƿે̋ડટ કાડƙ અને બ̲̋ક̬ગ Ǒાેડ: 
○ ચાેરાઈ ગયેલી કાડƙની મા̋હતીથી અન̍ધકૃત ખરીદી કે લેવડદેવડ કરવી. 

8. ̏નવેશ અને ̋ƿʍાેકરʉી Ǒાેડ: 
○ પાેɯી ˱ીʼ, ખાેટા ̋ƿʍાે વાૅલેટ્સ, અને પંપ-અેɱ-ડʱ ˱ેʼ. 

સાયબર ઠગાઈના ઉદાહરણાે: 

 ખાેટાે PayPal ઈમેલ કે જમેાં અેક ̏લ̬ક ɦારા "તમા̈́ં ખાતંુ ચકાસા"ે અેવંુ કહેવામાં અાવે 
 WhatsApp પર મળેલાે મેસજે કે જમેાં કહેશે કે તમે લાેટરી ͂તી છે અને તેને મેળવવા માટે પૈસા માેકલવા 

પડે 
 ડે̋ટ̬ગ અેƯસ પર ખાેટી ǐાેફાઇલ બનાવીને પસૈા માંગવાનંુ 
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સાયબર સુરƖાના મુȕ ઘટકાે: 

1. નેટવકƙ  સુરƖા: 
○ ફાયરવાેલ, ઇƮǇુઝન ̋ડટેȆન ̐સ˶મ અને અૅȋેસ કંǇાેલનાે ઉપયાેગ કરીને અાતં̋રક નેટવકƙનું 
રƖણ 

2. અે̖ ʕકેશન સુરƖા: 
○ ̐સȂાેર કાે̋ ડ̬ગ, ટે̔˶̬ગ અને અપડેટ ɦારા સાેʘવેર અને અે̖ʕકેશનને સુર̐Ɩત રાખવા 

3. અɱેપાેઇɰ સુરƖા: 
○ અેɰીવાયરસ, પચે મેનેજમેɰ અને ̋ડવાઈસ માે̏નટ̋રગ̬થી કƳʔુટર, ફાેન અને ટેબલેટને 
સુર̐Ɩત બનાવવા 

4. ડેટા સુરƖા: 
○ અેિƮƿƯશન, મા̔˱̬ગ અને સુર̐Ɩત બેકઅપથી ડેટાનંુ રƖણ કરવું 

5. ȃાઉડ સુરƖા: 
○ AWS, Azure જવેી ȃાઉડ સેવા પર સંǁ̋હત મા̋હતીનું અૅȋેસ કંǇાેલ અને અાળેખ 
˗વ˺ાપન ɦારા રƖણ 

6. અાેળખ અને અૅȋેસ મેનેજમેɰ (IAM): 
○ ફǸ અ̍ધકૃત વપરાશકતાƙ જ ̐સ˶મ કે મા̋હતી અȋૅસે કરી શકે તેની ખાતરી કરવી 

7. ઇ̙ʉડɰ ̋ર˾ાʉે: 
○ સાયબર ઘટનાઅાેની અાળેખ, ǐ̍તસાદ અને પુનઃǐા̍ʏ માટેની યાેજના અને ǐાેટાેકાેલ 

સાયબર સુરƖા અમલમાં: 

● અેક કરતા વધુ અાેળખ (MFA) નાે ઉપયાેગ બ̲̋ક̬ગ અને ઈમેલ અેકાઉɰમા ં
● સં˺ ાઅાે ɦારા નેટવકƙ  Ǉા̋ફક માે̏નટર કરવા માટે ઇƮǇઝુન ̋ડટેȆન ̐સ˶મ ˺ા̌પત કરવી 
● ફાઈલાેને ȃાઉડમાં સંǁહ કરતા પહેલા અેિƮƿʍ કરવી 

સાયબર ઠગાઈ અને સાયબર સુરƖા વȝેનાે સબંંધ: 

પાસુ ં સાયબર ઠગાઈ સાયબર સુરƖા 

̄ͅપ ̋ડ̏જટલ છેતર̌પ̬ડી ɦારા ગુના̋હત 
ǐવૃ̍ ɇ 

સુરƖા માટેના રƖણાɒક પગલાં 

હેતુ વપરાશકતાƙઅાેને છેતરવુ ં ધમકીઅાે સામે રƖણ અાપવુ ં

̋ƿયાǐેરક હેકસƙ, ઠગાે, સાયબર ̋ƿ̌મન˔ IT ̏ન˧ાતાે, સુરƖા ̐સ˶ʼ, સં˺ ાઅા ે
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વપરાયેલી 
રીતા ે

̋ફ̏શ̬ગ, ઠગાઈ, નકલ, મેલવેર ફાયરવાેલ, અેિƮƿƯશન, અેɰીવાયરસ, 
̐સȂાેર ǐાટેાેકાેલ 

̏શકાર ˗̘Ǹગત વપરાશકતાƙઅાે, ˗વસાયાે, 
સરકારા ે

કાેઈપણ ̋ડ̏જટલ ̐સ˶મ કે વપરાશકતાƙ 

 

અા̎થ̭ક ઠગાઈ અને અા̎થ̭ક સુરƖા: 

▪ અા̎થ̭ક ઠગાઈ (Financial Fraud): 
અા અે ̋ƿયા છે જેમાં ˗̘Ǹ કે સં˺ા નાણાકીય લાભ મેળવવા માટે છેતર̌પ̬ડી કરે છે. તે ̍વ˝ાસ, ̐સ˶મ કે 
મા̋હતીનાે દુͅપયાેગ કરીને પૈસા, સંપ̍ɇ કે નાણાકીય અૅȋેસ મેળવવાનું કામ કરે છે. 

▪ અા̎થ̭ક સુરƖા (Financial Security): 
અા અે ̗˺̍ત છે જમેાં ˗̘Ǹ કે પ̋રવાર નાણાકીય રીત ે̗˺ર હાેય છે, છેતર̌પ̬ડી, અાક̖́ક ઘટના કે 
અા̎થ̭ક અાંચકાથી બચી શકે છે, અને વતƙમાન તથા ભ̍વˮના ખચા̳ પૂરા કરી શકે છે. 

▪ અા̎થ̭ક ઠગાઈ અ ેખતરાે છે જ ેતમારા નાણાં ચાેરી કરવાનાે ǐયાસ કરે છે. 

▪ અા̎થ̭ક સુરƖા અે ઢાલ છે જ ે સમજદારીથી કરેલી નાણાકીય યાેજના, સુરƖા અને ̏નયમનથી તમે 
ખતરાઅાેથી બચી શકાે છાે. 

અા̎થ̭ક ઠગાઈના સામાʈ ǐકારા:ે 

1. ƿે̋ડટ/ડે̐બટ કાડƙ  ઠગાઈ: 
○ ̍વનાઅનુમ̍ત કાેઈના કાડƙની મા̋હતીનાે ઉપયાેગ ખરીદી કે નાણાં ઉપાડવા માટે 

2. બ̲̋ક̬ગ ઠગાઈ: 
○ નકલી અેકાઉɰ, દƺતાવે̀ે કે ̍વના અનુમ̍ત Ǉાʉફર 
○ ATM ̔˱̌મ̬ગ કે ખાેટા ચેકના દાખલાઅાે 

3. ̏નવેશ ઠગાઈ: 
○ ફેક ˱ીʼ, પાેɯી યાેજના, અાતં̋રક વેપાર અને પંપ-અɱે-ડʱ 

4. અાેળખ ચાેરી: 
○ ˗̘Ǹગત મા̋હતીનાે ઉપયાેગ કરીને ખાતાં ખાેલવા કે લાેન લવેી 

5. પેરાેલ અને ખચƙ ઠગાઈ: 
○ કમƙચારી ɦારા ખાેટા દાવા કે કામના કલાકાેમાં ફેરફાર 

6. ઈƮƸયાેરʉ ઠગાઈ: 
○ ખાેટા દાવાઅાે ɦારા વીમા રકમ મેળવનાં ǐયાસા ે
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7. ચલણ અને ખરીદી ઠગાઈ: 
○ નકલી પુરવઠાકારના ̐બલા,ે ડુ̖ʕકેટ ચુકવણી અથવા વેચાણદાર સાથેની ̀ળ 

8. લાેન ઠગાઈ: 
○ ખાેટા દƺતાવે̀ે કે મા̋હતીના અાધાર પર લાેન મેળવવી 

અા̎થ̭ક ઠગાઈના ઉદાહરણાે: 

● કાેઈ ˗̘Ǹ તમારા નામે ƿે̋ડટ કાડƙ ખાેલે છે અને દેવંુ ચઢાવી દે છે 
● કાેઈ રાેકાણકારને ખાેટા ̋ƿʍાે ǐાેજǶેમાં વધારે વળતરનાે વાયદાે કરીને છેતરવામાં અાવે છે 
● કંપનીનાે અ̍ધકારી નાણા ઊભા કરવા માટે નાણાકીય ̋રપાેટƙમાં ફેરફાર કરે છે 

અા̎થ̭ક સુરƖાના મુȕ ઘટકાે: 

1. સુર̐Ɩત નાણાકીય ̐સ˶ʼ: 
○ બ̲કાે, પેમેɰ ગેટવે અને અે̖ʕકેશʉનું સાયબર અને શારી̋રક સુરƖા ɦારા રƖણ 

2. ˗̘Ǹગત નાણાકીય યાજેના: 
○ બજટે બનાવવાે, બચત કરવી અને સમજદારીથી રાેકાણ કરવંુ 

3. ̀ેખમ ˗વ˺ાપન: 
○ હેˉ, લાઇફ કે ̌મલકતના વીમાથી નાણાકીય ̀ેખમ ઘટાડવા ે

4. અે̔ ɰ-ઠગાઈ પગલાં: 
○ અેકાઉɰ માે̏નટ̋રગ̬, અલેટƙસ, મજબૂત પાસવડƙ અને MFA 

5. કાયદેસર અને ̏નયમન અનુસાર ǐ̋ƿયા: 
○ KYC, AML અને ડેટા સુરƖા કાયદાઅાેનું પાલન 

6. અાક̖́ક બચત અને સંપ̎ɇ સુરƖા: 
○ અાક̖́ક ખચƙ માટે બચત રાખવી અને રાેકાણમાં ̍વ̑ભɿતા લાવવી 

અા̎થ̭ક સુરƖા અમલમાં: 

● અાેનલાઇન બ̲̋ક̬ગ માટે બ-ેહʏાની અાેળખ (2FA) નાે ઉપયાેગ 
● 3-6 મ̋હના જેટલી અાવકની બચત ̀ળવી રાખવી 
● બ̲ક અને કાડƙ ˶ેટમેɰ્સ ̏નય̌મત તપાસવી 
● રાેકાણ માટે સુર̐Ɩત અને ̏નય̌મત ʕેટફામેƙ વાપરવુ ં

અા̎થ̭ક ઠગાઈ અને અા̎થ̭ક સુરƖા વȝેનાે સંબંધ: 

પાસુ ં અા̎થ̭ક ઠગાઈ અા̎થ̭ક સુરƖા 
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̄ͅપ છેતર̌પ̬ડી અને ગુના̋હત રƖણાɒક અને ˗ૂહાɒક 

હેતુ ̐બનકાયદેસર રીતે પસૈા મેળવવા નાણાકીય ̗˺રતા અને સલામતી 
̀ળવવી 

̋ƿયાǐેરક ઠગાે, ˱ેમસƙ, નમકહારાઅાે ˗̘Ǹઅાે, બ̲કાે, સરકારા,ે સરુƖા 
કંપનીઅાે 

̀ેખમ પૈસાની ખાેટ, ƿે̋ડટ ડેમેજ, કાયદાકીય 
મુƸકેલી 

બચત અને રાેકાણમાં અસમથƙતા 

બચાવ 
રીતા ે

ચેતવણી, ̋રપાે̋ટ̮ગ, કાનૂની કાયƙવાહી વીમાે, સાયબર સુરƖા, કાનૂની પાલન 

 

અા̎થ̭ક ઠગાઈ કેવી રીતે અા̎થ̭ક સુરƖાને ખાેરવે છે? 

 નાણા ચાેરી → તાȿા̏લક નાણાકીય ખાેટ 
 ƿે̋ડટ ˱ાેરમાં નુકસાન → લાેન મેળવવામા ંઅડચણ 
 ̐સ˶મ પર ̍વ˝ાસ ગુમાવવાે → રાેકાણ અને ̋ડ̏જટલ બચત સામે ભય 
 કાનૂની મુƸકેલીઅાે → ̏નદાષ̳ સા̐બત થવામાં સમય અન ેપૈસાનાે ખચƙ 

5. ઇમેઇલ અને સાે̐શયલ ̍મ̋ડયા મેનેજમેɰ ̐શƺત (Etiquette) 

ઇમેઇલ અને સાે̏શયલ ̌ મ̋ડયા મેનેજમેɰ અાજના ˗ાવસા̍યક અને ̠ વસાય સંબં̍ધત સંચારના મહɗપણૂƙ 
ભાગ છે. બંનેમાં ˗ાવસા̍યકતા, સમજદારી અને ǐેƖકાે માટે ̍વચારશીલતા જͅરી છે. 

ઇમેઇલ મયાƙદા (Email Etiquette): 

1. ̍વષય (Subject Line): 

● ̍વષય સાફ અને સીધા ેહાવેાે ̀ેઈઅે. તે ઇમેઇલનાે હેત ુદશાƙવવાે ̀ેઈઅે જથેી મેળવનાર તેને ǐાથ̌મકતા 
અાપી શકે. 

● ટંૂકી અને મા̋હતીસભર હાેવી ̀ેઈઅે. "Hello" કે "Update" જવેા અ˾ˠ ̍વષયથી બચાે. 
● અાખા કૅ̌પટલ અƖરમાં લખવાથી તે બૂમ પાડવાનું લાગી શકે છે. 

2. અ̐ભવાદન અને સંબાેધન (Greeting and Salutation): 

● અાપૈચા̋રક કે અનાૈપચા̋રક: સંબંધના અાધારે "Dear Mr. Smith" (અાેપચા̋રક) કે "Hi John" 
(અનાૈપચા̋રક) જવેા અ̑ભવાદનાે ઉપયાેગ કરાે. 
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● ઉપા̍ધનાે ઉપયાેગ: ̀ે મેળવનારની પસંદગી ̀ણતા ન હાે તાે "Dr." અથવા "Professor" જવેા ઉપા̍ધ 
વાપરવી સુર̐Ɩત પસંદગી છે. 

● ˗̘Ǹગત રીતે: નામ સાથે અ̑ભવાદન કરાે જથેી ઈમઇેલ વધુ ˗̘Ǹગત લાગે. 

3. ઈમેઇલનાે મુȕ ભાગ (Body of the Email): 

● ટંૂકંુ અને ˾ˠ: શȂ હાેય તેટલું ટંૂકંુ લખાે. લાંબુ લખાણ વાંચનારની ǐ̍ત̋ƿયા અાેછી કરી શકે છે. 
● રચના: પેરાǁાફ, બુલેટ પાેઈɰ્સ અને હે̋ડ̬ગનાે ઉપયાેગ કરાે જેથી વાંચવામાં સરળતા રહે. 
● ટાેન: ˗ાવસા̍યક ટાેન રાખાે. બહુ બેફામ કે અાેછી ભાષાનાે ઉપયાેગ ન કરાે. 
● ˗ાકરણ અને લેખન ભૂલ: ઇમેઇલ માેકલતા પહેલા પૃફરીડ કરાે જેથી ˗ાવસા̍યક છાપ રહે. 

4. ̀ેડાણ (Attachments): 

● મȕૂ લખાણમાં ઉ˒ેખ: ̀ેડાયેલ ફાઇલ ̍વશે ઈમેઇલમાં જણાવાે (જમે કે, "અહેવાલ ̀ેડાયેલ છે."). 
● માપ અને ફાેમ̳ટ: ફાઇલ બહુ માેટી ન હાેવી ̀ેઈઅે અન ેસામાʈ ફાેમ̳ટમાં હાેવી ̀ેઈઅે (PDF, Word 
વગરેે). માેટી ફાઇલ માટે Google Drive અથવા Dropbox નાે ઉપયાેગ કરાે. 
● ફાઇલનંુ નામ: "Sales_Report_Q1_2025.pdf" જેવા ˾ˠ નામ અાપાે, "Document1.pdf" નહ̯. 

5. જવાબ અાપવાે (Replying): 

● સમયસર: 24–48 કલાકમાં જવાબ અાપાે. વધુ સમય લાગી શકે તાે ǐા̍ʏના ̄ીકાર સાથે સંકેત અાપાે કે 
Ȃારે જવાબ અાપશાે. 

● Reply All નાે ઉપયાેગ ̍વચારીને કરાે: ̀ે જવાબ ફǸ અેક ˗̘Ǹ માટે હાેય તાે બધા લાેકાેને ન માેકલાે. 
● ટાેન: જમે ઈમેઇલનાે મૂળ ટાેન હાેય, તેમ જ જવાબ અાપાે (ફાેમƙલ હાેય તાે ફાેમƙલ જ રાખાે). 

6. ̐સȘેચર (Signature): 

● ˗ાવસા̍યક ̐સȘેચર: તમા̈́ં પૂ̈́ં નામ, પદ, કંપનીનું નામ અને સંપકƙ  ̍વગતાે હાેવી ̀ેઈઅે. જͅરી હાેય 
તાે લાેગાે કે LinkedIn જેવી ̏લ̬ક ઉમેરાે. 
● અ̍તશયતા ટાળાે: ̐સȘચેર સરળ અને ઉપયાેગી હાેવું ̀ેઈઅે, જͅર કરતાં વધુ મા̋હતી ન હાેવી ̀ેઈઅે. 

7. ગુʏતા (Confidentiality): 

● BCC ̍વ̈́ɡ CC: ̀ે તમે ઘણાં લાેકાેને ઈમેઇલ માેકલાે છાે અને તેઅાે અેકબી̀ન ેનથી અાેળખતા, તા ે
BCC નાે ઉપયાેગ કરાે જથેી ǐાઇવસી જળવાઈ રહે. 

● સંવેદનશીલ મા̋હતી: સંવેદનશીલ મા̋હતી માેકલતી વખતે અેિƮƿƯશન ̍વના ન માકેલાે. 

સાે̐શયલ ̍મ̋ડયા મેનેજમɰે મયાƙદા (̐શƺત): 

1. શૈલી અને અવાજ (Tone and Voice): 
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● સતતતા: અવાજ અને શલૈી તમારા ǒાɱના ̄ͅપ સાથે મેળ ખાતી હાેવી ̀ેઈઅ.ે ઉદાહરણ તરીકે, કાયદા 
̍વશેની કંપની માટે શૈલી અાેપચા̋રક હાયે ȱારે લાઇફ˶ાઇલ ǒાɱ માટે અનાૈપચા̋રક અને ̌મǋસભર હાેઈ 
શકે. 
● સંવા̋દતા: સાે̏શયલ ̌મ̋ડયા માǋ મા̋હતી અાપવાનુ ં માɪમ નહ̯, પણ સંવાદ માટેનું ʕેટફાેમƙ છે. 
̋ટʑણીઅાેને જવાબ અાપાે, પાે˶્સને લાઈક કરાે અને ફાેલાેઅરને સંલȘ રાખાે. 

● માʈતા અને ˗ાવસા̍યકતા: અનાૈપચા̋રક વાતચીતમાં પણ ˗ાવસા̍યકતા ̀ળવાે. ̍વવાદા˾દ ̍વષયાે 
કે નકારાɒક ̋ટʑણીઅાેથી બચાે. 

2. સામǁી વહ̲ચવી અને પાે˶  કરવું (Content Sharing and Posting): 

● ǐાસં̎ ગકતા: તમારી સામǁી તમારા ફાેલાેઅરના રસ અને જ̋ͅરયાતાે સાથે મેળ ખાવુ ં̀ેઈઅે. અનાવƸયક 
̍વષયાે પાે˶ કરવાથી ગેરસમજ ઊભી થઈ શકે છે. 

● માǋા કરતા ગુણવɇા: વારંવાર પાે˶ કરવાને બદલે ઉપયાેગી અને ̍વચારપૂવƙકની મા̋હતી જ રાે̏જ̬દી 
̏શƺતથી શેર કરાે. 

● વારંવાર: ખૂબ જ વધારે પાે˶ કરવાથી ફાેલાેઅર કંટાળી શકે છે, ȱારે અાેછી પાે˶્સથી અેƮગેજમેɰ ઘટી 
શકે છે. યાેƝય સંતુલન ̀ળવાે. 

3. ફાેલાેઅર સાથે સંવાદ (Interacting with Followers): 

● ǐ̍તસાદ અાપવાે: ̋ટʑણીઅાે અને સંદેશાઅાેને સમયસર જવાબ અાપાે. ફીડબેકને માʈતા અાપવી 
મહɗપૂણƙ છે. 

● સંયમ રાખવાે: સાે̏શયલ ̌ મ̋ડયા પર કાેઈ વાર તણાવ કે Ǉાે̏લ̬ગ થઈ શકે છે. શાંત અને અાદરસભર ભાષામા ં
જવાબ અાપાે. 

● ˗̘Ǹગત ˾શƙ: દરેક ̠ ̘Ǹને તેના યુઝરનેમ વડે સંબાેધન કરીને જવાબ અાપાે, જથેી ɪાન અને કાળ͂ 
દેખાય. 

4. હૅશટૅƝસ અને કીવડ્ƙસ (Hashtags and Keywords): 

● સંબં̍ ધત હૅશટૅƝસ: અેવી હૅશટૅƝસ વાપરાે જે તમારી પાે˶ સાથે સંબં̍ધત હાેય. ̐બનસંબં̍ધત હૅશટૅƝસ પણ 
˾ામ જવેી લાગી શકે. 

● Ǉે̓ɱ̬ગ ̍વષયાે: જઅેાે તમારા ǒાɱના મૂˑાે સાથે સુસગંત હાેય અેવા Ǉે̒ɱ̬ગ ̍વષયાે પર સામેલ થવું યાેƝય 
છે. 

5. ખાનગીતા અને મયાƙદાઅાે (Privacy and Boundaries): 

● ગાેપનીયતાનાે અાદર કરાે: કાેઈક ˗̘Ǹનું ફાેટાે કે મા̋હતી પાે˶ કરતા પહેલા તેમનાે સમં̍ત લાે. 
● સંવેદનશીલ ̍વષયાે: ̍વવાદા˾દ ̍વષયથી દૂર રહાે, ̀ે સુધી તમારા ǒાɱની ˾ˠ ̗˺̍ત ન હાેય. 
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● અ̍તશય મા̋હતી વહ̲ચવાથી બચાે: અંગત અથવા ̠ વસા̍યક મા̋હતી વધુ વહ̲ચવાથી ǐ̍તˤા ઉપર અસર 
પડી શકે છે. 

6. સંકટ ˗વ˺ાપન (Crisis Management): 

● સમયસર જવાબ: ̀ે કાેઈ નકારાɒક પ̋ર̗˺̍ત ઊભી થાય, તાે ઝડપથી અને ˗ાવસા̍યક રીતે જવાબ 
અાપાે. સમ̃ાનાે ઉ˒ેખ કરાે અને તેનાે ઉકેલ શંુ હશે તે જણાવાે. 

● પારદ̐શ̭તા: ખામી માનવી, માફી માગવી અને ઉકેલ તરફ અાગળ વધવું અા ̍વ˝ાસ જગાવવા માટે જͅરી 
છે. 
● શાં̍ત ̀ળવાે: Ȃારેય ગુ̅ ામાં ન અાવાે કે ̍વરાેધી ભાષા ન વાપરાે. શાં̍ત અને સમજદારી ̀ળવાે. 

7. પાે˶ ્ સનંુ શȻેુ̏લ̬ગ (Scheduling Posts): 

● સતતતા મહɗપૂણƙ: સમય પહેલાં પાે˶્સ શેȻુલ કરવાથી તમારી અાેનલાઈન હાજરી સતત જળવાઈ રહે 
છે. 
● અ̍તશય પાે̔˶̬ગથી બચાે: સતત પાે˶ કરા,ે પણ અેટલી બધી ન કરાે કે ફાેલાેઅર કંટાળી ̀ય. 

8. ̍વƸલેષણ અને ǐ̍તસાદ (Analytics and Feedback): 

● અƮેગેજમેɰ પર નજર રાખાે: કયા ǐકારની સામǁી પર સાૈથી વધુ ǐ̍ત̋ƿયા મળે છે તેનું ̍વƸલેષણ કરાે. 
● ǐ̍તસાદ અનુસાર ફેરફાર કરાે: ̀ે તમારી સામǁી બેસી ન રહી હાેય, તાે ˷ેટે͂ બદલાવ અને વધુ 
અનુͅપ મા̋હતી અાપાે. 

ઇમેલ અને સાે̐શયલ મી̋ડયા મેનેજમેɰ માટે સામાʈ Ǘેˤ ǐથાઅાે: 

1. સમયનંુ સંચાલન (Time Management): 

તમા̈́ં કામ ઇમેલ હાે કે સાે̏શયલ મી̋ડયા અેકાઉɰ મેનેજ કરવાનું હાેય, કાયƙને ǐાથ̌મકતા અાપવી 
અગɔની છે. ઈમેલના જવાબ અાપવા અને સાે̏શયલ મી̋ડયા પર સંલȘ થવા માટે ચાǲેસ સમય નǲી 
કરાે, પણ અે તમારા અાખા ̋દવસ પર હાવી ન થઈ ̀ય અેનું ɪાન રાખાે. 

2. ગંભીરતા અને અનાૈપચા̋રકતા વȝે સંતુલન (Balance Formality and Informality): 
˗ાવસા̍યક પ̋ર̗˺̍તમાં ગભંીરતા અને ̌મǋતાભયુ̫ વતƙન વȝે યાેƝય સંતુલન ̀ળવાે. ખૂબ જ ગંભીર 
લાગવું દુરભાવ ઉભાે કરી શકે છે, ȱારે વધુ અનાૈપચા̋રક હાેવું અમયાƙ̋દત જણાઈ શકે છે. 

3. અ̍તશયતા ટાળાે (Avoid Overload): 

ઈમેલ અને સાે̏ શયલ મી̋ડયા બંનેમાં તમે ઝડપથી વધુ સંવાદમાં ફસાઈ શકાે છાે. વધુ ઇમે˔ માેકલવી કે 
વધુ પાે˶ કરવી તમારા Ǘાેતાઅાેને પરેશાન કરી શકે છે.  સવંાદ હંમેશા હેતુપૂણƙ અને સબંં̍ ધત હાેવાે ̀ ઈેઅે. 
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4. સમય ઝાેનનાે અાદર કરાે (Respect Time Zones): 
વૈ̏ ˝ક ƺતરે સંવાદ ચલાવતી વખતે ǐાʏકતાƙના સમય ઝાનેનું ɪાન રાખાે. અનાૈપચા̋રક સમયાઅેે ઇમેલ 
માેકલવાનું કે પાે˶ કરવાનું ટાળા,ે ̀ે સુધી તે કાેઈ ˗ૂહાɒક ઉɠેશ માટે ન હાેય. 

5. સુરƖા અને ગાેપનીયતા (Security and Privacy): 
સંવદેનશીલ મા̋હતીની રƖા કરાે. ઈમેલ ɦારા પાસવડƙ કે ખાનગી મા̋હતી શેર કરવાનું ટાળાે અને ખાસ 
કરીને સાે̏શયલ મી̋ડયા પર શંુ શેર કરાે છાે તે અંગે સાવચેતી રાખા.ે 

 

 

6. તમા̈́ં કાયƙ ˗વ̘˺ત કરાે (અે̖ ʕકેશન): 

ટા˱ મેનેજમેɰ અે̖ʕકેશન અે સાેʘવેર ટૂલ છે જે વપરાશકતાƙઅાેને તેમના કાયƙ અને ǐાેજǶેાેને સંગ̋ઠત, 
ǐાથ̌મકતાવાર, Ǉેક અને મેનેજ કરવામાં મદદ કરે છે. અાવી અે̖ʕકેશનાે ˗̘Ǹગત વપરાશકતાƙઅાે, ટીમા ે
અને સં˺ ાઅાે માટે ઉપયǸુ છે જેથી તેઅાે ઉɎાદનƖમતા વધારી શકે, સમયસર કાયƙ પૂણƙ કરી શકે અને 
કામની ǐવાહરેખા સરળ બનાવી શકે. ટા˱ મેનેજમેɰ અે̖ʕકેશનનાે અસરકારક ઉપયાેગ કરીને તમે તમારા 
કાયƙƖમતા વધારે શકાે છાે, સંગ̋ઠત રહી શકાે છાે અને તણાવ ઘટાડાે કરી શકાે છાે ભલે તમે ˗̘Ǹગત કાયƙ 
કરી ર̈ા હાે કે ટીમ સાથે સહકારમાં. 

ટા˱ મેનેજમેɰ અે̖ʕકેશનની મȕુ ̍વશેષતાઅાે: 

1. કાયƙ બનાવવંુ અને સંગઠન: 

● ટા˱ અેƮǇી: વપરાશકતાƙઅાે ટા˱ બનાવી શકે છે, શીષƙક, વણƙન અને ̍વગતાે ઉમેરી શકે છે. 
● ટા˱ની ǐાથ̍મકતા: તાȿા̏લકતા અને મહɗના અાધારે (જમે કે: અાેછી, મɪમ, ઊંચી) ટા˱ને ǐાથ̌મકતા 
અાપી શકાય છે. 

● ̏નધાƙ̋રત તારીખાે અને ડેડલાઇન: ̏નધાƙ̋રત સમયસીમા સેટ કરી શકાય છે જથેી સમયસર કાયƙ પૂ̈́ થાય. 
● Ǘેણીઅાે કે ટૅƝસ: ટા˱ને “કાયƙ”, “ખાનગી”, “તાȿા̏લક” જવેી લેબ˔થી Ǘેણીકૃત કરી શકાય છે. 

2. ઉપકાયા̳ (Sub-Tasks): 

● માેટા કાયા̳નંુ ̍વભાજન: માેટા કાયƙને નાના પગલાંઅાેમા ંવહ̲ચી શકાય છે જેથી કાયƙ સરળ બને અને ǐગ̍ત 
̀ળવી શકાય. 

● ̋ડડેʉી ̋રલેશનશીƯસ: કેટલાક અેપમાં ટા˱ વȝે પર˾ર અાધાર સેટ કરી શકાય છે — કઈ કામગીરી 
પહેલાં કરવી અે નǲી કરી શકાય છે. 

3. ટા˱ યાદીઅાે અન ેǐાેજેǶ મેનેજમેɰ: 
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● ̍વ̍વધ યાદીઅાે અથવા ǐાેજેǶાે: તમે "કાયƙ", "ખાનગી", "માક̳̋ટ̬ગ કેʱેઇન", "ȃાયɰ ̋ડ̏લવરેબ˔" 
જવેી યાદીઅાે બનાવી શકાે છાે. 

● કાનબન બાેડƙ: ટા˱ને “કરવું છે,” “ǐ̋ƿયામાં,” “પણૂƙ” જેવી કાેલમામેાં મૂકી ̍વƣયઅુલ ͅપરેખા અાપી શકાય 
છે. 

4. સહકાર અને ટીમ મેનેજમેɰ: 
● ટીમ સʬાેને કાયƙ સા̲પવું: ચાેǲસ કાયƙને ટીમના સʬને સા̲પી ǐગ̍ત Ǉેક કરી શકાય છે. 
● ̋ટʑણીઅાે અને સંવાદ: ટા˱ પર સીધી ̋ટʑણીઅાે કરી સંવાદ સરળ બને છે. 
● ફાઈલ ̀ેડાણાે: જͅરી દƺતાવે̀ે સીધા ટા˱ સાથે ̀ેડીને બધંુ અેક જƝયાઅે રાખી શકાય છે. 

5. રીમાઇɱસƙ અને નાે̋ ટ̋ફકેશʉ: 
● અાટાેમે̋ટક રીમાઇɱસƙ: સમયસર યાદ અપાવવા માટે અલામƙ અથવા નાે̋ટ̋ફકેશન સેટ કરી શકાય છે. 
● પુષ નાે̋ટ̋ફકેશન: માેબાઇલ કે ડે˱ટાેપ પર ɗ̋રત અપડેટ મળે છે. 
● ઈમેલ અેલટƙ: કાયƙ પૂણƙ થવા પર કે ટીમના સʬની ̋ટʑણી માટે ઈમેલ નાે̋ટ̋ફકેશન મળે છે. 

6. સમય Ǉે̋ક̬ગ અને ઉɎાદકતા માે̏નટ̋ર̬ગ: 
● સમયનંુ ના̲ધણંુ: કેટલાે સમય કાેઇ કાયƙ પર ̍વતાવાયાે તે રેકાેડƙ કરી શકાય છે. 
● ǐગ̍ત સંકેતા:ે ǐગ̍ત બાર કે ટકાવારી દશાƙવી શકે છે કે તમે કાયƙ કેટલું પૂણƙ કયુ̫ છે. 

7. પુનરાવ̍ત̭ત કાયા̳ (Recurring Tasks): 
● પુનરાવ̍ત̭ત અાયાેજન: દરરાેજ, દર સʏાહે કે દર મ̋હન ેથતી કામગીરી માટે પુનરાવ̍ત̭ત ટા˱ સેટ કરી 
શકાય છે. 
● ટા˱ ટેʱલેટ્સ: વારંવાર થતા કાયા̳ માટે ટેʱલેટ બનાવવાથી સમય બચે છે. 

8. અʈ સાધનાે સાથે અેકીકરણ: 
● કૅલેɱર ઇ̔ɰǁેશન: Google Calendar, Outlook વગરેે સાથે ટા˱ ̐સɬ કરી શકાય છે. 
● તૃતીયપƖ ટૂ˔: Trello, Asana, Todoist જેવી અેપ Slack, Google Drive, Dropbox જવેી ટૂ˔ 
સાથે અેકીકૃત થઈ શકે છે. 
● ƿાેસ-ʕેટફાેમƙ ̐સ̬ƛગ: કાેƳʔુટર, ફાેન કે ટેબલેટ — તમામ ઉપકરણાેમાં કાયƙ ̐સɬ થાય છે. 

9. ̍વƸલેષણ અને અહેવાલ: 
● ǐગ̍ત અહેવાલ: પણૂƙ થયેલા, માેડા પડેલા કે ચાલુ રહેલા કાયા̳ ̍વશે ̋રપાેટƙ મળ ેછે. 
● ઉɎાદકતા ̍વશે ̀ણકારી: કેટલી કામગીરી પૂણƙ થઈ, કેટલાે સમય ખચાƙયાે તે અંગે અેના̏લ̋ટȋ 
ઉપલʤ હાેય છે. 

10. વપરાશકતાƙ ઇɰરફેસ (UI) અને ક˶માઇઝેશન: 
● અાसान ઇɰરફેસ: સરળ અને ˗ાકુલ ન કરતાે ઇɰરફેસ હાેવાે ̀ેઈઅે. 
● ક˶માઇઝ ˗ૂઝ: ̏લ˶, કેલɱેર, કાનબન બાેડƙ કે ̎ǁડ રીતે કાયા̳ દશાƙવી શકાય છે. 
● દેખાવ અને થીʼ: ડાકƙ  માેડ, ફાેɰ સાઇઝ, રંગાેની પસંદગી જવેી ͅપરેખાઅાે બદલી શકાય છે. 
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ટા˱ મેનેજમેɰ અે̖ʕકેશનનાે ઉપયાેગ કરીને કાયƙ ˗વ˺ાપન માટે Ǘેˤ પɡ̍તઅાે: 

1. કાયƙ વણƙનમાં ˾ˠતા રાખાે: 
● દરેક કાયƙ માટે ˾ˠ વણƙન અને લƽય હાેવું ̀ેઈઅે જથેી કાેઈ ગેરસમજ ન થાય. ઉદાહરણ તરીકે, 
"ǐેઝɰેશન તૈયાર કરાે" ના બદલે "Q1 વેચાણ ǐેઝɰેશન માટે ƺલાઈડ્સ બનાવાે" લખાે. 

2. ǐાથ̍મકતાનું યાેƝય રીતે ઉપયાેગ કરાે: 
● કાયƙની તાȿા̏લકતા અને મહɗના અાધારે તેને ǐાથ̌મકતા અાપા.ે "Critical", "High Priority", "Low 
Priority" જવેા લેબ˔નાે ઉપયાેગ કરીને મહɗના કાયƙ અાેળખી શકાય છે. 

3. વાƺત̍વક સમયમયાƙદા નǲી કરાે: 
● તમારા સમયની સાચી અસર અાંકીને શȂ હાેય તેવી ડેડલાઇન નǲી કરાે. અાેછા સમયમાં વધારે કાયƙ 
રાખવું બનƙઅાઉટ અથવા સમયમયાƙદા ચૂકી જવાની શȂતા ઊભી કરે છે. 

4. ̏નય̍મતપણે કાયƙની સમીƖા અને સુધારાઅાે કરાે: 
● તમારા ટા˱ ̏લ˶ની સમયાંતરે સમીƖા કરાે. જે કાયƙ ɪાન માંગે છે તે ̀ણા,ે સમયમયાƙદા સુધારાે અને 
પૂણƙ થયેલા કાયƙને અપડેટ કરાે. 

5. પુનરાવ̍ત̭ત કાયƙ માટે ટેʱલેટ બનાવાે: 
● ̀ે તમે વારંવાર સમાન ǐકારના કાયƙ કરાે છા,ે તાે ટેʱલટે બનાવવાથી સમય બચશે અને નવી ǐવેશ 
ǐ̋ƿયા સરળ બનશે. 

6. ટીમ ǐાેજેǶ માટે સહયાેગી સુ̍વધાનાે ઉપયાેગ કરાે: 
● કાયƙ ટીમના સʬાેને સા̲પા,ે ̋ટʑણીઅાે અને ફાઈ˔ ̀ેડીને સહયાેગ સાધાે. ઇમેલ કે અʈ ચેટ ટૂલના 
બદલે અે̖ʕકેશનમાં જ સંવાદ કરાે. 

7. રીમાઇɱસƙ અને નાે̋ ટ̋ફકેશʉનાે ઉપયાેગ કરા:ે 
● મહɗપૂણƙ કાયƙ માટે રીમાઇɱર સેટ કરાે, પણ વધુ અેલટƙથી પાેતાને અાેવરલાેડ ન કરાે. નાે̋ટ̋ફકેશન 
સે̋ ટ̬Ɲસ કાયƙના મહɗ અનુસાર ગાેઠવા.ે 

8. ̀તુ સધુારણા માટે સમય Ǉે̋ક̬ગનાે ઉપયાેગ કરાે: 
● ̀ે તમા̈́ં કાેઈ કાયƙ વધુ સમય લ ેછે, તાે સમય Ǉે̋ક̬ગ ફીચરનાે ઉપયાેગ કરીને ̐બનઉɎાદકતા અાેળખી 
શકાય છે અને ǐ̋ƿયામાં સુધારાે કરી શકાય છે. 

9. માેટા કાયƙને નાના ભાગામેાં વહ̲ચાે: 
● માેટંુ કાયƙ ડરામણું લાગી શકે છે. તેને નાના, કાયƙƖમ ભાગાેમાં વહ̲ચવાથી સફળતા અને ǐેરણા બંને મળે છે. 

10. પૂણƙ થયેલા કાયƙનું સમીƖણ કરાે: 
● સʏાહ કે મ̋હનાના અંતે પૂણƙ થયેલા કાયƙની સમીƖા કરાે. શું સા̈́ં થયુ,ં Ȃાં સુધારાે શȂ છે અને અાગળ 
શું મહɗપૂણƙ છે તે ̍વચારાે. 
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ǐȕાત ટા˱ મેનેજમેɰ અે̖ʕકેશનાે: 
અા બધા ફીચસƙ ધરાવતી કેટલીક લાેક̌ǐય અે̖ʕકેશનાે નીચે મુજબ છે: 

● Trello: ̍વƣયુઅલ ટા˱ મેનેજમɰે અેપ જે કાનબન બાેડƙ ɦારા કાયƙને ગાેઠવે છે — ˗̘Ǹગત અને ટીમ 
માટે પરફેǶ. 
● Asana: ǐાેજǶે મેનેજમેɰ માટે અેડવાંસ ટૂલ, જ ેટાઈમલાઇન, ̋ડપેɱʉી અને ̋રપાે̋ટ̮ગ ફીચસƙ અાપે 
છે. 
● Todolist: સરળ પણ શ̘Ǹશાળી ટૂ-ડુ ̏લ˶ અેપ જ ેકાયƙની ǐાથ̌મકતા, લેબ˔ અને ઉɎાદનƖમતા 
Ǉેક કરે છે. 
● ClickUp: અɔંત ક˶માઇઝેબલ ʕેટફાેમƙ જે કાયƙ ˗વ˺ાપન, ǐાેજǶે ʕા̏ન̬ગ અને ટીમ સહયાેગ 
̀ેડે છે. 
● Monday.com: ̍વƣયુઅલ વકƙ  મેનેજમɰે ʕેટફાેમƙ, જમેાં ટીમાે તેમના કાયƙ અને ǐાેજેǶાેને ગાેઠવી 
અને Ǉેક કરી શકે છે. 
● Microsoft To Do: સરળ અને બાેધગʸ ટા˱ મેનેજમેɰ અેપ જ ેMicrosoft 365 સાથે ઈ̔ɰǁેટ થાય 
છે. 

7. અવાજ સાધનાે (Voice Tools) 

 અવાજ સાધનાે તે સાેʘવેર અને ટેકનાેલાે͂ છે જે વાૅઇસ અાધા̋રત ̋ƿયાǐ̍ત̋ƿયા (voice-based 
interactions) માટે ̋ડઝાઇન કરેલા હાેય છે, જમે કે ભાષા અાેળખાણ (speech recognition), વાૅઇસ 
કમાɱ્સ (voice commands), અથવા ટેȌ-ટુ-˾ીચ (speech synthesis). 

 અા સાધનાે ́ાટƙફાેʉ, ́ાટƙ ˾ીકસƙ, વȢુƙઅલ અ̐સ˶ɰ્સ, Ǉાʉ̋ƿƯશન સ̍વ̭સ અને અƖમતાઅા ે
માટેના સાધનાેમાં ˗ાપકપણે વપરાય છે. 

 અવાજ સાધનાે ટેકનાેલાે͂ સાથેની અમારી ̋ƿયાǐ̍ત̋ƿયાને સરળ, ઝડપી અને વધુ અસરકારક બનાવે 
છે. 

 વધતી ટેકનાેલાે͂ સાથે, અવાજ સાધનાે વધુ સંવેદનશીલ અને ǐચ̏લત બની ર̈ા છે, જ ેǐાેડ̖Ƕ̍વટી, 
અȋૅે̐સ̐બ̏લટી અને અનકૂુળતા માટે ઉપયાેગી છે. 

 કૃ̍ǋમ બુ̏ ɡ (AI), મશીન લ̏ન̮ગ અને નેચરલ લ̾Ɲવેજ ǐાેસે̐સ̬ગમાં થયેલા ̍વકાસના કારણે અવાજ 
સાધનાેનું ભ̍વˮ ખૂબ ઉȨળ લાગી ર̈ંુ છે. 

અવાજ સાધનાેના ǐકાર: 

1. વાૅઇસ અ̐સ˶ɰ્સ: 
ઉદાહરણ સાધનાે: Amazon Alexa, Google Assistant, Apple Siri, Microsoft Cortana 
કાયƙ: અે તમારી ભાષા અાેળખીને, અાપેલા અાદેશાે પર ̋ƿયા કરે છે, જેમ કે ʸુ̏ઝક વગાડવી, ̋રમાઇɱર સેટ 
કરવાે કે ́ાટƙ હાેમ ઉપકરણાે ̏નયં̍ǋત કરવુ.ં 
ઉપયાેગ: 
▪ ́ાટƙ હાે̓  
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▪ હેɱ્સ Ǒી અાેપરેશન 
▪ મા̋હતી મેળવવી 

2. ˾ીચ રેકાે̗Șશન સાેʘવેર: 
ઉદાહરણ સાધનાે: Dragon NaturallySpeaking, Google Speech-to-Text 
કાયƙ: બાેલેલા શʣાેને લખાણમાં બદલે છે. 
ઉપયાેગ: 
▪ ̋ડકટેશન 
▪ અાૅ̋ડયાે Ǉાʉ̋ƿƯશન 
▪ ̍વƗાને માટે અૅȋે̐સ̐બ̏લટી 

3. વાૅઇસ કમાɱ ̐સ˶ʼ: 
ઉદાહરણ સાધનાે: Google Assistant SDK, Alexa Skills Kit 
કાયƙ: વપરાશકતાƙ ɦારા વાૅઇસ કમાɱ અાપી ઉપકરણાે ̏નયં̍ǋત કરવું. 
ઉપયાેગ: 
▪ ́ાટƙફાેન અને વાહન ̏નયǋંણ 
▪ વેબસાઇટ ̍વ̏ઝટસƙ માટે અવાજ અાધા̋રત સહાય 

4. Speech-to-Text (STT) અને Text-to-Speech (TTS): 
ઉદાહરણ સાધનાે: Google Speech-to-Text, Natural Reader 
કાયƙ: STT બાેલેલા શʣાેને લખાણમાં બદલે છે. TTS લખાણને અવાજમાં બદલે છે. 
ઉપયાેગ: 
▪ અʬાસ માટે 
▪ ભાષા અનુવાદ 
▪ ને̍વગશેન 

5. વાૅઇસ બાયાેમે̋Ǉȋ: 
ઉદાહરણ સાધનાે: Nuance, Verint Voice Biometrics 
કાયƙ: ˗̘Ǹના અવાજના અનʈ લƖણાે પરથી અાેળખ કરવાની તકનીક. 
ઉપયાેગ: 
▪ અાેળખના હેતુઅાે 
▪ ઠગાઈ શાેધવી 

6. Voice Interaction with AI (Conversational AI): 
ઉદાહરણ સાધનાે: ChatGPT, Google Dialogflow 
કાયƙ: યંǋાે સાથે વાƺત̍વક સંવાદની Ɩમતા 
ઉપયાેગ: 
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▪ ǁાહક સેવા 
▪ IVR ̐સ˶ʼ 

7. Voice Translation: 
ઉદાહરણ સાધનાે: Google Translate, iTranslate Voice 
કાયƙ: અેક ભાષામાં અવાજ ઇનપુટ લઈ બી͂ ભાષામાં અનુવાદ અાપવા.ે 
ઉપયાેગ: 
▪ ǐવાસ માટે 
▪ ˗વસા̍યક સંવાદ માટે 

અવાજ સાધનાે કેવી રીતે કાયƙ કરે છે: 

1. Speech Recognition Process: 
▪ વપરાશકતાƙનાે અવાજ માઇƿાેફાેન ɦારા અવાજ ̐સȘલમાં ફેરવે છે 
▪ અા ̐સȘલને ડેટામાં બદલવામાં અાવે છે 
▪ NLP ɦારા અથƙ સમજવામાં અાવે છે 
▪ પ̋રણામͅપે અાઉટપુટ કે ̋ƿયા થાય છે 

2. Text-to-Speech Process: 
▪ લખાણ ઇનપુટ અપાય છે 
▪ તે અવાજ ͅપમાં રેɱર થાય છે 
▪ યુઝરને સાંભળવા માટે અાૅ̋ ડયાે ͅપે અાપવામાં અાવે છે 

અવાજ સાધનાેના ઉપયાેગ: 

1. ˗̘Ǹગત ǐાેડ̖Ƕ̍વટી: 
▪ વાૅઇસ ̋ડǶેશન 
▪ અવાજથી રીમાઇɱર સેટ કરવાે 
▪ હેɱ્સ Ǒી અાેપરેશન 

2. ˗વસાય અને ǁાહક સહાય: 
▪ વȢુƙઅલ અ̐સ˶ɰ્સ 
▪ કાેલ સેɰર IVR 
▪ મી̋ટ̬ગ Ǉાʉ̋ƿƯશન 

3. અȋૅે̐સ̐બ̏લટી: 
▪ Ǎ̑ˠહીન લાેકાે માટે TTS 
▪ ટાઇપ ન કરી શકતા લાેકાેને STT 
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4. ́ાટƙ હાેમ અને IoT: 
▪ અવાજથી લાઇટ, ટીવી વગેરે ̏નયં̍ǋત કરવું 
▪ મનાેરંજન માટે અવાજ કમાɱ 

5. હેˉકેર: 
▪ ડાેકટરાે માટે વાૅઇસ અાધા̋રત નાેટ્સ 
▪ ટે̏લમે̋ડ̐સન ɦારા અવાજ સંવાદ 

અવાજ સાધનાેના લાભ: 

▪ હેɱ્સ Ǒી અનુકૂળતા 
▪ સમય બચાવવાે 
▪ શારી̋રક રીતે અશǸ લાેકાેને ટેકા ે
▪ ˗̘Ǹગત અનુભવ 
▪ બુ̏ ɡશાળી અને સહજ વપરાશ 

 

અવાજ સાધનાેના પડકારાે: 

▪ સાચી અાેળખ ન થાય તેવું શȂ 
▪ ગાેપનીયતાની ̎ચ̬તા 
▪ સંદભƙને યાેƝય રીતે સમ͂ શકતું ન હાેય 
▪ ઈɰરનેટ પર અાધા̋રત હાેય 

8.  બે̐ સક Ǉબલશૂ̋ ટ̬ગ ̔˱લ (મૂળભૂત સમ̃ા ઉકેલવાની કાૈશˑતા) 

મૂળભૂત Ǉબલશૂ̋ટ̬ગ કાૈશˑાે ખૂબ જ અગɔના છે જેથી તમે તમારા ઉપકરણાે, સાેʘવેર, નેટવકƙ  અથવા 
̐સ˶મમાં ઉભી થતી સમ̃ાઅાેને અાેળખી શકાે અને ઉકેલી શકાે. તમે કાેƳʔટુર ચાલી ન ર̈ું હાેય, ધીમુ ં
વાઇ-ફાઇ હાેવુ ં કે કાેઈ અેપ જવાબ ન અાપતી હાેય તેવા સમયે શાંત અને પɡ̍તબɡ રીતે કામ કરવું ઘણંુ 
અસરકારક સા̐બત થાય છે. 

અહ̯ ̍વ̍વધ ǐકારની સામાʈ સમ̃ાઅાે માટે ઉપયાેગી Ǉબલશૂ̋ટ̬ગ કાૈશˑાે અને પગલાં દશાƙ˗ા છે: 

1. શાંત અને ɪાનકેિƮǍત રહાે 
શͅઅાત કરતા પહેલા ગભરાવું નહ̯ અને શાંત રહાે. ધીરજ અને તકƙસંગત પɡ̍તથી કામ કરવાથી સમ̃ા 
સરળતાથી ઉકેલી શકાય છે. 

2. મા̋હતી ભેગી કરા ે
સમ̃ા ̍વશે વધુથી વધુ મા̋હતી મેળવાે: 

 સમ̃ા શું છે? Ȃારે શͅ થઈ? 
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 તાજતેરમાં કાઈે ફેરફાર થયાે છે? (જમે કે software update, hardware વધારવું વગેરે) 

 શું અા સમ̃ા ફǸ અેક ઉપકરણમાં છે કે અનેક ઉપકરણાેને અસર કરે છે? 

 કાેઈ Error Message દેખાય તાે ˲ીનશાેટ લાે. 

3. સમ̃ાને ફરી સ̀ ̳
ȱાં સુધી શȂ હાેય ɔાં સુધી સમ̃ાને ફરી સજƙવાનાે ǐયાસ કરાે જથેી કારણ સમ͂ શકાય. 

4. મૂળભૂત ચકાસણીઅાે કરાે 

 પાવર સʕાય: કેબ˔ ̀ેડાયેલ છે? બેટરી ચાજƙ છે? 

 કને̖Ƕ̍વટી: નેટવકƙ  ̀ેડાણ છે? રાઉટર અન ેકેબ˔ તપાસાે. 

 ̋ડવાઇસ ˶ેટસ: ઉપકરણ ચાલુ છે કે નહ̯ તે ચકાસાે. 

5. ઉપકરણ રી˶ાટƙ કરા ે
રી˶ાટƙ કરવાથી ઘણી વખત તાȿા̏લક ખામીઅાે દૂર થઈ શકે છે. 

6. સાેʘવેર અપડેટ્સ તપાસાે 

 અાેપરે̋ટ̬ગ ̐સ˶મ અપડેટ્સ 

 અે̖ ʕકેશન અને ǉાઇવસƙ અપડેટ કરાે 

 ફમƙવેર અપડેટ્સ (જમે કે રાઉટર, ̌ǐɰર) 

7. સે̋ ટ̬Ɲસ તપાસા ે

 ̋ડƺʕે, સાઉɱ અને પર̌મશન સે̋ટ̬Ɲસ તપાસાે. 

8. બહારના કારણાેને અાેળખાે 
ISP સમ̃ા કે સવƙર ડાઉન હાેવાે જવેી બા̈ પ̋ર̗˺̍તઅાે પણ જવાબદાર હાેઈ શકે છે. 

9. ઉકેલ શાેધાે (Google અને Forums) 
Google પર Error Message શાેધાે. Stack Overflow, Reddit જવેા ʕેટફાે̓ ƙ પણ ઉપયાેગી છે. 

10. બી̀ ભાગાેનાે ઉપયાેગ કરી તપાસાે 
કેબલ કે હાડƙવેર બદલીને તપાસાે કે Ȃાં તકલીફ છે. 

11. ̐બ˄-ઇન Troubleshooting Tools નાે ઉપયાગે કરાે 

 Windows: Control Panel અથવા Settingsમાંથી Troubleshooter ચલાવાે 

 macOS: Disk Utility કે Diagnostics ટૂલ 
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 Mobile Devices: Diagnostics apps 

12. Safe Mode માં ટે˶ કરા ે
ફǸ જ̋ͅરયાતની ̐સ˶મ સ̍વ̭સીસ સાથે ̋ડવાઇસ ચાલુ કરાે જેથી થડƙ પાટ̰ અે̖ ʕકેશન તપાસી શકાય. 

13. Malware કે Virus માટે ˱ેન કરાે 
Antivirus કે Malwarebytes જવેા ટૂ˔થી ˱ેન કરાે. 

14. System Reset/Restore કરાે 

 Windows: System Restore Point ઉપયાેગ કરાે 

 macOS: Time Machine કે Reinstall 

 Mobile: Factory Reset (બેકઅપ લેવંુ જͅરી છે) 

15. ̏ન˧ાતની મદદ લાે 

 Customer Support અથવા 

 Repair Centre પર જવું પડે તાે ઘબરાવવંુ નહ̯. 

 

 

9. ઇ-ગવનƙʉ (ઈલેƛǇાે̏નક શાસન) 

▪ ઇ-ગવનƙʉ (ઇલેƛǇાે̏ નક ગવનƙʉ) અે ̋ડ̏જટલ સાધનાે, ટેǽાેલાે͂  અને ̐સ˶મનાે ઉપયાેગ કરીને 
શાસન કરવાની ǐ̋ƿયા છે – જમેાં સરકારી સેવાઅાે પૂરી પાડવી, નાગ̋રકાે સાથે સંવાદ સાધવાે અને વહીવટ 
કામગીરીને સરળ બનાવવી શામેલ છે. 

▪ અા મા̋હતી અને સંચાર ટેǽાેલાે͂  (ICT) નાે ઉપયાેગ કરીને શાસનને વધુ કાયƙƖમ, પારદશƙક, 
જવાબદારીસભર અને સરળ બનાવે છે, જથેી નાગ̋રકાેને સરળતાથી સરકારી સેવાઅાે મળી શકે. 
▪ અાજકાલના અાધુ̏નક શાસન માટે ઇ-ગવનƙʉ ખૂબ મહɗપૂણƙ બની ગઈ છે કારણ કે તે ̋ડ̏જટલ 
ટેǽાેલાે͂ ɦારા કામગીરીઅાેન ેǍતુ બનાવે છે, સેવા પરૂાવટ સુધારે છે અને નાગ̋રકાેને સશǸ બનાવે છે. 

ઇ-ગવનƙʉના મȕુ પાસાઅાે 

1. નાગ̋રકાેને સવેા પૂરાવટ (G2C - Government to Citizen): 

 અાૅનલાઇન સેવાઅાે: લાઇસʉ, પર̌મટ, સામા̏જક કˑાણ યાેજના, કર ચુકવણી વગેરે માટે 
અાેનલાઇન અર͂. 

 ઇ-હેˉ: અારાેƝય સેવાઅાે, અાેનલાઈન કʉ˄ેશન, મે̋ડકલ રેકાેડƙ અને ̍વમાની મા̋હતી. 
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 ઇ-અȱેુકેશન: અાેનલાઇન અʬાસ સામǁી, કાેસƙ ર͂˷ેશન અને પરીƖા ˗વ˺ાપન. 

 ઇ-વાે̋ટ̬ગ: ઇલƛેǇાે̏ નક મતદાન મંચ ɦારા મતદાન કરવાનું સગવડભયુ̫ માɪમ. 

2. ˗વસાય સેવાઅાે (G2B - Government to Business): 

 લાઇસʉ અન ે̏નયમનકારક મંજૂરીઅા:ે અાૅનલાઇન ર͂˷ેશન, ટેȋ ફાઇ̏લ̬ગ. 

 ઇ-ટેɱ̋ર̬ગ અને ઇ-ǐાȂેાેરમɰે: અાેડƙર માટે ˾ધાƙɒક અને પારદશƙક ǐ̋ƿયા. 

 ̏નય̍મત અપડેટ્સ: વેપારીઅાે માટે ̏નયમાેના ઇ-અપડેટ્સ. 

3. સરકારથી સરકાર સુધી (G2G): 

 સરકારી ̍વભાગાે વȝે મા̋હતી વહેતું બનાવવી: સમયસર અને વધુ અસરકારક ̏નણƙય માટે. 

 ડેટા મેનેજમેɰ: કેિƮǍય ̋ડ̏જટલ ડેટા ˶ાેરેજ અને અȋૅેસ સુ̍ વધાઅાે. 

4. નાગ̋રકાેની ભાગીદારી (G2C, C2G - Citizen to Government): 

 ̀હેર ચચાƙ અન ેǐ̍તસાદ: ની̍તǐ̋ƿયામાં ભાગ લેવાે, ઇ-પે̋ ટશન, સવ,̳ અને અાૅનલાઇન 
̋હઅ̋રગ̬. 

 પારદશƙકતા અને જવાબદારી: ની̍ત, બજેટ અને ખચƙ અાનેલાઈન ̀હેર કરવાે. 

5. ̋ડ̏જટલ ʕેટફાેમƙ અને ઇƮǑા˷Ǵર: 

 સરકારી વબેસાઇટ અને પાેટƙલ: કર ચુકવણી, અર͂, દƺતાવેજ ઉપલʤતા. 

 માેબાઇલ અે̖ʕકેશʉ: સરળતાથી માેબાઇલથી સેવાઅાેનાે લાભ. 

ઇ-ગવનƙʉના માેડે˔ 

1. Government-to-Citizen (G2C): 

 નાગ̋રકાેને સીધી સેવાઅાે, જમે કે ટેȋ પેમેɰ, પાસપાેટƙ અર͂, લાઇસʉ ̋રʈુઅલ. 

 ઉદાહરણ: ઇ-ટેȋ ફાઈ̏લ̬ગ, પિƱલક સ̍વ̭સ પાેટƙલ, ઇ-હેˉ. 

2. Government-to-Business (G2B): 

 વેપારીઅાે માટે લાઇસʉ, ર̏જ˷ેશન, ટેɱ̋રગ̬. 

 ઉદાહરણ: ˗વસાય લાઇસʉ માટે અર͂, સરકારી ટેɱર માટે ભાગ લેવાે. 

3. Government-to-Government (G2G): 

 સરકારી ̍વભાગાે વȝે અાંત̋રક કાેy ુ̏નકેશન. 
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 ઉદાહરણ: ʸુ̏ન̐સપલ, રાȱ અને કેƮǍ સરકાર વȝે મા̋હતી વહ̲ચણી. 

4. Citizen-to-Government (C2G): 

 નાગ̋રકાે સરકાર સાથે સીધી રીતે સંપકƙ  કરે છે. 

 ઉદાહરણ: ફ̋રયાદાે ના̲ધાવવી, અાૅનલાઇન ચચાƙમાં ભાગ લેવાે, ઇ-પે̋ ટશન. 

ઇ-ગવનƙʉના લાભા ે

1. સુધારેલી ǐવેશતા અને સુ̍વધા: 

 ૨૪/૭ સરકારી સેવાઅાેનાે ઉપયાેગ – ઘેરેથી. 

 ǁામીણ ̍વƺતારાેમાં લાેકાે માટે પણ સરળતા. 

2. પારદશƙકતા અને જવાબદારી: 

 નાગ̋રકાે માટે બજટે, ની̍તઅાે અને ખચƙની મા̋હતી ખુ˒ી હાેવાથી ̍વ˝ાસ વધે છે. 

 Ǔˠાચાર ઘટાડવામાં મદદͅપ. 

3. ખચƙમાં બચત: 

 છાપકામ, મેઈ̏લ̬ગ, અાે̋ફસ જƝયાઅાે જેવી Ǉે̋ડશનલ ખચƙ ઘટે છે. 

 અાૅનલાઇન ǐ̋ƿયાથી માનવીય Ǘમ પણ ઘટે છે. 

4. ઝડપી સેવા પૂરાવટ: 

 અર͂અાે, ચુકવણીઅા,ે મંજૂરીઅાે ઝડપથી થાય છે. 

 ̋ડ̏જટલ વલણ કાયƙƖમતા વધારશે. 

5. પયાƙવરણીય ટકાઉપણુ:ં 

 પેપરલેસ કામથી કુદરતી સંસાધનાે બચાવે છે. 

 ઇલƛેǇાે̏ નક રેકાેડƙ ɦારા કાયƙǐણાલી હલકી બને છે. 

6. સુધારેલું સંચાર: 

 સરકારી ની̍તઅાે અંગે ઇમેઇલ, સાેƸયલ મી̋ડયા, માેબાઇલ અે̖ʕકેશનથી જનતામાં ̀ગૃ̍ ત અાવે છે. 

 ̍વભાગાે વȝે સંકલન અને ઝડપી ̏નણƙય શȂ બને છે. 

ઇ-ગવનƙʉ અમલમાં પડતી પડકારા ે

1. ̋ડ̏જટલ ̋ડવાઈડ (̋ડ̏જટલ ̍વભાજન): 
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 બધા નાગ̋રકાેને ̋ડ̏જટલ ઉપકરણાે અથવા ઈɰરનેટની ઉપલʤતા નથી. જનેા કારણે વૃɡા,ે ǁાʸ 
̍વƺતારાેના લાેકાે અથવા નીચા અાવક ધરાવતાં લાેકાે જેવી નબળી સમુદાયાેની ઇ-ગવનƙʉ 
ǐવૃ̍ ɇઅાેમાં ભાગીદારી અાેછા પડે છે. 

 સરકારાેઅે ઇɰરનેટ અૅȋસે, ̋ડ̏જટલ સાƖરતા અને ̋કફાયતી ટેકનાેલાે͂ને ǐાɘેાહન અાપવા 
માટે ની̍તઅાે અમલમાં મૂકવી ̀ેઈઅે જથેી દરેક નાગ̋રકનાે સમાવેશ થાય. 

2. સુરƖા અને ગાેપનીયતા અંગેની ̎ચ̬તા: 

 ઇ-ગવનƙʉ ʕેટફાેમƙમાં નાગ̋રકાેની સંવેદનશીલ મા̋હતી હાેય છે, જનેા કારણે તઅેાે સાયબર 
હુમલાઅાે, ડેટા ચાેરી અને અાળેખ ચાેરી માટે લƽય બની શકે છે. 

 ડેટાની સુરƖા માટે અેિƮƿƯશન અને સુર̐Ɩત અાેથે̔ɰકેશન જવેી મજબૂત તકનીકાે જͅરી છે. 

 નાગ̋રકાે અને સરકાર વȝે ̍વ˝ાસ વધારવા માટે ડેટા ગાપેનીયતાનંુ ̀ળવવું પણ મહɗપૂણƙ છે. 

3. બદલાવ માટે ǐ̍તબંધ (Resistance to Change): 

 પરંપરાગત પɡ̍તઅાેનાે અʬાસ ધરાવતા સરકારી કમƙચારીઅાે અને નાગ̋રકાે ̋ડ̏જટલ પɡ̍તઅાે 
અપનાવામાં સંકાેચ કરી શકે છે. 

 અા બદલાવને સફળ બનાવવા યાેƝય તાલીમ અને ̀ગૃ̍ ત અ̑ભયાન જͅરી છે. 

 

4. ǐારં̐ભક ખચƙ વધુ હાેવાે: 

 વેબસાઇટ, માેબાઇલ અે̖ʕકેશન, ડેટાબેઝ અને સુર̐Ɩત નેટવકƙ  જવેી ̋ડ̏જટલ ઈƮǑા˷Ǵર 
˺ાપવામાં ભારે ખચƙ થાય છે. 

 સરકારાેઅે જͅરી ટેકનાેલાે͂ અને માનવીય સંસાધનાેમાં રાેકાણ કરવંુ પડે છે. 

 તેમ છતાં, લાંબા ગાળ ેખચƙમાં બચત અને કાયƙƖમતા વધે છે. 

5. અેકીકરણની સમ̃ાઅા ે(Integration Issues): 

 ઘણા સરકારી ̍વભાગામેાં જૂની ̐સ˶માે કામ કરતી હાેય છે, જ ેનવી ̋ડ̏જટલ ̐સ˶મ સાથે સુસગંત 
નથી. 

 જૂની અને નવી ̐સ˶મ વȝે ડેટાનું વહન સરળ બનાવવા માટે ̍વશાળ યાેજના અને અમલ જͅરી 
બને છે. 

 અેકબી̀ સાથે સંક̏લત થતી ̐સ˶માે બનાવવી સમયખાેર અને જ̋ટલ ǐ̋ƿયા હાેઈ શકે છે. 

6. કાયદેસર અને ̏નયમનકારી પડકારાે: 
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 ઇ-ગવનƙʉ માટે ઈ-સહી, ̋ડ̏જટલ ચુકવણી અને વȢુƙઅલ મતદાન જવેી નવી ǐ̋ƿયાઅાેને 
માʈતા અાપવા માટે માેજૂદા કાયદાઅાેમાં સુધારાની જͅર પડે છે. 

 ટેકનાેલાે͂ સાથે ગ̍તશીલ રહેવા માટે સરકારાઅેે પાેતાના કાયદાકીય માળખાને અપડેટ કરવંુ 
̀ેઈઅે જથેી ̋ડ̏જટલ સેવાઅાે કાયદેસર અને અમલમાં લાવા યાેƝય બને. 

10. ̋ડ̏જટલ હƺતાƖર અન ે̋ડ̏જટલ ǐમાણપǋ 

 ࣶࣷ ̋ડ̏જટલ હƺતાƖર અને ̋ડ̏જટલ ǐમાણપǋ બંન ે̋ડ̏જટલ સંચાર, લેવડદેવડ અને મા̋હતીની સુરƖા માટે 
મૂળભૂત ઘટકાે છે. તે ̍વ˝સનીયતા ˺ા̌પત કરવી, યાેƝયતા સુ̏ન̏˛ત કરવી અને મા̋હતી સાથે ચેડા થવાથી 
બચાવ કરવાે—અા બધામાં મહɗપૂણƙ ભૂ̌મકા ભજવે છે. 
 ࣶࣷ અા ̍વચારાેનંુ ઉપયાેગ સુર̐Ɩત અાૅનલાઇન સંચાર, ̋ડ̏જટલ કરાર, ઇ-કાેમસƙ, ઇમેઇલ અેિƮƿƯશન અને 
અʈ ઘણા Ɩેǋાેમાં થાય છે. 
 ࣶࣷ ̋ડ̏જટલ હƺતાƖર ̋ƿʍાેǁાફી પɡ̍ત ɦારા સંદેશાે અથવા દƺતાવેજની સાચી અાેળખ અને તેની 
અખં̋ડતતા સુ̏ન̏˛ત કરે છે. 
 ࣶࣷ ̋ડ̏જટલ ǐમાણપǋ અે ˗̘Ǹ કે સં˺ાની અાેળખ અને તેના ̀હેર કી (Public Key) ની પૃ̑ˠ અાપે છે, 
જથેી બંને પƖાે વȝે સુર̐Ɩત સંચાર શȂ બને છે. 

̋ડ̏જટલ હƺતાƖર શું છે? 

̋ડ̏જટલ હƺતાƖર અે અેક ̋ƿʍાǁેાફીક તક̏નકી છે જ ે̋ડ̏જટલ સંદેશા અથવા દƺતાવેજની સાચી અાેળખ 
અને અખં̋ડતતા ̏નધાƙ̋ રત કરે છે. 
અા ટેક̏નક હƺતલે̑ ખત હƺતાƖર જવેી જ છે, પણ વધુ સુર̐Ɩત છે કારણ કે તેમાં અ̐સ̌મ̋Ǉક ̋ƿʍાેǁાફી 
(Asymmetric Cryptography) નાે ઉપયાેગ થાય છે. 

̋ડ̏જટલ હƺતાƖર કેવી રીત ેકાયƙ કરે છે? 

̋ડ̏જટલ હƺતાƖર "Public Key Infrastructure (PKI)" પર અાધા̋રત હાેય છે જમેાં ̀હેર કી અને ખાનગી 
કીનાે ઉપયાેગ થાય છે. 

ǐ̋ƿયા: 

1. હે̐શ̬ગ (Hashing) ǐ̋ƿયા: 

o દƺતાવેજ પર હƺતાƖર કરવા માટે સાૈથી પહેલા દƺતાવેજનાે "હેશ" બનાવવામાં અાવે છે. 
હેશ અે દƺતાવેજનું યુ̏નક ̋ડ̏જટલ ̋ફ̬ગર̌ǐɰ હાેય છે. 

2. ખાનગી કી વડે અેિƮƿƯશન: 

o તે હેશ ને હƺતાƖર કરનારની ખાનગી કી વડે અેિƮƿʍ કરવામાં અાવે છે. 
અા ǐ̋ƿયા પછી જ ેબનાવાય છે તે ̋ડ̏જટલ હƺતાƖર કહેવાય છે. 

3. સાચા હƺતાƖર ની ચકાસણી (Verification): 
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o ǐાʏ કરનાર ˗̘Ǹ હƺતાƖર કરનારની ̀હેર કીથી અા ̋ડ̏જટલ હƺતાƖરને ̋ડ̋ƿʍ કરે છે. 

o ɔારબાદ ǐાʏ દƺતાવેજના ેપાેતે હેશ બનાવે છે અન ેતેને ̋ડ̋ƿʍ કરેલા હેશ સાથે સરખાવે છે. 

o ̀ે બંને હેશ મેળખાતાં હાેય તાે તેનું અથƙ અે થાય કે દƺતાવેજમાં કાઇે ફેરફાર થયા ેનથી અને તે 
હƺતાƖર યાƝેય રીતે કરવામાં અા˗ું છે. 

 

 

̋ડ̏જટલ હƺતાƖરના લƖણાે: 

 ǐમા̒ણકતા (Authentication): માેકલનારની અાેળખ પુ̑ˠ કરે છે. 

 અખં̋ડતતા (Integrity): દƺતાવેજ કે સંદેશામાં હƺતાƖર પછી કાેઇ ફેરફાર થયાે નથી તે ̏ન̏˛ત 
કરે છે. 
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 અ˾ˠતા ન હાેવી (Non-repudiation): માેકલનાર સંદેશ માેકલવાનાે ઇɬાર કરી શકે ન̋હ, 
કારણ કે હƺતાƖર તેને સંબં̍ધત છે. 

̋ડ̏જટલ હƺતાƖરનાે ઉપયાેગ: 

 ઇમેઇલ: ઇમેઇલ માેકલનાર સાચાે છે અને તેમાં ચેડા ન થયાે છે તેની ખાતરી. 

 કરાર: ̋ડ̏જટલ કરાર અને દƺતાવે̀ેની અસ̏લયત અને અખં̋ડતતા માટે. 

 સાેʘવેર ̍વતરણ: સાેʘવરે અાપનાર ̍વ˝સનીય છે અને તેમાં ફેરફાર ન થયાે હાયે તેની ખાતરી. 

 નાણાકીય લેવડદેવડ: અાેનલાઈન બ̲̋ક̬ગ અને ફાઇના̘ʉયલ ˗વહારામેાં છેતર̌પ̬ડી અટકાવવા 
માટે. 

̋ડ̏જટલ હƺતાƖરના લાભા:ે 

 વધુ સુરƖા: અેિƮƿƯશનના કારણે તેને નકલ કરવી ખુબ મુƸકેલ છે. 

 ǐ̋ƿયા ઝડપી બને: કાગળ વગરના ˗વહારને કારણે કામગીરી ઝડપથી થાય છે. 

 કાનૂની માʈતા: ઘણા દેશામેાં ̋ડ̏જટલ હƺતાƖરને કાનનૂી માʈતા અાપવામાં અાવી છે અને તેને 
હƺતલે̑ ખત હƺતાƖરના બરાબર માનવામાં અાવે છે. 
(ઉદાહરણ: યુ.અેસ.નાે eSign Act કે યુરાેપનાે eIDAS ̏નયમ). 

̋ડ̏જટલ ǐમાણપǋ 

̋ડ̏જટલ ǐમાણપǋ અે ઇલેƛǇાે̏નક દƺતાવેજ છે જ ેǐમાણપǋધારકની ̀હેર કી માટે ̋ડ̏જટલ પાસપાેટƙ 
તરીકે કાયƙ કરે છે. તે ǐમાણપǋધારકની અાેળખની ખાતરી કરે છે અને અા મા̋હતી અાપે છે કે ̀હેર કી જ ે
કાેઇ ˗̘Ǹ, સં˺ ા અથવા ઉપકરણ સાથે સંબં̍ધત છે તે સાચું છે. 

Certificate Authority (CA) અે ̍વ˝સનીય સં˺ા હાેય છે જ ે̋ડ̏જટલ ǐમાણપǋા ે̀રી કરે છે. CA 
ǐમાણપǋ અાપે તે પહેલાં ધરનારની અાેળખની ચકાસણી કરે છે. તેને તમે નાેટરી ̀હેર તરીકે સમ͂ શકાે, 
જ ેપહેલાં અાેળખ ની ખાતરી કરે છે અને પછી ̀હેર કી ને ǐમા̒ણત કરે છે. 

̋ડ̏જટલ ǐમાણપǋના મȕુ ઘટકાે: 

અેક સામાʈ ̋ડ̏જટલ ǐમાણપǋમાં નીચે મુજબની મા̋હતી હાેય છે: 

1. ̀હેર કી (Public Key): સંબં̍ધત ˗̘Ǹ કે સં˺ા સાથ ે̀ેડાયેલી ̀હેર કી. 

2. ǐમાણપǋ ધરનારની મા̋હતી: નામ, સં˺ ા, દેશ વગેરે જવેી અાેળખ મા̋હતી. 

3. ǐમાણપǋ અાપનાર CA ની મા̋હતી: કે જણેે ǐમાણપǋ ̀રી કયુ̫ છે તે સં˺ાની ̍વગતાે. 

4. CA નંુ ̋ડ̏જટલ હƺતાƖર: CA તેના ખાનગી કી વડે ǐમાણપǋ પર હƺતાƖર કરે છે જેથી તેની 
માʈતા સા̐બત થાય. 
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5. ̐સ̋રયલ નંબર: ǐમાણપǋ માટે અાપેલું અનʈ નંબર. 

6. સમાપન તારીખ: તે તારીખ ȱાં પછી ǐમાણપǋ માʈ રહેશે નહ̯. 

7. અે˂ ાે̋ રધમ મા̋હતી: ǐમાણપǋ હƺતાƖર કરવા માટે કયા અેિƮƿƯશન અે˂ાે̋રધમનાે ઉપયાેગ 
થયાે છે તે મા̋હતી. 

̋ડ̏જટલ ǐમાણપǋ કેવી રીતે કાયƙ કરે છે? 

1. ǐમાણપǋ માટે અર͂: 

o કાેઈ પણ ˗̘Ǹ, વેબસાઈટ અથવા સં˺ા ̀હેર અને ખાનગી કીનું ̀ેડાણ (Key Pair) 
બનાવે છે અને CA પાસે ̋ડ̏જટલ ǐમાણપǋ માટે અર͂ કરે છે. 

2. CA ɦારા ચકાસણી: 

o CA અા અર͂ કરનારની અાેળખ ̍વ̍વધ રીતે ચકાસે છે. જમે કે વેબસાઈટ માટે ડામેેઇન 
મા̏લકીની પુ̑ˠ અને ˗̘Ǹ માટે કાેઈ સરકારી અાેળખ દƺતાવેજ ɦારા અાેળખની 
ચકાસણી કરી શકે છે. 

3. ǐમાણપǋ ̀રી કરવું: 

o અાેળખ ચકા̃ા પછી CA ǐમાણપǋ ̀રી કરે છે. તેમાં ̀હેર કી અને CA નંુ ̋ડ̏જટલ 
હƺતાƖર સામેલ હાેય છે. 

4. ǐમાણપǋની ચકાસણી: 

o ȱારે કાેઈ ˗̘Ǹ સંદેશ મેળવેછે અથવા વેબસાઈટની મલુાકાત લે છે, ɔારે તેઅાે તે 
̋ડ̏જટલ ǐમાણપǋ સાચું છે કે નહ̯ તે ચકાસે છે—CA ના ̀હેર કી વડે તે હƺતાƖરની 
માʈતા તપાસી શકાય છે. 

o માેટાભાગના ǒાઉઝરાે અને ઇમેઇલ ȃાયɰસમાં ̍વ˝સનીય CA ની યાદી પહેલેથી જ ǐી-
ઇʊાેલ હાેય છે. ̀ે ǐમાણપǋ માʈ છે અને CA ̍વ˝સનીય છે, તાે સુર̐Ɩત કનȆેન 
˺ા̌પત થઈ શકે છે. 
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̋ડ̏જટલ ǐમાણપǋના ǐકારાે: 

● SSL/TLS ǐમાણપǋાે: 
વેબસાઇટ્સને સુર̐Ɩત કરવા અને વેબ ǒાઉઝર અને સવƙર વȝે અેન̋ƿʍેડ સંચાર ˺ા̌પત કરવા માટે 
ઉપયાેગમાં લેવાય છે. 

● કાેડ સાઇ̏ન̬ગ ǐમાણપǋા:ે 
ડેવલપસƙ ɦારા સાેʘવેર અથવા અે̖ ʕકેશનને સાઇન કરવા માટે ઉપયાેગમાં લેવાય છે જથેી સા̐બત થઈ 
શકે કે કાેડમાં કાેઈ ફેરફાર થયાે નથી. 

● ઇમેઇલ ǐમાણપǋાે (S/MIME): 
ઇમેઇલ સંચારને અેન̋ƿʍ અને ̋ડ̏જટલ સાઇન કરીને સુર̐Ɩત બનાવવા માટે વપરાય છે. 
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● ȃાઈɰ ǐમાણપǋાે: 
યૂઝરાેની અાેળખ કરવા માટે અને તેમને સુર̐Ɩત ̐સ˶મ કે નેટવકƙ  પર ǐવેશ અાપવાનાે અ̍ધકાર અાપવા 
માટે વપરાય છે. 

̋ડ̏જટલ ǐમાણપǋાેના લાભાે: 

● ̍વ˝સનીયતા અન ેઅાેળખપǋ (Authentication): 
̋ડ̏જટલ ǐમાણપǋાે અે ˗̘Ǹ, વેબસાઇટ અથવા સં˺ાની અાેળખની ખાતરી કરે છે, જ ેઇ-કાેમસƙ અને 
અાેનલાઈન લેવડદેવડમાં ખૂબ મહɗપૂણƙ છે. 

● સુર̐Ɩત સચંાર: 
અેન̋ƿʍ થયેલ સંચાર ચેન˔ ˺ા̌પત કરે છે જથેી સવƙર અને ȃાયɰ વȝે સંચાર ખાનગી રહે. 

● કાયદેસર માʈતા: 
̍વ˝સનીય CA ɦારા ̀રી કરાયેલા ̋ડ̏જટલ ǐમાણપǋાે અે ખાતરી અાપે છે કે સાઇન કરનાર ˗̋કત અે જ 
છે જ ેતે દાવાે કરે છે અને લેનદેન કાયદેસર છે. 

● ડેટાની અખં̋ડતતા: 
ખાતરી કરે છે કે ડેટા પ̋રવહન દર̌મયાન બદલાયું નથી; ̀ે ǐમાણપǋ સાથે ચેડા થાય તાે સાઇન અમાʈ 
થાય છે. 

̋ડ̏જટલ ̐સȘેચર ̍વ̈́ɡ ̋ડ̏જટલ ǐમાણપǋ: 

પાસુ ં ̋ડ̏જટલ ̐સȘેચર ̋ડ̏જટલ ǐમાણપǋ 

ઉɠેƸય સંદેશ કે દƺતાવેજની સચાેટતા, 
અખં̋ડતતા અને ઇનકાર ન કરી શકાય 
તેવા પુરાવાનું ǐમા̒ણત કરવું. 

˗̘Ǹ, સં˺ ા કે વેબસાઇટની અાેળખ અને 
તેમની ̀હેર કીની સȝાઈની ખાતરી. 

Ȃાં 
વપરાય છે 

દƺતાવે̀ે, ઇમઇેલ, સાેʘવેર કે 
નાણાકીય લેવડદેવડને સુર̐Ɩત કરવા. 

ǐમાણપǋધારકની ̀હેર કી અાેળખવા અને 
સુર̐Ɩત કનેȆન ˺ા̌પત કરવા (જમે કે 
SSL/TLS). 

કેવી રીતે 
કાયƙ કરે છે 

ખાનગી કીથી દƺતાવેજ સાઇન થાય છે 
અને ̀હેર કીથી તેની ચકાસણી થાય છે. 

CA ̀હેર કી ધરાવતું ǐમાણપǋ ̀રી કરે છે, 
જનેે તેના પાેતાના ̋ડ̏જટલ સાઇનથી 
ǐમા̒ણત કરે છે. 

કાેણ ̀રી 
કરે છે 

˗̘Ǹ કે સં˺ ા પાેતે સાઇન કરે છે. ̍વ˝સનીય CA (Certificate Authority) 
અાેળખ ચકાસીને ǐમાણપǋ અાપે છે. 

મȕુ 
ભૂ̍મકા 

સાઇન કરેલા કɰેɰની સȝાઈ અને 
અખં̋ડતતા સુ̏ન̏˛ત કરે છે. 

̀હેર કી ની ̍વ˝સનીયતા અને માʈતા 
સુ̏ ન̏˛ત કરે છે. 
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̋ડ̏જટલ ̐સȘેચર અને ̋ડ̏જટલ ǐમાણપǋના સામાʈ ઉપયાેગ: 

1. ઇમેઇલ સુરƖા: 

 ̋ડ̏જટલ ̐સȘેચર ઉપયાેગ કરીને માેકલનારની અાેળખ ચકાસવામાં અાવે છે અને ઇમેઇલ 
કɰેɰમાં ફેરફાર થયાે નથી તેની ખાતરી મળ ેછે. 

 ̋ડ̏જટલ ǐમાણપǋાે S/MIME ɦારા ઇમેઇલ અેન̋ƿƯશન અને ̋ડ̏જટલ સાઇ̏ન̬ગને સપાેટƙ કરે છે. 

2. વેબસાઈટ સુરƖા (SSL/TLS): 

 વેબસાઈટ્સ SSL/TLS ǐમાણપǋાે ɦારા યૂઝર અને સવƙર વȝેના સંચારને સુર̐Ɩત બનાવે છે જેથી 
ƿે̋ડટ કાડƙ ̍વગેરે જવેા ડેટા અેન̋ƿʍ રહી શકે. 

 ̋ડ̏જટલ ̐સȘેચર પણ SSL/TLS ǐમાણપǋની સȝાઈ ચકાસવામાં સહાયͅપ બને છે. 

3. સાેʘવેર ̍વતરણ: 

 ડેવલપસƙ સાʘેવેર પકેેજને ̋ડ̏જટલ રીતે સાઇન કરે છે જથેી વપરાશકતાƙ તેની ખરા ˸ાેતમાંથી 
હાેવાની ખાતરી કરી શકે. 

 CA ɦારા ̀રી ̋ડ̏જટલ ǐમાણપǋથી સા̐બત થાય છે કે સાેʘવેર ̍વ˝સનીય ˸ાેતમાંથી છે અને 
તેમાં ફેરફાર થયાે નથી. 

4. કાયદેસર અને ˗વસા̍યક દƺતાવે̀ ે: 

 ̋ડ̏જટલ ̐સȘેચર ɦારા અાૅનલાઇન કરાર, કાયદેસર દƺતાવે̀ે અને ˗વસા̍યક કરારની સȝાઈ 
અને અખં̋ડતતા ̏ન̏˛ત થાય છે. 

 ̋ડ̏જટલ ǐમાણપǋાે દƺતાવજેમાં સાઇન કરનારની અાેળખ ચકાસવામાં સહાયͅપ થાય છે, જ ેયાેƝય 
પƖાેની સચાેટતા ̏ન̏˛ત કરે છે. 

11. ̀હેર ઇɰરફેસ (̋કયાે˱) 

̀હેર ઇɰરફેસ ̋કયાે˱ (̋કયાે˱) અે અેક ભાૈ̍તક ઉપકરણ છે જ ેવપરાશકતાƙઅાેન ે̋ડ̏જટલ સેવાઅાે, 
મા̋હતી અથવા લેનદેન સુધી પહા̲ચ અાપવા માટે બનાવવામાં અા˗ું છે. સામાʈ રીતે અા ઉપકરણ ̄-
સેવા (self-service) ̄ͅપમાં હાેય છે, અેટલે કે વપરાશકતાƙ કાેઈ ˶ાફ અથવા ǁાહક સેવા ǐ̍ત̏ન̍ધની 
મદદ ̍વના જ જ̋ͅરયાત મુજબ કામ કરી શકે છે. ̋કયાે˱સ સામાʈ રીતે અરેપાેટƙ, શાે̌પ̬ગ માેલ, લાઇǒેરી, 
હાે̖˾ટલ અને સરકારી કચેરીઅાેમાં ̀ેવા મળે છે. 
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̋કયાે˱ના ǐકારાે: 

1. મા̋હતી ̋કયાે˱: 

o સામાʈ મા̋હતી, નકશા, શȻૂેલ અને ̋ડરેǶરી જેવી મા̋હતી અાપે છે. ઉદાહરણ તરીકે, 
શાે̌પ̬ગ માેલમાં મા̋હતી ̋કયાે˱  દુકાનાેનંુ ˺ાન બતાવે છે કે ઉપલʤ સેવાઅાે ̍વશે 
મા̋હતી અાપે છે. 

2. ̄-સેવા ̋કયાે˱: 

o વપરાશકતાƙઅાે પાેતે જ કામ કરી શકે છે, જમે કે રે˶ાેરɰમાં ફૂડ અાેડƙર કરવાે, અેરપાેટƙ પર 
ưલાઇટ ચેક-ઇન કરવાે કે પા̋ક̮ગ માટે ચુકવણી કરવી. 

3. સરકારી સેવાઅાે ̋કયાે˱: 

o ડાેȂૂમɰે રીʈુ કરવું, ટેȋ ચૂકવવાે અથવા જʆ ǐમાણપǋ મેળવવંુ જવેી ̀હેર સેવાઅાે 
માટે ઉપયાેગ થાય છે. 

4. ચુકવણી ̋કયાે˱: 

o વીજ ̐બલ, ટેȋ કે અʈ ફી જવેી ચુકવણી માટે ઇɰરફેસ અાપે છે. જમે કે Ǉાʉપાેટƙ 
̋કયાે˱  ̋ટ̋કટ ખરીદવા માટે અથવા Ǉાવેલ કાડƙ ̋રચાજƙ માટે વપરાય છે. 

5. હેˉકેર ̋કયાે˱: 

o દદ̰અાે માટે અેપાેઇɰમɰે શેȻૂલ કરવી, ટે˶ ̋રઝ˄ ̀વેાે કે ડાૅǶર અાે̋ ફસમાં ચેક-ઇન 
કરવા માટે સેવા અાપે છે. 

̀હેર ̋કયાે˱ કેવી રીતે કાયƙ કરે છે: 

1. યૂઝર ઇɰરફેસ (UI): 

o ટચ ˲ીન સાથે સરળ અને ˾ˠ ઇɰરફેસ હાેય છે જથેી ટે̚ǽકલ Ɨાન અાેછંુ હાેય તાે 
પણ વપરાશકતાƙ સરળતાથી ઉપયાેગ કરી શકે. 

2. કને̖Ƕ̍વટી: 

o અા ̋કયાે˱સ સામાʈ રીતે ઇɰરનેટ અથવા લાેકલ નેટવકƙ  સાથે ̀ેડાયેલી હાેય છે જથેી 
̋રયલટાઇમ મા̋હતી મેળવવી અને લેનદેન શȂ બને. 

3. ચુકવણી ̐સ˶મ: 

o કેટલાક ̋કયાે˱સમાં ઇ̔ɰǁેટેડ પેમેɰ ̐સ˶મ હાેય છે, જમેાં ƿે̋ડટ કાડƙ, માેબાઇલ વાૅલેટ 
અથવા રાેકડ માટે પણ સગવડ હાેય છે. 
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4. અાેથે̔ ɰકેશન: 

o કેટલીક સેવાઅાે માટે અાેળખપǋ જͅરી હાેય છે, જમેાં બાયાેમે̋Ǉક (અાંગળીના ̏નશાન, 
ચહેરા અાેળખ) કે PIN કાેડનાે ઉપયાેગ થાય છે. 

5. અȋેે̐સ̐બ̏લટી: 

o બધાને ઉપયાેગમાં સરળ બને તે માટે ̋કયાે˱ હાઈ-કાેƮǇા˶ ˲ીન, અાે̋ડયાે સહાયતા, 
˲ીન રીડર અને ˚ીલચેર અેȋેસ જવેી સુ̍વધાઅાે અાપે છે. 

̀હેર ઇɰરફેસ (̋કયાે˱)ના લાભાે: 

1. અસરકારકતા અને સરળતા: 

o લાંબી લાઈનમાં ઉભા રહેવાની જͅર ન રહે અને ઝડપથી સેવા મળે છે. 

2. ખચƙમાં બચત: 

o માનવ સંસાધન પરનાે ખચƙ બચાવે છે કારણ કે ̋કયાે˱ ઘણાં કામાે અાપમેળે કરે છે. 

3. સેવા ƺતર સુધારણા: 

o નાગ̋રકાે માટે સરકારી સેવાઅાે ઝડપી બને છે અને સંતાષે વધુ મળે છે. 

4. 24x7 ઉપલʤતા: 

o ̏નય̌મત સમય ̐સવાય પણ ̋કયાે˱ સેવાઅાે અાપ ેછે, જમે કે રાǋે લાઈસʉ રીʈુ કરવું કે 
ફી ભરવી. 

5. ડેટા સંǁહ અને ̍વƸલેષણ: 

o વપરાશ ડેટા અેકઠંુ કરી શકાય છે, જનેાથી સેવાનાે સુધાર અને યાેƝય ˺ાન પસંદ કરવામા ં
મદદ મળે છે. 

̀હેર ઇɰરફેસ (̋કયાે˱)ની પડકારા:ે 

1. મɰેેનʉ અન ેડાઉનટાઇમ: 

o ̏નય̌મત ̀ળવણી જͅરી છે. ̀ે ̋કયાે˱ બંધ પડે તાે વપરાશકતાƙને મƸુકેલી પડે. 

2. સુરƖા ̎ચ̬તાઅાે: 

o ̋કયાે˱  હે̋ક̬ગ કે દુ̈́પયાેગ માટે સંવદેનશીલ છે. ચુકવણી જેવી સેવાઅાે માટે અેન̋ƿƯશન 
અને બહુ-પગ̎થયાં અાેળખ જͅરી હાેય છે. 

3. યૂઝર ગાપેનીયતા: 
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o ̋કયાે˱  ˗̘Ǹગત મા̋હતી અેકǋ કરે છે, જનેે સુર̐Ɩત રીતે રાખવું મહɗપણૂƙ છે. 

4. અȋેે̐સ̐બ̏લટી મુɠાઅાે: 

o ભાષા અવરાેધ, અપંગતા અથવા ટેǽાેલાે͂નાે અભાવ હાેય તાે લાેકાે માટે ̋કયાે˱ ઉપયાેગ 
મુƸકેલ બની શકે છે. 

̋કયાે˱ અે̖ʕકેશનના ઉદાહરણાે: 

1. અેરપાેટƙ ̋કયાે˱: 

o ưલાઇટ ચેક-ઇન, બાે̋ ડ̮ગ પાસ છાપવાે અને બેગ ટેગ ̌ǐɰ કરવા માટે ઉપયાેગ થાય છે. 

2. હેˉકેર ̋કયાે˱: 

o દદ̰ ચેક-ઇન, અેપાેઇɰમેɰ, મા̋હતી દશાƙવવુ,ં કે ફાેમƙ ભરી શકાય છે. 

3. ̋રટેલ ̋કયાે˱: 

o અાેડƙર અાપવા,ે ǐાેડǶ ̍વગતાે ̀ેવી, અને સેˎ-ચેકઅાઉટ માટે વપરાય છે. 

4. સરકારી સેવાઅાે ̋કયાે˱: 

o ǉાઇ̍વ̬ગ લાઈસʉ માટે અર͂, ટેȋ ચૂકવણી કે ̀હેર રેકાેડ્ƙસ મેળવવા માટે ઉપયાેગ 
થાય છે. 

12. અાેપન-સાેસƙ મફત સાેʘવેર 

અાેપન-સાેસƙ મફત સાેʘવેર અે અેવાે સાેʘવેર છે જ ેમફતમાં ઉપલʤ હાેય છે અને સાથે તેનંુ સાેસƙ કાેડ પણ 
ઉપલʤ હાેય છે. અેટલે કે, કાેઈપણ ˗̘Ǹ તેને અȋૅસે કરી શકે છે, તમેાં ફેરફાર કરી શકે છે અને તેને 
પુનઃ̍વતરણ પણ કરી શકે છે. અાજકાલના સાેʘવેર ઈકાે̐સ˶મમાં તેનું મહɗ ઘણું છે અને તેણે વૈ̏˝ક ƺતરે 
સાેʘવેરના ̍વકાસ અને વહ̲ચણીના ઢાંચાને બદલી નાȕાે છે. 

⮚ અાેપન-સાેસƙ સાેʘવરે 

● અાેપન-સાેસƙ સાેʘવેર અે અેવંુ સાેʘવેર છે જમેાં સાેસƙ કાેડ ̀હેરપણે ઉપલʤ હાેય છે જથેી કાેઈ પણ 
તેને ̀ેઈ શકે, ફેરફાર કરી શકે અને ̍વતરીત કરી શકે. 
● અા ǐકારનાે સાેʘવેર સામાʈ રીતે ̍વકાસકતાƙઅાેના સમુદાય ɦારા સંયુǸ રીતે ̍વકસાવવામાં અાવે છે. 
● અાેપન-સાેસƙ સાેʘવેરનું સાૈથી ̀ણીતંુ ઉદાહરણ છે – ̏લનȋ અાેપરે̋ટ̬ગ ̐સ˶મ. 

અાેપન-સાેસƙ સાʘેવેરની મુȕ લાƖ̒ણકતાઅાે: 

1. પારદ̏શ̭તા – સાેસƙ કાેડ કાેઈપણ માટે ઉપલʤ હાેય છે. 

2. સમુદાય અાધા̋રત ̍વકાસ – ̄યંસેવકાે ɦારા ̍વકાસ કરવામાં અાવે છે. 
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3. ̄તǋં રીતે ફેરફાર કરવાની છૂટ – પાેતાનાં ઉɠેશ માટે કાડેમાં ફેરફાર કરી શકાય છે. 

4. ̍વતરણની છૂટ – સુધારેલી અાવૃ̍ɇઅાેને પણ ̍વતરીત કરી શકાય છે. 

⮚ મફત સાʘેવેર (Free Software) 

"Ǒી સાેʘવેર" નાે અથƙ ફǸ ભાવથી નહ̯ પરંતુ ̄તǋંતાથી છે. ̋રચડƙ ˶ાેલમેન ɦારા ˺ા̌પત Ǒી સાેʘવેર 
ફાઉɱેશન મુજબ, Ǒી સાʘેવેર ચાર મુȕ ̄તǋંતાઅાે પર અાધા̋રત છે: 

1. ̄તǋંતા 0 – કાેઈ પણ હેતુ માટે સાેʘવેર ચલાવવાની છૂટ. 

2. ̄તǋંતા 1 – કઈ રીતે કાયƙ કરે છે તે સમજવા અને જͅર ǐમાણે ફેરફાર કરવાની છૂટ. 

3. ̄તǋંતા 2 – અʈને સહાયͅપ થવા માટે નકલ કરવાનાે અ̍ધકાર. 

4. ̄તǋંતા 3 – સુધારેલી અાવૃ̍ ɇઅાે વહ̲ચવાની છૂટ. 

કેટલાક અાેપન-સાેસƙ સાʘેવેર મફત સાેʘવેર પણ હાેય છે, પરંતુ બંને શʣાે સદાય સમાન નથી. 

મફત સાેʘવેરનાં ઉદાહરણાે: 
● GNU/Linux 
● LibreOffice 
● GIMP 

અાેપન-સાેસƙ અને મફત સાʘેવેર માટે લાયસʉ 

સાેʘવેર કયા રીતે ઉપયાેગમાં લેવાઈ શકે છે તેની ˗ાȕા લાયસʉ ɦારા થાય છે. 

̀ણીતાં લાયસʉ: 
● GPL (General Public License) 
● MIT License 
● Apache License 
● BSD License 

Copyleft લાયસʉ (જેમ કે GPL): સુધારેલી અાવૃ̍ɇઅાે પણ અાેપન-સાેસƙ રહે અે સુ̏ન̏˛ત કરે છે. 
Permissive લાયસʉ (જેમ કે MIT): ˗ાપારી ઉપયાેગની છૂટ અાપે છે. 

અાેપન-સાેસƙ મફત સાેʘવેરના લાભાે: 

1. ખચƙમાં બચત: 
● મફતમાં ડાઉનલાેડ અને ઉપયાેગ કરી શકાય છે. 
● Vendor lock-in ટાળે છે. 
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2. ક˶માઇઝેશન અને લવચીકતા: 
● જͅર મુજબ ફેરફાર કરી શકાય છે. 
● સમુદાયથી સતત સુધારાઅાે મળે છે. 

3. સુરƖા અને ̍વ˝સનીયતા: 
● કાેડ અાેપન હાેવાને કારણે auditing સરળ બને છે. 
● બƝસ ઝડપથી સુધારાય છે. 
● અાʢેાેલેટ થવાનું અાેછી શȂતા. 

4. સહકાર અને નવીનતા: 
● ̍વ˝˗ાપી ̍વકાસકતાƙઅાનેું યાેગદાન. 
● ઝડપી ̍વકાસ અને ̍વશાળ ફીચર સેટ. 

5. કાેઈ મા̏લકી હǲના ̏નયંǋણાે નથી: 
● સાૈʸ લાયસʉ હેઠળ સંપૂણƙ ̄તǋંતા. 

પડકારાે અને ̍વચારણા: 

1. સપાેટƙ અને ડાȂેુમɰેેશન: 
● ફાેમƙલ સપાેટƙ અાેછાે હાેય છે. 
● ડાેȂુમɰેેશન Ȃારેક અધૂરાે હાેય છે. 

2. વપરાશકતાƙ માટે સહેલાઇ: 
● કેટલાંક સાેʘવેર ǐાેǁામર માટે સરળ હાેય પણ સામાʈ વપરાશકતાƙ માટે મુƸકેલ હાેઈ શકે છે. 
● પરંતુ Ubuntu, LibreOffice, GIMP જવેા સાધનાે વધુ સાહ̏જક બʈા છે. 

3. અનુકૂળતા સમ̃ાઅાે: 
● ǐાǐેાયટરી ફાેમ̳ટ સાથે અનુͅપ થવામાં અડચણ અાવી શકે છે. 

4. ̐બઝનેસ અપનાવવું: 
● ˗ાપા̋રક સપાેટƙ ના હાેય તાે સં˺ાઅાે ̋હચકાય છે. 
● Red Hat અને Oracle જવેી કંપનીઅાે ˗ાપા̋રક સપાેટƙ અાપે છે. 

̀ણીતાં અાેપન-સાેસƙ મફત સાેʘવેર ǐાજેેǶ્સ: 

● Linux 
● Firefox 
● Apache HTTP Server 
● VLC Media Player 
● WordPress 
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● Blender 
● MySQL 

13. નમુનાͅપ ǐ˜ાે અને જવાબાે (Model Questions and Answers) 

ǐ.1: નીચમેાંથી કયું Google નંુ utility નથી? 
A) Google Drive 
B) Google Photos 
C) Microsoft OneDrive 
D) Google Maps 
જવાબ: C) Microsoft OneDrive 

ǐ.2: ChatGPT જવેા AI અાધા̋રત ચેટબાેટનું મȕુ કાયƙ શું છે? 
A) ̋ફːાેની ભલામણ કરવી 
B) અાપમેળે ǁાહક સહાય પૂરી પાડવી અને લખાણ જવાબાે જનરેટ કરવાે 
C) રમતાે રમવી 
D) ઈɰરનેટ પર શાેધ કરવી 
જવાબ: B) અાપમેળે ǁાહક સહાય પૂરી પાડવી અને લખાણ જવાબાે જનરેટ કરવાે 

ǐ.3: Zoom અથવા Google Meet જવેી ̍વ̋ડયાે કાેʃરʉ અે̖ʕકેશનમાં નીચેમાંથી કયાે ફીચર સામાʈ 
રીતે ઉપલʤ નથી? 
A) ˲ીન શે̋રગ̬ 
B) પૃʕ ભૂ̌મ ધંૂધળી બનાવવી 
C) ̋રયલ-ટાઈમ ફે̐સયલ રેક̗Șશન 
D) ǒેકઅાઉટ ͅʼ 
જવાબ: C) ̋રયલ-ટાઈમ ફે̐સયલ રેક̗Șશન 

ǐ.4: સાયબર સુરƖા સંદભ̳ phishing શું છે? 
A) અંગત ડેટાને અેિƮƿʍ કરીને સુર̐Ɩત કરવાની પɡ̍ત 
B) ખાેટી ઈમેઈલ અથવા વેબસાઇટ ɦારા સંવદેનશીલ મા̋હતી મેળવવાનાે ǐયાસ 
C) રેʉમવરેનાે અેક ǐકાર 
D) ડેટા પનુઃǐા̍ʏનાે ǐકાર 
જવાબ: B) ખાેટી ઈમેઈલ અથવા વેબસાઇટ ɦારા સંવેદનશીલ મા̋હતી મેળવવાનાે ǐયાસ 

ǐ.5: અાૈપચા̋રક ઈમેઈલ માેકલતી વખતે Ǘેˤ ˗વહાર કયાે છે? 
A) ઇમાે͂ અને ઢીલી ભાષાનાે ઉપયાેગ 
B) અાખંુ સંદેશ કે̌પટલ અƖરમાં લખવાે 
C) ˗ાવસા̍યક ભાષાનાે ઉપયાેગ કરવાે અને યાેƝય રીતે સંબાેધન કરવું 
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D) ખૂબ લાંબી ̍વષય લાઇન વાળું ઈમેઈલ માેકલવું 
જવાબ: C) ˗ાવસા̍યક ભાષાનાે ઉપયાેગ કરવાે અને યાેƝય રીતે સંબાેધન કરવુ ં

ǐ.6: નીચમેાથંી કયાે ફીચર કાયƙ ˗વ˺ાપન અે̖ʕકેશનમાં સામાʈ રીતે ̀ેવા મળે છે? 
A) કાયƙની ǐાથ̌મકતા ̏નધાƙરણ 
B) ફાઈલ સંǁહ 
C) અɥતન છબી સંપાદન સાધના ે
D) ̍વ̋ડયાે ˷ી̌મ̬ગ 
જવાબ: A) કાયƙની ǐાથ̌મકતા ̏નધાƙરણ 

ǐ.7: નીચેમાંથી કયું અવાજ અાધા̋રત સાધન હાથ વગરના ̏નયંǋણ માટે ઉદાહરણͅપ છે? 
A) Adobe Photoshop 
B) Google Assistant 
C) Excel Spreadsheet 
D) Slack 
જવાબ: B) Google Assistant 

ǐ.8: ̀ે કƳʔુટર શͅ ન થાય તાે troubleshooting માટેનું પહેલું પગલું શું હાેય? 
A) તાજેતરમાં ઇʊાેલ કરેલા બધા કાયƙƿમાે દૂર કરાે 
B) પાવર સʕાય યાેƝય રીતે ̀ેડાયેલું છે કે કેમ તે ચકાસાે 
C) અાેપરે̋ટ̬ગ ̐સ˶મ ફરીથી ઇʊાેલ કરાે 
D) તરત જ ǁાહક સહાયતા સંપકƙ  કરા ે
જવાબ: B) પાવર સʕાય યાƝેય રીતે ̀ેડાયેલું છે કે કેમ તે ચકાસાે 

ǐ.9: ઈ-ગવનƙʉનાે મુȕ હેતુ શંુ છે? 
A) ̀હેર Ɩેǋમાં Ǔˠાચારને ǐાેɘાહન અાપવા ે
B) ̋ડ̏જટલ સાધનાે અને સેવાઅાેથી સારી શાસન ǐણાલી પૂરી પાડવી 
C) સરકારી સેવાઅાેમાં ̀હેરની ǐવૃ̍ ɇઅાે મયાƙ̋દત કરવી 
D) સરકારી સેવાઅાેનંુ ખાનગીકરણ કરવંુ 
જવાબ: B) ̋ડ̏જટલ સાધનાે અને સેવાઅાેથી સારી શાસન ǐણાલી પૂરી પાડવી 

ǐ.10: ̋ડ̏જટલ સ̋ટ̭̋ફકેટનાે મુȕ ઉપયાેગ શું છે? 
A) શારી̋રક દƺતાવે̀ેને અેિƮƿʍ કરવાે 
B) ǐેષકની અાેળખને ǐમા̒ણત કરવી અને સંદેશાેની અખં̋ડતતા સુ̏ન̏˛ત કરવી 
C) અાેનલાઇન બ̲̋ક̬ગ માટે પાસવડƙ બનાવવા ે
D) સાે̏શયલ મી̋ડયા હાજરી પૂરી પાડવી 
જવાબ: B) ǐેષકની અાેળખને ǐમા̒ણત કરવી અને સંદેશાેની અખં̋ડતતા સુ̏ન̏˛ત કરવી 
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ǐ.11: ̀હેર ઈɰરફેસ ̋કયાે˱ નાે સામાʈ ઉપયાેગ શંુ છે? 
A) અાૅનલાઇન ગેʼ રમવા 
B) અેરપાેટƙ પર ưલાઈટ માટે ચેક-ઇન કરવુ ં
C) ફાેટાે સંપાદન કરવું 
D) સાેʘવેર કાયƙƿમ બનાવવું 
જવાબ: B) અેરપાેટƙ પર ưલાઈટ માટે ચેક-ઇન કરવુ ં

ǐ.12: નીચમેાંથી કયું Google utility અાૅનલાઇન દƺતાવે̀ે સંǁહવા, વહ̲ચવા અને સંપા̋દત કરવા માટે 
વપરાય છે? 
A) Google Photos 
B) Google Drive 
C) Google Maps 
D) Google Keep 
જવાબ: B) Google Drive 

ǐ.13: નીચેમાંથી કયું two-factor authentication નું ઉદાહરણ છે? 
A) ફǸ પાસવડƙનાે ઉપયાેગ કરીને લાૅગ ઇન કરવું 
B) પાસવડƙ દાખલ કયાƙ પછી ફાેન પર one-time code મેળવવાે 
C) સાે̏શયલ મી̋ડયા અાેળખાણથી લાૅગ ઇન કરવું 
D) ફǸ ̋ફ̬ગર̌ǐɰ ˱ેનરનાે ઉપયાેગ 
જવાબ: B) પાસવડƙ દાખલ કયાƙ પછી ફાેન પર one-time code મેળવવાે 

ǐ.14: ˗ાવસા̍યક ઈમઈેલ મેનેજમેɰમાં કયાે અાચરણ યાેƝય નથી? 
A) અાૈપચા̋રક અ̑ભવાદન અને હƺતાƖરનાે ઉપયાેગ 
B) તાȿા̏લક ઈમેઈ˔નાે ઝડપથી જવાબ અાપવાે 
C) ̐બઝનેસ ઈમેઈલમાં ખૂબ જ સામાʈ ભાષાનાે ઉપયાેગ 
D) ˾ˠ અને સંબં̍ધત ̍વષય લાઇનનાે ઉપયાેગ 
જવાબ: C) ̐બઝનેસ ઈમેઈલમાં ખૂબ જ સામાʈ ભાષાનાે ઉપયાેગ 

ǐ.15: Trello અથવા Asana જેવી task management apps માં કયાે ફીચર સામાʈ છે? 
A) અાપમેળે કɰેɰ જનરેશન 
B) કાયƙ ̏નધાƙરણ અને અં̍ તમ તારીખ સુયાે̏જત કરવી 
C) ̍વ̋ડયાે કાે̏લ̬ગ 
D) ʸુ̏ઝક ˷ી̌મ̬ગ 
જવાબ: B) કાયƙ ̏નધાƙરણ અને અં̍તમ તારીખ સુયાે̏જત કરવી 

ǐ.16: નીચેના કયા અવાજ સાધનાેથી વપરાશકતાƙઅાે ફાેન કે ́ાટƙ ̋ડવાઈસને અવાજથી ̏નયં̍ ǋત કરી શકે 
છે? 
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A) Microsoft Cortana 
B) Google Assistant 
C) Siri 
D) ઉપરાેǸ બધંુ 
જવાબ: D) ઉપરાેǸ બધંુ 

ǐ.17: ઈɰરનેટ કનેȆનની સમ̃ા હાેય ɔારે સાǐૈથમ શું કરવું ̀ેઈઅે? 
A) માેડેમ અને રાઉટર ફરીથી શͅ કરા ે
B) તમારા ̋ડવાઇસ પર અપડેટ્સ ચકાસાે 
C) ઇɰરનેટ સેવા ǐદાતા સાથે સંપકƙ  કરા ે
D) અલગ Wi-Fi નેટવકƙથી ̀ેડાવાનાે ǐયાસ કરા ે
જવાબ: A) માેડેમ અને રાઉટર ફરીથી શͅ કરાે 

ǐ.18: ઈ-ગવનƙʉનાે મહɗપણૂƙ લાભ શંુ છે? 
A) સરકારી સેવાઅામેાં ͅબͅ મુલાકાતની જ̋ͅરયાત ઘટાડે છે 
B) વધારે ʨુરાƿેેસી સુ̏ન̏˛ત કરે છે 
C) સરકારી સેવાઅાેને અેક ̋ફ̏ઝકલ ˺ળે કેિƮǍત કરે છે 
D) ̀હેરની ભાગીદારી દૂર કરે છે 
જવાબ: A) સરકારી સેવાઅામેાં ͅબͅ મુલાકાતની જ̋ͅરયાત ઘટાડે છે 

ǐ.19: ̋ડ̏જટલ સ̋ટ̭̋ફકેટ શંુ ǐમા̒ણત કરે છે? 
A) ̋ડ̏જટલ દƺતાવેજ પર હƺતાƖર કરનાર ˗̘Ǹની અાળેખ 
B) દƺતાવેજનું ભાૈ̍ તક ˺ાન 
C) દƺતાવેજ વાંચનાર ˗̘Ǹઅાેની સંȕા 
D) દƺતાવેજની મા̏લકી 
જવાબ: A) ̋ડ̏જટલ દƺતાવજે પર હƺતાƖર કરનાર ˗̘Ǹની અાેળખ 

ǐ.20: ̀હેર ̋કયાે˱નાે સામાʈ ઉપયાેગ કયા માટે થાય છે? 
A) સાે̏શયલ મી̋ડયા ǒાઉઝ કરવું 
B) ̐બલ ચુકવવંુ અથવા લેવડદેવડ કરવી 
C) કƳʔુટર ǐાેǁામ લખવુ ં
D) ̋ડ̏જટલ ફાેટાે સંપા̋દત કરવા ે
જવાબ: B) ̐બલ ચુકવવંુ અથવા લેવડદેવડ કરવી 

ǐ.21: નીચમેાંથી કઈ ̍વ̋ડયાે કાેʃર̘ʉ̬ગ અેપ ̐બઝનેસ મી̋ટ̬ગ માટે સામાʈ રીતે વપરાય છે અને 
વે̐ બનાર હાે̔ ˶̬ગ, ˲ીન શે̋ રગ̬ અને ǒેકઅાઉટ ͅʼ જવેા ફીચસƙ અાપે છે? 
A) Google Meet 
B) WebEx 
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C) WhatsApp 
D) Facebook Messenger 
જવાબ: B) WebEx 

ǐ.22: ̋ડ̏જટલ સહી (Digital Signature) નંુ મુȕ કાયƙ શંુ છે? 
A) અાૅનલાઇન ǇાɯેȆʉ માટે અેિƮƿƯશન પૂ̈́  પાડવી 
B) ̋ડ̏જટલ સંદેશાઅાે કે દƺતાવે̀ેની ખરા પનને અને અખં̋ડતતાને ચકાસવી 
C) પાસવડ્ƙસને સુર̐Ɩત રીતે સાચવવા 
D) દƺતાવેજના ˺ાનને Ǉૅક કરવું 
જવાબ: B) ̋ડ̏જટલ સંદેશાઅાે કે દƺતાવે̀ેની ખરા પનને અને અખં̋ડતતાને ચકાસવી 

ǐ.23: નીચેમાંથી કયું અવાજ અાધા̋રત સાધન (Voice Tool) નથી? 
A) Google Assistant 
B) Alexa 
C) Siri 
D) Zoom 
જવાબ: D) Zoom 

ǐ.24: નીચેમાંથી કયાે Google યુ̋ ટ̏લટી દƺતાવે̀ે, ˿ેડશીટ અને ǐેઝɰેશનને ̋રયલ ટાઈમમાં બનાવવા, 
વહ̲ચવા અને સહયાેગ માટે ઉપયાેગ થાય છે? 
A) Google Docs 
B) Google Drive 
C) Google Meet 
D) Google Calendar 
જવાબ: A) Google Docs 

ǐ.25: નીચમેાંથી કયાે ̍વકˍ ઈ-ગવનƙʉ ̐સ˶મમાં સામાʈ રીતે ̀ેવા મળતાે ફીચર છે? 
A) ઇલƛેǇાે̏ નક ટેȋ ફાઇ̏લગ̬ અને ચુકવણી ̐સ˶મ 
B) ફǸ અાૅનલાઇન ખરીદી ʕેટફાેમƙ 
C) શારી̋રક દƺતાવે̀ેની હેɱ̏લ̬ગ 
D) સરકારી ડેટાની મયાƙ̋દત અૅȋેસ 
જવાબ: A) ઇલƛેǇાે̏ નક ટેȋ ફાઇ̏લ̬ગ અને ચુકવણી ̐સ˶મ 

ǐ.26: ̋ડ̏જટલ સહીમાં ǐાઇવેટ કી (Private Key) ની ભૂ̌મકા શંુ છે? 
A) ̋ડ̏જટલ સહીને અેિƮƿʍ કરવા માટે વપરાય છે 
B) ̋ડ̏જટલ સહીની ખરા પનને ચકાસવા માટે વપરાય છે 
C) ગʏુ રીતે રાખવામાં અાવે છે અને ̋ડ̏જટલ સહી બનાવવા માટે વપરાય છે 
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D) દƺતાવે̀ેને સુર̐Ɩત રીતે વહ̲ચવા માટે વપરાય છે 
જવાબ: C) ગʏુ રીતે રાખવામાં અાવે છે અને ̋ડ̏જટલ સહી બનાવવા માટે વપરાય છે 

ǐ.27: નીચમેાંથી કયું અાેપન સાેસƙ સાેʘવેરનું ઉદાહરણ નથી? 
A) Mozilla Firefox 
B) WordPress 
C) Microsoft Windows 
D) Apache HTTP Server 
જવાબ: C) Microsoft Windows 

ǐ.28: અાેપન સાેસƙ સાેʘવરેની મુȕ અાેળખ શું છે? 
A) સાેʘવેર મફત હાેય છે પણ ફǸ માેટા કંપનીઅાે માટે 
B) સાેસƙ કાેડ ̀હેરમાં ઉપલʤ હાેય છે અને તેનું ફેરફાર તથા ̍વતરણ કરી શકાય છે 
C) ફǸ શƖૈ̒ણક સં˺ાઅાે માટે ઉપલʤ હાેય છે 
D) દરેક વપરાશકતાƙ માટે પઇેડ લાયસʉ સાથે અાવે છે 
જવાબ: B) સાેસƙ કાેડ ̀હેરમાં ઉપલʤ હાેય છે અને તેનું ફેરફાર તથા ̍વતરણ કરી શકાય છે 

ǐ.29: ઈ-ગવનƙʉ ʕેટફાેમામ̳ાં અાેનલાઈન પાેટƙલનાે ઉપયાેગ શંુ માટે થાય છે? 
A) સરકારી અર͂અાે અને સેવાઅાે અાૅનલાઇન ǐ̋ƿયા કરવા 
B) ગુનેગારાેને Ǉૅક કરવા 
C) સાે̏શયલ મી̋ડયા પર અૅȋેસ રાેકવા 
D) ફǸ સરકારી સમાચાર દશાƙવવા 
જવાબ: A) સરકારી અર͂અાે અને સેવાઅાે અાૅનલાઇન ǐ̋ƿયા કરવા 

ǐ.30: નીચમેાંથી કયાે સામાʈ ǐકારનાે સાયબર હુમલાે છે જે ખાેટી ઈમેઈલ અથવા નકલી વેબસાઈટ ɦારા 
સંવદેનશીલ મા̋હતી ચાેરી કરવાનાે ǐયાસ કરે છે? 
A) Phishing 
B) DDoS (Distributed Denial of Service) 
C) SQL Injection 
D) Ransomware 
જવાબ: A) Phishing 
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